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C H A P T E R 1
Introduction to the Product and the Release

This chapter contains the following sections:

• Introduction to the Web Security Appliance, on page 1
• What’s New in AsyncOS 11.7, on page 2
• Related Topics, on page 4
• Using the Appliance Web Interface, on page 4
• Supported Languages, on page 7
• The Cisco SensorBase Network, on page 7

Introduction to the Web Security Appliance
The Cisco Web Security Appliance intercepts and monitors Internet traffic and applies policies to help keep
your internal network secure from malware, sensitive data loss, productivity loss, and other Internet-based
threats.
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What’s New in AsyncOS 11.7
DescriptionFeature

The File Analysis service in your appliance now supports all the file
types supported by Cisco AMPThreat Grid. This has dual advantages.
You can:

• Upload files that only contain dynamic content for file analysis.
This helps administrators to track the daily file upload limit.
Previously, the on-box pre-classfication engine filtered the files
with a limited scope before sending them for analysis. Now, a
new cloud-based Threat Grid pre-classifcation engine is added
to filter and remove low risk files. This improves efficacy by
saving the submission limit for possible malicious files.

• Reduce file uploads for file analysis.

To configure this feature, see Enabling and Configuring File
Reputation and Analysis Services , on page 268.

If you are using the private cloud file analysis server
version 2.4 or an earlier version, it is recommended
that you do not enable the new file types for file
analysis.

Note

Anew verdict – LowRisk is introducedwhen no dynamic content
is found in a file after file analysis. You can view the verdict
details in the Incoming Files Handed by AMP section of the
Advanced Malware Protection report.

The low risk files are not searchable in the File
Analysis page in Reporting with their SHA because
they are not sent for analysis to the AMP Threat Grid.

Note

Improved Pre-classification Efficacy
(Reducing File Uploads to Cisco
AMP Threat Grid)
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DescriptionFeature

You can now configure your appliance to transparently identify users
with ISE-PIC version 2.4 (with pxGrid version 2.0). ISE-PIC fetches
user-identity information (user names and Active Directory groups)
to allow transparent user identification in policies configured to use
those profiles.

Note • When you upgrade to AsyncOS 11.7 forWeb Security
appliances, you must reconfigure ISE for a successful
integration. Any previously configured ISE
functionality will not work until the ISE is
reconfigured again.

• AsyncOS 11.7 for Web Security appliances only
supports ISE release 2.4. If the ISE versions in your
deployment are older than ISE 2.4, continue to use
AsyncOS releases forWeb Security appliances earlier
than 11.7.

For more information, see Overview of the Identity Services Engine
(ISE) / ISE Passive Identity Controller (ISE-PIC) Service, on page
139.

ISE-PIC Integration

URL category filtering will be applied to all transactions that go
through translate.google.com, further fortifying the ability to identify
and take action on all transactions.

You must enable the HTTPS proxy and choose to decrypt HTTPS
requests.

Encapsulated URL Protection

The WBRS engine is enhanced to improve the efficacy of web
reputation and web category information for URLs.

EnhancedWeb-based reputation score
(WBRS) Engine

The appliance now provides the SNI of pass-through HTTPS
transactions, which enables you to search for transactions for a specific
website in the Web Tracking page.

Server Name Indication (SNI)
Information in reports

You can use up to 30 feed files with URL category definitions, with
each file containing up to 5,000 entries.

Increasing the number of external feed entries causes
performance degradation.

Note

Support for 30 Feed Files in External
Live Feed for Custom and External
URL Categories

A new subcommand loginhistory is added to the CLI command
adminaccessconfig to configure the number of days for which the
login history is retained.

Default value is 1 day.

This is available in FIPS and non-FIPS mode.

Login History Configuration
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DescriptionFeature

A new subcommand maxsessions is added to the CLI command
adminaccessconfig to configure the maximum number of concurrent
sessions of the appliance through the Command Line Interface and
web interface.

Default value in FIPS mode is 3 and non-FIPS mode is 10.

MaximumConcurrent Login Sessions
Configuration

The appliance provides walkthroughs to assist you in accomplishing
a particular configuration task. The following walkthroughs are
supported in this release:

• Authenticate end-users using Active Directory – NTLM

• Authenticate end-users using Active Directory – Kerberos

• Decrypt HTTPS traffic

The list of walkthroughs is cloud updateable. Make sure
that you clear your browser cache to view an updated
version of the How-Tos widget and pop-up window.

Note

For information on how to enable the walkthroughs, see Additional
Security Settings for Accessing the Appliance, on page 433.

Enhanced User Experience Using
Walkthroughs

Smart Software Licensing enables you to manage and monitor Cisco
Web Security appliance licenses seamlessly. To activate Smart
Software licensing, youmust register your appliance with Cisco Smart
Software Manager (CSSM), which is the centralized database that
maintains the licensing details of all the Cisco products that you
purchase and use.

After you enable the Smart Licensing feature on your
appliance, you will not be able to roll back from Smart
Licensing to Classic Licensing mode.

Caution

For more information, see Smart Software Licensing, on page 415.

Support for Smart Software Licensing

Related Topics
• http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-release-notes-list.html

Using the Appliance Web Interface
• Web Interface Browser Requirements, on page 5
• Enabling Access to the Web Interface on Virtual Appliances , on page 5
• Accessing the Appliance Web Interface, on page 5
• Committing Changes in the Web Interface, on page 7
• Clearing Changes in the Web Interface, on page 7
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Web Interface Browser Requirements
To access the web interface, your browser must support and be enabled to accept JavaScript and cookies. It
must be able to render HTML pages containing Cascading Style Sheets (CSS).

The Cisco Web Security Appliance follows the Target Environments set by YUI:
http://yuilibrary.com/yui/environments/

Your session automatically times out after 30 minutes of inactivity.

Some buttons and links in the web interface cause additional windows to open. Therefore, you may need to
configure the browser’s pop-up blocking settings in order to use the web interface.

Only use one browser window or tab at a time to edit the appliance configuration. Also, do not edit the
appliance using the web interface and the CLI at the same time. Editing the appliance from multiple places
concurrently results in unexpected behavior and is not supported.

Note

To access the GUI, your browser must support and be enabled to accept JavaScript and cookies, and it must
be able to render HTML pages containing Cascading Style Sheets (CSS).

Conditional support is offered for Internet Explorer 6.0 and Opera 10.0.x on theWindows XP operating system
and for Safari 3.1 on Mac OS X. Conditional support means that important functional bugs will be addressed,
but minor or visual issues may not be corrected.

Browsers are supported only for operating systems officially supported by the browser.

You may need to configure your browser’s pop-up blocking settings in order to use the GUI, because some
buttons or links in the interface will cause additional windows to open.

Enabling Access to the Web Interface on Virtual Appliances
By default, the HTTP and HTTPS interfaces are not enabled on virtual appliances. To enable these protocols,
you must use the command-line interface.

Step 1 Access the command-line interface. See Accessing the Command Line Interface, on page 499.
Step 2 Run the interfaceconfig command.

Pressing Enter at a prompt accepts the default value.

Look for the prompts for HTTP and HTTPS and enable the protocol(s) that you will use.

Accessing the Appliance Web Interface
If you are using a virtual appliance, see Enabling Access to the Web Interface on Virtual Appliances , on page
5.

Step 1 Open a browser and enter the IP address (or hostname) of the Web Security appliance. If the appliance has not been
previously configured, use the default settings:
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https://192.168.42.42:8443

-or-

http://192.168.42.42:8080

where 192.168.42.42 is the default IP address, and 8080 is the default admin port setting for HTTP, and 8443 is default
admin port for HTTPS.

Otherwise, if the appliance is currently configured, use the IP address (or host name) of the M1 port.

You must use a port number when connecting to the appliance (by default, port 8080). Failing to specify a port
number when accessing the web interface results in a default port 80, Proxy Unlicensed error page.

Note

Step 2 [New Web Interface Only] Login to the legacy web interface and click Web Security appliance is getting a new look.
Try it!! link to access the new web interface. When you click this link, it opens a new tab in your web browser and goes
to https://wsa_appliance.com:<trailblazer-https-port>/ng-login, where wsa_appliance.com is the appliance
host name and <trailblazer-https-port> is the trailblazer HTTPS port configured on the appliance.

• You must login to the legacy web interface of the appliance.

• Ensure that your DNS server can resolve the hostname of the appliance that you specified.

• By default, the new web interface needs TCP ports 6080, 6443 and 4431 to be operational. Ensure that
these ports are not blocked in the enterprise firewall.

• The default port for accessing new web interface is 4431. This can be customized using
trailerblazerconfig CLI command. For more information on the trailblazerconfig CLI command,
see Web Security Appliance CLI Commands, on page 503.

• The new web interface also needs AsyncOS API (Monitoring) ports for HTTP and HTTPS. By default
these ports are 6080 and 6443. The AsyncOS API (Monitoring) ports can also be customized in the
interfaceconfigCLI command. For more information on the interfaceconfigCLI command, seeWeb
Security Appliance CLI Commands, on page 503.

• If you change these default ports, then ensure that the customized ports for the new web interface too must
not be blocked in the enterprise firewall.

Note

Step 3 When the appliance login screen appears, enter your user name and passphrase to access the appliance.

By default, the appliance ships with the following user name and passphrase:

• User name: admin
• Passphrase: ironport

If this is the first time you have logged in with the default admin user name, you will be prompted to immediately change
the passphrase.

Step 4 To view a listing of recent appliance access attempts, both successes and failures, for your user name, click the
recent-activity icon (i or ! for success or failure respectively) in front of the “Logged in as” entry in the upper right corner
of the application window.
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Committing Changes in the Web Interface

Step 1 Click the Commit Changes button.
Step 2 Enter comments in the Comment field if you choose.
Step 3 Click Commit Changes.

You can make multiple configuration changes before you commit all of them.Note

Clearing Changes in the Web Interface

Step 1 Click the Commit Changes button.
Step 2 Click Abandon Changes.

Supported Languages
AsyncOS can display its GUI and CLI in any of the following languages:

• German

• English

• Spanish

• French

• Italian

• Japanese

• Korean

• Portuguese

• Russian

• Chinese

• Taiwanese

The Cisco SensorBase Network
The Cisco SensorBase Network is a threat management database that tracks millions of domains around the
world and maintains a global watch list for Internet traffic. SensorBase provides Cisco with an assessment of
reliability for known Internet domains. TheWeb Security appliance uses the SensorBase data feeds to improve
the accuracy of Web Reputation Scores.
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SensorBase Benefits and Privacy
Participating in the Cisco SensorBase Network means that Cisco collects data and shares that information
with the SensorBase threat management database. This data includes information about request attributes and
how the appliance handles requests.

Cisco recognizes the importance of maintaining your privacy, and does not collect or use personal or confidential
information such as usernames and passphrases. Additionally, the file names and URL attributes that follow
the hostname are obfuscated to ensure confidentiality. When it comes to decrypted HTTPS transactions, the
SensorBase Network only receives the IP address, web reputation score, and URL category of the server name
in the certificate.

If you agree to participate in the SensorBase Network, data sent from your appliance is transferred securely
using HTTPS. Sharing data improves Cisco’s ability to react to web-based threats and protect your corporate
environment from malicious activity.

Enabling Participation in The Cisco SensorBase Network

Standard SensorBase Network Participation is enabled by default during system setup.Note

Step 1 Choose Security Services > SensorBase.
Step 2 Verify that SensorBase Network Participation is enabled.

When it is disabled, none of the data that the appliance collects is sent back to the SensorBase Network servers.

Step 3 In the Participation Level section, choose one of the following levels:

• Limited. Basic participation summarizes server name information and sends MD5-hashed path segments to the
SensorBase Network servers.

• Standard. Enhanced participation sends the entire URLwith unobfuscated path segments to the SensorBase Network
servers. This option assists in providing a more robust database, and continually improves the integrity of Web
Reputation Scores.

Step 4 In the AnyConnect Network Participation field, choose whether or not to include information collected from clients that
connect to the Web Security appliance using Cisco AnyConnect Client.

AnyConnect Clients send their web traffic to the appliance using the Secure Mobility feature.

Step 5 In the Excluded Domains and IP Addresses field, optionally enter any domains or IP addresses to exclude from traffic
sent to the SensorBase servers.

Step 6 Submit and commit your changes.
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C H A P T E R 2
Connect, Install, and Configure

This chapter contains the following sections:

• Overview of Connect, Install, and Configure, on page 9
• Deploying a Virtual Appliance , on page 10
• Comparison of Modes of Operation, on page 10
• Task Overview for Connecting, Installing, and Configuring, on page 14
• Connecting the Appliance, on page 14
• Gathering Setup Information, on page 16
• System Setup Wizard, on page 18
• Upstream Proxies, on page 24
• Network Interfaces, on page 26
• Configuring Failover Groups for High Availability, on page 28
• Using the P2 Data Interface for Web Proxy Data , on page 30
• Redirect Hostname and System Hostname, on page 41
• DNS Settings, on page 43
• Troubleshooting Connect, Install, and Configure, on page 45

Overview of Connect, Install, and Configure
The Web Security appliance provides the following modes of operation:

• Standard: The Standard mode of Web Security appliance operation includes on-site Web Proxy services
and Layer-4 traffic monitoring, which are not available in the Cloud Web Security Connector mode.

• Cloud Web Security Connector: In Cloud Web Security Connector mode, the appliance connects to and
routes traffic to a Cisco Cloud Web Security (CWS) proxy, where Web security policies are enforced.

• Cisco Defense Orchestrator: In the Cisco Defense Orchestrator mode, the appliance is on-boarded to the
Cisco Defense Orchestrator. Policy management, and optionally, reporting, is carried out through the
Cisco Defense Orchestrator. See Configuration Changes and Constraints in Cisco Defense Orchestrator
Mode, on page 56for more information on the configuration changes and constraints.

The appliance has multiple network ports, with each assigned to manage one or more specific data types.

The appliance uses network routes, DNS, VLANs, and other settings and services to manage network
connectivity and traffic interception. The System Setup Wizard lets you set up basic services and settings,
while the appliance’s Web interface lets you modify settings and configure additional options.
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Deploying a Virtual Appliance
To deploy a virtual web security appliance, see the Cisco Content Security Virtual Appliance Installation
Guide , available from
http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-installation-guides-list.html

Migrating from a Physical to a Virtual Appliance
To migrate your deployment from a physical appliance to a virtual appliance, see the virtual appliance
installation guide referenced in the previous topic and the Release Notes for your AsyncOS version.

Comparison of Modes of Operation
The following table presents the various menu commands available in Standard and Cloud connector Modes,
thereby indicating the various features available in each mode.

To see the features available in the Cisco Defense Orchestrator mode, see Configuration Changes and
Constraints in Cisco Defense Orchestrator Mode, on page 56.
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Available in Cloud Connector ModeAvailable in Standard ModeMenu

System StatusSystem Status

Overview

Users

User Count

Web Sites

URL Categories

Application Visibility

Anti-Malware

Advanced Malware Protection

File Analysis

AMP Verdict Updates

Client Malware Risk

Web Reputation Filters

Layer-4 Traffic Monitor

Reports by User Location

Web Tracking

System Capacity

System Status

Scheduled Reports

Archived Reports

Reporting
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Available in Cloud Connector ModeAvailable in Standard ModeMenu

Identification Profiles

Cloud Routing Policies

External Data Loss Prevention

Custom URL Categories

Identification Profiles

Cloud Routing Policies

SaaS Policies

Decryption Policies

Routing Policies

Access Policies

Overall Bandwidth Limits

Cisco Data Security

Outbound Malware Scanning

External Data Loss Prevention

Web Traffic Tap Policies

SOCKS Policies

Custom URL Categories

Define Time Ranges and Quotas

Bypass Settings

Layer-4 Traffic Monitor

Web Security
Manager

Web ProxyWeb Proxy

FTP Proxy

HTTPS Proxy

SOCKS Proxy

PAC File Hosting

Acceptable Use Controls

Anti-Malware and Reputation

Data Transfer Filters

AnyConnect Secure Mobility

End-User Notification

L4 Traffic Monitor

SensorBase

Reporting

Cisco Cloudlock

Cisco Cognitive Threat Analytics

Security Services
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Available in Cloud Connector ModeAvailable in Standard ModeMenu

Interfaces

Transparent Redirection

Routes

DNS

High Availability

Internal SMTP Relay

External DLP Servers

Certificate Management

Authentication

Machine ID Service

Cloud Connector

Interfaces

Transparent Redirection

Routes

DNS

High Availability

Internal SMTP Relay

Upstream Proxy

External DLP Servers

Web Traffic Tap

Certificate Management

Authentication

Identity Provider for SaaS

Identity Services Engine

Network

Alerts

Log Subscriptions

SSL Configuration

Users

Network Access

Time Zone

Time Settings

Configuration Summary

Configuration File

Feature Keys

Upgrade and Update Settings

System Upgrade

System Setup Wizard

Policy Trace

Alerts

Log Subscriptions

Return Addresses

SSL Configuration

Users

Network Access

Time Zone

Time Settings

Configuration Summary

Configuration File

Feature Keys Settings

Feature Keys

Upgrade and Update Settings

System Upgrade

System Setup Wizard

FIPS Mode

Next Steps

System
Administration
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Available in Cloud Connector ModeAvailable in Standard ModeMenu

N/AN/ACisco CWS
Portal(available only
in Hybrid Web
Security mode)

Task Overview for Connecting, Installing, and Configuring
More InformationTask

Connecting the Appliance, on page 14• Connect the appliance to Internet traffic.

Gathering Setup Information, on page 16• Gather and record set-up information.

System Setup Wizard, on page 18• Run the System Setup Wizard.

Enabling the HTTPS Proxy, on page 226

Authentication Realms, on page 94

Identification Profiles and Authentication , on page
130

• Configure HTTPS proxy settings, Authentication
Realms and Identification Profiles. This stepmust
be completed for Hybrid Web Security mode.

Upstream Proxies, on page 24• (Optional) Connect upstream proxies.

Connecting the Appliance
Before you begin

• To mount the appliance, cable the appliance for management, and connect the appliance to power, follow
the instructions in the hardware guide for your appliance. For the location of this document for your
model, see Documentation Set, on page 523.

• If you plan to physically connect the appliance to a WCCP v2 router for transparent redirection, first
verify that the WCCP router supports Layer 2 redirection.

• Be aware of Cisco configuration recommendations:

• Use simplex cabling (separate cables for incoming and outgoing traffic) if possible for enhanced
performance and security.

Step 1 Connect the Management interface if you have not already done so:
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NotesEthernet Port

Connect M1 to where it can:

• Send and receive Management traffic.
• (Optional) Send and receive web proxy data traffic.

You can connect a laptop directly to M1 to administer the appliance.

To connect to the management interface using a hostname (http://hostname:8080), add
the appliance hostname and IP address to your DNS server database.

M1

• Available for outbound management services traffic but not administration.
• Enable Use M1 port for management only (Network > Interfaces page).
• Set routing for the service to use the Data interface.

P1 and P2 (optional)

Step 2 (Optional) Connect the appliance to data traffic either directly or through a transparent redirection device:

Transparent RedirectionExplicit ForwardingEthernet Port

Device: WCCP v2 router:

• For Layer 2 redirection, physically connect
router to P1/P2.

• For Layer 3 redirection, be aware of possible
performance issues with Generic Routing
Encapsulation.

• Create a WCCP Service on the appliance.

Device: Layer-4 Switch:

• For Layer 2 redirection, physically connect
switch to P1/P2.

• For Layer 3 redirection, be aware of possible
performance issues with Generic Routing
Encapsulation.

The appliance does not support inline
mode.

Note

P1 only:

• Enable Use M1 port for management
only.

• Connect P1 and M1 to different subnets.
• Use a duplex cable to connect P1 the
internal network and the internet to
receive both inbound and outbound traffic.

P1 and P2

• Enable P1.
• Connect M1, P1, and P2 to different
subnets.

• Connect P2 to the internet to receive
inbound internet traffic.

After running the System SetupWizard, enable
P2.

P1/P2

N/AIf Use M1 port for management only is
disabled, M1 is the default port for data traffic.

M1 (optional)

Step 3 (Optional) To monitor Layer-4 traffic, connect the Appliance to a TAP, switch, or hub after the proxy ports and before
any device that performs network address translation (NAT) on client IP addresses:
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NotesEthernet Port

To allow Layer-4 Traffic Monitor blocking, put Layer 4 Traffic Monitor on the same network as
the Web Security appliance.

Recommended configuration:

Device: Network TAP:

• Connect T1 to network TAP to receive outbound client traffic.
• Connect T2 to network TAP to receive inbound internet traffic.

Other options:

Device: Network TAP:

• Use duplex cable on T1 to receive inbound and outbound traffic.

Device: Spanned or mirrored port on a switch

• Connect T1 to receive outbound client traffic and connect T2 to receive inbound internet
traffic.

• (Less preferred) Connect T1 using a half or full duplex cable to receive both inbound and
outbound traffic.

Device: Hub:

• (Least preferred) Connect T1 using a duplex cable to receive both inbound and outbound
traffic.

The appliance listens to traffic on all TCP ports on these interfaces.

T1/T2

Step 4 Connect external proxies upstream of the appliance to allow the external proxies to receive data from the appliance.

What to do next

Gathering Setup Information, on page 16

Related Topics

• Enabling or Changing Network Interfaces, on page 27
• Using the P2 Data Interface for Web Proxy Data , on page 30
• Adding and Editing a WCCP Service, on page 36
• Configuring Transparent Redirection, on page 34
• Upstream Proxies, on page 24

Gathering Setup Information
You can use the worksheet below to record the configuration values you will need while running the System
SetupWizard. For additional information about each property, see System SetupWizard Reference Information,
on page 19.
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System Setup Wizard Worksheet

ValuePropertyValueProperty

RoutesAppliance Details

Management TrafficDefault SystemHostname

Default GatewayLocal DNS Server(s)

(Required if not using
Internet Root Servers)

(Optional) Static Route
Table Name

DNS Server 1

(Optional) Static Route
Table Destination
Network

(Optional) DNS Server 2

(Optional) Standard
Service Router Addresses

(Optional) DNS Server 3

(Optional) Data Traffic(Optional) Time Settings

Default GatewayNetwork Time Protocol
Server

Static Route Table Name(Optional) External
Proxy Details

Static Route Table
Destination Network

Proxy Group Name

(Optional) WCCP
Settings

Proxy Server Address

WCCP Router AddressProxy Port Number

WCCPRouter PassphraseInterface Details

Administrative SettingsManagement (M1) Port

Administrator PassphraseIPv4 Address (required)

IPv6 Address (optional)

Email System Alerts ToNetwork Mask

(Optional) SMTP Relay
Host

Hostname

(Optional) Data (P1)
Port

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
17

Connect, Install, and Configure
Gathering Setup Information



System Setup Wizard Worksheet

ValuePropertyValueProperty

IPv4 (optional)

IPv6 Address (optional)

Network Mask

Hostname

System Setup Wizard
Before you begin

• Connect the Appliance to networks and devices. See Connecting the Appliance, on page 14.
• Complete the System Setup Wizard worksheet. See Gathering Setup Information, on page 16.
• If you are setting up a virtual appliance:

• Use the loadlicense command to load the virtual appliance license. For complete information, see
the Cisco Content Security Virtual Appliance Installation Guide, available from
http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-installation-guides-list.html.

• Enable the HTTP and/or HTTPS interfaces: In the command-line interface (CLI), run the
interfaceconfig command.

• Note that reference information for each configuration item used in the System SetupWizard is available
at System Setup Wizard Reference Information, on page 19.

Only use the System Setup Wizard the first time you install the appliance, or if you want to completely
overwrite the existing configuration.

Warning

Step 1 Open a browser and enter the IP address of the Web Security appliance. The first time you run the System Setup Wizard,
use the default IP address:

https://192.168.42.42:8443

-or-

http://192.168.42.42:8080

where 192.168.42.42 is the default IP address, and 8080 is the default admin port setting for HTTP, and 8443 is default
admin port for HTTPS.

Otherwise, if the appliance is currently configured, use the IP address of the M1 port.

Step 2 When the appliance login screen appears, enter the user name and passphrase to access the appliance. By default, the
appliance ships with the following user name and passphrase:

• User name: admin

• Passphrase: ironport
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Step 3 You must immediately change the passphrase.
Step 4 Choose System Administration > System Setup Wizard.

If the appliance is already configured, you will be warned that you are about to reset the configuration. To continue with
the System SetupWizard, checkReset Network Settings, and then click theReset Configuration button. The appliance
will reset and the browser will refresh to the appliance home screen.

Step 5 Read and accept the terms of the end-user license agreement.
Step 6 Click Begin Setup to continue.
Step 7 Configure all settings using the reference tables provided in the following sections as required. See System SetupWizard

Reference Information, on page 19.
Step 8 Review the configuration information. If you need to change an option, click Edit for that section.
Step 9 Click Install This Configuration.

What to do next

A Next Steps page should appear once the configuration installed. However, depending on the IP, host name,
or DNS settings you configured during setup, you may lose connection to the appliance at this stage. If a
“page not found” error is displayed in your browser, change the URL to reflect any new address settings and
reload the page. Then continue with any post-setup tasks you wish to perform.

System Setup Wizard Reference Information
• Network / System Settings, on page 19
• Network / Network Interfaces and Wiring, on page 21
• Network / Routes for Management and Data Traffic, on page 22
• Network / Transparent Connection Settings, on page 22
• Network /Administrative Settings , on page 23

Network / System Settings

DescriptionProperty

The system hostname is the fully-qualified hostname used to identify the appliance
in the following areas:

• the command line interface (CLI)
• system alerts
• end-user notification and acknowledgment pages
• when forming the machine NetBIOS namewhen theWeb Security appliance
joins an Active Directory domain

The system hostname does not correspond directly to interface hostnames and is
not used by clients to connect to the appliance.

Default SystemHostname
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DescriptionProperty

• Use the Internet’s Root DNS Servers – You can choose to use the Internet
root DNS servers for domain name service lookups when the appliance does
not have access to DNS servers on your network.

Internet Root DNS servers will not resolve local host names. If
you need the appliance to resolve local host names you must use
a local DNS server, or add the appropriate static entries to the
local DNS using the CLI.

Note

• Use these DNS Servers – Provide address(es) for the local DNS server(s)
that the appliance can use to resolve host names.

See DNS Settings, on page 43 for more information about these settings.

DNS Server(s)

The Network Time Protocol (NTP) server used to synchronize the system clock
with other servers on the network or the Internet.

The default is time.sco.cisco.com.

NTP Server

Provide time-zone information for location of the appliance; affects timestamps
in message headers and log files.

Time Zone

• Standard – Used for standard on-premise policy enforcement.
• Cloud Web Security Connector – Used primarily to direct traffic to Cisco’s
Cloud Web Security service for policy enforcement and threat defense.

• Hybrid Web Security – Used in conjunction with Cisco’s Cloud Web
Security service for cloud and on-premise policy enforcement and threat
defense.

See Comparison of Modes of Operation, on page 10 for more information about
these modes of operation.

Appliance Mode of
Operation

Network / Network Context

When you use the Web Security appliance in a network that contains another proxy server, it is recommended
that you place the Web Security appliance downstream from the proxy server, closer to the clients.

Note

DescriptionProperty

Is there another proxy on your network, such that

traffic must pass through it? it will be upstream of the Web Security appliance?

If yes for both points, select the checkbox. This allows you to create a proxy
group for one upstream proxy. You can add more upstream proxies later.

Is there another web
proxy on your network?

A name used to identify the proxy group on the appliance.Proxy group name

The hostname or IP address of the upstream proxy server.Address
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DescriptionProperty

The port number of the upstream proxy server.Port

Related Topics

• Upstream Proxies, on page 24

Network / Cloud Connector Settings
Need to confirm page name and settings.

DescriptionSetting

The address of the Cloud Proxy Server (CPS), for example,
proxy1743.scansafe.net .

CloudWeb Security Proxy Servers

If AsyncOS fails to connect to a Cloud Web Security proxy, either
Connect directly to the Internet, or Drop requests.

Failure Handling

Method for authorizing transactions:

• Web Security Appliance public-facing IPv4 address.
• Authorization key included with each transaction. You can generate
an authorization key within the Cisco Cloud Web Security Portal.

CloudWeb Security Authorization
Scheme

Network / Network Interfaces and Wiring
The IP address, network mask, and host name to use to manage the Web Security appliance and, by default,
for proxy (data) traffic.

You can use the host name specified here when connecting to the appliance management interface (or in
browser proxy settings if M1 is used for proxy data), but you must register it in your organization’s DNS.

DescriptionSetting

(Optional) Check Use M1 port for management only if you want to use a
separate port for data traffic.

If you configure theM1 interface for management traffic only, youmust configure
the P1 interface for data traffic. You must also define different routes for
management and data traffic. However, you can configure the P1 interface even
when the M1 interface is used for both management and data traffic.

You can enable and configure the P1 port only in the System Setup Wizard. If
you want to enable the P2 interface, you must do this after finishing the System
Setup Wizard.

Ethernet Port

The IP address and network mask to use when managing the Web Security
appliance on this network interface.

IP Address / Netmask

The host name to use whenmanaging theWeb Security appliance on this network
interface.

Hostname
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Network / Layer 4 Traffic Monitor Wiring

DescriptionProperty

The type of wired connections plugged into the “T” interfaces:

• Duplex TAP. The T1 port receives both incoming and outgoing traffic.
• Simplex TAP. The T1 port receives outgoing traffic (from the clients to the
Internet) and the T2 port receives incoming traffic (from the Internet to the
clients).

Cisco recommends using Simplex when possible because it can increase
performance and security.

Layer-4 Traffic Monitor

Network / Routes for Management and Data Traffic

If you enable “Use M1 port for management only”, this section will have separate sections for management
and data traffic; otherwise one joint section will be shown.

Note

DescriptionProperty

The default gateway IP address to use for the traffic through the Management
and Data interfaces.

Default Gateway

Optional static routes for management and data traffic. Multiple routes can be
added.

• Name – A name used to identify the static route.
• Internal Network – The IPv4 address for this route’s destination on the
network.

• Internal Gateway – The gateway IPv4 address for this route. A route
gatewaymust reside on the same subnet as theManagement or Data interface
on which it is configured.

Static Routes Table

Network / Transparent Connection Settings

By default, the Cloud Connector is deployed in transparent mode. which requires a connection to a Layer-4
switch, or a version 2 WCCP router.

Note

DescriptionProperty

Specifies that the Web Security appliance is connected to a layer 4 switch for
transparent redirection, or that no transparent redirection device is used and clients
will explicitly forward requests to the appliance.

Layer-4 Switch or No
Device
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DescriptionProperty

Specifies that the Web Security appliance is connected to a version 2
WCCP-capable router.

If you connect the appliance to a version 2WCCP router, you must create at least
one WCCP service. You can enable the standard service on this screen, or after
the System SetupWizard is finished, where you can also create multiple dynamic
services.

When you enable the standard service, you can also enable router security and
enter a passphrase. The passphrase used here must be used all appliances and
WCCP routers within the same service group.

A standard service type (also known as the “web-cache” service) is assigned a
fixed ID of zero, a fixed redirection method (by destination port), and a fixed
destination port of 80.

A dynamic service type allows you to define a custom ID, port numbers, and
redirection and load balancing options.

WCCP v2 Router

Network /Administrative Settings

DescriptionProperty

The passphrase used to access the Web Security appliance for administrative
purposes.

Administrator Passphrase

The email address to which the appliance sends systems alerts.Email System Alerts To

The address and port for an SMTP relay host that AsyncOS can use to send system
generated email messages.

If no SMTP relay host is defined, AsyncOS uses the mail servers listed in the
MX record.

Send Email via SMTP
Relay Host (optional)

Specifies whether the appliance sends system alerts and weekly status reports to
Cisco Customer Support.

AutoSupport

Specifies whether to participate in the Cisco SensorBase Network. If you
participate, you can configure Limited or Standard (full) participation. Default
is Standard.

The SensorBase Network is a threat management database that tracks millions
of domains around the world andmaintains a global watch list for Internet traffic.
When you enable SensorBase Network Participation, theWeb Security appliance
sends anonymous statistics about HTTP requests to Cisco to increase the value
of SensorBase Network data.

SensorBase Network
Participation
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Security / Security Settings

DescriptionOption

Specifies whether to block or monitor all web traffic by default after the System
Setup Wizard completes. You can change this behavior later by editing the
Protocols and User Agents settings for the Global Access Policy. The default
setting is to monitor traffic.

Global Policy Default
Action

Specifies whether the Layer-4 Traffic Monitor should monitor or block suspected
malware by default after the System Setup Wizard completes. You can change
this behavior later. The default setting is to monitor traffic.

L4 Traffic Monitor

Specifies whether or not to enable Acceptable Use Controls.

If enabled, Acceptable Use Controls allow you to configure policies based on
URL filtering. They also provide application visibility and control, as well as
related options such as safe search enforcement. The default setting is enabled.

Acceptable Use Controls

Specifies whether or not to enableWeb Reputation filtering for the Global Policy
Group.

Web Reputation Filters is a security feature that analyzes web server behavior
and assigns a reputation score to a URL to determine the likelihood that it contains
URL-based malware. The default setting is enabled.

Reputation Filtering

Specifies whether to enable malware and spyware scanning using Webroot,
McAfee, or Sophos. The default setting is that all three options are enabled. Most
security services will be automatically enabled/disabled to match the services
normally available for cloud policies. Similarly, policy-related defaults will not
be applicable. At least one scanning option must be enabled.

If any option is enabled, also choose whether to monitor or block detected
malware. The default setting is to monitor malware.

You can further configure malware scanning after you finish the System Setup
Wizard.

Malware and Spyware
Scanning

Specifies whether or not to enable Cisco Data Security Filters.

If enabled, the Cisco Data Security Filters evaluate data leaving the network and
allow you to create Cisco Data Security Policies to block particular types of
upload requests. The default setting is enabled.

Cisco Data Security
Filtering

Upstream Proxies
The web proxy can forward web traffic directly to its destination web server or use routing policies to redirect
it to an external upstream proxy.

• Upstream Proxies Task Overview, on page 25
• Creating Proxy Groups for Upstream Proxies, on page 25
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Upstream Proxies Task Overview
More InformationTask

Connecting the Appliance, on page 14.• Connect the external proxy upstream of the Cisco
Web Security Appliance.

Creating Proxy Groups for Upstream Proxies, on
page 25.

• Create and configure a proxy group for the upstream
proxy.

Create Policies to Control Internet Requests, on
page 197

• Create a routing policy for the proxy group tomanage
which traffic is routed to the upstream proxy.

Creating Proxy Groups for Upstream Proxies

Step 1 Choose Network > Upstream Proxies.

Step 2 Click Add Group.
Step 3 Complete the Proxy Group settings.

DescriptionProperty

The name used to identify proxy groups on the appliance, such as in routing policies, for
example.

Name

The address, port and reconnection attempts (should a proxy not respond) for the proxy
servers in the group. Rows for each proxy server can be added or deleted as required.

You can enter the same proxy server multiple times to allow unequal load
distribution among the proxies in the proxy group.

Note

Proxy Servers

The strategy that the web proxy uses to load balance requests between multiple upstream
proxies. Choose from:

• None (failover). The Web Proxy directs transactions to one external proxy in the
group. It tries to connect to the proxies in the order they are listed. If one proxy
cannot be reached, the Web Proxy attempts to connect to the next one in the list.

• Fewest connections. The Web Proxy keeps track of how many active requests are
with the different proxies in the group and it directs a transaction to the proxy
currently servicing the fewest number of connections.

• Hash based. Least recently used. TheWeb Proxy directs a transaction to the proxy
that least recently received a transaction if all proxies are currently active. This
setting is similar to round robin except the Web Proxy also takes into account
transactions a proxy has received by being a member in a different proxy group.
That is, if a proxy is listed in multiple proxy groups, the “least recently used” option
is less likely to overburden that proxy.

• Round robin. The Web Proxy cycles transactions equally among all proxies in the
group in the listed order.

The Load Balancing option is dimmed until two or more proxies have been
defined.

Note

Load Balancing
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DescriptionProperty

Specifies the default action to take if all proxies in this group fail. Choose from:

• Connect directly. Send the requests directly to their destination servers.
• Drop requests. Discard the requests without forwarding them.

Failure Handling

Step 4 Submit and commit your changes.

What to do next

• Creating a Policy , on page 203

Network Interfaces
• IP Address Versions, on page 26
• Enabling or Changing Network Interfaces, on page 27

IP Address Versions
In Standard mode, Cisco Web Security Appliance supports IPv4 and IPv6 addresses in most cases.

In Cloud Connector mode, Cisco Web Security Appliance supports IPv4 only.Note

ADNS server may return a result with both an IPv4 and an IPv6 address. DNS settings include an IP Address
Version Preference to configure AsyncOS behavior in these cases.

NotesIPv6IPv4Interface/Service

Use of IPv6 addresses requires an IPv6
routing table that defines the default IPv6
gateway. Depending on the network, you
may also need to specify a static IPv6 route
in the routing table.

OptionalRequiredM1 interface

If the P1 interface has an IPv6 address
configured and the appliance uses split
routing (separate management and data
routes), then the P1 interface cannot use
the IPv6 gateway configured on the
Management route. Instead, specify an
IPv6 gateway for the Data routing table.

OptionalOptionalP1 interface

—OptionalOptionalP2 interface

—SupportedSupportedData services
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NotesIPv6IPv4Interface/Service

Images, for example custom logos on
end-user notification pages, require IPv4.

Partially SupportedSupportedControl and
Management
Services

—Not SupportedSupportedAnyConnect Secure
Mobility (MUS)

Related Topics

• Enabling or Changing Network Interfaces, on page 27
• DNS Settings, on page 43

Enabling or Changing Network Interfaces
• Add or modify interface IP addresses

• Change the Layer-4 Traffic Monitor wiring type

• Enable split routing of management and data traffic

Step 1 Choose Network > Interfaces.
Step 2 Click Edit Settings.
Step 3 Configure the Interface options.

DescriptionOption

Modify or add new IPv4 or IPv6 Address, Netmask, and Hostname details for the M1, P1, or P2
interfaces as required.

• M1 – AsyncOS requires an IPv4 address for the M1 (Management) port. In addition to the
IPv4 address, you can specify an IPv6 address. By default, the Management interface is
used to administer the appliance and Web Proxy (data) monitoring. However, you can
configure the M1 port for management use only.

• P1 andP2 – Use an IPv4 address, IPv6 address, or both for the Data ports. The Data interfaces
are used for Web Proxy monitoring and Layer-4 Traffic Monitor blocking (optional). You
can also configure these interfaces to support outbound services such as DNS, software
upgrades, NTP, and traceroute data traffic.

If the Management and Data interfaces are all configured, each must be assigned IP
addresses on different subnets.

Note

When split routing is enabled, the Management interface cannot communicate with
the Smart Licensing Portal. To register the Web Security Appliance with the Smart
Licensing Portal, choose a Data interface.

Note

Interfaces
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DescriptionOption

Check Restrict M1 port to appliance management services only to limit M1 to management
traffic only, requiring use of a separate port for data traffic.

When you use M1 for management traffic only, configure at least one data interface,
on another subnet, for proxy traffic. Define different routes for management and data
traffic.

Note

Separate Routing for
Management
Services

Enable/disable use of, and specify a default port number for, the following network protocols:

• FTP – Disabled by default.

• SSH

• HTTP

• HTTPS

Also, you can enable/disable redirection of HTTP traffic to HTTPS.

Appliance
Management
Services

Step 4 Submit and commit your changes.

What to do next

If you added an IPv6 address, add an IPv6 routing table.

Related Topics

• Connecting the Appliance, on page 14.

• IP Address Versions, on page 26

• Configuring TCP/IP Traffic Routes, on page 31

Configuring Failover Groups for High Availability
Using the Common Address Redundancy Protocol (CARP), the Web Security Appliances enable multiple
hosts on your network to share an IP address, providing IP redundancy to ensure high availability of services
provided by those hosts.

Failover is available only for the proxy service. The proxy automatically binds to the failover interface when
the failover group is created. Thus, if the proxy goes down for any reason, failover is triggered.

In CARP, there are three states for a host:

• primary - there can only be one primary host in each failover group

• backup

• init

The primary host in the CARP failover group sends regular advertisements to the local network so that the
back-up hosts know it is still alive. (This advertisement interval is configurable on the Web Security
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Appliances.) If the back-up hosts do not receive an advertisement from the primary for the specified period
of time (because the proxy is down, or the Web Security appliance has gone down, or it is disconnected from
the network), then failover is triggered and one of the backups will take over the duties of primary.

The advertisements from the primary Web Security appliances do not reach the remaining back-up hosts in
the following conditions:

• Network/Interface Unavailability

• OS Health and Availability

Disable Data-Plane IP Learning in the Application Centric Infrastructure (ACI)
to use the Web Security appliance High Availability feature.

Note

Add Failover Group

Before you begin

• Identify a virtual IP address that will be used exclusively for this failover group. Clients will use this IP
address to connect to the failover group in explicit forward proxy mode.

• Configure all Appliances in the failover group with identical values for the following parameters:

• Failover Group ID
• Hostname
• Virtual IP Address

• If you are configuring this feature on a virtual appliance, ensure that the virtual switch and the virtual
interfaces specific to each appliance are configured to use promiscuous mode. For more information, see
the documentation for your virtual hypervisor.

Step 1 Choose Network > High Availability.
Step 2 Click Add Failover Group.
Step 3 Enter a Failover Group ID in the range 1 to 255.
Step 4 (Optional) Enter a Description.
Step 5 Enter the Hostname, for example www.example.com.
Step 6 Enter the Virtual IP Address and Netmask, for example 10.0.0.3/24 (IPv4) or 2001:420:80:1::5/32 (IPv6).
Step 7 Choose an option from the Interface menu. The Select Interface Automatically option will select the interface based

on the IP address you provided.

If you do not select the Select Interface Automatically option, you must choose an interface in the same
subnet as the virtual IP address you provided.

Note

Step 8 Choose the priority. Click Primary to set the priority to 255. Alternatively, select Backup and enter a priority between
1 (lowest) and 254 in the Priority field.

Step 9 (Optional). To enable security for the service, select the Enable Security for Service check box and enter a string of
characters that will be used as a shared secret in the Shared Secret and Retype Shared Secret fields.

The shared secret, virtual IP, and failover group ID must be the same for all appliances in the failover group.Note
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Step 10 Enter the delay in seconds (1 to 255) between hosts advertising their availability in the Advertisement Interval field.
Step 11 Submit and commit your changes.

What to do next

Related Topics

• Failover Problems, on page 473

Edit High Availability Global Settings

Step 1 Choose Network > High Availability.
Step 2 In the High Availability Global Settings area, click Edit Settings.
Step 3 In the Failover Handling menu, choose an option.

• Preemptive—The highest priority host will assume control when available.

• Non-preemptive—The host in control will remain in control even if a higher priority host becomes available.

Step 4 Click Submit. Alternatively, click Cancel to abandon your changes.

View Status of Failover Groups
Choose Network > High Availability. The Failover Groups area displays the current fail-over group. You
can click Refresh Status to update the display. You can also view fail-over details by choosing Network >
Interfaces or Report > System Status.

Using the P2 Data Interface for Web Proxy Data
By default, the web proxy does not listen for requests on P2, even when enabled. However, you can configure
P2 to listen for web proxy data.

If you enable P2 to listen for client requests using the advancedproxyconfig > miscellaneousCLI command,
you can choose whether to use P1 or P2 for outgoing traffic. To use P1 for outgoing traffic, change the Default
Route for data traffic to specify the next IP address that the P1 interface is connected to.

Note

Before you begin

Enable P2 (you must also enable P1 if not already enabled) (see Enabling or Changing Network Interfaces,
on page 27).

Step 1 Access the CLI.
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Step 2 Use the advancedproxyconfig > miscellaneous commands to access the required area
example.com> advancedproxyconfig

Choose a parameter group:
- AUTHENTICATION - Authentication related parameters
- CACHING - Proxy Caching related parameters
- DNS - DNS related parameters
- EUN - EUN related parameters
- NATIVEFTP - Native FTP related parameters
- FTPOVERHTTP - FTP Over HTTP related parameters
- HTTPS - HTTPS related parameters
- SCANNING - Scanning related parameters
- PROXYCONN - Proxy connection header related parameters
- CUSTOMHEADERS - Manage custom request headers for specific domains
- MISCELLANEOUS - Miscellaneous proxy related parameters
- SOCKS - SOCKS Proxy parameters

Step 3 []> miscellaneous

Step 4 Press Enter past each question until the question:

Do you want proxy to listen on P2?

Enter ‘y’ for this question.

Step 5 Press Enter past the remaining questions.
Step 6 Commit your changes.

What to do next

Related Topics

• Connecting the Appliance, on page 14.
• Configuring TCP/IP Traffic Routes, on page 31.
• Configuring Transparent Redirection, on page 34

Configuring TCP/IP Traffic Routes
Routes are used for determining where to send (or route) network traffic. The Web Security appliance routes
the following kinds of traffic:

• Data traffic. Traffic the Web Proxy processes from end users browsing the web.

• Management traffic. Traffic created by managing the appliance through the web interface and traffic
the appliance creates for management services, such as AsyncOS upgrades, component updates, DNS,
authentication, and more.

By default, both types of traffic use the routes defined for all configured network interfaces. However, you
can choose to split the routing, so that management traffic uses a management routing table and data traffic
uses a data routing table. Both types of traffic split are split as follows:
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Data TrafficManagement Traffic

• HTTP

• HTTPS

• FTP

• WCCP negotiation

• DNS (configurable)

• Update/Upgrade/Feature Key
(configurable)

• WebUI

• SSH

• SNMP

• NTLM authentication (with domain
controller)

• ICAP request with external DLP server

• Syslogs

• FTP push

• DNS (configurable)

• Update/Upgrade/Feature Key
(configurable)

The number of sections on theNetwork >Routes page is determined by whether or not split routing is enabled:

• Separate route configuration sections for Management and Data traffic (split routing enabled).When
you use the Management interface for management traffic only (Restrict M1 port to appliance
management services only is enabled), then this page includes two sections to enter routes, one for
management traffic and one for data traffic.

• One route configuration section for all traffic (split routing not enabled).When you use theManagement
interface for both management and data traffic (Restrict M1 port to appliance management services
only is disabled), then this page includes one section to enter routes for all traffic that leaves the Web
Security appliance, both management and data traffic.

A route gatewaymust reside on the same subnet as theManagement or Data interface on which it is configured.
If multiple data ports are enabled, the web proxy sends out transactions on the data interface that is on the
same network as the default gateway configured for data traffic.

Note

Outbound Services Traffic
TheWeb Security appliance also uses the management and data interfaces to route outbound traffic for services
such as DNS, software upgrades, NTP, and traceroute data traffic.You configure this for each service
individually, by choosing the route it uses for outbound traffic. By default, the management interface is used
for all services.

Related Topics

• To enable split routing of management and data traffic, see Enabling or Changing Network Interfaces,
on page 27.
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Modifying the Default Route

Step 1 Choose Network > Routes.
Step 2 Click on Default Route in the Management or Data table as required (or the combined Management/Data table if split

routing is not enabled).
Step 3 In the Gateway column, enter the IP address of the computer system on the next hop of the network connected to the

network interface you are editing.
Step 4 Submit and commit your changes.

Adding a Route

Step 1 Choose Network > Routes.
Step 2 Click the Add Route button corresponding to the interface for which you are creating the route.
Step 3 Enter a Name, Destination Network, and Gateway.
Step 4 Submit and commit your changes.

Saving and Loading Routing Tables

Choose Network > Routes.

To save a route table, click Save Route Table and specify where to save the file.

To load a saved route table, click Load Route Table, navigate to the file, open it, and submit and commit your changes.

When the destination address is on the same subnet as one of the physical network interfaces, AsyncOS sends
data using the network interface with the same subnet. It does not consult the routing tables.

Note

Deleting a Route

Step 1 Choose Network > Routes.
Step 2 Check the checkbox in the Delete column for the appropriate route.
Step 3 Click Delete and confirm.

Step 4 Submit and commit your changes.

What to do next

Related Topics

• Enabling or Changing Network Interfaces, on page 27.
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Configuring Transparent Redirection
• Specifying a Transparent Redirection Device, on page 34
• Configuring WCCP Services, on page 35

Specifying a Transparent Redirection Device

Before you begin

Connect the appliance to a Layer-4 switch or a WCCP v2 router.

Step 1 Choose Network > Transparent Redirection.
Step 2 Click Edit Device.
Step 3 Choose the type of device that transparently redirects traffic to the appliance from the Type drop-down list: Layer 4

Switch or No Device or WCCP v2 Router.
Step 4 Submit and commit your changes.
Step 5 For WCCP v2 devices, complete these additional steps:

a) Configure the WCCP device using device documentation.
b) On the WSA’s Transparent Redirection page, click Add Service to add a WCCP service, as described in Adding and

Editing a WCCP Service, on page 36.
c) If IP spoofing is enabled on the appliance, create a second WCCP service.

What to do next

Related Topics

• Connecting the Appliance, on page 14.
• Configuring WCCP Services, on page 35.

Using An L4 Switch
If you are using a Layer 4 switch for transparent redirection, depending how it is configured, you may need
to configure a few additional options on the WSA.

• Generally, do not enable IP Spoofing; if you spoof upstream IP addresses youmay create an asynchronous
routing loop.

• On the Edit Web Proxy Settings page (Security Services > Web Proxy), check Enable Identification
of Client IP Addresses using X-Forwarded-For in the Use Received Headers section (Advanced
Settings). Then add one or more egress IP addresses to the Trusted Downstream Proxy or Load
Balancer list.

• Optionally, you can use the CLI command advancedproxyconfig > miscellaneous to configure the
following proxy-related parameters as necessary:

• Would you like proxy to respond to health checks from L4 switches (always enabled

if WSA is in L4 transparent mode)? – Enter Y if you want to allow the WSA to respond to
health checks.
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• Would you like proxy to perform dynamic adjustment of TCP receive window size? – Use
the default Y in most cases; enter N if you have another proxy device upstream of the WSA.

• Do you want to pass HTTP X-Forwarded-For headers? – No need unless there is a requirement
upstream for X-Forwarded-For (XFF) headers.

• Would you like proxy to log values from X-Forwarded-For headers in place of incoming

connection IP addresses? – To aid in troubleshooting, you can enter Y; client IP addresses will
be displayed in the access logs.

• Would you like the proxy to use client IP addresses from X-Forwarded-For headers?

Again, to aid policy configuration and reporting, you can enter Y.

• If you are using X-Forwarded-For (XFF) headers, add %f to the Access Logs subscription in order to log
the XFF headers. For the W3C Logs format, add cs(X-Forwarded-For).

Configuring WCCP Services
AWCCP service is an appliance configuration that defines a service group to a WCCP v2 router. It includes
information such as the service ID and ports used. Service groups allow a web proxy to establish connectivity
with a WCCP router and to handle redirected traffic from the router.

If WCCP proxy health checking is enabled, the WSA’s WCCP daemon sends a proxy health check message
(xmlrpc client request) to the xmlrpc server running on the Web proxy every 10 seconds. If the proxy is up
and running, the WCCP service receives a response from the proxy and the WSA sends a WCCP “here I am”
(HIA)message to the specifiedWCCP-enabled routers every 10 seconds. If theWCCP service doesn’t receive
a reply from the proxy, then HIA messages are not sent to the WCCP routers.

After a WCCP router misses three consecutive HIA messages, the router removes the WSA from its service
group and traffic is no longer forwarded to the WSA.

You can use the CLI command advancedproxyconfig > miscellaneous > Do you want to enable WCCP

proxy health check? to enable and disable the proxy health check messages; the health check is disabled
by default.

The WCCPv2 service works with the IPv4 and IPv6 networks. A maximum of 15 service groups can be
configured on a single appliance. Each service group on the WCCP router can contain up to 32 appliances.
The WCCPv2 service is also used for the Load Balancing mechanism to reduce content engine overloading
and data blocking.

Note

• About WCCP Load Balancing, on page 35
• Adding and Editing a WCCP Service, on page 36
• Creating WCCP Services for IP Spoofing, on page 39

About WCCP Load Balancing

The Assignment Weight parameter in the WCCP service definition is used to adjust the load on this WSA
when it is operating as member of a WCCP pool, or service group. This weighting represents the proportion
of total WCCP traffic that can be sent to this WSA for processing.

Assignment weighting adjustment is required only when different types of gateway appliances are members
of the same WCCP pool and you need to divert more of the traffic to the stronger appliances.
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AllWSAs that are members of aWCCP pool must be running a version of AsyncOS that supports assignment
weighting to benefit from WCCP load balancing.

Note

See Adding and Editing a WCCP Service, on page 36 for more information about the Assignment Weight
parameter.

Adding and Editing a WCCP Service

Before you begin

Configure the appliance to use aWCCP v2 Router (see Specifying a Transparent Redirection Device, on page
34).

Step 1 Choose Network > Transparent Redirection.
Step 2 ClickAdd Service, or, to edit a WCCP service, click the name of theWCCP service in the Service Profile Name column.
Step 3 Configure the WCCP options as described:

DescriptionWCCP Service Option

The name for the WCCP service.

If you leave this empty and choose a standard service (see below), the
name ‘web_cache’ is automatically assigned here.

Note

Service Profile Name
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DescriptionWCCP Service Option

The service group type for the router. Choose from:

Standard service. This service type is assigned a fixed ID of zero, a fixed redirection
method of by destination port, and a fixed destination port of 80. You can create one
standard service only. If a standard service already exists on the appliance, this option
is dimmed.

Dynamic service. This service type allows you to define a custom ID, port numbers,
and redirection and load balancing options. Enter the same parameters when creating
the service on the WCCP router as you entered for the dynamic service.

If you create a dynamic service, enter the following information:

• Service ID. You can enter any number from 0 to 255 in the Dynamic Service
ID field. However, note that you can configure no more than 15 service groups
on this appliance.

• Port number(s). Enter up to eight port numbers for traffic to redirect in the Port
Numbers field.

• Redirection basis. Choose to redirect traffic based on the source or destination
port. Default is destination port.

To configure Native FTPwith transparent redirection and IP spoofing,
choose Redirect based on source port (return path) and set the source
port to 13007.

Note

• Load balancing basis.When the network usesmultipleWeb Security appliances,
you can choose how to distribute packets among the appliances. You can
distribute packets based on the server or client address. When you choose client
address, packets from a client always get distributed to the same appliance.
Default is server address.

Service

The IPv4 or IPv6 address for one or more WCCP enabled routers. Use each router’s
unique IP; you cannot enter a multicast address. You cannot mix IPv4 and IPv6
addresses within a service group.

Router IP Addresses

Check Enable Security for Service to require a passphrase for this service group.
If enabled, every appliance and WCCP router that uses the service group must use
the same passphrase.

Provide and confirm the passphrase to use.

Router Security
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DescriptionWCCP Service Option

Load-Balancing Method. This determines how the router performs load balancing
of packets among multiple Web Security appliances. Choose from:

• Allow Mask Only.WCCP routers make decisions using hardware in the router.
This method can increase router performance over the hash method. Not all
WCCP routers support mask assignment, however. (IPv4 only.)

• Allow Hash Only. This method relies on a hash function to make redirection
decisions. This method can be less efficient than the mask method, but may be
the only option the router supports. (IPv4 and IPv6.)

• Allow Hash or Mask. Allows AsyncOS to negotiate a method with the router.
If the router supports mask, then AsyncOS uses masking, otherwise hashing is
used.

Mask Customization. If you select Allow Mask Only or Allow Hash or Mask, you
can customize the mask or specify the number of bits:

• Custom mask (max 6 bits). You can specify the mask. The web interface
displays the number of bits associated with the mask you provide. You can use
up to five bits for an IPv4 router, or six bits for an IPv6 router.

• System generated mask. You can let the system generate a mask for you.
Optionally, you can specify the number of bits for the system-generated mask,
between one and five bits.

Assignment Weight – The WCCP weighting for this WSA; valid values are zero to
255. This weighting represents the proportion of total traffic that can be sent to this
WSA for processing as member of a WCCP service group. A value of zero means
this WSA will be a part of the service group, but it will not receive any redirected
traffic from the router. See About WCCP Load Balancing, on page 35 for more
information.

Forwarding method.This is themethod bywhich redirected packets are transported
from the router to the web proxy.

Return Method. This is the method by which redirected packets are transported
from the web proxy to the router.

Advanced

Both the forwarding and return methods use one of the following method types:

• Layer 2 (L2). This redirects traffic at layer 2 by replacing the packet’s destination
MAC address with the MAC address of the target web proxy. The L2 method
operates at hardware level and typically offers the best performance. Not all
WCCP routers support L2 forwarding, however. In addition, WCCP routers
only allow L2 negotiation with a directly (physically) connected Web Security
appliance.

• Generic Routing Encapsulation (GRE). This method redirects traffic at layer
3 by encapsulating the IP packet with a GRE header and a redirect header. GRE
operates at software level, which can impact performance.

• L2 or GRE. With this option, the appliance uses the method that the router says
it supports. If both the router and appliance support L2 and GRE, the appliance
uses L2.

If the router is not directly connected to the appliance, you must choose GRE.
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Step 4 Submit and commit your changes.

Creating WCCP Services for IP Spoofing

Step 1 If you have enabled IP spoofing on the web proxy, create twoWCCP services. Create a standardWCCP service, or create
a dynamic WCCP service that redirects traffic based on destination ports.

Step 2 Create a dynamic WCCP service that redirects traffic based on source ports.

Use the same port numbers, router IP address, and router security settings as used for the service created in Step 1.

• Cisco suggests using a service ID number from 90 to 97 for the WCCP service used for the return path
(based on the source port).

Note

What to do next

Related Topics

• Web Proxy Cache, on page 67.

Increasing Interface Capacity Using VLANs
You can configure one or more VLANs to increase the number of networks the CiscoWeb Security Appliance
can connect to beyond the number of physical interfaces included.

VLANs appear as dynamic “Data Ports” labeled in the format of: “VLAN DDDD” where the “DDDD” is the
ID and is an integer up to 4 digits long (VLAN 2, or VLAN 4094 for example). AsyncOS supports up to 30
VLANs.

A physical port does not need an IP address configured in order to be in a VLAN. The physical port on which
a VLAN is created can have an IP that will receive non-VLAN traffic, so you can have both VLAN and
non-VLAN traffic on the same interface.

VLANs can only be created on the Management and P1 data ports.

Configuring and Managing VLANs
You can create, edit and delete VLANs via the etherconfig command. Once created, a VLAN can be
configured via the interfaceconfig command in the CLI.

Whenever you make changes to a VLAN configuration, ensure to reboot the appliance.Note

Example 1: Creating a New VLAN

In this example, two VLANs are created (named VLAN 31 and VLAN 34) on the P1 port:
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Do not create VLANs on the T1 or T2 interfaces.Note

Step 1 Access the CLI.
Step 2 Follow the steps shown.

example.com> etherconfig
Choose the operation you want to perform:
- MEDIA - View and edit ethernet media settings.
- VLAN - View and configure VLANs.
- MTU - View and configure MTU.
[]> vlan
VLAN interfaces:
Choose the operation you want to perform:
- NEW - Create a new VLAN.
[]> new
VLAN ID for the interface (Ex: "34"):
[]> 34
Enter the name or number of the ethernet interface you wish bind to:
1. Management
2. P1
3. T1
4. T2
[1]> 2
VLAN interfaces:
1. VLAN 34 (P1)
Choose the operation you want to perform:
- NEW - Create a new VLAN.
- EDIT - Edit a VLAN.
- DELETE - Delete a VLAN.
[]> new
VLAN ID for the interface (Ex: "34"):
[]> 31
Enter the name or number of the ethernet interface you wish bind to:
1. Management
2. P1
3. T1
4. T2
[1]> 2
VLAN interfaces:
1. VLAN 31 (P1)
2. VLAN 34 (P1)
Choose the operation you want to perform:
- NEW - Create a new VLAN.
- EDIT - Edit a VLAN.
- DELETE - Delete a VLAN.
[]>

Step 3 Commit your changes.

Example 2: Creating an IP Interface on a VLAN

In this example, a new IP interface is created on the VLAN 34 ethernet interface.
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Making changes to an interface may close your connection to the appliance.Note

Step 1 Access the CLI.
Step 2 Follow the steps shown:

example.com> interfaceconfig
Currently configured interfaces:
1. Management (10.10.1.10/24 on Management: example.com)
2. P1 (10.10.0.10 on P1: example.com)
Choose the operation you want to perform:
- NEW - Create a new interface.
- EDIT - Modify an interface.
- DELETE - Remove an interface.
[]> new
IP Address (Ex: 10.10.10.10):
[]> 10.10.31.10
Ethernet interface:
1. Management
2. P1
3. VLAN 31
4. VLAN 34
[1]> 4
Netmask (Ex: "255.255.255.0" or "0xffffff00"):
[255.255.255.0]>
Hostname:
[]> v.example.com
Currently configured interfaces:
1. Management (10.10.1.10/24 on Management: example.com)
2. P1 (10.10.0.10 on P1: example.com)
3. VLAN 34 (10.10.31.10 on VLAN 34: v.example.com)
Choose the operation you want to perform:
- NEW - Create a new interface.
- EDIT - Modify an interface.
- DELETE - Remove an interface.
[]>
example.com> commit

Step 3 Commit your changes.

What to do next

Related Topics

• Enabling or Changing Network Interfaces, on page 27.
• Configuring TCP/IP Traffic Routes, on page 31.

Redirect Hostname and System Hostname
After running the System Setup Wizard, the System Hostname and the Redirect Hostname are the same.
However, changing the system hostname using the sethostname command does not change the redirect
hostname. Therefore the settings may have different values.
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AsyncOS uses the redirect hostname for end-user notifications and acknowledgments.

The system hostname is the fully-qualified hostname used to identify the appliance in the following areas:

• The command line interface (CLI)
• System alerts
• When forming the machine NetBIOS name when the Web Security appliance joins an Active Directory
domain.

The system hostname does not correspond directly to interface hostnames and is not used by clients to connect
to the appliance.

Changing the Redirect Hostname

Step 1 In the web user interface, navigate to Network>Authentication.
Step 2 Click Edit Global Settings.
Step 3 Enter a new value for Redirect Hostname.

Changing the System Hostname

Step 1 Access the CLI.
Step 2 Use the sethostname command to change the name of the Web Security appliance:

example.com> sethostname

example.com> hostname.com

example.com> commit
...
hostname.com>

Step 3 Commit your changes.

Configuring SMTP Relay Host Settings
AsyncOS periodically sends system-generated email messages, such as notifications, alerts, and Cisco Customer
Support requests. By default, AsyncOS uses information listed in the MX record on your domain to send
email. However, if the appliance cannot directly reach the mail servers listed in the MX record, you must
configure at least one SMTP relay host on the appliance.

If the Web Security appliance cannot communicate with the mail servers listed in the MX record or any of
the configured SMTP relay hosts, it cannot send email messages and it writes a message in the log files.

Note
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You can configure one or more SMTP relay hosts. When you configure multiple SMTP relay hosts, AsyncOS
uses the topmost available SMTP relay host. If an SMTP relay host is unavailable, it tries to use the one below
it in the list.

Configuring an SMTP Relay Host

Step 1 Choose Network > Internal SMTP Relay.
Step 2 Click Edit Settings.
Step 3 Complete the Internal SMTP Relay settings.

DescriptionProperty

The hostname or IP address to use for the SMTP relayRelay Hostname or IP
Address

The port for connecting to the SMTP relay. If this property is left empty, the appliance
uses port 25.

Port

The routing table associated with an appliance network interface, either Management or
Data, to use for connecting to the SMTP relay. Choose whichever interface is on the same
network as the relay system.

Routing Table to Use for
SMTP

Step 4 (Optional) Click Add Row to add additional SMTP relay hosts.
Step 5 Submit and commit your changes.

DNS Settings
AsyncOS for Web can use the Internet root DNS servers or your own DNS servers. When using the Internet
root servers, you can specify alternate servers to use for specific domains. Since an alternate DNS server
applies to a single domain, it must be authoritative (provide definitive DNS records) for that domain.

You can also specify secondary DNS name servers to resolve the queries not resolved by the primary name
servers. Secondary DNS servers are not used as failover DNS servers. They are queried according to the
priority, when primary DNS servers return errors specified in Editing DNS Settings, on page 44.

• Split DNS, on page 43

• Clearing the DNS Cache, on page 44

• Editing DNS Settings, on page 44

Split DNS
AsyncOS supports split DNS where internal servers are configured for specific domains and external or root
DNS servers are configured for other domains. If you are using your own internal server, you can also specify
exception domains and associated DNS servers.
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Clearing the DNS Cache

Before you begin

Be aware that using this command might cause a temporary performance degradation while the cache is
repopulated.

Step 1 Choose Network > DNS.
Step 2 Click Clear DNS Cache.

Editing DNS Settings

Step 1 Choose Network > DNS

Step 2 Click Edit Settings.
Step 3 Configure the DNS settings as required.

DescriptionProperty

Use these DNS Servers. The local DNS server(s) that the appliance can use to resolve
hostnames.

Alternate DNS servers Overrides (Optional). Authoritative DNS servers for particular
domains

Use the Internet’s Root DNS Servers. You can choose to use the Internet root DNS
servers for domain name service lookups when the appliance does not have access to DNS
servers on your network.

Internet Root DNS servers will not resolve local hostnames. If you need the
appliance to resolve local hostnames you must use a local DNS server or add
the appropriate static entries to the local DNS using the Command Line
Interface.

Note

Primary DNS Servers

The secondary DNS server(s) that the appliance can use to resolve hostnames not resolved
by the primary name servers.

The secondary DNS servers receive host name queries when the primary DNS
servers return the following errors:

Note

• No Error, no answer section received.

• Server failed to complete request, no answer section.

• Name Error, no answer section received.

• Function not implemented.

• Server Refused to Answer Query.

Secondary DNS Servers
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DescriptionProperty

Specifies which interface the DNS service will route traffic through.Routing Table for DNS
Traffic

When a DNS server provides both an IPv4 and an IPv6 address, AsyncOS uses this
preference to choose the IP address version.

AsyncOS does not honor the version preference for transparent FTP requests.Note

IP Address Version
Preference

The wait time in seconds before timing out non-responsive reverse DNS lookups.Wait Before Timing out
Reverse DNS Lookups

A DNS domain search list used when a request is sent to a bare hostname (with no '.'
character). The domains specified will each be attempted in turn, in the order entered, to
see if a DNS match for the hostname plus domain can be found.

Domain Search List

Step 4 Submit and commit your changes.

What to do next

Related Topics

• Configuring TCP/IP Traffic Routes, on page 31

• IP Address Versions, on page 26

Troubleshooting Connect, Install, and Configure
• Failover Problems, on page 473
• Upstream Proxy Does Not Receive Basic Credentials, on page 492
• Client Requests Fail Upstream Proxy, on page 492
• Maximum Port Entries, on page 493
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C H A P T E R 3
Connect the Appliance to a Cisco Cloud Web
Security Proxy

This chapter contains the following sections:

• How to Configure and Use Features in Cloud Connector Mode , on page 47
• Deployment in Cloud Connector Mode , on page 47
• Configuring the Cloud Connector, on page 48
• Controlling Web Access Using Directory Groups in the Cloud, on page 51
• Bypassing the Cloud Proxy Server, on page 51
• Partial Support for FTP and HTTPS in Cloud Connector Mode , on page 51
• Preventing Loss of Secure Data, on page 52
• Viewing Group and User Names and IP Addresses , on page 52
• Subscribing to Cloud Connector Logs, on page 52
• Identification Profiles and Authentication with Cloud Web Security Connector , on page 53

How to Configure and Use Features in Cloud Connector Mode
Use of the features included in the Cloud Connector subset is the same as in standard mode, except as noted.
See Comparison of Modes of Operation, on page 10 for additional information.

This chapter links to locations within this documentation that provide information about some of the major
features of the Web Security Appliance that are common to both standard mode and Cloud Web Security
Connector mode.With the exception of Cloud Connector configuration settings and information about sending
directory groups to the cloud, relevant information is in other locations throughout this document.

This chapter includes information about configuring the Cloud Web Security Connector that is not applicable
in standard mode.

This document does not include information about the Cisco Cloud Web Security product. Cisco Cloud Web
Security documentation is available from
http://www.cisco.com/c/en/us/support/security/cloud-web-security/tsd-products-support-series-home.html

Deployment in Cloud Connector Mode
When you initially set up the appliance, you choose whether to deploy in Cloud Connector mode or standard
mode. You can also run the System Setup Wizard on an appliance that is currently deployed in standard mode
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to redeploy it in Cloud Connector mode, if you have the required licensing. Running the System SetupWizard
overwrites your existing configurations and deletes all existing data.

Deployment of the appliance is the same in both standard and Cloud Security mode except that on-site web
proxy services and Layer-4 TrafficMonitor services are not available in CloudWeb Security Connector mode.

You can deploy the Cloud Web Security Connector in either explicit forward mode or in transparent mode.

To modify Cloud Connector settings after initial setup, select Network > Cloud Connector.

Related Topics

• Connect, Install, and Configure, on page 9

Configuring the Cloud Connector
Before you begin

See Enabling Access to the Web Interface on Virtual Appliances , on page 5.

Step 1 Access the Web Interface for the Web Security Appliance:

Enter the IPv4 address of the Web Security appliance in an Internet browser.

The first time you run the System Setup Wizard, use the default IPv4 address:

https://192.168.42.42:8443

-or-

http://192.168.42.42:8080

where 192.168.42.42 is the default IPv4 address, and 8080 is the default admin port setting for HTTP, and 8443 is
default admin port for HTTPS.

Step 2 Select System Administration > System Setup Wizard.
Step 3 Accept the terms of the license agreement.
Step 4 Click Begin Setup.
Step 5 Configure system settings:

DescriptionSetting

The fully-qualified hostname for the Web Security appliance.Default System
Hostname

The Internet root DNS servers for domain name service lookups.

See also DNS Settings, on page 43.

DNS Server(s)

A server with which to synchronize the system clock. The default is time.ironport.com.NTP Server

Sets the time zone on the appliance so that timestamps in message headers and log files are
correct.

Time Zone

Step 6 Select Cloud Web Security Connector for the appliance mode.
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Step 7 Configure Cloud Connector settings:

DescriptionSetting

The address of the Cloud Proxy Server (CPS), for example, proxy1743.scansafe.net.Cloud Web Security
Proxy Servers

If AsyncOS fails to connect to a Cloud Web Security proxy, either Connect directly to the
Internet or Drop requests.

Failure Handling

Method for authorizing transactions:

• Web Security Appliance public facing IPv4 address

• Authorization key included with each transaction. You can generate an authorization
key within the Cisco Cloud Web Security Portal.

Cloud Web Security
Authorization Scheme

Step 8 Configure network interfaces and wiring:

DescriptionSetting

If you configure the M1 interface for management traffic only, you must configure the P1
interface for data traffic. However, you can configure the P1 interface even when the M1
interface is used for both management and data traffic.

Ethernet Port

The IPv4 address to use to manage the Web Security appliance.IP Address

The network mask to use when managing the Web Security appliance on this network
interface.

Network Mask

The hostname to use when managing the Web Security appliance on this network interface.Hostname

Step 9 Configure routes for Management and Data traffic:

DescriptionSetting

The default gateway IPv4 address to use for the traffic through theManagement and/or Data
interface.

Default Gateway

A name used to identify the static route.Name

The IPv4 address for this route’s destination on the network.Internal Network

The gateway IPv4 address for this route. A route gateway must reside on the same subnet
as the Management or Data interface on which it is configured.

Internal Gateway

Step 10 Configure transparent connection settings:

By default, the Cloud Connector is deployed in transparent mode. which requires a connection to a Layer-4
switch or a version 2 WCCP router.

Note
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DescriptionSetting

• The Web Security appliance is connected to a layer 4 switch.

or

• You will deploy the Cloud Connector in explicit forward mode.

Layer-4 Switch

or

No Device

The Web Security appliance is connected to a version 2 WCCP capable router.

Note: A passphrase can contain up to seven characters and is optional.

WCCP v2 Router

Step 11 Configure administrative settings:

DescriptionSetting

A passphrase to access the Web Security appliance. The passphrase must be six characters
or more.

Administrator Passphrase

An email address to which the appliance sends alerts.Email system alerts to

(Optional) A hostname or address for an SMTP relay host that AsyncOS uses for sending
system generated email messages.

The default SMTP relay host is the mail servers listed in the MX record.

The default port number is 25.

Send Email via SMTP
Relay Host

The appliance can send system alerts and weekly status report to Cisco Customer Support.AutoSupport

Step 12 Review and install:
a) Review the installation.
b) Click Previous to go back and make changes.
c) Click Install This Configuration to continue with the information you provided.

What to do next

Related Topics

• Preventing Loss of Secure Data, on page 52

• Network Interfaces, on page 26

• Configuring TCP/IP Traffic Routes, on page 31

• Configuring Transparent Redirection, on page 34

• Managing Alerts, on page 436

• Configuring an SMTP Relay Host, on page 43
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Controlling Web Access Using Directory Groups in the Cloud
You can use Cisco Cloud Web Security to control web access based on directory groups. When traffic to
Cisco Cloud Web Security is being routed through a Web Security Appliance in Cloud Connector mode,
Cisco Cloud Web Security needs to receive the directory-group information with the transactions from the
Cloud Connector so it can apply the group-based cloud policies.

Before you begin

Add an authentication realm to the Web Security Appliance configuration.

Step 1 Navigate to Network > Cloud Connector.
Step 2 In the Cloud Policy Directory Groups area, click Edit Groups.
Step 3 Select the User Groups andMachine Groups for which you have created Cloud Policies within Cisco CloudWeb Security.
Step 4 Click Add.
Step 5 Click Done and Commit your changes.

What to do next

Related information

• Authentication Realms, on page 94

Bypassing the Cloud Proxy Server
Cloud routing policies allow you to route web traffic to either Cisco Cloud Web Security proxies or directly
to the Internet based on these characteristics:

• Identification Profile
• Proxy Port
• Subnet
• URL Category
• User Agent

The process of creating cloud routing policies in Cloud Connector mode is identical to the process of creating
routing policies using the standard mode.

Related Topics

• Creating a Policy , on page 203

Partial Support for FTP and HTTPS in Cloud Connector Mode
The Web Security appliance in Cloud Connector mode does not fully support FTP or HTTPS.
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FTP

FTP is not supported by the Cloud Connector. AsyncOS drops native FTP traffic when the appliance is
configured for Cloud Connector.

FTP over HTTP is supported in Cloud Connector mode.

HTTPS

The Cloud Connector does not support decryption. It passes HTTPS traffic without decrypting.

Because the Cloud Connector does not support decryption, AsyncOS generally does not have access to
information in the client headers of HTTPS traffic. Therefore, AsyncOS generally cannot enforce routing
policies that rely on information in encrypted headers. This is always the case for transparent HTTPS
transactions. For example, for transparent HTTPS transactions, AsyncOS does not have access to the port
number in the HTTPS client header and therefore it cannot match a routing policy based on port number. In
this case, AsyncOS uses the default routing policy.

There are two exceptions for explicit HTTPS transactions. AsyncOS has access to the following information
for explicit HTTPS transactions:

• URL
• Destination port number

For explicit HTTPS transactions, it is possible to match a routing policy based on URL or port number.

Preventing Loss of Secure Data
You can integrate the Cloud Connector with external Data Loss Prevention servers through Network >
External DLP Servers.

Related Topics

• Prevent Loss of Sensitive Data, on page 291

Viewing Group and User Names and IP Addresses
To view the configured group names, user names, and IP addresses, go to whoami.scansafe.net.

Subscribing to Cloud Connector Logs
The Cloud Connector Logs provides useful information for troubleshooting problemswith the Cloud Connector,
for example, authenticated users and groups, the Cloud header, and the authorization key.

Step 1 Navigate to System Administration > Log Subscriptions.
Step 2 Select Cloud Connector Logs from the Log Type menu.
Step 3 Type a name in the Log Name field.
Step 4 Set the log level.
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Step 5 Submit and Commit your changes.

What to do next

Related Topics

• Monitor System Activity Through Logs, on page 359

Identification Profiles and Authentication with Cloud Web
Security Connector

The Cloud Web Security Connector supports basic authentication and NTLM. You can also bypass
authentication for certain destinations.

In Cloud Connector mode, using an Active Directory realm, you can identify transaction requests as originating
from specific machines. The Machine ID service is not available in standard mode.

With two exceptions, Authentication works the same throughout the Web Security Appliance, whether in
standard configuration or Cloud Connector configuration. Exceptions:

• The Machine ID service is not available in standard mode.
• AsyncOS does not support Kerberos when the appliance is configured in Cloud Connector mode.

Identification Profiles based on User Agent or Destination URL are not supported for HTTPS traffic.Note

Related Topics

• Identifying Machines for Policy Application, on page 53
• Guest Access for Unauthenticated Users, on page 54
• Classify End-Users for Policy Application, on page 123
• Acquire End-User Credentials, on page 83

Identifying Machines for Policy Application
By enabling the Machine ID service, AsyncOS can apply policies based on the machine that made the
transaction request rather than the authenticated user or IP address or some other identifier. AsyncOS uses
NetBIOS to acquire the machine ID.

Be aware that the machine identity service is only available through Active Directory realms. If you do not
have an Active Directory realm configured, this service is disabled.

Note

Step 1 Select Network > Machine ID Service.
Step 2 Click Enable and Edit Settings.
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Step 3 Configure Machine Identification settings:

DescriptionSetting

Select to enable the machine identification service.Enable NetBIOS for Machine
Identification

The Active Directory realm to use to identify the machine that is initiating the
transaction request.

Realm

If AsyncOS cannot identify the machine, should it drop the transaction or continue
with policy matching?

Failure Handling

Step 4 Submit and Commit your changes.

Guest Access for Unauthenticated Users
If the Web Security appliance is configured to provide guest access for unauthenticated users, in Cloud
Connector mode, AsyncOS assigns guest users to the group, __GUEST_GROUP__, and sends that information
to Cisco CloudWeb Security. Use Identities to provide guest access to unauthenticated users. Use Cisco Cloud
Web Security policies to control these guest users.

Related Topics

• Granting Guest Access After Failed Authentication, on page 116
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C H A P T E R 4
Connect the Appliance to Cisco Defense
Orchestrator

This chapter contains the following sections:

• Overview of Cisco Defense Orchestrator Integration, on page 55
• How to Configure and Use Features in Cisco Defense Orchestrator Mode, on page 55
• Deployment in Cisco Defense Orchestrator Mode, on page 56
• Disabling Cisco Defense Orchestrator, on page 60
• Enabling Cisco Defense Orchestrator, on page 60
• Cisco Defense Orchestrator Reporting, on page 61
• Troubleshooting Cisco Defense Orchestrator Mode Issues, on page 61

Overview of Cisco Defense Orchestrator Integration
The Cisco Defense Orchestrator is a cloud-based platform that helps network operations staff establish and
maintain an end-to-end security posture by managing security policies across Cisco security devices. You can
connect your appliances with Cisco Defense Orchestrator and analyze security policy configuration of your
appliances to identify and resolve policy inconsistencies, model policy changes to validate their impact, and
orchestrate policy changes to achieve consistency and maintain clarity in security posture.

How to Configure and Use Features in Cisco Defense
Orchestrator Mode

Use of the features included in the Cisco Defense Orchestrator subset is the same as in standard mode, except
as noted. See Configuration Changes and Constraints in Cisco Defense Orchestrator Mode, on page 56 for
additional information.

This chapter links to locations within this documentation that provide information about some of the major
features of theWeb Security Appliance that are common to both standardmode and Cisco Defense Orchestrator
mode.

This chapter also includes information about configuring Cisco Defense Orchestrator that is not applicable
in standard mode.
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This document does not include information about Cisco Defense Orchestrator. Cisco Defense Orchestrator
documentation is available from https://docs.defenseorchestrator.com.

Deployment in Cisco Defense Orchestrator Mode
Depending on your requirements, you can use one of the following methods to configure your appliance in
Cisco Defense Orchestrator mode:

• Using System Setup Wizard. Use this option when you have a new appliance. Choose the Cisco Defense
Orchestrator mode of operation while running the System SetupWizard. For instructions, see Configuring
Your Appliance in Cisco Defense Orchestrator Mode Using System Setup Wizard, on page 57.

• Using the Cisco Defense Orchestrator Settings page in the web interface. Use this option if you have
an existing device in the standard mode and have existing policies. You will be able to manage these
policies using the Cisco Defense Orchestrator. For instructions, see Configuring Your Standard Mode
Appliance in Cisco Defense Orchestrator Mode Using the Web Interface, on page 59.

Configuration Changes and Constraints in Cisco Defense Orchestrator Mode
This section specifies the configuration changes that will occur in your Web Security Appliance after
on-boarding it to the Cisco Defense Orchestrator. It also specifies configurable options and constraints.

There are no limitations in the web interface other than what is specified below. Authentication is not supported
from the Cisco Defense Orchestrator.

Note

Constraints in the Web Security Appliance after on-boarding:

In the appliance, you will not be able to configure the features that are administered through the Cisco Defense
Orchestrator. Configurations for these features are migrated to the Cisco Defense Orchestrator when the
appliance is on-boarded. All other configuration settings in the appliance are set to default settings.

Barring features administered through the Cisco Defense Orchestrator, all other features will be available in
your appliance.

After on-boarding, Access Policies are controlled through Cisco Defense Orchestrator. Exceptions are specified
below. You can configure the following Access Policies features only in the Web Security Appliance:

• Access Policies- Policy Definitions

• Protocols and User Agents

• Anti-Malware and Reputation

• Custom URL Categories (External Live Feed Category)

You can configure the following features only in the Cisco Defense Orchestrator:

• Custom URL Categories (Local Custom Category)

• URL Filtering, Applications, and Objects (except size and custom MIME type)
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• Global and non global access policies

• Access Policies support:

• Adding multiple access policies is supported.

• Adding, reordering, deleting access policies is supported.

• URL filtering (Predefined URL Category Filtering), applications, and objects (object types), with
the following limitations:

• Bandwidth limits for applications and application-types is not supported.

• For archived objects, inspect is not supported.

• Advanced membership definitions for access policies and identities are not supported.

• Range Request Forwarding is not supported.

• Time and volume quota management is not supported.

• Safe Search, Referred Exceptions, Site Content Rating are not supported for URLs

If reporting through Cisco Defense Orchestrator is enabled:

• Summarized reports in the Cisco Defense Orchestrator will be available.

• Reporting will also be available in the Web Security Appliance.

• Reporting will not be available in the Security Management Appliance.

Configuring Your Appliance in Cisco Defense Orchestrator Mode Using System
Setup Wizard

You can configure your new appliance in Cisco Defense Orchestrator mode while installing it, using the
System Setup Wizard.

Before you begin

See Configuration Changes and Constraints in Cisco Defense Orchestrator Mode, on page 56 to know more
about the configuration changes that will occur in your Web Security Appliance after on-boarding it to the
Cisco Defense Orchestrator.

Step 1 Open a browser and enter the IP address of the Web Security appliance. Use the default IP address when you run the
System Setup Wizard for the first time:

https://192.168.42.42:8443

-or-

http://192.168.42.42:8080

Where 192.168.42.42 is the default IP address, and 8080 is the default admin port setting for HTTP, and 8443 is default
admin port for HTTPS.

Otherwise, if the appliance is currently configured, use the IP address of the M1 port.
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Step 2 When the appliance login screen appears, enter the username and passphrase to access the appliance. By default, the
appliance ships with the following username and passphrase:

• Username: admin

• Passphrase: ironport

Step 3 Select System Administration > System Setup Wizard.
Step 4 Accept the terms of the license agreement.
Step 5 Click Begin Setup.
Step 6 Select Cisco Defense Orchestrator for the appliance mode.
Step 7 Configure all settings using the reference tables provided in the following sections as required. See System Setup

Wizard Reference Information, on page 19, page 2-11.
Step 8 Review and install:

a) Review the installation.
b) Click Previous to go back and make changes.
c) Click Install This Configuration to continue with the information you provided.

Depending on the IP address, hostname, or DNS settings you configured during setup, you may lose connection to the
appliance at this stage. If a “page not found” error is displayed in your browser, change the URL to reflect any new
address settings and reload the page. Enter your credentials if prompted.

Step 9 ClickCisco Defense Orchestrator Portal. The portal opens in a newwindow or tab, according to your browser settings.
Step 10 On the Cisco Defense Orchestrator portal, perform the following steps:

a) Log in to the Cisco Defense Orchestrator portal.
b) On-board the Web Security Appliance in the portal.
c) Copy the registration token (key).

Step 11 Complete the Cisco Defense Orchestrator registration on your Web Security Appliance. Perform the following steps:
a) Select Network > Cisco Defense Orchestrator.
b) Enter the registration token (key) and click Register.
c) A success message displays after successful registration.

After you perform this step, any Content Security Management Appliance used for policy enforcement will
be unable to effect policy changes in the Cisco Web Security Appliance.

Note

What to do next

• (Optional) Configure your appliance to send reports to Cisco Defense Orchestrator. See How to Enable
Cisco Defense Orchestrator Reporting, on page 61.

• Configure access policies in Cisco Defense Orchestrator. See https://docs.defenseorchestrator.com/.

Related Topics
Troubleshooting Cisco Defense Orchestrator Mode Issues, on page 61
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Configuring Your Standard Mode Appliance in Cisco Defense Orchestrator
Mode Using the Web Interface

Use this procedure if you have existing policies on your appliance and you want to manage these policies
using Cisco Defense Orchestrator.

Before you begin

See Configuration Changes and Constraints in Cisco Defense Orchestrator Mode, on page 56 to know more
about the configuration changes that will occur in your Web Security Appliance after on-boarding it to the
Cisco Defense Orchestrator.

Step 1 Select Network > Cisco Defense Orchestrator.
Step 2 Under Cisco Defense Orchestrator Settings, click Edit Settings.
Step 3 Select Enable and click Submit.
Step 4 Commit your changes.

After you perform this step, any Content Security Management Appliance used for policy enforcement will be
unable to effect policy changes in the Cisco Web Security Appliance.

Note

Step 5 ClickCisco Defense Orchestrator Portal. The portal opens in a new window or tab, according to your browser settings.
Step 6 On the Cisco Defense Orchestrator portal, perform the following steps:

a) Log in to the Cisco Defense Orchestrator portal.
b) On-board the Web Security Appliance in the portal.
c) Copy the registration token (key).

Step 7 Complete the Cisco Defense Orchestrator registration on your Web Security Appliance. Perform the following steps:
a) Select Network > Cisco Defense Orchestrator.
b) Enter the registration token (key) and click Register.
c) A success message displays after successful registration.

What to do next

• (Optional) Configure your appliance to send reports to Cisco Defense Orchestrator. See How to Enable
Cisco Defense Orchestrator Reporting, on page 61.

• Analyze your appliance's access policies on Cisco Defense Orchestrator. See
https://docs.defenseorchestrator.com/.

Related Topics
Troubleshooting Cisco Defense Orchestrator Mode Issues, on page 61
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Disabling Cisco Defense Orchestrator
Before you begin

After disabling Cisco Defense Orchestrator, if you need to enable it, you will have to regenerate the registration
token (key) from the Cisco Defense Orchestrator portal, and on-board the appliance again. See Enabling Cisco
Defense Orchestrator, on page 60.

Step 1 Select Network > Cisco Defense Orchestrator.
Step 2 Click Edit Settings.
Step 3 Uncheck Enable.
Step 4 Submit and commit the change.

Enabling Cisco Defense Orchestrator
Before you begin

Ensure you have connectivity to the Cisco Defense Orchestrator portal.

Step 1 Select Network > Cisco Defense Orchestrator.
Step 2 Click Edit Settings.
Step 3 Check Enable.
Step 4 Submit and commit the change.
Step 5 ClickCisco Defense Orchestrator Portal. The portal opens in a new window or tab, according to your browser settings.
Step 6 On the Cisco Defense Orchestrator portal, perform the following steps:

a) Log in to the Cisco Defense Orchestrator portal.
b) On-board the Web Security Appliance in the portal.
c) Copy the registration token (key).

Step 7 Complete the Cisco Defense Orchestrator registration on your Web Security Appliance. Perform the following steps:
a) Navigate to the Cisco Defense Orchestrator Registration section.
b) Enter the registration token (key) and click Register.
c) A success message displays after successful registration.

After you perform this step, any Content Security Management Appliance used for policy enforcement will be
unable to effect policy changes in the Cisco Web Security Appliance.

Note
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Cisco Defense Orchestrator Reporting
After deploying your appliance in Cisco Defense Orchestrator mode, you can configure your appliance to
send reports to Cisco Defense Orchestrator.

To enable Cisco Defense Orchestrator reporting, see How to Enable Cisco Defense Orchestrator Reporting,
on page 61. You will not be able to view and manage your report data on Security Management Appliance
also.

How to Enable Cisco Defense Orchestrator Reporting

Before you begin

Deploy your appliance in Cisco Defense Orchestrator mode. For instructions, see Deployment in Cisco Defense
Orchestrator Mode, on page 56.

Step 1 Select Security Services > Reporting and click Edit Settings.
Step 2 Select Local Reporting.
Step 3 Select Cisco Defense Orchestrator Reporting.
Step 4 Submit and commit your changes.

Once you enable Cisco Defense Orchestrator reporting, centralized reporting using Security Management
appliance will no longer work. However, you can continue to use AdvancedWeb Security Reporting application
for centralized reporting.

Note

What to do next

View your appliance's summary reports on Cisco Defense Orchestrator. See
https://docs.defenseorchestrator.com/.

Troubleshooting Cisco Defense Orchestrator Mode Issues

Unable to Register Cisco Defense Orchestrator
After enabling Cisco Defense Orchestrator mode on your appliance, if you are unable to register Cisco Defense
Orchestrator, do the following:

Step 1 Make sure that the registration key obtained from the Cisco Defense Orchestrator portal is correct.
Step 2 Make sure that the registration key obtained from the Cisco Defense Orchestrator portal is valid.
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If the registration key has expired, generate a new registration key on Cisco Defense Orchestrator. For more information,
see https://docs.defenseorchestrator.com.

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
62

Connect the Appliance to Cisco Defense Orchestrator
Unable to Register Cisco Defense Orchestrator

https://docs.defenseorchestrator.com


C H A P T E R 5
Intercepting Web Requests

This chapter contains the following sections:

• Overview of Intercepting Web Requests, on page 63
• Tasks for Intercepting Web Requests, on page 63
• Best Practices for Intercepting Web Requests, on page 64
• Web Proxy Options for Intercepting Web Requests, on page 65
• Domain Map, on page 73
• Client Options for Redirecting Web Requests, on page 75
• Using PAC Files with Client Applications, on page 75
• FTP Proxy Services, on page 78
• SOCKS Proxy Services, on page 79
• Troubleshooting Intercepting Requests, on page 82

Overview of Intercepting Web Requests
The Web Security appliance intercepts requests that are forwarded to it by clients or other devices over the
network.

The appliance works in conjunction with other network devices to intercept traffic. These may be ordinary
switches, transparent redirection devices network taps,and other proxy servers or Web Security appliances.

Tasks for Intercepting Web Requests
Links to Related Topics and ProceduresTaskSteps

• Best Practices for Intercepting Web
Requests, on page 64

Review best practices.Step 1
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Links to Related Topics and ProceduresTaskSteps

• Upstream Proxies, on page 24
• Network Interfaces, on page 26
• Configuring Transparent Redirection, on
page 34

• Configuring TCP/IP Traffic Routes, on
page 31

• Increasing Interface Capacity Using
VLANs, on page 39

(Optional) Perform follow up networking
tasks:

• Connect and configure upstream proxies.
• Configure network interface ports.
• Configure transparent redirection
devices.

• Configure TCP/IP routes.
• Configure VLANs.

Step 2

• Web Proxy Options for InterceptingWeb
Requests, on page 65

• Configuring Web Proxy Settings, on
page 65

• Web Proxy Options for InterceptingWeb
Requests, on page 65

• Web Proxy Cache, on page 67
• Web Proxy IP Spoofing, on page 70
• Web Proxy Bypassing, on page 72

(Optional) Perform follow up Web Proxy
tasks:

• Configure the web proxy to operate in
either Forward or Transparent mode.

• Decide if additional services are needed
for the protocol types you want to
intercept

• Configure IP spoofing.
• Manage the web proxy cache.
• Use custom web request headers.
• Bypass the proxy for some requests.

Step 3

• Client Options for Redirecting Web
Requests, on page 75

• Using PAC Files with Client
Applications, on page 75

Perform client tasks:

• Decide how clients should redirect
requests to the web proxy.

• Configure clients and client resources.

Step 4

• FTP Proxy Services, on page 78(Optional) Enable and Configure the FTP
proxy.

Step 5

Best Practices for Intercepting Web Requests
• Enable only the proxy services you require.
• Use the same forwarding and return method (either L2 or GRE) for all WCCP services defined in the
Web Security appliance. This allows the proxy bypass list to work consistently.

• Ensure that users cannot access PAC files from outside the corporate network. This allows your mobile
workers to use the web proxy when they are on the corporate network and to connect directly to web
servers at other times.

• Allow a web proxy to accept X-Forwarded-For headers from trustworthy downstream proxies or load
balancers only.

• Leave the web proxy in the default transparent mode, even if initially using only explicit forwarding.
Transparent mode also accepts explicitly forwarded requests.
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Web Proxy Options for Intercepting Web Requests
By itself, the Web Proxy can intercept web requests that use HTTP (including FTP over HTTP) and HTTPS.
Additional proxy modules are available to enhance protocol management:

• FTP Proxy. The FTP Proxy allows the interception of native FTP traffic (rather than just FTP traffic
that has been encoded within HTTP).

• HTTPS Proxy. The HTTPS proxy supports the decryption of HTTPS traffic and allows the web proxy
to pass unencrypted HTTPS requests on to policies for content analysis.

When in transparent mode, the Web Proxy drops all transparently redirected HTTPS requests if the HTTPS
proxy is not enabled. No log entries are created for dropped transparently redirected HTTPS requests.

Note

• SOCKS Proxy. The SOCKS proxy allows the interception of SOCKS traffic.

Each of these additional proxies requires the Web Proxy in order to function.You cannot enable them if you
disable the Web Proxy.

The Web proxy is enabled by default. All other proxies are disabled by default.Note

Related Topics

• FTP Proxy Services, on page 78
• SOCKS Proxy Services, on page 79

Configuring Web Proxy Settings

Before you begin

Enable the web proxy.

Step 1 Choose Security Services > Web Proxy.
Step 2 Click Edit Settings.
Step 3 Configure the basic web proxy settings as required.

DescriptionProperty

The ports that the web Proxy will listen on for HTTP connectionsHTTP Ports to Proxy

Specifies whether to enable or disable Web Proxy caching.

The web proxy caches data to increase performance.

Caching
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DescriptionProperty

• Transparent (Recommended) — Allow the web proxy to name the internet target. The
web proxy can intercept both transparent and explicitly forwarded web requests in this
mode.

• Forward —Allow the client browser to name the internet target. Requires individual
configuration of each web browser to use the web proxy. The web proxy can intercept
only explicitly forwarded web requests in this mode.

Proxy Mode

• IP Spoofing disabled — The web proxy changes the request source IP address to match
its own address to increase security.

• IP Spoofing enabled — The web proxy retains the source address so that it appears to
originate from the source client rather than from the Web Security appliance.

IP Spoofing

Step 4 Complete the advanced web proxy settings as required.

DescriptionProperty

The maximum time in seconds the web proxy keeps open a connection to a client or server
after a transaction has been completed and no further activity is detected.

• Client side. The timeout value for connections to clients.
• Server side. The timeout value for connections to servers.

If you increase these values connections will remain open longer and reduce the overhead used
to open and close connections repeatedly. However, you also reduce the ability of the Web
Proxy to open new connections if the maximum number of simultaneous persistent connections
has been reached.

Cisco recommends keeping the default values.

Persistent Connection
Timeout

The maximum time in seconds that the web proxy waits for more data from an idle client or
server when the current transaction has not yet been completed.

• Client side. The timeout value for connections to clients.
• Server side. The timeout value for connections to servers.

In-Use Connection
Timeout

The maximum number of connections (sockets) the Web Proxy keeps open with servers.Simultaneous Persistent
Connections (Server
Maximum Number)
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DescriptionProperty

Generate and add headers that encode information about the request.

• X-Forwarded-For headers encode the IP address of the client from which an HTTP
request originated.

Note • To turn header forwarding on or off, use the CLI advancedproxyconfig
command, Miscellaneous option, “Do you want to pass HTTP
X-Forwarded-For headers?”

• Using an explicit forward upstream proxy to manage user authentication
or access control with proxy authentication requires forwarding of these
headers.

• For transparent HTTPS requests, the appliance does not decrypt the XFF
header. For explicit requests, the appliance uses the XFF header received
in the CONNECT request, and does not decrypt the XFF inside the SSL
tunnel, so identification of client IP Addresses using X-Forwarded-For is
not applicable for HTTPS transparent requests.

• Request Side VIA headers encode the proxies through which the request passed on its
way from the client to the server.

• Response Side VIA headers encode the proxies through which the request passed on its
way from the server to the client.

Generate Headers

Allows aWeb proxy deployed as an upstream proxy to identify clients using X-Forwarded-For
headers send by downstream proxies. The Web Proxy will not accept the IP address in a
X-Forwarded-For header from a source that is not included in this list.

If enabled, requires the IP address of a downstream proxy or load balancer (you cannot enter
subnets or host names).

Use Received Headers

Use the Enable Range Request Forwarding checkbox to enable or disable forwarding of
range requests. Refer to Managing Access to Web Applications, on page 281 for more
information.

Range Request
Forwarding

Step 5 Submit and commit your changes.

What to do next

• Web Proxy Cache, on page 67
• Configuring Transparent Redirection, on page 34

Web Proxy Cache
The web proxy caches data to increase performance. AsyncOS includes defined caching modes that range
from safe to aggressive, and also allows customized caching. You can also exclude specific URLs from being
cached, either by removing them from the cache, or by configuring the cache to ignore them.
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Clearing the Web Proxy Cache

Step 1 Choose Security Services > Web Proxy.
Step 2 Click Clear Cache and confirm your action.

Removing URLs from the Web Proxy Cache

Step 1 Access the CLI.
Step 2 Use the webcache > evict commands to access the required caching area:

example.com> webcache
Choose the operation you want to perform:
- EVICT - Remove URL from the cache
- DESCRIBE - Describe URL cache status
- IGNORE - Configure domains and URLs never to be cached
[]> evict
Enter the URL to be removed from the cache.
[]>

Step 3 Enter the URL to be removed from the cache.

If you do not include a protocol in the URL, http://will be prepended to it (e.g., www.cisco.comwill become
http://www.cisco.com )

Note

Specifying Domains or URLs that the Web Proxy never Caches

Step 1 Access the CLI.
Step 2 Use the webcache -> ignore commands to access the required submenus:

example.com> webcache
Choose the operation you want to perform:
- EVICT - Remove URL from the cache
- DESCRIBE - Describe URL cache status
- IGNORE - Configure domains and URLs never to be cached
[]> ignore
Choose the operation you want to perform:
- DOMAINS - Manage domains
- URLS - Manage urls
[]>

Step 3 Enter the address type you wish to manage: DOMAINS or URLS.

[]> urls
Manage url entries:
Choose the operation you want to perform:
- DELETE - Delete entries
- ADD - Add new entries
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- LIST - List entries
[]>

Step 4 Enter add to add new entries:

[]> add
Enter new url values; one on each line; an empty line to finish
[]>

Step 5 Enter domains or URLs, one per line; for example:

Enter new url values; one on each line; an empty line to finish
[]> www.example1.com
Enter new url values; one on each line; an empty line to finish
[]>

You can include certain regular expression (regex) characters when specifying a domain or URLs. With the DOMAINS
option, you can use a preceding dot character to exempt an entire domain and its subdomains from caching. For example,
you can enter .google.com rather than simply google.com to exempt www.google.com, docs.google.com, and so on.

With the URLS option, you can use the full suite of regular-expression characters. See Regular Expressions, on page 178
for more information about using regular expressions.

Step 6 When you are finished entering values, press Enter until you are returned to the main command-line interface.
Step 7 Commit your changes.

Choosing The Web Proxy Cache Mode

Step 1 Access the CLI.
Step 2 Use the advancedproxyconfig -> caching commands to access the required submenus:

example.com> advancedproxyconfig
Choose a parameter group:
- AUTHENTICATION - Authentication related parameters
- CACHING - Proxy Caching related parameters
- DNS - DNS related parameters
- EUN - EUN related parameters
- NATIVEFTP - Native FTP related parameters
- FTPOVERHTTP - FTP Over HTTP related parameters
- HTTPS - HTTPS related parameters
- SCANNING - Scanning related parameters
- PROXYCONN - Proxy connection header related parameters
- CUSTOMHEADERS - Manage custom request headers for specific domains
- MISCELLANEOUS - Miscellaneous proxy related parameters
- SOCKS - SOCKS Proxy parameters
[]> caching
Enter values for the caching options:
The following predefined choices exist for configuring advanced caching
options:
1. Safe Mode
2. Optimized Mode
3. Aggressive Mode
4. Customized Mode
Please select from one of the above choices:
[2]>

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
69

Intercepting Web Requests
Choosing The Web Proxy Cache Mode



Step 3 Enter a number corresponding to the web proxy cache settings you require:

DescriptionModeEntry

The least caching and the most adherence to RFC #2616 compared to the other
modes.

Safe1

Moderate caching and moderate adherence to RFC #2616. Compared to safe mode,
in optimized mode theWeb Proxy caches objects when no caching time is specified
when a Last-Modified header is present. TheWeb Proxy caches negative responses.

Optimized2

The most caching and the least adherence to RFC #2616. Compared to optimized
mode, aggressivemode caches authenticated content, ETagmismatches, and content
without a Last-Modified header. The Web Proxy ignores the no-cache parameter.

Aggressive3

Configure each parameter individually.Customized mode4

Step 4 If you chose option 4 (Customized mode), enter values (or leave at the default values) for each of the custom settings.
Step 5 Press Enter until you return to the main command interface.
Step 6 Commit your changes.

What to do next

Related Topics

• Web Proxy Cache, on page 67.

Web Proxy IP Spoofing
When the web proxy forwards a request, it changes the request source IP address to match its own address
by default. This increases security, but you can change this behavior by implementing IP spoofing, so that
requests retain their source address and appear to originate from the source client rather than from the Web
Security appliance.

IP spoofing works for transparent and explicitly forwarded traffic. When the Web Proxy is deployed in
transparent mode, you have the choice to enable IP spoofing for transparently redirected connections only or
for all connections (transparently redirected and explicitly forwarded). If explicitly forwarded connections
use IP spoofing, you should ensure that you have appropriate network devices to route return packets back to
the Web Security appliance.

When IP spoofing is enabled and the appliance is connected to aWCCP router, you must configure twoWCCP
services: one based on source ports and one based on destination ports.

Related Topics

• Configuring Web Proxy Settings, on page 65

• Configuring WCCP Services, on page 35
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Web Proxy Custom Headers
You can add custom headers to specific outgoing transactions to request special handling from destination
servers. For example, if you have a relationship with YouTube for Schools, you can use a custom header to
identify transaction requests to YouTube.com as coming from your network and as requiring special handling.

Adding Custom Headers To Web Requests

Step 1 Access the CLI.
Step 2 Use the advancedproxyconfig -> customheaders commands to access the required submenus:

example.com> advancedproxyconfig
Choose a parameter group:
- AUTHENTICATION - Authentication related parameters
- CACHING - Proxy Caching related parameters
- DNS - DNS related parameters
- EUN - EUN related parameters
- NATIVEFTP - Native FTP related parameters
- FTPOVERHTTP - FTP Over HTTP related parameters
- HTTPS - HTTPS related parameters
- SCANNING - Scanning related parameters
- PROXYCONN - Proxy connection header related parameters
- CUSTOMHEADERS - Manage custom request headers for specific domains
- MISCELLANEOUS - Miscellaneous proxy related parameters
- SOCKS - SOCKS Proxy parameters
[]> customheaders
Currently defined custom headers:
Choose the operation you want to perform:
- DELETE - Delete entries
- NEW - Add new entries
- EDIT - Edit entries
[]>

Step 3 Enter the required subcommand as follows:

DescriptionOption

Deletes the custom header you identify. Identify the header to delete using the number associated with
the header in the list returned by the command.

Delete

Creates the header you provide for use with the domain or domains you specify.

Example header:

X-YouTube-Edu-Filter: ABCD1234567890abcdef

(The value in this case is a unique key provided by YouTube.)

Example domain:

youtube.com

New

Replaces an existing header with one you specify. Identify the header to delete using the number
associated with the header in the list returned by the command.

Edit

Step 4 Press Enter until you return to the main command interface.
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Step 5 Commit your changes.

Web Proxy Bypassing
• Web Proxy Bypassing for Web Requests, on page 72
• Configuring Web Proxy Bypassing for Web Requests, on page 72
• Configuring Web Proxy Bypassing for Applications, on page 72

Web Proxy Bypassing for Web Requests
You can configure the Web Security appliance so that transparent requests from particular clients, or to
particular destinations, bypass the Web Proxy.

Bypassing the web proxy allows you to:

• Prevent interference with non-HTTP-compliant (or proprietary) protocols that use HTTP ports but do
not work properly when they connect to a proxy server.

• Ensure that traffic from a particular machine inside the network, such as a malware test machine, bypasses
the Web Proxy and all its built-in security protection.

Bypassing only works for requests that are transparently redirected to the web proxy. The web proxy processes
all requests that clients explicitly forward to it, whether the proxy is in transparent or forward mode.

Configuring Web Proxy Bypassing for Web Requests

Step 1 Choose Web Security Manager > Bypass Settings.
Step 2 Click Edit Bypass Settings.
Step 3 Enter the addresses for which you wish to bypass the web proxy.

When you configure /0 as a subnet mask for any IP in the bypass list, the appliance bypasses all the web traffic.
In this case, the appliance interprets the configuration as 0.0.0.0/0.

Note

Step 4 Submit and commit your changes.

Configuring Web Proxy Bypassing for Applications

Step 1 Choose Web Security Manager > Bypass Settings.
Step 2 Click Edit Application Bypass Settings.
Step 3 Select the application(s) you wish to bypass scanning for.
Step 4 Submit and commit your changes.
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Web Proxy Usage Agreement
You can configure the Web Security appliance to inform users that it is filtering and monitoring their web
activity. The appliance does this by displaying an end-user acknowledgment page when a user first accesses
a browser after a certain period of time. When the end-user acknowledgment page appears, users must click
a link to access the original site requested or any other website.

Related Topics

• Notify End-Users of Proxy Actions, on page 303

Domain Map
You can configure the Web Security appliance so that transparent HTTPS requests from particular clients, or
to particular destinations, bypass the HTTPS Proxy.

You can use passthrough for applications that require traffic to pass through the appliance, without undergoing
any modification, or certificate checks of the destination servers.

Domain Map for Specific Applications

Before you begin

Ensure you have an identification policy defined for the devices that require pass through traffic to specific
servers. See Classifying Users and Client Software, on page 125 for more information. Specifically, you must:

• Choose Exempt from authentication/identification.

• Specify the addresses to which this Identification Profile should apply. You can use IP addresses, CIDR
blocks, and subnets.

Step 1 Enable HTTPS Proxy. See Enabling the HTTPS Proxy, on page 226 for more information.
Step 2 Choose Web Security Manager > Domain Map.

a) Click Add Domain.
b) Enter the Domain Name or the destination server.
c) Choose the order of the priority if there are existing domains specified.
d) Enter the IP addresses.
e) Click Submit.

Step 3 Choose Web Security Manager > Custom and External URL Categories.
a) Click Add Category.
b) Provide the following information.

DescriptionSetting

Enter an identifier for this URL category. This name appears when you configure URL filtering
for policy groups.

Category Name
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DescriptionSetting

Specify the order of this category in the list of custom URL categories. Enter “1” for the first
URL category in the list.

The URL filtering engine evaluates a client request against the custom URL categories in the
order specified.

List Order

Choose Local Custom Category.Category Type

You can enter regular expressions in this section to specify additional sets of addresses.

You can use regular expressions to specify multiple addresses that match the patterns you enter.

See Regular Expressions, on page 178 for more information about using regular expressions.

Advanced

c) Submit and commit the changes.

Step 4 Choose Web Security Manager > Decryption Policies.
a) Create a new decryption policy.
b) Choose the identification profile that you created for bypassing HTTPS traffic for specific applications.
c) In the Advanced panel, click the link for URL Categories.
d) In the Add column, click to add the custom URL category created in step 3.
e) Click Done.
f) In the Decryption Policies page, click the link for URL Filtering.
g) Choose Pass Through.
h) Submit and commit the changes.

You can use the%( format specifier to view access log information. See Customizing Access Logs, on page 391 for more
information.

• The Domain Map feature works in HTTPS Transparent mode.

• This feature does not work in Explicit mode and for HTTP traffic.

• Local Custom Category must be configured to allow the traffic using this feature.

• Enabling this feature will modify or assign the server name as per the server name configured in the
Domain Map, even if SNI information is available.

• This feature does not block traffic based on domain name if that traffic matches the Domain Map and
corresponding custom category, decryption policy and passthrough action are configured.

• Authentication does not work with this pass through feature. Authentication requires decryption, but traffic
will not be decrypted in this case.

• UDP traffic is not monitored. You must configure UDP traffic not to come to the WSA, instead it should
go directly through firewall to the internet for applications like WhatsApp, Telegram etc.

• WhatsApp, Telegram and Skype works in Transparent mode. However, some apps like WhatsApp do not
work in Explicit mode due to restrictions on the app.

Note
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Client Options for Redirecting Web Requests
If you choose to have clients explicitly forward requests to the web proxy, you must also decide how to
configure the clients to do this. Choose from the following methods:

• Configure Clients Using Explicit Settings. Configure clients with the web proxy hostname and port
number. See individual client documentation for details on how to do this.

The web proxy port uses port numbers 80 and 3128 by default. Clients can use either port.Note

• Configure Clients Using a Proxy Auto-Config (PAC) File. PAC files provide clients with instructions
on where to direct web requests. This options allows you to centrally manage subsequent changes to the
proxy details.

If you choose to use PAC files, you must also choose where to store them and how clients will find them.

Related Topics

• Using PAC Files with Client Applications, on page 75

Using PAC Files with Client Applications

Options For Publishing Proxy Auto-Config (PAC) Files
You must publish PAC files where clients can access them. Valid locations are:

• Web servers.
• Web Security appliances. You can place PAC files on a Web Security appliance, which appears to
clients as a web browser. The appliance also offers additional options to manage PAC files, including
the ability to service requests that use different hostnames, ports, and file names.

• Local machines. You can place the PAC file locally on a client’s hard disk. Cisco does not recommend
this as a general solution, and it is not suited to automatic PAC file detection methods, but it can be useful
for testing.

Related Topics

• Hosting PAC Files on the Web Security Appliance, on page 76
• Specifying PAC Files in Client Applications, on page 77

Client Options For Finding Proxy Auto-Config (PAC) Files
If you choose to use PAC files for your clients, you must also choose how clients will find the PAC files. You
have two options:

• Configure client with the PAC file location. Configure the client with a URL that specifically points
to the PAC file.

• Configure clients to detect the PAC file location automatically. Configure clients to find PAC files
automatically using the WPAD protocol along with DHCP or DNS.
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Automatic PAC File Detection
WPAD is a protocol that allows the browser determine the location of a PAC file using DHCP and DNS.

• To use WPAD with DHCP, you must set up option 252 on the DHCP server’s with the url of the PAC
file location. Not all browsers support DHCP, however.

• To use WPAD with DNS, you must configure a DNS record to point to the PAC file’s host server.

You can configure either or both options. WPAD will first try to find PAC files using DHCP, and if it cannot,
it will then try DNS.

Related Topics

• Detecting the PAC File Automatically in Clients, on page 77

Hosting PAC Files on the Web Security Appliance

Step 1 Choose Security Services > PAC File Hosting

Step 2 Click Enable and Edit Settings.
Step 3 (Optional) Complete the following basic settings:

DescriptionOption

The ports that the Web Security appliance will use to listen for PAC file requests.PAC Server Ports

Allows the PAC file to expire after a specified number of minutes in the browser’s cache.PAC File Expiration

Step 4 Click Browse in the PAC Files section and select a PAC file from your local machine for upload to the Web Security
appliance.

If the file you select is called default.pac , you do not have to specify the file name when configuring its
location in a browser. The Web Security appliance looks for a file called default.pac if no name is specified.

Note

Step 5 Click Upload to upload the PAC file selected in step 4 to the Web Security appliance.
Step 6 (Optional) In the Hostnames for Serving PAC Files Directly section, configure hostnames and associated file names for

PAC file requests that do not include a port number:

DescriptionOption

The hostname that the PAC file request must include if theWeb Security appliance is to service
the request. As the request does not include a port number, it will be processed through the
Web Proxy HTTP ports (e.g. port 80) and must be distinguishable as a PAC file request through
this hostnamevalue.

Hostname

The PAC file name that will be associated with the hostname on the same row. Request to the
hostname will return the PAC file specified here.

Only PAC files that have been uploaded are available for selection.

Default PAC File for
"Get/" Request through
Proxy Port

Adds another row to specify additional hostnames and PAC file names.Add Row
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Step 7 Submit and commit your changes.

Specifying PAC Files in Client Applications
• Configuring a PAC File Location Manually in Clients, on page 77
• Detecting the PAC File Automatically in Clients, on page 77

Configuring a PAC File Location Manually in Clients

Step 1 Create and publish a PAC file.
Step 2 Enter a URL in your browser’s PAC file configuration area that points to the PAC file location.

The following are valid URL formats if the Web Security appliance is hosting the PAC file:

http://server_address[.domain][:port][/filename] | http://WSAHostname[/filename]

whereWSAHostname is the hostname value configured when hosting the PAC file on aWeb Security appliance. Otherwise
the URL format will depend on the storage location and, in some cases, on the client.

What to do next

• Hosting PAC Files on the Web Security Appliance, on page 76

Detecting the PAC File Automatically in Clients

Step 1 Create a PAC file called wpad.dat and publish it to a web server or Web Security appliance (the file must be placed in a
web server’s root folder if you intend using WPAD with DNS).

Step 2 Configure the web server to set up .dat files with the following MIME type:

application/x-ns-proxy-autoconfig

AWeb Security appliance does this for you automatically.Note

Step 3 To support DNS lookup, create an internally resolvable DNS name beginningwith ‘ wpad ’ (for example, wpad.example.com
) and associate it with the IP address of the server hosting the wpad.dat file.

Step 4 To support DHCP lookup, configure your DHCP server’s option 252 with the url of the wpad.dat file location (for
example: “ http://wpad.example.com/wpad.dat ”). The URL can use any valid host address, including an IP address,
and does not require a specific DNS entry.

What to do next

• Using PAC Files with Client Applications, on page 75
• Hosting PAC Files on the Web Security Appliance, on page 76
• WPAD Not Working With Firefox, on page 473
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FTP Proxy Services
• Overview of FTP Proxy Services, on page 78
• Enabling and Configuring the FTP Proxy, on page 78

Overview of FTP Proxy Services
The web proxy can intercept two types of FTP requests:

• Native FTP. Native FTP requests are generated by dedicated FTP clients (or by browsers using built-in
FTP clients). Requires the FTP proxy.

• FTP over HTTP. Browsers sometimes encode FTP requests inside HTTP requests, rather than using
native FTP. Does not require the FTP proxy.

Related Topics

• Enabling and Configuring the FTP Proxy, on page 78
• Configuring FTP Notification Messages, on page 312

Enabling and Configuring the FTP Proxy

To configure proxy settings that apply to FTP over HTTP connections, see Configuring Web Proxy Settings,
on page 65.

Note

Step 1 Choose Security Services > FTP Proxy.
Step 2 Click Enable and Edit Settings (if the only available option is Edit Settings then the FTP proxy is already enabled).
Step 3 (Optional) Configure the basic FTP Proxy settings.

DescriptionProperty

The port that the FTP Proxy will listen to for FTP control connections. Clients should use
this port when configuring an FTP proxy (not as the port for connecting to FTP servers,
which normally use port 21).

Proxy Listening Port

Whether of not data connections from anonymous users are cached.

Data from non-anonymous users is never cached.Note

Caching

Allows the FTP Proxy to imitate the FTP server’s IP address. This supports FTP clients that
do not allow transactions when the IP address is different for the control and data connections.

Server Side IP Spoofing

Allows a choice of authentication format the FTP Proxy can use when communicating with
FTP clients.

Authentication Format

The range of TCP ports that FTP clients should use to establish a data connection with the
FTP Proxy for passive mode connections.

Passive Mode Data Port
Range
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DescriptionProperty

The range of TCP ports FTP servers should use to establish a data connection with the FTP
Proxy for active mode connections. This setting applies to both native FTP and FTP over
HTTP connections.

Increasing the port range accommodates more requests from the same FTP server. Because
of the TCP session TIME-WAIT delay (usually a few minutes), a port does not become
available again for the same FTP server immediately after being used. As a result, any given
FTP server cannot connect to the FTP Proxy in active mode more than n times in a short
period of time, where n is the number of ports specified in this field.

Active Mode Data Port
Range

The welcome banner that appears in FTP clients during connection. Choose from:

• FTP server message. The message will be provided by the destination FTP server.
This option is only available when the web proxy is configured for transparent mode,
and only applies for transparent connections.

• Custom message. When selected, this custom message is displayed for all native FTP
connections. When not selected, this is still used for explicit forward native FTP
connections.

Welcome Banner

Step 4 (Optional) Configure the advanced FTP Proxy settings:

DescriptionProperty

The maximum number of seconds the FTP Proxy waits for more communication in the
control connection from an idle FTP client or FTP server when the current transaction has
not been completed.

• Client side. The timeout value for control connections to idle FTP clients.
• Server side. The timeout value for control connections to idle FTP servers.

Control Connection
Timeouts

How long the FTP Proxy waits for more communication in the data connection from an
idle FTP client or FTP server when the current transaction has not been completed.

• Client side. The timeout value for data connections to idle FTP clients.
• Server side. The timeout value for data connections to idle FTP servers.

Data Connection Timeouts

Step 5 Submit and commit your changes.

What to do next

• Overview of FTP Proxy Services, on page 78

SOCKS Proxy Services
• Overview of SOCKS Proxy Services, on page 80
• Enabling Processing of SOCKS Traffic, on page 80
• Configuring the SOCKS Proxy, on page 80
• Creating SOCKS Policies, on page 81
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Overview of SOCKS Proxy Services
The Web Security appliance includes a SOCKS proxy to process SOCKS traffic. SOCKS policies are the
equivalent of access policies that control SOCKS traffic. Similar to access policies, you can make use of
Identification Profiles to specify which transactions are governed by each SOCKS policy. Once SOCKS
policies are applied to transactions, routing policies can then govern routing of the traffic.

Note the following regarding the SOCKS proxy:

• The SOCKS protocol only supports direct forward connections.
• The SOCKS proxy does not support (will not forward to) upstream proxies.
• The SOCKS proxy does not support scanning services, which are used by Application Visibility and
Control (AVC), Data Loss Prevention (DLP), and malware detection.

• The SOCKS proxy does not support policy tracing.
• The SOCKS proxy does not decrypt SSL traffic; it tunnels from client to server.

Enabling Processing of SOCKS Traffic

Before you begin

Enable the Web Proxy.

Step 1 Choose Security Services > SOCKS Proxy.
Step 2 Click Edit Settings.
Step 3 Select Enable SOCKS Proxy.
Step 4 Submit and Commit Changes.

Configuring the SOCKS Proxy

Step 1 Choose Security Services > SOCKS Proxy.
Step 2 Click Edit Settings.
Step 3 Select Enable SOCKS Proxy.
Step 4 Configure the basic and advanced SOCKS Proxy settings.

Enabled.SOCKS Proxy

Ports that accept SOCKS requests. Default is 1080.SOCKS Control Ports

UDP ports on which the SOCKS server should listen. Default is 16000-16100.UDP Request Ports

Time to wait (in seconds) to send or receive data from a SOCKS client in the negotiation phase.
Default is 60.

Proxy Negotiation
Timeout
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Time to wait (in seconds) for data from a UDP client or server before closing the UDP tunnel.
Default is 60.

UDP Tunnel Timeout

Creating SOCKS Policies

Step 1 Choose Web Security Manager > SOCKS Policies.
Step 2 Click Add Policy.
Step 3 Assign a name in the Policy Name field.

Each policy group name must be unique and only contain alphanumeric characters or the space character.Note

Step 4 (Optional) Add a description.
Step 5 In the Insert Above Policy field, choose where in the SOCKS policies table to insert this SOCKS policy.

When configuring multiple SOCKS policies, determine a logical order for each policy. Order your policies to
ensure that correct matching occurs.

Note

Step 6 In the Identities and Users section, choose one or more Identities to apply to this policy group.
Step 7 (Optional) Expand the Advanced section to define additional membership requirements.

The port configured in the browser.

(Optional) Define policy group membership by the proxy port used to access the Web Proxy. Enter
one or more port numbers in the Proxy Ports field. Separate multiple ports with commas.

You might want to define policy group membership on the proxy port if you have one set of clients
configured to explicitly forward requests on one port, and another set of clients configured to explicitly
forward requests on a different port.

If the Identity associated with this policy group defines Identity membership by this
advanced setting, the setting is not configurable at the SOCKS policy group level.

Note

Proxy Ports

(Optional) Define policy group membership by subnet or other addresses.

You can choose to use the addresses that may be defined with the associated Identity, or you can
enter specific addresses here.

If the Identity associated with this policy group defines its membership by addresses, then
in this policy group you must enter addresses that are a subset of the Identity’s addresses.
Adding addresses in the policy group further narrows down the list of transactions that
match this policy group.

Note

Subnets

(Optional) Define policy group membership by time range:

a. Select a time range from the Time Range field.
b. Specify whether this policy group should apply to the times inside or outside the selected time

range.

Time Range

Step 8 Submit and Commit Changes.
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What to do next

• (Optional) Add an Identity for use with SOCKS Policies.
• Add one or more SOCKS Policies to manage SOCKS traffic.

Troubleshooting Intercepting Requests
• URL Categories Do Not Block Some FTP Sites, on page 474
• Large FTP Transfers Disconnect, on page 475
• Zero Byte File Appears On FTP Servers After File Upload, on page 475
• Unable to Route FTP Requests Via an Upstream Proxy, on page 492
• HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require Authentication,
on page 485

• User Matches Global Policy for HTTPS and FTP over HTTP Requests, on page 486
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C H A P T E R 6
Acquire End-User Credentials

This chapter contains the following sections:

• Overview of Acquire End-User Credentials, on page 83
• Authentication Best Practices, on page 84
• Authentication Planning, on page 84
• Authentication Realms, on page 94
• Authentication Sequences, on page 111
• Failed Authentication, on page 113
• Credentials, on page 119
• Troubleshooting Authentication, on page 121

Overview of Acquire End-User Credentials
NotesSupported Network ProtocolAuthentication SchemeServer

Type/Realm

Kerberos is only supported in
Standard mode. It is not
supported in Cloud Connector
mode.

HTTP, HTTPS

Native FTP, FTP over HTTP

SOCKS (Basic authentication)

Kerberos

NTLMSSP

Basic

Active Directory

—HTTP, HTTPS

Native FTP, FTP over HTTP

SOCKS

BasicLDAP

Authentication Task Overview
Links to Related Topics and ProceduresTaskStep

• How to Create an Active Directory
Authentication Realm (NTLMSSP and
Basic), on page 99

• Creating an LDAP Authentication
Realm, on page 101

Create an authentication realm.1
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Links to Related Topics and ProceduresTaskStep

• Configuring Global Authentication
Settings, on page 106

Configure global authentication settings.2

• External Authentication, on page 95Configure external authentication.

You can authenticate users through an external
LDAP or RADIUS server.

3

• Creating Authentication Sequences, on
page 112

(Optional) Create and order additional
authentication realms.

Create at least one authentication realm for each
authentication protocol and scheme combination
you plan to use.

4

• Configuring Credential Encryption, on
page 120

(Optional) Configure credential encryption.5

• Classifying Users and Client Software,
on page 125

Create Identification Profiles to classify users and
client software based on authentication
requirements.

6

• Managing Web Requests Through
Policies Best Practices, on page 199

Create policies to manage Web requests from the
users and user groups for which you created
Identification Profiles.

7

Authentication Best Practices
• Create as few Active Directory realms as is practical. Multiple Active Directory realms require additional
memory usage for authentication.

• If using NTLMSSP, authenticate users using either the Web Security appliance or the upstream proxy
server, but not both. (Recommend Web Security appliance)

• If using Kerberos, authenticate using the Web Security appliance.
• For optimal performance, authenticate clients on the same subnet using a single realm.
• Some user agents are known to have issues with machine credentials or authentication failures, which
can negatively impact normal operations. You should bypass authentication with these user agents. See
Bypassing Authentication with Problematic User Agents , on page 114.

Authentication Planning
• Active Directory/Kerberos, on page 85
• Active Directory/Basic, on page 86
• Active Directory/NTLMSSP, on page 87
• LDAP/Basic, on page 87
• Identifying Users Transparently, on page 88
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Active Directory/Kerberos
Transparent, Cookie-Based
Caching

Transparent, IP-Based CachingExplicit Forward

Advantages:

• Better performance and
interoperability when
compared to NTLM

• Works with both Windows
and non-Windows clients that
have joined the domain

• Works with all major
browsers

• Authentication is associated
with the user rather than the
host or IP address

Disadvantages:

• Each new web domain
requires the entire
authentication process
because cookies are domain
specific

• Requires cookies to be
enabled

• Does not work for HTTPS
requests

Advantages:

• Better performance and
interoperability when
compared to NTLM

• Works with both Windows
and non-Windows clients
that have joined the domain

• Works with all major
browsers

• With user agents that do not
support authentication, users
only need to authenticate
first in a supported browser

• Relatively low overhead
• Works for HTTPS requests
if the user has previously
authenticatedwith an HTTP
request

Advantages:

• Better performance and
interoperability when compared
to NTLM

• Works with both Windows and
non-Windows clients that have
joined the domain

• Supported by all browsers and
most other applications

• RFC-based
• Minimal overhead
• Works for HTTPS (CONNECT)
requests

• Because the passphrase is not
transmitted to the authentication
server, it is more secure

• Connection is authenticated, not
the host or IP address

• Achieves true single sign-on in
an Active Directory environment
when the client applications are
configured to trust the Web
Security appliance
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Active Directory/Basic
Transparent, Cookie-Based
Caching

Transparent, IP-Based CachingExplicit Forward

Advantages:

• Works with all major
browsers

• Authentication is
associated with the user
rather than the host or IP
address

Disadvantages:

• Each new web domain
requires the entire
authentication process
because cookies are
domain specific

• Requires cookies to be
enabled

• Does not work for
HTTPS requests

• No single sign-on
• Passphrase is sent as clear
text (Base64)

Advantages:

• Works with all major browsers
• With user agents that do not
support authentication, users
only need to authenticate first
in a supported browser

• Relatively low overhead
• Works for HTTPS requests if
the user has previously
authenticated with an HTTP
request

Disadvantages:

• Authentication credentials are
associated with the IP address,
not the user (does not work in
Citrix and RDP environments,
or if the user changes IP
address)

• No single sign-on
• Passphrase is sent as clear text
(Base64)

Advantages:

• Supported by all browsers and
most other applications

• RFC-based
• Minimal overhead
• Works for HTTPS (CONNECT)
requests

• Because the passphrase is not
transmitted to the authentication
server, it is more secure

• Connection is authenticated, not
the host or IP address

• Achieves true single sign-on in an
Active Directory environment
when the client applications are
configured to trust the Web
Security appliance

Disadvantages:

• Passphrase sent as clear text
(Base64) for every request

• No single sign-on
• Moderate overhead: each new
connection needs to be
re-authenticated

• Primarily supported on Windows
only and with major browsers only
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Active Directory/NTLMSSP
TransparentExplicit Forward

Advantages:

• More Flexible

Transparent NTLMSSP authentication is similar to
transparent Basic authentication except that theWeb Proxy
communicates with clients using challenge and response
instead of basic clear text username and passphrase.

The advantages and disadvantages of using transparent
NTLM authentication are the same as those of using
transparent Basic authentication except that transparent
NTLM authentication has the added advantaged of
not sending the passphrase to the authentication server
and you can achieve single sign-on when the client
applications are configured to trust the Web Security
appliance.

Advantages:

• Because the passphrase is not transmitted to
the authentication server, it is more secure

• Connection is authenticated, not the host or
IP address

• Achieves true single sign-on in an Active
Directory environment when the client
applications are configured to trust the Web
Security appliance

Disadvantages:

• Moderate overhead: each new connection
needs to be re-authenticated

• Primarily supported on Windows only and
with major browsers only

LDAP/Basic
TransparentExplicit Forward

Advantages:

• More Flexible than explicit forward.
• More browser support than NTLM
• With user agents that do not support authentication, users
only need to authenticate first in a supported browser

• Relatively low overhead
• Works for HTTPS requests if the user has previously
authenticated with an HTTP request

Disadvantages:

• No single sign-on
• Passphrase is sent as clear text (Base64)
• Authentication credentials are associated with the IP
address, not the user (does not work in Citrix and RDP
environments, or if the user changes IP address)

Workarounds:

• Failed Authentication, on page 113

Advantages:

• RFC-based
• More browser support than NTLM
• Minimal overhead
• Works for HTTPS (CONNECT)
requests

Disadvantages:

• No single sign-on
• Passphrase sent as clear text (Base64)
for every request

Workarounds:

• Failed Authentication, on page 113
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Identifying Users Transparently
Traditionally, users are identified and authenticated by prompting them to enter a user name and passphrase.
These credentials are validated against an authentication server, and then theWeb Proxy applies the appropriate
policies to the transaction based on the authenticated user name.

However, you can configure the Web Security appliance to authenticate users transparently—that is, without
prompting the end user for credentials. Transparent identification authenticates the user by means of credentials
obtained from another trusted source, with the assumption that the user has already been authenticated by that
trusted source, and then applies the appropriate policies.

You might want to identify users transparently to:

• Create a single sign-on environment so users are not aware of the presence of a proxy on the network.

• To apply authentication-based policies to transactions coming from client applications that are incapable
of displaying an authentication prompt to end users.

Identifying users transparently only affects how the Web Proxy obtains the user name and assigns an
Identification Profile. After it obtains the user name and assigns an Identification Profile, it applies all other
policies normally, regardless of how it assigned the Identification Profile.

If transparent authentication fails, you can configure how to handle the transaction: you can grant the user
guest access, or you can force an authentication prompt to appear to the user.

When an end user is shown an authentication prompt due to failed transparent user identification, and the user
then fails authentication due to invalid credentials, you can choose whether to allow the user guest access.

When you enable re-authentication and a transaction is blocked by URL filtering, an end-user notification
page appears with the option to log in as a different user. Users who click the link are prompted for
authentication. For more information, see Failed Authorization: Allowing Re-Authentication with Different
Credentials, on page 117.

Note

Understanding Transparent User Identification
The available methods of transparent user identification are:

• Transparently identify users with ISE – Available when the Identity Services Engine (ISE) or Passive
Identity Connector (ISE-PIC) service is enabled (Network > Identity Services Engine). For these
transactions, the user name and associated Secure Group Tags will be obtained from an Identity Services
Engine server. If you are using ISE-PIC, the user name and associated ISE Secure Groups will be obtained.
See Tasks for Integrating the ISE/ISE-PIC Service, on page 143.

• Transparently identify users with ASA – Users are identified by the current IP address-to-user name
mapping received from a Cisco Adaptive Security Appliance (for remote users only). This option is
available when AnyConnect Secure Mobility is enabled and integrated with an ASA. The user name will
be obtained from the ASA, and associated directory groups will be obtained from the authentication
realm or sequence specified on the Web Security appliance. See Remote Users, on page 218.

• Transparently identify users with authentication realms – This option is available when one or more
authentication realms are configured to support transparent identification using one of the following
authentication servers:

• Active Directory – Create an NTLM or Kerberos authentication realm and enable transparent user
identification. In addition, youmust deploy a separate Active Directory agent such as Cisco’s Context
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Directory Agent. For more information, see Transparent User Identification with Active Directory,
on page 89.

• LDAP – Create an LDAP authentication realm configured as an eDirectory, and enable transparent
user identification. For more information, see Transparent User Identification with LDAP, on page
90.

AsyncOS forWeb communicates at regular intervals with eDirectory or an Active Directory agent to maintain
mappings that match authenticated user names to their current IP addresses.

Transparent User Identification with Active Directory

Active Directory does not record user log-in information in a format that is easily queried by other systems
such as theWeb Security appliance. Active Directory agents, such as Cisco’s Context Directory Agent (CDA),
are necessary to query the Active Directory security event logs for information about authenticated users.

CDA is not supported by Active Directory in Windows Server 2016. You can use Identity Services Engine
(ISE) or ISE Passive Identity Controller (ISE-PIC) service to receive user information and achieve transparent
user identification. You must configure identification profiles and relevant access policies, and decryption
policies that use CDA, with ISE/ISE-PIC information when you switch from CDA to ISE/ISE-PIC.

Note

AsyncOS for Web communicates with the Active Directory agent to maintain a local copy of the
IP-address-to-user-name mappings. When AsyncOS for Web needs to associate an IP address with a user
name, it first checks its local copy of the mappings. If no match is found, it queries an Active Directory agent
to find a match.

For more information on installing and configuring an Active Directory agent, see the section “Setting Up an
Active Directory Agent to Provide Information to the Web Security Appliance” below.

Consider the following when you identify users transparently using Active Directory:

• Transparent user identification with Active Directory works with an NTLM or Kerberos authentication
scheme only. You cannot use it with an LDAP authentication realm that corresponds to an Active Directory
instance.

• Transparent user identification works with the versions of Active Directory supported by an Active
Directory agent.

• You can install a second instance of an Active Directory agent on a different machine to achieve high
availability. When you do this, each Active Directory agent maintains IP-address-to-user-namemappings
independently of the other agent. AsyncOS for Web uses the backup Active Directory agent after three
unsuccessful ping attempts to the primary agent.

• The Active Directory agent uses on-demandmodewhen it communicates with theWeb Security appliance.
• The Active Directory agent pushes user log-out information to theWeb Security appliance. Occasionally,
some user log-out information is not recorded in the Active Directory security logs. This can happen if
the client machine crashes, or if the user shuts down the machine without logging out. If there is no user
log-out information in the security logs, an Active Directory agent cannot inform the appliance that the
IP address no longer is assigned to that user. To obviate this possibility, you can define how long AsyncOS
caches the IP-address-to-user mappings when there are no updates from an Active Directory agent. For
more information, see Using the CLI to Configure Advanced Transparent User Identification Settings,
on page 91.

• The Active Directory agent records the sAMAccountName for each user logging in from a particular IP
address to ensure the user name is unique.
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• The client IP addresses that the client machines present to the Active Directory server and the Web
Security appliance must be the same.

• AsyncOS for Web searches only direct parent groups for a user. It does not search nested groups.

Setting Up an Active Directory Agent to Provide Information to the Web Security Appliance

Because AsyncOS for Web cannot obtain client IP addresses directly from Active Directory, it must obtain
IP-address-to-user-name mapping information from an Active Directory agent.

Install an Active Directory agent on a machine in the network that is accessible to theWeb Security appliance,
and which can communicate with all visible Windows domain controllers. For best performance, this agent
should be physically as close as possible to the Web Security appliance. In smaller network environments,
you may want to install the Active Directory agent directly on the Active Directory server.

The Active Directory agent instance used to communicate with the Web Security appliance can also support
other appliances, including Cisco’s Adaptive Security Appliance and other Web Security appliances.

Note

Obtaining, Installing, and Configuring Cisco’s Context Directory Agent

You can find information about downloading, installing, and configuring the Cisco Context Directory Agent
here: http://www.cisco.com/en/US/docs/security/ibf/cda_10/Install_Config_guide/cda10.html.

The Web Security appliance and Active Directory agent communicate with each other using the RADIUS
protocol. The appliance and the agent must be configured with the same shared secret to obfuscate user
passphrases. Other user attributes are not obfuscated.

Note

Transparent User Identification with LDAP

AsyncOS for Web can communicate with an eDirectory server configured as a Lightweight Directory Access
Protocol (LDAP) realms maintaining IP-address-to-user-name mappings. When a user logs in through an
eDirectory client, the user is authenticated against the eDirectory server. When authentication succeeds, the
client IP address is recorded in the eDirectory server as an attribute ( NetworkAddress ) of the user who logged
in.

Consider the following when you identify users transparently using LDAP (eDirectory):

• The eDirectory client must be installed on each client workstation, and end users must use it to authenticate
against an eDirectory server.

• The LDAP tree used by the eDirectory client log-in must be the same LDAP tree configured in the
authentication realm.

• If the eDirectory clients use multiple LDAP trees, create an authentication realm for each tree, and then
create an authentication sequence that uses each LDAP authentication realm.

• When you configure the LDAP authentication realm as an eDirectory, you must specify a Bind DN for
the query credentials.

• The eDirectory server must be configured to update the NetworkAddress attribute of the user object
when a user logs in.

• AsyncOS for Web searches only direct parent groups for a user. It does not search nested groups.
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• You can use the NetworkAddress attribute for an eDirectory user to determine the most-recent log-in IP
address for the user.

Rules and Guidelines for Transparent User Identification
Consider the following rules and guidelines when using transparent user identification with any authentication
server:

• When usingDHCP to assign IP addresses to client machines, ensure the IP-address-to-user-namemappings
are updated on the Web Security appliance more frequently than the DHCP lease. Use the tuiconfig
CLI command to update the mapping update interval. For more information, see Using the CLI to
Configure Advanced Transparent User Identification Settings, on page 91.

• If a user logs out of a machine and another user logs into the same machine before the IP-address-to
user-name mapping is updated on the Web Security appliance, then the Web Proxy logs the client as the
previous user.

• You can configure how the Web Proxy handles transactions when transparent user identification fails.
It can grant users guest access, or it can force an authentication prompt to appear to end users.

• When a user is shown an authentication prompt due to failed transparent user identification, and the user
then fails authentication due to invalid credentials, you can choose whether to allow the user guest access.

• When the assigned Identification Profile uses an authentication sequence with multiple realms in which
the user exists, AsyncOS for Web fetches the user groups from the realms in the order in which they
appear in the sequence.

• When you configure an Identification Profile to transparently identify users, the authentication surrogate
must be IP address. You cannot select a different surrogate type.

• When you view detailed transactions for users, theWeb Tracking page showswhich users were identified
transparently.

• You can log which users were identified transparently in the access and WC3 logs using the %m and
x-auth-mechanism custom fields. A log entry of SSO_TUI indicates that the user name was obtained by
matching the client IP address to an authenticated user name using transparent user identification.
(Similarly, a value of SSO_ASA indicates that the user is a remote user and the user name was obtained
from a Cisco ASA using AnyConnect Secure Mobility.)

Configuring Transparent User Identification
Configuring transparent user identification and authorization is detailed in Acquire End-User Credentials, on
page 83. The basic steps are:

• Create and order authentication realms.
• Create Identification Profiles to classify users and client software.
• Create policies to manage web requests from the identified users and user groups.

Using the CLI to Configure Advanced Transparent User Identification Settings
AsyncOS for Web provides the following TUI-related CLI commands:

• tuiconfig – Configure advanced settings associated with transparent user identification. Batch mode
can be used to configure multiple parameters simultaneously.

• Configure mapping timeout for Active Directory agent – Length of time, in minutes,
IP-address-to-user mappings are cached for IP addresses retrieved by the AD agent when there are
no updates from the agent.

• Configure proxy cache timeout for Active Directory agent – Length of time, in seconds,
proxy-specific IP-address-to-user mappings are cached; valid values range from five to 1200 seconds.
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The default and recommended value is 120 seconds. Specifying a lower value may negatively affect
proxy performance.

• Configure mapping timeout for Novell eDirectory – Length of time, in seconds, IP-address
to-user mappings are cached for IP addresses retrieved from the eDirectory server when there are
no updates from the server.

• Configure query wait time for Active Directory agent – The length of time, in seconds, to
wait for a reply from the Active Directory agent. When the query takes more than this value,
transparent user identification is considered to have failed. This limits the authentication delay
experienced by the end user.

• Configure query wait time for Novell eDirectory – The length of time, in seconds, to wait
for a reply from the eDirectory server. When the query takes more than this value, transparent user
identification is considered to have failed. This limits the authentication delay experienced by the
end user.

The Active Directory settings apply to all AD realms using an AD agent for transparent user identification.
The eDirectory settings apply to all LDAP realms using eDirectory for transparent user identification.

If validation fails for any one parameter, none of the values will be changed.

• tuistatus – This command provides the following AD-related subcommands:

• adagentstatus – Displays the current status of all AD agents, as well as information about their
connections with the Windows domain controllers.

• listlocalmappings – Lists all IP-address-to-user-name mappings stored on the Web Security
appliance, as retrieved by the AD agent(s). It does not list entries stored on the agent(s), nor does
it list mappings for which queries are currently in progress.

Configuring Single-Sign-on
Obtaining credentials transparently facilitates a single-sign-on environment. Transparent user identification
is an authentication realm setting.

For Internet Explorer, be sure the Redirect Hostname is the short host name (containing no dots) or the NetBIOS
name rather than a fully qualified domain. Alternatively, you can add the appliance host name to Internet
Explorer’s Local intranet zone (Tools > Internet options > Security tab); however, this will be required on
every client. For more information about this, see How do I properly set up NTLM with SSO (credentials
sent transparently)?

With Firefox and other non-Microsoft browsers, the parameters network.negotiate-auth.delegation-uris,
network.negotiate-auth.trusted-uris and network.automatic-ntlm-auth.trusted-uris must be set to the
transparent-mode Redirect Hostname. You also can refer to Firefox is not sending authentication credentials
transparently (SSO). This article provides general information about changing Firefox parameters.

For information about the Redirect Hostname, see Configuring Global Authentication Settings, on page 106,
or the CLI command sethostname.

Creating a Service Account in Windows Active Directory for Kerberos
Authentication in High Availability Deployments

Use this procedure if you are having issues with high availability with Kerberos authentication. Scenarios,
where issues may arise when using Kerberos Authentication in High Availability Deployments are:
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• The servicePrincipalName of the high availability hostname is added to multiple machine accounts in
the Active Directory.

• Kerberos authentication works if the servicePrincipalName has been added to single machine account
in the Active Directory. When the primary node changes, high availability may be impacted, because
different appliance nodes use different encryption strings to decrypt Kerberos service tickets.

Before you begin

• Choose the user name to be used for high availability with Kerberos authentication. We recommend
creating a new user name, which will be used solely for this purpose.

• If you prefer using an existing user name:

• Set a password, if the user name does not have one.

• In the user account properties dialog box (in Active Directory users and computers):

Ensure that the User must change password at next logon check box is unchecked.

Check the Password never expires check box.

Step 1 Create a new user name in Active Directory users and computers.

• Specify a password.

• Uncheck the User must change password at next logon check box.

• Check the Password never expires check box.

Step 2 Check if the SPN of the high availability hostname is associated with the Active Directory user object created or chosen.
SPN consists of a http/ prefix, and is suffixed with the appliance’s high availability hostname. Ensure that the clients are
able to resolve the hostname.

a. Use the setspn -q command in Windows, to query for any existing association.

Example: setspn -q http/highavail.com

In this example, highavail.com is the appliance’s high availability hostname.

b. Remove, or add the SPN depending on the results of the query:

ActionQuery Result

Associate the SPN of the high availability hostname is associated with the
Active Directory user object.

• Use the setspn -s command:

setspn -s http/highavail.com hausername

In this example, highavail.com is the appliance’s high availability
hostname, and hausername is the user name created or chosen.

No such SPN found.
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ActionQuery Result

No further action is necessary in the Active Directory.Existing SPN found!

The common name (CN) shows the user
name created or chosen.

Example: CN = hausername

a. Remove the SPN.

Use the setspn -d command:

setspn -d http/highavail.com johndoe

In this example, highavail.com is the appliance’s high availability
hostname, and johndoe is the user name to be disassociated.

b. Add the SPN.

Use the setspn -s command:

setspn -s http/highavail.com hausername

In this example, highavail.com is the appliance’s high availability
hostname, and hausername is the user name created or chosen.

Existing SPN found!

The common name (CN) does not show
the user name created or chosen.

Ensure that keytab authentication is enabled in the relevant Active Directory realm. See Creating an Active
Directory Realm for Kerberos Authentication Scheme, on page 95. For realms already created, edit the realm,
and enable the keytab authentication.

Note

Authentication Realms
Authentication realms define the details required to contact the authentication servers and specify which
authentication scheme to use when communicating with clients. AsyncOS supports multiple authentication
realms. Realms can also be grouped into authentication sequences that allow users with different authentication
requirements to be managed through the same policies.

• External Authentication, on page 95
• Creating an Active Directory Realm for Kerberos Authentication Scheme, on page 95
• How to Create an Active Directory Authentication Realm (NTLMSSP and Basic), on page 99
• Creating an LDAP Authentication Realm, on page 101
• About Deleting Authentication Realms, on page 106
• Configuring Global Authentication Settings, on page 106

Related Topics

• Authentication Sequences, on page 111
• RADIUS User Authentication, on page 430
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External Authentication
You can authenticate users through an external LDAP or RADIUS server.

Configuring External Authentication through an LDAP Server

Before you begin

Create an LDAP authentication realm and configure it with one or more external authentication queries.
Creating an LDAP Authentication Realm, on page 101.

Step 1 Enable external authentication on the appliance:
a) Navigate to System Administration > Users.
b) Click Enable in the External Authentication section.
c) Configure the options:

DescriptionOption

—Enable External Authentication

Select LDAP.Authentication Type

The number of seconds AsyncOS stores the external authentication
credentials before contacting the LDAP server again to
re-authenticate. Default is zero (0).

External Authentication Cache Timeout

A query configured with the LDAP realm.LDAP External Authentication Query

The number of seconds AsyncOS waits for a response to the query
from the server.

Timeout to wait for valid response from server.

For each group name in the directory, assign a role.Group Mapping

Step 2 Submit and commit your changes.

Enabling RADIUS External Authentication
See Enabling External Authentication Using RADIUS, on page 430.

Creating an Active Directory Realm for Kerberos Authentication Scheme

Before you begin

• Ensure that the appliance is configured in Standard mode (not Cloud Connector Mode).

• If you are setting up high availability, ensure that you also enable the Use keytab authentication check
box in the Kerberos High Availability section, specified in step 9.
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If your appliance resides behind a HTTP/HTTPS traffic distribution device like a load balancer, you
must associate the SPN of the traffic distribution device in the Active Directory with a user account, and
enter the credentials of that user account in the Kerberos High Availability section. The SPN of the first
device that redirects traffic in the network topology should be added. For example, if client devices’
outbound network traffic passes through a traffic manager, a load balancer, and then to the Web Security
appliance, the SPN for the traffic manager should be added to a user account on the Active Directory,
and the user credentials should be entered in this section. This is because the traffic manager is the first
device that encounters client devices’ traffic.

• Prepare the Active Directory Server.

•
• Create a user on the Active Directory server:

• Create a user on the Active Directory server that is a member of the Domain Admins or Account
Operators group.

Or

• Create a user name with the following permissions:

• Active Directory permissions Reset Password

• Validated write to servicePrincipalName

• Write account restrictions

• Write dNShost name

• Write servicePrincipalName

These are the minimal Active Directory permissions required by a user name to join an
appliance to the domain and ensure its complete functioning.

• Join your client to the domain. Supported clients are Windows XP, Windows 10 andMac OS 10.5+.

• Use the kerbtray tool from the Windows Resource Kit to verify the Kerberos ticket on the client:
http://www.microsoft.com/en-us/download/details.aspx?id=17657.

• Ticket viewer application on Mac clients is available under main menu > KeyChain Access to view
the Kerberos tickets.

• Ensure that you have the rights and domain information needed to join the Web Security appliance to
the Active Directory domain you want to authenticate against.

• Compare the current time on the Web Security appliance with the current time on the Active Directory
server and verify that the difference is no greater than the time specified in the “Maximum tolerance for
computer clock synchronization” option on the Active Directory server.

• If the Web Security appliance is managed by a Security Management appliance, be prepared to ensure
that same-named authentication realms on different Web Security appliances have identical properties
defined on each appliance.

• Web Security appliance configuration:

• In explicit mode, theWSA host name (CLI command sethostname) and the proxy name configured
in the browser must be the same.

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
96

Acquire End-User Credentials
Creating an Active Directory Realm for Kerberos Authentication Scheme

http://www.microsoft.com/en-us/download/details.aspx?id=17657


• In transparent mode, theWSAhost namemust be the same as the Redirect Hostname (see Configuring
Global Authentication Settings, on page 106). Further, the WSA host name and Redirect Hostname
must be configured prior to creating a Kerberos realm.

• Be aware that after you commit the new realm, you cannot change a protocol of realm authentication.

• Note that Single Sign On (SSO) must be configured on client browsers; see Configuring Single-Sign-on,
on page 92.

• To simplify use of logs, customize the access log to use the %m custom field parameter. See Customizing
Access Logs, on page 391.

Step 1 In the Cisco Web Security Appliance web interface, choose Network > Authentication.
Step 2 Click Add Realm.
Step 3 Assign a unique name to the authentication realm using only alphanumeric and space characters.
Step 4 Select Active Directory in the Authentication Protocol field.
Step 5 Enter up to three fully-qualified domain names or IP addresses for the Active Directory server(s).

Example: ntlm.example.com .

An IP address is required only if the DNS servers configured on the appliance cannot resolve the Active Directory
server hostname.

When multiple authentication servers are configured in the realm, the appliance attempts to authorize with up to three
authentication servers before failing to authorize the transaction within this realm.

Step 6 Join the appliance to the domain:
a) Configure the Active Directory Account:

DescriptionSetting

The Active Directory server domain name. Also known as a DNS Domain or realm.Active Directory
Domain

If the network uses NetBIOS, provide the domain name.

If this option is not available use the setntlmsecuritymode CLI command
to verify that the NTLM security mode is set to “domain.”

Tip

NetBIOS domain name

Specify a location within the Active Directory domain where AsyncOS will create an
Active Directory computer account, also known as a “machine trust account,” to uniquely
identify the computer on the domain.

If the Active Directory environment automatically deletes computer objects at particular
intervals, specify a location for the computer account that is in a container, protected
from automatic deletion.

Computer Account

b) Click Join Domain.

If you attempt to join a domain you have already joined (even if you use the same credentials), existing
connections will be closed, as the Active Directory will send a new set of keys to all clients including
this WSA. Affected clients will need to log off and log back in again.

Note
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c) Provide login credentials (user name and passphrase) for the account on the Active Directory, and click Create
Account.

Step 7 (Optional) Configure transparent user identification.

DescriptionSetting

Enter both the server name for the machine where the primary Context Directory agent
is installed and the shared secret used to access it.

(Optional) Enter the server name for the machine where a backup Context Directory
agent is installed and its shared secret.

Enable Transparent User
Identification using Active
Directory agent

Step 8 If you will use high availability, check the Use keytab authentication check box in the Kerberos High Availability
section.
a) Enter the Username and Password.

Enter the username of Active Directory user name associated with SPN(s) corresponding to the IP address or
hostname of the high availability cluster. Do not include the domain name with the user name (for example, enter
‘johndoe’, rather than ‘DOMAIN\johndoe’, or ‘johndoe@domain’). See Creating a Service Account in Windows
Active Directory for Kerberos Authentication in High Availability Deployments, on page 92 for specific information
about creating a service account that will be used for authentication in high availability deployments.

b) Repeat this step for all appliances in the high availability cluster.

If your appliance resides behind a HTTP/HTTPS traffic distribution device like a load balancer, you
should associate the SPN of the traffic distribution device in the Active Directory with a user account,
and enter the credentials of that user account in the Kerberos High Availability section. The SPN of the
first device that redirects traffic in the network topology should be added. For example, if client devices’
outbound network traffic passes through a traffic manager, a load balancer, and then to the Web Security
appliance, the SPN for the traffic manager should be added to a user account on the Active Directory,
and the user credentials should be entered in this section. This is because the traffic manager is the first
device that encounters client devices’ traffic.

Note

Step 9 (Optional) Click Start Test. This will test the settings you have entered, ensuring they are correct before real users use
them to authenticate. For details on the testing performed, see Using Multiple NTLM Realms and Domains, on page
106.

Step 10 Troubleshoot any issues found during testing. See Troubleshooting Tools for Authentication Issues , on page 471
Step 11 Submit and commit your changes.

What to do next

Create an Identification Profile that uses the Kerberos authentication scheme. Classifying Users and Client
Software, on page 125.
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How to Create an Active Directory Authentication Realm (NTLMSSP and Basic)

Prerequisites for Creating an Active Directory Authentication Realm (NTLMSSP and Basic)
• Ensure you have the rights and domain information needed to join the Web Security appliance to the
Active Directory domain you wish to authenticate against.

• If you plan to use “domain” as the NTLM security mode, use only nested Active Directory groups. If
Active Directory groups are not nested, use the default value, “ads”. See setntlmsecuritymode in the
Command Line Interface appendix of this guide.

• Compare the current time on the Web Security appliance with the current time on the Active Directory
server and verify that the difference is no greater than the time specified in the “Maximum tolerance for
computer clock synchronization” option on the Active Directory server.

• If the Web Security appliance is managed by a Security Management appliance, be prepared to ensure
that same-named authentication realms on different Web Security appliances have identical properties
defined on each appliance.

• Be aware that once you commit the new realm, you cannot change a realm’s authentication protocol.
• The WSA needs to connect to the domain controllers for all trusted domains, and to the configured
domain controllers into the NTLM realm. For authentication to work correctly, you need to open the
following ports to all domain controllers on the internal domain and on the external domain:

• LDAP (389 UDP and TCP)

• Microsoft SMB (445 TCP)

• Kerberos (88 UDP)

• End-point resolution – port mapper (135 TCP) Net Log-on fixed port

• For NTLMSSP, single sign on (SSO) can be configured on client browsers. See Configuring
Single-Sign-on, on page 92.

About Using Multiple NTLM Realms and Domains
The following rules apply in regard to using multiple NTLM realms and domains:

• You can create up to 10 NTLM authentication realms.
• The client IP addresses in one NTLM realm must not overlap with the client IP addresses in another
NTLM realm.

• Each NTLM realm can join one Active Directory domain only but can authenticate users from any
domains trusted by that domain. This trust applies to other domains in the same forest by default and to
domains outside the forest to which at least a one way trust exists.

• Create additional NTLM realms to authenticate users in domains that are not trusted by existing NTLM
realms.

Creating an Active Directory Authentication Realm (NTLMSSP and Basic)

Before you begin

Ensure that the higher range ports in the appliance (49152-65535) are unblocked in your firewall. These ports
are required to perform the asynchronous group lookup requests. Blocking these ports may cause intermittent
authentication failure.
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Step 1 Choose Network > Authentication.
Step 2 Click Add Realm.
Step 3 Assign a unique name to the authentication realm using only alphanumeric and space characters.
Step 4 Select Active Directory in the Authentication Protocol and Scheme(s) field.
Step 5 Enter up to three fully-qualified domain names or IP addresses for the Active Directory server(s).

Example: active.example.com .

An IP address is required only if the DNS servers configured on the appliance cannot resolve the Active Directory server
hostname.

When multiple authentication servers are configured in the realm, the appliance attempts to authorize with up to three
authentication servers before failing to authorize the transaction within this realm.

Step 6 Join the appliance to the domain:
a) Configure the Active Directory Account:

DescriptionSetting

The Active Directory server domain name. Also known as a DNS Domain or realm.Active Directory Domain

If the network uses NetBIOS, provide the domain name.NetBIOS domain name

Specify a location within the Active Directory domain where AsyncOS will create
an Active Directory computer account, also known as a “machine trust account”, to
uniquely identify the computer on the domain.

If the Active Directory environment automatically deletes computer objects at
particular intervals, specify a location for the computer account that is in a container,
protected from automatic deletion.

Computer Account

b) Click Join Domain.

If you attempt to join a domain you have already joined (even if you use the same credentials), existing
connections will be closed, as the Active Directory will send a new set of keys to all clients including this
WSA. Affected clients will need to log off and log back in again.

Note

c) Enter the sAMAccountName user name and passphrase for an existing Active Directory user that has rights to create
computer accounts in the domain.

Example: “jazzdoe” Do not use: “DOMAIN\jazzdoe” or “jazzdoe@domain”

This information is used once to establish the computer account and is not saved.

d) Click Create Account.

Step 7 (Optional) Configure transparent authentication.

DescriptionSetting

Enter both the server name for the machine where the primary Context Directory agent is
installed and the shared secret used to access it.

(Optional) Enter the server name for the machine where a backup Context Directory agent
is installed and its shared secret.

Enable Transparent
User Identification
using Active Directory
agent
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Step 8 (Optional) Click Start Test. This will test the settings you have entered, ensuring they are correct before real users use
them to authenticate.

Step 9 Submit and commit your changes.

Creating an LDAP Authentication Realm

Before you begin

• Obtain the following information about LDAP in your organization:

• LDAP version

• Server addresses

• LDAP ports

• If theWeb Security appliance is managed by a Security Management appliance, ensure that same-named
authentication realms on different Web Security appliances have identical properties defined on each
appliance.

Step 1 Choose Network > Authentication.
Step 2 Click Add Realm.
Step 3 Assign a unique name to the authentication realm using only alphanumeric and space characters.
Step 4 Select LDAP in the Authentication Protocol and Scheme(s) field.
Step 5 Enter the LDAP authentication settings:

DescriptionSetting

Choose the version of LDAP, and choose whether or not to use Secure LDAP.

The appliance supports LDAP versions 2 and 3. Secure LDAP requires LDAP version 3.

Choose whether or not this LDAP server supports Novell eDirectory to use with transparent user
identification.

LDAP Version
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DescriptionSetting

Enter the LDAP server IP address or hostname and its port number. You can specify up to three
servers.

The hostname must be a fully-qualified domain name. For example, ldap.example.com . An IP
address is required only if the DNS servers configured on the appliance cannot resolve the LDAP
server hostname.

The default port number for Standard LDAP is 389. The default number for Secure LDAP is 636.

If the LDAP server is an Active Directory server, enter the hostname or IP address and the port of
the domain controller here. Whenever possible, enter the name of the Global Catalog Server and
use port 3268. However, you might want to use a local domain controller when the global catalog
server is physically far away and you know you only need to authenticate users on the local domain
controller.

Note: When you configure multiple authentication servers in the realm, the appliance attempts to
authorize with up to three authentication servers before failing to authenticate the transaction within
that realm.

LDAP Server

Choose one of the following values:

• Use persistent connections (unlimited). Use existing connections. If no connections are
available a new connection is opened.

• Use persistent connections. Use existing connections to service the number of requests
specified. When the maximum is reached, establish a new connection to the LDAP server.

• Do not use persistent connections. Always create a new connection to the LDAP server.

LDAP Persistent
Connections

(under the
Advanced section)
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DescriptionSetting

Enter values for the following fields:

Base Distinguished Name (Base DN)

The LDAP database is a tree-type directory structure and the appliance uses the Base DN to navigate
to the correct location in the LDAP directory tree to begin a search. A valid Base DN filter string
is composed of one or more components of the form object-value. For example dc=companyname,
dc=com.

After you upgrade to this release, you cannot perform the Start Test for LDAP
authentication if this field is empty.

Note

User Name Attribute

Choose one of the following values:

• uid, cn, and sAMAccountName. Unique identifiers in the LDAP directory that specify a
username.

• custom. A custom identifier such as UserAccount.

User Filter Query

The User Filter Query is an LDAP search filter that locates the users Base DN. This is required if
the user directory is in a hierarchy below the Base DN, or if the login name is not included in the
user-specific component of that users Base DN.

Choose one of the following values:

• none. Filters any user.

• custom. Filters a particular group of users.

User
Authentication

Choose whether or not the authentication server accepts anonymous queries.

If the authentication server does accept anonymous queries, choose Server Accepts Anonymous
Queries.

If the authentication server does not accept anonymous queries, choose Use Bind DN and then
enter the following information:

• Bind DN. The user on the external LDAP server permitted to search the LDAP directory.
Typically, the bind DN should be permitted to search the entire directory.

• Passphrase. The passphrase associated with the user you enter in the Bind DN field.

The following text lists some example users for the Bind DN field:

cn=administrator,cn=Users,dc=domain,dc=com
sAMAccountName=jdoe,cn=Users,dc=domain,dc=com.

If the LDAP server is an Active Directory server, you may also enter the Bind DN username as
“DOMAIN\username.”

Query Credentials

Step 6 (Optional) Enable Group Authorization via group object or user object and complete the settings for the chosen option
accordingly:
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DescriptionGroup Object Setting

Choose the LDAP attribute which lists all users that belong to this group.

Choose one of the following values:

• member and uniquemember. Unique identifiers in the LDAP directory that specify
group members.

• custom. A custom identifier such as UserInGroup.

Group Membership
Attribute Within Group
Object

Choose the LDAP attribute which specifies the group name that can be used in the policy
group configuration.

Choose one of the following values:

• cn. A unique identifier in the LDAP directory that specifies the name of a group.

• custom. A custom identifier such as FinanceGroup.

Attribute that Contains
the Group Name

Choose an LDAP search filter that determines if an LDAP object represents a user group.

Choose one of the following values:

• objectclass=groupofnames

• objectclass=groupofuniquenames

• objectclass=group

• custom. A custom filter such as objectclass=person.

Note: The query defines the set of authentication groups which can be used in policy groups.

Query String to
Determine if Object is a
Group

DescriptionUser Object Setting

Choose the attribute which list all the groups that this user belongs to.

Choose one of the following values:

• memberOf. Unique identifiers in the LDAP directory that specify user members.

• custom. A custom identifier such as UserInGroup.

Group Membership
Attribute Within User
Object

Specify whether the group membership attribute is a distinguished name (DN) which refers
to an LDAP object. For Active Directory servers, enable this option.

When this is enabled, you must configure the subsequent settings.

Group Membership
Attribute is a DN

When the group membership attribute is a DN, this specifies the attribute that can be used as
group name in policy group configurations.

Choose one of the following values:

• cn. A unique identifier in the LDAP directory that specifies the name of a group.

• custom. A custom identifier such as FinanceGroup.

Attribute that Contains
the Group Name
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DescriptionUser Object Setting

Choose an LDAP search filter that determines if an LDAP object represents a user group.

Choose one of the following values:

• objectclass=groupofnames

• objectclass=groupofuniquenames

• objectclass=group

• custom. A custom filter such as objectclass=person.

Note: The query defines the set of authentication groups which can be used in Web Security
Manager policies.

Query String to
Determine if Object is a
Group

Step 7 (Optional) Configure external LDAP authentication for users.
a) Select External Authentication Queries.
b) Identify the user accounts:.

The Base DN to navigate to the correct location in the LDAP directory tree to begin a
search.

Base DN

The query to return the set of authentication groups, for example:

(&(objectClass=posixAccount)(uid={u}))

or

(&(objectClass=user)(sAMAccountName={u}))

Query String

The LDAP attribute, for example, displayName or gecos .Attribute containing the
user’s full name

c) (Optional) Deny login to expired accounts based on RFC 2307 account expiration LDAP attributes.
d) Provide a query to retrieve group information for users.

If a user belongs to multiple LDAP groups with different user roles, AsyncOS grants the user the permissions for the
most restrictive role.

The Base DN to navigate to the correct location in the LDAP directory tree to begin a
search.

Base DN

(&(objectClass=posixAccount)(uid={u}))Query String

gecosAttribute containing the
user’s full name

Step 8 (Optional) Click Start Test. This will test the settings you have entered, ensuring they are correct before real users use
them to authenticate. For details on the testing performed, see Using Multiple NTLMRealms and Domains, on page 106.

Once you submit and commit your changes, you cannot later change a realm’s authentication protocol.Note
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Step 9 Submit and commit your changes.

What to do next

Create an Identification Profile that uses the Kerberos authentication scheme. See Classifying Users and Client
Software, on page 125.

Related Topics

• External Authentication, on page 95

Using Multiple NTLM Realms and Domains
The following rules apply in regard to using multiple NTLM realms and domains:

• You can create up to 10 NTLM authentication realms.
• The client IP addresses in one NTLM realm must not overlap with the client IP addresses in another
NTLM realm.

• Each NTLM realm can join one Active Directory domain only but can authenticate users from any
domains trusted by that domain. This trust applies to other domains in the same forest by default and to
domains outside the forest to which at least a one way trust exists.

• Create additional NTLM realms to authenticate users in domains that are not trusted by existing NTLM
realms.

About Deleting Authentication Realms
Deleting an authentication realm disables associated identities, which in turn removes those identities from
associated policies.

Deleting an authentication realm removes it from sequences.

Configuring Global Authentication Settings
Configure Global Authentication Settings to apply settings to all authentication realms, independent of their
authentication protocols.

The Web Proxy deployment mode affects which global authentication settings you can configure. More
settings are available when it is deployed in transparent mode than in explicit forward mode.

Before you begin

Be familiar with the following concepts:

• Failed Authentication, on page 113

• Failed Authorization: Allowing Re-Authentication with Different Credentials, on page 117

Step 1 Choose Network > Authentication

Step 2 Click Edit Global Settings.
Step 3 Edit the settings in the Global Authentication Settings section:.
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DescriptionSetting

Choose one of the following values:

• Permit traffic to proceed without authentication. Processing continues
as if the user was authenticated.

• Block all traffic if user authentication fails. Processing is discontinued
and all traffic is blocked.

Action if Authentication Service
Unavailable

When you grant users guest access in an Identification Profile policy, this
setting determines how the Web Proxy identifies and logs the user as a guest
in the access logs.

For more information on granting users guest access, see Granting Guest Access
After Failed Authentication, on page 116.

Failed Authentication Handling

This setting allows users to authenticate again if the user is blocked from a
website due to a restrictive URL filtering policy or due to being restricted from
logging into another IP address.

The user sees a block page that includes a link that allows them to enter new
authentication credentials. If the user enters credentials that allow greater
access, the requested page appears in the browser.

Note: This setting only applies to authenticated users who are blocked due to
restrictive URL filtering policies or User Session Restrictions. It does not apply
to blocked transactions by subnet with no authentication.

For more information, see Failed Authorization: Allowing Re-Authentication
with Different Credentials, on page 117.

Re-authentication

(Enable Re-Authentication Prompt If
End User Blocked by URL Category or
User Session Restriction)

Controls the length of time that user credentials are stored in the cache before
revalidating them with the authentication server. This includes the username
and passphrase and the directory groups associated with the user.

The default value is the recommended setting. When the Surrogate Timeout
setting is configured and is greater than the Basic Authentication Token TTL,
then the Surrogate Timeout value takes precedence and theWeb Proxy contacts
the authentication server after surrogate timeout expires.

Basic Authentication Token TTL

The remaining authentication settings you can configure depends on how the Web Proxy is deployed, in transparent or
explicit forward mode.

Step 4 If the Web Proxy is deployed in transparent mode, edit the settings as follows:

DescriptionSetting

This setting specifies whether or not the client sends the login credentials to
the Web Proxy through an encrypted HTTPS connection.

This setting applies to both Basic and NTLMSSP authentication schemes, but
it is particularly useful for Basic authentication scheme because user credentials
are sent as plain text.

For more information, see Failed Authentication, on page 113.

Credential Encryption
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DescriptionSetting

Specify a TCP port to use for redirecting requests for authenticating users over
an HTTPS connection.

This specifies through which port the client will open a connection to the Web
Proxy using HTTPS. This occurs when credential encryption is enabled or
when using Access Control and users are prompted to authenticate.

HTTPS Redirect Port

Enter the short hostname of the network interface on which the Web Proxy
listens for incoming connections.

When you configure authentication on an appliance deployed in transparent
mode, theWeb Proxy uses this hostname in the redirection URL sent to clients
for authenticating users.

You can enter either the following values:

• Single word hostname. You can enter the single word hostname that is
DNS resolvable by the client and theWeb Security appliance. This allows
clients to achieve true single sign-on with Internet Explorer without
additional browser side setup. Be sure to enter the single word hostname
that is DNS resolvable by the client and the Web Security appliance. For
example, if your clients are in domain mycompany.com and the interface
on which the Web Proxy is listening has a full hostname of
proxy.mycompany.com , then you should enter proxy in this field.
Clients perform a lookup on proxy and they should be able to resolve
proxy.mycompany.com .

• Fully qualified domain name (FQDN). You can also enter the FQDN
or IP address in this field. However, if you do that and want true single
sign-on for Internet Explorer and Firefox browsers, you must ensure that
the FQDN or IP address is added to the client’s Trusted Sites list in the
client browsers. The default value is the FQDN of theM1 or P1 interface,
depending on which interface is used for proxy traffic.

Redirect Hostname

This setting specifies how long the Web Proxy waits before asking the client
for authentication credentials again. Until the Web Proxy asks for credentials
again, it uses the value stored in the surrogate (IP address or cookie).

It is common for user agents, such as browsers, to cache the authentication
credentials so the user will not be prompted to enter credentials each time.

Credential Cache Options:

Surrogate Timeout

When IP address is used as the authentication surrogate, this setting specifies
how long the Web Proxy waits before asking the client for authentication
credentials again when the client has been idle.

When this value is greater than the Surrogate Timeout value, this setting has
no effect and clients are prompted for authentication after the Surrogate Timeout
is reached.

You might want to use this setting to reduce the vulnerability of users who
leave their computers.

Credential Cache Options:

Client IP Idle Timeout
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DescriptionSetting

Specifies the number of entries that are stored in the authentication cache. Set
this value to safely accommodate the number of users that are actually using
this device. The default value is the recommended setting.

Credential Cache Options:

Cache Size

This setting specifies whether or not authenticated users are allowed to access
the Internet from multiple IP addresses simultaneously.

Youmight want to restrict access to one machine to prevent users from sharing
their authentication credentials with non-authorized users. When a user is
prevented from logging in at a different machine, an end-user notification page
appears. You can choose whether or not users can click a button to login as a
different username using the Re-authentication setting on this page.

When you enable this setting, enter the restriction timeout value, which
determines how long users must wait before being able to log into a machine
with a different IP address. The restriction timeout value must be greater than
the surrogate timeout value.

You can remove a specific user or all users from the authentication cache using
the authcache CLI command.

User Session Restrictions

When using Credential Encryption or Access Control, you can choose whether
the appliance uses the digital certificate and key shipped with the appliance
(the Cisco Web Security Appliance Demo Certificate) or a digital certificate
and key you upload here.

Advanced

Step 5 If the Web Proxy is deployed in explicit forward mode, edit the settings as follows:

DescriptionSetting

This setting specifies whether or not the client sends the login credentials to
the Web Proxy through an encrypted HTTPS connection. To enable credential
encryption, choose “HTTPS Redirect (Secure)”. When you enable credential
encryption, additional fields appear to configure how to redirect clients to the
Web Proxy for authentication.

This setting applies to both Basic and NTLMSSP authentication schemes, but
it is particularly useful for Basic authentication scheme because user credentials
are sent as plain text.

For more information, see Failed Authentication, on page 113.

Credential Encryption

Specify a TCP port to use for redirecting requests for authenticating users over
an HTTPS connection.

This specifies through which port the client will open a connection to the Web
Proxy using HTTPS. This occurs when credential encryption is enabled or
when using Access Control and users are prompted to authenticate.

HTTPS Redirect Port
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DescriptionSetting

Enter the short host name of the network interface on which the Web Proxy
listens for incoming connections.

When you enable Authentication Mode above, the Web Proxy uses this
hostname in the redirection URL sent to clients for authenticating users.

You can enter either the following values:

• Single word hostname. You can enter the single word host name that is
DNS resolvable by the client and theWeb Security appliance. This allows
clients to achieve true single sign-on with Internet Explorer without
additional browser side setup. Be sure to enter the single word host name
that is DNS resolvable by the client and the Web Security appliance. For
example, if your clients are in domain mycompany.com and the interface
on which the Web Proxy is listening has a full host name of
proxy.mycompany.com , then you should enter proxy in this field. Clients
perform a lookup on proxy and they should be able to resolve
proxy.mycompany.com .

• Fully qualified domain name (FQDN). You can also enter the FQDN
or IP address in this field. However, if you do that and want true single
sign-on for Internet Explorer and Firefox browsers, you must ensure that
the FQDN or IP address is added to the client’s Trusted Sites list in the
client browsers. The default value is the FQDN of the M1 or P1 interface,
depending on which interface is used for proxy traffic.

Redirect Hostname

This setting specifies how long the Web Proxy waits before asking the client
for authentication credentials again. Until the Web Proxy asks for credentials
again, it uses the value stored in the surrogate (IP address or cookie).

Note that it is common for user agents, such as browsers, to cache the
authentication credentials so the user will not be prompted to enter credentials
each time.

Credential Cache Options:

Surrogate Timeout

When IP address is used as the authentication surrogate, this setting specifies
how long the Web Proxy waits before asking the client for authentication
credentials again when the client has been idle.

When this value is greater than the Surrogate Timeout value, this setting has
no effect and clients are prompted for authentication after the Surrogate Timeout
is reached.

You might want to use this setting to reduce the vulnerability of users who
leave their computers.

Credential Cache Options:

Client IP Idle Timeout

Specifies the number of entries that are stored in the authentication cache. Set
this value to safely accommodate the number of users that are actually using
this device. The default value is the recommended setting.

Credential Cache Options:

Cache Size
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DescriptionSetting

This setting specifies whether or not authenticated users are allowed to access
the Internet from multiple IP addresses simultaneously.

You might want to restrict access to one machine to prevent users from sharing
their authentication credentials with non-authorized users. When a user is
prevented from logging at a different machine, an end-user notification page
appears. You can choose whether or not users can click a button to login as a
different username using the Re-authentication setting on this page.

When you enable this setting, enter the restriction timeout value, which
determines how long users must wait before being able to log into a machine
with a different IP address. The restriction timeout value must be greater than
the surrogate timeout value.

You can remove a specific user or all users from the authentication cache using
the authcache CLI command.

User Session Restrictions

When using Credential Encryption or Access Control, you can choose whether
the appliance uses the digital certificate and key shipped with the appliance
(the Cisco Web Security Appliance Demo Certificate) or a digital certificate
and key you upload here.

To upload a digital certificate and key, click Browse and navigate to the
necessary file on your local machine. Then clickUpload Files after you select
the files you want.

Advanced

Step 6 Submit and commit your changes.

Authentication Sequences
• About Authentication Sequences, on page 111
• Creating Authentication Sequences, on page 112
• Editing And Reordering Authentication Sequences, on page 112
• Deleting Authentication Sequences, on page 113

About Authentication Sequences
Use authentication sequences to allow single Identities to authenticate users via different authentication servers
or protocols. Authentication sequences are also useful for providing backup options in case primary
authentication options become unavailable.

Authentication sequences are collections of two or more authentication realms. The realms used can have
different authentication servers and different authentication protocols. For more information on authentication
realms, see Authentication Realms, on page 94.

After you create a second authentication realm, the appliance automatically displays a Realm Sequences
section under Network > Authentication and includes a default authentication sequence named All Realms.
The All Realms sequence automatically includes each realm you define. You can change the order of the
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realms within the All Realms sequence, but you cannot delete the All Realms sequence or remove any realms
from it.

Which authentication realms within a sequence get used during authentication depends on:

• The authentication scheme used. This is generally dictated by the type of credentials entered at the client.
• The order in which realms are listed within the sequence (for Basic realms only, as only one NTLMSSP
realm is possible).

For optimal performance, authenticate clients on the same subnet using a single realm.Tip

Creating Authentication Sequences

Before you begin

• Create two or more authentication realms (see Authentication Realms, on page 94).
• If theWeb Security appliance is managed by a Security Management appliance, ensure that same-named
authentication realms on different Web Security appliances have identical properties defined on each
appliance.

• Be aware that AsyncOS will use the realms to process authentication sequentially, beginning with the
first realm in the list.

Step 1 Choose Network > Authentication

Step 2 Click Add Sequence.
Step 3 Enter a unique name for the sequence using alphanumeric and space characters.
Step 4 In the first row of the Realm Sequence for Basic Scheme area, choose the first authentication realm you want to include

in the sequence.
Step 5 In the second row of the Realm Sequence for Basic Scheme area, choose the next realm you want to include in the

sequence.
Step 6 (Optional) Click Add Row to include another realm that uses Basic credentials.
Step 7 If an NTLM realm is defined, choose an NTLM realm in the Realm for NTLMSSP Scheme field.

The Web Proxy uses this NTLM realm when the client sends NTLMSSP authentication credentials.

Step 8 Submit and commit your changes.

Editing And Reordering Authentication Sequences

Step 1 Choose Network > Authentication.
Step 2 Click the name of the sequence you wish to edit or re-order.
Step 3 Choose a realm name from the Realms drop-down list on the row corresponding to the position number you want the

realm to occupy in the sequence.
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For the All Realms sequence, you can only change the order of its realms, you cannot change the realms
themselves. To change the order of realms in the All Realms sequence, click the arrows in the Order column
to reposition the corresponding realms.

Note

Step 4 Repeat Step 3 until all realms are listed and ordered as required, ensuring that each realm name appears in one row only.
Step 5 Submit and commit your changes.

Deleting Authentication Sequences

Before you begin

Be aware that deleting an authentication sequence also disables associated identities, which in turn removes
those identities from associated policies.

Step 1 Choose Network > Authentication.
Step 2 Click the trash can icon for the sequence name.
Step 3 Click Delete to confirm that you want to delete the sequence.
Step 4 Commit your changes.

Failed Authentication
• About Failed Authentication, on page 113
• Bypassing Authentication with Problematic User Agents , on page 114
• Bypassing Authentication, on page 115
• Permitting Unauthenticated Traffic While Authentication Service is Unavailable, on page 115
• Granting Guest Access After Failed Authentication, on page 116
• Failed Authorization: Allowing Re-Authentication with Different Credentials, on page 117

About Failed Authentication
Users may be blocked from the web due to authentication failure for the following reasons:

• Client/user agent limitations. Some client applications may not properly support authentication. You
can bypass authentication for these clients by configuring Identification Profiles that do not require
authorization and basing their criteria on the clients (and, optionally, on the URLs they need to access).

• Authentication service is unavailable. An authentication service might be unavailable due to network
or server issues. You can choose to allow unauthenticated traffic in this circumstance.

• Invalid credentials. Some users may be unable to supply valid credentials for proper authentication (for
example, visitors or users awaiting credentials). You can choose to grant these users limited access to
the web.

Related Topics

• Bypassing Authentication with Problematic User Agents , on page 114
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• Bypassing Authentication, on page 115
• Permitting Unauthenticated Traffic While Authentication Service is Unavailable, on page 115
• Granting Guest Access After Failed Authentication, on page 116

Bypassing Authentication with Problematic User Agents
Some user agents are known to have authentication issues that can impact normal operations.

You should bypass authentication via the following user agents:

• Windows-Update-Agent
• MICROSOFT_DEVICE_METADATA_RETRIEVAL_CLIENT
• Microsoft BITS
• SLSSoapClient
• Akamai NetSession Interface
• Microsoft-CryptoAPI
• NCSI
• MSDW
• Gnotify
• msde
• Google Update

The access policies will still filter (based on URL categories) and scan (McAfee, Webroot) traffic as per the
access policy setup.

Note

Step 1 Configure the Identification Profile to bypass authentication with the specified user agents:
a) Select Web Security Manager > Identification Profile.
b) Click Add Identification Profile.
c) Enter information:

ValueOption

User Agent AuthExempt Identification ProfileName

Set to the first profile in the processing orderInsert Above

Leave blank.Define Members by Subnet

No Authentication Required.Define Members by Authentication

d) Click Advanced > User Agents.
e) Click None Selected.
f) Under Custom user Agents, specify the problematic User Agent strings.

Step 2 Configure the Access Policy:
a) Choose Web Security Manager > Access Policies.
b) Click Add Policy.
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c) Enter information:

ValueOption

Auth Exemption for User AgentsPolicy Name

Set to the first policy in the processing order.Insert Above Policy

User Agent AuthExempt Identification ProfileIdentification Profile Policy

NoneAdvanced

Step 3 Submit and commit your changes.

Bypassing Authentication
More InformationStep

Creating and Editing Custom URL
Categories, on page 168

Create a custom URL category that contains the affected
websites by configuring the Advanced properties.

1

Classifying Users and Client Software,
on page 125

Create an Identification Profile with these characteristics:

• Placed above all identities that require authentication.
• Includes the custom URL category.
• Includes affected client applications.
• Does not require authentication

2

Creating a Policy , on page 203Create a policy for the Identification Profile.3

Related Topics

• Bypassing the Web Proxy

PermittingUnauthenticatedTrafficWhileAuthenticationServiceisUnavailable

This configuration applies only when an authentication service is unavailable. It will not bypass authentication
permanently. For alternative options, see About Failed Authentication, on page 113

Note

Step 1 Choose Network > Authentication.
Step 2 Click Edit Global Settings.
Step 3 Click the Permit Traffic To Proceed Without Authentication in the Action If Authentication Service Unavailable

field.
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Step 4 Submit and commit your changes.

Granting Guest Access After Failed Authentication
Granting guest access requires that the following procedures are completed:

1. Define an Identification Profile that Supports Guest Access, on page 116
2. Use an Identification Profile that Supports Guest Access in a Policy, on page 116
3. (Optional) Configure How Guest User Details are Logged, on page 117

If an Identification Profile allows guest access and there is no user-defined policy that uses that Identification
Profile, users who fail authentication match the global policy of the applicable policy type. For example, if
MyIdentificationProfile allows guest access and there is no user-defined Access Policy that uses
MyIdentificationProfile, users who fail authentication match the global Access Policy. If you do not want
guest users to match a global policy, create a policy above the global policy that applies to guest users and
blocks all access.

Note

Define an Identification Profile that Supports Guest Access

Step 1 Choose Web Security Manager > Identification Profiles.
Step 2 Click Add Identification Profile to add a new identity, or click the name of an existing identity that you wish to use.
Step 3 Check the Support Guest Privileges check box.
Step 4 Submit and commit your changes.

Use an Identification Profile that Supports Guest Access in a Policy

Step 1 Choose a policy type from the Web Security Manager menu.
Step 2 Click a policy name in the policies table.
Step 3 Choose Select One Or More Identification Profiles from the Identification Profiles And Users drop-down list (if not

already chosen).
Step 4 Choose a profile that supports guest access from the drop-down list in the Identification Profile column.
Step 5 Click the Guests (Users Failing Authentication) radio button.

If this option is not available it means the profile you chose is not configured to support guest access. Return
to step 4 and choose another, or see Define an Identification Profile that Supports Guest Access, on page 116
to define a new one.

Note

Step 6 Submit and commit your changes.
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Configure How Guest User Details are Logged

Step 1 Choose Network > Authentication.

Step 2 Click Edit Global Settings.
Step 3 Click a Log Guest User By radio button, described below, in the Failed Authentication Handling field.

DescriptionRadio button

The IP address of the guest user’s client will be logged in the access logs.IP Address

The user name that originally failed authentication will be logged in the access logs.User Name As Entered By
End-User

Step 4 Submit and commit your changes.

Failed Authorization: Allowing Re-Authentication with Different Credentials
• About Allowing Re-Authentication with Different Credentials, on page 117
• Allowing Re-Authentication with Different Credentials, on page 117

About Allowing Re-Authentication with Different Credentials
Use re-authentication to allow users the opportunity to authenticate again, using different credentials, if the
credentials they previously used have failed authorization. A user may authenticate successfully but still be
prevented from accessing a web resource if not authorized to do so. This is because authentication merely
identifies users for the purpose of passing their verified credentials on to policies, but it is the policies that
authorize those users (or not) to access resources.

A user must have authenticated successfully to be allowed to re-authenticate.

• To use the re-authentication feature with user defined end-user notification pages, the CGI script that
parses the redirect URL must parse and use the Reauth_URL parameter.

Allowing Re-Authentication with Different Credentials

Step 1 Choose Network > Authentication.
Step 2 Click Edit Global Settings.

Step 3 Check the Re-Authentication Prompt If End User Blocked by URL Category Or User Session Restriction check
box.

Step 4 Click Submit.
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Tracking Identified Users

When the appliance is configured to use cookie-based authentication surrogates, it does not get cookie
information from clients for HTTPS and FTP over HTTP requests. Therefore, it cannot get the user name
from the cookie.

Note

Supported Authentication Surrogates for Explicit Requests

Credential Encryption EnabledCredential Encryption DisabledSurrogate
Types

Native FTPHTTPS &

FTP over HTTP

HTTPNative FTPHTTPS &

FTP over
HTTP

HTTPProtocol:

NANANAYesYesYesNo Surrogate

YesYesYesYesYesYesIP-based

Yes***No/Yes**YesYes***Yes***YesCookie-based

Supported Authentication Surrogates for Transparent Requests

See also the description of the Authentication Surrogates options in Classifying Users and Client Software,
on page 125.

Note

Credential Encryption EnabledCredential Encryption DisabledSurrogate
Types

Native FTPHTTPSHTTPNative FTPHTTPSHTTPProtocol:

NANANANANANANo Surrogate

No/Yes*No/Yes*YesNo/Yes*No/Yes*YesIP-based

No/Yes**No/Yes**YesNo/Yes**No/Yes**YesCookie-based

*Works after the client makes a request to an HTTP site and is authenticated. Before this happens, the behavior
depends on the transaction type:

• Native FTP transactions. Transactions bypass authentication.
• HTTPS transactions. Transactions are dropped. However, you can configure the HTTPS Proxy to
decrypt the first HTTPS request for authentication purposes.

** When cookie-based authentication is used, the Web Proxy cannot authenticate the user for HTTPS, native
FTP, and FTP over HTTP transactions. Due to this limitation, all HTTPS, native FTP, and FTP over HTTP
requests bypass authentication, so authentication is not requested at all.
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*** No surrogate is used in this case even though cookie-based surrogate is configured.

Related Topics

• Identification Profiles and Authentication , on page 130

Tracking Re-Authenticated Users
With re-authentication, if a more privileged user authenticates and is authorized, the Web Proxy caches this
user identity for different amounts of time depending on the authentication surrogates configured:

• Session cookie. The privileged user identity is used until the browser is closed or the session times out.
• Persistent cookie. The privileged user identity is used until the surrogate times out.
• IP address. The privileged user identity is used until the surrogate times out.
• No surrogate. By default, the Web Proxy requests authentication for every new connection, but when
re-authentication is enabled, the Web Proxy requests authentication for every new request, so there is an
increased load on the authentication server when using NTLMSSP. The increase in authentication activity
may not be apparent to a user, however, because most browsers will cache the privileged user credentials
and authenticate without prompting until the browser is closed. Also, when the Web Proxy is deployed
in transparent mode, and the “Apply same surrogate settings to explicit forward requests” option is not
enabled, no authentication surrogates are used for explicit forward requests and increased load will occur
with re-authentication.

If theWeb Security appliance uses cookies for authentication surrogates, Cisco recommends enabling credential
encryption.

Note

Credentials
Authentication credentials are obtained from users by either prompting them to enter their credentials through
their browsers, or another client application, or by obtaining the credentials transparently from another source.

• Tracking Credentials for Reuse During a Session, on page 119
• Authentication and Authorization Failures, on page 120
• Credential Format, on page 120
• Credential Encryption for Basic Authentication, on page 120

Tracking Credentials for Reuse During a Session
Using authentication surrogates, after a user authenticates once during a session, you can track credentials for
reuse throughout that session rather than having the user authenticate for each new request. Authentication
surrogates may be based on the IP address of the user’s workstation or on a cookie that is assigned to the
session.

For Internet Explorer, be sure the Redirect Hostname is the short host name (containing no dots) or the NetBIOS
name rather than a fully qualified domain. Alternatively, you can add the appliance host name to Internet
Explorer’s Local intranet zone (Tools > Internet options > Security tab); however, this will be required on
every client. For more information about this, see How do I properly set up NTLM with SSO (credentials
sent transparently)?
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With Firefox and other non-Microsoft browsers, the parameters network.negotiate-auth.delegation-uris,
network.negotiate-auth.trusted-uris and network.automatic-ntlm-auth.trusted-uris must be set to the
transparent-mode Redirect Hostname. You also can refer to Firefox is not sending authentication credentials
transparently (SSO) . This article provides general information about changing Firefox parameters.

For information about the Redirect Hostname, see Configuring Global Authentication Settings, on page 106,
or the CLI command sethostname.

Authentication and Authorization Failures
If authentication fails for accepted reasons, such as incompatible client applications, you can grant guest
access.

If authentication succeeds but authorization fails, it is possible to allow re-authentication using a different set
of credentials that may be authorized to access the requested resource.

Related Topics

• Granting Guest Access After Failed Authentication, on page 116
• Allowing Re-Authentication with Different Credentials, on page 117

Credential Format
Credential FormatAuthentication Scheme

MyDomain\jsmithNTLMSSP

jsmith

MyDomain\jsmith

If the user does not enter theWindows domain, theWeb Proxy prepends
the default Windows domain.

Note

Basic

Credential Encryption for Basic Authentication

About Credential Encryption for Basic Authentication
Enable credential encryption to transmit credentials over HTTPS in encrypted form. This increases security
of the basic authentication process.

TheWeb Security appliance uses its own certificate and private key by default to create an HTTPS connection
with the client for the purposes of secure authentication. Most browsers will warn users, however, that this
certificate is not valid. To prevent users from seeing the invalid certificate message, you can upload a valid
certificate and key pair that your organization uses.

Configuring Credential Encryption

Before you begin

• Configure the appliance to use IP surrogates.

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
120

Acquire End-User Credentials
Authentication and Authorization Failures

http://www.cisco.com/c/en/us/support/docs/security/web-security-appliance/118027-config-wsa-00.html
http://www.cisco.com/c/en/us/support/docs/security/web-security-appliance/118027-config-wsa-00.html
http://www.toptip.ca/2010/03/change-secret-configuration-parameters.html


• (Optional) Obtain a certificate and unencrypted private key. The certificate and key configured here are
also used by Access Control.

Step 1 Choose Network > Authentication.
Step 2 Click Edit Global Settings.
Step 3 Check the Use Encrypted HTTPS Connection For Authentication check box in the Credential Encryption field.
Step 4 (Optional) Edit the default port number (443) in the HTTPS Redirect Port field for client HTTP connections during

authentication.
Step 5 (Optional) Upload a certificate and key:

a) Expand the Advanced section.
b) Click Browse in the Certificate field and find the certificate file you wish to upload.
c) Click Browse in the Key field and find the private key file you wish to upload.
d) Click Upload Files.

Step 6 Submit and commit your changes.

What to do next

Related Topics

• Certificate Management, on page 448.

Troubleshooting Authentication
• LDAP User Fails Authentication due to NTLMSSP, on page 471
• LDAP Authentication Fails due to LDAP Referral, on page 471
• Basic Authentication Fails, on page 472
• Users Erroneously Prompted for Credentials, on page 472
• HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require Authentication,
on page 485

• Cannot Access URLs that Do Not Support Authentication, on page 491
• Client Requests Fail Upstream Proxy, on page 492
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C H A P T E R 7
Classify End-Users for Policy Application

This chapter contains the following sections:

• Overview of Classify Users and Client Software, on page 123
• Classify Users and Client Software: Best Practices, on page 124
• Identification Profile Criteria, on page 124
• Classifying Users and Client Software, on page 125
• Identification Profiles and Authentication , on page 130
• Troubleshooting Identification Profiles, on page 132

Overview of Classify Users and Client Software
Identification Profiles let you classify users and user agents (client software) for these purposes:

• Group transaction requests for the application of policies (except SaaS)
• Specification of identification and authentication requirements

AsyncOS assigns an Identification Profile to every transaction:

• Custom Identification Profiles — AsyncOS assigns a custom profile based on that identity’s criteria.
• The Global Identification Profile — AsyncOS assigns the global profile to transactions that do not meet
the criteria for any custom profile. By default, the global profile does not require authentication.

AsyncOS processes Identification Profiles sequentially, beginning with the first. The global profile is the last
profile.

An Identification Profile may include only one criterion. Alternately, Identification Profiles that include
multiple criteria require that all the criteria are met.

One policy may call on multiple Identification Profiles:
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This Identification Profile allows guest access and applies to users who fail
authentication.

1

Authentication is not used for this Identification Profile.2

The specified user groups in this Identification Profile are authorized for this policy.3

This Identification Profile uses an authentication sequence and this policy applies to
one realm in the sequence.

4

Classify Users and Client Software: Best Practices
• Create fewer, more general Identification Profiles that apply to all users or fewer, larger groups of users.
Use policies, rather than profiles, for more granular management.

• Create Identification Profiles with unique criteria.
• If deployed in transparent mode, create an Identification Profile for sites that do not support authentication.
See Bypassing Authentication, on page 115.

Identification Profile Criteria
These transaction characteristics are available to define an Identification Profile:

DescriptionOption

The client subnet must match the list of subnets in a policy.Subnet

The protocol used in the transaction: HTTP, HTTPS, SOCKS, or native FTP.Protocol

The proxy port of the request must be in the Identification Profile’s list of ports,
if any are listed. For explicit forward connections, this is the port configured in
the browser. For transparent connections, this is the same as the destination port.

Port
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DescriptionOption

The user agent (client application) making the request must be in the Identification
Profile’s list of user agents, if any are listed. Some user agents cannot handle
authentication, therefore creating an profile that does not require authentication is
necessary. User agents include programs such as updaters and browsers, such as
Internet Explorer and Mozilla Firefox.

User Agent

The URL category of the request URL must be in the Identification Profile’s list
of URL categories, if any are listed.

URL Category

If the Identification Profile requires authentication, the client authentication
credentials must match the Identification Profile’s authentication requirements.

Authentication
requirements

Classifying Users and Client Software
Before you begin

• Create authentication realms. See How to Create an Active Directory Authentication Realm (NTLMSSP
and Basic), on page 99 or Creating an LDAP Authentication Realm, on page 101 .

• Be aware that when you commit changes to Identification Profiles, end-users must re-authenticate.

• If you are in Cloud Connector mode, be aware that an additional Identification Profile option is available:
Machine ID. See Identifying Machines for Policy Application, on page 53.

• (Optional) Create authentication sequences. See Creating Authentication Sequences, on page 112

• (Optional) Enable Secure Mobility if the Identification Profile will include mobile users.

• (Optional) Understand authentication surrogates. See Tracking Identified Users, on page 118 .

Step 1 Choose Web Security Manager > Identification Profiles.
Step 2 Click Add Profile to add a profile.
Step 3 Use the Enable Identification Profile check box to enable this profile, or to quickly disable it without deleting it.
Step 4 Assign a unique profile Name.
Step 5 A Description is optional.
Step 6 From the Insert Above drop-down list, choose where this profile is to appear in the table.

Position Identification Profiles that do not require authentication above the first Identification Profile that
requires authentication.

Note

Step 7 In theUser Identification Method section, choose an identificationmethod and then supply related parameters; displayed
options vary according to the method chosen.
a) Choose an identification method from the User Identification Method drop-down list.
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DescriptionOption

Users are identified primarily by IP address. No additional parameters are required.Exempt from
authentication/
identification

Users are identified by the authentication credentials they enter.Authenticate users

Available when the ISE service is enabled (Network > Identity Services Engine). For
these transactions, the user name and associated Secure Group Tags will be obtained
from the Identity Services Engine. In ISE-PIC deployments, ISE groups and users
information is received. For more information, see Tasks for Integrating the ISE/ISE-PIC
Service, on page 143.

Transparently identify
users with ISE

This option is available when one or more authentication realms are configured to
support transparent identification.

Transparently identify
users with authentication
realm

When at least one Identification Profile with authentication or transparent identification is configured, the
policy tables will support defining policy membership using user names, directory groups, and Secure
Group Tags.

Note

b) Supply parameters appropriate to the chosen method. Not all of the sections described in this table are visible for
each choice.

If user authentication is not available from ISE:

• Support Guest Privileges – The transaction will be allowed to continue, and will
match subsequent policies for Guest users from all Identification Profiles.

• Block Transactions – Do not allow Internet access to users who cannot be
identified by ISE.

• Support Guest privileges – Check this box to grant guest access to users who fail
authentication due to invalid credentials.

Fallback to Authentication
Realm or Guest Privileges
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Select a Realm or Sequence—Choose a defined authentication realm or sequence.

Select a Scheme—Choose an authentication scheme:

• Kerberos—The client is transparently authenticated by means of Kerberos tickets.

• Basic – The client always prompts users for credentials. After the user enters
credentials, browsers typically offer a check box to remember the provided
credentials. Each time the user opens the browser, the client either prompts for
credentials or resends the previously saved credentials.

Credentials are sent unsecured as clear text (Base64). A packet capture between
the client and Web Security appliance can reveal the user name and passphrase.

• NTLMSSP—The client transparently authenticates using its Windows login
credentials. The user is not prompted for credentials.

However, the client prompts the user for credentials under the following
circumstances:

• The Windows credentials failed.

• The client does not trust the Web Security appliance because of browser
security settings.

Credentials are sent securely using a three-way handshake (digest style
authentication). The passphrase is never sent across the connection.

• Support Guest privileges – Check this box to grant guest access to users who fail
authentication due to invalid credentials.

Authentication Realm

• Select a Realm or Sequence – Choose a defined authentication realm or sequence.Realm for Group
Authentication
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Specify how transactions will be associated with a user after successful authentication
(options vary depending on Web Proxy deployment mode):

• IP Address – TheWeb Proxy tracks an authenticated user at a particular IP address.
For transparent user identification, select this option.

• Persistent Cookie – The Web Proxy tracks an authenticated user on a particular
application by generating a persistent cookie for each user per application. Closing
the application does not remove the cookie.

• Session Cookie – The Web Proxy tracks an authenticated user on a particular
application by generating a session cookie for each user per domain per application.
(However, when a user provides different credentials for the same domain from
the same application, the cookie is overwritten.) Closing the application removes
the cookie.

• No Surrogate – The Web Proxy does not use a surrogate to cache the credentials,
and it tracks an authenticated user for every new TCP connection.When you choose
this option, the web interface disables other settings that no longer apply. This
option is available only in explicit forward mode and when you disable credential
encryption on the Network > Authentication page.

• Apply same surrogate settings to explicit forward requests – Check to apply
the surrogate used for transparent requests to explicit requests; enables credential
encryption automatically. This option appears only when theWeb Proxy is deployed
in transparent mode.

Note • You can define a timeout valve for the authentication surrogate for all
requests in Global Authentication Settings.

Authentication Surrogates

Step 8 In the Membership Definition section, supply membership parameters appropriate to the chosen identification method.
Note that all of the options described in this table are not available to every User Identification Method.

Membership Definition

Configure this Identification Profile to apply to:Local Users Only,Remote Users Only,
or Both. This selection affects the available authentication settings for this Identification
Profile.

Define Members by User
Location

Enter the addresses to which this Identification Profile should apply. You can use IP
addresses, CIDR blocks, and subnets.

If nothing is entered, the Identification Profile applies to all IP addresses.Note

Define Members by Subnet

Select the protocols to which this Identification Profile should apply; select all that apply:

• HTTP/HTTPS – Applies to all requests that use HTTP or HTTPS as the underlying
protocol, including FTP over HTTP, and any other protocol tunneled using HTTP
CONNECT.

• Native FTP – Applies to native FTP requests only.

• SOCKS – Applies to SOCKS Policies only

Define Members by
Protocol
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• Do Not Use Machine ID in This Policy – The user is not identified by machine
ID.

• Define User Authentication Policy Based on Machine ID – The user is identified
primarily by machine ID.

Click the Machine Groups area to display the Authorized Machine Groups page.

For each group you want to add, in the Directory Search field, start typing the name
of the group to add and then click Add. You can select a group and click Remove
to remove it from the list.

Click Done to return to the previous page.

Click the Machine IDs area to display the Authorized Machines page.

In the AuthorizedMachines, field, enter the machine IDs to associate with the policy
then click Done.

Authentication using Machine ID is supported only in Connector mode and
requires Active Directory.

Note

Define Members by
Machine ID

Expand this section to define additional membership requirements.

• Proxy Ports – Specify one or more proxy ports used to access theWeb Proxy. Enter
port numbers separated by commas. For explicit forward connections, the proxy
port is configured in the browser.

For transparent connections, this is the same as the destination port.

Defining identities by port works best when the appliance is deployed in explicit
forward mode, or when clients explicitly forward requests to the appliance. Defining
identities by port when client requests are transparently redirected to the appliance
may result in some requests being denied.

• URL Categories – Select user-defined or predefined URL categories. Membership
for both is excluded by default, meaning theWeb Proxy ignores all categories unless
they are selected in the Add column.

If you need to define membership by URL category, only define it in the Identity
group when you need to exempt from authentication requests to that category.

• User Agents – Defines policy group membership by the user agents found in the
client request. You can select some commonly defined agents, or define your own
using regular expressions.

Also specify whether these user-agent specifications are inclusive or exclusive. In
other words, whether membership definition includes only the selected user agents,
or specifically excludes the selected user agents

Advanced

Step 9 Submit and Commit Changes.

What to do next

• Overview of Acquire End-User Credentials, on page 83
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• Managing Web Requests Through Policies Task Overview, on page 199

Enable/Disable an Identity

Before you begin

• Be aware that disabling an Identification Profile removes it from associated policies.
• Be aware that re-enabling an Identification Profile does not re-associate it with any policies.

Step 1 Choose Web Security Manager > Identification Profiles.
Step 2 Click a profile in the Identification Profiles table to open the Identification Profile page for that profile.
Step 3 Check or clear Enable Identification Profile immediately under Client/User Identification Profile Settings.
Step 4 Submit and Commit Changes.

Identification Profiles and Authentication
The following diagram shows how the Web Proxy evaluates a client request against an Identification Profile
when the Identification Profiles is configured to use:

• No authentication surrogates
• IP addresses as authentication surrogates
• Cookies as authentication surrogates with transparent requests
• Cookies as authentication surrogates with explicit requests and credential encryption is enabled
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Figure 1: Identification Profiles and Authentication Processing – No Surrogates and IP-based Surrogates

The following diagram shows how the Web Proxy evaluates a client request against an Identification Profile
when the Identification Profile is configured to use cookies as the authentication surrogates, credential
encryption is enabled, and the request is explicitly forwarded.
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Figure 2: Identification Profiles and Authentication Processing – Cookie-based Surrogates

Troubleshooting Identification Profiles
• Basic Authentication Problems, on page 472
• Policy Problems, on page 484
• Policy is Never Applied, on page 485
• Policy Troubleshooting Tool: Policy Trace, on page 486
• Upstream Proxy Problems, on page 491
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C H A P T E R 8
SaaS Access Control

This chapter contains the following sections:

• Overview of SaaS Access Control, on page 133
• Configuring the Appliance as an Identity Provider, on page 134
• Using SaaS Access Control and Multiple Appliances, on page 135
• Creating SaaS Application Authentication Policies, on page 136
• Configuring End-user Access to the Single Sign-on URL, on page 138

Overview of SaaS Access Control
The Web Security appliance uses the Security Assertion Markup Language (SAML) to authorize access to
SaaS applications. It works with SaaS applications that are strictly compliant with SAML version 2.0.

Cisco SaaS Access Control allows you to:

• Control which users can access SaaS applications and from where.
• Quickly disable access to all SaaS applications when users are no longer employed by the organization.
• Reduce the risk of phishing attacks that ask users to enter their SaaS user credentials.
• Choose whether users are transparently signed in (single sign-on functionality) or prompted to enter their
authentication user name and pass phrase.

SaaS Access Control only works with SaaS applications that require an authentication mechanism that is
supported by the Web Security appliance. Currently, the Web Proxy uses the “PasswordProtectedTransport”
authentication mechanism.

To enable SaaS Access Control, you must configure settings on both theWeb Security appliance and the SaaS
application:

Procedure

PurposeCommand or Action

Configuring the Appliance as an Identity Provider, on page
134

Configure the Web Security appliance as an identity
provider.

Step 1

Creating SaaS Application Authentication Policies, on page
136

Create an authentication policy for the SaaS application.Step 2
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PurposeCommand or Action

Configuring End-user Access to the Single Sign-on URL,
on page 138

Configure the SaaS application for single sign-on.Step 3

Using SaaS Access Control and Multiple Appliances, on
page 135

(Optional) Configue multiple Web Security appliances.Step 4

Configuring the Appliance as an Identity Provider
When you configure the Web Security appliance as an identity provider, the settings you define apply to all
SaaS applications it communicates with. The Web Security appliance uses a certificate and key to sign each
SAML assertion it creates.

Before you begin

• (Optional) Locate a certificate (PEM format) and key for signing SAML assertions.
• Upload the certificate to each SaaS application.

Step 1 Choose Network > Identity Provider for SaaS.
Step 2 Click Edit Settings.
Step 3 Check Enable SaaS Single Sign-on Service.
Step 4 Enter a virtual domain name in the Identity Provider Domain Name field.
Step 5 Enter a unique text identifier in the Identity Provider Entity ID field (a URI formatted string is recommended).
Step 6 Either upload or generate a certificate and key:

Additional StepsMethod

a. Select Use Uploaded Certificate and Key.

b. In the Certificate field, click Browse; locate the file to upload.

The Web Proxy uses the first certificate or key in the file. The certificate
file must be in PEM format. DER format is not supported.

Note

c. In the Key field, click Browse; locate the file to upload.

If the key is encrypted, select Key is Encrypted.

The key length must be 512, 1024, or 2048 bits. The private key file must
be in PEM format. DER format is not supported.

Note

d. Click Upload Files.
e. Click Download Certificate to download a copy of the certificate for transfer to the

SaaS applications with which the Web Security appliance will communicate.

Upload a certificate and
key
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Additional StepsMethod

a. Select Use Generated Certificate and Key.

b. Click Generate New Certificate and Key.

1. In the Generate Certificate and Key dialog box, enter the information to display
in the signing certificate.

You can enter any ASCII character except the forward slash ( / ) in
the Common Name field.

Note

2. Click Generate.

c. Click Download Certificate to transfer the certificate to the SaaS applications with
which the Web Security appliance will communicate.

d. (Optional) To use a signed certificate, click the Download Certificate Signing
Request (DCSR) link to submit a request to a certificate authority (CA). After you
receive a signed certificate from the CA, click Browse and navigate to the signed
certificate location. Click Upload File. (bug 37984)

Generate a certificate and
key

If the appliance has both an uploaded certificate and key pair and a generated certificate and key pair, it only
uses the certificate and key pair currently selected in the Signing Certificate section.

Note

Step 7 Make note of the settings when you configure the appliance as an identity provider. Some of these settings must be used
when configuring the SaaS application for single sign-on.

Step 8 Submit and Commit Changes.

What to do next

After specifying the certificate and key to use for signing SAML assertions, upload the certificate to each
SaaS application.

Related Topics

• Configuring End-user Access to the Single Sign-on URL, on page 138

Using SaaS Access Control and Multiple Appliances
Before you begin

Configuring the Appliance as an Identity Provider, on page 134

Step 1 Configure the same Identity Provider Domain Name for each Web Security appliance.
Step 2 Configure the same Identity Provider Entity ID for each Web Security appliance.
Step 3 Upload the same certificate and private key to each appliance on the Network > Identity Provider for SaaS page.
Step 4 Upload this certificate to each SaaS application you configure.
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Creating SaaS Application Authentication Policies
Before you begin

• Create associated identities.
• Configure Identity Provider, see Configuring the Appliance as an Identity Provider, on page 134.
• Provide an Identity Provider Signing Certificate and Key: Network > Identity Provider for SaaS > Enable
and Edit Settings.

• Create an Authentication Realm, Authentication Realms, on page 94.

Step 1 Choose Web Security Manager > SaaS Policies.

Step 2 Click Add Application.
Step 3 Configure the settings:

DescriptionProperty

Enter a name to identify the SaaS application for this policy; each application name must be
unique. TheWeb Security appliance uses the application name to generate a single sign-on URL.

Application Name

(Optional) Enter a description for this SaaS policy.Description

Configure the metadata that describes the service provider referenced in this policy. You can
either describe the service provider properties manually or upload a metadata file provided by
the SaaS application.

The Web Security appliance uses the metadata to determine how to communicate with the SaaS
application (service provider) using SAML. Contact the SaaS application to learn the correct
settings to configure the metadata.

Configure Keys Manually – If you select this option, provide the following:

• Service Provider Entity ID. Enter the text (typically in URI format) the SaaS application
uses to identify itself as a service provider.

• Name ID Format. Choose from the drop-down list the format the appliance should use to
identify users in the SAML assertion it sends to service providers. The value you enter here
must match the corresponding setting configured on the SaaS application.

• Assertion Consumer Service URL. Enter the URL to which the Web Security appliance
is to send the SAML assertion it creates. Read the SaaS application documentation to
determine the correct URL to use (also known as the login URL).

Import File from Hard Disk – If you select this option, click Browse, locate the file, and then
click Import.

This metadata file is an XML document, following the SAML standard, that describes
a service provider instance. Not all SaaS applications use metadata files, but for those
that do, contact the SaaS application provider for the file.

Note

Metadata for Service
Provider
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DescriptionProperty

Specify how users are identified/authenticated for SaaS single sign-on:

• Always prompt users for their local authentication credentials.
• Prompt users for their local authentication credentials if the Web Proxy obtained their user
names transparently.

• Automatically sign in SaaS users using their local authentication credentials.

Choose the authentication realm or sequence the Web Proxy should use to authenticate users
accessing this SaaS application. Users must be a member of the authentication realm or
authentication sequence to successfully access the SaaS application. If an Identity Services
Engine is used for authentication, and LDAP was selected, the realm will be used for the SAML
user names and attribute mapping.

User Identification /
Authentication for
SaaS SSO

Specify how the Web Proxy should represent user names to the service provider in the SAML
assertion. You can pass the user names as they are used inside your network (No mapping), or
you can change the internal user names into a different format using one of the followingmethods:

• LDAP query. The user names sent to the service provider are based on one or more LDAP
query attributes. Enter an expression containing LDAP attribute fields and optional custom
text. You must enclose attribute names in angled brackets. You can include any number of
attributes. For example, for the LDAP attributes “user” and “domain,” you could enter
<user>@<domain>.com.

• Fixed Rule Mapping. The user names sent to the service provider are based on the internal
user name with a fixed string added before or after the internal user name. Enter the fixed
string in the Expression Name field, with %s either before or after the string to indicate
its position in the internal user name.

SAML User Name
Mapping

(Optional) You can provide to the SaaS application additional information about the internal
users from the LDAP authentication server if required by the SaaS application. Map each LDAP
server attribute to a SAML attribute.

SAML Attribute
Mapping

Choose the authentication mechanism the Web Proxy uses to authenticate its internal users.

The authentication context informs the service provider which authentication
mechanism the identity provider used to authenticate the internal users. Some service
providers require a particular authentication mechanism to allow users to access the
SaaS application. If a service provider requires an authentication context that is not
supported by an identity provider, users cannot access the service provider using
single sign-on from the identity provider.

Note

Authentication
Context

Step 4 Submit and Commit Changes.

What to do next

Set up the single sign-on settings on the SaaS application side, using the same parameters to configure the
application.
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Configuring End-user Access to the Single Sign-on URL
After you configure the Web Security appliance as an identity provider and create a SaaS Application
Authentication Policy for the SaaS application, the appliance creates a single sign-on URL (SSO URL). The
Web Security appliance uses the application name configured in the SaaS Application Authentication Policy
to generate the single sign-on URL; the SSO URL format is:

http://IdentityProviderDomainName /SSOURL/ApplicationName

Step 1 Obtain the single sign-on URL from the Web Security Manager > SaaS Policies page.
Step 2 Make the URL available to end-users depending on which flow type.
Step 3 If you choose Identity provider initiated flow, the appliance redirects users to the SaaS application.
Step 4 If you choose Service Provider initiated flows, you must configure this URL in the SaaS application.

• Always prompt SaaS users for proxy authentication. After entering valid credentials, users are logged into the SaaS
application.

• Transparently sign in SaaS users. Users are logged into the SaaS application automatically.

To achieve single sign-on behavior using explicit forward requests for all authenticated users when the
appliance is deployed in transparent mode, select “Apply same surrogate settings to explicit forward
requests” when you configure the Identity group.

Note
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C H A P T E R 9
Integrate the Cisco Identity Services Engine (ISE)
/ ISE Passive Identity Controller (ISE-PIC)

This chapter contains the following sections:

• Overview of the Identity Services Engine (ISE) / ISE Passive Identity Controller (ISE-PIC) Service, on
page 139

• ISE/ISE-PIC Certificates, on page 141
• Fallback Authentication, on page 142
• Tasks for Integrating the ISE/ISE-PIC Service, on page 143
• Acquiring ISE/ISE-PIC ERS Server Details from ISE/ISE-PIC, on page 149
• VDI (Virtual Desktop Infrastructure) User Authentication in ISE/ISE-PIC Integrations, on page 150
• Troubleshooting Identity Services Engine Problems, on page 151

Overview of the Identity Services Engine (ISE) / ISE Passive
Identity Controller (ISE-PIC) Service

Cisco’s Identity Services Engine (ISE), and Passive Identity Connector (ISE-PIC) are applications that run
on separate servers in your network to provide enhanced identity management. The Web Security appliance
can access user-identity information from an ISE or ISE-PIC server.When either ISE, or ISE-PIC is configured,
information is retrieved (user names and associated Secure Group Tags from ISE, user names and Active
Directory groups from ISE-PIC) for appropriately configured Identification Profiles, to allow transparent user
identification in policies configured to use those profiles.
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• The ISE/ISE-PIC service is not available in Connector mode.

• ISE/ISE-PIC version 2.4, and PxGrid version 2.0 are supported.

• The ISE configuration page in the Web Security appliance's web interface is used to configure ISE or
ISE-PIC servers, upload certificates, and to connect to either ISE or ISE-PIC services. The steps to
configure ISE or ISE-PIC are similar and the any details specific for ISE-PIC configurations have been
mentioned where applicable.

Table 1: Web Security Appliance -ISE Version Support Matrix

ISE VersionsWeb
Security
Appliance
Versions

ISEv2.7_p3ISEv2.7_p2ISEv2.7_p1ISEv2.6_p8ISEv2.6_p7ISEv2.6_p6ISEv2.6_p5ISEv2.4_p13ISEv2.4_p12

–SupportedSupportedSupportedSupportedSupportedSupported–Supportedcoeus-11-7-*

Table 2: Web Security Appliance -ISE Scale Support Matrix

Session Scale With AD Group EnabledSession Scale Without AD
Group Enabled

Models

MaximumSupported End
Points

(AD group entries for
each user, and end point
in ISE database.)

Maximum Supported
Active Sessions

Maximum Supported
Active Sessions

-

400K125K200KS680,S690,S695

150K50K150KS380,S390, S600V

75K50K50KS190,S195,S300V

50K40K50KS100V

Note

Related Topics

• About pxGrid, on page 140

• About the ISE/ISE-PIC Server Deployment and Failover, on page 141

About pxGrid
Cisco’s Platform Exchange Grid (pxGrid) enables collaboration between components of the network
infrastructure, including security-monitoring and network-detection systems, identity and access management
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platforms, and so on. These components can use pxGrid to exchange information via a publish/subscribe
method.

There are essentially three pxGrid components: the pxGrid publisher, the pxGrid client, and the pxGrid
controller.

• pxGrid publisher – Provides information for the pxGrid client(s).

• pxGrid client – Any system, such as theWeb Security appliance, that subscribes to published information;
in this case, Security Group Tag (SGT), Active Directory groups, user-group, and profiling information.

• pxGrid controller – In this case, the ISE/ISE-PIC pxGrid node that controls the client
registration/management and topic/subscription processes.

Trusted certificates are required for each component, and these must be installed on each host platform.

About the ISE/ISE-PIC Server Deployment and Failover
A single ISE/ISE-PIC node set-up is called a standalone deployment, and this single node runs the
Administration, and Policy Service. To support failover and to improve performance, youmust set upmultiple
ISE/ISE-PIC nodes in a distributed deployment. The minimum required distributed ISE/ISE-PIC configuration
to support ISE/ISE-PIC failover on your Web Security appliance is:

• Two pxGrid nodes

• Two Administration nodes

• One Policy Service node

This configuration is referred to in the Cisco Identity Services Engine Hardware Installation Guide as a
'Medium-Sized Network Deployment'. Refer to the network deployments section in that installation guide for
additional information.

Related Topics

• ISE/ISE-PIC Certificates, on page 141

• Tasks for Integrating the ISE/ISE-PIC Service, on page 143

• Connect to the ISE/ISE-PIC Services, on page 145

• Troubleshooting Identity Services Engine Problems, on page 151

ISE/ISE-PIC Certificates

This section describes the certificates necessary for an ISE/ISE-PIC connection. Tasks for Integrating the
ISE/ISE-PIC Service, on page 143 provides detailed information about these certificates. Certificate
Management, on page 448, provides general certificate-management information for AsyncOS.

Note

A set of two certificates is required for mutual authentication and secure communication between the Web
Security appliance and each ISE/ISE-PIC server:
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• WSA Client Certificate – Used by the ISE/ISE-PIC server to authenticate the Web Security appliance.

• ISE pxGrid Certificate – Used by the Web Security appliance to authenticate an ISE/ISE-PIC server
on port 5222 for Web Security appliance-ISE/ISE-PIC data subscription (on-going publish/subscribe
queries to the ISE/ISE-PIC server).

These two certificates can be Certificate Authority (CA)-signed or self-signed. AsyncOS provides the option
to generate a self-signedWSAClient certificate, or a Certificate Signing Request (CSR) instead, if a CA-signed
certificate is needed. Similarly, the ISE/ISE-PIC server provides the option to generate self-signed ISE/ISE-PIC
pxGrid certificates, or CSRs instead if CA-signed certificates are needed.

Related Topics

• Using Self-signed Certificates, on page 142

• Using CA-signed Certificates, on page 142

• Overview of the Identity Services Engine (ISE) / ISE Passive Identity Controller (ISE-PIC) Service, on
page 139

• Tasks for Integrating the ISE/ISE-PIC Service, on page 143

• Connect to the ISE/ISE-PIC Services, on page 145

Using Self-signed Certificates
When self-signed certificates are used on the ISE/ISE-PIC server, the ISE/ISE-PIC pxGrid certificate developed
on the ISE/ISE-PIC server, as well as the WSA Client certificate developed on the Web Security appliance
must be added to the Trusted Certificates store on the ISE/ISE-PIC server (On ISE - Administration >
Certificates > Trusted Certificates > Import; on ISE-PIC - Certificates > Trusted Certificates > Import).

Using CA-signed Certificates
In the case of CA-signed certificates:

• On the ISE/ISE-PIC server, ensure the appropriate CA root certificate for the WSA Client certificate is
present in the Trusted Certificates store (Administration > Certificates > Trusted Certificates).

• On the Web Security appliance, ensure the appropriate CA root certificates are present in the Trusted
Certificates list (Network > Certificate Management > Manage Trusted Root Certificates).

• On the Identity Services Engine page (Network > Identity Services Engine), be sure to upload the CA
root certificate for the ISE/ISE-PIC pxGrid certificate.

Fallback Authentication
For user information not available in ISE/ISE-PIC, you can configure a fallback authentication. Ensure you
have the following for successful fallback authentication.

• Identification profile configured with a fallback option of Active Directory based realm.

• Access policy with the correct Identification profile which contains the fallback option.
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Tasks for Integrating the ISE/ISE-PIC Service

• ISE/ISE-PIC version 2.4, and PxGrid version 2.0 are supported.

• To continue using existing access policies with ISE-PIC, you must edit the respective identification
profiles to use ISE-PIC and identify users transparently. This applies to identification profiles using
CDA. If you are migrating from CDA identification, to ISE-PIC based identification, you must edit the
respective identification profiles.

Note

• Reconfigure the ISE on the Web Security appliance, if you are upgrading from AsyncOS 11.5 or earlier
versions to AsyncOS 11.7 or later versions.

• The certificate must be generated through the ISE/ISE-PIC device and the generated certificate must be
uploaded to the Web Security appliance.

Note

Links to Topics and ProceduresTaskStep

Generating Certificate through ISE/ISE-PIC, on page 144Generate certificate through
ISE/ISE-PIC device

1

Configuring ISE/ISE-PIC server for Web Security Appliance
Access, on page 144

Configure the ISE/ISE-PIC
for Web Security appliance
access.

2

Connect to the ISE/ISE-PIC Services, on page 145Configure and enable
ISE/ISE-PIC Services in the
Web Security Appliance.

3

Import the Self-signed Web Security Appliance Client
Certificate to ISE/ISE-PIC Standalone Deployment, on page
147

Import the Self-signed Web Security Appliance Client
Certificate to ISE/ISE-PIC Distributed Deployment, on page
147

If theWeb Security appliance
Client Certificate is
self-signed, import it to
ISE/ISE-PIC.

4

Configuring logging for ISE/ISE-PIC, on page 149If required, configure logging
in the Web Security
appliance.

5

Acquiring ISE/ISE-PICERSServerDetails from ISE/ISE-PIC,
on page 149

Acquire ISE/ISE-PIC ERS
server details.

6
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Related Topics

• Overview of the Identity Services Engine (ISE) / ISE Passive Identity Controller (ISE-PIC) Service, on
page 139

• ISE/ISE-PIC Certificates, on page 141

• Troubleshooting Identity Services Engine Problems, on page 151

Generating Certificate through ISE/ISE-PIC

The certificate that is generated through the ISE/ISE-PIC device must be in the PKCS12 format.Note

• ISE/ISE-PIC:

Step 1 Choose Work Centres > PassiveID > Subscribers > Certificates.
Step 2 Choose PKCS 12 format from the Certificate Download Format drop-down list. Enter other appropriate information

on the Certificates tab and generate a pxGrid certificate.
Step 3 Extract Root CA, WSA Client Certificate, and WSA Client Key from the generated XXX.pk12 file using the openssl

command:

• Root CA: openssl pkcs12 -in XXX.p12 -cacerts -nokeys -chain -out RootCA.pem

• WSA Client Certificate: openssl pkcs12 -in XXX.p12 -clcerts -nokeys -out publicCert.pem

• WSA Client Key: openssl pkcs12 -in XXX.p12 -nocerts -nodes -out privateKey.pem

Use the same certificate password that you have entered on the ISE web interface while performing step 2.Note

Follow the same steps to generate the secondary Root CA, WSA Client Certificate, and WSA Client Key
through the secondary/failover ISE server.

Note

Configuring ISE/ISE-PIC server for Web Security Appliance Access
• ISE

• Each ISE server must be configured to allow identity topic subscribers (such as Web Security
appliance) to obtain session context in real-time.

1. Choose Administration > pxGrid Services > Settings > pxGrid Settings.

2. Ensure Automatically approve new certificate-based accounts is checked.

Delete any old Web Security appliances configured that do not take part in any authentication with
ISE/ISE-PIC.

Ensure the ISE server footer is green, and says Connected to pxGrid.
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• ISE-PIC

• Each ISE-PIC server must be configured to allow identity topic subscribers (such as Web Security
appliance) to obtain session context in real-time.

1. Choose Subscribers > Settings.

2. Ensure Automatically approve new certificate-based accounts is checked.

Delete any old Web Security appliances configured that do not take part in any authentication with
ISE/ISE-PIC.

Ensure the ISE server footer is green, and says Connected to pxGrid.

Refer to Cisco Identity Services Engine documentation for more information.

Connect to the ISE/ISE-PIC Services

If the ISE Admin, pxGrid, and MNT certificates are signed by your Root CA certificate, then upload the Root
CA certificate itself to the ISE pxGrid Node Certificate fields on the appliance (Network > Identity Services
Engine).

Note

Before you begin

• Be sure each ISE/ISE-PIC server is configured appropriately for WSA access; see Tasks for Integrating
the ISE/ISE-PIC Service, on page 143.

• Obtain valid ISE/ISE-PIC-related certificates and keys. See Generating Certificate through ISE/ISE-PIC,
on page 144for related information.

• Import the obtained RootCA.pem to the Web Security appliance (Network > CertificateManagement
> TrustedRootCertificate > Client on ManageTrustedRootCertificate). To extract Root CA, WSA
Client Certificate, and WSA Client Key from the generated XXX.pk12 file, see Generating Certificate
through ISE/ISE-PIC, on page 144.

Follow the same procedure for RootCA.pem extracted from secondary
XXXX.pk12 file (if secondary/failover ISE Sever is available).

Note

• The ISE configuration page in the Web Security appliance's web interface is used to configure ISE or
ISE-PIC servers, upload certificates, and to connect to either ISE or ISE-PIC services. The steps to
configure ISE or ISE-PIC are identical, and any details specific to ISE-PIC configurations have been
mentioned where applicable.

• Enable ERS if you are building access policies using Active Directory groups provided by ISE/ISE-PIC.

Step 1 Choose Network > Identification Service Engine.
Step 2 Click Edit Settings.
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If you are configuring ISE/ISE-PIC for the first time, click Enable and Edit Settings.

Step 3 Check Enable ISE Service.
Step 4 Identify the Primary Admin Node using its host name or IPv4 address and provide the following information on the

Primary ISE pxGrid Node Tab on the Web Security appliance.
a) Provide an ISE pxGrid Node Certificate for WSA-ISE/ISE-PIC data subscription (on-going queries to the

ISE/ISE-PIC server).

Browse to and select the certificate (or the certificate chain that includes any intermediate certificates) which is
generated from the primary ISE server as Root CA (i.e. RootCA.pem); see ,Generating Certificate through ISE/ISE-PIC,
on page 144 and then clickUpload File. See Uploading a Certificate and Key, on page 451 for additional information.

Step 5 If you are using a second ISE/ISE-PIC server for failover, identify its Primary Admin Node using its host name or IPv4
address and provide the following information on the Secondary ISE pxGrid Node tab on the Web Security appliance
using its host name or IPv4 address.
a) Provide the secondary ISE pxGrid Node Certificate.

Browse to and select the certificate (or the certificate chain that includes any intermediate certificates) which is
generated from the secondary ISE server as Root CA (i.e. RootCA.pem); see Generating Certificate through
ISE/ISE-PIC, on page 144, and then clickUpload File .See Uploading a Certificate and Key, on page 451 for additional
information.

During failover from primary to secondary ISE servers, any user not in the existing ISE SGT cache will be
required to authenticate, or will be assigned Guest authorization, depending on your WSA configuration. After
ISE failover is complete, normal ISE authentication resumes.

Note

Step 6 Provide a WSA Client Certificate for WSA-ISE/ISE-PIC server mutual authentication:

• Use Uploaded Certificate and Key

For both the certificate and the key, click Choose and browse to the respective file.

Select and upload publicCert.pem and privateKey.pem generated through the ISE/ISE-PIC device. See
Generating Certificate through ISE/ISE-PIC, on page 144.

Note

If the Key is Encrypted, check this box.

ClickUpload Files. (See Uploading a Certificate and Key, on page 451 for additional information about this option.)

Step 7 Enable the ISE External Restful Service (ERS).

• Enter the username and password of the ERS administrator. SeeAcquiring ISE/ISE-PIC ERS Server Details from
ISE/ISE-PIC, on page 149.

• If ERS is available on the same ISE/ISE-PIC pxGrid nodes, check the Server name same as ISE pxGrid Node
check box. Otherwise, enter the primary and secondary (if configured), servers' hostnames or IPv4 addresses.

Step 8 Click Start Test to test the connection with the ISE/ISE-PIC pxGrid node(s).
Step 9 Click Submit.
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What to do next

• Classifying Users and Client Software, on page 125

• Create Policies to Control Internet Requests, on page 197

Related Information

• http://www.cisco.com/c/en/us/support/security/identity-services-engine/
products-implementation-design-guides-list.html , particularly “How To Integrate Cisco WSA using
ISE/ISE-PIC and TrustSec through pxGrid..”

ImporttheSelf-signedWebSecurityApplianceClientCertificatetoISE/ISE-PIC
Standalone Deployment

The basic steps are:

• ISE Admin Node

• Choose Administration > Certificates > Certificate Management > Trusted Certificates >
Import.

Ensure that the following options are checked:

• Trust for Authentication within ISE

• Trust for client authentication and syslog

• Trust for authentication of Cisco services

• ISE-PIC Admin Node

• Choose Certificates > Certificate Management > Trusted Certificates > Import.

Ensure that the following options are checked:

• Trust for Authentication within ISE

• Trust for client authentication and syslog

• Trust for authentication of Cisco services

Refer to Cisco Identity Services Engine documentation for more information.

ImporttheSelf-signedWebSecurityApplianceClientCertificatetoISE/ISE-PIC
Distributed Deployment

The basic steps are:

• ISE Admin Node:

• Choose Administration > Certificates > Certificate Management > Trusted Certificates >
Import.
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Ensure that the following options are checked:

• Trust for Authentication within ISE

• Trust for client authentication and syslog

• Trust for authentication of Cisco services

• ISE-PIC Admin Node:

• Choose Certificates > Certificate Management > Trusted Certificates > Import.

Ensure that the following options are checked:

• Trust for Authentication within ISE

• Trust for client authentication and syslog

• Trust for authentication of Cisco services

Refer to Cisco Identity Services Engine documentation for more information.

In Distributed ISE Deployment, the Web Security appliance communicates with MNT, PAN, and PxGrid
nodes. In this case, the certificates or the issuer for all of the certificates, must be available in the ‘Extracted
Root certificate’ i.e. in the RootCA which is generated through the ISE/ISE-PIC device. See Generating
Certificate through ISE/ISE-PIC, on page 144.

Note

Step 1 Follow the steps in the Generating Certificate through ISE/ISE-PIC, on page 144 to generate RootCA, WSA Client
Certificate, and WSA Client Key.

Step 2 On ISE/ISE-PIC Admin Node, export the self-signed certificates manually through ISE/ISE-PIC > Administration
> System > Certificates > System Certificates

a. Select a certificate which is having ‘Used by’ one of these:[pxGrid, EAP Authentication, Admin, Portal, RADIUS
DTLS].

b. Click Export and save the generated .pem file.

Repeat the above steps for all ISE/ISE-PIC distributed nodes.

Step 3 Append the downloaded certificate-files in RootCA.pem manually using openssl commands. To generate and extract
certificate-files in RootCA.pem through the ISE/ISE-PIC device, see Generating Certificate through ISE/ISE-PIC, on
page 144.

a. Execute the following command on the downloaded certificate:
Example:

openssl x509 -in <DownloadCertificate>.pem -text | egrep "Subject:|Issuer:

Example (output):

Issuer: CN=isehcamnt2.node
Subject: CN=isehcamnt2.node

b. Modify the content as follows:
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Example:
Subject=/CN=isehcamnt2.node
Issuer=/CN=isehcamnt2.node

c. Add the following line in the RootCA.pem:

Bag Attributes: <Empty Attributes>

d. Add Subject and Issuer from step (2) in RootCA.pem along with step (3).
Example:
Bag Attributes: <Empty Attributes>
Subject=/CN=isehcamnt2.node
Issuer=/CN=isehcamnt2.node

e. Copy the whole content of the downloaded certificate file and paste them at the end of the RootCA after step (4) data.

Repeat steps (1) to (5) for all Distributed ISE/ISE-PIC node downloaded certificates and save the modified RootCA
certificate.

Step 4 Upload the modified RootCA.pem in the ISE configuration page of the Web Security appliance. See Connect to the
ISE/ISE-PIC Services, on page 145.

Configuring logging for ISE/ISE-PIC
• Add the custom field%m to the Access Logs to log the Authenticationmechanism – CustomizingAccess
Logs, on page 391.

• Verify that the ISE/ISE-PIC Service Log was created; if it was not, create it – Adding and Editing Log
Subscriptions, on page 366.

• Define Identification Profiles that access ISE/ISE-PIC for user identification and authentication –
Classifying Users and Client Software.

• Configure access policies that utilize ISE/ISE-PIC identification to define criteria and actions for user
requests – Policy Configuration.

Acquiring ISE/ISE-PIC ERS Server Details from ISE/ISE-PIC
• Enable the Cisco ISE REST API in ISE/ISE-PIC (the APIs use HTTPS port 9060).

Youmust enable ISE External Restful Service (ERS) on the web security appliance
(Network > Identity Services Engine) to configure security policies based on
groups. This is applicable to 11.7 and later versions.

Note

• ISE

• ChooseAdministration > Settings >ERS Settings >ERS settings for primary admin node
> Enable ERS.

Enable ERS for Read for All Other Nodes if there are any secondary nodes.
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• ISE-PIC

• Choose Settings > ERS Settings > Enable ERS.

• Ensure you have created an ISE administrator with the correct External RESTful Services group. The
External RESTful Services Admin group has full access to all ERS APIs (GET, POST, DELETE, PUT).
This user can Create, Read, Update, and Delete ERS API requests. The External RESTful Services
Operator has Read Only access (GET request only).

• ISE

• Choose Administration > System > Admin Access > Administrators > Admin Users.

• ISE-PIC

• Choose Administration > Admin Access > Admin Users.

• If the ERS service is available on separate servers, and not on the ISE/ISE-PIC pxGrid nodes, you will
need the primary and secondary (if configured), servers' hostnames or IPv4 addresses.

Refer to Cisco Identity Services Engine documentation for more information.

VDI (Virtual Desktop Infrastructure) User Authentication in
ISE/ISE-PIC Integrations

You can configure transparent identification with ISE/ISE-PIC for users on VDI environments based on the
source ports used.

You must install the Cisco Terminal Services (TS) Agent, on the VDI servers. The Cisco TS agent provides
the identity information to ISE/ISE-PIC. The identity information includes domain, user name, and the port
ranges used by each user.

• Download the Cisco TS agent from the support site https://www.cisco.com/c/en/us/support/index.html.

• See the Cisco Terminal Services (TS) Agent Guide https://www.cisco.com/c/en/us/support/security/
defense-center/products-installation-and-configuration-guides-list.html for more information.

• Configure the ISE/ISE-PIC API provider to work with a Cisco TS agent. See the Cisco TS agent
documentation for information about sending API calls.

• Fallback authentication for VDI environment users is not supported.

• Ensure the number of maximum remote desktop sessions are the same in the Cisco Terminal Services
agent and Microsoft server settings. This prevents incorrect session information from being sent to the
Web Security appliance from ISE, and avoids false authentication for new sessions.

Note
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Troubleshooting Identity Services Engine Problems
• Identity Services Engine Problems, on page 479

• Tools for Troubleshooting ISE Issues, on page 479
• ISE Server Connection Issues, on page 479
• ISE-related Critical Log Messages, on page 481
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C H A P T E R 10
Classify URLs for Policy Application

This chapter contains the following sections:

• Overview of Categorizing URL Transactions, on page 153
• Configuring the URL Filtering Engine , on page 156
• Managing Updates to the Set of URL Categories , on page 156
• Filtering Transactions Using URL Categories, on page 162
• Creating and Editing Custom URL Categories, on page 168
• Filtering Adult Content, on page 173
• Redirecting Traffic in the Access Policies, on page 175
• Warning Users and Allowing Them to Continue, on page 176
• Creating Time Based URL Filters, on page 177
• Viewing URL Filtering Activity, on page 178
• Regular Expressions, on page 178
• URL Category Descriptions, on page 182

Overview of Categorizing URL Transactions
Using policy groups, you can create secure policies that control access to web sites containing questionable
content. The sites that are blocked, allowed, or decrypted depend on the categories you select when setting
up category blocking for each policy group. To control user access based on a URL category, you must enable
CiscoWebUsage Controls. This is a multi-layered URL filtering engine that uses domain prefixes and keyword
analysis to categorize URLs.

You can use URL categories when performing the following tasks:

MethodOption

Matching URLs to URL Categories, on page 155Define policy group membership

Filtering Transactions Using URL Categories, on page 162Control access to HTTP, HTTPS, and FTP
requests

Creating and Editing Custom URL Categories, on page 168Create user defined custom URL categories
that specify specific hostnames and IP
addresses
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Categorization of Failed URL Transactions
The Dynamic Content Analysis engine categorizes URLs when controlling access to websites in Access
Policies only. It does not categorize URLs when determining policy group membership or when controlling
access to websites using Decryption or Cisco Data Security Policies. This is because the engine works by
analyzing the response content from the destination server, so it cannot be used on decisions that must be
made at request time before any response is downloaded from the server.

If the web reputation score for an uncategorized URL is within the WBRS ALLOW range, AsyncOS allows
the request without performing Dynamic Content Analysis.

After the Dynamic Content Analysis engine categorizes a URL, it stores the category verdict and URL in a
temporary cache. This allows future transactions to benefit from the earlier response scan and be categorized
at request time instead of at response time.

Enabling theDynamic Content Analysis engine can impact transaction performance. However, most transactions
are categorized using the Cisco Web Usage Controls URL categories database, so the Dynamic Content
Analysis engine is usually only called for a small percentage of transactions.

Enabling the Dynamic Content Analysis Engine

It is possible for an Access Policy, or an Identity used in an Access Policy, to define policy membership by
a predefined URL category and for the Access Policy to perform an action on the same URL category. The
URL in the request can be uncategorized when determining Identity and Access Policy group membership,
but must be categorized by the Dynamic Content Analysis engine after receiving the server response. Cisco
Web Usage Controls ignores the category verdict from the Dynamic Content Analysis engine and the URL
retains the “uncategorized” verdict for the remainder of the transaction. Future transactions will still benefit
from the new category verdict.

Note

Step 1 Choose Security Services > Acceptable Use Controls.
Step 2 Enable the Cisco Web Usage Controls.
Step 3 Click to enable the Dynamic Content Analysis engine.
Step 4 Submit and Commit Changes.

Uncategorized URLs
An uncategorized URL is a URL that does not match any pre-defined URL category or included custom URL
category.

When determining policy group membership, a custom URL category is considered included, only when it
is selected for policy group membership.

Note

All transactions resulting in unmatched categories are reported on the Reporting > URL Categories page as
“Uncategorized URLs.” A large number of uncategorized URLs are generated from requests to web sites
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within the internal network. Cisco recommends using custom URL categories to group internal URLs and
allow all requests to internal web sites. This decreases the number of web transactions reported as
“Uncategorized URLs” and instead reports internal transactions as part of “URL Filtering Bypassed” statistics.

Related Topics

• Understanding Unfiltered and Uncategorized Data, on page 178.
• Creating and Editing Custom URL Categories, on page 168.

Matching URLs to URL Categories
When the URL filtering engine matches a URL category to the URL in a client request, it first evaluates the
URL against the custom URL categories included in the policy group. If the URL in the request does not
match an included custom category, the URL filtering engine compares it to the predefined URL categories.
If the URL does not match any included custom or predefined URL categories, the request is uncategorized.

When determining policy group membership, a custom URL category is considered included only when it is
selected for policy group membership.

Note

To see what category a particular web site is assigned to, go to the URL in Reporting Uncategorized and
Misclassified URLs, on page 155.

Related Topics

• Uncategorized URLs, on page 154.

Reporting Uncategorized and Misclassified URLs
You can report uncategorized and misclassified URLs to Cisco. Cisco provides a URL submission tool on its
website that allows you to submit multiple URLs simultaneously:

• https://talosintelligence.com/tickets

• To check the status of submitted URLs, click the Status on Submitted URLs tab on this page.

• You can also use the URL submission tool to look up the assigned URL category for any URL.

• https://www.talosintelligence.com/reputation_center/support

• To submit a dispute, you must be logged into your Cisco account. Disputes can be filed for URLs,
IPs, or domains.

• Use the Reputation Center Search box to look up web reputation information.

URL Categories Database
The category that a URL falls into is determined by a filtering categories database. TheWeb Security appliance
collects information and maintains a separate database for each URL filtering engine. The filtering categories
databases periodically receive updates from the Cisco update server.
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The URL categories database includes many different factors and sources of data internal to Cisco and from
the Internet. One of the factors occasionally considered, heavily modified from the original, is information
from the Open Directory Project.

To see what category a particular web site is assigned to, go to the URL in Reporting Uncategorized and
Misclassified URLs, on page 155.

Related Topics

• Manually Updating Security Service Components, on page 456.

Configuring the URL Filtering Engine
By default, the Cisco Web Usage Controls URL filtering engine is enabled in the System Setup Wizard.

Step 1 Choose Security Services > Acceptable Use Controls.
Step 2 Click Edit Global Settings.
Step 3 Verify the Enable Acceptable Use Controls property is enabled.
Step 4 Choose whether to enable the following Cisco Web Usage Controls:

a. Application Visibility and Control

b. Dynamic Content Analysis Engine

c.

Step 5 Choose the default action the Web Proxy should use when the URL filtering engine is unavailable, either Monitor or
Block. Default is Monitor.

Step 6 Submit and Commit Changes.

Managing Updates to the Set of URL Categories
The set of predefined URL categories may occasionally be updated in order to accommodate new web trends
and evolving usage patterns. Updates to the URL category set are distinct from the changes that add new
URLs and re-map misclassified URLs. Category set updates may change configurations in your existing
policies and therefore require action. URL category set updates may occur between product releases; an
AsyncOS upgrade is not required.

Information is available from: http://www.cisco.com/en/US/products/ps10164/prod_release_notes_list.html.

Take the following actions:

MethodWhen to Act

Understanding the Impacts of URL Category Set Updates , on page 157

Controlling Updates to the URL Category Set , on page 160

Default Settings for New and Changed Categories , on page 161

Receiving Alerts About Category and Policy Changes , on page 162

Before updates occur

(Do these tasks as part of your
initial setup)

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
156

Classify URLs for Policy Application
Configuring the URL Filtering Engine

http://www.cisco.com/en/US/products/ps10164/prod_release_notes_list.html


MethodWhen to Act

Responding to Alerts about URL Category Set Updates , on page 162After updates occur

Understanding the Impacts of URL Category Set Updates
URL category set updates can have the following impacts on existing Access Policies, Decryption Policies,
and Cisco Data Security policies, and on Identities:

• Effects of URL Category Set Changes on Policy Group Membership , on page 157
• Effects of URL Category Set Updates on Filtering Actions in Policies , on page 157

Effects of URL Category Set Changes on Policy Group Membership
This section applies to all policy types with membership that can be defined by URL category, and to Identities.
When policy group membership is defined by URL category, changes to the category set may have the
following effects:

• If the sole criterion for membership is a deleted category, the policy or identity is disabled.

If membership in any policy is defined by a URL category that changes, and if this causes ACL list changes,
the web proxy will restart.

Effects of URL Category Set Updates on Filtering Actions in Policies
URL category set updates can change policy behavior in the following ways:

Effect on Policies and IdentitiesChange

For the new URL categories now, one of the following actions will be picked
from the Default Action for Update Categories option of the Policy Configuartion
page:

• Least Restrictive

• Most Restrictive

The actions are set by default for the new categories. In Access Policies, and
Cisco Data Security Policies:

• Most Restrictive is Block

• Least Restrictive is Monitor

In Web Traffic Tap (WTT) Policies:

• Most Restrictive is Tap

• Least Restrictive is No Tap

In Decryption Policies:

• Most Restrictive is Block

• Least Restrictive is Pass Through

A new category can be
added
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Effect on Policies and IdentitiesChange

The action associated with the deleted category is deleted.

If the policy depended exclusively on the deleted category, the policy is disabled.

If a policy depends on an identity that depended exclusively on a deleted category,
the policy will be disabled.

A category can be deleted

No change to the behavior of the existing policy.A category can be
renamed

A single category can become multiple new categories. New category actions
will be picked from the Default Action for Update Categories.

A category can split
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Effect on Policies and IdentitiesChange

If all original categories in a policy had the same action assigned, the merged
category has the same action as the original categories. If all original categories
were set to “Use Global Setting” then the merged category is also set to “Use
Global Setting.”

If the policy had different actions assigned to the original categories, the action
assigned to the merged category depends on the Uncategorized URLs setting in
that policy:

• If Uncategorized URLs is set to Block (or “Use Global Setting” when the
global setting is Block), then the most restrictive action among the original
categories is applied to the merged category.

• If Uncategorized URLs is set to any action other than Block (or “Use Global
Setting” when the global setting is anything other than Block), then the least
restrictive action among the original categories is applied to the merged
category.

In this case, sites that were previously blocked may now be accessible to
users.

If policy membership is defined by URL category, and some of the categories
involved in the merge, or the Uncategorized URLs action, are not included in the
policy membership definition, then the values in the Global Policy are used for
the missing items.

The order of restrictiveness is as follows (not all actions are available for all
policy types):

• Block

• Drop

• Decrypt

• Warn

• Time-based

• Monitor

• Pass Through

Time-based policies that are based on merged categories adopt the
action associated with any one of the original categories. (In time-based
policies, there may be no obviously most- or least-restrictive action.)

Note

Two or more existing
categories can merge

Related Topics

• Merged Categories - Examples , on page 160.
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Merged Categories - Examples
Some examples of merged categories, based on settings on the URL Filtering page for the policy:

Merged
Category

Uncategorized URLsOriginal Category 2Original
Category 1

Monitor(Not Applicable)MonitorMonitor

Block(Not Applicable)BlockBlock

Use Global
Settings

(Not Applicable)Use Global SettingsUseGlobal
Settings

WarnMonitor

Use the least restrictive among the original
categories.

BlockWarn

Block• Block or
• Use Global Setting, when Global is set to
Block

Use the most restrictive among the original
categories.

• Block or
• Use Global Settings,when
Global is set to Block

Monitor

Monitor• Monitor or
• Use Global Setting, when Global is set to
Monitor

Use the least restrictive among the original
categories.

• Monitor or
• Use Global Settings,
when Global is set to
Monitor

Block

MonitorAn action for Uncategorized URLs is not
specified in this policy, but the value in the
Global Policy for Uncategorized URLs is
Monitor

An action for this category is
not specified in this policy, but
the value in the Global Policy
for this category is Block

For
policies in
which
membership
is defined
by URL
category:

Monitor

Controlling Updates to the URL Category Set
By default, URL category set updates to occur automatically. These updates may change existing policy
configurations, so you may prefer to disable all automatic updates.
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MethodOption

Manually Updating the URL Category Set , on page
161

and

Manually Updating Security Service Components,
on page 456

If you disable updates, you will need to manually
update all services listed in the Update Servers (list)
section of the System Administration > Upgrade and
Update Settings page

Configuring Upgrade and Service Update Settings,
on page 459.

Disabling all automatic updates

If you use the CLI, disable updates by setting the update interval to zero (0)Note

Manually Updating the URL Category Set

• Do not interrupt an update in progress.

• If you have disabled automatic updates, you can manually update the set of URL categories at your
convenience.

Note

Step 1 Choose Security Services > Acceptable Use Controls.
Step 2 Determine whether an update is available:

Look at the “Cisco Web Usage Controls - Web Categorization Categories List” item in the Acceptable Use Controls
Engine Updates table.

Step 3 To update, click Update Now.

Default Settings for New and Changed Categories
URL category set updates may change the behavior of your existing policies. You should specify default
settings for certain changes when you configure your policies, so that they are ready when URL category set
updates occur. When new categories are added, or existing categories merge into a new category, the default
action for these categories for each policy are affected by the Default Action for Update Categories setting
in that policy.

Verifying Existing Settings and/or Making Changes

Step 1 Choose Web Security Manager.
Step 2 For each Access Policy, Decryption Policy, and Cisco Data Security policy click the URL Filtering link.
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Step 3 Check the selected setting for Uncategorized URLs.

What to do next

Related Topics

• Effects of URL Category Set Updates on Filtering Actions in Policies , on page 157.

Receiving Alerts About Category and Policy Changes
Category set updates trigger two types of alerts:

• Alerts about category changes
• Alerts about policies that have changed or been disabled as a result of category set changes.

Step 1 Choose System Administration > Alerts.
Step 2 Click Add Recipient and add email address (or multiple email addresses).
Step 3 Decide which Alert Types and Alert Severities to receive.
Step 4 Submit and Commit Changes.

Responding to Alerts about URL Category Set Updates
When you receive an alert about category set changes, you should do the following:

• Check policies and identities to be sure that they still meet your policy goals after category merges,
additions, and deletions, and

• Consider modifying policies and identities to benefit from new categories and the added granularity of
split categories.

Related Topics

• Understanding the Impacts of URL Category Set Updates , on page 157

Filtering Transactions Using URL Categories
The URL filtering engine lets you filter transactions in Access, Decryption, and Data Security Policies. When
you configure URL categories for policy groups, you can configure actions for custom URL categories, if
any are defined, and predefined URL categories.

The URL filtering actions you can configure depends on the type of policy group:

MethodOption

Configuring URL Filters for Access Policy Groups, on page 163Access Policies

Configuring URL Filters for Decryption Policy Groups, on page 166Decryption Policies
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MethodOption

Configuring URL Filters for Data Security Policy Groups, on page 167Cisco Data Security Policies

Related Topics

• Redirecting Traffic in the Access Policies, on page 175
• Warning Users and Allowing Them to Continue, on page 176
• Creating and Editing Custom URL Categories, on page 168
• Effects of URL Category Set Updates on Filtering Actions in Policies , on page 157

Configuring URL Filters for Access Policy Groups
You can configure URL filtering for user-defined Access Policy groups and the Global Policy Group.

Step 1 Choose Web Security Manager > Access Policies.
Step 2 Click the link in the policies table under the URL Filtering column for the policy group you want to edit.
Step 3 (Optional) In the Custom URL Category Filtering section, you can add custom URL categories on which to take action

in this policy:
a) Click Select Custom Categories.
b) Choose which custom URL categories to include in this policy and click Apply.

Choose which custom URL categories the URL filtering engine should compare the client request against. The URL
filtering engine compares client requests against included custom URL categories, and ignores excluded custom URL
categories. The URL filtering engine compares the URL in a client request to included custom URL categories before
predefined URL categories.

The custom URL categories included in the policy appear in the Custom URL Category Filtering section.

Step 4 In the Custom URL Category Filtering section, choose an action for each included custom URL category.

DescriptionAction

Uses the action for this category in the Global Policy Group. This is the default action for user
defined policy groups.

Applies to user defined policy groups only.

When a customURL category is excluded in the global Access Policy, then the default
action for included customURL categories in user defined Access Policies isMonitor
instead of Use Global Settings. You cannot choose Use Global Settings when a custom
URL category is excluded in the global Access Policy.

Note

Use Global Settings

The Web Proxy denies transactions that match this setting.Block

Redirects traffic originally destined for a URL in this category to a location you specify. When
you choose this action, the Redirect To field appears. Enter a URL to which to redirect all traffic.

Redirect
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DescriptionAction

Always allows client requests for web sites in this category.

Allowed requests bypass all further filtering and malware scanning.

Only use this setting for trusted web sites. You might want to use this setting for internal sites.

Allow

The Web Proxy neither allows nor blocks the request. Instead, it continues to evaluate the client
request against other policy group control settings, such as web reputation filtering.

Monitor

The Web Proxy initially blocks the request and displays a warning page, but allows the user to
continue by clicking a hypertext link in the warning page.

Warn

As a individual user approaches either the volume or time quotas you have specified, a warning
is displayed. When a quota is met, a block page is displayed. See Time Ranges and Quotas, on
page 214.

Quota-Based

The Web Proxy blocks or monitors the request during the time ranges you specify. See Time
Ranges and Quotas, on page 214.

Time-Based

Step 5 In the Predefined URL Category Filtering section, choose one of the following actions for each category:

• Use Global Settings

• Monitor

• Warn

• Block

• Time-Based

• Quota-Based

Step 6 In the Uncategorized URLs section, choose the action to take for client requests to web sites that do not fall into a
predefined or custom URL category. This setting also determines the default action for new and merged categories
resulting from URL category set updates.

Step 7 Submit and Commit Changes.

What to do next

• Exceptions to Blocking for Embedded and Referred Content, on page 164

Exceptions to Blocking for Embedded and Referred Content
AWebsite may embed or refer to content that is categorized differently than the source page, or that is
considered an application. By default, embedded/referred content is blocked or monitored based on the action
selected for its assigned category or application, regardless of how the source Website is categorized. For
example, a News site could contain content, or a link to content, that categorized as Streaming Video and
identified as being the application YouTube. According to your policy, Streaming Video and YouTube are
both blocked, while News sites are not.
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Requests for embedded content usually include the address of the site from which the request originated (this
is known as the “referer” field in the request’s HTTP header). This header information is used to determine
categorization of the referred content.

Note

You can use this feature to define exceptions to the default actions for embedded/referred content; for example,
to permit all content embedded in or referred to from News Websites, or from a custom category representing
your intranet.

Referer-based exceptions are supported only in Access policies. To use this feature with HTTPS traffic, before
defining exceptions in Access policies, you must configure HTTPS decryption of the URL Categories that
you will select for exception. See Configuring URL Filters for Decryption Policy Groups, on page 166 for
information about configuring HTTPS decryption. See Conditions and Restrictions for Exceptions to Blocking
for Embedded and Referred Content, on page 478 for additional information about using this feature with
HTTPS decryption.

Note

Step 1 On the URL Filtering page for a particular Access Policy (see Configuring URL Filters for Access Policy Groups, on
page 163), click Enable Exceptions in the Exceptions to Blocking for Embedded/Referred Content section.

Step 2 Click the Click to select categories link in the Set Exception for Content Referred by These Categories column, opening
the URL filtering category referral-exception selection page.

Step 3 From the Predefined and Custom URL Categories lists, select the categories for which you wish to define this referral
exception, then click Done to return to the URL Filtering page for this Access Policy.

Step 4 Choose an exception type from the Set Exception for this Referred Content drop-down list:

• All embedded/referred content – All content embedded in and referred from sites of the specified category types
is not blocked, regardless of the categorization of that content.

• Selected embedded/referred content – After choosing this option, select specific Categories and Applications that
are not blocked when originating from the specified URL categories.

• All embedded/referred content except – After choosing this option, all content embedded in and referred from
sites of the specified category types is not blocked, except those URL categories and applications you now specify
here. In other words, these types will remain blocked.

Step 5 Submit and Commit Changes.

What to do next

You can elect to display “Permitted by Referrer” transaction data in the tables and charts provided on the
following Reporting pages: URL Categories, Users and Web Sites, as well as related charts on the Overview
page. See Choosing Which Data to Chart , on page 330 for more information about selecting chart-display
options.
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Configuring URL Filters for Decryption Policy Groups
You can configure URL filtering for user defined Decryption Policy groups and the global Decryption Policy
group.

Step 1 Choose Web Security Manager > Decryption Policies.
Step 2 Click the link in the policies table under the URL Filtering column for the policy group you want to edit.
Step 3 (Optional) In the Custom URL Category Filtering section, you can add custom URL categories on which to take action

in this policy:
a) Click Select Custom Categories.
b) Choose which custom URL categories to include in this policy and click Apply.

Choose which custom URL categories the URL filtering engine should compare the client request against. The URL
filtering engine compares client requests against included customURL categories, and ignores excluded customURL
categories. The URL filtering engine compares the URL in a client request to included customURL categories before
predefined URL categories.

The custom URL categories included in the policy appear in the Custom URL Category Filtering section.

Step 4 Choose an action for each custom and predefined URL category.

DescriptionAction

Uses the action for this category in the global Decryption Policy group. This is the default
action for user defined policy groups.

Applies to user defined policy groups only.

When a custom URL category is excluded in the global Decryption Policy, then the default
action for included custom URL categories in user defined Decryption Policies is Monitor
instead of Use Global Settings. You cannot choose Use Global Settings when a custom URL
category is excluded in the global Decryption Policy.

Use Global Setting

Passes through the connection between the client and the server without inspecting the traffic
content.

Pass Through

The Web Proxy neither allows nor blocks the request. Instead, it continues to evaluate the
client request against other policy group control settings, such as web reputation filtering.

Monitor

Allows the connection, but inspects the traffic content. The appliance decrypts the traffic and
applies Access Policies to the decrypted traffic as if it were a plain text HTTP connection.
By decrypting the connection and applying Access Policies, you can scan the traffic for
malware.

Decrypt

Drops the connection and does not pass the connection request to the server. The appliance
does not notify the user that it dropped the connection.

Drop

If you want to block a particular URL category for HTTPS requests, choose to decrypt that URL category in
the Decryption Policy group and then choose to block the same URL category in the Access Policy group.

Note

Step 5 In the Uncategorized URLs section, choose the action to take for client requests to web sites that do not fall into a
predefined or custom URL category.

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
166

Classify URLs for Policy Application
Configuring URL Filters for Decryption Policy Groups



This setting also determines the default action for new and merged categories resulting from URL category set updates.

Step 6 Submit and Commit Changes.

Configuring URL Filters for Data Security Policy Groups
You can configure URL filtering for user defined Data Security Policy groups and the Global Policy Group.

Step 1 Choose Web Security Manager > Cisco Data Security.
Step 2 Click the link in the policies table under the URL Filtering column for the policy group you want to edit.
Step 3 (Optional) In the Custom URL Category Filtering section, you can add custom URL categories on which to take action

in this policy:
a) Click Select Custom Categories.
b) Choose which custom URL categories to include in this policy and click Apply.

Choose which custom URL categories the URL filtering engine should compare the client request against. The URL
filtering engine compares client requests against included customURL categories, and ignores excluded customURL
categories. The URL filtering engine compares the URL in a client request to included customURL categories before
predefined URL categories.

The custom URL categories included in the policy appear in the Custom URL Category Filtering section.

Step 4 In the Custom URL Category Filtering section, choose an action for each custom URL category.

DescriptionAction

Uses the action for this category in the Global Policy Group. This is the default action for user
defined policy groups.

Applies to user defined policy groups only.

When a custom URL category is excluded in the global Cisco Data Security Policy, then the
default action for included customURL categories in user defined Cisco Data Security Policies
is Monitor instead of Use Global Settings. You cannot choose Use Global Settings when a
custom URL category is excluded in the global Cisco Data Security Policy.

Use Global Setting

Always allows upload requests for web sites in this category. Applies to customURL categories
only.

Allowed requests bypass all further data security scanning and the request is evaluated against
Access Policies.

Only use this setting for trusted web sites. You might want to use this setting for internal sites.

Allow

The Web Proxy neither allows nor blocks the request. Instead, it continues to evaluate the
upload request against other policy group control settings, such as web reputation filtering.

Monitor

The Web Proxy denies transactions that match this setting.Block

Step 5 In the Predefined URL Category Filtering section, choose one of the following actions for each category:

• Use Global Settings
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• Monitor

• Block

Step 6 In the Uncategorized URLs section, choose the action to take for upload requests to web sites that do not fall into a
predefined or custom URL category. This setting also determines the default action for new and merged categories
resulting from URL category set updates.

Step 7 Submit and Commit Changes.

What to do next

Related Topics

• Effects of URL Category Set Updates on Filtering Actions in Policies , on page 157.

Creating and Editing Custom URL Categories
You can create custom and external live-feedURL categories that describe specific host names and IP addresses.
In addition, you can edit and delete existing URL categories. When you include these custom URL categories
in the same Access, Decryption, or Cisco Data Security Policy group and assign different actions to each
category, the action of the higher included custom URL category takes precedence.

You can use no more than 30 External Live Feed files in these URL category definitions, and each file should
contain no more than 5000 entries. Increasing the number of external feed entries causes performance
degradation.

The Web Security appliance uses the first four characters of custom URL category names preceded by “c_”
in the access logs. Consider the custom URL category name if you use Sawmill to parse the access logs. If
the first four characters of the customURL category include a space, Sawmill cannot properly parse the access
log entry. Instead, only use supported characters in the first four characters. If you want to include the full
name of a custom URL category in the access logs, add the %XF format specifier to the access logs.

Note

Before you begin

Go to Security Services > Acceptable Use Controls to enable Acceptable Use Controls.

Step 1 Choose Web Security Manager > Custom and External URL Categories.
Step 2 To create a custom URL category, click Add Category. To edit an existing custom URL category, click the name of the

URL category.
Step 3 Provide the following information.

DescriptionSetting

Enter an identifier for this URL category. This name appears when you configure URL filtering
for policy groups.

Category Name
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DescriptionSetting

Specify the order of this category in the list of custom URL categories. Enter “1” for the first URL
category in the list.

The URL filtering engine evaluates a client request against the customURL categories in the order
specified.

List Order

Choose Local Custom Category or External Live Feed Category.Category Type

Choose Management or Data. This choice is available only if “split routing” is enabled; that is,
it is not available with local custom categories. See Enabling or Changing Network Interfaces, on
page 27 for information about enabling split routing.

Routing Table

If you choose Local Custom Category for the Category Type, provide the custom Sites:

• Enter one or more Site addresses for this custom category. You can enter multiple addresses
separated by line breaks or commas. These addresses can be in any of the following formats:

• IPv4 address, such as 10.1.1.0

• IPv6 address, such as 2001:0db8::

• IPv4 CIDR address, such as 10.1.1.0/24

• IPv6 CIDR address, such as 2001:0db8::/32

• Domain name, such as example.com

• Hostname, such as crm.example.com

• Partial hostname, such as .example.com; this will also match www.example.com

• Regular expressions can be entered in the Advanced section, as described below.

It is possible to use the same address in multiple custom URL categories, but the order
in which the categories are listed is relevant. If you include these categories in the same
policy, and define different actions for each, the action defined for the category listed
highest in the custom URL categories table will be the one applied.

Note

• (Optional) Click Sort URLs to sort all addresses in the Sites field.

Once you sort the addresses, you cannot retrieve their original order.Note

Sites / Feed File
Location
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DescriptionSetting

If you choose External Live Feed Category for the Category Type, provide the Feed File
Location information; that is, locate and download the file containing the addresses for this custom
category:

a. Select either Cisco Feed Format, or Office 365 Feed Format, or Office 365 Web Service,
and provide the appropriate feed-file information.

• Cisco Feed Format:

• Choose the transport protocol to be used—either HTTPS or HTTP—and then enter
the URL of the live-feed file. This file must be a comma-separated values
(.csv)-formatted file. See External Feed-file Formats, on page 172 for more
information about this file.

• Optionally, provide Authentication credentials in the Advanced section. Provide
a Username and Passphrase to be used for connection to the specified feed server.

• Office 365 Feed Format:

• Enter the Office 365 Feed Location (URL) of the live-feed file.

This file must be an XML-formatted file; see External Feed-file Formats, on page
172 for more information about this file.

• Office 365 Web Service

Enter the web service URL. It must not contain a ClientRequestId, and have JSON
as the format. The appliance automatically generates the ClientRequestId.

b. For Cisco Feed Format and Office 365 Feed formats, click Get File to test the connection to
the feed server, and then parse and download the feed file from the server.

Progress is displayed in the text box below theGet File button. If an error occurs, the problem
is indicated andmust be rectified before trying again. Refer to Issues Downloading An External
Live Feed File, on page 482 for additional information about possible errors.

For the Office 365 Web Service, click Start Test to initiate the service and download URLs
and IPs.

You can use no more than 30 External Live Feed files in these URL category definitions,
and each file should contain nomore than 5000 entries. Increasing the number of external
feed entries causes performance degradation.

Note

After you save your changes to this live-feed category, you can click View in the Feed
Content column for this entry on the Custom and External URL Categories page (Web
Security Manager > Custom and External URL Categories) to open a window that
displays the addresses contained in the Cisco Feed Format or Office 365 Feed Format
feed file you downloaded here.

Tip

Feed Location
(cont.)
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DescriptionSetting

If you choose Local Custom Category for the Category Type, you can enter regular expressions
in this section to specify additional sets of addresses.

You can use regular expressions to specify multiple addresses that match the patterns you enter.

Note • The URL filtering engine compares URLs with addresses entered in the Sites field
first. If the URL of a transaction matches an entry in the Sites field, it is not
compared to any expression entered here.

• Use “%20” instead of space character while adding URL paths as regular
expressions. URL paths must not contain space characters when used as regular
expressions.

See Regular Expressions, on page 178 for more information about using regular expressions.

Advanced

Choose a feed update option:

• Do not auto update

• Every n HH:MM; for example, enter 00:05 for five minutes. However, note that updating
frequently can affect WSA performance.

Upon every reload and republish, the appliance downloads the available feed file and
updates the downloaded time, even if the available feed file is same as the currently
downloaded one.

Note

Auto Update the
Feed

Step 4 Submit and Commit Changes.

What to do next

Related Topics

• Regular Expressions, on page 178.

• Customizing Access Logs, on page 391.

• Problems with Custom and External URL Categories, on page 482

AddressFormatsandFeed-fileFormatsforCustomandExternalURLCategories
When Creating and Editing Custom and External URL Categories, you must provide one or more network
addresses, whether for a Local Custom Category, or in an External Live Feed Category feed file. In each
instance, you can enter multiple addresses separated by line breaks or commas. These addresses can be in any
of the following formats:

• IPv4 address, such as 10.1.1.0

• IPv6 address, such as 2001:0db8::

• IPv4 CIDR address, such as 10.1.1.0/24
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• IPv6 CIDR address, such as 2001:0db8::/32

• Domain name, such as example.com

• Hostname, such as crm.example.com

• Partial hostname, such as .example.com; this will also match www.example.com

• Regular expressions to specify multiple addresses that match the provided patterns (see Regular
Expressions, on page 178 for more information about using regular expressions)

It is possible to use the same address in multiple custom URL categories, but the order in which the categories
are listed is relevant. If you include these categories in the same policy, and define different actions for each,
the action defined for the category listed highest in the custom URL categories table will be the one applied.

Note

External Feed-file Formats
If you select External Live Feed Category for the Category Type when Creating and Editing Custom and
External URL Categories, you must select the feed format (Cisco Feed Format or Office 365 Feed Format)
and then provide a URL to the appropriate feed-file server.

The expected format for each feed file is as follows:

• Cisco Feed Format – This must be a comma-separated values (.csv) file; that is, a text file with a .csv
extension. Each entry in the .csv file must be on a separate line, formatted as address/comma/addresstype
(for example: www.cisco.com,site or ad2.*\.com,regex). Valid addresstypes are site and regex. Here
is an excerpt from a Cisco Feed Format .csv file:
www.cisco.com,site

\.xyz,regex

ad2.*\.com,regex

www.trafficholder.com,site

2000:1:1:11:1:1::200,site

Do not include http:// or https:// as part of any site entry in the file, or an
error will occur. In other words, www.example.com is parsed correctly, while
http://www.example.com produces an error.

Note

• Office 365 Feed Format – This is an XML file located on a Microsoft Office 365 server, or a local
server to which you saved the file. It is provided by the Office 365 service and cannot be modified. The
network addresses in the file are enclosed by XML tags, following this structure: products > product

> addresslist > address. In the current implementation, an addresslist type can be IPv6, IPv4, or
URL (which can include domains and regex patterns). Here is a snippet of an Office 365 feed file:
<products updated="4/15/2016">

<product name="o365">
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<addresslist type="IPv6">

<address>2603:1040:401::d:80</address>

<address>2603:1040:401::a</address>

<address>2603:1040:401::9</address>

</addresslist>

<addresslist type="IPv4">

<address>13.71.145.72</address>

<address>13.71.148.74</address>

<address>13.71.145.114</address>

</addresslist>

<addresslist type="URL">

<address>*.aadrm.com</address>

<address>*.azurerms.com</address>

<address>*.cloudapp.net2</address>

</addresslist>

</product>

<product name="LYO">

<addresslist type="URL">

<address>*.broadcast.skype.com</address>

<address>*.Lync.com</address>

</addresslist>

</product>

</products>

Filtering Adult Content
You can configure the Web Security appliance to filter adult content from some web searches and websites.
To enforce safe search and site content ratings, the AVC engine takes advantage of the safe mode feature
implemented at a particular website by rewriting URLs and/or web cookies to force the safety mode to be on.

The following features filter adult content:
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DescriptionOption

You can configure the Web Security appliance so that outgoing
search requests appear to search engines as safe search requests.
This can prevent users from bypassing acceptable use policies
using search engines.

Enforce safe searches

Some content sharing sites allow users to restrict their own access
to the adult content on these sites by either enforcing their own
safe search feature or blocking access to adult content, or both.
This classification feature is commonly called content ratings.

Enforce site content ratings

Any Access Policy that has either the safe search or site content ratings feature enabled is considered a safe
browsing Access Policy.

Note

Enforcing Safe Searches and Site Content Ratings

When you enable Safe Search or Site Content Rating, the AVC Engine is tasked with identifying applications
for safe browsing. As one of the criteria, the AVC engine will scan the response body to detect a search
application. As a result, the appliance will not forward range headers.

Note

Step 1 Choose Web Security Manager > Access Policies.
Step 2 Click the link under the URL Filtering column for an Access Policy group or the Global Policy Group.
Step 3 When editing a user-defined Access Policy, choose Define Content Filtering Custom Settings in the Content Filtering

section.
Step 4 Click the Enable Safe Search check box to enable the safe search feature.
Step 5 Choose whether to block users from search engines that are not currently supported by the Web Security appliance safe

search feature.
Step 6 Click the Enable Site Content Rating check box to enable the site content ratings feature.
Step 7 Choose whether to block all adult content from the supported content ratings websites or to display the end-user URL

filtering warning page.

When the URL of one of the supported search engines or supported content ratings websites is included in a
custom URL category with the Allow action applied, no search results are blocked and all content is visible.

Note

Step 8 Submit and Commit Changes.

What to do next

Related Topics

• Warning Users and Allowing Them to Continue, on page 176.
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Logging Adult Content Access
By default, the access logs include a safe browsing scanning verdict inside the angled brackets of each entry.
The safe browsing scanning verdict indicates whether or not either the safe search or site content ratings
feature was applied to the transaction. You can also add the safe browsing scanning verdict variable to the
access logs or W3C access logs:

• Access logs: %XS
• W3C access logs: x-request-rewrite

DescriptionValue

The original client request was unsafe and the safe search feature was applied.ensrch

The original client request was unsafe and the site content ratings feature was applied.encrt

The original client request was to an unsupported search engine.unsupp

The original client request was unsafe, but neither the safe search nor the site content ratings
feature could be applied due to an error.

err

Neither the safe search nor the site content ratings feature was applied to the client request
because the features were bypassed (for example, the transaction was allowed in a custom
URL category) or the request was made from an unsupported application.

-

Requests blocked due to either the safe search or site content rating features, use one of the following ACL
decision tags in the access logs:

• BLOCK_SEARCH_UNSAFE
• BLOCK_CONTENT_UNSAFE
• BLOCK_UNSUPPORTED_SEARCH_APP
• BLOCK_CONTINUE_CONTENT_UNSAFE

Related Topics

• ACL Decision Tags, on page 377.

Redirecting Traffic in the Access Policies
You can configure the Web Security appliance to redirect traffic originally destined for a URL in a custom
URL category to a location you specify. This allows you to redirect traffic at the appliance instead of at the
destination server. You can redirect traffic for a custom Access Policy group or the Global Policy Group

Before you begin

To redirect traffic you must define at least one custom URL category.

Step 1 Choose Web Security Manager > Access Policies.
Step 2 Click the link under the URL Filtering column for an Access Policy group or the Global Policy Group.
Step 3 In the Custom URL Category Filtering section, click Select Custom Categories.
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Step 4 In the Select Custom Categories for this Policy dialog box, choose Include in policy for the custom URL category you
want to redirect.

Step 5 Click Apply.
Step 6 Click the Redirect column for the custom category you want to redirect.
Step 7 Enter the URL to which you want to redirect traffic in the Redirect To field for the custom category.
Step 8 Submit and Commit Changes.

Beware of infinite loops when you configure the appliance to redirect traffic.Note

What to do next

Related Topics

• Creating and Editing Custom URL Categories, on page 168

Logging and Reporting
When you redirect traffic, the access log entry for the originally requested website has an ACL tag that starts
with REDIRECT_CUSTOMCAT. Later in the access log (typically the next line) appears the entry for the
website to which the user was redirected.

The reports displayed on the Reporting tab display redirected transactions as “Allowed.”

Warning Users and Allowing Them to Continue
You can warn users that a site does not meet the organization’s acceptable use policies. Users are tracked in
the access log by user name if authentication has made a user name available, and tracked by IP address if no
user name is available.

You can warn and allow users to continue using one of the following methods:

• Choose the Warn action for a URL category in an Access Policy group or
• Enable the site content ratings feature and warn users that access adult content instead of blocking them.

Configuring Settings for the End-User Filtering Warning Page

• The warn and continue feature only works for HTTP and decrypted HTTPS transactions. It does not
work with native FTP transactions.

• When the URL filtering engine warns users for a particular request, it provides a warning page that the
Web Proxy sends to the end user. However, not all websites display the warning page to the end user.
When this happens, users are blocked from the URL that is assigned theWarn option without being given
the chance to continue accessing the site anyway.

Note

Step 1 Choose Security Services > End-User Notification.
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Step 2 Click Edit Settings.
Step 3 Configure the following settings on the End-User Filtering Warning page:

MethodOption

The Time BetweenWarning determines how often theWeb Proxy displays the end-user
URL filtering warning page for each URL category per user.

This setting applies to users tracked by username and users tracked by IP address.

Specify any value from 30 to 2678400 seconds (one month). Default is 1 hour (3600
seconds).

Time Between Warning

The custom message is text you enter that appears on every end-user URL filtering
warning page.

Include some simple HTML tags to format the text.

Custom Message

Step 4 Click Submit.

What to do next

Related Topics

• Filtering Adult Content, on page 173
• Custom Messages on Notification Pages, on page 312
• Configuring the End-User URL Filtering Warning Page, on page 311

Creating Time Based URL Filters
You can configure how the Web Security appliance to handles requests for URLs in particular categories
differently based on time and day.

Before you begin

Go to the Web Security Manager > Defined Time Range page to define at least one time range.

Step 1 Choose Web Security Manager > Access Policies.
Step 2 Click the link in the policies table under the URL Filtering column for the policy group you want to edit.
Step 3 Select Time-Based for the custom or predefined URL category you want to configure based on time range.
Step 4 In the In Time Range field, choose the defined time range to use for the URL category.
Step 5 In the Action field, choose the action to enact on transactions in this URL category during the defined time range.
Step 6 In the Otherwise field, choose the action to enact on transactions in this URL category outside the defined time range.
Step 7 Submit and Commit Changes.
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What to do next

Related Topics

• Time Ranges and Quotas, on page 214

Viewing URL Filtering Activity
TheReporting > URL Categories page provides a collective display of URL statistics that includes information
about top URL categories matched and top URL categories blocked. This page displays category-specific
data for bandwidth savings and web transactions.

Related Topics

• Generate Reports to Monitor End-user Activity, on page 327

Understanding Unfiltered and Uncategorized Data
When viewing URL statistics on the Reporting > URL Categories page, it is important to understand how to
interpret the following data:

DescriptionData Type

Represents policy, port, and admin user agent blocking that occurs before
URL filtering.

URL Filtering Bypassed

Represents all transactions for which the URL filtering engine is queried,
but no category is matched.

Uncategorized URL

URL Category Logging in Access Logs
The access log file records the URL category for each transaction in the scanning verdict information section
of each entry.

Related Topics

• Monitor System Activity Through Logs, on page 359.
• URL Category Descriptions, on page 182.

Regular Expressions
The Web Security appliance uses a regular expression syntax that differs slightly from the regular expression
syntax used by other Velocity pattern-matching engine implementations. Further, the appliance does not
support using a backward slash to escape a forward slash. If you need to use a forward slash in a regular
expression, simply type the forward slash without a backward slash.

Technically, AsyncOS for Web uses the Flex regular expression analyzer.Note

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
178

Classify URLs for Policy Application
Viewing URL Filtering Activity



You can use regular expressions in the following locations:

• Custom URL categories for Access Policies. When you create a custom URL category to use with
Access Policy groups, you can use regular expressions to specify multiple web servers that match the
pattern you enter.

• Custom user agents to block. When you edit the applications to block for an Access Policy group, you
can use regular expressions to enter specific user agents to block.

Regular expressions that perform extensive character matching consume resources and can affect system
performance. For this reason, regular expressions should be cautiously applied.

Note

Related Topics

• Creating and Editing Custom URL Categories, on page 168

Forming Regular Expressions
Regular expressions are rules that typically use the word “matches” in the expressions. They can be applied
to match specific URL destinations or web servers. For example, the following regular expression matches
any pattern containing “blocksite.com”:

\.blocksite\.com

Consider the following regular expression example:

server[0-9]\.example\.com

In this example, server[0-9]matches server0, server1, server2, ..., server9 in the domain example.com.

In the following example, the regular expression matches files ending in .exe, .zip and .bin in the downloads
directory.
/downloads/.*\.(exe|zip|bin)

You must enclose regular expressions that contain blank spaces or non-alphanumeric characters in ASCII
quotation marks.

Note

Guidelines for Avoiding Validation Failures
Important: Regular expressions that return more that 63 characters will fail and produce an invalid-entry
error. Please be sure to form regular expressions that do not have the potential to return more than 63
characters.

Follow these guidelines to minimize validation failures:

• Use literal expressions rather than wildcards and bracketed expressions whenever possible. A literal
expression is essentially just straight text such as “It’s as easy as ABC123”. This is less likely to fail
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than using “It’s as easy as [A-C]{3}[1-3]{3}”. The latter expression results in the creation of
non-deterministic finite automatons (NFA) entries, which can dramatically increase processing time.

• Avoid the use of an unescaped dot whenever possible. The dot is a special regular-expression character
that means match any character except for a newline. If you want to match an actual dot, for example,
as in “url.com”, then escape the dot using the \ character, as in “url\.com”. Escaped dots are treated as
literal entries and therefore do not cause issues.

• Any unescaped dot in a pattern that will return more than 63 characters after the dot will be disabled by
the pattern-matching engine, and an alert to that effect will be sent to you, and you will continue to receive
an alert following each update until you correct or replace the pattern.

Similarly, use more specific matches rather than unescaped dots wherever possible. For example, if you
want to match a URL that is followed by a single digit, use “url[0-9]” rather than “url.”.

• Unescaped dots in a larger regular expression can be especially problematic and should be avoided. For
example, “Four score and seven years ago our fathers brought forth on this continent, a

new nation, conceived in Liberty, and dedicated to the proposition that all men are

created .qual” may cause a failure. Replacing the dot in “.qual” with the literal “equal” should resolve
the problem.

Also, an unescaped dot in a pattern that will return more than 63 characters after the dot will be disabled
by the pattern-matching engine. Correct or replace the pattern.

• You cannot use “.*” to begin or end a regular expression. You also cannot use “./” in a regular expression
intended to match a URL, nor can you end such an expression with a dot.

• Combinations of wildcards and bracket expressions can cause problems. Eliminate as many combinations
as possible. For example, “id:[A-F0-9]{8}-[A-F0-9]{4}-[A-F0-9]{4}-[A-F0-9]{4}-[A-F0-9]{12}\)
Gecko/20100101 Firefox/9\.0\.1\$”may cause a failure, while “Gecko/20100101 Firefox/9\.0\.1\$”
will not. The latter expression does not include any wildcards or bracketed expressions, and both
expressions use only escaped dots.

When wildcards and bracketed expressions cannot be eliminated, try to reduce the expression’s size and
complexity. For example, “[0-9a-z]{64}” may cause a failure. Changing it to something smaller or less
complex, such as “[0-9]{64}” or “[0-9a-z]{40}” may resolve the problem.

If a failure occurs, try to resolve it by applying the previous rules to the wildcard (such as *, + and .) and
bracketed expressions.

You can use the CLI option advancedproxyconfig > miscellaneous > Do you want to enable URL lower

case conversion for velocity regex? to enable or disable default regex conversion to lower case for
case-insensitivematching. Use if you are experiencing issues with case sensitivity. SeeWeb Security Appliance
CLI Commands, on page 503 for more information about this option.

Note
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Regular Expression Character Table
DescriptionMeta-character

Matches any single character, except the newline character (0x0A). For example,
the regular expression r.t matches the strings rat, rut, r t, but not root.

Be wary of using unescaped dots in long patterns, and especially in the middle of
longer patterns. See Guidelines for Avoiding Validation Failures, on page 179 for
more information.

.

Matches zero or more occurrences of the character immediately preceding. For
example, the regular expression .* means match any string of characters, and [0-9]*
matches any string of digits.

Be wary of using this meta-character, especially in conjunction with the dot character.
Any pattern containing an unescaped dot that returns more than 63 characters after
the dot will be disabled. See Guidelines for Avoiding Validation Failures, on page
179 for more information.

*

The escape character; it means treat the following meta-character as an ordinary
character. For example, \^ is used to match the caret character (^) rather than the
beginning of a line. Similarly, the expression \. is used to match an actual dot rather
than any single character.

\

Matches the beginning of a line. For example, the regular expression ^When in
matches the beginning of the string “When in the course of human events” but not
the string “What and when in the”.

^

Matches the end of a line or string. For example, b$\. matches any line or string that
ends with “b.”

$

Matches one or more occurrences of the character or regular expression immediately
preceding. For example, the regular expression 9+ matches 9, 99, and 999.

+

Matches zero or one occurrence of the preceding pattern element. For example,
colou?r matches both “colour” and “color” since the “u” is optional.

?

Treat the expression between the left and right parens as a group, limiting the scope
of other meta-characters. For example, (abc)+ matches one or more occurrences of
the string “abc”; such as, “abcabcabc” or “abc123” but not “abab” or “ab123”.

( )

Logical OR: matches the preceding pattern or the following pattern. For example
(him|her) matches the line “it belongs to him” and the line “it belongs to her” but
does not match the line “it belongs to them.”

|
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DescriptionMeta-character

Matches any one of the characters between the brackets. For example, the regular
expression r[aou]t matches “rat”, “rot”, and “rut”, but not “ret”.

Ranges of characters are specified by a beginning character, a hyphen, and an ending
character. For example, the pattern [0-9] means match any digit. Multiple ranges
can be specified as well. The pattern [A-Za-z] means match any upper- or lower-case
letter. To match any character except those in the range (that is, the complementary
range), use a caret as the first character after the opening bracket. For example, the
expression [^269A-Z] matches any characters except 2, 6, 9, and uppercase letters.

[ ]

Specifies the number of times to match the previous pattern.

For example:

D{1,3} matches one to three occurrences of the letter D

Matches a specific number {n} or a minimum number {n,} of instances of the
preceding pattern. For example, the expression A[0-9]{3} matches “A” followed
by exactly three digits. That is, it matches “A123” but not “A1234”. The expression
[0-9]{4,} matches any sequence of four or more digits.

{ }

Literally interpret any characters enclosed within the quotation marks.“...”

URL Category Descriptions
This section lists the URL categories for Cisco Web Usage Controls. The tables also include the abbreviated
URL category names that may appear in the Web Reputation filtering and anti-malware scanning section of
an access log file entry.

In the access logs, the URL category abbreviations for Cisco Web Usage Controls include the prefix “IW_”
before each abbreviation so that the “art” category becomes “IW_art.”

Note

Example URLsDescriptionCodeAbbre
viation

URL Category

www.adultentertainmentexpo.com

www.sincerelynot.com

Directed at adults, but not necessarily
pornographic. May include adult clubs
(strip clubs, swingers clubs, escort
services, strippers); general information
about sex, non-pornographic in nature;
genital piercing; adult products or
greeting cards; information about sex not
in the context of health or disease.

1006adltAdult
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Example URLsDescriptionCodeAbbre
viation

URL Category

www.adforce.com

www.doubleclick.com

Banner and pop-up advertisements that
often accompany a web page; other
advertising websites that provide
advertisement content. Advertising
services and sales are classified as
“Business and Industry.”

1027advAdvertisements

www.samueladams.com

www.whisky.com

Alcohol as a pleasurable activity; beer
andwinemaking, cocktail recipes; liquor
sellers, wineries, vineyards, breweries,
alcohol distributors. Alcohol addiction
is classified as “Health and Medicine.”
Bars and restaurants are classified as
“Dining and Drinking.”

1077alcAlcohol

www.petmd.com

www.wheatenorg.uk

Information about domestic animals,
livestock, service animals, pets and their
care. Veterinary services, medicines, and
animal health. Pet and animal training,
aquariums, zoos, and animal shows.
Includes animal shelters, humane
societies, animal centric charities, and
sanctuaries, bee keeping, training, and
animal husbandry; dinosaurs and extinct
animals.

1107petsAnimals and Pets

www.moma.org

www.nga.gov

Galleries and exhibitions; artists and art;
photography; literature and books;
performing arts and theater; musicals;
ballet; museums; design; architecture.
Cinema and television are classified as
“Entertainment.”

1002artArts

www.astro.com

www.astrology.com

Astrology; horoscope; fortune telling;
numerology; psychic advice; tarot.

1074astrAstrology

www.craigslist.com

www.ebay.com

Online and offline auctions, auction
houses, and classified advertisements.

1088auctAuctions
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Example URLsDescriptionCodeAbbre
viation

URL Category

www.freightcenter.com

www.ge.com

Marketing, commerce, corporations,
business practices, workforce, human
resources, transportation, payroll,
security and venture capital; office
supplies; industrial equipment (process
equipment), machines and mechanical
systems; heating equipment, cooling
equipment; materials handling
equipment; packaging equipment;
manufacturing: solids handling, metal
fabrication, construction and building;
passenger transportation; commerce;
industrial design; construction, building
materials; shipping and freight (freight
services, trucking, freight forwarders,
truckload carriers, freight and
transportation brokers, expedited
services, load and freight matching, track
and trace, rail shipping, ocean shipping,
road feeder services, moving and
storage).

1019busiBusiness and
Industry

www.localproduct.co

www.oregonbc.com

Websites that focus on the recreational
and medicinal consumption of cannabis.
Sites may includemarketing, discussions
about legal and regulatory issues, growth
and production, paraphernalia, research,
and investment in the cannabis industry.
Dispensaries, cannabinoid (CBD oil,
THC, etc.) based products are also
included.

1109cannCannabis

www.icq.com

www.e-chat.co

Web-based instant messaging and chat
rooms.

1040chatChat and Instant
Messaging

www.bestessays.com

www.superiorpapers.com

Promoting cheating and selling written
work, such as term papers, for
plagiarism.

1051plagCheating and
Plagiarism

—Worldwide illegal child sexual abuse
content.

1064cprnChild Abuse
Content
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Example URLsDescriptionCodeAbbre
viation

URL Category

www.azurewebsites.net

www.s3.amazonaws.com

Platforms used to serve cloud
infrastructure or data center hosting to
support an organization's applications,
services, or data processing. Due to the
de-centralized nature of these domains
and IP addresses, a more specific
category cannot be applied based on
content or ownership.

1118servCloud and Data
Centers

www.computersecurity.com

www.symantec.com

Offering security products and services
for corporate and home users.

1065csecComputer Security

www.xml.com

www.w3.org

Information about computers and
software, such as hardware, software,
software support; information for
software engineers, programming and
networking; website design; the web and
Internet in general; computer science;
computer graphics and clipart. “Freeware
and Shareware” is a separate category.

1003compComputers and
Internet

www.thesmallbusinessexpo.com

www.makerfaire.com

Seminars, trade shows, conventions and
conferences themed around a particular
industry, market, or common interest.
May include information about acquiring
tickets, registration, abstract or
presentation proposal guidelines,
workshops, sponsorship details, vendor
or exhibitor information, and other
marketing or promotional material. This
category includes academic,
professional, as well as pop-culture
events, all of which tend to be a
short-lived or annual event.

1110expoConventions,
Conferences and
Trade Shows

www.coinbase.com

www.coinsutra.com

Online brokerages and websites that
enable users to trade cryptocurrencies;
information regarding cryptocurrencies
including analysis, commentary, advice,
performance indexes, and price charts.
General information about cryptomining
and mining businesses are included in
this category but domains and IP
addresses directly involved in mining
activities are categorized as
Cryptomining.

1111crypCryptocurrency
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Example URLsDescriptionCodeAbbre
viation

URL Category

www.give-me-coins.com

www.slushpool.com

Hosts that are actively participating in a
cryptocurrency mining pool.

1112mineCryptomining

www.eharmony.com

www.match.com

Dating, online personals, matrimonial
agencies.

1055dateDating

www.hallmarkecards.com

www.bluemountain.com

Enabling sending of digital postcards
and e-cards.

1082cardDigital Postcards

www.zagat.com

www.experiencethepub.com

Eating and drinking establishments;
restaurants, bars, taverns, and pubs;
restaurant guides and reviews.

1061foodDining and
Drinking

www.diy-tips.co.uk

www.thisoldhouse.com

Guidance and information to create,
improve, modify, decorate and repair
something without the aid of experts or
professionals.

1097diyDIY Projects

Sites that provide DNS Tunneling as a
service. These services can be for PC or
mobile and create a VPN connection
specifically over DNS to send traffic that
may bypass corporate policies and
inspection.

1122tunnDNS-Tuneling

www.cloudflare-dns.com

www.dns.google.com

Encrypted DNS requests using either the
DNS over HTTPS (DoH) protocol or the
DNS over TLS protocol. These protocols
are typically used as a layer of security
and privacy by end-users, but the
encryption hides the destination of the
request and passes it through a
third-party.

1113dohtDoH and DoT

http://109.60.192.55IP addresses of broadband links that
usually indicates users attempting to
access their home network, for example
for a remote session to a home computer.

1091dynDynamic and
Residential

www.noip.com

www.afraid.org

sers may use dynamic DNS services to
make certain applications or content
accessible via the web from endpoints
hosted on dynamically assigned IP
addresses. Access is granted through a
hostname on the domain owned by the
dynamic DNS service.

1114ddnsDynamic DNS
Provider
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Example URLsDescriptionCodeAbbre
viation

URL Category

www.education.com

www.greatschools.org

Education-related, such as schools,
colleges, universities, teachingmaterials,
and teachers’ resources; technical and
vocational training; online training;
education issues and policies; financial
aid; school funding; standards and
testing.

1001eduEducation

www.eonline.com

www.ew.com

Details or discussion of films; music and
bands; television; celebrities and fan
websites; entertainment news; celebrity
gossip; entertainment venues. Compare
with the “Arts” category.

1093entEntertainment

www.car-accidents.com

www.crime-scene-photos.com

Material of a sexually violent or criminal
nature; violence and violent behavior;
tasteless, often gory photographs, such
as autopsy photos; photos of crime
scenes, crime and accident victims;
excessive obscene material; shock
websites.

1075extrExtreme

www.fashion.net

www.styleseat.com

Clothing and fashion; hair salons;
cosmetics; accessories; jewelry; perfume;
pictures and text relating to body
modification; tattoos and piercing;
modeling agencies. Dermatological
products are classified as “Health and
Medicine.”

1076fashFashion

www.sharefile.com

www.wetransfer.com

File transfer services with the primary
purpose of providing download services
and hosted file sharing

1071ftsFile Transfer
Services

www.bypassschoolfilter.com

www.filterbypass.com

Promoting and aiding undetectable and
anonymous web usage, including cgi,
php and glype anonymous proxy
services.

1025filtFilter Avoidance

www.finance.yahoo.com

www.bankofamerica.com

Primarily financial in nature, such as
accounting practices and accountants,
taxation, taxes, banking, insurance,
investing, the national economy,
personal finance involving insurance of
all types, credit cards, retirement and
estate planning, loans, mortgages. Stock
and shares are classified as “Online
Trading.”

1015fnncFinance
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Example URLsDescriptionCodeAbbre
viation

URL Category

www.freewarehome.com

www.filehippo.com

Providing downloads of free and
shareware software.

1068freeFreeware and
Shareware

www.888.com

www.gambling.com

Casinos and online gambling;
bookmakers and odds; gambling advice;
competitive racing in a gambling
context; sports booking; sports gambling;
services for spread betting on stocks and
shares. Websites dealing with gambling
addiction are classified as “Health and
Medicine.” Government-run lotteries are
classified as “Lotteries”.

1049gambGambling

www.games.com

www.shockwave.com

Various card games, board games, word
games, and video games; combat games;
sports games; downloadable games;
game reviews; cheat sheets; computer
games and Internet games, such as
role-playing games.

1007gameGames

www.usa.gov

www.law.com

Government websites; foreign relations;
news and information relating to
government and elections; information
relating to the field of law, such as
attorneys, law firms, law publications,
legal reference material, courts, dockets,
and legal associations; legislation and
court decisions; civil rights issues;
immigration; patents and copyrights;
information relating to law enforcement
and correctional systems; crime
reporting, law enforcement, and crime
statistics; military, such as the armed
forces, military bases, military
organizations; anti-terrorism.

1011govGovernment and
Law

www.hackthissite.org

www.gohacking.com

Discussing ways to bypass the security
of websites, software, and computers.

1050hackHacking

www.kkk.com

www.aryanunity.com

Websites promoting hatred, intolerance,
or discrimination on the basis of social
group, color, religion, sexual orientation,
disability, class, ethnicity, nationality,
age, gender, gender identity; sites
promoting racism; sexism; racist
theology; hate music; neo-Nazi
organizations; supremacism; Holocaust
denial.

1016hateHate Speech
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Example URLsDescriptionCodeAbbre
viation

URL Category

www.webmd.com

www.health.com

Health care; diseases and disabilities;
medical care; hospitals; doctors;
medicinal drugs; mental health;
psychiatry; pharmacology; exercise and
fitness; physical disabilities; vitamins
and supplements; sex in the context of
health (disease and health care); tobacco
use, alcohol use, drug use, and gambling
in the context of health (disease and
health care).

1104hmedHealth and
Medicine

www.pun.me

www.jokes.com

Jokes, sketches, comics and other
humorous content. Adult humor likely
to offend is classified as “Adult.”

1079lolHumor

www.bulletsafaris.com

www.mfha.org

Hunting and Fishing Professional or
sport hunting; gun clubs and other
hunting related sites.

1022huntHunting

www.ekran.no

www.pyrobin.com

Promoting crime, such as stealing, fraud,
illegally accessing telephone networks;
computer viruses; terrorism, bombs, and
anarchy; websites depicting murder and
suicide as well as explaining ways to
commit them.

1022ilacIllegal Activities

www.keygenninja.com

www.rootscrack.com

Providing the ability to download
software or other materials, serial
numbers, key generators, and tools for
bypassing software protection in
violation of copyright agreements.
Torrents are classified as “Peer File
Transfer.”

1084ildlIllegal Downloads

www.shroomery.org

www.hightimes.com

Information about recreational drugs,
drug paraphernalia, drug purchase and
manufacture.

1047drugIllegal Drugs

www.akamai.net

www.webstat.net

Content delivery infrastructure and
dynamically generated content; websites
that cannot be classified more
specifically because they are secured or
otherwise difficult to classify.

1018infrInfrastructure and
Content Delivery
Networks
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Example URLsDescriptionCodeAbbre
viation

URL Category

www.samsungotn.net

www.transport.nest.com

Domains used to monitor the general
health, activity, or aid in the
configuration of Internet of Things (IoT)
and other network-aware electronics.
Additionally these sites may provide
software or firmware updates or allow
remote access to administer the device.
IoT exists in both consumer and
professional segments, in products such
as printers, televisions, thermostats,
system monitoring, automation, and
smart appliances.

1116iotInternet of Things

www.skype.com

www.getvoca.com

Telephonic services using the Internet.1067voipInternet Telephony

www.careerbuilder.com

www.monster.com

Career advice; resume writing and
interviewing skills; job placement
services; job databanks; permanent and
temporary employment agencies;
employer websites.

1004jobJob Search

www.swimsuits.com

www.victoriassecret.com

Intimate apparel and swimwear,
especially when modeled.

1031lingLingerie and
Swimsuits

www.calottery.com

www.flalottery.com

Sweepstakes, contests and
state-sponsored lotteries.

1034lotrLotteries

www.goarmy.com

www.todaysmilitary.com

Military, such as the armed forces;
military bases; military organizations;
anti-terrorism.

1099milMilitary

www.cbfsms.com

www.zedge.net

Short Message Services (SMS);
ringtones and mobile phone downloads.
Cellular carrier websites are included in
the “Business and Industry” category.

1070cellMobile Phones

www.ushmm.org

www.museodelasmomiasdeguanajuato.negocio.site

Museums and exhibits, both online and
physical, dedicated to preserving
information regarding subjects that could
be of general interest or highly
specialized. Subjects could range from
art, history, science, or be of cultural
importance.

1117museMuseums
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Example URLsDescriptionCodeAbbre
viation

URL Category

www.nature.org

www.thepottedgarden.co.uk

Sites related to natural resources;
ecology and conservation; forests;
wilderness; plants; flowers; forest
conservation; forest, wilderness, and
forestry practices; forest management
(reforestation, forest protection,
conservation, harvesting, forest health,
thinning, and prescribed burning);
agricultural practices (agriculture,
gardening, horticulture, landscaping,
planting, weed control, irrigation,
pruning, and harvesting); pollution issues
(air quality, hazardous waste, pollution
prevention, recycling, waste
management, water quality, and the
environmental cleanup industry).

1106nconNature and
Conservation

www.cnn.com

www.news.bbc.co.uk

News; headlines; newspapers; television
stations; magazines; weather; ski
conditions.

1058newsNews

www.panda.org

www.unions.org

Non-governmental organizations such
as clubs, lobbies, communities,
non-profit organizations and labor
unions.

1087ngoNon-governmental
Organizations

www.1001fessesproject.com

www.naturistsociety.com

Nudism and nudity; naturism; nudist
camps; artistic nudes.

1060nsnNon-sexual Nudity

—Sites that have been inspected but are
unreachable or do not have enough
content to be assigned a category.

1103nactNot Actionable

www.reddit.com

www.stackexchange.com

Affinity groups; special interest groups;
web newsgroups; message boards.
Excludes websites classified as
“Professional Networking” or “Social
Networking.”

1024commOnline
Communities

www.pastebin.com

www.docs.google.com

Cloud-based software used to create,
convert, or edit documents.
Collaboration and sharing features may
be available with access permissions
typically configured by the author.
Documents may be stored online or
available to download.

1115docsOnline Document
Sharing and
Collaboration
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Example URLsDescriptionCodeAbbre
viation

URL Category

www.join.me

www.teamviewer.com

Online meetings; desktop sharing;
remote access and other tools that
facilitate multi-location collaboration

1100meetOnline Meetings

www.adrive.com

www.dropbox.com

Offsite and peer-to-peer storage for
backup, sharing, and hosting.

1066osbOnline Storage and
Backup

www.tdameritrade.com

www.etrade.com

Online brokerages; websites that enable
the user to trade stocks online;
information relating to the stockmarket,
stocks, bonds, mutual funds, brokers,
stock analysis and commentary, stock
screens, stock charts, IPOs, stock splits.
Services for spread betting on stocks and
shares are classified as “Gambling.”
Other financial services are classified as
“Finance.”

1028tradOnline Trading

www.mail.zoho.com

www.webmail.edmc.edu

Websites used to access business email
(often via Outlook Web Access).

1085pemOrganizational
Email

www.ghoststudy.com

www.ufocasebook.com

UFOs; ghosts; cryptid; telekenesis; urban
legends; and myths.

1101prnmParanormal

www.domainzaar.com

www.cricketbuzz.com

Websites that monetize traffic from the
domain using paid listings from an ad
network, or are owned by “squatters”
hoping to sell the domain name for a
profit. These also include fake search
websites which return paid ad links.

1092parkParked Domains

www.bittorrent.com

www.torrentdownloads.me

Peer-to-peer file request websites. This
does not track the file transfers
themselves.

1056p2pPeer File Transfer

www.blogmaverick.com

www.stallman.org

Websites about and from private
individuals; personal homepage servers;
websites with personal contents; personal
blogs with no particular theme.

1081persPersonal Sites

www.openvpn.net

www.torvpn.com

Virtual private network (VPN) sites or
tools that are typically for personal use,
and, may or may not be approved for
corporate usage.

1102pvpnPersonal VPN

www.flickr.com

www.photobucket.com

Facilitating the storing and searching for,
images, photographs, and clip-art.

1090imgPhoto Search and
Images
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Example URLsDescriptionCodeAbbre
viation

URL Category

www.politics.com

www.gp.org

Websites of politicians; political parties;
news and information on politics,
elections, democracy, and voting.

1083polPolitics

www.redtube.com

www.youporn.com

Sexually explicit text or depictions.
Includes explicit anime and cartoons;
general explicit depictions; other fetish
material; explicit chat rooms; sex
simulators; strip poker; adult movies;
lewd art; web-based explicit email.

1054pornPornography

Private IP addresses which are used as
the host part of a URL. Private IP
addresses are meant for internal use
behind border routers only, so they are
not publicly routable.

1121piahPrivate IP
Addresses as Host

www.linkedin.com

www.europeanpwn.net

Social networking for the purpose of
career or professional development. See
also “Social Networking.”

1089pnetProfessional
Networking

www.realtor.com

www.zillow.com

Information that would support the
search for real estate; office and
commercial space; real estate listings,
such as rentals, apartments, and homes;
house building.

1045restReal Estate

www.allrecipes.com

www.seriouseats.com

Sites dedicated to sharing or discussing
information about cooking, recipes, and
food or non-alcoholic beverages; cultural
aspects of cuisine and food; diet
descriptions and adherence tips, general
nutrition information about foods. Use
and instruction on cooking appliances
and utensils. Food celebrity, lifestyle,
and enthusiast blogs.

1105reciRecipes and Food

www.wikipedia.org

www.yellowpages.com

City and state guides; maps, time;
reference sources; dictionaries; libraries.

1017refReference

URLs that are restricted in Germany due
to content which may be unlawful as
determined by the regional government.

1125xdeuRegional Restricted
Sites (Germany)

URLs that are restricted in Great Britain
due to content which may be unlawful
as determined by the regional
government.

1123xgbrRegional Restricted
Sites (Great
Britain)
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Example URLsDescriptionCodeAbbre
viation

URL Category

URLs that are restricted in Italy due to
content which may be unlawful as
determined by the regional government.

1124xitaRegional Restricted
Sites (Italy)

www.betsafe62.com

www.tornadobet69.com

URLs that are restricted in Poland due
to content which may be unlawful as
determined by the regional government.

1126xpolRegional Restricted
Sites (Poland)

www.religionfacts.com

www.religioustolerance.org

Religious content, information about
religions; religious communities.

1086relReligion

www.netsuite.com

www.salesforce.com

Web portals for online business services;
online meetings.

1080saasSaaS and B2B

www.discoverykids.com

www.nickjr.com

Directed at, and specifically approved
for, young children.

1057kidsSafe for Kids

www.physorg.com

www.science.gov

Science and technology, such as
aerospace, electronics, engineering,
mathematics, and other similar subjects;
space exploration; meteorology;
geography; environment; energy (fossil,
nuclear, renewable); communications
(telephones, telecommunications).

1012sciScience and
Technology

www.bing.com

www.google.com

Search engines and other initial points
of access to information on the Internet.

1020srchSearch Engines and
Portals

www.avert.org

www.scarleteen.com

Factual websites dealingwith sex; sexual
health; contraception; pregnancy.

1052sxedSex Education

www.amazon.com

www.shopping.com

Bartering; online purchasing; coupons
and free offers; general office supplies;
online catalogs; online malls.

1005shopShopping

www.facebook.com

www.twitter.com

Social networking. See also
“Professional Networking.”

1069snetSocial Networking

www.archaeology.org

www.anthropology.net

Sciences and history related to society;
archaeology; anthropology; cultural
studies; history; linguistics; geography;
philosophy; psychology; women's
studies.

1014socsSocial Science

www.childcareaware.org

www.familysearch.org

Family and relationships; ethnicity;
social organizations; genealogy; seniors;
child-care.

1010sctySociety andCulture
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www.softwarepatch.com

www.windowsupdate.com

Websites that host updates for software
packages.

1053swupSoftware Updates

www.espn.com

www.recreation.gov

All sports, professional and amateur;
recreational activities; fishing; fantasy
sports; public parks; amusement parks;
water parks; theme parks; zoos and
aquariums; spas.

1008sprtSports and
Recreation

www.live-radio.net

www.shoutcast.com

Real-time streaming audio content
including Internet radio and audio feeds.

1073audStreaming Audio

www.hulu.com

www.youtube.com

Real-time streaming video including
Internet television, web casts, and video
sharing.

1072vidStreaming Video

Terrorist or extremist websites that
promote death or violence as part of their
ideology. Sites may contain graphic or
disturbing images, videos, and text.
Some sites may not advocate terrorism
but share first-hand material of a violent
nature.

1119terrTerrorism and
Violent Extremism

www.bat.com

www.tobacco.org

Pro-tobacco websites; tobacco
manufacturers; pipes and smoking
products (not marketed for illegal drug
use). Tobacco addiction is classified as
“Health and Medicine.”

1078tobTobacco

www.cars.com

www.motorcycles.com

Personal transportation; information
about cars and motorcycles; shopping
for new and used cars and motorcycles;
car clubs; boats, airplanes, recreational
vehicles (RVs), and other similar items.
Note, car and motorcycle racing is
classified as “Sports and Recreation.”

1044trnsTransportation

www.expedia.com

www.lonelyplanet.com

Business and personal travel; travel
information; travel resources; travel
agents; vacation packages; cruises;
lodging and accommodation; travel
transportation; flight booking; airfares;
car rental; vacation homes.

1046trvlTravel

www.bit.ly

www.tinyurl.com

Domains used to shorten long URLs,
brand URLs, or may obscure the final
destination of a hyperlink.

1120shrtURL Shorteners
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URL Category

www.coldsteel.com

www.gunbroker.com

Information relating to the purchase or
use of conventional weapons such as gun
sellers, gun auctions, gun classified ads,
gun accessories, gun shows, and gun
training; general information about guns;
other weapons and graphic hunting sites
may be included. Government military
websites are classified as “Government
and Law.”

1036weapWeapons

www.archive.org

www.webcache.googleusercontent.com

Cached or archived web content often
stored for preservation or to decrease
load times.

1108cachWeb Cache and
Archives

www.bluehost.com

www.godaddy.com

Website hosting; bandwidth services.1037whstWeb Hosting

www.babelfish.com

www.translate.google.com

Translation of web pages between
languages.

1063tranWeb Page
Translation

www.mail.yahoo.com

www.outlook.com

Public web-based email services.
Websites enabling individuals to access
their company or organization’s email
service are classified as “Organizational
Email.”

1038mailWeb-based Email

Related Topics

• Managing Updates to the Set of URL Categories , on page 156

• Reporting Uncategorized and Misclassified URLs, on page 155
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C H A P T E R 11
Create Policies to Control Internet Requests

This chapter contains the following sections:

• Overview of Policies: Control Intercepted Internet Requests, on page 197
• Managing Web Requests Through Policies Task Overview, on page 199
• Managing Web Requests Through Policies Best Practices, on page 199
• Policies, on page 199
• Policy Configuration, on page 207
• Block, Allow, or Redirect Transaction Requests, on page 211
• Client Applications, on page 212
• Time Ranges and Quotas, on page 214
• Access Control by URL Category, on page 217
• Remote Users, on page 218
• Troubleshooting Policies, on page 220

Overview of Policies: Control Intercepted Internet Requests
When the user creates a web request the configured Web Security Appliance intercepts the requests and
manages the process of which the request travels to get to its final outcome, be that accessing a particular web
site, an email or even accessing an online application. In configuring the Web Security Appliance policies
are created to define the criteria and actions of requests made by the user.

Policies are the means by which the Web Security Appliance identifies and controls web requests. When a
client sends a web request to a server, the Web Proxy receives the request, evaluates it, and determines to
which policy it belongs. Actions defined in the policy are then applied to the request.

The Web Security Appliance uses multiple policy types to manage different aspects of web requests. Policy
types might fully manage transactions by themselves or pass transactions along to other policy types for
additional processing. Policy types can be groups by the functions they perform, such as access, routing, or
security.

AsyncOS evaluates transactions based on policies before it evaluates external dependencies to avoid unnecessary
external communication from the appliance. For example, if a transaction is blocked based on a policy that
blocks uncategorized URLs, the transaction will not fail based on a DNS error.

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
197



Intercepted HTTP/HTTPS Request Processing
The following diagram depicts the flow of an intercepted Web request as it is processed by the appliance.

Figure 3: HTTP/HTTPS Transaction Flow

Also see the following diagrams depicting various transaction processing flows:

• Figure 1: Identification Profiles and Authentication Processing – No Surrogates and IP-based Surrogates,
on page 131

• Figure 2: Identification Profiles and Authentication Processing – Cookie-based Surrogates, on page 132
• Figure 4: Policy Group Transaction Flow for Access Policies, on page 203
• Figure 6: Policy Group Transaction Flow for Decryption Policies, on page 226
• Figure 7: Applying Decryption Policy Actions, on page 229
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Managing Web Requests Through Policies Task Overview
Links to Related Topics and ProceduresTask List for Managing Web Requests through

Policies
Step

Authentication Realms, on page 94Set up and sequence Authentication Realms1

Creating Proxy Groups for Upstream Proxies,
on page 25

(For upstream proxies) Create a proxy group.2

Client Applications, on page 212(Optional) Create Custom Client Applications2

Creating and Editing CustomURLCategories,
on page 168

(Optional) Create Custom URL Categories3

Classifying Users and Client Software, on
page 125

Create Identification Profiles4

Time Ranges and Quotas, on page 214(Optional) Create time ranges to Limit Access
by Time of Day

5

• Creating a Policy , on page 203
• Policy Order, on page 202

Create and Order Policies6

Managing Web Requests Through Policies Best Practices
If you want to use Active Directory user objects to manage web requests, do not use primary groups as criteria.
Active Directory user objects do not contain the primary group.

Policies
• Policy Types, on page 199
• Policy Order, on page 202
• Creating a Policy , on page 203

Policy Types
Link to taskDescriptionRequest TypePolicy Type

Creating a Policy , on page
203

Block, allow or redirect inbound
HTTP, FTP, and decrypted HTTPS
traffic.

Access policies also manage inbound
encrypted HTTPS traffic if the
HTTPS proxy is disabled.

• HTTP
• Decrypted
HTTPS

• FTP

Access
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Link to taskDescriptionRequest TypePolicy Type

Creating a Policy , on page
203

Allow or block SOCKS
communication requests.

• SOCKSSOCKS

Creating SaaS Application
Authentication Policies, on
page 136

Allow or deny access to a Software
as a Service (SaaS) application.

Use single sign-on to authenticate
users and increase security by
allowing access to applications to be
quickly disabled.

To use the single sign-on feature of
policies you must configure the Web
Security appliance as an identity
provider and upload or generate a
certificate and key for SaaS.

• applicationApplication
Authentication

Creating a Policy , on page
203

Decrypt, pass through, or dropHTTPS
connections.

AsyncOS passes decrypted traffic to
Access policies for further processing.

• HTTPSEncrypted
HTTPS
Management

Creating a Policy , on page
203

Manage data uploads to the web. Data
Security policies scan outbound traffic
to ensure it complies to company rules
for data uploads, based on its
destination and content. Unlike
External DLP policies, which redirect
outbound traffic to external servers
for scanning, Data Security policies
use the Web Security appliance to
scan and evaluate traffic.

• HTTP
• Decrypted
HTTPS

• FTP

Data Security

Creating a Policy , on page
203

Send outbound traffic to servers
running 3rd-party DLP systems,
which scan it for adherence to
company rules for data uploads.
Unlike Data Security policies, which
also manage data uploads, External
DLP policies move scanning work
away from the Web Security
appliance, which frees resources on
the appliance and leverages any
additional functionality offered by
3rd-party software.

• HTTP
• Decrypted
HTTPS

• FTP

External DLP
(Data Loss
Prevention)
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Link to taskDescriptionRequest TypePolicy Type

Creating a Policy , on page
203

Block, monitor, or allow requests to
upload data that may contain
malicious data.

Prevent malware that is already
present on your network from being
transmitted to external networks.

• HTTP
• Decrypted
HTTPS

• FTP

Outbound
Malware
Scanning

Creating a Policy , on page
203

Direct web traffic through upstream
proxies or direct it to destination
servers. You might want to redirect
traffic through upstream proxies to
preserve your existing network design,
to off-load processing from the Web
Security appliance, or to leverage
additional functionality provided by
3rd-party proxy systems.

If multiple upstream proxies are
available, theWeb Security appliance
can use load balancing techniques to
distribute data to them.

• HTTP
• HTTPS
• FTP

Routing

Each policy type uses a policy table to store andmanage its policies. Each policy table comes with a predefined,
global policy, which maintains default actions for a policy type. Additional, user-defined policies are created
and added to the policy table as required. Policies are processed in the order in which they are listed in the
policy table.

Individual policies define the user-request types they manage, and the actions they perform on those requests.
Each policy definition has two main sections:

• Identification Profiles and Users – Identification Profiles are used in policy membership criteria and
are particularly important as they contain many options for identifying web transaction. They also share
many properties with policies.

• Advanced – The criteria used to identify users to which the policy applies. One or more criteria can be
specified in a policy, and all must be match for the criteria to be met.

• Protocols – Allow the transfer of data between various networking devices such as http, https, ftp,
etc.

• Proxy Ports – the numbered port by which the request accesses the web proxy,
• Subnets – The logical grouping of connected network devices (such as geographic location or Local
Area Network [LAN]), where the request originated

• Time Range – Time ranges can be created for use in policies to identify or apply actions to web
requests based on the time or day the requests were made. The time ranges are created as individual
units.

• URL Categories – URL categories are predefined or custom categories of websites, such as News,
Business, Social Media, etc. These can be used to identify or apply actions to web requests.

• User Agents – These are the client applications (such as updaters and Web browsers) used to make
requests. You can define policy criteria based on user agents, and you can specify control settings
based on user agents. You can also exempt user agents from authentication, which is useful for
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applications that cannot prompt for credentials. You can define custom user agents but cannot re-use
these definitions other policies.

When you define multiple membership criteria, the client request must meet all criteria to match the policy.Note

Policy Order
The order in which policies are listed in a policy table determines the priority with which they are applied to
Web requests. Web requests are checked against policies beginning at the top of the table and ending at the
first policy matched. Any policies below that point in the table are not processed.

If no user-defined policy is matched against a Web request, then the global policy for that policy type is
applied. Global policies are always positioned last in Policy tables and cannot be re-ordered.

The following diagram depicts the flow of a client request through the Access policies table.
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Figure 4: Policy Group Transaction Flow for Access Policies

Creating a Policy

Before you begin

• Enable the appropriate proxy:

• Web Proxy (for HTTP, decrypted HTTPS, and FTP)
• HTTPS Proxy
• SOCKS Proxy

• Create associated Identification Profiles.
• Understand Policy Order, on page 202.
• (Encrypted HTTPS only) Upload or generate a Certificate and Key.
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• (Data Security only) Enable Cisco Data Security Filters Settings.
• (External DLP only) Define an External DLP server.
• (Routing only) Define the associated upstream proxy on the Web Security appliance.
• (Optional) Create associated client applications.
• (Optional) Create associated time ranges. See Time Ranges and Quotas, on page 214.
• (Optional) Create associated URL categories. See Creating and Editing Custom URL Categories, on
page 168.

Step 1 In the Policy Settings section, use the Enable Identity check box to enable this policy, or to quickly disable it without
deleting it.

Step 2 Assign a unique policy Name.
Step 3 A Description is optional.
Step 4 From the Insert Above drop-down list, choose where this policy is to appear in the table.

Arrange policies such that, from top to bottom of the table, they are in most-restrictive to least-restrictive order.
See Policy Order, on page 202 for more information.

Note

Step 5 In the Policy Expires area, check the Set Expiration for Policy check box to set the expiry time for the policy. Enter
the date and time for the policy expiration that you want to set. The policies are automatically disabled once they exceed
the set expiry time.

System checks the policies every minute to disable the policies which get expired during the minute. For
example, if a policy is set to expire at 11:00, at maximum it will be disabled by 11:01.

Policy Expiry feature is applicable only for Access, Decryption, and Web Traffic Tap policies.

Note

You will receive an email prior to three days of the policy expiry and another one upon policy expiry.

To receive alerts, you must enable Policy Expiration alerts using System Administration >Alerts . See Policy
Expiration Alerts, on page 444

Note

You can set the policy expiration time through Cisco Content Security Management Appliances as well. The policies
will get expired after the set expiry time but will not be shown as disabled in the Cisco Content Security Management
Appliances GUI.

Once you set the policy expiration feature, the expiry happens based on the appliance's local time settings.

Step 6 In the Policy Member Definition section, specify how user and group membership is defined: from the Identification
Profiles and Users list, choose one of the following:

• All Identification Profiles – This policy will apply to all existing profiles. Youmust also define at least oneAdvanced
option.

• Select One or More Identification Profiles – A table for specifying individual Identification Profiles appears, one
profile-membership definition per row.

Step 7 If you chose All Identification Profiles:
a) Specify the authorized users and groups to which this policy applies by selecting one of the following options:

• All Authenticated Users – All users identified through authentication or transparent identification.
• Selected Groups and Users – Specified users and groups are used.

To add or edit the specified ISE Secure Group Tags (SGTs) and the specified Users, click the link following
the appropriate label. For example, click the list of currently specified users to edit that list. See Adding and
Editing Secure Group Tags for a Policy, on page 206 for more information.
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If you use ISE, you can add or edit ISE Secure Group Tags. This is not supported in ISE-PIC deployments. To
add or edit the specified ISE Groups, click the link following the label. This option is specific to ISE-PIC.

• Guests – Users connected as guests and those failing authentication.
• All Users – All clients, whether authenticated or not. If this option is selected, at least one Advanced option
also must be provided.

Step 8 If you chose Select One or More Identification Profiles, a profile-selection table appears.
a) Choose an Identification Profile from the Select Identification Profile drop-down list in the Identification Profiles

column.
b) Specify the Authorized Users and Groups to which this policy applies:

• All Authenticated Users – All users identified through authentication or transparent identification.
• Selected Groups and Users – Specified users and groups are used.

To add or edit the specified ISE Secure Group Tags (SGTs) and the specified Users, click the link following the
appropriate label. For example, click the list of currently specified users to edit that list. See Adding and Editing
Secure Group Tags for a Policy, on page 206 for more information.

• Guests – Users connected as guests and those failing authentication.

c) To add a row to the profile-selection table, click Add Identification Profile. To delete a row, click the trash-can icon
in that row.

Repeat steps (a) through (c) as necessary to add all desired Identification Profiles.

Step 9 Expand the Advanced section to define additional group membership criteria. (This step may be optional depending on
selection in the Policy Member Definition section. Also, some of the following options will not be available, depending
on the type of policy you are configuring.) .

DescriptionAdvanced Option

Select the protocols to which this policy will apply. All others means any protocol not selected. If
the associated identification profile applies to specific protocols, this policy applies to those same
protocols

Protocols

Applies this policy only to traffic using specific ports to access the web proxy. Enter one or more
port numbers, separating multiple ports with commas.

For explicit forward connections, this is the port configured in the browser.

For transparent connections, this is the same as the destination port.

If the associated identification profile applies only to specific proxy ports, you cannot
enter proxy ports here.

Note

Proxy Ports

Applies this policy only to traffic on specific subnets. Select Specify subnets and enter the specific
subnets, separated by commas.

Leave Use subnets from selected Identities selected if you do not want additional filtering by
subnet.

If the associated identity applies to specific subnets, you can further restrict the application
of this policy to a subset of the addresses to which the identity applies.

Note

Subnets
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DescriptionAdvanced Option

You can apply time ranges for policy membership:

• Time Range – Choose a previously defined time range (Time Ranges and Quotas, on page 214).
• Match Time Range – Use this option to indicate whether this time range is inclusive or exclusive.
In other words, whether to match only during the range specified, or at all times except those
in the specified range.

Time Range

You can restrict policy membership by specific destinations (URLs) and by categories of URLs.
Select all desired custom and predefined categories. See Creating and Editing CustomURLCategories,
on page 168 for information about custom categories.

URL Categories

You can select specific user agents, and define custom agents using regular expressions, as part of
membership definition for this policy.

• Common User Agents

• Browsers – Expand this section to select various Web browsers.
• Others – Expand this section to select specific non-browser agents such as application
updaters.

• Custom User Agents – You can enter one or more regular expressions, one per line, to define
custom user agents.

• Match User Agents – Use this option to indicate whether these user-agent specifications are
inclusive or exclusive. In other words, whether membership definition includes only the selected
user agents, or specifically excludes the selected user agents.

User Agents

Adding and Editing Secure Group Tags for a Policy
To change the list of Secure Group Tags (SGTs) assigned to a particular Identification Profile in a policy,
click the link following the ISE Secure Group Tags label in the Selected Groups and Users list on the Add/Edit
Policy page. (See Creating a Policy , on page 203.) This link is either “No tags entered,” or it is a list of currently
assigned tags. The link opens the Add/Edit Secure Group Tags page.

All SGTs currently assigned to this policy are listed in the Authorized Secure Group Tags section. All SGTs
available from the connected ISE server are listed in the Secure Group Tag Search section.

Step 1 To add one or more SGTs to the Authorized Secure Group Tags list, select the desired entries in the Secure Group Tag
Search section, and then click Add.

• The SGTs already added, are highlighted in green. To quickly find a specific SGT in the list of those
available, enter a text string in the Search field.

• When a Web Security appliance is connected to ISE/ISE-PIC, default SGTs from ISE/ISE-PIC are also
displayed. These SGTs will not have users assigned. Ensure that you select the correct SGTs.

Note

Step 2 To remove one or more SGTs from the Authorized Secure Group Tags list, select those entries and then click Delete.
Step 3 Click Done to return to the Add/Edit Group page.
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What to do next

Related Topics

• Time Ranges and Quotas, on page 214
• Using Client Applications in Policies, on page 213

Policy Configuration
Each row in a table of policies represents a policy definition, and each column displays current contains a link
to a configuration page for that element of the policy.

Of the following policy-configuration components, you can specify the “Warn” option only with URL Filtering.Note

DescriptionOption

Used to control policy access to protocols and configure blocking for particular
client applications, such as instant messaging clients, web browsers, and Internet
phone services. You can also configure the appliance to tunnel HTTP CONNECT
requests on specific ports. With tunneling enabled, the appliance passes HTTP
traffic through specified ports without evaluating it.

Protocols and User
Agents

AsyncOS forWeb allows you to configure how the appliance handles a transaction
based on the URL category of a particular HTTP or HTTPS request. Using a
predefined category list, you can choose to block, monitor, warn, or set
quota-based or time-based filters.

You can also create custom URL categories and then choose to block, redirect,
allow, monitor, warn, or apply quota-based or time-based filters for Websites in
the custom categories. See Creating and Editing Custom URL Categories, on
page 168 for information about creating custom URL categories.

In addition, you can add exceptions to blocking of embedded or referred content.

URL Filtering

The Application Visibility and Control engine (AVC) engine is an Acceptable
Use policy component that inspects Web traffic to gain deeper understanding
and control of Web traffic used for applications. The appliance allows the Web
Proxy to be configured to block or allow applications by Application Types, and
by individual applications. You can also apply controls to particular application
behaviors, such as file transfers, within a particular application. See Managing
Access to Web Applications, on page 281 for configuration information.

Applications

These options let you configure the Web Proxy to block file downloads based
on file characteristics, such as file size, file type, and MIME type. An object is,
generally, any item that can be individually selected, uploaded, downloaded and
manipulated. See Access Policies: Blocking Objects, on page 208 for information
about specifying blocked objects.

Objects
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DescriptionOption

Web reputation filters allow for a web-based reputation score to be assigned to
a URL to determine the probability of it containing URL-based malware.
Anti-malware scanning identifies and stops web-basedmalware threats. Advanced
Malware Protection identifies malware in downloaded files.

The Anti-Malware and Reputation policy inherits global settings respective to
each component. Within Security Services > Anti-Malware and Reputation,
malware categories can be customized to monitor or block based on malware
scanning verdicts andweb reputation score thresholds can be customized.Malware
categories can be further customized within a policy. There are also global settings
for file reputation and analysis services.

For more information, see Anti-Malware and Reputation Settings in Access
Policies, on page 251 and Configuring File Reputation and Analysis Features, on
page 265.

Anti-Malware and
Reputation

Access Policies: Blocking Objects
You can use the options on the Access Policies: Objects page to block file downloads based on file
characteristics, such as file size, file type, and MIME type. An object is, generally, any item that can be
individually selected, uploaded, downloaded and manipulated.

You can specify a number of types of objects to be blocked by each individual Access policy, and by the
Global policy. These object types include Archives, Document Types, Executable Code, Web Page Content,
and so on.

Step 1 On the Access Policies page (Web Security Manager > Access Policies), click the link in the Objects column of the
row representing the policy you wish to edit.

Step 2 Choose the desired type of object blocking for this Access policy:

• Use Global Policy Objects Blocking Settings – This policy uses the object-blocking settings defined for the Global
Policy; these settings are displayed in read-only mode. Edit the settings for the Global Policy to change them.

• Define Custom Objects Blocking Settings – You can edit all object-blocking settings for this policy.

• Disable Object Blocking for this Policy – Object blocking is disabled for this policy; no object-blocking options
are presented.

Step 3 If you choseDefine Custom Objects Blocking Settings in the previous step, select and deselect object-blocking options
on the Access Policies: Objects page as needed.

You can block objects based on their download size:

• HTTP/HTTPS Max Download Size – Either provide the maximum object size for
HTTP/HTTPS download (objects larger than this will be blocked), or indicate that
there is no maximum size for object download via HTTP/HTTPS.

• FTP Max Download Size – Either provide the maximum object size for FTP
download (objects larger than this will be blocked), or indicate that there is no
maximum size for object download via FTP.

Object Size
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Block Object Type

Expand this section to select types of Archive files that are to be blocked. This list includes
Archive types such as ARC, BinHex, and StuffIt.

Archives

Expand this section to select whether to Allow, Block, or Inspect specific types of
Inspectable Archive files. Inspectable Archives are archive or compressed files that the
WSA can inflate to inspect each of the contained files in order to apply the file-type block
policy. The Inspectable Archives list includes archive types such as 7zip, Microsoft CAB,
RAR, and TAR.

The following points apply to archive inspection:

• Only archive types marked Inspect will be inflated and inspected.

• Only one archive will be inspected at a time, Additional concurrent inspectable
archives may not be inspected.

• If an inspected archive contains a file type that is assigned the Block action by the
current policy, the entire archive will be blocked, regardless of any allowed file types
it may contain.

• An inspected archive that contains an unsupported archive type will be marked as
“unscannable.” If it contains a blocked archive type, it will be blocked.

• Password-protected and encrypted archives are not supported and will be marked as
“unscannable.”

• An inspectable archive which is incomplete or corrupt is marked as “unscannable.”

• The DVS Engine Object Scanning Limits value specified for the Anti-Malware
and Reputation global settings also applies to the size of an inspectable archive; an
object exceeding this size is marked as “unscannable.” See Enabling Anti-Malware
and Reputation Filters, on page 249 for information about this object size limit.

• An inspectable archive marked as “unscannable” can be either Blocked in its entirety
or Allowed in its entirety.

• When access policies are configured to block custom MIME types, and archive
inspection is enabled:

• If the appliance directly downloads a file with the custom MIME type as part
of the content-type header, access is blocked.

• If the same file is part of a ZIP/archive file, the appliance inspects the archive
and determines theMIME type based on its ownMIME evaluation. If theMIME
evaluated by the appliance's engine does not match the configured customMIME
type, the content is not blocked.

See Archive Inspection Settings, on page 210 for information about configuring archive
inspection.

Inspectable Archives

Expand this section to select types of text documents to be blocked. This list includes
document types such as FrameMaker, Microsoft Office, and PDF.

Document Types
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Expand this section to select types of executable code to be blocked. The list includes
Java Applet, UNIX Executable and Windows Executable.

Executable Code

Types of installers to be blocked; the list includes UNIX/LINUX Packages.Installers

Types of media files to be blocked. The list includes Audio, Video and Photographic
Image Processing Formats (TIFF/PSD).

Media

This list includes BitTorrent Links (.torrent).P2P Metafiles

This list includes Flash and Images.Web Page Content

This list includes Calendar Data.Miscellaneous

You can define additional objects/files to be blocked based on MIME type.

Enter one or more MIME types in the Block Custom MIME Types field, one per line.

Custom MIME Types

Step 4 Click Submit.

Archive Inspection Settings
You can Allow, Block, or Inspect specific types of Inspectable Archives for individual Access policies.
Inspectable Archives are archive or compressed files that theWSA can inflate to inspect each of the contained
files in order to apply the file-type block policy. See Access Policies: Blocking Objects, on page 208 for more
information about configuring archive inspection for individual Access policies.

During archive inspection, nested objects are written to disk for examination. The amount of disk space that
can be occupied at any given time during file inspection is 1 GB. Any archive file exceeding this maximum
disk-use size will be marked unscannable.

Note

The WSA’s Acceptable Use Controls page provides system-wide Inspectable Archives Settings; that is, these
settings apply to archive extraction and inspection whenever enabled in an Access policy.

Step 1 Choose Security Services > Acceptable Use Controls.
Step 2 Click the Edit Archives Settings button.
Step 3 Edit the Inspectable Archives Settings as needed.

• Maximum Encapsulated Archive Extractions – Maximum number of “encapsulated” archives to be extracted
and inspected. That is, maximum depth to inspect an archive containing other inspectable archives. An encapsulated
archive is one that is contained in another archive file. This value can be zero through five; depth count begins at
one with the first nested file.

The external archive is considered file zero. If the archive has files nested beyond this maximum nested value, the
archive is marked as unscannable. Note that this will impact performance.

• Block Uninspectable Archives – If checked, the WSA will block archives it failed to inflate and inspect.
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Step 4 Submit and Commit Changes.

Block, Allow, or Redirect Transaction Requests
The web proxy controls web traffic based on the policies that you create for groups of transaction requests.

• Allow. The Web Proxy permits the connection without interruption. Allowed connections may not have
been scanned by the DVS engine.

• Block. TheWeb Proxy does not permit the connection and instead displays an end user notification page
explaining the reason for the block.

• Redirect. The Web Proxy does not allow the connection to the originally requested destination server
and instead connects to a different specified URL, see Redirecting Traffic in the Access Policies, on page
175.

The preceding actions are final actions that the Web Proxy takes on a client request. The Monitor action that
you can configure for Access Policies is not a final action.

Note

Generally, different types of policies control traffic based on the transport protocol.

Actions SupportedProtocolsPolicy Type

MonitorRedirectAllowBlockSOCKSFTPHTTPSHTTP

xxxxxxxAccess

xxxSOCKS

xxSAAS

xxxDecryption

xxxxxData Security

xxxxExternal DLP

xxxxxOutbound
Malware
Scanning

xxxxRouting

Decryption policy takes precedence over Access policy.Note

The following diagram shows how the Web Proxy determines which action to take on a request after it has
assigned a particular Access Policy to the request. The Web reputation score of the destination server is
evaluated only once, but the result is applied at two different points in the decision flow.

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
211

Create Policies to Control Internet Requests
Block, Allow, or Redirect Transaction Requests



Figure 5: Applying Access Policy Actions

Client Applications

About Client Applications
Client Applications (such as a web browser) are used to make requests. You can define policy membership
based on client applications, and you can specify control settings and exempt client applications from
authentication, which is useful for applications that cannot prompt for credentials.
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Using Client Applications in Policies

Defining Policy Membership Using Client Applications

Step 1 Choose a policy type from the Web Security Manager menu.
Step 2 Click a policy name in the policies table.
Step 3 Expand the Advanced section and click the link in the Client Applications field.
Step 4 Define one or more of the client applications:

MethodOption

Expand the Browser and Other sections and check the required client application check boxes.

Choose only the AnyVersion options when possible, as this provides better performance
than having multiple selections.

Tip

Choose a predefined
client application

Enter an appropriate regular expression in the Custom Client Applications field. Enter additional
regular expressions on new lines as required.

Click Example Client Applications Patterns for examples of regular expressions.Tip

Define a custom
client application

Step 5 (Optional) Click the Match All Except The Selected Client Applications Definitions radio button to base the policy
membership on all client applications except those you have defined.

Step 6 Click Done.

Defining Policy Control Settings Using Client Applications

Step 1 Choose a policy type from the Web Security Manager menu.
Step 2 Find the required policy name in the policies table.
Step 3 Click the cell link in the Protocols and Client Applications column on the same row.
Step 4 Choose Define Custom Settings from the drop-down list in the Edit Protocols and Client Applications Settings pane (if

not already set).
Step 5 Enter a regular expression in the Custom Client Applications field that matches the client application you wish to define.

Enter additional regular expressions on new lines as required.

Click Example Client Application Patterns for examples of regular expressions.Tip

Step 6 Submit and commit your changes.
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Exempting Client Applications from Authentication

Procedure

PurposeCommand or Action

Classifying Users and Client Software, on page 125Create an Identification Profile that does not require
authentication.

Step 1

Using Client Applications in Policies, on page 213Set the Identification Profile membership as the client
application to exempt.

Step 2

Policy Order, on page 202Place the Identification Profile above all other Identification
Profiles in the policies table that require authentication.

Step 3

Time Ranges and Quotas
You can apply time ranges and time and volume quotas to access policies and decryption policies to restrict
when a user has access, as well as their maximum connection time or data volume (also referred to as a
“bandwidth quota”).

• Time Ranges for Policies and Acceptable Use Controls, on page 214
• Time and Volume Quotas, on page 215

Time Ranges for Policies and Acceptable Use Controls
Time ranges are defined periods of time during which policies and acceptable use controls apply.

You cannot use time ranges to define the times at which users must authenticate. Authentication requirements
are defined in Identification Profiles, which do not support time ranges.

Note

• Creating a Time Range, on page 214

Creating a Time Range

Step 1 Choose Web Security Manager > Define Time Ranges and Quotas.
Step 2 Click Add Time Range.
Step 3 Enter a name for the time range.
Step 4 Choose a Time Zone option:

• Use Time Zone Setting From Appliance – Use the same time zone as the Web Security appliance.
• Specify Time Zone for this Time Range – Define a different time zone, either as a GMT Offset, or as a region,
country and a specific time zone in that country.

Step 5 Check one or more Day of Week check boxes.
Step 6 Select a Time of Day option:
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• All Day – Use the full 24-hour period.
• From and To – Define a specific range of hours: enter a start time and end time in HH:MM (24-hour format).

Each time range defines a start time and an end-time boundary. For example, entering 8:00 through 17:00
matches 8:00:00 through 16:59:59, but not 17:00:00. Midnight must be specified as 00:00 for a start time, and
as 24:00 for an end time.

Tip

Step 7 Submit and commit your changes.

Time and Volume Quotas
Quotas allow individual users to continue accessing an Internet resource (or a class of Internet resources) until
they exhaust the data volume or time limit imposed. AsyncOS enforces defined quotas on HTTP, HTTPS and
FTP traffic.

As a user approaches either their time or volume quota, AsyncOS displays first a warning, and then a block
page.

Please note the following regarding use of time and volume quotas:

• If AsyncOS is deployed in transparent mode and HTTPS proxy is disabled, there is no listening on port
443, and requests are dropped. This is standard behavior. If AsyncOS is deployed in explicit mode, you
can set quotas in your access policies.

When HTTPS proxy is enabled, possible actions on a request are pass-through, decrypt, drop, or monitor.
Overall, quotas in decryption policies are applicable only to the pass-through categories.

With pass-through, you will also have the option to set quotas for tunnel traffic. With decrypt, this option
is not available, as the quotas configured in the access policy will be applied to decrypted traffic.

• If URL Filtering is disabled or if its feature key is unavailable, AsyncOS cannot identify the category of
a URL, and the Access Policy > URL Filtering page is disabled. Thus, the feature key needs to be
present, and Acceptable Use Policies enabled, to configure quotas..

• Many websites such as Facebook and Gmail auto-update at frequent intervals. If such a website is left
open in an unused browser window or tab, it will continue to consume the user’s quota of time and
volume.

• When you restart the proxy and the high-performance mode is:

• Enabled - Time and volume quotas are not reset. Quotas are automatically reset once within the
24-hour window based on the configured time.

• Disabled - Time and volume quotas are reset. The reset impact remains only for the current 24-hour
window as the quotas are automatically reset once within 24 hours. Proxy may restart due to
configuration changes or proxy process crash.

• Your EUN pages (both warning and block) cannot be displayed for HTTPS even when decrypt-for-EUN
option is enabled.

The most restrictive quota will always apply when more than one quota applies to any given user.Note

• Volume Quota Calculations, on page 216
• Time Quota Calculations, on page 216
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• Defining Time and Volume Quotas, on page 216

Volume Quota Calculations
Calculation of volume quotas is as follows:

• HTTP and decrypted HTTPS traffic – The HTTP request and response body are counted toward quota
limits. The request headers and response headers will not be counted toward the limits.

• Tunnel traffic (including tunneled HTTPS) – AsyncOS simply shuttles the tunneled traffic from the client
to the server, and vice versa. The entire data volume of the tunnel traffic is counted toward quota limits.

• FTP – The control-connection traffic is not counted. The size of the file uploaded and downloaded is
counted toward quota limits.

Only client-side traffic is counted toward quota limits. Cached content also counts toward the limit, as client-side
traffic is generated even when a response is served from the cache.

Note

Time Quota Calculations
Calculation of time quotas is as follows:

• HTTP and decrypted HTTPS traffic – The duration of each connection to the same URL category, from
formation to disconnect, plus one minute, is counted toward the time quota limit. If multiple requests are
made to the same URL category within one minute of each other, they are counted as one continuous
session and the one minute is added only at the end of this session (that is, after at least one minute of
“silence”).

• Tunnel traffic (including tunneled HTTPS) – The actual duration of the tunnel, from formation to
disconnect, counts toward quota limits. The above calculation for multiple requests applies to tunneled
traffic as well.

• FTP – The actual duration of the FTP control session, from formation to disconnect, counts toward quota
limits. The above calculation for multiple requests applies to FTP traffic as well.

Defining Time and Volume Quotas

Before you begin

• Go to Security Services > Acceptable Use Controls to enable Acceptable Use Controls.
• Define a time range unless you want the quota to apply as a daily limit.

Step 1 Navigate to Web Security Manager > Define Time Ranges and Quotas.
Step 2 Click Add Quota.
Step 3 Enter a unique Quota Name in the field.
Step 4 To reset the quota every day, select Reset this quota daily at and enter a time in the 12-hour format in the field, then

choose AM or PM from the menu. Alternatively, select Select a predefined time range profile.
Step 5 To set a time quota, select the Time Quota check box and choose the number of hours from the hrsmenu and the number

of minutes from the mins menu, from zero (always blocked) to 23 hours and 59 minutes.
Step 6 To set a volume quota enter a number in the field and choose KB (kilobytes), MB (megabytes), or GB (gigabytes) from

the menu.
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Step 7 Click Submit and then click Commit Changes to apply your changes. Alternatively, click Cancel to abandon your
changes.

What to do next

(Optional) Navigate to Security Services > End-User Notification to configure end-user notifications for
quotas.

Access Control by URL Category
You can identify and action Web requests based on the category of Website they address. The Web Security
appliance ships with many predefined URL categories, such as Web-based Email and others.

Predefined categories, and theWebsites associated with them, are defined within filtering databases that reside
on the Web Security appliance. These databases are automatically kept up to date by Cisco. You can also
create custom URL categories for host names and IP addresses that you specify.

URL categories can be used by all policies except policies to identify requests. They can also be used by
Access, Encrypted HTTPS Management and Data Security policies to apply actions to requests.

See Creating and Editing Custom URL Categories, on page 168 for information about creating custom URL
categories.

Using URL Categories to Identify Web Requests

Before you begin

• Enable Acceptable Use Control, see Configuring the URL Filtering Engine , on page 156.
• (Optional) Create Custom URL Categories, see Creating and Editing Custom URL Categories, on page
168.

Step 1 Choose a policy type (except SaaS) from the Web Security Manager menu.
Step 2 Click a policy name in the policies table (or add a new policy).
Step 3 Expand the Advanced section and click the link in the URL Categories field.
Step 4 Click the Add column cells corresponding to URL Categories you wish to identify web requests by. Do this for the

Custom URL Categories and Predefined URL Categories lists as required.
Step 5 Click Done.
Step 6 Submit and commit your changes.

Using URL Categories to Action Web Request

Before you begin

• Enable Acceptable Use Control, see Configuring the URL Filtering Engine , on page 156.
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• (Optional) Create Custom URL Categories, see Creating and Editing Custom URL Categories, on page
168.

If you have used URL categories as criteria within a policy then those categories alone are available to specify
actions against within the same policy. Some of the options described below may differ or be unavailable
because of this.

Note

Step 1 Choose one of Access Policies, Cisco Data Security Policies, or Encrypted HTTPS Management from the Web
Security Manager menu.

Step 2 Find the required policy name in the policies table.
Step 3 Click the cell link in the URL Filtering column on the same row.
Step 4 (Optional) Add custom URL categories:

a) Click Select Custom Categories.
b) Choose which custom URL categories to include in this policy and click Apply.

Choose which custom URL categories the URL filtering engine should compare the client request against. The URL
filtering engine compares client requests against included customURL categories, and ignores excluded customURL
categories. The URL filtering engine compares the URL in a client request to included customURL categories before
predefined URL categories.

The custom URL categories included in the policy appear in the Custom URL Category Filtering section.

Step 5 Choose an action for each custom and predefined URL category.

Available actions vary between custom and predefined categories and between policy types.Note

Step 6 In the Uncategorized URLs section, choose the action to take for client requests to web sites that do not fall into a
predefined or custom URL category.

Step 7 Submit and commit your changes.

Remote Users
• About Remote Users, on page 218
• How to Configure Identification of Remote Users, on page 219
• Display Remote User Status and Statistics for ASAs, on page 220

About Remote Users
CiscoAnyConnect SecureMobility extends the network perimeter to remote endpoints, enabling the integration
of web filtering services offered by the Web Security appliance.

Remote and mobile users use the Cisco AnyConnect Secure VPN (virtual private network)client to establish
VPN sessions with the Adaptive Security Appliance (ASA). The ASA sends web traffic to the Web Security
appliance along with information identifying the user by IP address and user name. TheWeb Security appliance
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scans the traffic, enforces acceptable use policies, and protects the user from security threats. The security
appliance returns all traffic deemed safe and acceptable to the user.

When Secure Mobility is enabled, you can configure identities and policies to apply to users by their location:

• Remote users. These users are connected to the network from a remote location using VPN. The Web
Security appliance automatically identifies remote users when both the Cisco ASA and Cisco AnyConnect
client are used for VPN access. Otherwise, theWeb Security appliance administrator must specify remote
users by configuring a range of IP addresses.

• Local users. These users are connected to the network either physically or wirelessly.

When the Web Security appliance integrates with a Cisco ASA, you can configure it to identify users by an
authenticated user name transparently to achieve single sign-on for remote users.

How to Configure Identification of Remote Users
Further informationTask

Configuring Identification of Remote Users, on page 2191. Configure identification of
remote users.

Classifying Users and Client Software, on page 125

1. In the “Define Members by User Location” section, select Remote
Users Only.

2. In the “DefineMembers by Authentication” section, select “Identify
Users Transparently through Cisco ASA Integration.”

2. Create an identity for remote
users.

Creating a Policy , on page 2033. Create a policy for remote users.

Configuring Identification of Remote Users

Step 1 Security Services > AnyConnect Secure Mobility, and click Enable.
Step 2 Read the terms of the AnyConnect Secure Mobility License Agreement, and click Accept.
Step 3 Configure how to identify remote users.

Additional StepsDescriptionOption

a. Enter a range of IP addresses in the IP Range field.
b. Go to step 4

Specify a range of IP addresses that the
appliance should consider as assigned to
remote devices.

IP Address
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Additional StepsDescriptionOption

a. Enter the Cisco ASA host name or IP address.

b. Enter the port number used to access the ASA.
The default port number for the Cisco ASA is
11999.

c. If multiple Cisco ASA are configured in a cluster,
click Add Row and configure each ASA in the
cluster.

If two Cisco ASA are configured for
high availability, enter only one host
name or IP address for the activeCisco
ASA.

Note

d. Enter the access passphrase for the Cisco ASA.

The passphrase you enter here must
match the access passphrase configured
for the specified Cisco ASA.

Note

e. Optional, click Start Test to verify the Web
Security appliance can connect to the configured
Cisco ASA.

Specify one or more Cisco ASA the Web
Security appliance communicateswith. The
Cisco ASAmaintains an IP address-to-user
mapping and communicates that
information with the Web Security
appliance. When the Web Proxy receives
a transaction, it obtains the IP address and
determines the user by checking the IP
address-to-user mapping. When users are
determined by integrating with a Cisco
ASA, you can enable single sign-on for
remote users.

Cisco ASA
Integration

Step 4 Submit and Commit Changes.

Display Remote User Status and Statistics for ASAs
Use this command to display information related to Secure Mobility when the Web Security appliance is
integrated with an ASA.

DescriptionCommand

This command displays the following information:

• The status of the Web Security appliance connection with each ASA.
• The duration of the Web Security appliance connection with each ASA in minutes.
• The number of remote clients from each ASA.
• The number of remote clients being serviced, which is defined as the number of
remote clients that have passed traffic through the Web Security appliance.

• The total number of remote clients.

musstatus

Troubleshooting Policies
• Access Policy not Configurable for HTTPS, on page 484
• Some Microsoft Office Files Not Blocked, on page 472
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• Blocking DOS Executable Object Types Blocks Updates for Windows OneCare, on page 473
• Identification Profile Disappeared from Policy, on page 485
• Policy is Never Applied, on page 485
• HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require Authentication,
on page 485

• User Matches Global Policy for HTTPS and FTP over HTTP Requests, on page 486
• User Assigned Incorrect Access Policy , on page 486
• Policy Troubleshooting Tool: Policy Trace, on page 486
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C H A P T E R 12
Create Decryption Policies to Control HTTPS
Traffic

This chapter contains the following sections:

• Overview of Create Decryption Policies to Control HTTPS Traffic, on page 223
• Managing HTTPS Traffic through Decryption Policies Best Practices, on page 224
• Decryption Policies , on page 224
• Root Certificates, on page 230
• Routing HTTPS Traffic, on page 236
• Troubleshooting Decryption/HTTPS/Certificates, on page 236

OverviewofCreateDecryptionPolicies toControlHTTPSTraffic
Decryption policies define the handling of HTTPS traffic within the web proxy:

• When to decrypt HTTPS traffic.
• How to handle requests that use invalid or revoked security certificates.

You can create decryption policies to handle HTTPS traffic in the following ways:

• Pass through encrypted traffic
• Decrypt traffic and apply the content-based access policies defined for HTTP traffic. This also makes
malware scanning possible.

• Drop the HTTPS connection
• Monitor the request (take no final action) as the web proxy continues to evaluate the request against
policies that may lead to a final drop, pass through, or decrypt action.

Handle personally identifiable information with care: If you choose to decrypt an end-user’s HTTPS
session, the Web Security appliance access logs and reports may contain personally identifiable information.
The Administrator can configure how much URI text is stored in the logs using the advancedproxyconfig
CLI command and the HTTPS subcommand. You can log the entire URI, or a partial form of the URI with the
query portion removed. However, even when you choose to strip the query from the URI, personally identifiable
information may still remain.

Caution
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Managing HTTPS Traffic through Decryption Policies Task Overview
Links to Related Topics and ProceduresTask List for Managing HTTPS Traffic

through Decryption Policies
Step

Enabling the HTTPS Proxy, on page 226Enabling the HTTPS proxy1

• Uploading a Root Certificate and Key, on page 232
• Generating a Certificate and Key for the HTTPS
Proxy, on page 233

Upload or Generate a certificate and key2

Configuring Decryption Options, on page 229Configuring Decryption options3

Configuring Invalid Certificate Handling, on page 233(Optional) Configure invalid certificate
handling

5

Enabling Real-Time Revocation Status Checking, on
page 234

(Optional) Enabling real-time revocation
status checking

6

Trusted Root Certificates, on page 235(Optional) Manage trusted and blocked
certificates

7

Managing HTTPS Traffic through Decryption Policies Best
Practices

Create fewer, more general Decryption Policy groups that apply to all users or fewer, larger groups of users
on the network. Then, if you need to apply more granular control to decrypted HTTPS traffic, use more specific
Access Policy groups.

Decryption Policies
The appliance can perform any of the following actions on an HTTPS connection request:

DescriptionOption

Monitor is an intermediary action that indicates the Web Proxy should continue
evaluating the transaction against the other control settings to determine which final
action to ultimately apply.

Monitor

The appliance drops the connection and does not pass the connection request to the
server. The appliance does not notify the user that it dropped the connection.

Drop
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DescriptionOption

The appliance passes through the connection between the client and the server without
inspecting the traffic content.

However, with a standard pass-through policy, the WSA does check the validity of
the requested server by initiating an HTTPS handshake with the server. This validity
check includes server certificate validation. If the server fails the check, the transaction
is blocked.

You can skip validation checks for specific sites by configuring policies that
incorporate custom categories which include these sites, thereby indicating that these
sites are trustworthy—these sites are passed through without validity checks. Exercise
care when configuring policies that allow validity checks to be skipped.

Pass through

The appliance allows the connection, but inspects the traffic content. It decrypts the
traffic and applies Access Policies to the decrypted traffic as if it were a plaintext
HTTP connection. By decrypting the connection and applying Access Policies, you
can scan the traffic for malware.

Decrypt

All actions except Monitor are “final actions” the Web Proxy applies to a transaction. A final action is an
action that causes theWeb Proxy to stop evaluating the transaction against other control settings. For example,
if a Decryption Policy is configured to monitor invalid server certificates, the Web Proxy makes no final
decision on how to handle the HTTPS transaction if the server has an invalid certificate. If a Decryption Policy
is configured to block servers with a low Web reputation score, then any request to a server with a low
reputation score is dropped without considering the URL category actions.

The following diagram shows how the Web Proxy evaluates a client request against the Decryption Policy
groups. Figure 7: Applying Decryption Policy Actions, on page 229 shows the order theWeb Proxy uses when
evaluating control settings for Decryption Policies. Figure 5: Applying Access Policy Actions, on page 212
shows the order the Web Proxy uses when evaluating control settings for Access Policies.
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Figure 6: Policy Group Transaction Flow for Decryption Policies

Enabling the HTTPS Proxy
To monitor and decrypt HTTPS traffic, you must enable the HTTPS Proxy. When you enable the HTTPS
Proxy, you must configure what the appliance uses for a root certificate when it sends self-signed server
certificates to the client applications on the network. You can upload a root certificate and key that your
organization already has, or you can configure the appliance to generate a certificate and key with information
you enter.

Once the HTTPS Proxy is enabled, all HTTPS policy decisions are handled by Decryption Policies. Also on
this page, you can configure what the appliance does with HTTPS traffic when the server certificate is invalid.

Before you begin

When the HTTPS proxy is enabled, HTTPS-specific rules in access policies are disabled and the web proxy
processes decrypted HTTPS traffic using rules for HTTP.

Step 1 Security Services > HTTPS Proxy, click Enable and Edit Settings.
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The HTTPS Proxy License Agreement appears.

Step 2 Read the terms of the HTTPS Proxy License Agreement, and click Accept.
Step 3 Verify the Enable HTTPS Proxy field is enabled.
Step 4 In the HTTPS Ports to Proxy field, enter the ports the appliance should check for HTTPS traffic. Port 443 is the default

port.

The maximum number of ports for which the Web Security appliance can serve as proxy is 30, which includes
both HTTP and HTTPS.

Note

Step 5 Upload or generate a root/signing certificate to use for decryption.

If the appliance has both an uploaded certificate and key pair and a generated certificate and key pair, it only
uses the certificate and key pair currently selected in the Root Certificate for Signing section.

Note

Step 6 In the HTTPS Transparent Request section, select one of the following options:

• Decrypt the HTTPS request and redirect for authentication

• Deny the HTTPS request

This setting only applies to transactions that use IP address as the authentication surrogate and when the user has not yet
been authenticated.

This field only appears when the appliance is deployed in transparent mode.Note

Step 7 In the Applications that Use HTTPS section, choose whether to enable decryption for enhanced application visibility and
control.

Decryption may cause some applications to fail unless the root certificate for signing is installed on the client.
For more information on the appliance root certificate, see Managing Certificate Validation and Decryption
for HTTPS, on page 231.

Note

Step 8 Submit and commit your changes.

What to do next

Related Topics

• Managing Certificate Validation and Decryption for HTTPS, on page 231

Controlling HTTPS Traffic
After the Web Security appliance assigns an HTTPS connection request to a Decryption Policy group, the
connection request inherits the control settings of that policy group. The control settings of the Decryption
Policy group determine whether the appliance decrypts, drops, or passes through the connection:

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
227

Create Decryption Policies to Control HTTPS Traffic
Controlling HTTPS Traffic



DescriptionOption

You can configure the action to take on HTTPS requests for each predefined and
custom URL category. Click the link under the URL Filtering column for the policy
group you want to configure.

If you want to block (with end-user notification) a particular URL category
for HTTPS requests instead of drop (with no end-user notification), choose
to decrypt that URL category in the Decryption Policy group and then
choose to block the same URL category in the Access Policy group.

Note

URL Categories

You can configure the action to take on HTTPS requests based on the web reputation
score of the requested server. Click the link under the Web Reputation column for the
policy group you want to configure.

Web Reputation

You can configure the action the appliance should take when none of the other settings
apply. Click the link under the Default Action column for the policy group you want
to configure.

The configured default action only affects the transaction when no decision
is made based on URL category or Web Reputation score. If Web
Reputation filtering is disabled, the default action applies to all transactions
that match aMonitor action in a URL category. If Web Reputation filtering
is enabled, the default action is used only if the Monitor action is selected
for sites with no score.

Note

Default Action

To bypass encrypted traffic having a good web reputation score, make sure that you disable the Decrypt for
Application Detection option in the Decryption Options section of the HTTPS Proxy Settings page.

The following diagram shows how the appliance determines which action to take on an HTTPS request after
it has assigned a particular Decryption Policy to the request. The Web reputation score of the destination
server is evaluated only once, but the result is applied at two different points in the decision flow. For example,
note that a Web reputation score Drop action overrides any action specified for predefined URL categories.
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Figure 7: Applying Decryption Policy Actions

Configuring Decryption Options

Before you begin

Verify that the HTTPS proxy is enabled as described in Enabling the HTTPS Proxy, on page 226.

Step 1 Security Services > HTTPS Proxy.
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Step 2 Click Edit Settings.
Step 3 Enable the decryption options.

DescriptionDecryption Option

For users who have not been authenticated prior to this HTTPS transaction, allow
decryption for authentication.

Decrypt for Authentication

Allow decryption so that AsyncOS can display the end-user notification.

If the certificate is invalid and invalid certificates are set to drop, when running
a policy trace, the first logged action for the transaction will be “decrypt”.

Note

Decrypt for End-User
Notification

For users who have not acknowledged the web proxy prior to this HTTPS transaction,
allow decryption so that AsyncOS can display the end-user acknowledgment.

Decrypt for End-User
Acknowledgment

Enhances the ability of AsyncOS to detect HTTPS applications.Decrypt for Application
Detection

Authentication and HTTPS Connections
Authentication at the HTTPS connection layer is available for these types of requests:

DescriptionOption

• secure client authentication disabled or
• secure client authentication enabled and an IP-based surrogate

Explicit requests

• IP-based surrogate, decryption for authentication enabled or
• IP-based surrogate, client previously authenticated using an HTTP request

Transparent
requests

Root Certificates
The HTTPS proxy uses the root certificates and private key files that you upload to the appliance to decrypt
traffic. The root certificate and private key files you upload to the appliance must be in PEM format; DER
format is not supported.

You can enter root certificate information in the following ways:

• Generate. You can enter some basic organization information and then click a button so the appliance
generates the rest of the certificate and a private key.

• Upload.You can upload a certificate file and its matching private key file created outside of the appliance.
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You can also upload an intermediate certificate that has been signed by a root certificate authority. When the
Web Proxy mimics the server certificate, it sends the uploaded certificate along with the mimicked certificate
to the client application. That way, as long as the intermediate certificate is signed by a root certificate authority
that the client application trusts, the application will trust the mimicked server certificate, too. See About
Certificates and Keys, on page 449 for more information.

Note

You can choose how to handle the root certificates issued by the Web Security appliance:

• Inform users to accept the root certificate. You can inform the users in your organization what the
new policies are at the company and tell them to accept the root certificate supplied by the organization
as a trusted source.

• Add the root certificate to client machines. You can add the root certificate to all client machines on
the network as a trusted root certificate authority. This way, the client applications automatically accept
transactions with the root certificate.

Step 1 Security Services > HTTPS Proxy.
Step 2 Click Edit Settings.
Step 3 Click the Download Certificate link for either the generated or uploaded certificate.

To reduce the possibility of client machines getting a certificate error, submit the changes after you generate
or upload the root certificate to the Web Security appliance, then distribute the certificate to client machines,
and then commit the changes to the appliance.

Note

Managing Certificate Validation and Decryption for HTTPS
The Web Security appliance validates certificates before inspecting and decrypting content.

Valid Certificates
Qualities of a valid certificate:

• Not expired. The certificate’s validity period includes the current date.
• Recognized certificate authority. The issuing certificate authority is included in the list of trusted
certificate authorities stored on the Web Security appliance.

• Valid signature. The digital signature was properly implemented based on cryptographic standards.
• Consistent naming. The common name matches the hostname specified in the HTTP header.
• Not revoked. The issuing certificate authority has not revoked the certificate.

Related Topics

• Enabling Real-Time Revocation Status Checking, on page 234
• Configuring Invalid Certificate Handling, on page 233
• Options for Certificate Revocation Status Checking, on page 234
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Invalid Certificate Handling
The appliance can perform one of the following actions for invalid server certificates:

• Drop.
• Decrypt.
• Monitor.

Certificates that are Invalid for Multiple Reasons

For server certificates that are invalid due to both an unrecognized root authority and an expired certificate,
the HTTPS proxy performs the action that applies to unrecognized root authorities.

In all other cases, for server certificates that are invalid for multiple reasons simultaneously, the HTTPS Proxy
performs actions in order from the most restrictive action to the least restrictive action.

Untrusted Certificate Warnings for Decrypted Connections

When theWeb Security appliance encounters an invalid certificate and is configured to decrypt the connection,
AsyncOS creates an untrusted certificate that requires the end-user to accept or reject the connection. The
common name of the certificate is “Untrusted Certificate Warning.”

Adding this untrusted certificate to the list of trusted certificates will remove the end user’s option to accept
or reject the connection.

When AsyncOS generates one of these certificates, it creates a proxy log entry with the text “Signing untrusted
key” or “Signing untrusted cert”.

Uploading a Root Certificate and Key

Before you begin

Enable the HTTPS Proxy. Enabling the HTTPS Proxy, on page 226.

Step 1 Security Services > HTTPS Proxy.
Step 2 Click Edit Settings.
Step 3 Select Use Uploaded Certificate and Key.
Step 4 Click Browse for the Certificate field to navigate to the certificate file stored on the local machine.

If the file you upload contains multiple certificates or keys, the Web Proxy uses the first certificate or key in the file.

Step 5 Click Browse for the Key field to navigate to the private key file.

The key length must be 512, 1024, or 2048 bits.Note

Step 6 Select Key is Encrypted if the key is encrypted.
Step 7 Click Upload Files to transfer the certificate and key files to the Web Security appliance.

The uploaded certificate information is displayed on the Edit HTTPS Proxy Settings page.

Step 8 (Optional) Click Download Certificate so you can transfer it to the client applications on the network.
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Generating a Certificate and Key for the HTTPS Proxy

Before you begin

Enable the HTTPS Proxy. Enabling the HTTPS Proxy, on page 226.

Step 1 Security Services > HTTPS Proxy.
Step 2 Click Edit Settings.
Step 3 Select Use Generated Certificate and Key.
Step 4 Click Generate New Certificate and Key.
Step 5 In the Generate Certificate and Key dialog box, enter the information to display in the root certificate.

You can enter any ASCII character except the forward slash ( / ) in the Common Name field.

Step 6 Click Generate.
Step 7 The generated certificate information is displayed on the Edit HTTPS Proxy Settings page.
Step 8 (Optional) Click Download Certificate so you can transfer it to the client applications on the network.
Step 9 (Optional) Click the Download Certificate Signing Request link. so you can submit the Certificate Signing Request

(CSR) to a certificate authority (CA).
Step 10 (Optional) Upload the signed certificate to the Web Security appliance after receiving it back from the CA. You can

do this at anytime after generating the certificate on the appliance.
Step 11 Submit and Commit Changes.

Configuring Invalid Certificate Handling

Before you begin

Verify that the HTTPS proxy is enabled as described in Enabling the HTTPS Proxy, on page 226.

Step 1 Security Services > HTTPS Proxy.
Step 2 Click Edit Settings.
Step 3 For each type of certificate error, define the proxy response: Drop, Decrypt, or Monitor.

DescriptionCertificate Error Type

The current date falls outside of the range of validity for the certificate.Expired

The hostname in the certificate does not match the hostname the client was trying to
access.

The Web Proxy can only perform hostname match when it is deployed in
explicit forward mode. When it is deployed in transparent mode, it does not
know the hostname of the destination server (it only knows the IP address), so
it cannot compare it to the hostname in the server certificate.

Note

Mismatched hostname
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DescriptionCertificate Error Type

Either the root authority or an intermediate certificate authority is unrecognized.Unrecognized root
authority/issuer

There was a problem with the signing certificate.Invalid signing certificate

There was a problem with the leaf certificate, for example, a rejection, decoding, or
mismatch problem.

Invalid leaf certificate

Most other error types are due to the appliance not being able to complete the SSL
handshake with the HTTPS server. For more information about additional error scenarios
for server certificates, see http://www.openssl.org/docs/apps/verify.html.

All other error types

Step 4 Submit and Commit Changes.

Options for Certificate Revocation Status Checking
To determine whether the issuing certificate authority has revoked a certificate, the Web Security appliance
can check with the issuing certificate authority in these ways:

• Certificate Revocation List (Comodo certificates only). TheWeb Security appliance checks Comodo’s
certificate revocation list. Comodo maintains this list, updating it according to their own policies.
Depending on when it was last updated, the certificate revocation list may be out of date at the time the
Web Security appliance checks it.

• Online Certificate Status Protocol (OCSP). The Web Security appliance checks the revocation status
with the issuing certificate authority in real time. If the issuing certificate authority supports OCSP, the
certificate will include a URL for real-time status checking. This feature is enabled by default for fresh
installations and disabled by default for updates.

The Web Security appliance only performs the OCSP query for certificates that it determines to be valid in
all other respects and that include the OCSP URL.

Note

Related Topics

• Enabling Real-Time Revocation Status Checking, on page 234
• Configuring Invalid Certificate Handling, on page 233

Enabling Real-Time Revocation Status Checking

Before you begin

Ensure the HTTPS Proxy is enabled. See Enabling the HTTPS Proxy, on page 226.

Step 1 Security Services > HTTPS Proxy.
Step 2 Click Edit Settings.
Step 3 Select Enable Online Certificate Status Protocol (OCSP).
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Step 4 Configure the OCSP Result Handling properties,

Cisco recommends configuring the OCSP Result Handling options to the same actions as Invalid Certificate Handling
options. For example, if you set Expired Certificate to Monitor, configure Revoked Certificate to monitor.

Step 5 (Optional) Expand the Advanced configuration section and configure the settings described below.

DescriptionField Name

Time to wait before rechecking a valid OCSP response in seconds (s), minutes (m), hours
(h), or days (d). Default unit is seconds. Valid range is from 1 second to 7 days.

OCSP Valid Response
Cache Timeout

Time to wait before rechecking an invalid OCSP response in seconds (s), minutes (m), hours
(h), or days (d). Default unit is seconds. Valid range is from 1 second to 7 days.

OCSP Invalid Response
Cache Timeout

Time to wait before attempting to contact the OCSP responder again after failing to get a
response in seconds (s), minutes (m), hours (h), or days (d). Valid range from 1 second to
24 hours.

OCSP Network Error
Cache Timeout

Maximum allowed difference in time settings between the Web Security appliance and the
OCSP responder in seconds (s) or minutes (m). Valid range from 1 second to 60 minutes.

Allowed Clock Skew

Maximum time to wait for a response from the OCSP responder. Valid range is from 1
second to 10minutes. Specify a shorter duration to reduce delays in end user access to HTTPS
requests in the event that the OCSP responder is unavailable.

Maximum Time to Wait
for OCSP Response

Group Name of the upstream proxies.Use upstream proxy for
OCSP checking

IP addresses or hostnames of the servers to exempt. May be left blank.Servers exempt from
upstream proxy

Step 6 Submit and Commit Changes.

Trusted Root Certificates
The Web Security appliance ships with and maintains a list of trusted root certificates. Web sites with trusted
certificates do not require decryption.

You can manage the trusted certificate list, adding certificates to it and functionally removing certificates
from it. While the Web Security appliance does not delete certificates from the primary list, it allows you to
override trust in a certificate, which functionally removes the certificate from the trusted list.

Adding Certificates to the Trusted List

Before you begin

Verify that the HTTPS Proxy is enabled. See Enabling the HTTPS Proxy, on page 226.

Step 1 Security Services > HTTPS Proxy.
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Step 2 Click Manage Trusted Root Certificates.

Step 3 Click Import.
Step 4 Click Browse and navigate to the certificate file.
Step 5 Submit and Commit Changes.

Look for the certificate you uploaded in the Custom Trusted Root Certificates list.

Removing Certificates from the Trusted List

Step 1 Select Security Services > HTTPS Proxy.
Step 2 Click Manage Trusted Root Certificates.

Step 3 Select the Override Trust checkbox corresponding to the certificate you wish to remove from the list.
Step 4 Submit and Commit Changes.

Routing HTTPS Traffic
The ability of AsyncOS to route HTTPS transactions based on information stored in client headers is limited
and is different for transparent and explicit HTTPS.

DescriptionOption

In the case of transparent HTTPS, AsyncOS does not have access to information in the
client headers. Therefore, AsyncOS cannot enforce routing policies if any routing policy
or identification profile relies on the information in client headers.

Transparent
HTTPS

In the case of explicit HTTPS, AsyncOS has access to the following information in client
headers:

• URL

• Destination port number

Therefore, for explicit HTTPS transactions, it is possible to match a routing policy based
on URL or port number.

Explicit HTTPS

Troubleshooting Decryption/HTTPS/Certificates
• Accessing HTTPS Sites Using Routing Policies with URL Category Criteria, on page 477
• HTTPS with IP-based Surrogates and Transparent Requests, on page 477
• Bypassing Decryption for Particular Websites, on page 478
• Alert: Problem with Security Certificate, on page 478
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C H A P T E R 13
Scan Outbound Traffic for Existing Infections

This chapter contains the following sections:

• Overview of Scanning Outbound Traffic, on page 237
• Understanding Upload Requests, on page 238
• Creating Outbound Malware Scanning Policies, on page 239
• Controlling Upload Requests , on page 240
• Logging of DVS Scanning, on page 241

Overview of Scanning Outbound Traffic
To prevent malicious data from leaving the network, the Web Security appliance provides the Outbound
Malware Scanning feature. Using policy groups, you can define which uploads are scanned for malware,
which anti-malware scanning engines to use for scanning, and which malware types to block.

The Cisco Dynamic Vectoring and Streaming (DVS) engine scans transaction requests as they leave the
network. By working with the Cisco DVS engine, the Web Security appliance enables you to prevent users
from unintentionally uploading malicious data.

You can perform the following tasks:

Link to TaskTask

Creating Outbound Malware Scanning Policies, on page 239Create policies to block malware

Controlling Upload Requests , on page 240Assign upload requests to outbound
malware policy groups

User Experience When Requests Are Blocked by the DVS Engine
When the Cisco DVS engine blocks an upload request, the Web Proxy sends a block page to the end user.
However, not all Websites display the block page to the end user. Some Web 2.0 Websites display dynamic
content using Javascript instead of a static Webpage and are not likely to display the block page. Users are
still properly blocked from uploading malicious data, but they may not always be informed of this by the
Website.
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Understanding Upload Requests
Outbound Malware Scanning Policies define whether or not the Web Proxy blocks HTTP requests and
decrypted HTTPS connections for transactions that upload data to a server (upload requests). An upload
request is an HTTP or decrypted HTTPS request that has content in the request body.

When the Web Proxy receives an upload request, it compares the request to the Outbound Malware Scanning
policy groups to determine which policy group to apply. After it assigns the request to a policy group, it
compares the request to the policy group’s configured control settings to determine whether to block the
request or monitor the request. When an OutboundMalware Scanning Policy determines to monitor a request,
it is evaluated against the Access Policies, and the final action theWeb Proxy takes on the request is determined
by the applicable Access Policy.

Upload requests that try to upload files with a size of zero (0) bytes are not evaluated against Outbound
Malware Scanning Policies.

Note

Criteria for Group Membership
Each client request is assigned to an Identity and is then evaluated against the other policy types to determine
to which policy group it belongs for each type. The Web Proxy applies the configured policy control settings
to a client request based on the request’s policy group membership.

The Web Proxy follows a specific process for matching the group membership criteria. It considers the
following factors for group membership:

DescriptionCriteria

Each client request either matches an Identification Profile, fails authentication
and is granted guest access, or fails authentication and is terminated.

Identification Profile

If the assigned Identification Profile requires authentication, the user must be in
the list of authorized users in the Outbound Malware Scanning Policy group to
match the policy group. The list of authorized users can be any of the specified
groups or users or can be guest users if the Identification Profile allows guest
access.

Authorized users

You can configure several advanced options for Outbound Malware Scanning
Policy group membership. Some options, such as proxy port and URL category,
can also be defined within the Identification Profile. When an advanced option
is configured in the Identification Profile, it is not configurable in the Outbound
Malware Scanning Policy group level.

Advanced options

Matching Client Requests to Outbound Malware Scanning Policy Groups
The Web Proxy compares the upload request status to the membership criteria of the first policy group. If
they match, the Web Proxy applies the policy settings of that policy group.
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If they do not match, the Web Proxy compares the upload request to the next policy group. It continues this
process until it matches the upload request to a user defined policy group. If it does not match a user defined
policy group, it matches the global policy group. When the Web Proxy matches the upload request to a policy
group or the global policy group, it applies the policy settings of that policy group.

Creating Outbound Malware Scanning Policies
You can create Outbound Malware Scanning Policy groups based on combinations of several criteria, such
as one or more Identities or the URL category of the destination site. You must define at least one criterion
for policy group membership. When you define multiple criteria, the upload request must meet all criteria to
match the policy group. However, the upload request needs to match only one of the configured Identities.

Step 1 Choose Web Security Manager > Outbound Malware Scanning.
Step 2 Click Add Policy.
Step 3 Enter a name and an optional description for the policy group.

Each policy group name must be unique and only contain alphanumeric characters or the space character.Note

Step 4 In the Insert Above Policy field, select where in the policies table to place the policy group.

When configuring multiple policy groups, you must specify a logical order for each group.

Step 5 In the Identification Profiles and Users section, select one or more Identity groups to apply to this policy group.
Step 6 (Optional) Expand the Advanced section to define additional membership requirements.
Step 7 To define policy groupmembership by any of the advanced options, click the link for the advanced option and configure

the option on the page that appears.

DescriptionAdvanced Option

Choose whether or not to define policy group membership by the protocol used in the client
request. Select the protocols to include.

“All others” means any protocol not listed above this option.

When the HTTPS Proxy is enabled, only Decryption Policies apply to HTTPS
transactions. You cannot define policy membership by the HTTPS protocol for
Access, Routing, Outbound Malware Scanning, Data Security, or External DLP
Policies.

Note

Protocols

Choose whether or not to define policy group membership by the proxy port used to access
the Web Proxy. Enter one or more port numbers in the Proxy Ports field. Separate multiple
ports with commas.

For explicit forward connections, this is the port configured in the browser. For transparent
connections, this is the same as the destination port.

If you define policy groupmembership by the proxy port when client requests are transparently
redirected to the appliance, some requests might be denied.

If the Identity associated with this policy group defines Identity membership by this
advanced setting, the setting is not configurable at the non-Identity policy group
level.

Note

Proxy Ports
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DescriptionAdvanced Option

Choose whether or not to define policy group membership by subnet or other addresses.

You can select to use the addresses that may be defined with the associated Identity, or you
can enter specific addresses here.

If the Identity associated with this policy group defines its membership by addresses,
then in this policy group you must enter addresses that are a subset of the addresses
defined in the Identity. Adding addresses in the policy group further narrows down
the list of transactions that match this policy group.

Note

Subnets

Choose whether or not to define policy group membership by URL categories. Select the user
defined or predefined URL categories.

If the Identity associated with this policy group defines Identity membership by this
advanced setting, the setting is not configurable at the non-Identity policy group
level.

Note

URL Categories

Choose whether to define policy groupmembership by the user agents (client applications such
as updaters and Web browsers) used in the client request. You can select some commonly
defined user agents, or define your own using regular expressions. Specify whether membership
definition includes only the selected user agents, or specifically excludes the selected user
agents.

If the Identification Profile associated with this policy group defines Identification
Profile membership by this advanced setting, the setting is not configurable at the
non-Identification Profile policy group level.

Note

User Agents

Choose whether or not to define policy group membership by user location, either remote or
local.

User Location

Step 8 Submit your changes.
Step 9 Configure OutboundMalware Scanning Policy group control settings to define how theWeb Proxy handles transactions.

The new Outbound Malware Scanning Policy group automatically inherits global policy group settings until you
configure options for each control setting.

Step 10 Submit and Commit Changes.

Controlling Upload Requests
Each upload request is assigned to an Outbound Malware Scanning Policy group and inherits the control
settings of that policy group. After the Web Proxy receives the upload request headers, it has the information
necessary to decide if it should scan the request body. The DVS engine scans the request and returns a verdict
to the Web Proxy. The block page appears to the end user, if applicable.

Step 1 Choose Web Security Manager > Outbound Malware Scanning.
Step 2 In the Destinations column, click the link for the policy group you want to configure.
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Step 3 In the Edit Destination Settings section, select Define Destinations Scanning Custom Settings from the drop-down
menu.

Step 4 In the Destinations to Scan section, select one of the following:

DescriptionOption

The DVS engine scans no upload requests. All upload requests are evaluated against
the Access Policies

Do not scan any uploads

The DVS engine scans all upload requests. The upload request is blocked or evaluated
against the Access Policies, depending on the DVS engine scanning verdict

Scan all uploads

The DVS engine scans upload requests that belong in specific custom URL categories.
The upload request is blocked or evaluated against the Access Policies, depending on
the DVS engine scanning verdict.

Click Edit custom categories list to select the URL categories to scan

Scan uploads to specified
custom URL categories

Step 5 Submit your changes.
Step 6 In the Anti-Malware Filtering column, click the link for the policy group.
Step 7 In the Anti-Malware Settings section, select Define Anti-Malware Custom Settings.
Step 8 In theCisco DVS Anti-Malware Settings section, select which anti-malware scanning engines to enable for this policy

group.
Step 9 In the Malware Categories section, select whether to monitor or block the various malware categories.

The categories listed in this section depend on which scanning engines you enable.

URL transactions are categorized as unscannable when the configured maximum time setting is reached or
when the system experiences a transient error condition. For example, transactions might be categorized as
unscannable during scanning engine updates or AsyncOS upgrades. The malware scanning verdicts
SV_TIMEOUT and SV_ERROR are considered unscannable transactions.

Note

Step 10 Submit and Commit Changes.

Logging of DVS Scanning
The access logs indicate whether or not the DVS engine scanned an upload request for malware. The scanning
verdict information section of each access log entry includes values for the DVS engine activity for scanned
uploads. You can also add one of the fields to the W3C or access logs to more easily find this DVS engine
activity:

Table 3: Log Fields in W3C Logs and Format Specifiers in Access Logs

Format Specifier in Access LogsW3C Log Field

%X2x-req-dvs-scanverdict

%X4x-req-dvs-threat-name

%X3x-req-dvs-verdictname
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When the DVS engine marks an upload request as being malware and it is configured to block malware
uploads, the ACL decision tag in the access logs is BLOCK_AMW_REQ.

However, when the DVS engine marks an upload request as being malware and it is configured to monitor
malware uploads, the ACL decision tag in the access logs is actually determined by the Access Policy applied
to the transaction.

To determine whether or not the DVS engine scanned an upload request for malware, view the results of the
DVS engine activity in the scanning verdict information section of each access log entry.
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C H A P T E R 14
Configuring Security Services

This chapter contains the following sections:

• Overview of Configuring Security Services , on page 243
• Overview of Web Reputation Filters , on page 244
• Overview of Anti-Malware Scanning , on page 246
• Understanding Adaptive Scanning, on page 248
• Enabling Anti-Malware and Reputation Filters, on page 249
• Configuring Anti-Malware and Reputation in Policies, on page 251
• Integrating the Appliance with AMP for Endpoints Console, on page 255
• Maintaining the Database Tables, on page 257
• Logging of Web Reputation Filtering Activity and DVS Scanning , on page 257
• Caching, on page 258
• Malware Category Descriptions, on page 258

Overview of Configuring Security Services
The Web Security appliance uses security components to protect end users from a range of malware threats.
You can configure anti-malware and web reputation settings for each policy group. When you configure
Access Policies, you can also have AsyncOS for Web choose a combination of anti-malware scanning and
web reputation scoring to use when determining what content to block.

To protect end users frommalware, you enable these features on the appliance, and then configure anti-malware
and web reputation settings per policy.

LinkDescriptionOption

Overview of Anti-Malware Scanning ,
on page 246

Works with multiple anti-malware
scanning engines integrated on the
appliance to block malware threats

Anti-malware scanning

Overview of Web Reputation Filters ,
on page 244

Analyzes web server behavior and
determines whether the URL contains
URL-based malware

Web Reputation Filters

Overview of File Reputation Filtering
and File Analysis , on page 261

Protects from threats in downloaded
files by evaluating file reputation and
by analyzing file characteristics.

Advanced Malware
Protection
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Related Topics

• Enabling Anti-Malware and Reputation Filters, on page 249
• Understanding Adaptive Scanning, on page 248

Overview of Web Reputation Filters
Web Reputation Filters assigns a web-based reputation score (WBRS) to a URL to determine the likelihood
that it contains URL-based malware. The Web Security appliance uses web reputation scores to identify and
stop malware attacks before they occur. You can use Web Reputation Filters with Access, Decryption, and
Cisco Data Security Policies.

Web Reputation Scores
Web Reputation Filters use data to assess the reliability of Internet domains and score the reputation of URLs.
The web reputation calculation associates a URL with network parameters to determine the probability that
malware exists. The aggregate probability that malware exists is then mapped to a Web Reputation Score
between -10 and +10, with +10 being the least likely to contain malware.

Example parameters include the following:

• URL categorization data
• Presence of downloadable code
• Presence of long, obfuscated End-User License Agreements (EULAs)
• Global volume and changes in volume
• Network owner information
• History of a URL
• Age of a URL
• Presence on any block lists
• Presence on any allow lists
• URL typos of popular domains
• Domain registrar information
• IP address information

Cisco does not collect identifiable information such as user names, passphrases, or client IP addresses.Note

Understanding How Web Reputation Filtering Works
Web Reputation Scores are associated with an action to take on a URL request. You can configure each policy
group to correlate an action to a particular Web Reputation Score. The available actions depend on the policy
group type that is assigned to the URL request:

ActionPolicy Type

You can choose to block, scan, or allowAccess Policies

You can choose to drop, decrypt, or pass throughDecryption Policies
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ActionPolicy Type

You can choose to block or monitorCisco Data Security Policies

Web Reputation in Access Policies
When you configure web reputation settings in Access Policies, you can choose to configure the settings
manually, or let AsyncOS forWeb choose the best options using Adaptive Scanning.When Adaptive Scanning
is enabled, you can enable or disable web reputation filtering in each Access Policy, but you cannot edit the
Web Reputation Scores.

ExampleDescriptionActionScore

• URL downloads information without
user permission.

• Sudden spike in URL volume.
• URL is a typo of a popular domain.

Bad site. The request is blocked, and
no further malware scanning occurs.

Block-10 to -6.0

• Recently created URL that has a
dynamic IP address and contains
downloadable content.

• Network owner IP address that has a
positive Web Reputation Score.

Undetermined site. Request is passed
to the DVS engine for further
malware scanning. The DVS engine
scans the request and server response
content.

Scan-5.9 to 5.9

• URL contains no downloadable
content.

• Reputable, high-volume domain with
long history.

• Domain present on several allow lists.
• No links to URLs with poor
reputations.

Good site. Request is allowed. No
malware scanning required.

Allow6.0 to 10.0

By default, URLs in an HTTP request that are assigned aWeb Reputation Score of +7 are allowed and require
no further scanning. However, a weaker score for an HTTP request, such as +3, is automatically forwarded
to the Cisco DVS engine where it is scanned for malware. Any URL in an HTTP request that has a poor
reputation is blocked.

Related Topics

• Understanding Adaptive Scanning, on page 248

Web Reputation in Decryption Policies

DescriptionActionScore

Bad site. The request is dropped with no notice sent to the end
user. Use this setting with caution.

Drop-10 to -9.0

Undetermined site. Request is allowed, but the connection is
decrypted and Access Policies are applied to the decrypted traffic.

Decrypt-8.9 to 5.9
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DescriptionActionScore

Good site. Request is passed through with no inspection or
decryption.

Pass through6.0 to 10.0

Web Reputation in Cisco Data Security Policies

DescriptionActionScore

Bad site. The transaction is blocked, and no further scanning
occurs.

Block-10 to -6.0

The transaction will not be blocked based onWeb Reputation, and
will proceed to content checks (file type and size).

Sites with no score are monitored.Note

Monitor-5.9 to 0.0

Overview of Anti-Malware Scanning
The Web Security appliance anti-malware feature uses the Cisco DVS™ engine in combination with
anti-malware scanning engines to stop web-basedmalware threats. The DVS engine works with theWebroot™,
McAfee, and Sophos anti-malware scanning engines.

The scanning engines inspect transactions to determine a malware scanning verdict to pass to the DVS engine.
The DVS engine determines whether to monitor or block the request based on the malware scanning verdicts.
To use the anti-malware component of the appliance, you must enable anti-malware scanning and configure
global settings, and then apply specific settings to different policies.

Related Topics

• Enabling Anti-Malware and Reputation Filters, on page 249
• Understanding Adaptive Scanning, on page 248
• McAfee Scanning, on page 247

Understanding How the DVS Engine Works
The DVS engine performs anti-malware scanning on URL transactions that are forwarded from the Web
Reputation Filters. Web Reputation Filters calculate the probability that a particular URL contains malware,
and assign a URL score that is associated with an action to block, scan, or allow the transaction.

When the assigned web reputation score indicates to scan the transaction, the DVS engine receives the URL
request and server response content. The DVS engine, in combination with the Webroot and/or Sophos or
McAfee scanning engines, returns a malware scanning verdict. The DVS engine uses information from the
malware scanning verdicts and Access Policy settings to determine whether to block or deliver the content to
the client.

Working with Multiple Malware Verdicts
The DVS engine might determine multiple malware verdicts for a single URL. Multiple verdicts can come
from one or both enabled scanning engines:
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• Different verdicts from different scanning engines.When you enable bothWebroot and either Sophos
or McAfee, each scanning engine might return different malware verdicts for the same object. When a
URL causes multiple verdicts from both enabled scanning engines, the appliance performs the most
restrictive action. For example, if one scanning engine returns a block verdict and the other a monitor
verdict, the DVS engine always blocks the request.

• Different verdicts from the same scanning engine. A scanning engine might return multiple verdicts
for a single object when the object contains multiple infections. When a URL causes multiple verdicts
from the same scanning engine, the appliance takes action according to the verdict with the highest
priority. The following text lists the possible malware scanning verdicts from the highest to the lowest
priority.

• Virus
• Trojan Downloader
• Trojan Horse
• Trojan Phisher
• Hijacker
• System monitor
• Commercial System Monitor
• Dialer
• Worm
• Browser Helper Object
• Phishing URL
• Adware
• Encrypted file
• Unscannable
• Other Malware

Webroot Scanning
The Webroot scanning engine inspects objects to determine the malware scanning verdict to send to the DVS
engine. The Webroot scanning engine inspects the following objects:

• URL request.Webroot evaluates a URL request to determine if the URL is a malware suspect. IfWebroot
suspects the response from this URLmight contain malware, the appliance monitors or blocks the request,
depending on how the appliance is configured. If Webroot evaluation clears the request, the appliance
retrieves the URL and scans the server response.

• Server response. When the appliance retrieves a URL, Webroot scans the server response content and
compares it to the Webroot signature database.

McAfee Scanning
The McAfee scanning engine inspects objects downloaded from a web server in HTTP responses. After
inspecting the object, it passes a malware scanning verdict to the DVS engine so the DVS engine can determine
whether to monitor or block the request.

The McAfee scanning engine uses the following methods to determine the malware scanning verdict:

• Matching virus signature patterns
• Heuristic analysis
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Matching Virus Signature Patterns
McAfee uses virus definitions in its database with the scanning engine to detect particular viruses, types of
viruses, or other potentially unwanted software. It searches for virus signatures in files. When you enable
McAfee, the McAfee scanning engine uses this method to scan server response content.

Heuristic Analysis
Heuristic analysis is a technique that uses general rules, rather than specific rules, to detect new viruses and
malware. When the McAfee scanning engine uses heuristic analysis, it looks at the code of an object, applies
generic rules, and determines how likely the object is to be virus-like.

Using heuristic analysis increases the possibility of reporting false positives (clean content designated as a
virus) and might impact appliance performance.When you enable McAfee, you can choose whether or not to
also enable heuristic analysis when scanning objects.

McAfee Categories

Malware Scanning Verdict CategoryMcAfee Verdict

VirusKnown Virus

Trojan HorseTrojan

AdwareJoke File

VirusTest File

VirusWannabe

VirusKilled

Commercial System MonitorCommercial Application

AdwarePotentially Unwanted Object

AdwarePotentially Unwanted Software Package

Encrypted FileEncrypted File

Sophos Scanning
The Sophos scanning engine inspects objects downloaded from a web server in HTTP responses. After
inspecting the object, it passes a malware scanning verdict to the DVS engine so the DVS engine can determine
whether to monitor or block the request. You might want to enable the Sophos scanning engine instead of the
McAfee scanning engine if McAfee anti-malware software is installed.

Understanding Adaptive Scanning
Adaptive Scanning decides which anti-malware scanning engine (including Advanced Malware Protection
scanning for downloaded files) will process the web request.
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Adaptive Scanning applies the ‘Outbreak Heuristics’ anti-malware category to transactions it identifies as
malware prior to running any scanning engines. You can choose whether or not to block these transactions
when you configure anti-malware settings on the appliance.

Adaptive Scanning and Access Policies
When Adaptive Scanning is enabled, some anti-malware and reputation settings that you can configure in
Access Policies are slightly different:

• You can enable or disable web reputation filtering in each Access Policy, but you cannot edit the Web
Reputation Scores.

• You can enable anti-malware scanning in each Access Policy, but you cannot choose which anti-malware
scanning engine to enable. Adaptive Scanning chooses the most appropriate engine for each web request.

If Adaptive Scanning is not enabled and an Access Policy has particular web reputation and anti-malware
settings configured, and then Adaptive Scanning is enabled, any existing web reputation and anti-malware
settings are overridden.

Note

Per-policy Advanced Malware Protection settings are the same whether or not Adaptive Scanning is enabled.

Enabling Anti-Malware and Reputation Filters
Before you begin

Check the Web Reputation Filters, DVS engine, and the Webroot, McAfee, and Sophos scanning engines are
enabled. By default these should be enabled during system setup.

Step 1 Choose Security Services > Anti-Malware and Reputation.
Step 2 Click Edit Global Settings.
Step 3 Configure settings as necessary.

DescriptionSetting

Choose whether or not to enable Web Reputation Filtering.Web Reputation Filtering

Choosewhether or not to enable Adaptive Scanning. You can only enable Adaptive Scanning
when Web Reputation Filtering is enabled.

Adaptive Scanning

See Enabling and Configuring File Reputation and Analysis Services , on page 268.File Reputation Filtering
and File Analysis

Click Register the Appliance with AMP for Endpoints to integrate your appliance with
AMP for Endpoints console. For detailed instructions, see Integrating the Appliance with
AMP for Endpoints Console, on page 255.

AMP for Endpoints
Console Integration
(Advanced > Advanced
Settings for File
Reputation)
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DescriptionSetting

Specify a maximum object size for scanning.

The Maximum Object Size value you specify applies to the entire size of requests and
responses that might be scanned by all anti-malware and anti-virus scanning engines and
by Advanced Malware Protection features. It also specifies the maximum size of an
inspectable archive for Archive inspection; see Access Policies: Blocking Objects, on page
208 for more about Archive inspection.

When an upload or download size exceeds this size, the security component may abort the
scan in progress and may not provide a scanning verdict to theWeb Proxy. If an inspectable
archive exceeds this size, it is marked “Not Scanned.”

DVS Engine Object
Scanning Limits

Choose whether or not to enable the Sophos scanning engine.Sophos

Choose whether or not to enable the McAfee scanning engine.

When you enable the McAfee scanning engine, you can choose whether or not to enable
heuristic scanning.

Heuristic analysis increases security protection, but can result in false positives
and decreased performance.

Note

McAfee

Choose whether or not to enable the Webroot scanning engine.

When you enable theWebroot scanning engine, you can configure the Threat Risk Threshold
(TRT). The TRT assigns a numerical value to the probability that malware exists.

Proprietary algorithms evaluate the result of a URLmatching sequence and assign a Threat
Risk Rating (TRR). This value is associated with the threat risk threshold setting. If the
TRR value is greater than or equal to the TRT, the URL is considered malware and is passed
on for further processing.

Setting the Threat Risk Threshold to a value lower than 90 dramatically increases
the rate of URL blocking and denies legitimate requests. Cisco strongly
recommends maintaining the TRT default value of 90. The minimum value for
a TRT setting is 51.

Note

Webroot

Step 4 Submit and Commit Changes.

What to do next

• Understanding Adaptive Scanning, on page 248
• McAfee Scanning, on page 247

Clearing the Advanced Malware Protection Services Cache
AMP clear cache functionality clears file reputation dispositions for clean, malicious, and unknown files.
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AMP cache is used to increase performance. By usingClear Cache command, you might observe a temporary
performance degradation while the cache is repopulated.

Note

Step 1 Choose Security Services > Anti-Malware and Reputation.
Step 2 In the Advanced Malware Protection Services section, click Clear Cache and confirm your action.

Configuring Anti-Malware and Reputation in Policies
When Anti-Malware and Reputation Filters are enabled on the appliance, you can configure different settings
in policy groups. You can enable monitoring or blocking for malware categories based on malware scanning
verdicts.

You can configure anti-malware settings in the following policy groups:

Link to TaskPolicy Type

Anti-Malware and Reputation Settings in Access Policies, on
page 251

Access Policies

Controlling Upload Requests Using Outbound Malware
Scanning Policies

Outbound Malware Scanning Policies

You can configure web reputation settings in the following policy groups:

Link to TaskPolicy Type

Anti-Malware and Reputation Settings in Access Policies, on
page 251

Access Policies

Configuring Web Reputation Filter Settings for Decryption
Policy Groups, on page 254

Decryption Policies

Configuring Web Reputation Filter Settings for Decryption
Policy Groups, on page 254

Cisco Data Security Policies

You can configure Advanced Malware Protection settings only in Access Policies. See Configuring File
Reputation and Analysis Features, on page 265

Anti-Malware and Reputation Settings in Access Policies
When Adaptive Scanning is enabled, the web reputation and anti-malware settings you can configure for
Access Policies are slightly different than when Adaptive Scanning is turned off.
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If your deployment includes a Security Management appliance, and you are configuring this feature in a
Primary Configuration, options on this page depend on whether Adaptive Security is enabled for the relevant
primary configuration. Check the setting on the Security Management appliance, on the Web > Utilities >
Security Services Display page.

Note

• Understanding Adaptive Scanning, on page 248

Configuring Anti-Malware and Reputation Settings with Adaptive Scanning Enabled

Step 1 Choose Web Security Manager > Access Policies.
Step 2 Click the Anti-Malware and Reputation link for the Access Policy you want to configure.
Step 3 Under the Web Reputation and Anti-Malware Settings section, choose Define Web Reputation and Anti-Malware

Custom Settings.

This allows you to configure web reputation and anti-malware settings for this Access Policy that differ from the global
policy.

Step 4 In the Web Reputation Settings section, choose whether or not to enable Web Reputation Filtering. Adaptive Scanning
chooses the most appropriate web reputation score thresholds for each web request.

Step 5 Configure the settings in the Advanced Malware Protection Settings section.
Step 6 Scroll down to the Cisco DVS Anti-Malware Settings section.
Step 7 Configure the anti-malware settings for the policy as necessary.

Choose whether or not to scan traffic based on the user-agent field specified in the HTTP
request header.

When you select this checkbox, you can choose to monitor or block suspect user agents in
the Additional Scanning section at the bottom of the page.

Chrome browsers do not include a user-agent string in FTP-over-HTTP requests;
therefore, Chrome cannot be detected as the user agent in those requests.

Note

Enable Suspect User Agent
Scanning

Choose whether or not to use the DVS engine to scan traffic for malware. Adaptive Scanning
chooses the most appropriate engine for each web request.

Enable Anti-Malware
Scanning

Choose whether to monitor or block the various malware categories based on a malware
scanning verdict.

Malware Categories

Choose whether to monitor or block the types of objects and responses listed in this section.

The category Outbreak Heuristics applies to transactions which are identified as
malware by Adaptive Scanning prior to running any scanning engines.

Note

URL transactions are categorized as unscannable when the configuredmaximum
time setting is reached or when the system experiences a transient error condition.
For example, transactions might be categorized as unscannable during scanning
engine updates or AsyncOS upgrades. The malware scanning verdicts
SV_TIMEOUT and SV_ERROR, are considered unscannable transactions.

Note

Other Categories
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Step 8 Submit and Commit Changes.

What to do next

• Understanding Adaptive Scanning, on page 248

Configuring Anti-Malware and Reputation Settings with Adaptive Scanning Disabled

Step 1 Choose Web Security Manager > Access Policies.
Step 2 Click the Anti-Malware and Reputation link for the Access Policy you want to configure.
Step 3 Under the Web Reputation and Anti-Malware Settings section, choose Define Web Reputation and Anti-Malware

Custom Settings.

This allows you to configure web reputation and anti-malware settings for this Access Policy that differ from the global
policy.

Step 4 Configure the settings in the Web Reputation Settings section.
Step 5 Configure the settings in the Advanced Malware Protection Settings section.
Step 6 Scroll down to the Cisco DVS Anti-Malware Settings section.
Step 7 Configure the anti-malware settings for the policy as necessary.

When you enable Webroot, Sophos or McAfee scanning, you can choose to monitor or block some additional
categories in the Malware categories on this page

Note

DescriptionSetting

Choose whether or not to enable the appliance to scan traffic based on the user-agent field
specified in the HTTP request header.

When you select this checkbox, you can choose to monitor or block suspect user agents in
the Additional Scanning section at the bottom of the page.

Chrome browsers do not include a user-agent string in FTP-over-HTTP requests;
therefore, Chrome cannot be detected as the user agent in those requests.

Note

Enable Suspect User
Agent Scanning

Choose whether or not to enable the appliance to use the Webroot scanning engine when
scanning traffic.

Enable Webroot

Choose whether or not to enable the appliance to use either the Sophos or McAfee scanning
engine when scanning traffic.

Enable Sophos or
McAfee

Choose whether to monitor or block the various malware categories based on a malware
scanning verdict. The categories listed in this section depend on which scanning engines you
enable above.

Malware Categories
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DescriptionSetting

Choose whether to monitor or block the types of objects and responses listed in this section.

URL transactions are categorized as unscannable when the configured maximum
time setting is reached or when the system experiences a transient error condition.
For example, transactions might be categorized as unscannable during scanning
engine updates or AsyncOS upgrades. The malware scanning verdicts
SV_TIMEOUT and SV_ERROR, are considered unscannable transactions.

Note

Other Categories

Step 8 Submit and Commit Changes.

What to do next

• Configuring Web Reputation Score Thresholds for Access Policies, on page 254
• Malware Category Descriptions, on page 258

Configuring Web Reputation Scores
When you install and set up the Web Security appliance, it has default settings for Web Reputation Scores.
However, you can modify threshold settings for web reputation scoring to fit your organization’s needs.You
configure the web reputation filter settings for each policy group.

Configuring Web Reputation Score Thresholds for Access Policies

Step 1 Choose Web Security Manager > Access Policies.
Step 2 Click the link under the Anti-Malware and Reputation column for the Access Policy group you want to edit.
Step 3 Under the Web Reputation and Anti-Malware Settings section, choose Define Web Reputation and Anti-Malware

Custom Settings.

This allows you to configure web reputation and anti-malware settings for this Access Policy that differ from the global
policy.

Step 4 Verify the Enable Web Reputation Filtering field is enabled.
Step 5 Move the markers to change the range for URL block, scan, and allow actions.
Step 6 Submit and Commit Changes.

You can edit the web reputation score thresholds in Access Policies when Adaptive Scanning is disabledNote

Configuring Web Reputation Filter Settings for Decryption Policy Groups

Step 1 Choose Web Security Manager > Decryption Policies.
Step 2 Click the link under the Web Reputation column for the Decryption Policy group you want to edit.
Step 3 Under the Web Reputation Settings section, choose Define Web Reputation Custom Settings. This allows you to

override the web reputation settings from the Global Policy Group.
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Step 4 Verify the Enable Web Reputation Filtering field is checked.
Step 5 Move the markers to change the range for URL drop, decrypt, and pass through actions.
Step 6 In the Sites with No Score field, choose the action to take on request for sites that have no assigned Web Reputation

Score.
Step 7 Submit and Commit Changes.

Configuring Web Reputation Filter Settings for Data Security Policy Groups

Step 1 Choose Web Security Manager > Cisco Data Security.
Step 2 Click the link under the Web Reputation column for the Data Security Policy group you want to edit.
Step 3 Under the Web Reputation Settings section, choose Define Web Reputation Custom Settings.

This allows you to override the web reputation settings from the Global Policy Group.

Step 4 Move the marker to change the range for URL block and monitor actions.
Step 5 Submit and Commit Changes.

Only negative and zero values can be configured for web reputation threshold settings for Cisco Data Security
Policies. By definition, all positive scores are monitored

Note

Integrating the Appliance with AMP for Endpoints Console
You can integrate your appliance with AMP for Endpoints console, and perform the following actions in AMP
for Endpoints console:

• Create a simple custom detection list.

• Add new malicious file SHAs to the simple custom detection list.

• Create an application allowed list.

• Add new file SHAs to the application allowed list.

• Create a custom policy.

• Attach the simple custom detection list and the application allowed list to the custom policy.

• Create a custom group.

• Attach the custom policy to the custom group.

• Move your registered appliance from the default group to the custom group.

• View the file trajectory details of a particular file SHA.

To integrate your appliance with AMP for Endpoints console, you need to register your appliance with the
console.
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After the integration, when a file SHA is sent to the File Reputation server, the verdict obtained for the file
SHA from the File Reputation Server is overridden by the verdict already available for the same file SHA in
the AMP for Endpoints console.

If a file SHA is already marked as malicious globally, and if the same file SHA is added to the blocked list
in AMP for Endpoints console, the file disposition is malicious.

The Advanced Malware Protection report page includes a new section - Incoming Malicious Files by
Category to view the percentage of file SHAs on the blocked list received from the AMP for Endpoints
console that are displayed asCustom Detection. The threat name of a file SHA on the blocked list is displayed
as Custom Detection in the Malicious Threat Files section of the report. To view the file trajectory details
about a file SHA on the blocked list in the AMP for Endpoints console, see #unique_442.

Before you begin

Make sure you have a user account in AMP for Endpoints console with admin access rights. For more details
on how to create an AMP for Endpoints console user account, contact Cisco TAC.

Make sure you have enabled and configured File Reputation Filtering. See Enabling and Configuring File
Reputation and Analysis Services , on page 268to know how to enable and configure File Reputation Filtering.

Step 1 Select Security Services > Anti-Malware and Reputation.
Step 2 Click Edit Global Settings.
Step 3 Click Register Appliance with AMP for Endpoints in the Advanced Settings panel for File Reputation in the

Anti-Malware Reputation page of the web interface.

Once you click Register Appliance with AMP for Endpoints, the AMP for Endpoints console login page appears.

You must enable and configure File Reputation Filtering before you register the appliance with AMP for
Endpoints. See Enabling and Configuring File Reputation and Analysis Services , on page 268to know how to
enbale and configure File Reputaion Filtering.

Note

Step 4 Log in to the AMP for Endpoints console with your user credentials.
Step 5 Click Allow in the AMP for Endpoints authorization page to register your appliance.

Once you click Allow, the registration is complete, and it redirects you to the Anti-Malware Reputation page of your
appliance. Your appliance name is displayed in the AMP for Endpoints Console Integration field. You can use the
appliance name to customize your appliance settings in the AMP for Endpoints console page.

What to do next

Next Steps:

• You can go to Accounts > Applications section of the AMP for Endpoints console page, to verify whether
your appliance is registered with AMP for Endpoints console. Your appliance name is displayed in the
Applications section of the AMP for Endpoints console page.

• After registration, your appliance is added to the default group (Audit Group) which has a default policy
(Network Policy) attached to it. The default policy contains file SHAs that are added to the blocked list
or the allowed list. If you want to customize the AMP for Endpoints settings for your appliance, and add
your own file SHAs that are added to the blocked list or the allowed list, see the AMP for Endpoints user
documentation at https://console.amp.cisco.com/docs.
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• To deregister your appliance connection from AMP for Endpoints console, you can click Deregister in
the Advanced Settings for File Reputation section in your appliance, or you need to go to the AMP for
Endpoints console page at https://console.amp.cisco.com/. For more information, see the AMP for
Endpoints user documentation at https://console.amp.cisco.com/docs.

When you change your File Reputation server to a different data center, your appliance is automatically
deregistered from the AMP for Endpoints console. Youmust re-register your appliance with AMP for Endpoints
console with the same data center selected for the File Reputation server.

Note

If a malicious file SHA gets a clean verdict, then verify whether the same file SHA is added to the allowed
list in AMP for Endpoints console.

Note

Maintaining the Database Tables
The web reputation, Webroot, Sophos, and McAfee databases periodically receive updates from the Cisco
update server. Server updates are automated and the update interval is set by the server.

The Web Reputation Database
The Web Security appliance maintains a filtering database that contains statistics and information about how
different types of requests are handled. The appliance can also be configured to send web reputation statistics
to a Cisco SensorBase Network server. SensorBase server information is leveraged with data feeds from the
SensorBase Network and the information is used to produce a Web Reputation Score.

Logging of Web Reputation Filtering Activity and DVS Scanning
The access log file records the information returned by the Web Reputation Filters and the DVS engine for
each transaction. The scanning verdict information section in the access logs includes many fields to help
understand the cause for the action applied to a transaction. For example, some fields display the web reputation
score or the malware scanning verdict Sophos passed to the DVS engine.
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Logging Adaptive Scanning
DescriptionCustom Field in W3C LogsCustom

Field in
Access
Logs

The anti-malware name returned by Adaptive Scanning. If
the transaction is not blocked, this field returns a hyphen
(“-”). This variable is included in the scanning verdict
information (in the angled brackets at the end of each access
log entry).

x-as-malware-threat-name%X6

Transactions blocked and monitored by the adaptive scanning engine use the ACL decision tags:

• BLOCK_AMW_RESP
• MONITOR_AMW_RESP

Caching
The following guidelines explain how AsyncOS uses the cache while scanning for malware:

• AsyncOS only caches objects if the entire object downloads. If malware is blocked during scanning, the
whole object is not downloaded and therefore is not cached.

• AsyncOS scans content whether it is retrieved from the server or from the web cache.
• The length of time that content is cached varies with many factors - there is no default.
• AsyncOS rescans content when signatures are updated.

Malware Category Descriptions
DescriptionMalware Type

Adware encompasses all software executables and plug-ins that direct users
towards products for sale. These programs may also change security settings
making it impossible for users to make changes to their system settings.

Adware

A browser helper object is a browser plug-in that may perform a variety of
functions related to serving advertisements or hijacking user settings.

Browser Helper Object

A commercial system monitor is a piece of software with system monitor
characteristics that can be obtained with a legitimate license through legal
means.

Commercial System Monitor

A dialer is a program that utilizes your modem or another type of Internet
access to connect you to a phone line or a site that causes you to accrue long
distance charges to which you did not provide your full consent.

Dialer

Spyware is a type of malware installed on computers that collects small pieces
of information about users without their knowledge.

Generic Spyware
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DescriptionMalware Type

A hijacker modifies system settings or any unwanted changes to a user’s
system that may direct them to a website or run a program without a users
consent.

Hijacker

These are files that were identified as threats by the Advanced Malware
Protection file reputation service.

Known Malicious and
High-Risk Files

This category is used to catch all other malware and suspicious behavior that
does not exactly fit in one of the other defined categories.

Other Malware

A phishing URL is displayed in the browser address bar. In some cases, it
involves the use of domain names and resembles those of legitimate domains.

Phishing URL

Potentially Unwanted Application. A PUA is an application that is not
malicious, but may be considered to be undesirable.

PUA

A system monitor encompasses any software that performs one of the
following:

• Overtly or covertly records system processes and/or user action.
• Makes those records available for retrieval and review at a later time.

System Monitor

A trojan downloader is a Trojan that, after installation, contacts a remote
host/site and installs packages or affiliates from the remote host.

Trojan Downloader

A trojan horse is a destructive program that masquerades as a benign
application. Unlike viruses, Trojan horses do not replicate themselves.

Trojan Horse

A trojan phisher may sit on an infected computer waiting for a specific web
page to be visited or may scan the infected machine looking for user names
and passphrases.

Trojan Phisher

A virus is a program or piece of code that is loaded onto your computer
without your knowledge.

Virus

Aworm is program or algorithm that replicates itself over a computer network
and performs malicious actions.

Worm
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C H A P T E R 15
File Reputation Filtering and File Analysis

This chapter contains the following sections:

• Overview of File Reputation Filtering and File Analysis , on page 261
• Configuring File Reputation and Analysis Features, on page 265
• File Reputation and File Analysis Reporting and Tracking , on page 274
• Taking Action When File Threat Verdicts Change , on page 277
• Troubleshooting File Reputation and Analysis , on page 277

Overview of File Reputation Filtering and File Analysis
Advanced Malware Protection protects against zero-day and targeted file-based threatsby:

• Obtaining the reputation of known files.
• Analyzing behavior of certain files that are not yet known to the reputation service.
• Continuously evaluating emerging threats as new information becomes available, and notifying you
about files that are determined to be threats after they have entered your network.

This feature is available for file downloads. Uploaded files.

The file reputation and file analysis services have options for either public- or private-cloud (on-premesis).

• The private-cloud file reputation service is provided by Cisco AMP Virtual Private Cloud appliance,
operating in either “proxy” or “air-gap” (on-premises) mode. See Configuring an On-premises File
Reputation Server, on page 267.

• The private-cloud file analysis service is provided by an on-premises Cisco AMP Threat Grid appliance.
See Configuring an On-Premises File Analysis Server , on page 267.

File Threat Verdict Updates
Threat verdicts can change as new information emerges. A file may initially be evaluated as unknown or
clean, and the user may thus be allowed to access the file. If the threat verdict changes as new information
becomes available, you will be alerted, and the file and its new verdict appear in the AMP Verdict Updates
report. You can investigate the point-of-entry transaction as a starting point to remediating any impacts of the
threat.

Verdicts can also change from malicious to clean.
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When the appliance processes subsequent instances of the same file, the updated verdict is immediately
applied.

Information about the timing of verdict updates is included in the file-criteria document referenced in Supported
Files for File Reputation and Analysis Services , on page 263.

Related Topics

• File Reputation and File Analysis Reporting and Tracking , on page 274
• Taking Action When File Threat Verdicts Change , on page 277

File Processing Overview
First, the website from which the file is downloaded is evaluated against the Web Based Reputation Service
(WBRS).

If the web reputation score of the site is in the range configured to “Scan,” the appliance simultaneously scans
the transaction for malware and queries the cloud-based service for the reputation of the file. (If the site’s
reputation score is in the “Block” range, the transaction is handled accordingly and there is no need to process
the file further.) If malware is found during scanning, the transaction is blocked regardless of the reputation
of the file.

If Adaptive Scanning is also enabled, file reputation evaluation and file analysis are included in Adaptive
Scanning.

Communications between the appliance and the file reputation service are encrypted and protected from
tampering.

After a file’s reputation is evaluated:

• If the file is known to the file reputation service and is determined to be clean, the file is released to the
end user .

• If the file reputation service returns a verdict of malicious, then the appliance applies the action that you
have specified for such files.

• If the file is known to the reputation service but there is insufficient information for a definitive verdict,
the reputation service returns a threat score based on characteristics of the file such as threat fingerprint
and behavioral analysis. If this score meets or exceeds the configured reputation threshold, the appliance
applies the action that you have configured in the access policy for malicious or high-risk files.

• If the reputation service has no information about the file, and the file does not meet the criteria for
analysis (see Supported Files for File Reputation andAnalysis Services , on page 263), the file is considered
clean and the file is released to the end user .

• If you have enabled the cloud-based File Analysis service, and the reputation service has no information
about the file, and the file meets the criteria for files that can be analyzed (see Supported Files for File
Reputation and Analysis Services , on page 263), then the file is considered clean and is optionally sent
for analysis.

• For deployments with on-premises file analysis, the reputation evaluation and file analysis occur
simultaneously. If the reputation service returns a verdict, that verdict is used, as the reputation service
includes inputs from a wider range of sources. If the file is unknown to the reputation service, the file is
released to the user but the file analysis result is updated in the local cache and is used to evaluate future
instances of the file .

• If the file reputation verdict information is unavailable because the connection with the server timed out,
the file is considered as Unscannable and the actions configured are applied.
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Low Risk Files

When a file is initially evaluated as unknown, and has no dynamic content, the appliance sends it to the
pre-classification engine, where it is designated as low risk. This file is not uploaded for analysis. If the same
file is accessed within the cache expiry, it is evaluated again as low risk, and is not uploaded for analysis.
After the cache timeout, if the same file is accessed again, it is evaluated as unknown and low risk sequentially.
This process is repeated for low risk files. Since these low risk files are not uploaded, they will not be a part
of file analysis reports.

Figure 8: Advanced Malware Protection Workflow for Cloud File Analysis Deployments

If the file is sent for analysis:

• If the file is sent to the cloud for analysis: Files are sent over HTTPS.
• Analysis normally takes minutes, but may take longer.
• A file that is flagged as malicious after File Analysis may not be identified as malicious by the reputation
service. File reputation is determined by a variety of factors over time, not necessarily by a single file
analysis verdict.

• Results for files analyzed using an on premises Cisco AMP Threat Grid appliance are cached locally.

For information about verdict updates, see File Threat Verdict Updates , on page 261.

Supported Files for File Reputation and Analysis Services
The reputation service evaluates most file types. File type identification is determined by file content and is
not dependent on the filename extension.

Some files with unknown reputation can be analyzed for threat characteristics. When you configure the file
analysis feature, you choose which file types are analyzed. New types can be added dynamically; you will
receive an alert when the list of uploadable file types changes, and can select added file types to upload.

Details about what files are supported by the reputation and analysis services are available only to registered
Cisco customers. For information about which files are evaluated and analyzed, see File Criteria for Advanced
Malware Protection Services for Cisco Content Security Products, available from
http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-user-guide-list.html. The
criteria for evaluating a file’s reputation and for sending files for analysis may change at any time.

In order to access this document, you must have a Cisco customer account with a support contract. To register,
visit https://tools.cisco.com/RPF/register/register.do.
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Your setting for DVS Engine Object Scanning Limits on the Security Services > Anti-Malware and
Reputation page also determines the maximum file size for file reputation and analysis.

You should configure policies to block download of files that are not addressed by Advanced Malware
Protection.

A file (either in incoming mail or outgoing mail) that has already been uploaded for analysis from any source
will not be uploaded again. To view analysis results for such a file, search for the SHA-256 from the File
Analysis reporting page.

Note

Related Topics

• Enabling and Configuring File Reputation and Analysis Services , on page 268
• Ensuring That You Receive Alerts About Advanced Malware Protection Issues, on page 273
• Archive or Compressed File Processing, on page 264

Archive or Compressed File Processing
If the file is compressed or archived,

• Reputation of the compressed or archive file is evaluated.
• In case of some selective file types, the compressed or archive file is decompressed and reputations of
all the extracted files are evaluated.

For information about which archived and compressed files are examined, including file formats, see the
information linked from Supported Files for File Reputation and Analysis Services , on page 263.

In this scenario,

• If one of the extracted files is malicious, the file reputation service returns a verdict of Malicious for the
compressed or the archive file.

• If the compressed or archive file is malicious and all the extracted files are clean, the file reputation
service returns a verdict of Malicious for the compressed or the archive file.

• If the verdict of any of the extracted files is unknown, the extracted files are optionally (if configured
and the file type is supported for file analysis) sent for file analysis.

• If the extraction of a file fails while decompressing a compressed or an archive file, the file reputation
service returns a verdict of Unscannable for the compressed or the archive file. Keep in mind that, in this
scenario, if one of the extracted files is malicious, the file reputation service returns a verdict of Malicious
for the compressed or the archive file (Malicious verdict takes precedence over Unscannable verdict).

• An archive or compressed file is treated as unscannable in the following scenarios:

• The data compression ratio is more than 20.

• The archive file contains more than five levels of nesting.

• The archive file contains more than 200 child files.

• The archive file size is more than 50 MB.

• The archive file is password protected or unreadable.
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Reputation of the extracted files with safe MIME types, for example, text/plain, are not evaluated.Note

Privacy of Information Sent to the Cloud
• Only the SHA that uniquely identifies a file is sent to the reputation service in the cloud. The file itself
is not sent.

• If you are using the file analysis service in the cloud and a file qualifies for analysis, the file itself is sent
to the cloud.

• Information about every file that is sent to the cloud for analysis and has a verdict of "malicious" is added
to the reputation database. This information is used along with other data to determine a reputation score.

Information about files analyzed by an on premises Cisco AMP Threat Grid appliance is not shared with
the reputation service.

Configuring File Reputation and Analysis Features
• Requirements for Communication with File Reputation and Analysis Services , on page 265
• Configuring an On-premises File Reputation Server, on page 267
• Configuring an On-Premises File Analysis Server , on page 267
• Enabling and Configuring File Reputation and Analysis Services , on page 268
• (Public Cloud File Analysis Services Only) Configuring Appliance Groups , on page 272
• Configuring File Reputation and Analysis Service Action Per Access Policy , on page 273
• Ensuring That You Receive Alerts About Advanced Malware Protection Issues, on page 273
• Configuring Centralized Reporting for Advanced Malware Protection Features , on page 274

Requirements for Communication with File Reputation and Analysis Services
• All Web Security appliances that use these services must be able to connect to them directly over the
internet (excluding File Analysis services configured to use an on-premises Cisco AMP Threat Grid
Appliance.)

• By default, communication with file reputation and analysis services is routed through the Management
port (M1) on the appliance. If your appliance does not route data through the management port, see
Routing Traffic to File Reputation and File Analysis Servers Through a Data Interface , on page 266.

• By default, communication with file reputation and cloud-based analysis services is routed through the
interface that is associated with the default gateway. To route this traffic through a different interface,
create a static route for each address in the Advanced section of the Security Services > File Reputation
and Analysis page.

• The following firewall ports must be open:
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Appliance
Interface

HostnameIn/OutProtocolDescriptionFirewall
Ports

Management,
unless a static
route is
configured to
route this
traffic through
a data port.

As configured in Security
Services > Anti-Malware and
Reputation, Advanced section:
Advanced Settings for File
Reputation, Cloud Server Pool
parameter.

OutTCPAccess to cloud
services for
obtaining file
reputation.

32137
(default) or
443

As configured in Security
Services > Anti-Malware and
Reputation, Advanced section:
Advanced Settings for File
Analysis.

OutTCPAccess to cloud
services for file
analysis.

443

• When you configure the file reputation feature, choose whether to use SSL over port 443.

Related Topics

• Enabling and Configuring File Reputation and Analysis Services , on page 268

Routing Traffic to File Reputation and File Analysis Servers Through a Data Interface
If the appliance is configured to restrict the management port to appliance management services only (on the
Network > Interfaces page), configure the appliance to route file reputation and analysis traffic through the
data port instead.

Add routes for data traffic on the Network > Routes page. For general requirements and instructions, see
Configuring TCP/IP Traffic Routes, on page 31

GatewayDestination NetworkFor Connection To

IP address of the gateway for
the data port

In Security Services >Anti-Malware and Reputation,
Advanced section > Advanced Settings for File
Reputation section, provide the name (URL) of the
File Reputation Server, and the cloud server pool’s
Cloud Domain name.

If you choose Private Cloud for File Reputation
Server, enter the host name or IP address of the
Server, and provide a valid Public Key. This must
be the same key used by the private cloud appliance.

Host name of the Cloud Server Pool, as configured
in Security Services ; Anti-Malware and Reputation,
Advanced section: Advanced Settings for File
Reputation.

The file reputation
service
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GatewayDestination NetworkFor Connection To

IP address of the gateway for
the data port

• In Security Services > Anti-Malware and
Reputation, Advanced section > Advanced
Settings for File Analysis section, provide the
name (URL) of the File Analysis Server.

If you choose Private Cloud for the File
Analysis Server, enter the Server URL, and
provide a valid Certificate Authority.

• The File Analysis Client ID is client ID for this
appliance on the File Analysis server
(read-only).

Host name of the File Analysis Server, as configured
in Security Services; Anti-Malware and Reputation,
Advanced section: Advanced Settings for File
Analysis.

The file analysis
service

Related Topics

• Configuring TCP/IP Traffic Routes, on page 31

Configuring an On-premises File Reputation Server
If you will use a Cisco AMP Virtual Private Cloud appliance as a private-cloud file analysis server:

• You can obtain the Cisco AdvancedMalware Protection Virtual Private CloudAppliance documentation,
including the Installation and Configuration of FireAMP Private Cloud guide, from
http://www.cisco.com/c/en/us/support/security/fireamp-private-cloud-virtual-appliance/tsd-products-support-series-home.html

Use that documentation to perform the tasks described in this topic.

Additional documentation is available using the Help link in the AMP Virtual Private Cloud appliance.

• Set up and configure the Cisco AMP Virtual Private Cloud appliance in either “proxy” or “air-gap”
(on-premises) mode.

• Ensure the Cisco AMPVirtual Private Cloud appliance software version is 2.2, which enables integration
with Cisco Web Security appliances.

• Download the AMP Virtual Private Cloud certificate and keys on that appliance for upload to this Web
Security appliances

After you have set up the on-premises file-reputation server, you will configure connection to it from this
Web Security appliances; see Step 6 of Enabling and Configuring File Reputation and Analysis Services , on
page 268

Note

Configuring an On-Premises File Analysis Server
If you will use a Cisco AMP Threat Grid Appliance as a private-cloud file analysis server:

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
267

File Reputation Filtering and File Analysis
Configuring an On-premises File Reputation Server

http://www.cisco.com/c/en/us/support/security/fireamp-private-cloud-virtual-appliance/tsd-products-support-series-home.html


• Obtain the Cisco AMPThreat Grid Appliance Setup and Configuration Guide and the Cisco AMPThreat
Grid Appliance Administration Guide. Cisco AMP Threat Grid Appliance documentation is available
from
http://www.cisco.com/c/en/us/support/security/amp-threat-grid-appliances/products-installation-guides%20-list.html.

Use this documentation to perform the tasks described in this topic.

Additional documentation is available from the Help link in the AMP Threat Grid appliance.

In the Administration Guide, search for information about all of the following: integrations with other
Cisco appliances, CSA, Cisco Sandbox API WSA, and Web Security Appliances.

• Set up and configure the Cisco AMP Threat Grid Appliance.
• If necessary, update your Cisco AMP Threat Grid Appliance software to version 1.2.1, which supports
integration with Cisco Web Security appliances.

See the AMP Thread Grid documentation for instructions for determining the version number and for
performing the update.

• Ensure that your appliances can communicate with each other over your network. Cisco Web Security
appliances must be able to connect to the CLEAN interface of the AMP Threat Grid appliance.

• If you will deploy a self-signed certificate: Generate a self-signed SSL certificate from the Cisco AMP
Threat Grid appliance to be used on your Web Security appliance. See instructions for downloading
SSL certificates and keys in the administrator’s guide for your AMP Threat Grid appliance. Be sure to
generate a certificate that has the hostname of your AMP Threat Grid appliance as CN. The default
certificate from the AMP Threat Grid appliance does NOT work.

• Registration of your Web Security appliancewith your Threat Grid appliance occurs automatically when
you submit the configuration for File Analysis, as described in Enabling and Configuring File Reputation
and Analysis Services , on page 268. However, you must activate the registration as described in the same
procedure.

After you have set up the on-premises file-analysis server, you will configure connection to it from this Web
Security appliance; see Step 7 of Enabling and Configuring File Reputation and Analysis Services , on page
268

Note

Enabling and Configuring File Reputation and Analysis Services

Before you begin

• Acquire feature keys for the file reputation service and the file analysis service and transfer them to this
appliance. See Working with Feature Keys, on page 414 for more information about adding feature keys
to the appliance.

• Meet the Requirements for Communication with File Reputation and Analysis Services , on page 265.
• Ensure that a Data network interface is enabled on the appliance if you want to use a Data network
interface for File Reputation and Analysis services. See Enabling or Changing Network Interfaces, on
page 27

• Verify connectivity to the update servers configured in Configuring Upgrade and Service Update Settings,
on page 459.
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• If you will use a Cisco AMP Virtual Private Cloud Appliance as a private cloud file reputation server,
see Configuring an On-premises File Reputation Server, on page 267.

• If you will use a Cisco AMP Threat Grid Appliance as a private cloud file analysis server, see Configuring
an On-Premises File Analysis Server , on page 267.

Step 1 Select Security Services > Anti-Malware and Reputation.
Step 2 Click Edit Global Settings.
Step 3 Click Enable File Reputation Filtering and optionally Enable File Analysis.

• If Enable File Reputation Filtering is checked, you must configure the section File Reputation Server (in Step
6), by either choosing the URL of an external public-reputation cloud server, or by providing the Private reputation
cloud server connection information.

• Similarly, if Enable File Analysis is checked, you must configure the section File Analysis Server URL (in Step
7), providing either the URL of an external cloud server, or the Private analysis cloud connection information.

New file types may be added after an upgrade and are not enabled by default. If you have enabled file
analysis, and require the new file types to be included in analysis, you must enable them.

Note

Step 4 Accept the license agreement if presented.
Step 5 In the File Analysis section, select the required file types from the appropriate file groups (for example, “Microsoft

Documents”) to send for file analysis.

For information about supported file types, see the document described in Supported Files for File Reputation and
Analysis Services , on page 263

Step 6 Expand the Advanced Settings for File Reputation panel and adjust the following options as needed:

DescriptionOption

The name of the domain to be used for file reputation queries.Cloud Domain

Choose either: the host name of the public reputation cloud server, or Private reputation
cloud.

If you choose Private reputation cloud, provide the following:

• Server – The host name or IP address of the Cisco AMP Virtual Private Cloud
appliance.

• Public Key – Provide a valid public key for encrypted communications between
this appliance and your private cloud appliance. This must be the same key used
by the private cloud server: locate the key file on this appliance, and then click
Upload File.

You must have already downloaded the key file from the server to this
appliance.

Note

File Reputation Server

The routing table (associated with an appliance network interface type, either
Management or Data) to be used for Advanced Malware Protection services. If the
appliance has both theManagement interface and one or more Data interfaces enabled,
you can select Management or Data.

Routing Table
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DescriptionOption

Check Use SSL (Port 443) to communicate on port 443 instead of the default port,
32137. Refer to the Cisco AMP Virtual Private Cloud Appliance user guide for
information about enabling SSH access to the server.

SSL communication over port 32137 may require you to open that port in
your firewall.

Note

This option also allows you to configure an upstream proxy for communication with
the file reputation service. If checked, provide the appropriate Server, Username and
Passphrase information.

WhenUse SSL (Port 443) is selected, you can also checkRelax Certificate Validation
to skip standard certificate validation if the tunnel proxy server's certificate is not signed
by a trusted root authority. For instance, select this option if using a self-signed
certificate on a trusted internal tunnel proxy server.

If you checked Use SSL (Port 443) in the SSL Communication for File
Reputation section of the Advanced Settings for File Reputation, you must
add the AMP on-premises reputation server CA certificate to the certificate
store on this appliance, using Network > Certificates (Custom Certificate
Authorities) in the Web interface. Obtain this certificate from the server
(Configuration > SSL > Cloud server > download).

Note

SSL Communication for File
Reputation

The frequency, in minutes, with which to ping for retrospective events.Heartbeat Interval

The upper limit for acceptable file reputation scores. Scores above this threshold indicate
the file is infected.

• Use value from Cloud Service (60)

• Enter Custom Value – defaults to 60.

Reputation Threshold

The number of elapsed seconds before the reputation query times out.Query Timeout

The number of elapsed seconds before the file processing times out.Processing Timeout

The client ID for this appliance on the File Reputation server (read-only).File Reputation Client ID

Do not change any other settings in this section without guidance from Cisco support.Note

Step 7 If you will use the cloud service for file analysis, expand the Advanced Settings for File Analysis panel and adjust the
following options as needed:
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DescriptionOption

Choose either: the name (URL) of an external cloud server, or Private analysis cloud.

If specifying an external cloud server, choose the server that is physically nearest to
your appliance. Newly available servers will be added to this list periodically using
standard update processes.

Choose Private analysis cloud to use an on-premises Cisco AMPThreat Grid appliance
for file analysis, and provide the following:

• Certificate Authority – Choose eitherUse Cisco Default Certificate Authority,
or Use Uploaded Certificate Authority.

If you choose Use Uploaded Certificate Authority, click Browse to upload a
valid certificate file for encrypted communications between this appliance and
your private cloud appliance. This must be the same certificate used by the private
cloud server.

If you have configured the Cisco AMP Threat Grid portal on your appliance
for file analysis, you can access the Cisco AMP Threat Grid portal (for
example, https://panacea.threatgrid.eu) to view and track the files submitted
for file analysis. For more information on how to access the Cisco AMP
Threat Grid portal, contact Cisco TAC.

Note

File Analysis Server URL

Check Use File Reputation Proxy checkbox to use the same File Reputation tunnel
proxy that you have already configured, as an upstream proxy for file analysis.

If you want to configure a different upstream proxy, uncheck the Use File Reputation
Proxy checkbox and enter the appropriate Server, Port, Username, and Passphrase
infrormation.

Proxy Settings

The client ID for this appliance on the File Analysis server (read-only).File Analysis Client ID

Step 8 (Optional) Expand the Cache Settings panel, if you want to configure the cache expiry period for File Reputation
disposition values.

Step 9 Submit and commit your changes.
Step 10 If you are using an on-premises Cisco AMP Threat Grid appliance, activate the account for this appliance on the AMP

Threat Grid appliance.

Complete instructions for activating the “user” account are available in the AMP Threat Grid documentation.

a) Note the File Analysis Client ID that appears at the bottom of the page section. This identifies the “user” that you
will activate.

b) Sign in to the AMP Threat Grid appliance.
c) Select Welcome... > Manage Users and navigate to User Details.
d) Locate the “user” account based on the File Analysis Client ID of your Web Security appliances.
e) Activate this “user” account for your appliance.
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Important! Changes Needed in File Analysis Setting
If you plan to use a new public cloud File Analysis service, make sure you read the following instructions to
maintain datacenter isolation:

• The existing appliance grouping information is not preserved in the new File Analysis server. You must
regroup your appliances on the new File Analysis server.

• Messages that are quarantined to the File Analysis Quarantine are retained until the retention period.
After the quarantine retention period, the messages are released from the File Analysis Quarantine, and
re-scanned by the AMP engine. The file is then uploaded to the new File Analysis server for analysis
but the message is not sent to the File Analysis Quarantine again.

For more details, refer to the Cisco AMP Thread Grid documentation from
http://www.cisco.com/c/en/us/support/security/amp-threat-grid-appliances/products-installation-guides
-list.html.

(Public Cloud File Analysis Services Only) Configuring Appliance Groups
In order to allow all content security appliances in your organization to view file analysis result details in the
cloud for files sent for analysis from any appliance in your organization, you need to join all appliances to
the same appliance group.

You can configure appliance groups at the machine level. The appliance groups cannot be configured at the
cluster level.

Note

Step 1 Select Security Services > Anti-Malware and Reputation .
Step 2 In the Appliance Grouping for File Analysis Cloud Reporting section, enter the File Analysis Cloud Reporting Group

ID.

• If this is the first appliance being added to the group, provide a useful identifier for the group.

• This ID is case-sensitive, and cannot contain spaces.

• The ID you provide must be identical on all appliances that will share data about files that are uploaded for analysis.
However, the ID is not validated on subsequent group appliances.

• If you enter the Group ID incorrectly or need to change it for any other reason, you must open a case with Cisco
TAC.

• This change takes effect immediately; it does not require a Commit.

• All appliances in the group must be configured to use the same File Analysis server in the cloud.

• An appliance can belong to only one group.

• You can add a machine to a group at any time, but you can do it only once.

Step 3 Click Add Appliance to Group.
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Which Appliances Are In the Analysis Group?

Step 1 Select Security Services> Anti-Malware and Reputation .
Step 2 In the Appliance Grouping for File Analysis Cloud Reporting section, click View Appliances in Group.
Step 3 To view the File Analysis Client ID of a particular appliance, look in the following location:

Location of File Analysis Client IDAppliance

Advanced Settings for File Analysis section on the Security Services > File
Reputation and Analysis page.

Email Security appliance

Advanced Settings for File Analysis section on the Security Services > Anti-Malware
and Reputation page.

Web Security appliance

At the bottom of the Management Appliance > Centralized Services > Security
Appliances page.

Security Management appliance

Configuring File Reputation and Analysis Service Action Per Access Policy

Step 1 Select Web Security Manager > Access Policies.
Step 2 Click the link in the Anti-Malware and Reputation column for a policy in the table.
Step 3 In the Advanced Malware Protection Settings section, select Enable File Reputation Filtering and File Analysis.

If File Analysis is not enabled globally, only File Reputation Filtering is offered.

Step 4 Select an action for Known Malicious and High-Risk Files: Monitor or Block.

The default is Monitor.

Step 5 Submit and commit your changes.

Ensuring That You Receive Alerts About Advanced Malware Protection Issues
Ensure that the appliance is configured to send you alerts related to Advanced Malware Protection.

You will receive alerts when:

SeverityTypeAlert Description

WarningAnti-MalwareYou are setting up a connection to an on-premises
(private cloud) Cisco AMPThreat Grid appliance and
you need to activate the account as described in
Enabling and Configuring File Reputation and
Analysis Services , on page 268

(As is standard for all features)Feature keys expire
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SeverityTypeAlert Description

WarningAnti-MalwareThe file reputation or file analysis service is
unreachable.

InfoAnti-MalwareCommunication with cloud services is established.

Info

InfoAnti-MalwareA file reputation verdict changes.

InfoAnti-MalwareFile types that can be sent for analysis have changed.
You may want to enable upload of new file types.

WarningAnti-MalwareAnalysis of some file types is temporarily unavailable.

InfoAnti-MalwareAnalysis of all supported file types is restored after a
temporary outage.

ErrorAMPInvalid File Analysis service key. You need to contact
Cisco TAC with the file analysis id details to fix this
error.

Related Topics

• Several Alerts About Failure to Connect to File Reputation or File Analysis Servers , on page 278
• Taking Action When File Threat Verdicts Change , on page 277

Configuring Centralized Reporting for Advanced Malware Protection Features
If you will centralize reporting on a SecurityManagement appliance, see important configuration requirements
in the Advanced Malware Protection sections in the web reporting chapter of the online help or user guide
for your management appliance.

File Reputation and File Analysis Reporting and Tracking
• Identifying Files by SHA-256 Hash , on page 274
• #unique_442
• Viewing File Reputation Filtering Data in Other Reports , on page 276
• About Web Tracking and Advanced Malware Protection Features , on page 276

Identifying Files by SHA-256 Hash
Because filenames can easily be changed, the appliance generates an identifier for each file using a Secure
Hash Algorithm (SHA-256). If an appliance processes the same file with different names, all instances are
recognized as the same SHA-256. If multiple appliances process the same file, all instances of the file have
the same SHA-256 identifier.
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In most reports, files are listed by their SHA-256 value (in an abbreviated format). To identify the filenames
associated with a malware instance in your organization, select Reporting > Advanced Malware Protection
and click an SHA-256 link in the table. The details page shows associated filenames.

File Reputation and File Analysis Report Pages
DescriptionReport

Shows file-based threats that were identified by the file reputation
service.

For files with changed verdicts, see the AMP Verdict updates report.
Those verdicts are not reflected in the AdvancedMalware Protection
report.

If a file extracted from a compressed or archived file is malicious,
only the SHA value of the compressed or archived file is included in
the Advanced Malware Protection report.

The Incoming Malware Files by Category section shows the
percentage of file SHAs on the blocked list received from the AMP
for Endpoints console that are categorised as Custom Detection.

The threat name of file SHA on the blocked list obtained from AMP
for Endpoints console is displayed as Simple Custom Detection in
the Incoming Malware Threat Files section of the report.

You can click the link in the More Details section of the report to
view the file trajectory details about file SHA on the blocked list in
the AMP for Endpoints console.

You can view the Low Risk verdict details in the Incoming Files
Handed by AMP section of the report.

Advanced Malware Protection

Displays the time and verdict (or interim verdict) for each file sent
for analysis. The appliance checks for analysis results every 30
minutes.

To view more than 1000 File Analysis results, export the data as a
.csv file.

Drill down to view detailed analysis results, including the threat
characteristics for each file.

You can also search for additional information about an SHA, or
click the link at the bottom of the file analysis details page to view
additional details on the server that analyzed the file.

If extracted files from a compressed or an archive file are
sent for file analysis, only SHA values of these extracted
files are included in the File Analysis report.

Note

Advanced Malware Protection File
Analysis
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DescriptionReport

Because Advanced Malware Protection is focused on targeted and
zero-day threats, threat verdicts can change as aggregated data
provides more information.

The AMPReputation report lists the files processed by this appliance
for which the verdict has changed since the message was received.
For more information about this situation, see File Threat Verdict
Updates , on page 261.

To view more than 1000 verdict updates, export the data as a .csv
file.

In the case of multiple verdict changes for a single SHA-256, this
report shows only the latest verdict, not the verdict history.

To view all affected messages for a particular SHA-256 within the
maximum available time range (regardless of the time range selected
for the report) click a SHA-256 link.

Advanced Malware Protection
Reputation

Viewing File Reputation Filtering Data in Other Reports
Data for file reputation and analysis is available in other reports where relevant. A ;Blocked by Advanced
Malware Protection" column may be hidden by default in applicable reports. To display additional columns,
click the Columns link below the table.

The Report by User Location includes an Advanced Malware Protection tab.

About Web Tracking and Advanced Malware Protection Features
When searching for file threat information in Web Tracking, keep the following points in mind:

• To search for malicious files found by the file reputation service, selectKnown Malicious and High-Risk
Files for the Filter by Malware Category option in the Malware Threat area in the Advanced section
in Web Message Tracking.

• Web Tracking includes only information about file reputation processing and the original file reputation
verdicts returned at the time a transaction message was processed. For example, if a file was initially
found to be clean, then a verdict update found the file to be malicious, only the clean verdict appears in
Tracking results.

No information is provided for clean or unscannable attachments.

“Block – AMP” in search results means the transaction was blocked because of the file's reputation
verdict.

In Tracking details, the “AMP Threat Score” is the best-effort score that the cloud reputation service
provides when it cannot determine a clear verdict for the file. In this situation, the score is between 1 and
100. (Ignore the AMP Threat Score if an AMP Verdict is returned or if the score is zero .) The appliance
compares this score to the threshold score (configured on the Security Services > Anti-Malware and
Reputation page) to determine what action to take. By default, files with scores between 60 and 100 are
consideredmalicious. Cisco does not recommend changing the default threshold score. TheWBRS score
is the reputation of the site from which the file was downloaded; this score is not related to the file
reputation.
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• Verdict updates are available only in the AMP Verdict Updates report. The original transaction details
in Web Tracking are not updated with verdict changes. To see transactions involving a particular file ,
click a SHA-256 in the verdict updates report.

• Information about File Analysis, including analysis results and whether or not a file was sent for analysis,
are available only in the File Analysis report.

Additional information about an analyzed file may be available from the cloud or on-premises File
Analysis server. To view any available File Analysis information for a file, select Reporting > File
Analysis and enter the SHA-256 to search for the file , or click the SHA-256 link in Web Tracking
details. If the File Analysis service has analyzed the file from any source, you can see the details. Results
are displayed only for files that have been analyzed.

If the appliance processed a subsequent instance of a file that was sent for analysis, those instances will
appear in Web Tracking search results.

Taking Action When File Threat Verdicts Change

Step 1 View the AMP Verdict Updates report.
Step 2 Click the relevant SHA-256 link to view web tracking data for all transactions involving that file that end users were

allowed to access.
Step 3 Using the tracking data, identify the users that may have been compromised, as well as information such as the file names

involved in the breach and the web site from which the file was downloaded.
Step 4 Check the File Analysis report to see if this SHA-256 was sent for analysis, to understand the threat behavior of the file

in more detail.

What to do next

Related Topics

File Threat Verdict Updates , on page 261

Troubleshooting File Reputation and Analysis
• Log Files , on page 277
• Several Alerts About Failure to Connect to File Reputation or File Analysis Servers , on page 278
• API Key Error (On-Premises File Analysis) , on page 278
• Files are Not Uploaded As Expected , on page 279
• File Analysis Details in the Cloud Are Incomplete , on page 279
• Alerts about File Types That Can Be Sent for Analysis , on page 279

Log Files
In logs:

• AMP and amp refer to the file reputation service or engine.
• Retrospective refers to verdict updates.
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• VRT and sandboxing refer to the file analysis service.

Information about Advanced Malware Protection including File Analysis is logged in Access Logs or in
AMP Engine Logs. For more information, see the chapter on monitoring system activity through logs.

In the log message “Response received for file reputation query” possible values for “upload action” are:

• 1: SEND. In this case, you must send the file for File Analysis.
• 2: DON’T SEND. In this case, you do not send the file for File Analysis.
• 3: SEND ONLY METADATA. In this case, you send only the metadata and not the entire file for File
Analysis.

• 0: NO ACTION. In this case, no other action is required.

Several Alerts About Failure to Connect to File Reputation or File Analysis
Servers

Problem

You receive several alerts about failures to connect to the file reputation or analysis services in the cloud. (A
single alert may indicate only a transient issue.)

Solution

• Ensure that you have met the requirements in Requirements for Communication with File Reputation
and Analysis Services , on page 265.

• Check for network issues that may prevent the appliance from communicating with the cloud services.
• Increase the Query Timeout value:

Select Security Services > Anti-Malware and Reputation. The Query Timeout value is in the Advanced
settings area of the Advanced Malware Protection Services section.

API Key Error (On-Premises File Analysis)
Problem

You receive an API key alert when attempting to view File Analysis report details, or the Web Security
appliance is unable to connect to the AMP Threat Grid server to upload files for analysis.

Solution

This error can occur if you change the hostname of the AMP Threat Grid server and you are using a self-signed
certificate from the AMP Threat Grid server, as well as possibly under other circumstances. To resolve the
issue:

• Generate a new certificate from the AMP Threat Grid appliance that has the new hostname.
• Upload the new certificate to the Web Security appliance.
• Reset the API key on the AMP Threat Grid appliance. For instructions, see the online help on the AMP
Threat Grid appliance.

Related Topics

• Enabling and Configuring File Reputation and Analysis Services , on page 268
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Files are Not Uploaded As Expected
Problem

Files are not evaluated or analyzed as expected. There is no alert or obvious error.

Solution

Consider the following:

• The file may have been sent for analysis by another appliance and thus already be present on the File
Analysis server or in the cache of the appliance that is processing the file.

• Check the maximum file size limit configured for the DVS Engine Object Scanning Limits on the
Security Services > Anti-Malware and Reputation page. This limit applies to Advanced Malware
Protection features.

File Analysis Details in the Cloud Are Incomplete
Problem

Complete file analysis results in the public cloud are not available for files uploaded from other Web Security
appliances in my organization.

Solution

Be sure to group all appliances that will share file analysis result data. See (Public Cloud File Analysis Services
Only) Configuring Appliance Groups , on page 272. This configuration must be done on each appliance in the
group.

Alerts about File Types That Can Be Sent for Analysis
Problem

You receive alerts of severity Info about file types that can be sent for file analysis.

Solution

This alert is sent when supported file types change, or when the appliance checks to see what file types are
supported. This can occur when:

• You or another administrator changes the file types selected for analysis.
• Supported file types change temporarily based on availability in the cloud service. In this case, support
for the file types selected on the appliance will be restored as soon as possible. Both processes are dynamic
and do not require any action from you.

• The appliance restarts, for example as part of an AsyncOS upgrade.
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C H A P T E R 16
Managing Access to Web Applications

This chapter contains the following sections:

• Overview of Managing Access to Web Applications, on page 281
• Enabling the AVC Engine, on page 282
• Policy Application Control Settings, on page 283
• Controlling Bandwidth, on page 286
• Controlling Instant Messaging Traffic, on page 288
• Viewing AVC Activity, on page 289

Overview of Managing Access to Web Applications
The Application Visibility and Control (AVC) engine lets you create policies to control application activity
on the network without having to fully understand the underlying technology of each application. You can
configure application control settings in Access Policy groups. You can block or allow applications individually
or according to application type. You can also apply controls to particular application types.

Using Access Policies you can:

• Control application behaviors
• Control the amount of bandwidth used for particular application types
• Notify end-users when they are blocked
• Assign controls to Instant Messaging, Blogging and Social Media applications
• Specify Range Request settings

To control applications using the AVC engine, perform the following tasks:

Link to TaskTask

Enabling the AVC Engine, on page 282Enable the AVC engine

Configuring Application Control Settings in an Access
Policy Group, on page 285

Set Controls in an Access Policy Group

Controlling Bandwidth, on page 286Limit bandwidth consumed by some application
types to control congestion

Controlling Instant Messaging Traffic, on page 288Allow instant messaging traffic, but disallow
file sharing using instant messenger

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
281



Enabling the AVC Engine
Enable the AVC engine when you enable the Acceptable Use Controls.

You can view the AVC engine scanning activity in the Application Visibility report on the Reporting >
Application Visibility page.

Note

Step 1 Choose Security Services > Acceptable Use Controls.
Step 2 Click Enable or Edit Global Settings, depending on the current status of the Acceptable Use Controls.
Step 3 Be sure Enable Cisco Web Usage Controls is checked.
Step 4 In the Acceptable Use Controls Service panel, select Cisco Web Usage Controls, and then select Enable Application

Visibility and Control.
Step 5 Select the Default Action for Unreachable Service: Monitor or Block.
Step 6 Submit and Commit Changes.

What to do next

Related Topics

• AVC Engine Updates and Default Actions , on page 282
• User Experience When Requests Are Blocked by the AVC Engine , on page 283

AVC Engine Updates and Default Actions
AsyncOS periodically queries the update servers for new updates to all security service components, including
the AVC engine. AVC engine updates can include support for new application types and applications, as well
as updated support for existing applications if any application behaviors change. By updating the AVC engine
between AsyncOS version updates, the Web Security appliance remains flexible without requiring a server
upgrade.

AsyncOS for Web assigns the following default actions for the Global Access Policy:

• New Application Types default to Monitor.
• New application behaviors, such as block file transfer within a particular application; defaults toMonitor.
• New applications for an existing application type default to the Application Type’s default.

In the Global Access Policy, you can set the default action for each Application Type, so new applications
introduced in an AVC engine update automatically inherit the specified default action. See Configuring
Application Control Settings in an Access Policy Group, on page 285.

Note
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User Experience When Requests Are Blocked by the AVC Engine
When the AVC engine blocks a transaction, the Web Proxy sends a block page to the end user. However, not
all Websites display the block page to the end user; many Websites display dynamic content using JavaScript
instead of a static Web page and are not likely to display the block page. Users are still properly blocked from
downloading malicious data, but they may not always be informed of this by the Website.

When the HTTPS proxy is disabled and Webroot is:

• Enabled - The AVC engine may or may not be launched and return the verdict. The transaction will be
processed according to scanner's verdict.

• Disabled - The AVC engine will be launched and return the verdict. The transaction will be processed
according to AVC's verdict.

Note

Policy Application Control Settings
Controlling applications involves configuring the following elements:

DescriptionOption

A category that contains one or more applications.Application Types

Particular applications within an Application Type.Applications

Particular actions or behaviors that users can do within an application that
administrators can control. Not all applications include behaviors you can
configure.

Application behaviors

You can configure application control settings in Access Policy groups. On the Web Security Manager >
Access Policies page, click theApplications link for the policy group you want to configure.When configuring
applications, you can choose the following actions:

DescriptionOption

This action is a final action. Users are prevented from viewing a webpage and
instead an end-user notification page displays

Block

This action is an intermediary action. The Web Proxy continues comparing the
transaction to the other control settings to determine which final action to apply

Monitor

This action indicates that an application behavior is blocked. For example, when
you block file transfers for a particular instant messaging application, the action
for that application is Restrict.

Restrict

For certain applications, such asMedia and Facebook, you can limit the bandwidth
available for Web traffic. You can limit bandwidth for the application itself, and
for its users.

Bandwidth Limit
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Related Topics

• Range Request Settings, on page 284
• Rules and Guidelines for Configuring Application Control , on page 284

Range Request Settings
When HTTP range requests are disabled and a large file is downloaded over multiple streams, the consolidated
package is scanned. This disables the performance advantages of download-management utilities and
applications that are used to download large objects.

Alternatively, when Range Request Forwarding is enabled (see Configuring Web Proxy Settings, on page
65), you can control how incoming range requests are handled on a per-policy basis. This process is known
as “byte serving” and is a means of bandwidth optimization when requesting large files.

However, enabling range request forwarding can interfere with policy-based Application Visibility and Control
(AVC) efficiency, and can compromise security. Please exercise caution and enable HTTP Range Request
Forwarding only if the advantages outweigh the security implications.

The Range Request Settings are available only when Range Request Forwarding is enabled, and at least one
application is set to Block, Restrict, or Throttle.

Note

Range Request Settings for Policy

• Do not forward range requests—The client sends a request for a particular
range. But, the Web Security Appliance removes the range header from the
request before sending it to the target server. TheWeb Security Appliance then
scans the entire file and sends the range of bytes to the client.

When the client sends the range request for the first time, Web
Security Appliance, expecting subsequent range requests from the
client, sends the entire file. For any successive request from the
same or another client, Web Security Appliance delivers only the
partial content to the client.

Note

• Forward range requests—The client sends a request for a particular range.
The Web Security Appliance sends the same request to the target server and
receives a partial content which is then returned to the client. TheWeb Security
Appliance scans only the partial content for which the scan results may not be
accurate.

Range Request
Settings

You can specify traffic destinations which are exempt from the current forwarding
selection. That is, whenDo not forward range requests is selected, you can specify
destinations for which requests are forwarded. Similarly, when Forward range
requests is selected, you can specify destinations for which requests are not
forwarded.

Exception list

Rules and Guidelines for Configuring Application Control
Consider the following rules and guidelines when configuring application control settings:
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• The supported Application Types, applications, and application behaviors may change between AsyncOS
for Web upgrades, or after AVC engine updates.

• If you enable Safe Search or Site Content Rating, the AVC Engine is tasked with identifying applications
for safe browsing. As one of the criteria, the AVC engine will scan the response body to detect a search
application. As a result, the appliance will not forward range headers.

• In Application Type listings, the summary for each Application Type lists the final actions for its
applications, but does not indicate whether these actions are inherited from the global policy or configured
in the current Access Policy. To learn more about the action for a particular application, expand the
application type.

• In the Global Access Policy, you can set the default action for each Application Type, so new applications
introduced in an AVC engine update automatically inherit the default action.

• You can quickly configure the same action for all applications in an application type by clicking the “edit
all” link for the Application Type in Browse view. However, you can only configure the application
action, not application behavior actions. To configure application behaviors, you must edit the application
individually.

• In Search view, when you sort the table by the action column, the sort order is by the final action. For
example, “Use Global (Block)” comes after “Block” in the sort order.

• Decryption may cause some applications to fail unless the root certificate for signing is installed on the
client.

Related Topics

• Configuring Application Control Settings in an Access Policy Group, on page 285

• Configuring Overall Bandwidth Limits, on page 286

• Viewing AVC Activity, on page 289

Configuring Application Control Settings in an Access Policy Group

Step 1 Choose Web Security Manager > Access Policies.
Step 2 Click the link in the Policies table under the Applications column for the policy group you want to edit.
Step 3 When configuring the Global Access Policy:

a) Define the default action for each Application Type in the Default Actions for Application Types section.
b) You can edit the default actions for each Application Type’s individual members, as a group or individually, in the

Edit Applications Settings section of the page. Editing the default action for individual applications is described in
the following steps.

Step 4 When configuring a user defined Access Policy, choose Define Applications Custom Settings in the Edit Applications
Settings section.

Step 5 In the Application Settings area, choose Browse view or Search view from the drop-down menu:

• Browse view. You can browse Application Types. You can use Browse view to configure all applications of a
particular type at the same time. When an Application Type is collapsed in Browse view, the summary for the
Application Type lists the final actions for its applications; however it does not indicate whether the actions are
inherited from the global policy, or configured in the current Access Policy.
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• Search view.You can search for applications by name. You might use Search view when the total list of applications
is long and you need to quickly find and configure a particular application.

Step 6 Configure the action for each application and application behavior.
Step 7 Configure the bandwidth controls for each applicable application.
Step 8 Submit and Commit Changes.

What to do next

Related Topics

• Controlling Bandwidth, on page 286

Controlling Bandwidth
When both the overall limit and user limit applies to a transaction, the most restrictive option applies. You
can define bandwidth limits for particular URL categories by defining an Identity group for a URL category
and using it in an Access Policy that restricts the bandwidth.

You can define the following bandwidth limits:

Link to TaskDescriptionBandwidth
limit

Configuring Overall Bandwidth
Limits, on page 286

Define an overall limit for all users on the network for the
supported application types. The overall bandwidth limit
affects the traffic between theWeb Security appliance and
web servers. It does not limit traffic served from the web
cache.

Overall

Configuring User Bandwidth
Limits, on page 287

Define a limit for particular users on the network per
application type. User bandwidth limits traffic from web
servers as well as traffic served from the web cache.

User

Defining bandwidth limits only throttles the data going to users. It does not block data based on reaching a
quota. TheWeb Proxy introduces latency into each application transaction to mimic a slower link to the server.

Note

Configuring Overall Bandwidth Limits

Step 1 Choose Web Security Manager > Overall Bandwidth Limits

Step 2 Click Edit Settings.
Step 3 Select the Limit to option.
Step 4 Enter the amount of traffic to limit in either Megabits per second (Mbps) or kilobits per second (kbps).

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
286

Managing Access to Web Applications
Controlling Bandwidth



Step 5 Submit and Commit Changes.

Configuring User Bandwidth Limits
You can define user bandwidth limits by configuring bandwidth control settings on the Applications Visibility
and Control page of Access Policies. You can define the following types of bandwidth controls for users in
Access Policies:

Link to taskDescriptionOption

Configuring the Default
Bandwidth Limit for an
Application Type, on page
287

In the Global Access Policy, you can define
the default bandwidth limit for all applications
of an application type.

Default bandwidth limit for
an application type

Overriding the Default
Bandwidth Limit for an
Application Type, on page
287

In a user defined Access Policy, you can
override the default bandwidth limit for the
application type defined in the Global Access
Policy.

Bandwidth limit for an
application type

Configuring Bandwidth
Controls for an Application,
on page 288

In a user defined or Global Access Policy, you
can choose to apply the application type
bandwidth limit or no limit (exempt the
application type limit).

Bandwidth limit for an
application

Configuring the Default Bandwidth Limit for an Application Type

Step 1 Choose Web Security Manager > Access Policies.
Step 2 Click the link in the policies table under the Applications column for the Global Access Policy.
Step 3 In the Default Actions for Application Types section, click the link next to “Bandwidth Limit” for the application type

you want to edit.
Step 4 Select Set Bandwidth Limit and enter the amount of traffic to limit in either Megabits per second (Mbps) or kilobits per

second (kbps).
Step 5 Click Apply.
Step 6 Submit and Commit Changes.

Overriding the Default Bandwidth Limit for an Application Type
You can override the default bandwidth limit defined at the Global Access Policy group in the user defined
Access Policies. You can only do this in Browse view.

Step 1 Choose Web Security Manager > Access Policies.
Step 2 Click the link in the policies table under the Applications column for the user defined policy group you want to edit.
Step 3 Choose Define Applications Custom Settings in the Edit Applications Settings section.
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Step 4 Click the link next to “Bandwidth Limit” for the application type you want to edit.
Step 5 To choose a different bandwidth limit value, select Set Bandwidth Limit and enter the amount of traffic to limit in either

Megabits per second (Mbps) or kilobits per second (kbps). To specify no bandwidth limit, select No Bandwidth Limit
for Application Type.

Step 6 Click Apply.
Step 7 Submit and Commit Changes.

Configuring Bandwidth Controls for an Application

Step 1 Choose Web Security Manager > Access Policies.
Step 2 Click the link in the policies table under the Applications column for the policy group you want to edit.
Step 3 Expand the application type that contains the application you want to define.
Step 4 Click the link for the application you want to configure.
Step 5 Select Monitor, and then choose to use either the bandwidth limit defined for the application type or no limit.

The bandwidth limit setting is not applicable when the application is blocked or when no bandwidth limit is
defined for the application type.

Note

Step 6 Click Done.
Step 7 Submit and Commit Changes.

Controlling Instant Messaging Traffic
You can block or monitor the IM traffic, and depending on the IM service, you can block particular activities
(also known as application behaviors) in an IM session.

Step 1 Choose Web Security Manager > Access Policies.
Step 2 Click the link in the policies table under the Applications column for the policy group you want to edit.
Step 3 Click Define Applications Custom Setting.
Step 4 Expand the Instant Messaging application type.
Step 5 Click the link next to the IM application you want to configure.
Step 6 To block all traffic for this IM application, select Block.
Step 7 To monitor the IM application, but block particular activities within the application, select Monitor, and then select the

application behavior to Block.
Step 8 Click Done.
Step 9 Submit and Commit Changes.
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Viewing AVC Activity
TheReporting > Application Visibility page displays information about the top applications and application
types used. It also displays the top applications and application types blocked.

AVC Information in Access Log File
The access log file records the information returned by the Application Visibility and Control engine for each
transaction. The scanning verdict information section in the access logs includes the fields listed below:

Custom Field in W3C LogsCustom Field in Access LogsDescription

x-avc-app%XOApplication name

x-avc-type%XuApplication type

x-avc-behavior%XbApplication behavior
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C H A P T E R 17
Prevent Loss of Sensitive Data

This chapter contains the following sections:

• Overview of Prevent Loss of Sensitive Data, on page 291
• Managing Upload Requests, on page 293
• Managing Upload Requests on an External DLP System, on page 293
• Evaluating Data Security and External DLP Policy Group Membership, on page 294
• Creating Data Security and External DLP Policies, on page 295
• Managing Settings for Upload Requests, on page 297
• Defining External DLP Systems, on page 298
• Controlling Upload Requests Using External DLP Policies, on page 301
• Logging of Data Loss Prevention Scanning , on page 301

Overview of Prevent Loss of Sensitive Data
The Web Security appliance secures your data by providing the following capabilities:

DescriptionOption

The Cisco Data Security filters on the Web Security appliance evaluate
data leaving the network over HTTP, HTTPS and FTP.

Cisco Data Security filters

The Web Security appliance integrates with leading third party
content-aware DLP systems that identify and protect sensitive data. The
Web Proxy uses the Internet Content Adaptation Protocol (ICAP) which
allows proxy servers to offload content scanning to external systems

Third-party data loss prevention
(DLP) integration

When the Web Proxy receives an upload request, it compares the request to the Data Security and External
DLP Policy groups to determine which policy group to apply. If both types of policies are configured, it
compares the request to Cisco Data Security policies before external DLP policies. After it assigns the request
to a policy group, it compares the request to the policy group’s configured control settings to determine what
to do with the request. How you configure the appliance to handle upload requests depends on the policy
group type.
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Upload requests that try to upload files with a size of zero (0) bytes are not evaluated against Cisco Data
Security or External DLP policies.

Note

To restrict and control data that is leaving the network, you can perform the following tasks:

Link to TaskTask

Managing Upload Requests, on page 293Create Cisco Data Security policies

Managing Upload Requests on an External DLP System,
on page 293

Create External DLP policies

Creating Data Security and External DLP Policies, on
page 295

Create Data Security and External DLP policies

Managing Settings for Upload Requests, on page 297Control Upload Requests using Cisco Data
Security policies

Controlling Upload Requests Using External DLP
Policies, on page 301

Control Upload Requests Using External DLP
policies

Bypassing Upload Requests Below a Minimum Size
To help reduce the number of upload requests recorded in the log files, you can define a minimum request
body size, below which upload requests are not scanned by the Cisco Data Security Filters or the external
DLP server.

To do this, use the following CLI commands:

• datasecurityconfig. Applies to the Cisco Data Security filters.
• externaldlpconfig. Applies to the configured external DLP servers.

The default minimum request body size is 4 KB (4096 bytes) for both CLI commands. Valid values are 1 to
64 KB. The size you specify applies to the entire size of the upload request body.

All chunk encoded uploads and all native FTP transactions are scanned by the Cisco Data Security filters or
external DLP servers when enabled. However, they can still be bypassed based on a custom URL category.

Note

User Experience When Requests Are Blocked As Sensitive Data
When the Cisco Data Security filters or an external DLP server blocks an upload request, it provides a block
page that the Web Proxy sends to the end user. Not all websites display the block page to the end user. For
example, some Web 2.0 websites display dynamic content using javascript instead of a static Web page and
are not likely to display the block page. Users are still properly blocked from performing data security violations,
but they may not always be informed of this by the website.
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Managing Upload Requests
Before you begin

Go to Security Services > Data Security Filters to enable the Cisco Data Security filters.

Create and configure Data Security Policy groups.

Cisco Data Security policies use URL filtering, Web reputation, and upload content information when evaluating the
upload request. You configure each of these security components to determine whether or not to block the upload request.

When the Web Proxy compares an upload request to the control settings, it evaluates the settings in order. Each control
setting can be configured to perform one of the following actions for Cisco Data Security policies:

DescriptionAction

The Web Proxy does not permit the connection and instead displays an end user notification page
explaining the reason for the block.

Block

The Web Proxy bypasses the rest of the Data Security Policy security service scanning and then
evaluates the request against the Access Policies before taking a final action.

For Cisco Data Security policies, Allow bypasses the rest of data security scanning, but does not bypass
External DLP or Access Policy scanning. The final action the Web Proxy takes on the request is
determined by the applicable Access Policy (or an applicable external DLP Policy that may block the
request).

Allow

The Web Proxy continues comparing the transaction to the other Data Security Policy group control
settings to determine whether to block the transaction or evaluate it against the Access Policies.

Monitor

For Cisco Data Security policies, only the Block action is a final action that the Web Proxy takes on a client request. The
Monitor and Allow actions are intermediary actions. In both cases, the Web Proxy evaluates the transaction against the
External DLP Policies (if configured) and Access Policies. The Web Proxy determines which final action to apply based
on the Access Policy group control settings (or an applicable external DLP Policy that may block the request).

What to do next

Related Topics

• Managing Upload Requests on an External DLP System, on page 293
• Managing Settings for Upload Requests, on page 297

Managing Upload Requests on an External DLP System
To configure the Web Security appliance to handle upload requests on an external DLP system, perform the
following tasks:
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Step 1 Choose Network > External DLP Servers. Define an external DLP system. To pass an upload request to an external
DLP system for scanning, you must define at least one ICAP-compliant DLP system on the Web Security appliance.

Step 2 Create and configure External DLP Policy groups. After an external DLP system is defined, you create and configure
External DLP Policy groups to determine which upload requests to send to the DLP system for scanning.

Step 3 When an upload request matches an External DLP Policy, the Web Proxy sends the upload request to the DLP system
using the Internet Content Adaptation Protocol (ICAP) for scanning. The DLP system scans the request body content
and returns a block or allow verdict to the Web Proxy. The allow verdict is similar to the Allow action for Cisco Data
Security policies in that the upload request will be compared to the Access Policies. The final action the Web Proxy takes
on the request is determined by the applicable Access Policy.

What to do next

Related Topics

• Controlling Upload Requests Using External DLP Policies, on page 301
• Defining External DLP Systems, on page 298

Evaluating Data Security and External DLP Policy Group
Membership

Each client request is assigned to an Identity and then is evaluated against the other policy types to determine
which policy group it belongs for each type. The Web Proxy evaluates upload requests against the Data
Security and External DLP policies. The Web Proxy applies the configured policy control settings to a client
request based on the client request’s policy group membership.

Matching Client Requests to Data Security and External DLP Policy Groups
To determine the policy group that a client request matches, the Web Proxy follows a specific process for
matching the group membership criteria. It considers the following factors for group membership:

• Identity. Each client request either matches an Identification Profile, fails authentication and is granted
guest access, or fails authentication and gets terminated.

• Authorized users. If the assigned Identification Profile requires authentication, the user must be in the
list of authorized users in the Data Security or External DLP Policy group to match the policy group.
The list of authorized users can be any of the specified groups or users or can be guest users if the
Identification Profile allows guest access.

• Advanced options. You can configure several advanced options for Data Security and External DLP
Policy group membership. Some options (such as proxy port and URL category) can also be defined
within the Identity. When an advanced option is configured in the Identity, it is not configurable in the
Data Security or External DLP Policy group level.

The information in this section gives an overview of how the Web Proxy matches upload requests to both
Data Security and External DLP Policy groups.

The Web Proxy sequentially reads through each policy group in the policies table. It compares the upload
request status to the membership criteria of the first policy group. If they match, the Web Proxy applies the
policy settings of that policy group.
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If they do not match, the Web Proxy compares the upload request to the next policy group. It continues this
process until it matches the upload request to a user defined policy group. If it does not match a user defined
policy group, it matches the global policy group. When the Web Proxy matches the upload request to a policy
group or the global policy group, it applies the policy settings of that policy group.

Creating Data Security and External DLP Policies
You can create Data Security and External DLP Policy groups based on combinations of several criteria, such
as one or more Identification Profiles or the URL category of the destination site. You must define at least
one criterion for policy group membership. When you define multiple criteria, the upload request must meet
all criteria to match the policy group. However, the upload request needs to match only one of the configured
Identification Profiles.

Step 1 Choose Web Security Manager > Cisco Data Security (for Defining Data Security Policy group membership) or
Web Security Manager > External Data Loss Prevention (for Defining External DLP Policy group membership).

Step 2 Click Add Policy.
Step 3 In the Policy Name field, enter a name for the policy group, and in the Description field (optional) add a description.

Each policy group name must be unique and only contain alphanumeric characters or the space character.Note

Step 4 In the Insert Above Policy field, choose where in the policies table to place the policy group.

When configuring multiple policy groups you must specify a logical order for each group. Order your policy groups
to ensure that correct matching occurs.

Step 5 In the Identities and Users section, choose one or more Identification Profile groups to apply to this policy group.
Step 6 (Optional) Expand the Advanced section to define additional membership requirements.
Step 7 To define policy groupmembership by any of the advanced options, click the link for the advanced option and configure

the option on the page that appears.

DescriptionAdvanced Option

Choose whether or not to define policy group membership by the protocol used in the client
request. Select the protocols to include.

“All others” means any protocol not listed above this option.

When the HTTPS Proxy is enabled, only Decryption Policies apply to HTTPS
transactions. You cannot define policy membership by the HTTPS protocol for
Access, Routing, Outbound Malware Scanning, Data Security, or External DLP
Policies.

Note

Protocols
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DescriptionAdvanced Option

Choose whether or not to define policy group membership by the proxy port used to access
the Web Proxy. Enter one or more port numbers in the Proxy Ports field. Separate multiple
ports with commas.

For explicit forward connections, this is the port configured in the browser. For transparent
connections, this is the same as the destination port. You might want to define policy group
membership on the proxy port if you have one set of clients configured to explicitly forward
requests on one port, and another set of clients configured to explicitly forward requests on a
different port.

Cisco recommends only defining policy group membership by the proxy port when the
appliance is deployed in explicit forward mode, or when clients explicitly forward requests to
the appliance. If you define policy group membership by the proxy port when client requests
are transparently redirected to the appliance, some requests might be denied.

If the Identity associated with this policy group defines Identity membership by
this advanced setting, the setting is not configurable at the non-Identity policy group
level.

Note

Proxy Ports

Choose whether or not to define policy group membership by subnet or other addresses.

You can choose to use the addresses that may be defined with the associated Identification
Profile, or you can enter specific addresses here.

If the Identification Profile associated with this policy group defines its membership
by addresses, then in this policy group you must enter addresses that are a subset
of the addresses defined in the Identification Profile. Adding addresses in the policy
group further narrows down the list of transactions that match this policy group.

Note

Subnets

Choose whether or not to define policy group membership by URL categories. Select the user
defined or predefined URL categories.

If the Identity associated with this policy group defines Identity membership by
this advanced setting, the setting is not configurable at the non-Identity policy group
level.

Note

URL Categories

Choose whether to define policy group membership by the user agents (client applications
such as updaters andWeb browsers) used in the client request. You can select some commonly
defined user agents, or define your own using regular expressions. Specify whether membership
definition includes only the selected user agents, or specifically excludes the selected user
agents.

If the Identification Profile associated with this policy group defines Identification
Profile membership by this advanced setting, the setting is not configurable at the
non-Identification Profile policy group level.

Note

User Agents

Choose whether or not to define policy group membership by user location, either remote or
local.

This option only appears when the Secure Mobility is enabled.

User Location

Step 8 Submit your changes.
Step 9 If you are creating a Data Security Policy group, configure its control settings to define how the Web Proxy handles

upload requests.
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The new Data Security Policy group automatically inherits global policy group settings until you configure options for
each control setting.

If you are creating an External DLP Policy group, configure its control settings to define how the Web Proxy handles
upload requests.

The new External DLP Policy group automatically inherits global policy group settings until you configure custom
settings.

Step 10 Submit and Commit Changes.

What to do next

Related Topics

• Evaluating Data Security and External DLP Policy Group Membership, on page 294
• Matching Client Requests to Data Security and External DLP Policy Groups, on page 294
• Managing Settings for Upload Requests, on page 297
• Controlling Upload Requests Using External DLP Policies, on page 301

Managing Settings for Upload Requests
Each upload request is assigned to a Data Security Policy group and inherits the control settings of that policy
group. The control settings of the Data Security Policy group determine whether the appliance blocks the
connection or evaluates it against the Access Polices.

Configure control settings for Data Security Policy groups on theWeb SecurityManager > Cisco Data Security
page.

You can configure the following settings to determine what action to take on upload requests:

LinkOption

URL Categories, on page 297URL Categories

Web Reputation, on page 298Web
Reputation

Content Blocking, on page 298Content

After a Data Security Policy group is assigned to an upload request, the control settings for the policy group
are evaluated to determine whether to block the request or evaluate it against the Access Policies.

URL Categories
AsyncOS forWeb allows you to configure how the appliance handles a transaction based on the URL category
of a particular request. Using a predefined category list, you can choose to monitor or block content by category.
You can also create custom URL categories and choose to allow, monitor, or block traffic for a website in the
custom category.
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Web Reputation
The Web Reputation setting inherits the global setting. To customize web reputation filtering for a particular
policy group, you can use the Web Reputation Settings pull-down menu to customize web reputation score
thresholds.

Only negative and zero values can be configured for web reputation threshold settings for Cisco Data Security
policies. By definition, all positive scores are monitored.

Content Blocking
You can use the settings on the Cisco Data Security > Content page to configure the Web Proxy to block data
uploads based on the following file characteristics:

• File size. You can specify the maximum upload size allowed. All uploads with sizes equal to or greater
than the specified maximum are blocked. You can specify different maximum file sizes for HTTP/HTTPS
and native FTP requests.

When the upload request size is greater than both the maximum upload size and the maximum scan size
(configured in the “DVS Engine Object Scanning Limits” field on Security Services > Anti-Malware
page), the upload request is still blocked, but the entry in the data security logs does not record the file
name and content type. The entry in the access logs is unchanged.

• File type. You can block predefined file types or custom MIME types you enter. When you block a
predefined file type, you can block all files of that type or files greater than a specified size. When you
block a file type by size, the maximum file size you can specify is the same as the value for the “DVS
Engine Object Scanning Limits” field on Security Services > Anti-Malware page. By default, that value
is 32 MB.

Cisco Data Security filters do not inspect the contents of archived files when blocking by file type.
Archived files can be blocked by its file type or file name, not according to its contents.

For some groups of MIME types, blocking one type blocks all MIME types in
the group. For example, blocking application/x-java-applet blocks all javaMIME
types, such as application/java and application/javascript.

Note

• File name. You can block files with specified names. You can use text as a literal string or a regular
expression for specifying file names to block.

Only enter file names with 8-bit ASCII characters. The Web Proxy only matches
file names with 8-bit ASCII characters.

Note

Defining External DLP Systems
TheWeb Security appliance can integrate with multiple external DLP servers from the same vendor by defining
multiple DLP servers in the appliance. You can define the load-balancing technique theWeb Proxy uses when
contacting the DLP systems. This is useful when you define multiple DLP systems. See SSL Configuration
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, on page 447for information about specifying the protocols used to secure communications with external DLP
servers.

Verify the external DLP server does not send the Web Proxy modified content. AsyncOS for Web only
supports the ability to block or allow upload requests. It does not support uploading content modified by an
external DLP server.

Note

Configuring External DLP Servers

Step 1 Choose Network > External DLP Servers.
Step 2 Click Edit Settings.

DescriptionSetting

Choose either:

• ICAP – DLP client/server ICAP communications are not encrypted.
• Secure ICAP – DLP client/server ICAP communications are via an encrypted tunnel.
Additional related options appear.

Protocol for External
DLP Servers

Enter the following information to access an ICAP compliant DLP system:

• Server address and Port – The hostname or IP address and TCP port for accessing the
DLP system.

• Reconnection attempts – The number of times the Web Proxy tries to connect to the DLP
system before failing.

• Service URL – The ICAP query URL specific to the particular DLP server. TheWeb Proxy
includes what you enter here in the ICAP request it sends to the external DLP server. The
URL must start with the ICAP protocol: icap://

• Certificate (optional) – The certificate provided to secure each External DLP Server
connection can be Certificate Authority (CA)-signed or self-signed. Obtain the certificate
from the specified server, and then upload it to the appliance:

• Browse to and select the certificate file, and then click Upload File.

This single file must contain both the client certificate and private key in
unencrypted form.

Note

• Use this certificate for all DLP servers using Secure ICAP – Check this box to use
the same certificate for all External DLP Servers you define here. Leave the option
unchecked to enter a different certificate for each server.

• Start Test – You can test the connection between theWeb Security appliance and the defined
external DLP server(s) by clicking Start Test.

External DLP Servers
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DescriptionSetting

If multiple DLP servers are defined, select which load-balancing technique the Web Proxy uses
to distribute upload requests to different DLP servers. You can choose the following load
balancing techniques:

• None (failover). The Web Proxy directs upload requests to one DLP server. It tries to
connect to the DLP servers in the order they are listed. If one DLP server cannot be reached,
the Web Proxy attempts to connect to the next one in the list.

• Fewest connections. TheWeb Proxy keeps track of how many active requests are with the
different DLP servers and it directs the upload request to the DLP server currently servicing
the fewest number of connections.

• Hash based. TheWeb Proxy uses a hash function to distribute requests to the DLP servers.
The hash function uses the proxy ID and URL as inputs so that requests for the same URL
are always directed to the same DLP server.

• Round robin. The Web Proxy cycles upload requests equally among all DLP servers in
the listed order.

Load Balancing

Enter how long the Web Proxy waits for a response from the DLP server. When this time is
exceeded, the ICAP request has failed and the upload request is either blocked or allowed,
depending on the Failure Handling setting.

Default is 60 seconds.

Service Request
Timeout

Specifies themaximumnumber of simultaneous ICAP request connections from theWeb Security
appliance to each configured external DLP server. The Failure Handling setting on this page
applies to any request which exceeds this limit.

Default is 25.

Maximum
Simultaneous
Connections

Choose whether upload requests are blocked or allowed (passed to Access Policies for evaluation)
when the DLP server fails to provide a timely response.

Default is allow (“Permit all data transfers to proceed without scanning”).

Failure Handling

Browse to and select the trusted-root certificate for the certificate(s) provided with the External
DLP Servers, and then click Upload File. See CertificateManagement, on page 448for additional
information.

Trusted Root
Certificate

Specify how various invalid certificates are handled: Drop or Monitor.Invalid Certificate
Options

This section displays all DLP server certificates currently available on the appliance.Server Certificates

Step 3 (Optional) You can add another DLP server by clicking Add Row and entering the DLP Server information in the new
fields provided.

Step 4 Submit and Commit Changes.
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Controlling Upload Requests Using External DLP Policies
Once the Web Proxy receives the upload request headers, it has the information necessary to decide if the
request should go to the external DLP system for scanning. The DLP system scans the request and returns a
verdict to the Web Proxy, either block or monitor (evaluate the request against the Access Policies).

Step 1 Choose Web Security Manager > External Data Loss Prevention.
Step 2 Click the link under the Destinations column for the policy group you want to configure.
Step 3 Under the Edit Destination Settings section, choose “Define Destinations Scanning Custom Settings.”
Step 4 In the Destination to scan section, choose one of the following options:

• Do not scan any uploads. No upload requests are sent to the configured DLP system(s) for scanning. All upload
requests are evaluated against the Access Policies.

• Scan all uploads. All upload requests are sent to the configured DLP system(s) for scanning. The upload request
is blocked or evaluated against the Access Policies depending on the DLP system scanning verdict.

• Scan uploads except to specified custom and external URL categories. Upload requests that fall in specific
custom URL categories are excluded from DLP scanning policies. Click Edit custom categories list to select the
URL categories to scan.

Step 5 Submit and Commit Changes.

Logging of Data Loss Prevention Scanning
The access logs indicate whether or not an upload request was scanned by either the Cisco Data Security
filters or an external DLP server. The access log entries include a field for the Cisco Data Security scan verdict
and another field for the External DLP scan verdict based.

In addition to the access logs, theWeb Security appliance provides the following log file types to troubleshoot
Cisco Data Security and External DLP Policies:

• Data Security Logs. Records client history for upload requests that are evaluated by the Cisco Data
Security filters.

• Data Security Module Logs. Records messages related to the Cisco Data Security filters.
• Default Proxy Logs. In addition recording errors related to theWeb Proxy, the default proxy logs include
messages related to connecting to external DLP servers. This allows you to troubleshoot connectivity or
integration problems with external DLP servers.

The following text illustrates a sample Data Security Log entry:

Mon Mar 30 03:02:13 2009 Info: 303 10.1.1.1 - -
<<bar,text/plain,5120><foo,text/plain,5120>>
BLOCK_WEBCAT_IDS-allowall-DefaultGroup-DefaultGroup-NONE-DefaultRouting ns server.com nc

DescriptionField Value

Timestamp and trace level
Mon Mar 30 03:02:13 2009 Info:
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DescriptionField Value

Transaction ID
303

Source IP address
10.1.1.1

User name
-

Authorized group names
-

File name, file type, file size for each file uploaded at once

This field does not include text/plain files that are less than
the configured minimum request body size, the default of
which is 4096 bytes.

Note
<<bar,text/plain,5120><foo,text/
plain,5120>>

Cisco Data Security policy and action
BLOCK_WEBCAT_IDS-allowall-
DefaultGroup-DefaultGroup-NONE-
DefaultRouting

Web reputation score
ns

Outgoing URL
server.com

URL category
nc

To learn when data transfer, such as a POST request, to a site was blocked by the external DLP server, search
for the IP address or hostname of the DLP server in the access logs.

Note
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C H A P T E R 18
Notify End-Users of Proxy Actions

This chapter contains the following sections:

• End-User Notifications Overview, on page 303
• Configuring General Settings for Notification Pages, on page 304
• End-User Acknowledgment Page, on page 304
• End-User Notification Pages , on page 307
• Configuring the End-User URL Filtering Warning Page, on page 311
• Configuring FTP Notification Messages, on page 312
• Custom Messages on Notification Pages, on page 312
• Editing Notification Page HTML Files Directly , on page 314
• Notification Page Types, on page 318

End-User Notifications Overview
You can configure the following types of notifications for end users:

Further informationDescriptionOption

End-User Acknowledgment Page,
on page 304

Informs end users that their web activity is being
filtered and monitored. An end-user
acknowledgment page is displayed when a user
first accesses a browser after a certain period of
time.

End-user
acknowledgement
page

End-User Notification Pages , on
page 307

Page shown to end users when access to a
particular page is blocked, specific to the reason
for blocking it.

End-user
notification pages

Configuring the End-User URL
Filtering Warning Page, on page
311

Warns end users that a site they are accessing does
not meet your organization’s acceptable use
policies, and allows them to continue if they
choose.

End-user URL
filtering warning
page

Configuring FTP Notification
Messages, on page 312.

Gives end users the reason a native FTP
transaction was blocked.

FTP notification
messages
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Further informationDescriptionOption

Configure these settings on the
Security Services > End User
Notification page, Time and
Volume Quotas Expiry Warning
Page section.

See also Time Ranges and Quotas,
on page 214.

Notifies end users when their access is blocked
because they have reached the configured data
volume or time limit.

Time and Volume
Quotas Expiry
Warning Page

Configuring General Settings for Notification Pages
Specify display languages and logo for notification pages. Restrictions are described in this procedure.

Step 1 Select Security Services > End-User Notification.
Step 2 Click Edit Settings.
Step 3 In the General Settings section, select the language the Web Proxy should use when displaying notification pages.

• The HTTP language setting applies to all HTTP notification pages (acknowledgment, on-box end-user, customized
end-user, and end-user URL filtering warning).

• The FTP language applies to all FTP notification messages.

Step 4 Choose whether or not to use a logo on each notification page. You can specify the Cisco logo or any graphic file referenced
at the URL you enter in the Use Custom Logo field.

This setting applies to all HTTP notification pages served over IPv4. AsyncOS does not support images over IPv6.

Step 5 Submit and Commit Changes.

What to do next

Related Topics

• Caveats for URLs and Logos in Notification Pages , on page 313

End-User Acknowledgment Page
You can configure the Web Security appliance to inform users that it is filtering and monitoring their web
activity. When configured, the appliance displays an end-user acknowledgment page for every user accessing
the web using HTTP or HTTPS. It displays the end-user acknowledgment page when a user tries to access a
website for the first time, or after a configured time interval.

The Web Proxy tracks users by username if authentication has made a username available. If no user name
is available, you can choose how to track users, either by IP address or web browser session cookie.
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Native FTP transactions are exempt from the end-user acknowledgment page.Note

• Access HTTPS and FTP Sites with the End-User Acknowledgment Page, on page 305
• About the End-user Acknowledgment Page, on page 305
• Configuring the End-User Acknowledgment Page, on page 306

Access HTTPS and FTP Sites with the End-User Acknowledgment Page
The end-user acknowledgment page works because it displays an HTML page to the end user that forces them
to click an acceptable use policy agreement. After users click the link, the Web Proxy redirects clients to the
originally requested website. It keeps track of when users accepted the end-user acknowledgment page using
a surrogate (either by IP address or web browser session cookie) if no username is available for the user.

• HTTPS. The Web Proxy tracks whether the user has acknowledged the end-user acknowledgment page
with a cookie, but it cannot obtain the cookie unless it decrypts the transaction. You can choose to either
bypass (pass through) or drop HTTPS requests when the end-user acknowledgment page is enabled and
tracks users using session cookies. Do this using the advancedproxyconfig > EUN CLI command, and
choose bypass for the “Action to be taken for HTTPS requests with Session based EUA (“bypass” or
“drop”).” command.

• FTP over HTTP. Web browsers never send cookies for FTP over HTTP transactions, so the Web Proxy
cannot obtain the cookie. To work around this, you can exempt FTP over HTTP transactions from
requiring the end-user acknowledgment page. Do this by creating a custom URL category using “ftp://”
as the regular expression (without the quotes) and defining and Identity policy that exempts users from
the end-user acknowledgment page for this custom URL category.

About the End-user Acknowledgment Page
• When a user is tracked by IP address, the appliance uses the shortest value for maximum time interval
and maximum IP address idle timeout to determine when to display the end-user acknowledgment page
again.

• When a user is tracked using a session cookie, the Web Proxy displays the end-user acknowledgment
page again if the user closes and then reopens their web browser or opens a second web browser
application.

• Using a session cookie to track users when the client accesses HTTPS sites or FTP servers using FTP
over HTTP does not work.

• When the appliance is deployed in explicit forward mode and a user goes to an HTTPS site, the end-user
acknowledgment page includes only the domain name in the link that redirects the user to the originally
requested URL. If the originally requested URL contains text after the domain name, that text is truncated.

• When the end-user acknowledgment page is displayed to a user, the access log entry for that transaction
shows OTHER as the ACL decision tag. This is because the originally requested URL was blocked, and
instead the user was shown the end-user acknowledgment page.
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Configuring the End-User Acknowledgment Page

Before you begin

• To configure the display language and customize the displayed logo, see Configuring General Settings
for Notification Pages, on page 304.

• If you will customize the message shown to end users, see Custom Messages on Notification Pages, on
page 312. If you require more customization than the CustomMessage box allows, see Editing Notification
Page HTML Files Directly , on page 314.

You can enable and configure the end-user acknowledgment page in the web interface or the command line
interface. When you configure the end-user acknowledgment page in the web interface, you can include a
custom message that appears on each page.

In the CLI, use advancedproxyconfig > eun.

Step 1 Choose Security Services > End-User Notification.
Step 2 Click Edit Settings.
Step 3 Enable the “Require end-user to click through acknowledgment page” field.
Step 4 Enter options:

DescriptionSetting

The Time Between Acknowledgments determines how often the Web Proxy displays the
end-user acknowledgment page for each user. This setting applies to users tracked by
username and users tracked by IP address or session cookie. You can specify any value
from 30 to 2678400 seconds (one month). Default is one day (86400 seconds).

When the Time Between Acknowledgments changes and is committed, the Web Proxy
uses the new value even for users who have already acknowledged the Web Proxy.

Time Between
Acknowledgements

The Inactivity Timeout determines how long a user tracked and acknowledged by IP
address or session cookie (unauthenticated users only) can be idle before the user is no
longer considered to have agreed to the acceptable use policy. You can specify any value
from 30 to 2678400 seconds (one month). Default is four hours (14400 seconds).

Inactivity Timeout
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DescriptionSetting

Determines which method the Web Proxy uses to track the user:

• IP Address. TheWeb Proxy allows the user at that IP address to use any web browser
or non-browser HTTP process to access the web once the user clicks the link on the
end-user acknowledgment page. Tracking the user by IP address allows the user to
access the web until the Web Proxy displays a new end-user acknowledgment page
due to inactivity or the configured time interval for new acknowledgments. Unlike
tracking by a session cookie, tracking by IP address allows the user to open upmultiple
web browser applications and not have to agree to the end-user acknowledgment
unless the configured time interval has expired.

When IP address is configured and the user is authenticated, the Web Proxy
tracks users by username instead of IP address.

Note

• Session Cookie. The Web Proxy sends the user’s web browser a cookie when the
user clicks the link on the end-user acknowledgment page and uses the cookie to track
their session. Users can continue to access the web using their web browser until the
Time Between Acknowledgments value expires, they have been inactive longer than
the allotted time, or they close their web browser.

If the user using a non-browser HTTP client application, they must be able to click
the link on the end-user acknowledgment page to access the web. If the user opens a
second web browser application, the user must go through the end-user
acknowledgment process again in order for the Web Proxy to send a session cookie
to the second web browser.

Using a session cookie to track users when the client accesses HTTPS sites or
FTP servers using FTP over HTTP is not supported.

Note

Surrogate Type

Customize the text that appears on every end-user acknowledgment page. You can include
some simple HTML tags to format the text.

You can only include a custom message when you configure the end-user
acknowledgment page in the web interface, versus the CLI.

Note

See also Custom Messages on Notification Pages, on page 312.

Custom message

Step 5 (Optional) Click Preview Acknowledgment Page Customization to view the current end-user acknowledgment page
in a separate browser window.

If the notification HTML files have been edited, this preview functionality is not available.Note

Step 6 Submit and Commit Changes.

End-User Notification Pages
When a policy blocks a user from a website, you can configure the appliance to notify the user why it blocked
the URL request. There are several ways to achieve this:
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SeeTo

Configuring On-Box End-User Notification
Pages, on page 308

Display predefined, customizable pages that are hosted
on the Web Security appliance.

Off-Box End-User Notification Pages , on page
309

Redirect the user to HTTP end-user notification pages at
a specific URL.

Configuring On-Box End-User Notification Pages

Before you begin

• To configure the display language and customize the displayed logo, see Configuring General Settings
for Notification Pages, on page 304.

• If you will customize the message displayed using on-box notifications, review the topics under Custom
Messages on Notification Pages, on page 312. If you require more customization than the CustomMessage
box allows, see Editing Notification Page HTML Files Directly , on page 314.

On-box pages are predefined, customizable notification pages residing on the appliance.

Step 1 Security Services > End-User Notification.
Step 2 Click Edit Settings.
Step 3 From the Notification Type field, choose Use On Box End User Notification.
Step 4 Configure the on-box end-user notification page settings.

DescriptionSetting

Include any additional text required on each notification page. When you enter a custom
message, AsyncOS places the message before the last sentence on the notification page which
includes the contact information.

Custom Message

Customize the contact information listed on each notification page.

AsyncOS displays the contact information sentence as the last sentence on a page, before
providing notification codes that users can provide to the network administrator.

Contact Information

When enabled, users can report misclassified URLs to Cisco. An additional button appears
on the on-box end-user notification pages for sites blocked due to suspected malware or URL
filters. This button allows the user to report when they believe the page has been misclassified.
It does not appear for pages blocked due to other policy settings.

Note • Youmust enable SensorBaseNetwork Participation. See Enabling Participation
in The Cisco SensorBase Network, on page 8 for more information.

• You must have a valid Cisco account linked to the serial number/s of your
appliance/s.

End-User
Misclassification
Reporting

Step 5 (Optional) Click Preview Notification Page Customization link to view the current end-user notification page in a
separate browser window.
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If the notification HTML files have been edited, this preview functionality is not available.Note

Step 6 Submit and Commit Changes.

Off-Box End-User Notification Pages
TheWeb Proxy can be configured to redirect all HTTP end-user notification pages to a specific URL that you
specify.

• Displaying the Correct Off-Box Page Based on the Reason for Blocking Access , on page 309
• URL Criteria for Off-Box Notification Pages , on page 309
• Off-Box End-User Notification Page Parameters, on page 310
• Redirecting End-User Notification Pages to a Custom URL (Off-Box) , on page 311

Displaying the Correct Off-Box Page Based on the Reason for Blocking Access
By default, AsyncOS redirects all blocked websites to the URL regardless of the reason why it blocked the
original page. However, AsyncOS also passes parameters as a query string appended to the redirect URL so
you can ensure that the user sees a unique page explaining the reason for the block. For more information on
the included parameters, see Off-Box End-User Notification Page Parameters, on page 310.

When you want the user to view a different page for each reason for a blocked website, construct a CGI script
on the web server that can parse the query string in the redirect URL. Then the server can perform a second
redirect to an appropriate page.

URL Criteria for Off-Box Notification Pages
• You can use any HTTP or HTTPS URL.
• The URL may specify a specific port number.
• The URL may not have any arguments after the question mark.
• The URL must contain a well-formed hostname.

For example, if you have the following URL entered in the Redirect to Custom URL field:
http://www.example.com/eun.policy.html

And you have the following access log entry:

1182468145.492 1 172.17.0.8 TCP_DENIED/403 3146 GET http://www.espn.com/index.html HTTP/1.1
- NONE/- - BLOCK_WEBCAT-DefaultGroup-DefaultGroup-NONE-NONE-DefaultRouting
<IW_sprt,-,-,-,-,-,-,-,-,-,-,-,-,-,-,IW_sprt,-> -

Then AsyncOS creates the following redirected URL:

http://www.example.com/eun.policy.html?Time=21/Jun/
2007:23:22:25%20%2B0000&ID=0000000004&Client_IP=172.17.0.8&User=-
&Site=www.espn.com&URI=index.html&Status_Code=403&Decision_Tag=
BLOCK_WEBCAT-DefaultGroup-DefaultGroup-NONE-NONE-DefaultRouting
&URL_Cat=Sports%20and%20Recreation&WBRS=-&DVS_Verdict=-&
DVS_ThreatName=-&Reauth_URL=-

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
309

Notify End-Users of Proxy Actions
Off-Box End-User Notification Pages



Off-Box End-User Notification Page Parameters
AsyncOS passes the parameters to the web server as standard URL Parameters in the HTTP GET request. It
uses the following format:

<notification_page_url>?param1=value1&param2=value2

The table describes the parameters AsyncOS includes in the query string.

DescriptionParameter Name

Date and time of the transaction.Time

Transaction ID.ID

IP address of the client.Client_IP

Username of the client making the request, if available.User

Hostname of the destination in the HTTP request.Site

URL path specified in the HTTP request.URI

HTTP status code for the request.Status_Code

ACL decision tag as defined in the Access log entry that indicates how the DVS engine
handled the transaction.

Decision_Tag

URL category that the URL filtering engine assigned to the transaction request.

Note: AsyncOS for Web sends the entire URL category name for both predefined and
user defined URL categories. It performs URL encoding on the category name, so spaces
are written as “%20”.

URL_Cat

WBRS score that the Web Reputation Filters assigned to the URL in the request.WBRS

Malware category that the DVS engine assigns to the transaction.DVS_Verdict

The name of the malware found by the DVS engine.DVS_ThreatName

A URL that users can click to authenticate again if the user is blocked from a website
due to a restrictive URL filtering policy. Use this parameter when the “Enable
Re-Authentication Prompt If End User Blocked by URL Category or User Session
Restriction” global authentication setting is enabled and the user is blocked from awebsite
due to a blocked URL category.

To use this parameter, make sure the CGI script performs the following steps:

1. Get the value of Reauth_Url parameter.

2. URL-decode the value.

3. Base64 decode the value and get the actual re-authentication URL.

4. Include the decoded URL on the end-user notification page in some way, either as a
link or button, along with instructions for users informing them they can click the link
and enter new authentication credentials that allow greater access.

Reauth_URL
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AsyncOS always includes all parameters in each redirected URL. If no value exists for a particular parameter,
AsyncOS passes a hyphen (-).

Note

Redirecting End-User Notification Pages to a Custom URL (Off-Box)

Step 1 Security Services > End-User Notification.
Step 2 Click Edit Settings.
Step 3 In the End-User Notification Pages section, choose Redirect to Custom URL.
Step 4 In the Notification Page URL field, enter the URL to which you want to redirect blocked websites.
Step 5 (Optional) Click Preview Custom URL link.
Step 6 Submit and Commit Changes.

Configuring the End-User URL Filtering Warning Page
Before you begin

• If you will customize the message displayed using on-box notifications, review the topics under Custom
Messages on Notification Pages, on page 312. If you require more customization than the CustomMessage
box allows, see Editing Notification Page HTML Files Directly , on page 314.

An end-user URL filtering warning page is displayed when a user first accesses a website in a particular URL
category after a certain period of time. You can also configure the warning page when a user accesses adult
content when the site content ratings feature is enabled.

Step 1 Security Services > End-User Notification.
Step 2 Click Edit Settings.
Step 3 Scroll down to the End-User URL Filtering Warning Page section.
Step 4 In the Time Between Warning field, enter the time interval the Web Proxy uses between displaying the end-user URL

filtering warning page for each URL category per user.

You can specify any value from 30 to 2678400 seconds (one month). Default is 1 hour (3600 seconds). You can enter
the value in seconds, minutes, or days. Use ‘s’ for seconds, ‘m’ for minutes, and ‘d’ for days.

Step 5 In the Custom Message field, enter text you want to appear on every end-user URL filtering warning page.
Step 6 (Optional) Click Preview URL Category Warning Page Customization to view the current end-user URL filtering

warning page in a separate browser window.

If the notification HTML files have been edited, this preview functionality is not available.Note

Step 7 Submit and Commit Changes.
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Configuring FTP Notification Messages
Before you begin

If you will customize the message displayed using on-box notifications, review the topics under Custom
Messages on Notification Pages, on page 312. If you require more customization than the Custom Message
box allows, see Editing Notification Page HTML Files Directly , on page 314.

The FTP Proxy displays a predefined, customizable notification message to native FTP clients when the FTP
Proxy cannot establish a connection with the FTP server for any reason, such as an error with FTP Proxy
authentication or a bad reputation for the server domain name. The notification is specific to the reason the
connection was blocked.

Step 1 Security Services > End-User Notification.
Step 2 Click Edit Settings.
Step 3 Scroll down to the Native FTP section.
Step 4 In the Language field, select the language to use when displaying native FTP notification messages.
Step 5 In the Custom Message field, enter the text you want to display in every native FTP notification message.
Step 6 Submit and Commit Changes.

Custom Messages on Notification Pages
The following sections apply to text entered into the “CustomMessage” box for any notification type configured
on the Edit End User Notification page.

• Supported HTML Tags in Custom Messages on Notification Pages, on page 312
• Caveats for URLs and Logos in Notification Pages , on page 313

Supported HTML Tags in Custom Messages on Notification Pages
You can use HTML tags to format the text in any notification on the Edit End User Notification page that
offers a “CustomMessage” box. Tags must be in lower case and follow standard HTML syntax (closing tags,
etc.)

You can use the following HTML tags.

• <a></a>
• <span></span>
• <b></b>
• <big></big>
• <br>
• <code></code>
• <em></em>
• <i></i>
• <small></small>
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• <strong></strong>

For example, you can make some text italic:
Please acknowledge the following statements <i>before</i> accessing the Internet.

With the <span> tag, you can use any CSS style to format text. For example, you can make some text red:
<span style=”color: red”>Warning:</span> You must acknowledge the following statements
<i>before</i> accessing the Internet.

If you need greater flexibility or wish to add JavaScript to your notification pages, you must edit the HTML
notification files directly. JavaScript entered into the Custom Message box for notifications in the web user
interface will be stripped out. See Editing Notification Page HTML Files Directly , on page 314.

Note

Caveats for URLs and Logos in Notification Pages
This section applies if you will make any of the following customizations:

• Enter text into the “Custom Message” box for any notification on the Edit End User Notification page
• Directly edit HTML files for on-box notifications
• Use a custom logo

All combinations of URL paths and domain names in embedded links within custom text, and the custom
logo, are exempted from the following for on-box notifications:

• User authentication
• End-user acknowledgment
• All scanning, such as malware scanning and web reputation scoring

For example, if the following URLs are embedded in custom text:

http://www.example.com/index.html

http://www.mycompany.com/logo.jpg

Then all of the following URLs will also be treated as exempt from all scanning:

http://www.example.com/index.html

http://www.mycompany.com/logo.jpg

http://www.example.com/logo.jpg

http://www.mycompany.com/index.html

Also, where an embedded URL is of the form: <protocol>://<domain-name>/<directory path>/ then all
sub-files and sub-directories under that directory path on the host will also be exempted from all scanning.

For example, if the following URL is embedded: http://www.example.com/gallery2/ URLs such as
http://www.example.com/gallery2/main.php will also be treated as exempt.

This allows you to create a more sophisticated page with embedded content so long as the embedded content
is relative to the initial URL. However, you should also take care when deciding which paths to include as
links and custom logos.
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Editing Notification Page HTML Files Directly
Each notification page is stored on the Web Security appliance as an HTML file. If you require more
customization than the “Custom Message” box in the web-based interface allows, you can directly edit these
HTML files. For example, you can include standard JavaScript or edit the overall look and feel of each page.

Information in the following sections applies to any type of end-user notification HTML file on the appliance,
including End-User Acknowledgment pages.

• Requirements for Editing Notification HTML Files Directly , on page 314
• Editing Notification Page HTML Files Directly , on page 314
• Using Variables in Notification HTML Files , on page 315
• Variables for Customizing Notification HTML Files , on page 316

Requirements for Editing Notification HTML Files Directly
• Each notification page file must be a valid HTML file. For a list of HTML tags you can include, see
Supported HTML Tags in Custom Messages on Notification Pages, on page 312.

• The customized notification page file names must exactly match the file names shipped with the Web
Security appliance.

If the configuration\eun directory does not contain a particular file with the required name, then the
appliance displays the standard on-box end-user notification page.

• Do not include any links to URLs in the HTML files. Any link included in the notification pages are
subject to the access control rules defined in the Access Policies and users might end up in a recursive
loop.

• Test your HTML files in supported client browsers to ensure that they behave as expected, especially if
they include JavaScript.

• For your customized pages to take effect, you must enable the customized files using the
advancedproxyconfig > EUN > Refresh EUN Pages CLI command.

Editing Notification HTML Files Directly

Before you begin

• Understand the requirements in Requirements for Editing Notification HTML Files Directly , on page
314.

• See Variables for Customizing Notification HTML Files , on page 316 and Using Variables in Notification
HTML Files , on page 315.

Step 1 Use an FTP client to connect to the Web Security appliance.
Step 2 Navigate to the configuration\eun directory.
Step 3 Download the language directory files for the notification pages you want to edit.
Step 4 On your local machine, use a text or HTML editor to edit the HTML files.
Step 5 Use the FTP client to upload the customized HTML files to the same directory from which you downloaded them in

step 3.
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Step 6 Open an SSH client and connect to the Web Security appliance.
Step 7 Run the advancedproxyconfig > EUN CLI command.
Step 8 Type 2 to use the custom end-user notification pages.
Step 9 If the custom end-user notification pages option is currently enabled when you update the HTML files, type 1 to refresh

the custom end-user notification pages.

If you do not do this, the new files do not take effect until the Web Proxy restarts.

Step 10 Commit your change.
Step 11 Close the SSH client.

Using Variables in Notification HTML Files
When editing notification HTML files, you can include conditional variables to create if-then statements to
take different actions depending on the current state.

The table describes the different conditional variable formats.

DescriptionConditional
Variable Format

This conditional variable evaluates to TRUE if the output of variable %V is not empty.%?V

Represents the following condition:

else

Use this with the %?V conditional variable.

%!V

Represents the following condition:

endif

Use this with the %?V conditional variable.

%#V

For example, the following text is some HTML code that uses %R as a conditional variable to check if
re-authentication is offered, and uses %r as a regular variable to provide the re-authentication URL.

%?R
<div align="left">
<form name="ReauthInput" action="%r" method="GET">
<input name="Reauth" type="button" OnClick="document.location='%r'"

id="Reauth" value="Login as different user...">
</form>

</div>
%#R

Any variable included in Variables for Customizing Notification HTML Files , on page 316 can be used as a
conditional variable. However, the best variables to use in conditional statements are the ones that relate to
the client request instead of the server response, and the variables that may or may not evaluate to TRUE
instead of the variables that always evaluate to TRUE.
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Variables for Customizing Notification HTML Files
You can use variables in the notification HTML files to display specific information to the user. You can also
turn each variable into a conditional variable to create if-then statements. For more information, see Using
Variables in Notification HTML Files , on page 315.

Always Evaluates to TRUE if
Used as Conditional Variable

DescriptionVariable

NoAuthentication realm for FTP%a

YesARP address%A

NoUser-agent name%b

NoBlocking reason, such as BLOCK-SRC or BLOCK-TYPE%B

YesError page contact person%c

NoEntire Set-Cookie: header line, or empty string%C

YesClient IP address%d

NoUser name%D

YesError page email address%e

NoThe error page logo URL%E

NoUser feedback section%f

NoThe URL for user feedback%F

YesThe web category name, if available%g

NoMaximum file size allowed in MB%G

YesThe hostname of the proxy%h

YesThe server name of the URL%H

YesTransaction ID as a hexadecimal number%i

YesManagement IP Address%I

NoURL category warning page custom text%j

NoRedirection link for the end-user acknowledgment page and
end-user URL filtering warning page

%k

NoResponse file type%K

NoWWW-Authenticate: header line%l

NoProxy-Authenticate: header line%L
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Always Evaluates to TRUE if
Used as Conditional Variable

DescriptionVariable

YesThe Method of the request, such as “GET” or “POST”%M

NoMalware category name, if available%n

NoMalware threat name, if available%N

NoWeb reputation threat type, if available%o

NoWeb reputation threat reason, if available%O

YesString for the Proxy-Connection HTTP header%p

YesProtocol%P

YesIdentity policy group name%q

YesPolicy group name for non-Identity polices%Q

NoRedirect URL%r

NoRe-authentication is offered. This variable outputs an empty
string when false and a space when true, so it is not useful to use
it alone. Instead, use it as condition variable.

%R

No, always evaluates to FALSEThe signature of the proxy%S

YesTimestamp in Unix seconds plus milliseconds%t

YesThe date%T

YesThe URI part of the URL (the URL excluding the server name)%u

YesThe full URL of the request%U

YesHTTP protocol version%v

YesManagement WebUI port%W

YesExtended blocking code. This is a 16-byte base64 value that
encodes the most of the web reputation and anti-malware
information logged in the access log, such as the ACL decision
tag and WBRS score.

%X

NoAdministrator custom text string, if set, else empty%Y

YesEnd-user acknowledgment page custom text%y

YesWeb reputation score%z

YesDLP meta data%Z

N/APrints the percent symbol (%) in the notification page%%
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Notification Page Types
By default, the Web Proxy displays a notification page informing users they were blocked and the reason for
the block.

Most notification pages display a different set of codes that may help administrators or Cisco Customer Support
troubleshoot any potential problem. Some codes are for Cisco internal use only. The different codes that might
appear in the notification pages are the same as the variables you can include in customized notification pages,
as shown in Variables for Customizing Notification HTML Files , on page 316.

The table describes the different notification pages users might encounter.

Notification TextNotification DescriptionFile Name and

Notification Title

The misclassification report has been
sent. Thank you for your feedback.

Notification page that is displayed after
the users uses the “Report
Misclassification” option.

ERR_ACCEPTED

Feedback Accepted,
Thank You

Based on your organization’s security
policies, this web site <URL > has been
blocked because its content has been
determined to be a security risk.

Block page that is displayed when the
user is blocked due to the Adaptive
Scanning feature.

ERR_ADAPTIVE_SECURITY

Policy: General

You are trying to visit a web page whose
content are rated as explicit or adult. By
clicking the link below, you
acknowledge that you have read and
agree with the organization's policies
that govern the usage of the Internet for
this type of content. Data about your
browsing behavior may be monitored
and recorded. You will be periodically
asked to acknowledge this statement for
continued access to this kind of web
page.

Click here to accept this statement and
access the Internet.

The warning page that is displayed
when the end-user accesses a page that
is classified as adult content. Users can
click an acknowledgment link to
continue to the originally requested site.

ERR_ADULT_CONTENT

Policy Acknowledgment

Based on your organization’s access
policies, access to application %1 of
type %2 has been blocked.

Block page that is displayed when the
user is blocked due to the Application
Visibility and Control engine.

ERR_AVC

Policy: Application
Controls

The system cannot process this request.
A non-standard browser may have
generated an invalid HTTP request.

If you are using a standard browser,
please retry the request.

Error page that results from an invalid
transaction request.

ERR_BAD_REQUEST

Bad Request
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Notification TextNotification DescriptionFile Name and

Notification Title

Based on your organization’s Access
Policies, access to this web site <URL
> has been blocked.

Block page that is displayed when the
user tries to access a blocked website
address.

ERR_BLOCK_DEST

Policy: Destination

Based on your organization’s Access
Policies, requests from your computer
have been blocked because it has been
determined to be a security threat to the
organization’s network. Your browser
may have been compromised by a
malware/spyware agent identified as
“<malware name >”.

Please contact <contact name > <email
address > and provide the codes shown
below.

If you are using a non-standard browser
and believe it has been misclassified,
use the button below to report this
misclassification.

Block page that is displayed when the
transaction request comes from an
application that has been identified to
be compromised by malware or
spyware.

ERR_BROWSER

Security: Browser

Based on your organization’s Access
Policies, requests from your browser
have been blocked. This browser
“<browser type >” is not permitted due
to potential security risks.

Block page that is displayed when the
transaction request comes from a
blocked user agent.

ERR_BROWSER_CUSTOM

Policy: Browser

A secure session cannot be established
because the site <hostname > provided
an invalid certificate.

Block page that is displayed when the
requested HTTPS site uses an invalid
certificate.

ERR_CERT_INVALID

Invalid Certificate

You are trying to visit a web page that
falls under the URL Category <URL
category >. By clicking the link below,
you acknowledge that you have read and
agree with the organization’s policies
that govern the usage of the Internet for
this type of content. Data about your
browsing behavior may be monitored
and recorded. You will be periodically
asked to acknowledge this statement for
continued access to this kind of web
page.

Click here to accept this statement and
access the Internet.

Warning page that is displayed when
the user requests a site that is in a
custom URL category that is assigned
the Warn action. Users can click an
acknowledgment link to continue to the
originally requested site.

ERR_CONTINUE_
UNACKNOWLEDGED

Policy Acknowledgment
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Notification TextNotification DescriptionFile Name and

Notification Title

The hostname resolution (DNS lookup)
for this hostname <hostname > has
failed. The Internet address may be
misspelled or obsolete, the host
<hostname > may be temporarily
unavailable, or the DNS server may be
unresponsive.

Please check the spelling of the Internet
address entered. If it is correct, try this
request later.

Error page that is displayed when the
requested URL contains an invalid
domain name.

ERR_DNS_FAIL

DNS Failure

The system cannot process the request
for this site <URL >. A non-standard
browser may have generated an invalid
HTTP request.

If using a standard browser, please retry
the request.

Error page that is displayed when the
transaction request triggers the HTTP
417 “Expectation Failed” response.

ERR_EXPECTATION_
FAILED

Expectation Failed

Based on your organization’s Access
Policies, access to this web site or
download <URL > has been blocked
because the download size exceeds the
allowed limit.

Block page that is displayed when the
requested file is larger than the allowed
maximum file size.

ERR_FILE_SIZE

Policy: File Size

Based on your organization’s Access
Policies, access to this web site or
download <URL > has been blocked
because the file type “<file type >” is
not allowed.

Block page that is displayed when the
requested file is a blocked file type.

ERR_FILE_TYPE

Policy: File Type

The request for page <URL > has been
denied because an internal server is
currently unreachable or overloaded.

Please retry the request later.

Error page that is displayed when the
URL filtering engine is temporarily
unable to deliver a URL filtering
response and the “Default Action for
Unreachable Service” option is set to
Block.

ERR_FILTER_FAILURE

Filter Failure

The page <URL > is being redirected to
<redirected URL >.

Internal redirection page for some
errors.

ERR_FOUND

Found

The request for the file <URL > did not
succeed. The FTP server <hostname >
unexpectedly terminated the connection.

Please retry the request later.

Error page that is displayed when the
FTP over HTTP transaction request
triggers the HTTP 416 “Requested
Range Not Satisfiable” response.

ERR_FTP_ABORTED

FTP Aborted
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Notification TextNotification DescriptionFile Name and

Notification Title

Authentication is required by the FTP
server <hostname >. A valid user ID and
passphrase must be entered when
prompted.

In some cases, the FTP server may limit
the number of anonymous connections.
If you usually connect to this server as
an anonymous user, please try again
later.

Error page that is displayed when the
FTP over HTTP transaction request
triggers the FTP 530 “Not Logged In”
response.

ERR_FTP_AUTH_
REQUIRED

FTP Authorization
Required

The system cannot communicate with
the FTP server <hostname >. The FTP
server may be temporarily or
permanently down, or may be
unreachable because of network
problems.

Please check the spelling of the address
entered. If it is correct, try this request
later.

Error page that is displayed when the
FTP over HTTP transaction request
triggers the FTP 425 “Can’t open data
connection” response.

ERR_FTP_CONNECTION_
FAILED

FTP Connection Failed

Access was denied by the FTP server
<hostname >. Your user ID does not
have permission to access this
document.

Error page that is displayed when the
FTP over HTTP transaction request is
for an object the user is not allowed to
access.

ERR_FTP_FORBIDDEN

FTP Forbidden

The file <URL > could not be found.
The address is either incorrect or
obsolete.

Error page that is displayed when the
FTP over HTTP transaction request is
for an object that does not exist on the
server.

ERR_FTP_NOT_FOUND

FTP Not Found

The system cannot communicate with
the FTP server <hostname >. The FTP
server may be temporarily or
permanently down, or may not provide
this service.

Please confirm that this is a valid
address. If it is correct, try this request
later.

Error page that is displayed for FTP
over HTTP transactions that try to
access a server that does support FTP.
The server usually returns the HTTP
501 “Not Implemented” response.

ERR_FTP_SERVER_ERR

FTP Server Error

The system cannot communicate with
the FTP server <hostname >. The FTP
server may be busy, may be
permanently down, or may not provide
this service.

Please confirm that this is a valid
address. If it is correct, try this request
later.

Error page that is displayed for FTP
over HTTP transactions that try to
access an FTP server that is unavailable.

ERR_FTP_SERVICE_
UNAVAIL

FTP Service Unavailable
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Notification TextNotification DescriptionFile Name and

Notification Title

The system cannot communicate with
the external server <hostname >. The
Internet server may be busy, may be
permanently down, or may be
unreachable because of network
problems.

Please check the spelling of the Internet
address entered. If it is correct, try this
request later.

Error page that is displayed when the
requested server has not responded in a
timely manner.

ERR_GATEWAY_TIMEOUT

Gateway Timeout

Based on your organization’s data
transfer policies, your upload request
has been blocked. File details:

<file details >

Block page that is displayed when the
user tries to upload a file that is blocked
due to a configured Cisco Data Security
Policy.

ERR_IDS_ACCESS_
FORBIDDEN

IDS Access Forbidden

Internal system error when processing
the request for the page <URL >.

Please retry this request.

If this condition persists, please contact
<contact name > <email address > and
provide the code shown below.

Error page that is displayed when there
is an internal error.

ERR_INTERNAL_ERROR

Internal Error

Based on your organization’s Access
Policies, this web site <URL > has been
blocked because it has been determined
to be a security threat to your computer
or the organization’s network.

Malware <malware name > in the
category <malware category > has been
found on this site.

Block page that is displayed when
malware is detected when downloading
a file.

ERR_MALWARE_
SPECIFIC

Security: Malware
Detected

Based on your organization’s policy, the
upload of the file to URL (<URL >) has
been blocked because the file was
detected to contain malware that will be
harmful to the receiving end's network
security.

Malware Name: <malware name >

Malware Category: <malware category
>

Block page that is displayed when
malware is detected when uploading a
file.

ERR_MALWARE_
SPECIFIC_OUTGOING

Security: Malware
Detected

530 Login deniedBlock message displayed in native FTP
clients when the native FTP transaction
is blocked.

ERR_NATIVE_FTP_DENIED
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Notification TextNotification DescriptionFile Name and

Notification Title

The request for the page <URL > failed.

The server address <hostname > may
be invalid, or you may need to specify
a port number to access this server.

Error page that is displayed when the
appliance has detected a forward loop
between the Web Proxy and another
proxy server on the network. The Web
Proxy breaks the loop and displays this
message to the client.

ERR_NO_MORE_
FORWARDS

No More Forwards

Based on your organization’s Access
Policies, access to this web site <URL
> has been blocked.

Block page that is displayed when the
request is blocked by any policy setting.

ERR_POLICY

Policy: General

Based on your organization’s Access
Policies, this request has been blocked
because the data transfer protocol
“<protocol type >” is not allowed.

Block page that is displayed when the
request is blocked based on the protocol
used.

ERR_PROTOCOL

Policy: Protocol

Authentication is required to access the
Internet using this system. A valid user
ID and passphrasemust be enteredwhen
prompted.

Notification page that is displayed when
users must enter their authentication
credentials to continue. This is used for
explicit transaction requests.

ERR_PROXY_AUTH_
REQUIRED

Proxy Authorization
Required

Based on your organization’s policies,
the request to access the Internet was
denied because this user ID has an
active session from another IP address.

If you want to login as a different user,
click on the button below and enter a
different a user name and passphrase.

Block page that is displayed when
someone tries to access the web using
the same username that is already
authenticated with the Web Proxy on a
different machine. This is used when
the User Session Restrictions global
authentication option is enabled.

ERR_PROXY_PREVENT_
MULTIPLE_LOGIN

Already Logged In From
Another Machine

This request is being redirected. If this
page does not automatically redirect,
click here to proceed.

Redirection page.ERR_PROXY_REDIRECT

Redirect
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Notification TextNotification DescriptionFile Name and

Notification Title

Please acknowledge the following
statements before accessing the Internet.

Your web transactions will be
automatically monitored and processed
to detect dangerous content and to
enforce organization’s policies. By
clicking the link below, you
acknowledge this monitoring and accept
that data about the sites you visit may
be recorded. You will be periodically
asked to acknowledge the presence of
the monitoring system. You are
responsible for following organization’s
polices on Internet access.

Click here to accept this statement and
access the Internet.

End-user acknowledgment page.

For more information, see End-User
Notification Pages , on page 307.

ERR_PROXY_
UNACKNOWLEDGED

Policy Acknowledgment

Internet access is not available without
proper licensing of the security device.

Please contact <contact name > <email
address > and provide the code shown
below.

To access the management
interface of the security
device, enter the configured
IP address with port.

Note

Block page that is displayed when there
is no valid license key for the Web
Security appliance Web Proxy.

ERR_PROXY_
UNLICENSED

Proxy Not Licensed

The system cannot process this request.
A non-standard browser may have
generated an invalid HTTP request.

If you are using a standard browser,
please retry the request.

Error page that is displayed when the
requested range of bytes cannot be
satisfied by the web server.

ERR_RANGE_NOT_
SATISFIABLE

Range Not Satisfiable

The page <URL > is being redirected to
<redirected URL >.

Internal redirection page.ERR_REDIRECT_
PERMANENT

Redirect Permanent

Please repeat your request.Internal redirection page.ERR_REDIRECT_REPEAT_
REQUEST

Redirect
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Notification TextNotification DescriptionFile Name and

Notification Title

Based on your organization’s policy, the
request to access <URL >was redirected
to a page where youmust enter the login
credentials. You will be allowed to
access the application if authentication
succeeds and you have the proper
privileges.

Notification page that is displayed when
users must enter their authentication
credentials to continue. This is used for
accessing applications.

ERR_SAAS_AUTHEN
TICATION

Policy: Access Denied

Based on your organization’s policy, the
access to the application <URL > is
blocked because you are not an
authorized user. If you want to login as
a different user, enter a different
username and passphrase for a user that
is authorized to access this application.

Block page that is displayedwhen users
try to access a application that they have
no privilege to access.

ERR_SAAS_AUTHORI
ZATION

Policy: Access Denied

The request to access <user name > did
not go through because errors were
found during the process of the single
sign on request.

Error page that is displayed when an
internal process fails trying to process
the single sign-on URL for accessing a
application.

ERR_SAML_PROCESSING

Policy: Access Denied

The server name <hostname > appears
to be an abbreviation, and is being
redirected to <redirected URL >.

Internal redirection page that
automatically expands the URL and
redirects users to the updated URL.

ERR_SERVER_NAME_
EXPANSION

Server Name Expansion

The requested URL was too long and
could not be processed. This may
represent an attack on your network.

Please contact <contact name > <email
address > and provide the code shown
below.

Block page that is displayed when the
URL length is too long.

ERR_URI_TOO_LONG

URI Too Long

Based on your organization’s access
policies, this web site <URL > has been
blocked because it has been determined
by Web Reputation Filters to be a
security threat to your computer or the
organization’s network. This web site
has been associated with
malware/spyware.

Threat Type: %o

Threat Reason: %O

Block page that is displayed when the
Web Reputation Filters block the site
due to a low web reputation score.

ERR_WBRS

Security: Malware Risk
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Notification TextNotification DescriptionFile Name and

Notification Title

Based on your organization’s Access
Policies, access to this web site <URL
> has been blocked because the web
category “<category type >” is not
allowed.

Block page that is displayedwhen users
try to access a website in a blocked URL
category.

ERR_WEBCAT

Policy: URL Filtering

Authentication is required to access the
requestedweb site <hostname >. A valid
user ID and passphrase must be entered
when prompted.

Notification page that is displayed when
the requested server requires users to
enter their credentials to continue.

ERR_WWW_AUTH_
REQUIRED

WWW Authorization
Required
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C H A P T E R 19
Generate Reports to Monitor End-user Activity

This chapter contains the following sections:

• Overview of Reporting , on page 327
• Using the Reporting Pages, on page 328
• Enabling Reporting, on page 333
• Scheduling Reports, on page 334
• Generating Reports On Demand, on page 335
• Archived Reports, on page 336
• Troubleshooting L4 Traffic Monitor Reports , on page 336

Overview of Reporting
The Web Security appliance generates high-level reports, allowing you to understand what is happening on
the network and also allowing you to view traffic details for a particular domain, user, or category. You can
run reports to view an interactive display of system activity over a specific period of time, or you can schedule
reports and run them at regular intervals.

Related Topics

• Printing and Exporting Reports from Report Pages, on page 332

Working with Usernames in Reports
When you enable authentication, reports list users by their usernames when they authenticate with the Web
Proxy. By default, usernames are written as they appear in the authentication server. However, you can choose
to make usernames unrecognizable in all reports.

Administrators always see usernames in reports.Note

Step 1 Choose Security Services > Reporting, and click Edit Settings.
Step 2 Under Local Reporting, select Anonymize usernames in reports.
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Step 3 Submit and Commit Changes.

Report Pages
The Web Security appliance offers the following reports:

• My Dashboard (the reporting “homepage”; can also be accessed by clicking the Home icon in the left
edge of the menu bar)

• Overview

• Users

• User Count

• Web Sites

• URL Categories

• Application Visibility

• Anti-Malware

• Advanced Malware Protection

• File Analysis

• AMP Verdict Updates

• Client Malware Risk

• Web Reputation Filters

• L4 Traffic Monitor

• SOCKS Proxy

• Reports by User Location

• Web Tracking

• System Capacity

• System Status

• Scheduled Reports

• Archived Reports

Using the Reporting Pages
The various report pages provide an overview of system activity and support multiple options for viewing the
system data. You can also search each page for Website and client-specific data.

You can perform the following tasks on most report pages:
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Link to TaskOption

Changing the Time Range, on page 329Change the time range displayed by a report

Searching Data, on page 330Search for specific clients and domains

Choosing Which Data to Chart , on page 330Choose which data to display in charts

Printing and Exporting Reports from Report Pages, on page
332

Export reports to external files

Changing the Time Range
You can update the data displayed for each security component using the Time Range field. This option allows
you to generate updates for predefined time ranges and it allows you to define custom time ranges from a
specific start time to a specific end time.

The time range you select is used throughout all of the report pages until you select a different value in the
Time Range menu.

Note

Data is returned in...Time Range

Sixty complete minutes plus up to 5 additional minutes.Hour

One-hour intervals for the last 24 hours and including the current partial hour.Day

On- day intervals for the last 7 days plus the current partial day.Week

One-day intervals for the last 30 days plus the current partial day.Month (30
days)

The last 24 hours (00:00 to 23:59) using the time zone defined on theWeb Security appliance.Yesterday

The custom time range you defined.

When you choose Custom Range, a dialog box appears to let you enter start and end times.

Custom
Range

All reports display date and time information based on the system’s configured time zone, shown as a Greenwich
Mean Time (GMT) offset. However, data exports display the time in GMT only to accommodate multiple
systems in multiple time zones around the world.

Note

Choosing a Time Range for Reports
Most predefined report pages allow you to choose a Time Range for the data to include. The time range that
you select is used for all of the report pages until you select a different value in the Time Range menu.
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Available Time Range options differ by appliance and differ for Email and Web reporting on the Security
Management appliance:

Time ranges on report pages are displayed as a Greenwich Mean Time (GMT) offset. For example, Pacific
time is GMT + 7 hours (GMT + 07:00).

Note

All reports display date and time information based on the systems configured time zone, shown as a Greenwich
Mean Time (GMT) offset. However, data exports display the time in GMT to accommodate multiple systems
in multiple time zones around the world.

Note

Searching Data
Some reports include a field you can use to search for particular data points. When you search for data, the
report refines the report data for the particular data set you are searching. You can search for values that
exactly match of the string you enter, or for values that start with the string you enter. The following report
pages include search fields:

DescriptionSearch Fields

Search for a user by user name or client IP address.Users

Search for a server by domain or server IP address.Web Sites

Search for a URL category.URL Categories

Search for an application name that the AVC engine monitors and blocks.Application
Visibility

Search for a user by user name or client IP address.Client Malware Risk

You need to configure Authentication to view client user IDs as well as client IP addresses.Note

Choosing Which Data to Chart
The default charts on each Web Reporting page display commonly referenced data, but you can choose to
chart different data instead. If a page has multiple charts, you can change each chart. The chart options are
the same as the columns headings of the table(s) in the report.

Step 1 Click the Chart Options link below a chart.
Step 2 Choose the data to display.
Step 3 Click Done.
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Custom Reports
You can create a custom report page by assembling charts (graphs) and tables from existing report pages.

Do ThisTo

See:

• Modules That Cannot Be Added to Custom Reports , on page 331.
• Creating Your Custom Report Page , on page 331

Add modules to your
custom report page

1. Choose Monitor > Email or Web > Reporting > Reporting > My Reports.
2. Select the time range to viewThe time range selected applies to all reports,

including all modules on the My Reports page.

Newly-added modules appear at the top of the relevant section.

View your custom
report page

Drag and drop modules into the desired location.Rearrange modules
on your custom report
page

Click the [X] in the top right corner of the module.Delete modules from
your custom report
page

Choose Reporting > Archived Reports and click Generate Report Now.Generate a PDF or
CSV version of your
custom report

Choose Reporting > Scheduled Reports.Periodically generate
a PDF or CSV
version of your
custom report

Modules That Cannot Be Added to Custom Reports
• Search results , including Web Tracking search results

Creating Your Custom Report Page

Before you begin

• Ensure that the modules that you want to add can be added. See Modules That Cannot Be Added to
Custom Reports , on page 331.

• Delete any default modules that you do not need by clicking the [X] in the top right corner of those
module.

Step 1 Use one of the following methods to add a module to your custom report page:

Some modules are available only using one of these methods. If you cannot add a module using one method,
try another method.

Note
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• Navigate to the report page under the that has the module you want to add, then click the [+] button at the top of the
module.

• Go to Reporting > My Reports, click the [+] button at the top of one of the sections, then select the report module
that you want to add. You may need to click the [+] button in each section on the My Reports page in order to find
the module that you are looking for.

You can add each module only once; if you have already added a particular module to your report, the option to add
it will not be available.

Step 2 If you add a module that you have customized (for example, by adding, deleting, or reordering columns, or by displaying
non-default data in the chart), customize the modules on the My Reports page.

Modules are added with default settings. Time range of the original module is not maintained.

Step 3 If you add a chart that includes a separate legend (for example, a graph from the Overview page), add the legend separately.
If necessary, drag and drop it into position beside the data it describes.

Subdomains vs. Second-level Domains in Reporting and Tracking
In reporting and tracking searches, second-level domains (regional domains listed at http://george.surbl.org/
two-level-tlds) are treated differently from subdomains, although the two domain types may appear to be the
same. For example:

• Reports will not include results for a two-level domain such as co.uk , but will include results for
foo.co.uk . Reports include subdomains under the main corporate domain, such as cisco.com .

• Tracking search results for the regional domain co.uk will not include domains such as foo.co.uk ,
while search results for cisco.com will include subdomains such as subdomain.cisco.com .

Printing and Exporting Reports from Report Pages
You can generate a printer-formatted PDF version of any report page by clicking the Printable (PDF) link
at the top-right corner of the page. You can also export raw data as a comma-separated value (CSV) file by
clicking the Export link.

Because CSV exports include only raw data, exported data from a Web-based report page may not include
calculated data such as percentages, even if that data appears in the Web-based report.

Exporting Report Data
Most reports include an Export link that allows you to export raw data to a comma-separated values (CSV)
file. After exporting the data to a CSV file, you can access and manipulate the data in it using applications
such as Microsoft Excel.

The exported CSV data displays all message tracking and reporting data in Greenwich Mean Time (GMT)
regardless of the time zone set on the Web Security appliance. The purpose of the GMT time conversion is
to allow data to be used independently from the appliance, or when referencing data from appliances in multiple
time zones.

The following example is an entry from a raw data export of the Anti-Malware category report, where Pacific
Daylight Time (PDT) is displayed as GMT 07:00 hours:
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Begin Timestamp, End Timestamp, Begin Date, End Date, Name,
Transactions Monitored, Transactions Blocked, Transactions Detected
1159772400.0, 1159858799.0, 2006-10-02 07:00 GMT, 2006-10-03 06:59 GMT, Adware, 525, 2100,
2625

DescriptionValueCategory Header

Query start time in number of seconds from epoch.1159772400.0Begin Timestamp

Query end time in number of seconds from epoch.1159858799.0End Timestamp

Date the query began.2006-10-02 07:00 GMTBegin Date

Date the query ended.2006-10-03 06:59 GMTEnd Date

Name of the malware category.AdwareName

Number of transactions monitored.525Transactions Monitored

Number of transactions blocked.2100Transactions Blocked

Total number of transactions = (Number of
transactions detected) + (Number of transactions
blocked).

2625Transactions Detected

- Category headers are different for each type of report.

- If you export localized CSV data, the headings may not be rendered properly in some browsers. This occurs
because some browsers may not use the proper character set for the localized text. To work around this
problem, you can save the file to your local machine, and open the file in anyWeb browser using File > Open.
When you open the file, select the character set to display the localized text.

Note

Enabling Reporting
If your organization has multiple Web Security appliances and uses a Cisco Content Security Management
Appliance to manage and view aggregated report data, you must enable centralized reporting on each Web
Security appliance.

You can choose the type of reporting based on the appliance setup. You can choose to retain all reports locally,
or access them through Cisco Defense Orchestrator if the appliance has been on-boarded to it. If your
organization has multipleWeb Security appliances and uses a Cisco Content SecurityManagement Appliance,
you can choose centralized reporting to manage and view aggregated report data. If you choose Centralized
Reporting or local reporting through Cisco Defense Orchestrator, you have to apply these selections on each
Web Security appliance.

Step 1 Choose Security Services > Reporting, and click Edit Settings.
a) Select Local Reporting to enable reporting on the appliance. The reports will be accessible after logging in to the

appliance portal.
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b) Select Local Reporting, and Cisco Defense Orchestrator Reporting to enable reporting through Cisco Defense
Orchestrator.

c) Select Centralized Reporting to enable reporting through Cisco Content Security Management Appliance.

The Web Security appliance only stores all its collected data for local reporting. If Centralized Reporting is enabled
on the appliance, then the Web Security appliance retains only System Capacity and System Status data, and those
are the only reports available on the Web Security appliance locally.

See the chapter “Using Centralized Web Reporting and Tracking” in your Cisco Content Security Management
Appliance user guide for information about configuring this feature on the management appliance.

Step 2 Submit and Commit Changes.

Scheduling Reports
You can schedule reports to run on a daily, weekly, or monthly basis. Scheduled reports can be configured
to include data for the previous day, previous seven days, or previous month.

You can schedule reports for the following types of reports:

• Overview
• Users
• Web Sites
• URL Categories
• Application Visibility
• Anti-Malware
• Advanced Malware Protection
• Advanced Malware Protection Verdict Updates
• Client Malware Risk
• Web Reputation Filters
• L4 Traffic Monitor
• SOCKS Proxy
• Reports by User Location
• System Capacity
• My Dashboard

Adding a Scheduled Report

Step 1 Choose Reporting > Scheduled Reports and click Add Scheduled Report.
Step 2 Choose a report Type.
Step 3 Enter a descriptive Title for the report.

Avoid creating multiple reports with the same name.

Step 4 Choose a time range for the data included in the report.
Step 5 Select the Format for the generated report.

The default format is PDF. Most reports also allow you to save raw data as a CSV file.
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Step 6 Depending on the type of report you configure, you can specify different report options, such as the number of rows
to include and by which column to sort the data. Configure these options as necessary.

Step 7 In the Schedule section, choose whether to run the report daily, weekly, or monthly, and at what time.
Step 8 In the Email to field, enter the email address(es) to which the generated report is to be sent.

If you do not specify an email address, the report is simply archived.

Step 9 Choose a Report Language for the data.
Step 10 Submit and Commit Changes.

Editing Scheduled Reports

Step 1 Choose Reporting > Scheduled Reports.
Step 2 Select the report title from the list.
Step 3 Modify settings.
Step 4 Submit and Commit Changes.

Deleting Scheduled Reports

Step 1 Choose Reporting > Scheduled Reports.
Step 2 Select the check boxes corresponding to the reports that you want to delete.
Step 3 To remove all scheduled reports, select the All check box.
Step 4 Delete and Commit Changes.

Archived versions of deleted reports are not deleted.Note

Generating Reports On Demand

Step 1 Choose Reporting > Archived Reports.
Step 2 Click Generate Report Now.

Step 3 Choose a report Type.
Step 4 Enter a descriptive Title for the report.

Avoid creating multiple reports with the same name.

Step 5 Choose a time range for the data included in the report.
Step 6 Select the Format for the generated report.

The default format is PDF. Most reports also allow you to save raw data as a CSV file.
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Step 7 Depending on the type of report you configure, you can specify different report options, such as the number of rows
to include and by which column to sort the data. Configure these options as necessary.

Step 8 Select one of the Delivery Options:

• Archive the report (the report will appear on the Archived Reports page).
• Email now to recipients; provide one or more email addresses.

Step 9 Choose a Report Language for the data.
Step 10 Click Deliver this Report to generate the report.
Step 11 Commit Changes.

Archived Reports
The Reporting > Archived Reports page lists available archived reports. Each name in the Report Title
column provides a link to a view of that report. The Show menu filters the types of reports that are listed. The
column headings can be clicked to sort the data in each column.

The appliance stores up to 12 instances of each scheduled report (up to a total of 1000 reports). Archived
reports are stored in the /periodic_reports directory on the appliance. Archived reports are deleted
automatically. As new reports are added, older reports are removed to keep the number at 1000. The limit of
12 instances applies to each scheduled report with the same name and time range.

Troubleshooting L4 Traffic Monitor Reports
If the Web Proxy is configured as a forward proxy and L4 Traffic Monitor is set to monitor all ports, the IP
address of the proxy’s data port is recorded and displayed as the client IP address in reports. If the Web Proxy
is configured as a transparent proxy, enable IP spoofing to correctly record and display the client IP addresses.
To do this, see the IronPort AsyncOS for Web User Guide.

Related Topics

• Client Malware Risk Page, on page 343
• Searching for Transactions Processed by the L4 Traffic Monitor , on page 348
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C H A P T E R 20
Web Security Appliance Reports

This chapter contains the following sections:

• Overview Page, on page 337
• Users Page, on page 339
• User Count Page, on page 340
• Web Sites Page, on page 340
• URL Categories Page, on page 340
• Application Visibility Page, on page 341
• Anti-Malware Page, on page 342
• Advanced Malware Protection Page, on page 343
• File Analysis Page, on page 343
• AMP Verdict Updates Page , on page 343
• Client Malware Risk Page, on page 343
• Web Reputation Filters Page, on page 344
• L4 Traffic Monitor Page, on page 344
• SOCKS Proxy Page , on page 345
• Reports by User Location Page, on page 345
• Web Tracking Page , on page 346
• System Capacity Page, on page 349
• System Status Page, on page 349

Overview Page
TheReporting > Overview page provides a synopsis of the activity on theWeb Security appliance. It includes
graphs and summary tables for Web traffic processed by the Web Security appliance.

Table 4: System Overview

DescriptionSection

Listing of Average transactions per second in past minute, Average bandwidth (bps) in

past minute, Average response time (ms) in past minute, and Total current connections.
Web Proxy Traffic
Characteristics
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DescriptionSection

Listing of current Overall CPU Load, RAM and Reporting / logging disk usage. Click System
Status Details to switch to the System Status page (see System Status Page, on page 349 for details).

The CPU utilization value shown on this page and the CPU value shown on the System
Status page may differ slightly because they are read separately, at differing moments.

Note

SystemResourceUtilization

Table 5: Time Range-based Categories and Summaries

DescriptionSection

Time Range: Choose a time range for the data displayed in the following sections. Options are Hour, Day,Week, 30 Days, Yesterday,
or a Custom Range.

Displays the actual number of transactions (vertical scale) as well as the approximate date that
the (Web Proxy) activity occurred (horizontal timeline).

Total Web Proxy Activity

Allows you to view the percentage of Web Proxy activity that are suspect or clean Web Proxy
activity.

Web Proxy Summary

Reports on traffic monitored and blocked by the L4 Traffic Monitor.L4 Traffic Monitor Summary

Allows you to view the web transactions that have been labeled as suspect by the various security
components.

Displays the actual number of transactions as well as the approximate date that the activity occurred.

Suspect Transactions

Allows you to view the percentage of blocked or warned transactions that are suspect.Suspect Transactions Summary

Displays the top 10 URL categories that have been blocked.Top URL Categories: Total
Transactions

Displays the top application types that have been blocked by the AVC engine.Top Application Types: Total
Transactions

Displays all malware categories that have been detected.Top Malware Categories:
Monitored or Blocked

Displays the users that are generating the blocked or warned transactions. Authenticated users
are displayed username and unauthenticated users are displayed by IP address.

Top Users: Blocked or Warned
Transactions

Displays the untapped and tapped traffic transactions in a graph format.Web Traffic Tap Status

Displays the summary of the tapped and untapped traffic transactions along with the total traffic
transactions.

Web Traffic Tap Summary

Displays the tapped HTTP and HTTPS traffic transactions in a graph format.Tapped HTTP/HTTPS Traffic

Displays the summary of HTTP and HTTPS traffic transactions along with the total HTTP/HTTPS
traffic transactions.

Tapped Traffic Summary

Displays encapsulated URL transactions. These are transactions that were performed through
websites like translate.google.com.

EUP Transactions
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DescriptionSection

Displays the summary of encapsulated URL transactions.EUP Transaction Summary

Displays the encapsulated URL transactions that were found to be suspect.EUP Suspect Transactions

Displays the summary of encapsulated URL transactions that were found to be suspect.EUP Suspect Transaction
Summary

Users Page
The Reporting > Users page provides several links that allows you to view web traffic information for
individual users. You can view howmuch time users on the network have spent on the Internet or on a particular
website or URL, and how much bandwidth users have used.

DescriptionSection

A menu that allows to choose the time range of the data contained in the report.Time Range (drop-down
list)

Lists the users (vertical scale) that have the greatest number of blocked
transactions (horizontal scale).

Top Users by
Transactions Blocked

Displays the users (vertical scale) that are using the most bandwidth on the system
(horizontal scale represented in gigabyte usage).

Top Users by Bandwidth
Used

Lists individual users and displays multiple statistics on each user.Users Table

User Details Page
TheUser Details page displays information about a specific user selected in the Users Table on theReporting
> Users page.

DescriptionSection

A menu that allows to choose the time range of the data contained in the report.Time Range (drop-down
list)

Lists the specific URL categories that a specific user is using.URL Categories by Total
Transactions

Displays at what times the user accessed the web.Trend by Total
Transaction

Shows all matched URL categories during a specified time range for both
completed and blocked transactions.

URL Categories Matched

Displays information about a specific Domain or IP address that this user has
accessed.

If you export this Domains data to a CSV file, be aware that only the
first 300,000 entries are exported to the file.

Note

Domains Matched
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DescriptionSection

Displays specific application that a specific user is using as detected by the AVC
engine.

Applications Matched

Displays the top malware threats that a specific user is triggering.Malware Threats Detected

Displays a specific policy that is being enforced on this particular user.Policies Matched

User Count Page
The Reporting > User Count page displays information about the total number of authenticated and
unauthenticated users of the appliance. The page lists the unique user count for the last 30 days, 90 days, and
180 days.

System computes the total user count of authenticted and unauthenticated users once a day.

For example, if you view the user count report on May 22, 23:59, at the latest, the system will display the
total user count till May 22, 00:00.

Note

Web Sites Page
The Reporting > Web Sites page is an overall aggregation of the activity that is happening on the Web
Security appliance.

DescriptionSection

Menu allows you to choose the time range of the data contained in the report.Time Range (drop-down
list)

Lists the top domains that are being visited on the site in a graph format.Top Domains by Total
Transactions

Lists the top domains that triggered a block action to occur per transaction in a
graph format.

Top Domains by
Transactions Blocked

Lists the domains that are that are being visited on the site in an interactive table.

If you export this Domains data to a CSV file, be aware that only the
first 300,000 entries are exported to the file.

Note

Domains Matched

URL Categories Page
The Reporting > URL Categories page can be used to view the URL categories that are being visited by
users on the network. The URL Categories page can be used in conjunction with the Application Visibility
Page and the Users Page to investigate a particular user and also what types of applications or websites that
a particular user is trying to access.
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The set of predefined URL categories is occasionally updated.Note

DescriptionSection

Choose the time range for your report.Time Range (drop-down list)

This section lists the top URL categories that are being visited on the
site in a graph format.

Top URL Categories by Total
Transactions

Lists the top URL that triggered a block or warning action to occur per
transaction in a graph format.

Top URL Categories by Blocked
and Warned Transactions

Shows the disposition of transactions by URL category during the
specified time range, plus bandwidth used and time spent in each
category.

If the percentage of uncategorized URLs is higher than 15-20%, consider
the following options:

• For specific localized URLs, you can create customURL categories
and apply them to specific users or group policies.

• You can report uncategorized and misclassified and URLs to the
Cisco for evaluation and database update.

• Verify that Web Reputation Filtering and Anti-Malware Filtering
are enabled.

URL Categories Matched

URL Category Set Updates and Reports
The set of predefined URL categories may periodically be updated automatically on your Web Security
appliance.

When these updates occur, old category names will continue to appear in reports until the data associated with
the older categories is too old to be included in reports. Report data generated after a URL category set update
will use the new categories, so you may see both old and new categories in the same report.

Application Visibility Page
The Reporting > Application Visibility page shows the applications and application types used and blocked
as detected by the Application Visibility and Control engine.

DescriptionSection

A menu that allows to choose the time range of the data contained in
the report.

Time Range (drop-down list)

This section lists the top application types that are being visited on the
site in a graph format.

Top Application Types by Total
Transactions
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DescriptionSection

Lists the top application types that triggered a block action to occur per
transaction in a graph format.

Top Applications by Blocked
Transactions

Allows you to view granular details about the application types listed
in the Top Applications Type by Total Transactions graph.

Application Types Matched

Shows all the application during a specified time range.Applications Matched

Anti-Malware Page
The Reporting > Anti-Malware page allows you to monitor and identify malware detected by the Cisco
DVS engine.

DescriptionSection

A menu that allows to choose the time range of the data contained in
the report.

Time Range (drop-down list)

Displays the top malware categories detected by the DVS engine.Top Malware Categories Detected

Displays the top malware threats detected by the DVS engine.Top Malware Threats Detected

Displays information about particular malware categories that are shown
in the Top Malware Categories Detected section.

Malware Categories

Displays information about particular malware threats that are shown
in the Top Malware Threats section.

Malware Threats

Malware Category Report Page

Step 1 Choose Reporting > Anti-Malware.
Step 2 In the Malware Categories interactive table, click on a category in the Malware Category column.

Malware Threat Report Page

Step 1 Choose Reporting > Anti-Malware.
Step 2 In the Malware Threat table, click on a category in the Malware Category column.
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Advanced Malware Protection Page
See File Reputation Filtering and File Analysis, on page 261.

File Analysis Page
See File Reputation and File Analysis Reporting and Tracking , on page 274.

AMP Verdict Updates Page
See File Reputation Filtering and File Analysis, on page 261.

Client Malware Risk Page
The Reporting > Client Malware Risk page is a security-related reporting page that can be used to monitor
client malware risk activity. The Client Malware Risk page also lists client IP addresses involved in frequent
malware connections, as identified by the L4 Traffic Monitor (L4TM).

DescriptionSection

A menu that allows you to choose the time range of the data contained
in the report.

Time Range (drop-down list)

This chart displays the top ten users that have encountered a malware
risk.

Web Proxy: Top Clients by
Malware Risk

This chart displays the IP addresses of the computers in your organization
that most frequently connect to malware sites.

L4 Traffic Monitor: Malware
Connections Detected

The Web Proxy: Clients by Malware Risk table shows detailed
information about particular clients that are displayed in theWeb Proxy:
Top Clients by Malware Risk section.

Web Proxy: Clients by Malware
Risk

This table displays IP addresses of computers in your organization that
frequently connect to malware sites.

L4 Traffic Monitor: Clients by
Malware Risk

Client Detail Page for Web Proxy - Clients by Malware Risk
The Client Details page shows all the web activity and malware risk data for a particular client during the
specified time range.

Step 1 Choose Reporting > Client Malware Risk.
Step 2 In the Web Proxy - Client Malware Risk section, click a user name in the “User ID / Client IP Address” column.
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What to do next

User Details Page, on page 339

Web Reputation Filters Page
The Reporting > Web Reputation Filters page is a security-related reporting page that allows you to view
the results of your set Web Reputation Filters for transactions during a specified time range.

DescriptionSection

A menu that allows to choose the time range of the data contained in
the report.

Time Range (drop-down list)

Displays the total number of web reputation actions (vertical) against
the time specified (horizontal timeline).

Web Reputation Actions (Trend)

Displays the web reputation action volume in percentages by
transactions.

Web Reputation Actions (Volume)

Displays the threat types that were blocked due to a low reputation score.Web Reputation Threat Types by
Blocked Transactions

Displays the threat types that resulted in a reputation score that indicated
to scan the transaction.

Web Reputation Threat Types by
Scanned Further Transactions

Displays the web reputation scores broken down for each action.Web Reputation Actions
(Breakdown by Score)

L4 Traffic Monitor Page
The Reporting > L4 Traffic Monitor page is a security-related reporting page that displays information
about malware ports and malware sites that the L4 Traffic Monitor has detected during the specified time
range. It also displays IP addresses of clients that frequently encounter malware sites.

The L4 Traffic Monitor listens to network traffic that comes in over all ports on the appliance and matches
domain names and IP addresses against entries in its own database tables to determine whether to allow
incoming and outgoing traffic.

DescriptionSection

A menu that allows you to choose a time range on which to report.Time Range (drop-down list)

Displays, in graph format, the IP addresses of computers in your
organization that most frequently connect to malware sites.

Top Client IPs

Displays, in graph format, the top malware domains detected by the L4
Traffic Monitor.

Top Malware Sites

Displays the IP addresses of computers in your organization that
frequently connect to malware sites.

Client Source IPs
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DescriptionSection

Displays the ports on which the L4 Traffic Monitor has most frequently
detected malware.

Malware Ports

Displays the domains on which the L4 Traffic Monitor most frequently
detects malware.

Malware Sites Detected

SOCKS Proxy Page
The Reporting > SOCKS Proxy Page allows you to view data and trends for transactions processed through
the SOCKS proxy, including information about top destinations and users.

Reports by User Location Page
TheReporting > Reports by User Location page allows you to find out what activities your local and remote
users are conducting.

Activities include:

• URL categories that are being accessed by the local and remote users.
• Anti-Malware activity that is being triggered by sites the local and remote users are accessing.
• Web Reputation of the sites being accessed by the local and remote users.
• Applications that are being accessed by the local and remote users.
• Users (local and remote).
• Domains accessed by local and remote users.

DescriptionSection

A menu that allows to choose the time range of the data contained in
the report.

Time Range (drop-down list)

Displays the activity of your remote users (vertical) over the specified
time (horizontal).

Total Web Proxy Activity: Remote
Users

Displays a summary of the activities of the local and remote users on
the network.

Web Proxy Summary

Displays the activity of your remote users (vertical) over the specified
time (horizontal).

Total Web Proxy Activity: Local
Users

Displays the suspect transactions that have been detected due to Access
Policies defined for remote users (vertical) over the specified time
(horizontal).

Suspect Transactions Detected:
Remote Users

Displays a summary of suspected transactions of the remote users on
the network.

Suspect Transactions Summary

Displays the suspect transactions that have been detected due to Access
Policies defined for your remote users (vertical) over the specified time
(horizontal).

Suspect Transactions Detected:
Local Users
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DescriptionSection

Displays a summary of suspected transactions of the local users on the
network.

Suspect Transactions Summary

Web Tracking Page
Use theWeb Tracking page to search for and get details about individual transactions or patterns of transactions
that may be of concern. Depending on your needs, search in one of the following tabs:

Link to TaskWeb Tracking Page

Searching for Transactions Processed by the Web Proxy ,
on page 346

Transactions processed by the Web Proxy

Searching for Transactions Processed by the L4 Traffic
Monitor , on page 348

Transactions processed by the L4 Traffic
Monitor

Searching for Transactions Processed by the SOCKS Proxy
, on page 349

Transactions processed by the SOCKS Proxy

Searching for Transactions Processed by the Web Proxy
You can use the Proxy Services tab on the Reporting > Web Tracking page to track and report on web
usage for a particular user or for all users.

You can view search results for the type of transactions logged (blocked, monitored, warned, and completed)
during a particular time period. You can also filter the data results using several criteria, such as URL category,
malware threat, and application.

The Web Proxy only reports on transactions that include an ACL decision tag other than OTHER-NONE.Note

Step 1 Choose Reporting > Web Tracking.
Step 2 Click the Proxy Services tab.
Step 3 Configure the settings.

DescriptionSetting

Choose the time range on which to report.Time Range

(Optional) Enter an authentication username as it appears in reports or a client IP address that you
want to track. You can also enter an IP range in CIDR format.

When you leave this field empty, the search returns results for all users.

User/Client IP
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DescriptionSetting

(Optional) Enter a website that you want to track. When you leave this field empty, the search
returns results for all websites.

You can search for SNI (Server Name Indication). SNI, an extension of the TLS protocol,
enables clients to securely specify hostnames while performing web transactions. You
must specify entire words.

For SNI to work, AMP, and Reputation Services must be enabled.

Note

Website

Choose the type of transactions that you want to track, either All Transactions, Completed, Blocked,
Monitored, or Warned.

Transaction Type

Step 4 (Optional) Expand the Advanced section and configure the fields to filter the web tracking results with more advanced
criteria.

DescriptionSetting

To filter by a URL category, select Filter by URL Category and type the first letter of a URL
category by which to filter. Choose the category from the list that appears.

URL Category

To filter by an application, select Filter by Application and choose an application by which to
filter.

To filter by an application type, select Filter by Application Type and choose an application
type by which to filter.

Application

To filter by the name of the policy responsible for the final decision on this transaction, select
Filter by Action Policy and enter a policy group name (Access Policy, Decryption Policy, or
Data Security Policy) by which to filter. See the description for PolicyGroupName in the section
Web Proxy Information in Access Log Files, on page 373 for more information.

Policy

See About Web Tracking and Advanced Malware Protection Features , on page 276.Advanced Malware
Protection

To filter by a particular malware threat, select Filter by Malware Threat and enter a malware
threat name by which to filter.

To filter by a malware category, select Filter by Malware Category and choose a malware
category by which to filter.

Malware Threat

In the WBRS section, you can filter by web reputation score and by a particular web reputation
threat.

• To filter by web reputation score, select Score Range and select the upper and lower values
by which to filter. Or, you can filter for websites that have no score by selecting No Score.

• To filter by web reputation threat, select Filter by Reputation Threat and enter a web
reputation threat by which to filter.

WBRS

To filter by the location of users (either remote or local), select Filter by User Location and
choose a user type by which to filter.

AnyConnect Secure
Mobility
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DescriptionSetting

To filter by transactions that were initiated by the client, select Filter by User-Requested
Transactions.

When you enable this filter, the search results include some “best guess” transactions.Note

User Request

Enable this filter for encapsulated URL transactions.

Note • You must enable the HTTPS Proxy. See Enabling the HTTPS Proxy, on page
226

• Ensure that the web reputation score range for https://translate.google.com is set
to decrypt. See ConfiguringWeb Reputation Filter Settings for Decryption Policy
Groups, on page 254

Encapsulated URL
Protection

Step 5 Click Search.

Results are sorted by time stamp, with the most recent result at the top.

The number in parentheses below the “Display Details” link is the number of related transactions spawned by the
user-initiated transaction, such as images loaded, javascripts run, and secondary sites accessed.

Step 6 (Optional) Click Display Details in the Transactions column to view more detailed information about each transaction.

If you need to viewmore than 1000 results, click the Printable Download link to obtain a CSV file that includes
the complete set of raw data, excluding details of related transactions.

Note

If a URL in the results is truncated, you can find the full URL in the access log.Tip

To view details for up to 500 related transactions, click the Related Transactions link.

What to do next

• URL Category Set Updates and Reports , on page 341
• Malware Category Descriptions, on page 258
• About Web Tracking and Advanced Malware Protection Features , on page 276

Searching for Transactions Processed by the L4 Traffic Monitor
The L4 Traffic Monitor tab on the Reporting > Web Tracking page provides details about connections to
malware sites and ports. You can search for connections to malware sites by the following types of information:

• Time range
• Site, using IP address or domain
• Port
• IP address associated with a computer in your organization
• Connection type

The first 1000 matching search results are displayed.
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Searching for Transactions Processed by the SOCKS Proxy
You can search for transactions that meet a variety of criteria, including blocked or completed transactions;
users; and destination domain, IP address, or port.

Step 1 Choose Web > Reporting > Web Tracking.
Step 2 Click the SOCKS Proxy tab.
Step 3 To filter results, click Advanced.
Step 4 Enter search criteria.
Step 5 Click Search.

What to do next

SOCKS Proxy Page , on page 345

System Capacity Page
The Reporting > System Capacity page displays current and historical information about resource usage on
the Web Security appliance.

When choosing time ranges for viewing data on the System Capacity page, the following is important to
remember:

• Hour Report. The Hour report queries the minute table and displays the exact number of items, such as
bytes and connection, that have been recorded by the appliance on an minute by minute basis over a 60
minute period.

• Day Report. The Day report queries the hour table and displays the exact number of items, such as bytes
and connection, that have been recorded by the appliance on an hourly basis over a 24 hour period. This
information is gathered from the hour table.

The Week Report and 30 Days Report work similarly to the Hour and Day Reports.

System Status Page
Use the Reporting > System Status page to monitor the System Status. This page displays the current status
and configuration of the Web Security appliance.
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DisplaysThis Section...

• System uptime

• System resource utilization — CPU usage, RAM usage, and percentage of
disk space used for reporting and logging.

The CPU utilization value shown on this page and the CPU value shown on the
systemOverview page (Overview Page, on page 337) may differ slightly because
they are read separately, at differing moments.

RAM usage for a system that is working efficiently may be above 90%, because
RAM that is not otherwise in use by the system is used by the web object cache.
If your system is not experiencing serious performance issues and this value is
not stuck at 100%, the system is operating normally.

Proxy Buffer Memory is one component that uses this RAM.Note

Web Security Appliance
Status

• Transactions per second

• Bandwidth

• Response time

• Cache hit rate

• Connections

Proxy Traffic
Characteristics

Web Traffic Tap CPU Utilization.Web Traffic Tap

Status of High Availability service.High Availability

• Identity Services EngineExternal Services

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
350

Web Security Appliance Reports
System Status Page



DisplaysThis Section...

Web Proxy settings:

• Web Proxy Status — enabled or disabled.

• Deployment Topology.

• Web Proxy Mode — forward or transparent.

• IP Spoofing — enabled or disabled.

L4 Traffic Monitor settings:

• L4 Traffic Monitor Status — enabled or disabled.

• L4 Traffic Monitor Wiring.

• L4 Traffic Monitor Action — monitor or block.

Web Traffic Tap settings:

• Web Traffic Tap Status — enabled or disabled

• Web Traffic Tap Interface — P1, P2, TI, or T2

Web Security Appliance Version Information

Hardware information

Current Configuration

Related Topics

System Capacity Page, on page 349
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C H A P T E R 21
Detecting Rogue Traffic on Non-Standard Ports

This chapter contains the following sections:

• Overview of Detecting Rogue Traffic, on page 353
• Configuring the L4 Traffic Monitor, on page 353
• List of Known Sites, on page 354
• Configuring L4 Traffic Monitor Global Settings, on page 354
• Updating L4 Traffic Monitor Anti-Malware Rules, on page 355
• Creating a Policy to Detect Rogue Traffic, on page 355
• Viewing L4 Traffic Monitor Activity, on page 356

Overview of Detecting Rogue Traffic
The Web Security appliance has an integrated Layer-4 Traffic Monitor that detects rogue traffic across all
network ports and stops malware attempts to bypass port 80. When internal clients are infected with malware
and attempt to phone-home across non-standard ports and protocols, the L4 Traffic Monitor prevents
phone-home activity from going outside the corporate network. By default, the L4 Traffic Monitor is enabled
and set to monitor traffic on all ports. This includes DNS and other services.

The L4 Traffic Monitor uses and maintains its own internal database. This database is continuously updated
with matched results for IP addresses and domain names.

Configuring the L4 Traffic Monitor

Step 1 Configure the L4 Traffic Monitor inside the firewall.

Step 2 Ensure the L4 Traffic Monitor is “logically” connected after the proxy ports and before any device that performs network
address translation (NAT) on client IP addresses.

Step 3 Configure the Global Settings

See Configuring L4 Traffic Monitor Global Settings, on page 354.

Step 4 Create L4 TrafficMonitor Policies
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See Creating a Policy to Detect Rogue Traffic, on page 355.

List of Known Sites
DescriptionAddress

Any IP address or hostname listed in the Allow List property. These addresses appear
in the log files as “allowed list” addresses.

Known allowed

Any IP address that is not known to be a malware site nor is a known allowed address.
They are not listed on the AllowList, Additional SuspectedMalware Addresses properties,
or in the L4 Traffic Monitor Database. These addresses do not appear in the log files.

Unlisted

These appear in the log files as “greylist” addresses and include:

• Any IP address that is associated with both an unlisted hostname and a known
malware hostname .

• Any IP address that is associated with both an unlisted hostname and a hostname
from the Additional Suspected Malware Addresses property

Ambiguous

These appear in the log files as “blocked list” addresses and include:

• Any IP address or hostname that the L4 Traffic Monitor Database determines to be
a known malware site and not listed in the Allow List.

• Any IP address that is listed in the Additional Suspected Malware Addresses
property, not listed in the Allow List and is not ambiguous

Known malware

Configuring L4 Traffic Monitor Global Settings

Step 1 Choose Security Services > L4 Traffic Monitor.
Step 2 Click Edit Global Settings.
Step 3 Choose whether or not to enable the L4 Traffic Monitor.
Step 4 When you enable the L4 Traffic Monitor, choose which ports it should monitor:

• All ports. Monitors all 65535 TCP ports for rogue activity.

• All ports except proxy ports. Monitors all TCP ports except the following ports for rogue activity.

• Ports configured in the “HTTP Ports to Proxy” property on the Security Services > Web Proxy page (usually
port 80).

• Ports configured in the “Transparent HTTPS Ports to Proxy” property on the Security Services > HTTPS Proxy
page (usually port 443).

Step 5 Submit and Commit Changes.
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Updating L4 Traffic Monitor Anti-Malware Rules

Step 1 Choose Security Services > L4 Traffic Monitor.
Step 2 Click Update Now.

Creating a Policy to Detect Rogue Traffic
The actions the L4 Traffic Monitor takes depends on the L4 Traffic Monitor policies you configure :

Step 1 Choose Web Security Manager > L4 Traffic Monitor.
Step 2 Click Edit Settings.
Step 3 On the Edit L4 Traffic Monitor Policies page, configure the L4 Traffic Monitor policies:

a) Define the Allow List
b) Add known good sites to the Allow List

Do not include the Web Security appliance IP address or hostname to the Allow List otherwise the L4
Traffic Monitor does not block any traffic.

Note

c) Determine which action to perform for Suspected Malware Addresses:

DescriptionAction

It always allows traffic to and from known allowed and unlisted addressesAllow

It monitors traffic under the following circumstances:

• When the Action for Suspected Malware Addresses option is set to Monitor, it always
monitors all traffic that is not to or from a known allowed address.

• When the Action for Suspected Malware Addresses option is set to Block, it monitors
traffic to and from ambiguous addresses

Monitor

When the Action for Suspected Malware Addresses option is set to Block, it blocks traffic to
and from known malware addresses

Block

- When you choose to block suspected malware traffic, you can also choose whether or not to always block
ambiguous addresses. By default, ambiguous addresses are monitored.

- If the L4 Traffic Monitor is configured to block, the L4 Traffic Monitor and the Web Proxy must be
configured on the same network. Use the Network > Routes page to confirm that all clients are accessible
on routes that are configured for data traffic.

Note

d) Define the Additional Suspected Malware Addresses properties

Adding internal IP addresses to the Additional SuspectedMalwareAddresses list causes legitimate destination
URLs to show up as malware in L4 Traffic Monitor reports. To avoid this do not enter internal IP addresses
in the “Additional Suspected Malware Addresses” field on the Web Security Manager > L4 Traffic
Monitor Policies page.

Note
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Step 4 Submit and Commit Changes.

What to do next

Related Topics

• Overview of Detecting Rogue Traffic, on page 353
• Valid Formats, on page 356.

Valid Formats
When you add addresses to the Allow List or Additional Suspected Malware Addresses properties, separate
multiple entries with whitespace or commas. You can enter addresses in any of the following formats:

• IPv4 IP address. Example: IPv4 format: 10.1.1.0. IPv6 format: 2002:4559:1FE2::4559:1FE2
• CIDR address. Example: 10.1.1.0/24.
• Domain name. Example: example.com.
• Hostname. Example: crm.example.com.

Viewing L4 Traffic Monitor Activity
The S-Series appliance supports several options for generating feature specific reports and interactive displays
of summary statistics.

Monitoring Activity and Viewing Summary Statistics
The Reporting > L4 Traffic Monitor page provides statistical summaries of monitoring activity. You can
use the following displays and reporting tools to view the results of L4 Traffic Monitor activity:

See...To view...

Reporting > Client ActivityClient statistics

Reporting > L4 Traffic MonitorMalware statistics

Port statistics

System Administration > Log Subscriptions

• trafmon_errlogs
• trafmonlogs

L4 Traffic Monitor log files

If the Web Proxy is configured as a forward proxy and L4 Traffic Monitor is set to monitor all ports, the IP
address of the proxy’s data port is recorded and displayed as a client IP address in the client activity report
on the Reporting > Client Activity page. If the Web Proxy is configured as a transparent proxy, enable IP
spoofing to correctly record and display the client IP addresses.

Note
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L4 Traffic Monitor Log File Entries
The L4 Traffic Monitor log file provides a detailed record of monitoring activity.
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C H A P T E R 22
Monitor System Activity Through Logs

This chapter contains the following sections:

• Overview of Logging, on page 359
• Common Tasks for Logging, on page 360
• Best Practices for Logging, on page 360
• Troubleshooting Web Proxy Issues Using Logs, on page 360
• Log File Types, on page 361
• Adding and Editing Log Subscriptions, on page 366
• Pushing Log Files to Another Server, on page 371
• Using Configuration History Logs, on page 371
• Archiving Log Files, on page 372
• Log File Names and Appliance Directory Structure, on page 372
• Viewing Log Files, on page 373
• Web Proxy Information in Access Log Files, on page 373
• W3C Compliant Access Log Files, on page 389
• Customizing Access Logs, on page 391
• Traffic Monitor Log Files, on page 395
• Log File Fields and Tags, on page 396
• Troubleshooting Logging, on page 409

Overview of Logging
The Web Security appliance records its own system and traffic management activities by writing them to log
files. Administrators can consult these log files to monitor and troubleshoot the appliance.

The appliance divides different types of activity into different logging types to simplify the task of finding
information on specific activities. The majority of these are automatically enabled by default, but some must
be manually enabled as required.

You enable and manage log files through log file subscriptions. Subscriptions allow you to define the settings
for creating, customizing, and managing log files.

The two main log files types typically used by administrators are:

• Access log. This records all Web Proxy filtering and scanning activity.
• Traffic Monitor log. This records all Layer-4 Traffic Monitor activity.
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You can view current and past appliance activity using these and other log types. Reference tables are available
to help you interpret log file entries.

Related Topics

• Common Tasks for Logging, on page 360
• Log File Types, on page 361

Common Tasks for Logging
Links to Related Topics and ProceduresTask

Adding and Editing Log Subscriptions, on page 366Add and edit log subscriptions

Viewing Log Files, on page 373View log files

Interpreting Access Log Scanning Verdict Entries, on page
383

Interpret log files

Customizing Access Logs, on page 391Customize log files

Pushing Log Files to Another Server, on page 371Push log files to another server

Archiving Log Files, on page 372Archiving log files

Best Practices for Logging
• Minimizing the number of log subscriptions will benefit system performance.
• Logging fewer details will benefit system performance.

Troubleshooting Web Proxy Issues Using Logs
By default, the Web Security appliance has one log subscription created for Web Proxy logging messages,
called the “Default Proxy Logs.” This captures basic information on all Web Proxy modules. The appliance
also includes log file types for each Web Proxy module so you can read more specific debug information for
each module without cluttering up the Default Proxy Logs.

Follow the steps below to troubleshoot Web Proxy issues using the various logs available.

Step 1 Read the Default Proxy Logs.
Step 2 If you see an entry that might related to the issue but does not have enough information to resolve it, create a log subscription

for the relevant specific Web Proxy module. The following Web Proxy module logs types are available:
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Logging Framework Logs

McAfee Integration Framework Logs

Memory Manager Logs

Miscellaneous Proxy Modules Logs

Request Debug Logs

SNMP Module Logs

Sophos Integration Framework Logs

WBRS Framework Logs

WCCP Module Logs

Webcat Integration Framework Logs

Webroot Integration Framework Logs

Access Control Engine Logs

AVC Engine Framework Logs

Configuration Logs

ConnectionManagement Logs

Data Security Module Logs

DCA Engine Framework Logs

Disk Manager Logs

FireAMP

FTP Proxy Logs

HTTPS Logs

License Module Logs

Step 3 Recreate the issue and read the new Web Proxy module log for relevant entries.
Step 4 Repeat as required with other Web Proxy module logs.
Step 5 Remove subscriptions that are no longer required.

What to do next

Related Topics

• Log File Types, on page 361
• Adding and Editing Log Subscriptions, on page 366

Log File Types
Some log types related to the web proxy component are not enabled. The main web proxy log type, called
the “Default Proxy Logs,” is enabled by default and captures basic information on all Web Proxy modules.
Each Web Proxy module also has its own log type that you can manually enable as required.

The following table describes the Web Security appliance log file types.

Enabled by
Default?

Supports
Syslog Push?

DescriptionLog File Type

NoNoRecords messages related to the Web Proxy ACL
(access control list) evaluation engine.

Access Control Engine
Logs

YesYesRecords information about file reputation scanning
and file analysis (Advanced Malware Protection.)

See also Log Files , on page 277.

AMP Engine Logs
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Enabled by
Default?

Supports
Syslog Push?

DescriptionLog File Type

YesYesRecords AAA (Authentication, Authorization, and
Accounting) events. Records all user interaction
with the application and command-line interfaces,
and captures committed changes.

Some of the audit log details are as follows:

• User - Logon

• User - Logon failed incorrect password

• User - Logon failed unknown user name

• User - Logon failed account expired

• User - Logoff

• User - Lockout

• User - Activated

• User - Password change

• User - Password reset

• User - Security settings/profile change

• User - Created

• User - Deleted/modified

• Group/Role - Deletion / modified

• Group /Role - Permissions change

Audit Logs

YesYesRecords Web Proxy client history.Access Logs

YesNoRecords authentication history and messages.Authentication
Framework Logs

NoNoRecords messages related to communication
between the Web Proxy and the AVC engine.

AVC Engine
Framework Logs

YesYesRecords debug messages from the AVC engine.AVC Engine Logs

YesYesRecords a historical audit of command line interface
activity.

CLI Audit Logs

NoNoRecords messages related to the Web Proxy
configuration management system.

Configuration Logs

NoNoRecords the appliance configuration on every
commit and sends the previous configuration file
prior to the current one to a remotely located backup
server through FTP or SCP.

Configuration History
Logs
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Enabled by
Default?

Supports
Syslog Push?

DescriptionLog File Type

NoNoRecords messages related to the Web Proxy
connection management system.

Connection
Management Logs

YesYesRecords client history for upload requests that are
evaluated by the Cisco Data Security Filters.

Data Security Logs

NoNoRecordsmessages related to the CiscoData Security
Filters.

Data Security Module
Logs

NoNoRecords messages related to communication
between the Web Proxy and the Cisco Web Usage
Controls Dynamic Content Analysis engine.

DCA Engine
Framework Logs

(Dynamic Content
Analysis)

YesYesRecords messages related to the Cisco Web Usage
Controls Dynamic Content Analysis engine.

DCA Engine Logs

(Dynamic Content
Analysis)

YesYesRecords errors related to the Web Proxy.

This is the most basic of allWeb Proxy related logs.
To troubleshoot more specific aspects related to the
Web Proxy, create a log subscription for the
applicable Web Proxy module.

Default Proxy Logs

NoNoRecords Web Proxy messages related to writing to
the cache on disk.

Disk Manager Logs

YesNoRecords messages related to using the external
authentication feature, such as communication
success or failure with the external authentication
server.

Even with external authentication is disabled, this
log containsmessages about local users successfully
or failing logging in.

External
Authentication Logs

YesYesRecords the web users reporting misclassified
pages.

Feedback Logs

NoNoRecords error and warning messages related to the
FTP Proxy.

FTP Proxy Logs

YesYesRecords all files uploaded to and downloaded from
the Web Security appliance using FTP.

FTP Server Logs

YesYesRecords history of page refreshes in the web
interface. GUI logs also include information about
SMTP transactions, for example information about
scheduled reports emailed from the appliance.

GUI Logs

(Graphical User
Interface)
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Enabled by
Default?

Supports
Syslog Push?

DescriptionLog File Type

YesYesHaystack logs record web transaction tracking data
processing.

Haystack Logs

NoNoRecords Web Proxy messages specific to the
HTTPS Proxy (when the HTTPS Proxy is enabled).

HTTPS Logs

YesYesRecords ISE server(s) connection and operational
information.

ISE Server Logs

NoNoRecords messages related to the Web Proxy’s
license and feature key handling system.

License Module Logs

NoNoRecords messages related to the Web Proxy’s
logging system.

Logging Framework
Logs

YesYesRecords errors related to log management.Logging Logs

NoNoRecords messages related to communication
between the Web Proxy and the McAfee scanning
engine.

McAfee Integration
Framework Logs

YesYesRecords the status of anti-malware scanning activity
from the McAfee scanning engine.

McAfee Logs

NoNoRecords Web Proxy messages related to managing
all memory including the in-memory cache for the
Web Proxy process.

MemoryManagerLogs

NoNoRecords Web Proxy messages that are mostly used
by developers or customer support.

Miscellaneous Proxy
Modules Logs

YesYesRecords the interaction between the Web Security
appliance and the AnyConnect client, including the
status check.

AnyConnect Secure
MobilityDaemonLogs

YesYesRecords changes to the system time made by the
Network Time Protocol.

NTP Logs

(Network Time
Protocol)

YesYesRecords proxy auto-config (PAC) file usage by
clients.

PAC File Hosting
Daemon Logs

YesNoRecords transactions that bypass the Web Proxy.Proxy Bypass Logs

YesYesRecords a history of report generation.Reporting Logs

YesYesRecords errors related to report generation.Reporting Query Logs
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Enabled by
Default?

Supports
Syslog Push?

DescriptionLog File Type

NoNoRecords very detailed debug information on a
specific HTTP transaction from all Web Proxy
module log types. You might want to create this
log subscription to troubleshoot a proxy issue with
a particular transaction without creating all other
proxy log subscriptions.

Note: You can create this log subscription in the
CLI only.

Request Debug Logs

YesYesRecords messages related to the Access Control
feature.

Auth Logs

YesYesRecords a history of the health of system services
and a history of unexpected daemon restarts.

SHD Logs

(System Health
Daemon)

YesYesRecords debug messages related to the SNMP
network management engine.

SNMP Logs

NoNoRecordsWeb Proxymessages related to interacting
with the SNMP monitoring system.

SNMP Module Logs

NoNoRecords messages related to communication
between the Web Proxy and the Sophos scanning
engine.

Sophos Integration
Framework Logs

YesYesRecords the status of anti-malware scanning activity
from the Sophos scanning engine.

Sophos Logs

YesYesRecords information related to the system, such as
feature key downloads.

Status Logs

YesYesRecords DNS, error, and commit activity.System Logs

YesYesRecords L4TM interface and capture errors.Traffic Monitor Error
Logs

YesNoRecords sites added to the L4TM block and allow
lists.

Traffic Monitor Logs

YesYesRecords data about how the Web Proxy discovers
the user name without doing actual authentication.
It includes information about interacting with the
Cisco adaptive security appliance for the Secure
Mobility as well as integrating with the Novell
eDirectory server for transparent user identification.

UDS Logs

(User Discovery
Service)

YesYesRecords a history of WBRS and other updates.Updater Logs
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Enabled by
Default?

Supports
Syslog Push?

DescriptionLog File Type

NoYesRecords Web Proxy client history in a W3C
compliant format.

For more information, seeW3CCompliant Access
Log Files, on page 389.

W3C Logs

YesNoRecords a history of Cisco SensorBase Network
participation uploads to the SensorBase network.

WBNP Logs

(SensorBase Network
Participation)

NoNoRecords messages related to communication
between the Web Proxy and the Web Reputation
Filters.

WBRS Framework
Logs

(Web Reputation
Score)

NoNoRecords Web Proxy messages related to
implementing WCCP.

WCCP Module Logs

NoNoRecords messages related to communication
between the Web Proxy and the URL filtering
engine associated with CiscoWeb Usage Controls.

Webcat Integration
Framework Logs

NoNoRecords messages related to communication
between the Web Proxy and the Webroot scanning
engine.

Webroot Integration
Framework Logs

YesYesRecords the status of anti-malware scanning activity
from the Webroot scanning engine.

Webroot Logs

YesYesRecords a history of web clients who click the
Accept button on the end-user acknowledgement
page.

Welcome Page
Acknowledgement
Logs

Adding and Editing Log Subscriptions
You can create multiple log subscriptions for each type of log file. Subscriptions include configuration details
for archiving and storage, including these:

• Rollover settings, which determine when log files are archived.
• Compression settings for archived logs.
• Retrieval settings for archived logs, which specifies whether logs are archived onto a remote server or
stored on the appliance.

Step 1 Choose System Administration > Log Subscriptions.
Step 2 To add a log subscription, click Add Log Subscription. Or, to edit a log subscription, click the name of the log file in

the Log Name field.

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
366

Monitor System Activity Through Logs
Adding and Editing Log Subscriptions



Step 3 Configure the subscription:

DescriptionOption

A list of available log file types that you can subscribe to. The other options on the page may
change according to log file type you choose.

The Request Debug Logs log type can only be subscribed to using the CLI and does
not appear on this list.

Note

Log Type

The name used to refer to the subscription on the Web Security appliance. This name is also used
for the log directory which will store the log files for the subscription. Enter only ASCII characters
([0-9], [A-Z], [a-z], and_).

Log Name

The maximum file size to which the current log file can grow before it is archived and a new log
file started. Enter a number between 100 kilobytes and 10 gigabytes.

Rollover by File
Size

The maximum time interval before the current log file is archived and a new log file started. The
following interval types are available:

• None. AsyncOS only performs a rollover when the log file reaches the maximum file size.
• Custom Time Interval. AsyncOS performs a rollover after a specified amount of time has
passed since the previous rollover. Specify the number of days, hours, minutes, and seconds
between rollovers using d , h , m , and s as suffixes.

• Daily Rollover.AsyncOS performs a rollover every day at a specified time. Separate multiple
times a day using a comma. Use an asterisk (*) for the hour to have rollover occur every hour
during the day. You can also use an asterisk to rollover every minute of an hour.

• Weekly Rollover.AsyncOS performs a rollover on one or more days of the week at a specified
time.

Rollover by Time

Specifies the log format to use, either Squid, Apache, or Squid Details.Log Style

(Access Logs)

Allows you to include custom information in each access log entry.

The syntax for entering format specifiers in the Custom Field is as follows:

<format_specifier_1> <format_specifier_2> ...

For example: %a %b %E

You can add tokens before the format specifiers to display descriptive text in the access log file.
For example:

client_IP %a body_bytes %b error_type %E

where client_IP is the description token for log format specifier %a, and so on.

Custom Fields

(Access Logs)

The name of the log files. Current log files are appended with a .c extension and rolled over log
files are appended with the file creation timestamp and a .s extension.

File Name
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DescriptionOption

Allows you to choose the fields you want to include in the W3C access log.

Select a field in the Available Fields list, or type a field in the Custom Field box, and click Add.

The order the fields appear in the Selected Log Fields list determines the order of fields in the
W3C access log file. You can change the order of fields using the Move Up and Move Down
buttons. You can remove a field by selecting it in the Selected Log Fields list and clickingRemove.

You can enter multiple user defined fields in the Custom Fields box and add them simultaneously
as long as each entry is separated by a new line (click Enter) before clicking Add.

When you change the log fields included in a W3C log subscription, the log subscription
automatically rolls over. This allows the latest version of the log file to include the correct new
field headers

You can anonymize the c-ip, cs-username, or cs-auth-group log fields of W3C logs, if required.
Check the Anonymization check box to anonymize c-ip, cs-username, and cs-auth-group fields.
After you select the check box, the field names are changed to c-a-ip, cs-a-username, and
cs-a-auth-group respectively.

You must enable anonymization only if the external server to which the log files are
pushed is compatible to handle the anonymization feature.

Note

After the log creation you can deanonymize the anonymized fields, if required. See Deanonymizing
W3C Log Fields, on page 370

Log Fields

(W3C Access Logs)

Allows you to create passphrase for encrypting the field values. This area will be enabled only
when you choose to anonymize c-ip, cs-username, or cs-auth-group log fields.

Sytem applies passphrase rules while configuring passphrase for anonymization.Note

To automatically generate a passphrase, check the check box next to Auto Generate Passphrase
and click Generate

If you have multiple appliances, all the appliances must set the same passphrase.Note

Passphrase for
Anonymization

(W3C Access Logs)

Specifies whether or not rolled over files are compressed. AsyncOS compresses log files using
the gzip compression format.

Log Compression

Allows you to specify HTTP status codes (4xx or 5xx only) to exclude the associated transactions
from an access log or a W3C access log.

For example, entering 401 will filter out authentication failure requests that have that transaction
number.

Log Exclusions
(Optional)

(Access Logs)
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DescriptionOption

Specifies the level of detail for log entries. Choose from:

• Critical. Includes errors only. This is the least detailed setting and is equivalent to the syslog
level “Alert.”

• Warning. Includes errors and warnings. This log level is equivalent to the syslog level
“Warning.”

• Information. Includes errors, warnings and additional system operations. This is the default
detail level and is equivalent to the syslog level “Info.”

• Debug. Includes data useful for debugging system problems. Use the Debug log level when
you are trying to discover the cause of an error. Use this setting temporarily, and then return
to the default level. This log level is equivalent to the syslog level “Debug.”

• Trace. This is the most detailed setting. This level includes a complete record of system
operations and activity. The Trace log level is recommended only for developers. Using this
level causes a serious degradation of system performance and is not recommended. This log
level is equivalent to the syslog level “Debug.”

More detailed settings create larger log files and have a greater impact on system
performance.

Note

Log Level

Specifies where rolled over log files are stored and how they are retrieved for reading. See below
for descriptions of the available methods.

Retrieval Method

The FTP on Appliance method (equivalent to FTP Poll) requires a remote FTP client accessing
the appliance to retrieve log files using an admin or operator user’s username and passphrase.

When you choose this method, you must enter the maximum number of log files to store on the
appliance. When the maximum number is reached, the system deletes the oldest file.

This is the default retrieval method.

Retrieval Method:

FTP on Appliance

The FTP on Remote Server method (equivalent to FTP Push) periodically pushes log files to an
FTP server on a remote computer.

When you choose this method, you must enter the following information:

• FTP server hostname
• Directory on FTP server to store the log file
• Username and passphrase of a user that has permission to connect to the FTP server

AsyncOS for Web only supports passive mode for remote FTP servers. It cannot push
log files to an FTP server in active mode.

Note

Retrieval Method:

FTP on Remote
Server

The SCP on Remote Server method (equivalent to SCP Push) periodically pushes log files using
the secure copy protocol to a remote SCP server. This method requires an SSH SCP server on a
remote computer using the SSH2 protocol. The subscription requires a user name, SSH key, and
destination directory on the remote computer. Log files are transferred based on a rollover schedule
set by you.

When you choose this method, you must enter the following information:

• SCP server hostname
• Directory on SCP server to store the log file
• Username of a user that has permission to connect to the SCP server

Retrieval Method:

SCP on Remote
Server
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DescriptionOption

You can only choose syslog for text-based logs.

The Syslog Push method sends log messages to a remote syslog server on port 514. This method
conforms to RFC 3164.

When you choose this method, you must enter the following information:

• Syslog server hostname
• Protocol to use for transmission, either UDP or TCP
• Maximum message size

Valid values for UDP are 1024 to 9216.

Valid values for TCP are 1024 to 65535.

Maximum message size depends on the syslog server configuration.

• Facility to use with the log

Retrieval Method:

Syslog Push

Step 4 Submit and commit your changes.

What to do next

If you chose SCP as the retrieval method, notice that the appliance displays an SSH key, which you will add
to the SCP server host. See Pushing Log Files to Another Server, on page 371.

Related Topics

• Log File Types, on page 361
• Log File Names and Appliance Directory Structure, on page 372

Deanonymizing W3C Log Fields
If you have enabled anonymization feature for field values (c-ip, cs-username, and cs-auth-group) during log
subscription, the destination log server will receive the anonymized values ( c-a-ip, cs-a-username, and
cs-a-auth-group) of those log fields and not the actual values. If you want to view the actual values you must
deanonymize the log fields.

You can deanonymize c-a-ip, cs-a-username, and cs-a-auth-group log field values that are anonymized while
adding the W3C log subscription.

Step 1 Choose System Administration > Log Subscriptions.
Step 2 Click Deanonymization in the Denonymization column corresponding to the log for which you want to deanonymize

the anonymized fields.
Step 3 In the Method area, choose any of the following methods to enter the encrypted text for deanonymization.

• Paste encrypted text – Paste only the encrypted text in the Anonymized Text field. You can enter a maximum of
500 entries in this field. You must separate the multiple entries with a comma.

• Upload File –Choose a file that contains the encrypted text. The file can contain a maximum of 1000 entries. The
file format should be CSV. The system supports space, new line, tab, and semi colon as the field separator.
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If you have changed the passphrase, you must enter the old passphrase to deanonymize the older data.Note

Step 4 Click Deanonymize and the Deanonymization Result table displays the deanonymized log field values.

Pushing Log Files to Another Server
Before you begin

Create or edit the desired log subscription, choosing SCP as the retrieval method. Adding and Editing Log
Subscriptions, on page 366

Step 1 Add keys to the remote system:
a) Access the CLI.
b) Enter the logconfig -> hostkeyconfig command.
c) Use the commands below to display the keys:

DescriptionCommand

Display system host keys. This is the value to place in the remote system’s ‘known_hosts’
file.

Host

Displays the public key of the system account that pushes the logs to the remote machine.
This is the same key that is displayed when setting up an SCP push subscription. This is the
value to place in the remote system’s ‘authorized_keys’ file.

User

d) Add these keys to the remote system.

Step 2 Still in the CLI, add the remote server’s SSH public host key to the appliance:

DescriptionCommand

Add a new key.New

Display system host key fingerprints.Fingerprint

Step 3 Commit your changes.

Using Configuration History Logs
A configuration history log consists of a configuration file with an additional section listing the name of the
user, a description of where in the configuration the user made changes, and the comment the user entered
when committing the change. Each time a user commits a change, a new log is created containing the
configuration file after the change.
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Archiving Log Files
AsyncOS archives (rolls over) log subscriptions when a current log file reaches a user-specified limit of
maximum file size or maximum time since last rollover.

These archive settings are included in log subscriptions:

• Rollover by File Size
• Rollover by Time
• Log Compression
• Retrieval Method

You can also manually archive (rollover) log files.

Step 1 Choose System Administration > Log Subscriptions.
Step 2 Check the checkbox in the Rollover column of the log subscriptions you wish to archive, or check the All checkbox to

select all the subscriptions.
Step 3 Click Rollover Now to archive the selected logs.

What to do next

Related Topics

• Adding and Editing Log Subscriptions, on page 366
• Log File Names and Appliance Directory Structure, on page 372

Log File Names and Appliance Directory Structure
The appliance creates a directory for each log subscription based on the log subscription name. The name of
the log file in the directory is composed of the following information:

• Log file name specified in the log subscription
• Timestamp when the log file was started
• A single-character status code, either .c (signifying current) or .s (signifying saved)

The filename of logs are made using the following formula:

/LogSubscriptionName/LogFilename.@timestamp.statuscode

You should only transfer log files with the saved status.Note

Reading and Interpreting Log Files
You can read current log file activity as a means of monitoring and troubleshooting theWeb Security appliance.
This is done using the appliance interface.
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You can also read archived files for a record of past activity. This can be done using the appliance interface
if the archived files are stored on the appliance; otherwise they must be read from their external storage location
using an appropriate method.

Each item of information in a log file is represented by a field variable. By determining which fields represent
which items of information, you can look up the field function and interpret the log file contents. For W3C
compliant access logs, the file header lists field names in the order in which they appear in log entries. For
standard Access logs, however, you must consult the documentation regarding this log type for information
on its field order.

Related Topics

• Viewing Log Files, on page 373.
• Web Proxy Information in Access Log Files, on page 373.
• Interpreting W3C Access Logs, on page 389.
• Interpreting Traffic Monitor Logs, on page 395.
• Log File Fields and Tags, on page 396.

Viewing Log Files
Before you begin

Be aware that this method of viewing is for log files that are stored on the appliance. The process of viewing
files stored externally goes beyond the scope of this documentation.

Step 1 Choose System Administration > Log Subscriptions.
Step 2 Click the name of the log subscription in the Log Files column of the list of log subscriptions.
Step 3 When prompted, enter the administers username and passphrase for accessing the appliance.
Step 4 When logged in, click one of the log files to view it in your browser or to save it to disk.
Step 5 Refresh the browser for updated results.

If a log subscription is compressed, download, decompress, and then open it.Note

What to do next

Related Topics

• Web Proxy Information in Access Log Files, on page 373.
• Interpreting W3C Access Logs, on page 389.
• Interpreting Traffic Monitor Logs, on page 395.

Web Proxy Information in Access Log Files
Access log files provides a descriptive record of all Web Proxy filtering and scanning activity. Access log
file entries display a record of how the appliance handled each transaction.
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Access logs are available in two formats: Standard and W3C compliant. W3C-compliant log files are more
customizable with regard to their content and layout than standard Access logs.

The following text is an example access log file entry for a single transaction:

Field DescriptionField ValueFormat Specifier

Timestamp since UNIX epoch.1278096903.150%t

Elapsed time (latency) in
milliseconds.

97%e

Client IP address.

Note: You can choose to mask the
IP address in the access logs using
the advancedproxyconfig >
authentication CLI command.

172.xx.xx.xx%a

Transaction result code.

For more information, see W3C
Compliant Access Log Files, on page
389.

TCP_MISS%w

HTTP response code.200%h

Response size (headers + body).8187%s

First line of the request.

Note: When the first line of the
request is for a native FTP
transaction, some special characters
in the file name are URL encoded in
the access logs. For example, the
“@” symbol is written as “%40” in
the access logs.

The following characters are URL
encoded:

& # % + , : ; = @ ^ { } [ ]

GET http://my.site.com/%1r

%2r

Authenticated username.

Note: You can choose to mask the
username in the access logs using the
advancedproxyconfig >
authentication CLI command.

–%A
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Field DescriptionField ValueFormat Specifier

Code that describes which server was
contacted for the retrieving the
request content.

Most common values include:

• NONE.TheWeb Proxy had the
content, so it did not contact any
other server to retrieve the
content.

• DIRECT.TheWeb Proxywent
to the server named in the
request to get the content.

• DEFAULT_PARENT. The
Web Proxy went to its primary
parent proxy or an external DLP
server to get the content.

DIRECT%H

Data source or server IP address.my.site.com%d

Response body MIME type.text/plain%c

ACL decision tag.

Note: The end of the ACL decision
tag includes a dynamically generated
number that the Web Proxy uses
internally. You can ignore this
number.

For more information, see ACL
Decision Tags, on page 377.

DEFAULT_CASE_11%D

Name of policy group responsible
for the final decision on this
transaction (Access Policy,
Decryption Policy, or Data Security
Policy). When the transaction
matches a global policy, this value is
“DefaultGroup.”

Any space in the policy group name
is replaced with an underscore ( _ ).

PolicyGroupNameN/A (Part of the ACL
decision tag)

Identity policy group name.

Any space in the policy group name
is replaced with an underscore ( _ ).

IdentityN/A (Part of the ACL
decision tag)
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Field DescriptionField ValueFormat Specifier

OutboundMalware Scanning Policy
group name.

Any space in the policy group name
is replaced with an underscore ( _ ).

OutboundMalwareScanningPolicyN/A (Part of the ACL
decision tag)

Cisco Data Security Policy group
name.When the transactionmatches
the global Cisco Data Security
Policy, this value is “DefaultGroup.”
This policy group name only appears
when Cisco Data Security Filters is
enabled. “NONE” appears when no
Data Security Policy was applied.

Any space in the policy group name
is replaced with an underscore ( _ ).

DataSecurityPolicyN/A (Part of the ACL
decision tag)

External DLP Policy group name.
When the transaction matches the
global External DLP Policy, this
value is “DefaultGroup.” “NONE”
appears when no External DLP
Policy was applied.

Any space in the policy group name
is replaced with an underscore ( _ ).

ExternalDLPPolicyN/A (Part of the ACL
decision tag)

Routing Policy group name as
ProxyGroupName/ProxyServerName
.

When the transaction matches the
global Routing Policy, this value is
“DefaultRouting.” When no
upstream proxy server is used, this
value is “DIRECT.”

Any space in the policy group name
is replaced with an underscore ( _ ).

RoutingPolicyN/A (Part of the ACL
decision tag)

Scanning verdict information. Inside
the angled brackets, the access logs
include verdict information from
various scanning engines.

For more information about the
values included within the angled
brackets, see InterpretingAccess Log
Scanning Verdict Entries, on page
383 and Malware Scanning Verdict
Values, on page 407.

<IW_comp,6.9,-,"-",-,-,-,-,"-",-,-,-,
"-",-,-,""-","-",-,-,IW_comp,
-,"-","-",
"Unknown","Unknown","-","-",
198.34,0,-,[Local],"-",37,
"W32.CiscoTestVector",33,0,
"WSA-INFECTED-FILE.pdf",
"fd5ef49d4213e05f448f11ed
9c98253d85829614fba368a4
21d14e64c426da5e”>

%Xr
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Field DescriptionField ValueFormat Specifier

Suspect user agent.–%?BLOCK_SUSPECT_
USER_AGENT,
MONITOR_SUSPECT_
USER_AGENT?% <
User-Agent:%!%-%

Transaction Result Codes
Transaction result codes in the access log file describe how the appliance resolves client requests. For example,
if a request for an object can be resolved from the cache, the result code is TCP_HIT. However, if the object
is not in the cache and the appliance pulls the object from an origin server, the result code is TCP_MISS. The
following table describes transaction result codes.

DescriptionResult Code

The object requested was fetched from the disk cache.
TCP_HIT

The client sent an IMS (If-Modified-Since) request for an object and the
object was found in the cache. The proxy responds with a 304 response.TCP_IMS_HIT

The object requested was fetched from the memory cache.
TCP_MEM_HIT

The object was not found in the cache, so it was fetched from the origin
server.TCP_MISS

The object was in the cache, but had expired. The proxy sent an IMS
(If-Modified-Since) request to the origin server, and the server confirmed
that the object has not been modified. Therefore, the appliance fetched the
object from either the disk or memory cache.

TCP_REFRESH_HIT

The client sent a “don’t fetch response from cache” request by issuing the
‘Pragma: no-cache’ header. Due to this header from the client, the appliance
fetched the object from the origin server.

TCP_CLIENT_REFRESH_MISS

The client request was denied due to Access Policies.
TCP_DENIED

The object was fetched from the origin server.
UDP_MISS

There was an error in the transaction. For example, a DNS failure or
gateway timeout.NONE

ACL Decision Tags
AnACL decision tag is a field in an access log entry that indicates how theWeb Proxy handled the transaction.
It includes information from the Web Reputation filters, URL categories, and the scanning engines.

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
377

Monitor System Activity Through Logs
Transaction Result Codes



The end of the ACL decision tag includes a dynamically generated number that theWeb Proxy uses internally
to increase performance. You can ignore this number.

Note

The following table describes the ACL decision tag values.

DescriptionACL Decision Tag

The Web Proxy allowed the transaction to an notification page and to any
logo used on that page.

ALLOW_ADMIN_ERROR_PAGE

The Web Proxy allowed the transaction based on custom URL category
filtering settings for the Access Policy group.

ALLOW_CUSTOMCAT

The Web Proxy allowed the transaction based on an embedded/referred
content exemption.

ALLOW_REFERER

The Web Proxy allowed the transaction based on the Web Reputation filter
settings for the Access Policy group.

ALLOW_WBRS

Value representing a verdict from the AMP reputation server for the file:

• 1 – Unknown

• 2 – Clean

• 3 – Malicious

• 4 – Unscannable

AMP_FILE_VERDICT
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DescriptionACL Decision Tag

Archive scan Verdict

ARCHIVESCAN_ALLCLEAR – There are no blocked file types in the inspected
archive.

ARCHIVESCAN_BLOCKEDFILETYPE – There is a blocked file type in the inspected
archive. The next field in the log entry (Verdict Detail) provides details,
specifically the type of file blocked, and the name of the blocked file.

ARCHIVESCAN_NESTEDTOODEEP – The archive is blocked because it contains
more “encapsulated” or nested archives than the configured maximum. The
Verdict Detail field contains “UnScanable Archive-Blocked.”

ARCHIVESCAN_UNKNOWNFMT – The archive is blocked because it contains a file
type of unknown format. The Verdict Detail is “UnScanable
Archive-Blocked.”

ARCHIVESCAN_UNSCANABLE – The archive is blocked because it contain a file
which cannot be scanned. The Verdict Detail is “UnScanable
Archive-Blocked.”

ARCHIVESCAN_FILETOOBIG – The archive is blocked because the size of the
archive is more than the configured maximum. The Verdict Detail is
“UnScanable Archive-Blocked.”

Archive scan Verdict Detail

The field following the Verdict field in the log entry provides additional
information about the Verdict, such as type of file blocked and name of the
blocked file, “UnScanable Archive-Blocked,” or “-” to indicate the archive
does not contain any blocked file types.

For example, if an Inspectable Archive file is blocked
(ARCHIVESCAN_BLOCKEDFILETYPE) based on Access Policy: Custom Objects
Blocking settings, the Verdict Detail entry includes the type of file blocked,
and the name of the blocked file.

Refer to Access Policies: Blocking Objects, on page 208 and Archive
Inspection Settings, on page 210 for more information about Archive
Inspection.

ARCHIVESCAN_ALLCLEAR

ARCHIVESCAN_BLOCKEDFILETYPE

ARCHIVESCAN_NESTEDTOODEEP

ARCHIVESCAN_UNKNOWNFMT

ARCHIVESCAN_UNSCANABLE

ARCHIVESCAN_FILETOOBIG

Transaction blocked based on some default settings for the Access Policy
group.BLOCK_ADMIN

Transaction blocked based on the TCP port of the destination as defined in
the HTTP CONNECT Ports setting for the Access Policy group.BLOCK_ADMIN_CONNECT

Transaction blocked based on the user agent as defined in the Block Custom
User Agents setting for the Access Policy group.BLOCK_ADMIN_CUSTOM_USER_AGENT

TheWeb Proxy blocked the transaction based on tunneling of the non HTTP
traffic on the HTTP ports for the Access Policy Group.

BLOCK_ADMIN_TUNNELING
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DescriptionACL Decision Tag

Transaction blocked; client tried to bypass authentication using the SSL port
as an explicit proxy. To prevent this, if an SSL connection is to the WSA
itself, only requests to the actual WSA redirect hostname are allowed.

BLOCK_ADMIN_HTTPS_
NonLocalDestination

Transaction blocked based on the MIME type of the request body content as
defined in the Data Security Policy group.BLOCK_ADMIN_IDS

Transaction blocked based on the file type as defined in the Access Policy
group.BLOCK_ADMIN_FILE_TYPE

Transaction blocked based on the protocol as defined in the Block Protocols
setting for the Access Policy group.BLOCK_ADMIN_PROTOCOL

Transaction blocked based on the size of the response as defined in the Object
Size settings for the Access Policy group.BLOCK_ADMIN_SIZE

Transaction blocked based on the size of the request body content as defined
in the Data Security Policy group.BLOCK_ADMIN_SIZE_IDS

The Web Proxy blocked the response based on the Advanced Malware
Protection settings for the Access Policy group.BLOCK_AMP_RESP

The Web Proxy blocked the request based on the Anti-Malware settings for
the Outbound Malware Scanning Policy group. The request body produced
a positive malware verdict.

BLOCK_AMW_REQ

The Web Proxy blocked the response based on the Anti-Malware settings
for the Access Policy group.BLOCK_AMW_RESP

The Web Proxy suspects the URL in the HTTP request might not be safe, so
it blocked the transaction at request time based on the Anti-Malware settings
for the Access Policy group.

BLOCK_AMW_REQ_URL

Transaction blocked based on the configured Application settings for the
Access Policy group.BLOCK_AVC

Transaction blocked based on the site content ratings settings for the Access
Policy group. The client request was for adult content and the policy is
configured to block adult content.

BLOCK_CONTENT_UNSAFE

Transaction blocked and displayed the Warn and Continue page based on
the site content ratings settings in the Access Policy group. The client request
was for adult content and the policy is configured to give a warning to users
accessing adult content.

BLOCK_CONTINUE_CONTENT_
UNSAFE

Transaction blocked and displayed the Warn and Continue page based on a
custom URL category in the Access Policy group configured to “Warn.”BLOCK_CONTINUE_CUSTOMCAT

Transaction blocked and displayed the Warn and Continue page based on a
predefined URL category in the Access Policy group configured to “Warn.”BLOCK_CONTINUE_WEBCAT
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DescriptionACL Decision Tag

Transaction blocked based on custom URL category filtering settings for the
Access Policy group.BLOCK_CUSTOMCAT

TheWeb Proxy blocked the request based on the verdict of the external DLP
system as defined in the External DLP Policy group.BLOCK_ICAP

The client request included an unsafe search query and the Access Policy is
configured to enforce safe searches, so the original client request was blocked.BLOCK_SEARCH_UNSAFE

Transaction blocked based on the Suspect User Agent setting for the Access
Policy group.BLOCK_SUSPECT_USER_AGENT

Transaction blocked based on the safe search settings for the Access Policy
group. The transaction was for an unsupported search engine, and the policy
is configured to block unsupported search engines.

BLOCK_UNSUPPORTED_SEARCH_APP

Transaction blocked based on the Web Reputation filter settings for the
Access Policy group.BLOCK_WBRS

The Web Proxy blocked the upload request based on the Web Reputation
filter settings for the Data Security Policy group.BLOCK_WBRS_IDS

Transaction blocked based on URL category filtering settings for the Access
Policy group.BLOCK_WEBCAT

The Web Proxy blocked the upload request based on the URL category
filtering settings for the Data Security Policy group.BLOCK_WEBCAT_IDS

The Web Proxy blocked the transaction based on the predefined YouTube
category filtering settings for the Access Policy group.

BLOCK_YTCAT

The Web Proxy decrypted the transaction based on some default settings for
the Decryption Policy group.DECRYPT_ADMIN

The Web Proxy decrypted the transaction although the server certificate has
expired.DECRYPT_ADMIN_EXPIRED_CERT

The Web Proxy decrypted the transaction based on URL category filtering
settings for the Decryption Policy group.DECRYPT_WEBCAT

TheWeb Proxy decrypted the transaction based on theWeb Reputation filter
settings for the Decryption Policy group.DECRYPT_WBRS

The Web Proxy allowed the client to access the server because none of the
AsyncOS services, such as Web Reputation or anti-malware scanning, took
any action on the transaction.

DEFAULT_CASE

The Web Proxy denied the the transaction. This occurs for HTTPS requests
when authentication is required and 'Decrypt for Authentication' is disabled
in the HTTPS proxy settings.

DENY_ADMIN

The Web Proxy dropped the transaction based on some default settings for
the Decryption Policy group.DROP_ADMIN
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DescriptionACL Decision Tag

The Web Proxy dropped the transaction because the server certificate has
expired.DROP_ADMIN_EXPIRED_CERT

The Web Proxy dropped the transaction based on URL category filtering
settings for the Decryption Policy group.DROP_WEBCAT

The Web Proxy dropped the transaction based on the Web Reputation filter
settings for the Decryption Policy group.DROP_WBRS

The Web Proxy monitored the server response because the server certificate
has expired.MONITOR_ADMIN_EXPIRED_CERT

The Web Proxy monitored the server response based on the Advanced
Malware Protection settings for the Access Policy group.MONITOR_AMP_RESP

The Web Proxy monitored the server response based on the Anti-Malware
settings for the Access Policy group.MONITOR_AMW_RESP

The Web Proxy suspects the URL in the HTTP request might not be safe,
but it monitored the transaction based on the Anti-Malware settings for the
Access Policy group.

MONITOR_AMW_RESP_URL

The Web Proxy monitored the transaction based on the Application settings
for the Access Policy group.MONITOR_AVC

Originally, the Web Proxy blocked the transaction and displayed the Warn
and Continue page based on the site content ratings settings in the Access
Policy group. The client request was for adult content and the policy is
configured to give a warning to users accessing adult content. The user
accepted the warning and continued to the originally requested site, and no
other scanning engine subsequently blocked the request.

MONITOR_CONTINUE_CONTENT_
UNSAFE

Originally, the Web Proxy blocked the transaction and displayed the Warn
and Continue page based on a custom URL category in the Access Policy
group configured to “Warn.” The user accepted the warning and continued
to the originally requested site, and no other scanning engine subsequently
blocked the request.

MONITOR_CONTINUE_CUSTOMCAT

Originally, the Web Proxy blocked the transaction and displayed the Warn
and Continue page based on a predefined URL category in the Access Policy
group configured to “Warn.” The user accepted the warning and continued
to the originally requested site, and no other scanning engine subsequently
blocked the request.

MONITOR_CONTINUE_WEBCAT

The Web Proxy scanned the upload request using either a Data Security
Policy or an External DLP Policy, but did not block the request. It evaluated
the request against the Access Policies.

MONITOR_IDS

The Web Proxy monitored the transaction based on the Suspect User Agent
setting for the Access Policy group.MONITOR_SUSPECT_USER_AGENT
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DescriptionACL Decision Tag

TheWeb Proxymonitored the transaction based on theWeb Reputation filter
settings for the Access Policy group.MONITOR_WBRS

The Web Proxy did not allow the user access to the application because the
user was already authenticated against an authentication realm, but not against
any authentication realm configured in the Application Authentication Policy.

NO_AUTHORIZATION

The user failed authentication.
NO_PASSWORD

TheWeb Proxy passed through the transaction based on some default settings
for the Decryption Policy group.PASSTHRU_ADMIN

TheWeb Proxy passed through the transaction although the server certificate
has expired.PASSTHRU_ADMIN_EXPIRED_CERT

The Web Proxy passed through the transaction based on URL category
filtering settings for the Decryption Policy group.PASSTHRU_WEBCAT

TheWeb Proxy passed through the transaction based on the Web Reputation
filter settings for the Decryption Policy group.PASSTHRU_WBRS

The Web Proxy redirected the transaction to a different URL based on a
custom URL category in the Access Policy group configured to “Redirect.”REDIRECT_CUSTOMCAT

The Web Proxy allowed the user access to the application because the user
was authenticated transparently against the authentication realm configured
in the Application Authentication Policy.

SAAS_AUTH

The Web Proxy did not complete the request due to an error, such as an
authorization failure, server disconnect, or an abort from the client.OTHER

Interpreting Access Log Scanning Verdict Entries
The access log file entries aggregate and display the results of the various scanning engines, such as URL
filtering, Web Reputation filtering, and anti-malware scanning. The appliance displays this information in
angled brackets at the end of each access log entry.

The following text is the scanning verdict information from an access log file entry. In this example, the
Webroot scanning engine found the malware:
<IW_infr,ns,24,"Trojan-Phisher-Gamec",0,354385,12559,-,"-",-,-,-,"-",-,-,"-","-",
-,-,
IW_infr,-,"Trojan Phisher","-","-","Unknown","Unknown","-","-",489.73,0,

[Local],“-“,"-",37,"W32.CiscoTestVector",33,0,"WSA-INFECTED-FILE.pdf",

"fd5ef49d4213e05f448f11ed9c98253d85829614fba368a421d14e64c426da5e”,

ARCHIVESCAN_BLOCKEDFILETYPE,

EXT_ARCHIVESCAN_VERDICT,

EXT_ARCHIVESCAN_THREATDETAIL,
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EXT_WTT_BEHAVIOR,
EXT_YTCAT,
"BlockedFileType: application/x-rpm,
BlockedFile: allfiles/linuxpackage.rp">

For an example of a whole access log file entry, see Web Proxy Information in Access Log Files, on page
373.

Note

Each element in this example corresponds to a log-file format specifier as shown in the following table:

DescriptionFormat SpecifierField ValuePosition

The custom URL category assigned to the
transaction, abbreviated. This field shows
“nc” when no category is assigned.

%XC
IW_infr

1

Web Reputation filters score. This field either
shows the score as a number, “ns” for no
score, or “dns” when there is a DNS lookup
error.

%XW
ns

2

The malware scanning verdict Webroot
passed to the DVS engine. Applies to
responses detected by Webroot only.

For more information, seeMalware Scanning
Verdict Values, on page 407.

%Xv
24

3

Name of the spyware that is associated with
the object. Applies to responses detected by
Webroot only.

“%Xn”
“Trojan-Phisher-Gamec”

4

The Webroot specific value associated with
the Threat Risk Ratio (TRR) value that
determines the probability that malware
exists. Applies to responses detected by
Webroot only.

%Xt
0

5

A value that Webroot uses as a threat
identifier. Cisco Customer Support may use
this value when troubleshooting an issue.
Applies to responses detected by Webroot
only.

%Xs
354385

6

A value that Webroot uses as a trace
identifier. Cisco Customer Support may use
this value when troubleshooting an issue.
Applies to responses detected by Webroot
only.

%Xi
12559

7
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DescriptionFormat SpecifierField ValuePosition

Themalware scanning verdictMcAfee passed
to the DVS engine. Applies to responses
detected by McAfee only.

For more information, seeMalware Scanning
Verdict Values, on page 407.

%Xd
-

8

The name of the file McAfee scanned.
Applies to responses detected by McAfee
only.

“%Xe”
“-”

9

A value that McAfee uses as a scan error.
Cisco Customer Support may use this value
when troubleshooting an issue. Applies to
responses detected by McAfee only.

%Xf
-

10

A value thatMcAfee uses as a detection type.
Cisco Customer Support may use this value
when troubleshooting an issue. Applies to
responses detected by McAfee only.

%Xg
-

11

A value that McAfee uses as a virus type.
Cisco Customer Support may use this value
when troubleshooting an issue. Applies to
responses detected by McAfee only.

%Xh
-

12

The name of the virus that McAfee scanned.
Applies to responses detected by McAfee
only.

“%Xj”
“-”

13

Themalware scanning verdict Sophos passed
to the DVS engine. Applies to responses
detected by Sophos only.

For more information, seeMalware Scanning
Verdict Values, on page 407.

%XY
-

14

A value that Sophos uses as a scan return
code. Cisco Customer Support may use this
value when troubleshooting an issue. Applies
to responses detected by Sophos only.

%Xx
-

15

The name of the file in which Sophos found
the objectionable content. Applies to
responses detected by Sophos only.

“%Xy”
“-”

16

A value that Sophos uses as the threat name.
Cisco Customer Support may use this value
when troubleshooting an issue. Applies to
responses detected by Sophos only.

“%Xz”
“-”

17
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DescriptionFormat SpecifierField ValuePosition

The Cisco Data Security scan verdict based
on the action in the Content column of the
Cisco Data Security Policy. The following
list describes the possible values for this field:

• 0. Allow

• 1. Block

• - (hyphen). No scanning was initiated
by the Cisco Data Security Filters. This
value appears when the Cisco Data
Security Filters are disabled, or when the
URL category action is set to Allow.

%Xl
-

18

The External DLP scan verdict based on the
result given in the ICAP response. The
following list describes the possible values
for this field:

• 0. Allow

• 1. Block

• - (hyphen). No scanning was initiated
by the external DLP server. This value
appears when External DLP scanning is
disabled, or when the content was not
scanned due to an exempt URL category
on the External DLP Policies >
Destinations page.

%Xp
-

19

The predefined URL category verdict
determined during request-side scanning,
abbreviated. This field lists a hyphen ( - )
when URL filtering is disabled.

For a list of URL category abbreviations, see
URL Category Descriptions, on page 182.

%XQ
IW_infr

20

The URL category verdict determined by the
Dynamic Content Analysis engine during
response-side scanning, abbreviated. Applies
to the Cisco Web Usage Controls URL
filtering engine only. Only applies when the
Dynamic Content Analysis engine is enabled
and when no category is assigned at request
time (a value of “nc” is listed in the
request-side scanning verdict).

For a list of URL category abbreviations, see
URL Category Descriptions, on page 182.

%XA
-

21
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DescriptionFormat SpecifierField ValuePosition

Unified response-side anti-malware scanning
verdict that provides the malware category
independent of which scanning engines are
enabled. Applies to transactions blocked or
monitored due to server response scanning.

“%XZ”
“Trojan Phisher”

22

TheURLwhich is encapsulated insideGoogle
translate engine. If there is no encapsulated
URL, the field value will be “-”.

%X#10#
“-”

24

The application name as returned by the AVC
engine, if applicable. Only applies when the
AVC engine is enabled.

"%XO"
“Unknown”

25

The application type as returned by the AVC
engine, if applicable. Only applies when the
AVC engine is enabled.

“%Xu”
“Unknown”

26

The application behavior as returned by the
AVC engine, if applicable. Only applies when
the AVC engine is enabled.

“%Xb”
“-”

27

Safe browsing scanning verdict. This value
indicates whether either the safe search or the
site content ratings feature was applied to the
transaction.

For a list of the possible values, see Logging
Adult Content Access, on page 175.

“%XS”
“-”

28

The average bandwidth consumed serving the
request, in Kb/sec.

%XB
489.73

29

A value that indicates whether the request was
throttled due to bandwidth limit control
settings, where “1” indicates the request was
throttled, and “0” indicates it was not.

%XT
0

30

The type of user making the request, either
“[Local]” or “[Remote].” Only applies when
AnyConnect Secure Mobility is enabled.
When it is not enabled, the value is a hyphen
(-).

%l
[Local]

31

Unified request-side anti-malware scanning
verdict independent of which scanning
engines are enabled. Applies to transactions
blocked or monitored due to client request
scanning when an Outbound Malware
Scanning Policy applies.

“%X3”
“-”

32
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DescriptionFormat SpecifierField ValuePosition

The threat name assigned to the client request
that was blocked or monitored due to an
applicable Outbound Malware Scanning
Policy.

This threat name is independent of which
anti-malware scanning engines are enabled.

“%X4”
“-”

33

Verdict from Advanced Malware Protection
file scanning:

• 0: File is not malicious

• 1: File was not scanned because of its
file type

• 2: File scan timed out

• 3: Scan error

• Greater than 3: File is malicious

%X#1#
37

34

Threat name, as determined by Advanced
Malware Protection file scanning; "-"
indicates no threat.

%X#2#
"W32.CiscoTestVector"

35

Reputation score from Advanced Malware
Protection file scanning. This score is used
only if the cloud reputation service is unable
to determine a clear verdict for the file.

For details, see information about the Threat
Score and the reputation threshold in File
Reputation Filtering and File Analysis, on
page 261

%X#3#
33

36

Indicator of upload and analysis request:

“0” indicates that Advanced Malware
Protection did not request upload of the file
for analysis.

“1” indicates that Advanced Malware
Protection did request upload of the file for
analysis.

%X#4#
0

37

The name of the file being downloaded and
analyzed.

%X#5#
"WSA-INFECTED-FILE.pdf"

38

The SHA-256 identifier for this file.%X#6#"fd5ef49d4213e05f448
f11ed9c98253d85829614fba
368a421d14e64c426da5e"

39

Archive scan Verdict.%X#8#
ARCHIVESCAN_BLOCKEDFILETYPE

40
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DescriptionFormat SpecifierField ValuePosition

Archive scan Verdict Detail. If an Inspectable
Archive file is blocked
(ARCHIVESCAN_BLOCKEDFILETYPE) based on
Access policy: Custom Objects Blocking
settings, this Verdict Detail entry includes the
type of file blocked, and the name of the
blocked file.

%XoEXT_ARCHIVESCAN_VERDICT41

File verdict by Archive Scanner%XmEXT_ARCHIVESCAN_THREATDETAIL42

Web Tap Behavior.%XUEXT_WTT_BEHAVIOR43

Refer to Log File Fields and Tags, on page 396 for a description of each format specifier’s function.

Related Topics

• Web Proxy Information in Access Log Files, on page 373

• Customizing Access Logs, on page 391

• W3C Compliant Access Log Files, on page 389

• Viewing Log Files, on page 373

• Log File Fields and Tags, on page 396

W3C Compliant Access Log Files
TheWeb Security appliance provides two different log types for recordingWeb Proxy transaction information:
access logs and W3C-formatted access logs. The W3C access logs are World Wide Web Consortium (W3C)
compliant, and record transaction history in the W3C Extended Log File (ELF) Format.

• W3C Field Types, on page 389
• Interpreting W3C Access Logs, on page 389

W3C Field Types
When defining a W3C access log subscription, you must choose which log fields to include, such as the ACL
decision tag or the client IP address. You can include one of the following types of log fields:

• Predefined. The web interface includes a list of fields from which you can choose.
• User defined. You can type a log field that is not included in the predefined list.

Interpreting W3C Access Logs
Consider the following rules and guidelines when interpreting W3C access logs:

• Administrators decide what data is recorded in eachW3C access log subscription; therefore,W3C access
logs have no set field format.
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• W3C logs are self-describing. The file format (list of fields) is defined in a header at the start of each log
file.

• Fields in the W3C access logs are separated by a white space.
• If a field contains no data for a particular entry, a hyphen ( - ) is included in the log file instead.
• Each line in the W3C access log file relates to one transaction, and each line is terminated by a LF
sequence.

• W3C Log File Headers, on page 390
• W3C Field Prefixes, on page 390

W3C Log File Headers
Each W3C log file contains header text at the beginning of the file. Each line starts with the # character and
provides information about the Web Security appliance that created the log file. The W3C log file headers
also include the file format (list of fields), making the log file self-describing.

The following table describes the header fields listed at the beginning of each W3C log file.

DescriptionHeader Field

The version of the W3C ELF format used.Version

The date and time at which the header (and log file) was created.Date

TheWeb Security appliance that generated the log file in the format “Management_IP
- Management_hostname.”

System

The Software which generated these logsSoftware

The fields recorded in the logFields

Example W3C log file:

#Version: 1.0
#Date: 2009-06-15 13:55:20
#System: 10.1.1.1 - wsa.qa
#Software: AsyncOS for Web 6.3.0
#Fields: timestamp x-elapsed-time c-ip
x-resultcode-httpstatus sc-bytes cs-method cs-url cs-username
x-hierarchy-origin cs-mime-type x-acltag x-result-code x-suspect-user-agent

W3C Field Prefixes
MostW3C log field names include a prefix that identifies from which header a value comes, such as the client
or server. Log fields without a prefix reference values that are independent of the computers involved in the
transaction. The following table describes the W3C log fields prefixes.

DescriptionPrefix Header

Clientc

Servers

Client to servercs
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DescriptionPrefix Header

Server to clientsc

Application specific identifier.x

For example, theW3C log field “cs-method” refers to the method in the request sent by the client to the server,
and “c-ip” refers to the client’s IP address.

Related Topics

• Web Proxy Information in Access Log Files, on page 373.
• Customizing Access Logs, on page 391.
• Traffic Monitor Log Files, on page 395.
• Log File Fields and Tags, on page 396.
• Viewing Log Files, on page 373.

Customizing Access Logs
You can customize regular and W3C access logs to include many different fields to capture comprehensive
information about web traffic within the network using predefined fields or user defined fields.

Related Topics

• For a list of predefined fields, see Log File Fields and Tags, on page 396.
• For information on user defined fields, see Access Log User Defined Fields, on page 391.

Access Log User Defined Fields
If the list of predefined Access log and W3C log fields does not include all header information you want to
log fromHTTP/HTTPS transactions, you can type a user-defined log field in the Custom Fields text box when
you configure the access and W3C log subscriptions.

Custom log fields can be any data from any header sent from the client or the server. If a request or response
does not include the header added to the log subscription, the log file includes a hyphen as the log field value.

The following table defines the syntax to use for access and W3C logs:

W3C Log Custom Field SyntaxAccess Log Format Specifier SyntaxHeader Type

cs(ClientHeaderName )%<ClientHeaderName :Header from the client application

sc(ServerHeaderName )%<ServerHeaderName :Header from the server

For example, if you want to log the If-Modified-Since header value in client requests, enter the following text
in the Custom Fields box for a W3C log subscription:

cs(If-Modified-Since)

Related Topics

• Customizing Regular Access Logs, on page 392.
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• Customizing W3C Access Logs, on page 392.

Customizing Regular Access Logs

Step 1 Choose System Administration > Log Subscriptions.
Step 2 Click the access log file name to edit the access log subscription.
Step 3 Enter the required format specifiers in the Custom Field.

The syntax for entering format specifiers in the Custom Field is as follows:

<format_specifier_1> <format_specifier_2> ...

For example: %a %b %E

You can add tokens before the format specifiers to display descriptive text in the access log file. For example:

client_IP %a body_bytes %b error_type %E

where client_IP is the description token for log format specifier %a , and so on.

You can create a custom field for any header in a client request or a server response.Note

Step 4 Submit and commit your changes.

What to do next

Related Topics

• Web Proxy Information in Access Log Files, on page 373.
• Log File Fields and Tags, on page 396.
• Access Log User Defined Fields, on page 391.

Customizing W3C Access Logs

Step 1 Choose System Administration > Log Subscriptions

Step 2 Click the W3C log file name to edit the W3C log subscription.
Step 3 Type a field in the Custom Field box, and click Add.

The order the fields appear in the Selected Log Fields list determines the order of fields in the W3C access log file. You
can change the order of fields using the Move Up and Move Down buttons. You can remove a field by selecting it in
the Selected Log Fields list and clicking Remove.

You can enter multiple user defined fields in the Custom Fields box and add them simultaneously as long as each entry
is separated by a new line (click Enter) before clicking Add.

When you change the log fields included in a W3C log subscription, the log subscription automatically rolls over. This
allows the latest version of the log file to include the correct new field headers

You can create a custom field for any header in a client request or a server response.Note
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Step 4 Submit and commit your changes.

What to do next

Related Topics

• W3C Compliant Access Log Files, on page 389.
• Log File Fields and Tags, on page 396.
• Access Log User Defined Fields, on page 391.
• Configuring Cisco CTA-specific Custom W3C Logs, on page 393
• Configuring Cisco Cloudlock-specific Custom W3C Logs, on page 394

Configuring Cisco CTA-specific Custom W3C Logs
You can configure your appliance to push Cognitive Threat Analytics (CTA)-specific custom W3C access
logs to Cisco Cloud Web Security service for analysis and reporting. Cisco ScanCenter is the administration
portal of CloudWeb Security (CWS). See https://www.cisco.com/c/en/us/support/security/cloud-web-security/
products-installation-and-configuration-guides-list.html

Before you begin

Create a device account in Cisco ScanCenter for your appliance, selecting SCP (Secure Copy Protocol) as the
automatic upload protocol. See the Proxy Device Uploads section of the Cisco ScanCenter Administrator
(https://www.cisco.com/c/en/us/td/docs/security/web_security/scancenter/administrator/guide/b_ScanCenter_
Administrator_Guide.html)

Note the SCP host name and the generated user name for your appliance. The user name is case sensitive and
unique for each device.

Step 1 Choose Security Services > Cisco Cognitive Threat Analytics.
Step 2 Click Edit Settings.
Step 3 In the Log Fields area, add additional log fields, if required. See Adding and Editing Log Subscriptions, on page 366.
Step 4 From the Selected Log Fields, check the check boxes next to c-ip, cs-username or cs-auth-group if you want to

anonymize these fields individually.

Alternatively, you can check the Anonymization check box to anonymize these fields simultaneously. See Adding
and Editing Log Subscriptions, on page 366.

Step 5 In the Retrieval Method area, enter the username generated for your device in Cisco ScanCenter. The device user
name is case sensitive and unique for each proxy device.

Step 6 Modify the Advanced Options values, if required.
Step 7 Click Submit.

The appliance generates public SSH keys and displays them on the Cisco Cognitive Threat Analytics page.

Step 8 Copy one of the public SSH key to the clipboard.
Step 9 Click the View Cisco Cognitive Threat Analytics portal link to switch to the Cisco ScanCenter portal, select the

appropriate device account and then paste the public SSH key to the CTA Device Provisioning page. (See the Proxy
Device Uploads section of the Cisco ScanCenter Administrator Guide).
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Log files from your proxy device will be uploaded to the CTA system for analysis on successful authentication between
your proxy device and CTA system.

Step 10 Switch back to the appliance and commit your changes.

You can also add CTA W3C logs using System Administration > Log Subscription. Follow the instructions in
Customizing W3C Access Logs, on page 392 to add a new W3C access log subscription with the following options:

• W3C Logs as log type

• Cisco Cognitive Threat Analytics Subscription as subscription

• SCP as file transfer type

See Adding and Editing Log Subscriptions, on page 366 to know more about custom fields.

If you have already configured a CTA log subscription, you must change the log name to cta_log to list it on
the Cisco Cognitive Threat Analytics page in the appliance.

Note

After log creation, if you want to delete the CTA log, click Disable in the Cisco Cognitive Threat Analytics page. You
can also delete the CTA log from the Log Subscriptions page (System Administration > Log subscriptions).

To deanonymize the anonymized CTA-specific W3C log fields, click Deanonymize in the Cisco Cognitive Threat
Analytics page. See Deanonymizing W3C Log Fields, on page 370

You can also deanonymize the anonymized CTA-specific W3C log fields using System Administration > Log
Subscription. See Deanonymizing W3C Log Fields, on page 370

Configuring Cisco Cloudlock-specific Custom W3C Logs
Cisco Cloudlock is a cloud-native CASB and cloud cybersecurity platform that protects users, data, and
applications across Software-as-a-Service, Platform-as-a-Service, and Infrastructure-as-a-Service. You can
configure your appliance to push W3C access logs to Cisco’s Cloudlock portal for analysis and reporting.
These custom W3C logs provide better visibility into the SaaS usage of the customers.

Before you begin

Create a device account in Cloudlock portal for your appliance, selecting SCP as the automatic upload protocol.

Logon to Cloudlock portal, access the online help and follow the instructions to create device account in the
Cloudlock portal.

Step 1 Choose Security Services > Cisco Cloudlock.
Step 2 Click Edit Settings.

The log fields are selected by default in the Log Fields area.You cannot add additional log fields other than
the log fields selected by default. You should not change the order of the log fields displayed in the Log Fields
area.

You cannot anonymize log fields (c-ip, cs-username, or cs-auth-group) of Cloudlock log files.

Note

Step 3 In the Retrieval Method area, enter the following information:

• Cloudlock server hostname and port number
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• Directory on the Cloudlock server to store the log file

• Username of the user who has permission to connect to the Cloudlock server

Step 4 Modify the Advanced Options values if required.
Step 5 Click Submit.

The appliance generates public SSH keys and displays them on the Cisco Cloudlock page.

Step 6 Copy one of the public SSH key to the clipboard.
Step 7 Click the View Cloudlock Portal link to switch to the Cisco Cloudlock portal. Select the appropriate device account and

then paste the public SSH key into the Cloudlock Setting page.

Log files from your proxy device will be uploaded to the Cloudlock system for analysis on successful authentication
between your proxy device and Cloudlock system.

Step 8 Switch back to the appliance and commit your changes.

You can also add Cloudlock W3C logs using System Administration > Log Subscription. Follow the instructions in
Customizing W3C Access Logs, on page 392 to add a new W3C access log subscription with the following options:

• W3C Logs as log type

• Cisco Cloudlock as subscription

• SCP as file transfer type

See Adding and Editing Log Subscriptions, on page 366 to know more about custom fields.

If you have already configured a Cloudlock log subscription, you must change the log name to cloudlock_log
to list it on the Cisco Cloudlock page in the appliance.

Note

After log creation, if you want to delete the Cloudlock log, click Disable in the Cisco Cloudlock page. You can also
delete the Cloudlock log from the Log Subscriptions page (System Administration > Log subscriptions).

Traffic Monitor Log Files
Layer-4 Traffic Monitor log files provides a detailed record of Layer-4 monitoring activity. You can view
Layer-4 Traffic Monitor log file entries to track updates to firewall block lists and firewall allow lists.

Interpreting Traffic Monitor Logs
Use the examples below to interpret the various entry types contains in Traffic Monitor Logs.

Example 1

172.xx.xx.xx discovered for blocksite.net (blocksite.net) added to firewall block list.

In this example, where a match becomes a block list firewall entry. The Layer-4 Traffic Monitor matched an
IP address to a domain name in the block list based on a DNS request which passed through the appliance.
The IP address is then entered into the block list for the firewall.

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
395

Monitor System Activity Through Logs
Traffic Monitor Log Files



Example 2

172.xx.xx.xx discovered for www.allowsite.com (www.allowsite.com) added to firewall allow

list.

In this example, a match becomes an allow list firewall entry. The Layer-4 Traffic Monitor matched a domain
name entry and added it to the appliance allow list. The IP address is then entered into the allow list for the
firewall.

Example 3

Firewall noted data from 172.xx.xx.xx to 209.xx.xx.xx (allowsite.net):80.

In this example, the Layer-4 Traffic Monitor logs a record of data that passed between an internal IP address
and an external IP address which is on the block list. Also, the Layer-4 Traffic Monitor is set to monitor, not
block.

Related Topics

• Viewing Log Files, on page 373

Log File Fields and Tags
• Access Log Format Specifiers and W3C Log File Fields, on page 396
• Transaction Result Codes, on page 377
• ACL Decision Tags, on page 377
• Malware Scanning Verdict Values, on page 407

Access Log Format Specifiers and W3C Log File Fields
Log files use variables to represent the individual items of information that make up each log file entry. These
variables are called format specifiers in Access logs and log fields in W3C logs and each format specifier has
a corresponding log field.

To configure Access Logs to display these values, see Customizing Access Logs, on page 391 and information
about custom fields in Adding and Editing Log Subscriptions, on page 366.

The following table describes these variables:

DescriptionLog Field in W3C LogsFormat
Specifier in
Access Logs

Custom field parameter for Secure Group Tags used in
ISE integrations.

ext_auth_sgt%X#11#

The time it takes from the moment the Web Proxy starts
connecting to the server to the time it is first able to write
to the server. If the Web Proxy has to connect to several
servers to complete the transaction, it is the sum of those
times.

x-p2s-first-byte-time%:<1
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DescriptionLog Field in W3C LogsFormat
Specifier in
Access Logs

Wait-time to receive the response from the Web Proxy
authentication process, after the Web Proxy sent the
request.

x-p2p-auth-wait-time%:<a

Wait-time to write request body to server after header.x-p2s-body-time%:<b

Time taken by the Web Proxy to send the DNS request to
the Web Proxy DNS process.

x-p2p-dns-wait-time%:<d

Wait-time to write request header to server after first byte.x-p2s-header-time%:<h

Wait-time to receive the response from the Web
Reputation Filters, after the Web Proxy sent the request.

x-p2p-reputation- wait-time%:<r

Wait-time to receive the verdict from the Web Proxy
anti-spyware process, after theWeb Proxy sent the request.

x-p2p-asw-req- wait-time%:<s

Wait-time for first response byte from serverx-s2p-first-byte-time%:>1

Wait-time to receive the response from the Web Proxy
authentication process, including the time required for the
Web Proxy to send the request.

x-p2p-auth-svc-time%:>a

Wait-time for complete response body after header
received

x-s2p-body-time%:>b

Time required for the Web Proxy to read a response from
the disk cache.

x-p2p-fetch-time%:>c

Time taken by the Web Proxy DNS process to send back
a DNS result to the Web Proxy.

x-p2p-dns-svc-time%:>d

Wait-time for server header after first response bytex-s2p-header-time%:>h

SSL server handshake latency information.%:>g

Volume quota consumed.-% O

Wait-time to receive the verdict from theWeb Reputation
Filters, including the time required for the Web Proxy to
send the request.

x-p2p-reputation-svc- time%:>r

Wait-time to receive the verdict from the Web Proxy
anti-spyware process, including the time required for the
Web Proxy to send the request.

x-p2p-asw-req-svc- time%:>s

Wait-time for first request byte from new client
connection.

x-c2p-first-byte-time%:1<

Wait-time for first byte written to client.x-p2c-first-byte-time%:1>
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DescriptionLog Field in W3C LogsFormat
Specifier in
Access Logs

Wait-time to receive the response from the AVC process,
including the time required for the Web Proxy to send the
request.

x-p2p-avc-svc-time%:A<

Wait-time to receive the response from the AVC process,
after the Web Proxy sent the request.

x-p2p-avc-wait-time%:A>

Wait-time for complete client body.x-c2p-body-time%:b<

Wait-time for complete body written to client.x-p2c-body-time%:b>

Wait-time to receive the verdict from the Dynamic Content
Analysis engine, including the time required for the Web
Proxy to send the request.

x-p2p-dca-resp- svc-time%:C<

Wait-time to receive the response from the Dynamic
Content Analysis engine, after the Web Proxy sent the
request.

x-p2p-dca-resp- wait-time%:C>

Wait-time for complete client header after first bytex-c2p-header-time%:h<

Wait-time for complete header written to clientx-s2p-header-time%:h>

Wait-time to receive the verdict from theMcAfee scanning
engine, including the time required for the Web Proxy to
send the request.

x-p2p-mcafee-resp- svc-time%:m<

Wait-time to receive the response from the McAfee
scanning engine, after the Web Proxy sent the request.

x-p2p-mcafee-resp- wait-time%:m>

Wait-time to receive the verdict from the Sophos scanning
engine, including the time required for the Web Proxy to
send the request.

x-p2p-sophos-resp- svc-time%:p<

Wait-time to receive the response from the Sophos
scanning engine, after the Web Proxy sent the request.

x-p2p-sophos-resp- wait-time%:p>

Wait-time to receive the verdict from the Webroot
scanning engine, including the time required for the Web
Proxy to send the request.

x-p2p-webroot-resp -svc-time%:w<

Wait-time to receive the response from the Webroot
scanning engine, after the Web Proxy sent the request.

x-p2p-webroot-resp-wait- time%:w>

Suspect user agent, if applicable. If the Web Proxy
determines the user agent is suspect, it will log the user
agent in this field. Otherwise, it logs a hyphen. This field
is written with double-quotes in the access logs.

x-suspect-user-agent%?BLOCK_SUSPECT_
USER_AGENT,
MONITOR_SUSPECT_
USER_AGENT?%
<
User-Agent:%!%-%
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DescriptionLog Field in W3C LogsFormat
Specifier in
Access Logs

Referercs(Referer)%<Referer:

Server header in the response.sc(Server)%>Server:

Client IP Address.c-ip%a

Authenticated user name. This field is written with
double-quotes in the access logs.

cs-username%A

Bytes sent to the client from the Web Proxy for the body
content.

sc-body-size%b

Total bytes used (request size + response size, which is
%q + %s).

bytes%B

Response body MIME type. This field is written with
double-quotes in the access logs.

cs-mime-type%c

Cookie header. This field is written with double-quotes
in the access logs.

cs(Cookie)%C

Data source or server IP address.s-hostname%d

ACL decision tag.x-acltag%D

Elapsed time in milliseconds.

For TCP traffic, this is the time elapsed between the
opening and closing of the HTTP connection.

For UDP traffic, this is the time elapsed between the
sending of the first datagram and the time at which the
last datagram can be accepted. A large elapsed time value
for UDP traffic may indicate that a large timeout value
and a long-lived UDP association allowed datagrams to
be accepted longer than necessary.

x-elapsed-time%e

Error code number that may help Customer Support
troubleshoot the reason for a failed transaction.(

x-error-code%E

X-Forwarded-For header.cs(X-Forwarded-For)%f

Client source portc-port%F

Authorized group names. This field is written with
double-quotes in the access logs.

This field is used for troubleshooting policy/authentication
issues to determine whether a user is matching the correct
group or policy.

cs-auth-group%g

Human-readable timestamp.%G
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DescriptionLog Field in W3C LogsFormat
Specifier in
Access Logs

HTTP response code.sc-http-status%h

Hierarchy retrieval.s-hierarchy%H

IP address of the last ICAP server contacted while
processing the request.

x-icap-server%i

Transaction ID.x-transaction-id%I
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DescriptionLog Field in W3C LogsFormat
Specifier in
Access Logs

Do not cache response code; DCF flags.

Response code descriptions:

• Response code based on client request:

• 1 = Request had “no-cache” header.

• 2 = Caching is not authorized for the request.

• 4 = Request is missing the 'Variant' header.

• 8 = Username or passphrase needed for user
request.

• 20 = Response for specified HTTP method.

• Response code based on response received by the
appliance:

• id="li_7443F05D141F4D9FB788FD416697DB65">
40 = Response contains “Cache-Control:
private” header.

• 80 = Response contains “Cache-Control:
no-store” header.

• 100 = Response indicates that request was a
query.

• 200 = Response has a small “Expires” value
(expires soon).

• 400 = Response does not have “Last Modified”
header.

• 1000 = Response expires immediately.

• 2000 = Response file is too big to cache.

• 20000 = New copy of file exists.

• 40000 = Response has bad/invalid values in
“Vary” header.

• 80000 = Response requires setting of cookies.

• 100000 =Non-cacheable HTTP STATUSCode.

• 200000 = Object received by appliance was
incomplete (based on size).

• 800000 = Response trailers indicate no caching.

• 1000000 = Response requires re-write.

DCF%j
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DescriptionLog Field in W3C LogsFormat
Specifier in
Access Logs

Data source IP address (server IP address)

This value is used to determine a requestor when the IP
address is flagged by an intrusion detection device on your
network. Allows you to locate a client that visited an IP
address that has been so flagged.

s-ip%k

Type of user, either local or remote.user-type%l

Request local time in human-readable format:
DD/MMM/YYYY : hh:mm:ss +nnnn. This field is written
with double-quotes in the access logs.

Enabling this field allows you to correlate logs to issues
without having to calculate local time from epoch time
for each log entry.

x-local_time%L

Used to troubleshoot authentication issues.

The authentication mechanism used on the transaction.
Possible values are:

• BASIC. The user name was authenticated using the
Basic authentication scheme.

• NTLMSSP. The user name was authenticated using
the NTLMSSP authentication scheme.

• NEGOTIATE. The user name was authenticated
using the Kerberos authentication scheme.

• SSO_TUI. The user namewas obtained bymatching
the client IP address to an authenticated user name
using transparent user identification.

• SSO_ISE. The user was authenticated by an ISE
server. (Log shows GUEST if that is chosen as the
fall-back mechanism for ISE authentication.)

• SSO_ASA. The user is a remote user and the user
name was obtained from a Cisco ASA using the
Secure Mobility.

• FORM_AUTH. The user entered authentication
credentials in a form in the web browser when
accessing a application.

• GUEST. The user failed authentication and instead
was granted guest access.

cs-auth-mechanism%m

Cache miss flags: CMF flags.CMF%M
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DescriptionLog Field in W3C LogsFormat
Specifier in
Access Logs

Server name or destination hostname. This field is written
with double-quotes in the access logs.

s-computerName%N

Destination port number.s-port%p

Protocol.cs-version%P

Request size (headers + body).cs-bytes%q

Request first line - request method, URI.x-req-first-line%r

Response size (header + body).sc-bytes%s

Timestamp in UNIX epoch.

Note: If you want to use a third party log analyzer tool to
read and parse the W3C access logs, you might need to
include the “timestamp” field. Most log analyzers only
understand time in the format provided by this field.

timestamp%t

User agent. This field is written with double-quotes in the
access logs.

This field helps determine if an application is failing
authentication and/or requires different access permissions.

cs(User-Agent)%u

Request URI.cs-uri%U

Date in YYYY-MM-DD.date%v

Time in HH:MM:SS.time%V

Result code. For example: TCP_MISS, TCP_HIT.sc-result-code%w

Result code denial.sc-result-code-denial%W

Latency.x-latency%x

Unified response-side anti-malware scanning verdict that
provides the malware category number independent of
which scanning engines are enabled. Applies to
transactions blocked or monitored due to server response
scanning.

This field is written with double-quotes in the access logs.

x-resp-dvs-scanverdict%X0

Unified response-side anti-malware scanning verdict that
provides the malware threat name independent of which
scanning engines are enabled. Applies to transactions
blocked or monitored due to server response scanning.

This field is written with double-quotes in the access logs.

x-resp-dvs-threat-name%X1
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DescriptionLog Field in W3C LogsFormat
Specifier in
Access Logs

Request side DVS Scan verdictx-req-dvs-scanverdict%X2

Request side DVS verdict namex-req-dvs-verdictname%X3

Request side DVS threat namex-req-dvs-threat-name%X4

Indicates whether Adaptive Scanning blocked the
transaction without invoke any anti-malware scanning
engine. The possible values are:

• 1. Transaction was blocked.

• 0. Transaction was not blocked.

This variable is included in the scanning verdict
information (in the angled brackets at the end of each
access log entry).

x-as-malware-threat-name%X6

The URL category verdict determined during
response-side scanning, abbreviated. Applies to the Cisco
Web Usage Controls URL filtering engine only.

x-webcat-resp-code- abbr%XA

The web application behavior identified by the AVC
engine.

x-avc-behavior%Xb

Average bandwidth of the user if bandwidth limits are
defined by the AVC engine.

x-avg-bw%XB

URL category abbreviation for the custom URL category
assigned to the transaction.

x-webcat-code-abbr%XC

McAfee specific identifier: (scan verdict).x-mcafee-scanverdict%Xd

McAfee specific identifier: (File name yielding verdict)
This field is written with double-quotes in the access logs.

x-mcafee-filename%Xe

McAfee specific identifier: (scan error).x-mcafee-av-scanerror%Xf

Full name of the URL category assigned to the transaction.
This field is written with double-quotes in the access logs.

x-webcat-code-full%XF

McAfee specific identifier: (detect type).x-mcafee-av-detecttype%Xg

AVC request header verdict.x-avc-reqhead-scanverdict%XG

McAfee specific identifier: (virus type).x-mcafee-av-virustype%Xh

AVC request body verdict.x-avc-reqbody- scanverdict%XH

Webroot specific scan identifier: (Trace ID)x-webroot-trace-id%Xi
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DescriptionLog Field in W3C LogsFormat
Specifier in
Access Logs

McAfee specific identifier: (virus name). This field is
written with double-quotes in the access logs.

x-mcafee-virus-name%Xj

Web reputation threat type.x-wbrs-threat-type%Xk

Web reputation threat reason.x-wbrs-threat-reason%XK

Cisco Data Security Policy scanning verdict. If this field
is included, it will display the IDS verdict, or “0” if IDS
was active but the document scanned clean, or “-” if no
IDS policy was active for the request.

x-ids-verdict%Xl

The URL category verdict determined during
response-side scanning, full name.Applies to the Cisco
Web Usage Controls URL filtering engine only.

x-webcat-resp-code- full%XL

AVC response header verdict.x-avc-resphead- scanverdict%XM

Webroot specific identifier: (Threat name) This field is
written with double-quotes in the access logs.

x-webroot-threat-name%Xn

AVC response body verdict.x-avc-reqbody-scanverdict%XN

The web application identified by the AVC engine.x-avc-app%XO

External DLP server scanning verdict.x-icap-verdict%Xp

Unrecognized header. Use this field to log extra headers
in client requests. This supports troubleshooting of
specialized systems that add headers to client requests as
a way of authenticating and redirecting those requests, for
example, YouTube for Schools.

x-acl-added-headers%XP

The predefined URL category verdict determined during
request-side scanning, abbreviated.

x-webcat-req-code- abbr%XQ

Scanning verdict information.x-result-code%Xr

The URL category verdict determined during request-side
scanning, full name.

x-webcat-req-code-full%XR

Webroot specific identifier: (Spy ID).x-webroot-spyid%Xs

Safe browsing scanning verdict.

Indicates whether either the safe search or site content
ratings feature was applied to the transaction.

x-request-rewrite%XS

Webroot specific identifier: (Threat Risk Ratio [TRR]).x-webroot-trr%Xt
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DescriptionLog Field in W3C LogsFormat
Specifier in
Access Logs

Flag that indicates whether bandwidth limits were applied
to the transaction.

x-bw-throttled%XT

The web application type identified by the AVC engine.x-avc-type%Xu

Malware scanning verdict from Webroot.x-webroot-scanverdict%Xv

The downstream IP address when the “Enable
Identification of Client IP Addresses using
X-Forwarded-For” checkbox is enabled for theWeb Proxy
settings.

x-request-source-ip%XV

Decoded WBRS score <-10.0-10.0>.x-wbrs-score%XW

Sophos specific identifier: (scan return code).x-sophos-scanerror%Xx

The name of the file in which Sophos found the
objectionable content. Applies to responses detected by
Sophos only.

x-sophos-file-name%Xy

Sophos specific identifier: (scan verdict).x-sophos-scanverdict%XY

Sophos specific identifier: (threat name).x-sophos-virus-name%Xz

Unified response-side anti-malware scanning verdict that
provides the malware category independent of which
scanning engines are enabled. Applies to transactions
blocked or monitored due to server response scanning.

This field is written with double-quotes in the access logs.

x-resp-dvs-verdictname%XZ

Verdict fromAdvancedMalware Protection file scanning:

• 0: File is not malicious.

• 1: File was not scanned because of its file type.

• 2: File scan timed out.

• 3: Scan error.

• Greater than 3: File is malicious.

x-amp-verdict%X#1#

Threat name, as determined by Advanced Malware
Protection file scanning. “-” indicates no threat.

x-amp-malware-name%X#2#
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DescriptionLog Field in W3C LogsFormat
Specifier in
Access Logs

Reputation score fromAdvancedMalware Protection file
scanning.

This score is used only if the cloud reputation service is
unable to determine a clear verdict for the file.

For details, see information about the Threat Score and
the reputation threshold in File Reputation Filtering and
File Analysis, on page 261

x-amp-score%X#3#

Indicator of upload and analysis request:

“0” indicates that Advanced Malware Protection did not
request upload of the file for analysis.

“1” indicates that Advanced Malware Protection did
request upload of the file for analysis.

x-amp-upload%X#4#

The name of the file being downloaded and analyzed.x-amp-filename%X#5#

The SHA-256 identifier for this file.x-amp-sha%X#6#

Method.cs-method%y

The entire URL.cs-url%Y

Code that describes which server was contacted for the
retrieving the request content (for example,
DIRECT/www.example.com).

x-hierarchy-originN/A

Result code and the HTTP response code, with a slash (/)
in between.

x-resultcode-httpstatusN/A

Display the verdict of Archive Inspection.x-archivescan-verdictN/A

Details of the file blocked by Archive Scan.x-archivescan-verdict- reasonN/A

Reserved for future.N/A%XU

Related Topics

• Web Proxy Information in Access Log Files, on page 373.

• Interpreting W3C Access Logs, on page 389.

Malware Scanning Verdict Values
A malware scanning verdict is a value assigned to a URL request or server response that determines the
probability that it contains malware. TheWebroot, McAfee, and Sophos scanning engines return the malware
scanning verdict to the DVS engine so the DVS engine can determine whether to monitor or block the scanned
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object. Each malware scanning verdict corresponds to a malware category listed on the Access Policies >
Reputation and Anti-Malware Settings page when you edit the anti-malware settings for a particular Access
Policy.

The following list presents the different Malware Scanning Verdict Values and each corresponding malware
category:

Malware CategoryMalware Scanning Verdict Value

Not Set-

Unknown0

Not Scanned1

Timeout2

Error3

Unscannable4

Generic Spyware10

Browser Helper Object12

Adware13

System Monitor14

Commercial System Monitor18

Dialer19

Hijacker20

Phishing URL21

Trojan Downloader22

Trojan Horse23

Trojan Phisher24

Worm25

Encrypted File26

Virus27

Other Malware33

PUA34

Aborted35

Outbreak Heuristics36
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Malware CategoryMalware Scanning Verdict Value

Known Malicious and High-Risk Files37

Related Topics

• Web Proxy Information in Access Log Files, on page 373.
• Interpreting W3C Access Logs, on page 389.

Troubleshooting Logging
• Custom URL Categories Not Appearing in Access Log Entries, on page 483
• Logging HTTPS Transactions, on page 483
• Alert: Unable to Maintain the Rate of Data Being Generated, on page 484
• Problem Using Third-Party Log-Analyzer Tool with W3C Access Logs, on page 484
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C H A P T E R 23
Perform System Administration Tasks

This chapter contains the following sections:

• Overview of System Administration, on page 411
• Saving, Loading, and Resetting the Appliance Configuration, on page 412
• Cisco Web Security Appliance Licensing, on page 414
• Virtual Appliance License, on page 426
• Enabling Remote Power Cycling , on page 427
• Administering User Accounts, on page 428
• Defining User Preferences, on page 432
• Configuring Administrator Settings, on page 432
• User Network Access, on page 434
• Resetting the Administrator Passphrase, on page 435
• Configuring the Return Address for Generated Messages, on page 435
• Managing Alerts, on page 436
• FIPS Compliance, on page 444
• System Date and Time Management, on page 446
• SSL Configuration , on page 447
• Certificate Management, on page 448
• AsyncOS for Web Upgrades and Updates, on page 453
• Reverting to a Previous Version of AsyncOS for Web, on page 460
• Monitoring System Health and Status Using SNMP, on page 461
• Web Traffic Tap, on page 466

Overview of System Administration
The S-Series appliance provides a variety of tools for managing the system. Functionality on System
Administration tab helps you manage the following tasks:

• Appliance configuration
• Feature keys
• Adding, editing, and removing user accounts
• AsyncOS software upgrades and updates
• System time
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Saving, Loading, and Resetting the Appliance Configuration
All configuration settings within the Web Security appliance are managed using a single XML configuration
file.

• Viewing and Printing the Appliance Configuration, on page 412
• Saving the Appliance Configuration File, on page 412
• Loading the Appliance Configuration File, on page 413
• Resetting the Appliance Configuration to Factory Defaults , on page 413

Viewing and Printing the Appliance Configuration

Step 1 Choose System Administration > Configuration Summary.

Step 2 View or print the Configuration Summary page as required.

Saving the Appliance Configuration File

Step 1 Choose System Administration > Configuration File.
Step 2 Complete the Configuration File options.

DescriptionOption

Choose how the generated configuration file is handled:

• Download file to local computer to view or save.
• Save file to this appliance (wsa_example.com).
• Email file to: – provide one or more email addresses.

Specify a file-handling option

• Mask passphrases in the Configuration Files

– The original passphrases are replaced with “*****” in the exported or saved
file. Please note that configuration files with masked passphrases cannot be
loaded directly back into AsyncOS for Web.

• Encrypt passphrases in the Configuration Files – If FIPS mode is enabled,
this option is available. See Enabling or Disabling FIPSMode , on page 446 for
information about enabling FIPS mode.

Specify a passphrase-handling
option

Choose how the configuration file is named:

• Use system-generated file name
• Use user-defined file name

Select a file-naming option

Step 3 Click Submit.
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Loading the Appliance Configuration File

Loading configuration will permanently remove all of your current configuration settings. It is strongly
recommended that you save your configuration before performing these actions.

Loading configurations from previous release to the latest is not recommended. You can retain the configuration
settings by upgrading the paths.

Caution

If a compatible configuration file is based on an older version of the set of URL categories than the version
currently installed on the appliance, policies and identities in the configuration file may be modified
automatically.

Note

If you encounter a certificate validation error when loading the configuration file, upload the rootCA of the
certificate to the trusted root directory of the Web Security appliance and then load the configuration file
again. To know how to upload the rootCA, see Certificate Management, on page 448.

Note

Step 1 Choose System Administration > Configuration File.
Step 2 Choose Load Configuration options and a file to load. Note:

• Files with masked passphrases cannot be loaded.

• Files must have the following header:

<?xml version=”1.0” encoding=”ISO-8859-1”?> <!DOCTYPE config SYSTEM “config.dtd”>

and a correctly formatted config section:

<config> ... your configuration information in valid XML </config>

Note

Step 3 Click Load.
Step 4 Read the warning displayed. If you understand the consequences of proceeding, click Continue.

Resetting the Appliance Configuration to Factory Defaults
You can choose whether or not to retain existing network settings when you reset the appliance configuration.

This action does not require a commit.

Before you begin

Save your configuration to a location off the appliance.
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Step 1 Choose System Administration > Configuration File.
Step 2 Scroll down to view the Reset Configuration section.
Step 3 Read the information on the page and select options.
Step 4 Click Reset.

Cisco Web Security Appliance Licensing
• Working with Feature Keys, on page 414

• Smart Software Licensing, on page 415

Working with Feature Keys
Feature keys enable specific functionality on your system.Keys are specific to the serial number of your
appliance (you cannot re-use a key from one system on another system).

• Displaying and Updating Feature Keys, on page 414
• Changing Feature Key Update Settings , on page 414

Displaying and Updating Feature Keys

Step 1 Choose System Administration > Feature Keys.
Step 2 To refresh the list of pending keys, click Check for New Keys to refresh the list of pending keys.
Step 3 To add a new feature key manually, paste or type the key into the Feature Key field and click Submit Key. If the feature

key is valid, the feature key is added to the display.
Step 4 To activate a new feature key from the Pending Activation list, mark its “Select” checkbox and click Activate Selected

Keys.

You can configure your appliance to automatically download and install new keys as they are issued. In this case, the
Pending Activation list will always be empty. You can tell AsyncOS to look for new keys at any time by clicking the
Check for New Keys button, even if you have disabled the automatic checking via the Feature Key Settings page.

Changing Feature Key Update Settings
The Feature Key Settings page is used to control whether your appliance checks for and downloads new
feature keys, and whether or not those keys are automatically activated.

Step 1 Choose System Administration > Feature Key Settings.
Step 2 Click Edit Settings.
Step 3 Change the Feature Key Settings as required.
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DescriptionOption

Options to automatically check and download feature keys and to automatically activate
downloaded feature keys.

Automatic checks are normally performed once a month but this changes to once a day
when a feature key is to expire in less than 10 days and once a day after key expiration, for
up to one month. After a month, the expired key is no longer included in the list of
expiring/expired keys.

Automatic Serving of
Feature Keys

Step 4 Submit and commit your changes.

Smart Software Licensing
• Overview, on page 415

• Enabling Smart Software Licensing , on page 417

• Registering the Appliance with Cisco Smart Software Manager , on page 418

• Requesting for Licenses, on page 419

• Deregistering the Appliance from Smart Cisco Software Manager, on page 419

• Reregistering the Appliance with Smart Cisco Software Manager, on page 420

• Changing Transport Settings, on page 420

• Renewing Authorization and Certificate, on page 420

• Updating Smart Agent, on page 420

• Alerts, on page 421

• Command Line Interface, on page 421

Overview
Smart Software Licensing enables you to manage and monitor Cisco Web Security appliance licenses
seamlessly. To activate Smart Software licensing, you must register your appliance with Cisco Smart Software
Manager (CSSM) which is the centralized database that maintains the licensing details about all the Cisco
products that you purchase and use. With Smart Licensing, you can register with a single token rather than
registering them individually on the website using Product Authorization Keys (PAKs).

Once you register the appliance, you can track your appliance licenses and monitor license usage through the
CSSM portal. The Smart Agent installed on the appliance connects the appliance with CSSM and passes the
license usage information to the CSSM to track the consumption.

See https://www.cisco.com/c/en/us/td/docs/wireless/technology/mesh/8-2/b_Smart_Licensing_
Deployment_Guide.html to know about Cisco Smart Software Manager.

Before you begin

• Make sure that your appliance has internet connectivity.
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• Contact Cisco sales team to create a smart account in Cisco Smart Software Manager portal
(https://software.cisco.com/#module/SmartLicensing) or install a Cisco Smart SoftwareManager Satellite
on your network.

See https://www.cisco.com/c/en/us/td/docs/wireless/technology/mesh/8-2/b_Smart_Licensing_
Deployment_Guide.html to know more about Cisco Smart Software Manager user account creation or
installing a Cisco Smart Software Manager Satellite.

For users who do not want to directly send the license usage information to the internet, the Smart
Software Manager Satellite can be installed on the premises, and it provides a subset of CSSM
functionality. Once you download and deploy the satellite application, you can manage licenses locally
and securely without sending data to CSSMusing the internet. The CSSMSatellite periodically transmits
the information to the cloud.

If you want to use Smart SoftwareManager Satellite, use Smart SoftwareManager
Satellite Enhanced Edition 6.1.0.

Note

• The existing users of classic licenses (traditional) should migrate their classic licenses to smart licenses.

See https://video.cisco.com/detail/video/5841741892001/
convert-classic-licenses-to-smart-licenses?autoStart=true&q=classic.

• The system clock of the appliance must be in sync with that of the CSSM. Any deviation in the system
clock of the appliance with that of the CSSM, will result in failure of smart licensing operations.

If you have internet connectivity and want to connect to the CSSM through a proxy, you must use the same
proxy that is configured for the appliance using System Administration-> Upgrade and Update Settings

Note

For virtual users, every time you receive a new PAK file (new or renewal), generate the license file and load
the file on the appliance. After loading the file, you must convert the PAK to Smart Licensing. In Smart
Licensing mode, the feature keys section in the license file will be ignored while loading the file and only the
certificate information will be used.

Note

The appliance will move from the Smart Licensing mode to Classic Licensing mode when you revert the
appliance to a previous veriosn of AsyncOS. You must enable Smart Licensing manually and request for
required licences.

Note

You must perform the following procedures to activate Smart Software Licensing for your appliance:

More InformatonDo This

Enabling Smart Software Licensing
, on page 417

Enable Smart Software LicensingStep 1
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More InformatonDo This

Registering the Appliance with
Cisco Smart Software Manager ,
on page 418

Register the appliance with Cisco
Smart Software Manager

Step 2

Requesting for Licenses, on page
419

Request for licenses (feature keys)Step 3

Enabling Smart Software Licensing

Step 1 Choose System Administration > Smart Software Licensing.
Step 2 Click Enable Smart Software Licensing.

To know about Smart Software Licensing, click on the Learn More about Smart Software Licensing link.

Step 3 Click OK after reading the information about Smart Software Licensing.
Step 4 Commit your changes.

What to do next

After you enable Smart Software Licensing, all the features in the Classic Licensingmode will be automatically
available in the Smart Licensingmode. If you are an existing user in Classic Licensingmode, you have 90-days
evaluation period to use the Smart Software Licensing feature without registering your appliance with the
CSSM.

You will get notifications on regular intervals (90th, 60th, 30th, 15th, 5th, and last day) prior to the expiry
and also upon expiry of the evaluation period. You can register your appliance with the CSSM during or after
the evaluation period.

New Virtual Appliance users with no active licenses in Classic Licensing mode will not have the evaluation
period even if they enable the Smart Software Licensing feature. Only the existing Virtual Appliance users
with active licenses in Classic Licensing mode will have evaluation period. If new Virtual Appliance users
want to evaluate the smart licensing feature, contact Cisco Sales team to add the evaluation license to the
smart account. The evaluation licenses are used for evaluation purpose after registration.

Note

After you enable the Smart Licensing feature on your appliance, you will not be able to roll back from Smart
Licensing to Classic Licensing mode.

Note
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The following features are restarted when you enable the Smart Licensing feature:

• Web Security Appliance Web Reputation Filters

• Web Security Appliance Anti-Virus Sophos

• Web Security Appliance Anti-Virus Webroot

• Web Security Appliance Web Proxy and DVS Engine

Note

Registering the Appliance with Cisco Smart Software Manager
Youmust enable the Smart Software Licensing feature under SystemAdministration menu in order to register
your appliance with the Cisco Smart Software Manager.

You cannot register multiple appliances in a single instance. You should register appliances one by one.Note

Step 1 Choose System Administration > Smart Software Licensing.
Step 2 Click Edit, if you want to change the Transport Settings. The available options are:

• Direct: Connects the appliance directly to the Cisco Smart SoftwareManager through HTTPs. This option is selected
by default.

• Transport Gateway: Connects the appliance to the Cisco Smart Software Manager through a Transport Gateway
or Smart SoftwareManager Satellite.When you choose this option, youmust enter the URL of the Transport Gateway
or the Smart Software Manager Satellite and click OK. This option supports HTTP and HTTPS. In FIPS mode,
Transport Gateway supports only HTTPS.

See https://www.cisco.com/c/en/us/td/docs/wireless/technology/mesh/8-2/b_Smart_Licensing_
Deployment_Guide.html to know about Transport Gateway.

Step 3 (Optional) Test Interface: Choose M1 or P1 interface while registering the appliance for the smart licensing feature.
This is applicable only when you enable split routing and register for smart licensing.

If split routing is not enabled, only M1 interface option is available in the Test Interface drop-down list.Note

Access the Cisco Smart SoftwareManager portal (https://software.cisco.com/#module/SmartLicensing) using your login
credentials. Navigate to the Virtual Account page of the portal and access the General tab to generate a new token. Copy
the Product Instance Registration Token for your appliance.

See https://www.cisco.com/c/en/us/td/docs/wireless/technology/mesh/8-2/b_Smart_Licensing_Deployment_Guide.html
to know about Product Instance Registration Token creation.

Step 4 Switch back to your appliance and paste the Product Instance Registration Token.
Step 5 Click Register.
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On the Smart Software Licensing page, you can check the Reregister this product instance if it is already registered
check box to reregister your appliance.

What to do next

The product registration process takes a few minutes and you can view the registration status on the Smart
Software Licensing page.

Requesting for Licenses
Once you complete the registration process successfully, you must request for licenses for the appliance's
features as required.

Step 1 Choose System Administration > Licenses.
Step 2 Click Edit Settings.
Step 3 Check the checkboxes under the License Request/Release column corresponding to the licenses you want to request for.
Step 4 Click Submit.

What to do next

When the licenses are overused or expired, they will go into out of compliance (OOC) mode and 30-days
grace period is provided to each license. You will get notifications on regular intervals (30th, 15th, 5th, and
last day) prior to the expiry and also upon the expiry of the OOC grace period.

After the expiry of the OOC grace period, you cannot use the licenses and the features will be unavailable.
To access the features again, you must update the licenses on the CSSM portal and renew the authorization.

Releasing Licenses

Step 1 Choose System Administration > Licenses.
Step 2 Click Edit Settings.
Step 3 Uncheck the checkboxes under the License Request column corresponding to the licenses you want to release.
Step 4 Click Submit.

Deregistering the Appliance from Smart Cisco Software Manager

Step 1 Choose System Administration > Smart Software Licensing.
Step 2 From the Action drop-down list, choose Deregister and click Go.
Step 3 Click Submit.
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Reregistering the Appliance with Smart Cisco Software Manager

Step 1 Choose System Administration > Smart Software Licensing.
Step 2 From the Action drop-down list, choose Reregister and click Go.

What to do next

See Registering the Appliance with Cisco Smart Software Manager , on page 418 to know about registration
process.

You can reregister the appliance after you reset the appliance configurations during unavoidable scenarios.

Changing Transport Settings
You can change the transport settings only before registering the appliance with CSSM.

You can change the transport settings only when the smart licensing feature is enabled.If you have already
registered your appliance, you must deregister the appliance to change the transport settings. After changing
the transport settings, you must register the appliance again.

Note

See Registering the Appliance with Cisco Smart Software Manager , on page 418 to know how to change the
transport settings.

Renewing Authorization and Certificate
After you register your appliance with the Smart Cisco Software Manager, you can renew the certificate.

You can renew authorization only after the successful registration of the appliance.Note

Step 1 Choose System Administration > Smart Software Licensing.
Step 2 From the Action drop-down list, choose the appropriate option:

• Renew Authorization Now

• Renew Certificates Now

Step 3 Click Go.

What to do next

Updating Smart Agent
To update the Smart Agent version installed on your appliance, perform the following steps:

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
420

Perform System Administration Tasks
Reregistering the Appliance with Smart Cisco Software Manager



Step 1 Choose System Administration > Smart Software Licensing.
Step 2 In the Smart Agent Update Status section, click Update Now and follow the process.

If you try to save any configuration changes using the CLI command saveconfig or through the web interface
using System Administration > Configuration Summary, then Smart Licensing related configuration will
not be saved.

Note

Alerts
You will receive notifications on the following scenarios:

• Smart Software Licensing successfully enabled

• Smart Software Licensing enabling failed

• Beginning of the evaluation period

• Expiry of evaluation period (on regular intervals during evaluation period and upon expiry)

• Successfully registered

• Registration failed

• Successfully authorized

• Authorization failed

• Successfully deregistered

• Deregistration failed

• Successfully renewed Id certificate

• Renewal of Id certificate failed

• Expiry of authorization

• Expiry of Id certificate

• Expiry of out of compliance grace period (on regular intervals during out of compliance grace period
and upon expiry).

• First instance of the expiry of a feature

Command Line Interface
• license_smart, on page 421

• show_license, on page 425

license_smart

• Description, on page 422
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• Usage, on page 422

• Example: Configuring Port for Smart Agent Service, on page 422

• Example: Enabling Smart Licensing, on page 422

• Example: Registering the Appliance with the Smart Software Manager , on page 423

• Example: Status of Smart Licensing , on page 423

• Example: Status Summary of Smart Licensing , on page 423

• Example: Setting the Smart Transport URL, on page 424

• Example: Requesting Licenses, on page 424

• Example: Releasing Licenses, on page 425

Description

Configure smart software licensing feature.

Usage

Commit: This command requires a 'commit'.

Batch Command: This command supports a batch format. For details, see the inline help by typing the
command: help license_smart.

Example: Configuring Port for Smart Agent Service

example.com> license_smart
Choose the operation you want to perform:
- ENABLE - Enables Smart Licensing on the product.
- SETAGENTPORT - Set port to run Smart Agent service.
[]> setagentport

Enter the port to run smart agent service.
[65501]>

Example: Enabling Smart Licensing

example.com> license_smart
Choose the operation you want to perform:
- ENABLE - Enables Smart Licensing on the product.
[]> enable
After enabling Smart Licensing on your appliance, follow below steps to activate
the feature keys (licenses):

a) Register the product with Smart Software Manager using license_smart > register command
in the CLI.
b) Activate the feature keys using license_smart > requestsmart_license command in the CLI.

Note: If you are using a virtual appliance, and have not enabled any of the
features in the classic licensing mode; you will not be able to activate the
licenses, after you switch to the smart licensing mode. You need to first register
your appliance, and then you can activate the licenses (features) in the smart licensing
mode.
Commit your changes to enable the Smart Licensing mode on your appliance.
All the features enabled in the Classic Licensing mode will be available in the Evaluation
period.
Type "Y" if you want to continue, or type "N" if you want to use the classic licensing mode
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[Y/N] []> y

> commit

Please enter some comments describing your changes:
[]>
Do you want to save the current configuration for rollback? [Y]>

Example: Registering the Appliance with the Smart Software Manager

example.com> license_smart
To start using the licenses, please register the product.
Choose the operation you want to perform:

- REGISTER - Register the product for Smart Licensing.
- URL - Set the Smart Transport URL.
- STATUS - Show overall Smart Licensing status.
- SUMMARY - Show Smart Licensing status summary.

[]> register
Reregister this product instance if it is already registered [N]> n

Enter token to register the product:
[]>
ODRlOTM5MjItOTQzOS00YjY0LWExZTUtZTdmMmY3OGNlNDZmLTE1MzM3Mzgw%0AMDEzNTR8WlpCQ1lMbGVMQWRx
OXhuenN4OWZDdktFckJLQzF5V3VIbzkyTFgx%0AQWcvaz0%3D%0A
Product Registration is in progress. Use license_smart > status command to check status of
registration.

Example: Status of Smart Licensing

example.com> license_smart
To start using the licenses, please register the product.
Choose the operation you want to perform:

- REQUESTSMART_LICENSE - Request licenses for the product.
- RELEASESMART_LICENSE - Release licenses of the product.
- REGISTER - Register the product for Smart Licensing.
- URL - Set the Smart Transport URL.
- STATUS - Show overall Smart Licensing status.
- SUMMARY - Show Smart Licensing status summary.

[]> status
Smart Licensing is: Enabled

Evaluation Period: In Use

Evaluation Period Remaining: 89 days 23 hours 53 minutes
Registration Status: Unregistered

License Authorization Status: Evaluation Mode

Last Authorization Renewal Attempt Status: No Communication Attempted

Product Instance Name: mail.example.com

Transport Settings: Direct (https://smartreceiver.cisco.com/licservice/license)

Example: Status Summary of Smart Licensing

example.com> license_smart
To start using the licenses, please register the product.
Choose the operation you want to perform:
- REGISTER - Register the product for Smart Licensing.

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
423

Perform System Administration Tasks
Example: Registering the Appliance with the Smart Software Manager



- URL - Set the Smart Transport URL.
- STATUS - Show overall Smart Licensing status.
- SUMMARY - Show Smart Licensing status summary.

[]> summary

FeatureName LicenseAuthorizationStatus
Web Security Appliance Cisco Eval
Web Usage Controls
Web Security Appliance Anti-Virus Webroot Eval
Web Security Appliance Anti-Virus Sophos Eval

Example: Setting the Smart Transport URL

example.com> license_smart

Choose the operation you want to perform:
- REQUESTSMART_LICENSE - Request licenses for the product.
- RELEASESMART_LICENSE - Release licenses of the product.
- REGISTER - Register the product for Smart Licensing.
- URL - Set the Smart Transport URL.
- STATUS - Show overall Smart Licensing status.
- SUMMARY - Show Smart Licensing status summary.

[]> url

1. DIRECT - Product communicates directly with the cisco license servers
2. TRANSPORT_GATEWAY - Product communicates via transport gateway or smart software manager
satellite.

Choose from the following menu options:
[1]> 1
Note: The appliance uses the Direct URL
(https://smartreceiver.cisco.com/licservice/license) to communicate with Cisco
Smart Software Manager (CSSM) via the proxy server configured using the updateconfig command.
Transport settings will be updated after commit.

Example: Requesting Licenses

Users of virtual appliance must register their appliance to request for or release the licenses.Note

example.com> license_smart
Choose the operation you want to perform:

- REQUESTSMART_LICENSE - Request licenses for the product.
- RELEASESMART_LICENSE - Release licenses of the product.
- REGISTER - Register the product for Smart Licensing.
- URL - Set the Smart Transport URL.
- STATUS - Show overall Smart Licensing status.
- SUMMARY - Show Smart Licensing status summary.

[]> requestsmart_license

Feature Name License Authorization Status
1. Web Security Appliance Anti-Virus Sophos Not Requested
2. Web Security Appliance Not requested

L4 Traffic Monitor

Enter the appropriate license number(s) for activation.
Separate multiple license with comma or enter range:
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[]> 1
Activation is in progress for following features:
Web Security Appliance Anti-Virus Sophos
Use license_smart > summary command to check status of licenses.

Example: Releasing Licenses

example.com> license_smart
Choose the operation you want to perform:

- REQUESTSMART_LICENSE - Request licenses for the product.
- RELEASESMART_LICENSE - Release licenses of the product.
- REGISTER - Register the product for Smart Licensing.
- URL - Set the Smart Transport URL.
- STATUS - Show overall Smart Licensing status.
- SUMMARY - Show Smart Licensing status summary.

[]> releasesmart_license

Feature Name License Authorization Status
1. Web Security Appliance Cisco Eval

Web Usage Controls
2. Web Security Appliance Eval

Anti-Virus Webroot
3. Web Security Appliance Eval

L4 Traffic Monitor
4. Web Security Appliance Cisco Eval

AnyConnect SM for AnyConnect
5. Web Security Appliance Advanced Eval

Malware Protection Reputation
6. Web Security Appliance Eval

Anti-Virus Sophos
7. Web Security Appliance Eval

Web Reputation Filters
8. Web Security Appliance Advanced Eval

Malware Protection

show_license

• Description, on page 425

• Example: Status of Smart Licensing, on page 425

• Example: Status Summary of Smart Licensing, on page 426

Description

Show Smart Licensing status and summary of status.

Example: Status of Smart Licensing

example.com> showlicense_smart
Choose the operation you want to perform:
- STATUS- Show overall Smart Licensing status.
- SUMMARY - Show Smart Licensing summary.
[]> status
Smart Licensing is: Enabled
Evaluation Period: In Use
Evaluation Period Remaining: 89 days 23 hours 53 minutes
Registration Status: Unregistered
License Authorization Status: Evaluation Mode
Last Authorization Renewal Attempt Status: No Communication Attempted
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Product Instance Name: example.com
Transport Settings: Direct (https://smartreceiver.cisco.com/licservice/license)

Example: Status Summary of Smart Licensing

example.com> showlicense_smart
Choose the operation you want to perform:
- STATUS- Show overall Smart Licensing status.
- SUMMARY - Show Smart Licensing summary.

[]> summary

FeatureName LicenseAuthorizationStatus
Web Security Appliance Cisco Eval
Web Usage Controls
Web Security Appliance Eval
Anti-Virus Webroot
Web Security Appliance Eval
Anti-Virus Sophos

Virtual Appliance License
The CiscoWeb Security Virtual appliance requires an additional license to run the virtual appliance on a host.

For more information about virtual appliance licensing, see the Cisco Content Security Virtual Appliance
Installation Guide , available from
http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-installation-guides-list.html.

You cannot open a Technical Support tunnel before installing the virtual appliance license.Note

After the license expires, the appliance will continue to serve as a web proxy without security services for180
days. Security service updates do not occur during this period.

You can configure the appliance so you receive alerts about license expiration.

Related Topics

• Managing Alerts, on page 436

Installing a Virtual Appliance License
See the Cisco Content Security Virtual Appliance Installation Guide, available from
http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-installation-guides-list.html
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Enabling Remote Power Cycling
Before you begin

• Cable the dedicated Remote Power Cycle (RPC) port directly to a secure network. For information, see
the hardware guide for your appliance model. For the location of this document, see Documentation Set,
on page 523.

• Ensure that the appliance is accessible remotely; for example, open any necessary ports through the
firewall.

• This feature requires a unique IPv4 address for the dedicated Remote Power Cycle interface. This interface
is configurable only via the procedure described in this section; it cannot be configured using the ipconfig
command.

• In order to cycle appliance power, you will need a third-party tool that can manage devices that support
the Intelligent Platform Management Interface (IPMI) version 2.0. Ensure that you are prepared to use
such a tool.

• For more information about accessing the command-line interface, see Command Line Interface, on page
499

The ability to remotely reset the power for the appliance chassis is available only on 80-series hardware.

If you want to be able to remotely reset appliance power, you must enable and configure this functionality in
advance, using the procedure described in this section.

Step 1 Use SSH or the serial console port to access the command-line interface.
Step 2 Sign in using an account with Administrator access.
Step 3 Enter the following commands:

remotepower

setup

Step 4 Follow the prompts to specify the following:

• The dedicated IP address for this feature, plus netmask and gateway.

• The username and passphrase required to execute the power-cycle command.

These credentials are independent of other credentials used to access your appliance.

Step 5 Enter commit to save your changes.
Step 6 Test your configuration to be sure that you can remotely manage appliance power.
Step 7 Ensure that the credentials that you entered will be available to you in the indefinite future. For example, store this

information in a safe place and ensure that administrators who may need to perform this task have access to the required
credentials.

What to do next

Related Topics
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• Hardware Appliances: Remotely Resetting Appliance Power , on page 490

Administering User Accounts
The following types of users can log into the appliance to manage it:

• Local users. You can define users locally on the appliance itself.

• Users defined in an external system. You can configure the appliance to connect to an external LDAP
or RADIUS server to authenticate users logging into the appliance.

Any user you define can log into the appliance using any method, such as logging into the web interface or
using SSH.

Note

Related Topics

• Managing Local User Accounts, on page 428

• RADIUS User Authentication, on page 430

• Configuring External Authentication through an LDAP Server, on page 95

Managing Local User Accounts
You can define any number of users locally on the Web Security appliance.

The default system admin account has all administrative privileges. You can change the admin account
passphrase, but you cannot edit or delete this account.

If you have lost the admin user passphrase, contact your Cisco support provider. For more details, see Reset
Your Administrator Password and Unlock the Administrator User Account.

Note

Adding Local User Accounts

Before you begin

Define the passphrase requirements that all user accounts must follow. See Setting Passphrase Requirements
for Administrative Users , on page 432.

Step 1 Choose System Administration > Users.

Step 2 Click Add User

Step 3 Enter a username, noting the following rules:

• Usernames can contain lowercase letters, numbers, and the dash ( - ) character, but cannot begin with a dash.
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• Usernames cannot greater than 16 characters.

• Usernames cannot be special names that are reserved by the system, such as “operator” or “root.”

• If you also use external authentication, usernames should not duplicate externally-authenticated usernames.

Step 4 Enter a full name for the user.
Step 5 Select a user type.

DescriptionUser Type

Allows full access to all system configuration settings. However, the upgradecheck and
upgradeinstall CLI commands can be issued only from the system defined “admin” account.

Administrator

Restricts users from creating, editing, or removing user accounts. The operators group also
restricts the use of the following CLI commands:

• resetconfig

• upgradecheck

• upgradeinstall

The operators group restricts the use of System Setup Wizard as well.

Operator

User accounts with this role:

• Can view configuration information.

• Can make and submit changes to see how to configure a feature, but they cannot commit
them.

• Cannot make any other changes to the appliance, such as clearing the cache or saving files.

• Cannot access the file system, FTP, or SCP.

Read-Only Operator

The guests group users can only view system status information, including reporting and tracking.Guest

Step 6 Enter or generate a passphrase.
Step 7 Submit and commit your changes.

Deleting User Accounts

Step 1 Choose System Administration > Users.
Step 2 Click the trash can icon corresponding to the listed user name and confirm when prompted.
Step 3 Submit and commit your changes.
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Editing User Accounts

Step 1 Choose System Administration > Users.
Step 2 Click the user name.
Step 3 Make changes to the user on the Edit User page as required.
Step 4 Submit and commit your changes.

Changing Passphrases
To change the passphrase of the account currently logged in, select Options > Change Passphrase from the
top right-hand side of the window.

For other accounts, edit the account and change the passphrase in the Local User Settings page.

Related Topics

• Editing User Accounts, on page 430
• Setting Passphrase Requirements for Administrative Users , on page 432

RADIUS User Authentication
The Web Security appliance can use a RADIUS directory service to authenticate users that log in to the
appliance using HTTP, HTTPS, SSH, and FTP. You can configure the appliance to contact multiple external
servers for authentication, using either PAP or CHAP authentication. You can map groups of external users
to different Web Security appliance user role types.

Sequence of Events For Radius Authentication
When external authentication is enabled and a user logs into the Web Security appliance, the appliance:

1. Determines if the user is the system-defined “admin” account.
2. If not, checks the first configured external server to determine if the user is defined there.
3. If the appliance cannot connect to the first external server, it checks the next external server in the list.
4. If the appliance cannot connect to any external server, it tries to authenticate the user as a local user defined

on the Web Security appliance.
5. If the user does not exist on any external server or on the appliance, or if the user enters the wrong

passphrase, access to the appliance is denied.

Enabling External Authentication Using RADIUS

Step 1 On the System Administration > Users page, click Enable External Authentication.
Step 2 Choose RADIUS as the Authentication Type.
Step 3 Enter the host name, port number, and Shared Secret passphrase for the RADIUS server. Default port is 1812.
Step 4 Enter the number of seconds the appliance is to wait for a response from the server before timing out.
Step 5 Choose the authentication protocol used by the RADIUS server.
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Step 6 (Optional) Click Add Row to add another RADIUS server. Repeat Steps 1 – 5 for each RADIUS server.

You can add up to ten RADIUS servers.Note

Step 7 In the External Authentication Cache Timeout field, enter the number of seconds AsyncOS stores the external
authentication credentials before contacting the RADIUS server again to re-authenticate. Default is zero.

If the RADIUS server uses one-time passphrases, for example passphrases created from a token, enter zero (0).
When the value is set to zero, AsyncOS does not contact the RADIUS server again to authenticate during the
current session.

Note

Step 8 Configure Group Mapping—Select whether to map all externally authenticated users to the Administrator role or to
different appliance-user role types.

DescriptionSetting

Enter a group name as defined in the RADIUSCLASS attribute, and choose an appliance
Role type. You can add more role mappings by clicking Add Row.

AsyncOS assigns RADIUS users to appliance roles based on the RADIUS CLASS
attribute. CLASS attribute requirements:

• three-character minimum
• 253-character maximum
• no colons, commas, or newline characters
• one or more mapped CLASS attributes for each RADIUS user (With this setting,
AsyncOS denies access to RADIUS users without a mapped CLASS attribute.)

For RADIUS users with multiple CLASS attributes, AsyncOS assigns themost restrictive
role. For example, if a RADIUS user has two CLASS attributes, which are mapped to
the Operator and Read-Only Operator roles, AsyncOS assigns the RADIUS user to the
Read-Only Operator role, which is more restrictive than the Operator role.

These are the appliance roles ordered from most restrictive to least restrictive:

• Administrator

• Operator

• Read-Only Operator

• Guest

Map externally authenticated
users to multiple local roles.

AsyncOS assigns all RADIUS users to the Administrator role.Map all externally
authenticated users to the
Administrator role.

Step 9 Submit and commit your changes.

What to do next

Related Topics

• External Authentication, on page 95
• Adding Local User Accounts, on page 428.
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Defining User Preferences
Preference settings, such as reporting display formats, are stored for each user and are the same regardless
from which client machine the user logs into the appliance.

Step 1 Choose Options > Preferences.
Step 2 On the User Preferences page, click Edit Preferences.
Step 3 Configure the preference settings as required.

DescriptionPreference Setting

The language AsyncOS for Web uses in the web interface and CLI.Language Display

The page that displays when the user logs into the appliance.Landing Page

The default time range that displays for reports on the Reporting tab.Reporting TimeRangeDisplayed
(default)

The number of rows of data shown for each report by default.Number of Reporting Rows
Displayed

Step 4 Submit and commit your changes.

Configuring Administrator Settings

Setting Passphrase Requirements for Administrative Users
To set passphrase requirements for locally-defined administrative users of the appliance:

Step 1 Select System Administration > Users.
Step 2 In the Passphrase Settings section, click Edit Settings.
Step 3 Choose options:

DescriptionOption

Create a .txt file with each forbidden word on a separate line, then select the file to
upload it. Subsequent uploads overwrite previous uploads.

List of words to disallow in
passphrases
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DescriptionOption

You can display a passphrase-strength indicator when an administrative user enters
a new passphrase.

This setting does not enforce creation of strong passphrases, it merely shows how
easy it is to guess the entered passphrase.

Select the roles for which you wish to display the indicator. Then, for each selected
role, enter a number greater than zero. A larger number means that a passphrase that
registers as strong is more difficult to achieve. This setting has no maximum value,
but a very high number makes it effectively impossible to enter a passphrase that
evaluates as “good.”

Experiment to see what number best meets your requirements.

Passphrase strength is measured on a logarithmic scale. Evaluation is based on the
U.S. National Institute of Standards and Technology rules of entropy as defined in
NIST SP 800-63, Appendix A.

Generally, stronger passphrases:

• Are longer
• Include upper case, lower case, numeric, and special characters
• Do not include words in any dictionary in any language.

To enforce passphrases with these characteristics, use the other settings on this page.

Passphrase Strength

Step 4 Submit and commit your changes.

Additional Security Settings for Accessing the Appliance
You can use the CLI command adminaccessconfig to configure the Web Security appliance to have stricter
access requirements for administrators logging into the appliance.

DescriptionCommand

Configures the appliance to display any text you specify when an administrator
tries to log in. The custom log-in banner appears when an administrator
accesses the appliance through any interface; for example, via the Web UI,
CLI, or FTP.

You can load the custom text either by pasting it into the CLI prompt, or by
copying it from a text file located on the Web Security appliance. To upload
the text from a file, you must first transfer the file to the configuration
directory on the appliance using FTP.

adminaccessconfig > banner

This is a post-log-in banner, displayed after successful administrator log-in.
This text is added to the appliance configuration by the same means as the
log-in adminaccessconfig > banner text.

adminaccessconfig >
welcome
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DescriptionCommand

Controls from which IP addresses administrators access the Web Security
appliance. Administrators can access the appliance from any machine, or
from machines with an IP address from a list you specify.

When restricting access to an allow list, you can specify IP addresses, subnets,
or CIDR addresses. By default, when you list the addresses that can access
the appliance, the IP address of your current machine is listed as the first
address in the allow list. You cannot delete the IP address of your current
machine from the allow list. This information also can be provided using the
Web UI; see User Network Access, on page 434.

adminaccessconfig >
ipaccess

Enable/disable Web UI cross-site request forgery protection, used to identify
and protect against malicious or spoofed requests. For best security, it is
recommended that CSRF protection be enabled.

adminaccessconfig > csrf

Configure use of host header in HTTP requests.

By default, the Web UI responds with the host header sent by the Web client
in an HTTP request. For increased security, you can configure the Web UI
to respond with only the appliance-specific host name; that is, the appliance’s
configured name (for example, wsa_04.local).

adminaccessconfig >
hostheader

Provide an inactivity time-out interval; that is, the number of minutes users
can be inactive before being logged out. This value can be between five and
1440 minutes (24 hours); the default value is 30 minutes. This information
also can be provided using the Web UI; see User Network Access, on page
434.

adminaccessconfig >
timeout

Enable walkthroughs that assist you in accomplishing specific configuration
tasks.

adminaccessconfig >
how-tos

Configures the appliance so administrators log into the web interface on port
8443 using stronger SSL ciphers (greater than 56 bit encryption).

When you configure the appliance to require stronger SSL ciphers, the change
only applies to administrators accessing the appliance usingHTTPS tomanage
the appliance. It does not apply to other network traffic connected to theWeb
Proxy using HTTPS.

adminaccessconfig >
strictssl

Configure the number of days for which the login history is retained.adminaccessconfig >
loginhistory

Configure the maximum number of concurrent login sessions (CLI and web
interface).

adminaccessconfig >
maxsessions

User Network Access
You can specify how long a user can be logged into the appliance before AsyncOS logs the user out due to
inactivity. You also can specify the type of user connections allowed.
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The session timeout applies to all users, including administrators, logged into either the Web UI or the CLI.
When AsyncOS logs a user out, the user is redirected to the appliance log-in page.

You also can use the CLI adminaccessconfig > timeout to set this time-out value.Note

Step 1 Choose System Administration > Network Access.
Step 2 Click Edit Settings.
Step 3 In the Session Inactivity Timeout field, enter the number of minutes users can be inactive before being logged out.

You can define a time-out interval between five and 1440 minutes (24 hours); the default value is 30 minutes.

Step 4 In the User Access section, you control users’ system access: choose either Allow Any Connection or Only Allow
Specific Connections.

If you choose Only Allow Specific Connections, define the specific connections as IP addresses, IP ranges, or CIDR
ranges. Along with the client IP address, the appliance IP address is automatically added in the User Access section.

Step 5 Submit and commit your changes.

Resetting the Administrator Passphrase
Before you begin

• If you do not know the passphrase for the admin account, contact your customer support provider to reset
the passphrase.

• Understand that changes to the passphrase take effect immediately and do not require you to commit the
change.

Any administrator-level user can change the passphrase for the “admin” user.

Step 1 Select Management Appliance > System Administration > Users.
Step 2 Click the admin link in the Users list.
Step 3 Select Change the passphrase.
Step 4 Generate or enter the new passphrase.

Configuring the Return Address for Generated Messages
You can configure the return address for mail generated by AsyncOS for reports.

Step 1 Choose System Administration > Return Addresses.
Step 2 Click Edit Settings.
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Step 3 Enter the display name, user name, and domain name.
Step 4 Submit and commit your changes.

Managing Alerts
Alerts are email notifications containing information about events occurring on the Cisco Web Security
Appliance appliance. These events can be of varying levels of importance (or severity) from minor
(Informational) to major (Critical) and pertain generally to a specific component or feature on the appliance.

To receive alerts and email notifications, you must configure the SMTP relay host that the appliance uses to
send the email messages.

Note

Alert Classifications and Severities
The information contained in an alert is determined by an alert classification and a severity. You can specify
which alert classifications, at which severity, are sent to any alert recipient.

Alert Classifications
AsyncOS sends the following types of alert:

• System

• Hardware

• Updater

• Web Proxy

• Anti-Malware

• L4 Traffic Monitor

• External URL Categories

• Policy Expiration

Alert Severities
Alerts can be sent for the following severities:

• Critical: Requires immediate attention.
• Warning: Problem or error requiring further monitoring and potentially immediate attention.
• Information: Information generated in the routine functioning of this device.
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Managing Alert Recipients

If you enabled AutoSupport during System Setup, the email address you specified will receive alerts for all
severities and classes by default. You can change this configuration at any time.

Note

Adding and Editing Alert Recipients

Step 1 Choose System Administration > Alerts.
Step 2 Click on a recipient in the Alert Recipients list to edit it, or click Add Recipient to add a new recipient.
Step 3 Add or edit the recipient’s email address. You can enter multiple addresses, separated by commas.
Step 4 Select which alert severities to receive for each alert type.
Step 5 Submit and commit your changes.

Deleting Alert Recipients

Step 1 Choose System Administration > Alerts.
Step 2 Click the trash can icon corresponding to the alert recipient in the Alert Recipient listing and confirm.
Step 3 Commit your changes.

Configuring Alert Settings
Alert settings are global settings, meaning that they affect how all of the alerts behave.

Step 1 Choose System Administration > Alerts.
Step 2 Click Edit Settings.
Step 3 Configure the alert settings as required.

DescriptionOption

The RFC 2822 compliant “Header From:” address to use when sending alerts. An option is
provided to automatically generate an address based on the system hostname
(“alert@<hostname>”)

From Address to Use
When Sending Alerts
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DescriptionOption

Specifies the time interval for duplicate alerts. There are two settings:

Initial Number of Seconds to Wait Before Sending a Duplicate Alert. If you set this value
to 0, duplicate alert summaries are not sent and instead, all duplicate alerts are sent without
any delay (this can lead to a large amount of email over a short amount of time). The number
of seconds to wait between sending duplicate alerts (alert interval) is increased after each
alert is sent. The increase is the number of seconds to wait plus twice the last interval. So a
5 second wait would have alerts sent at 5 seconds, 15, seconds, 35 seconds, 75 seconds, 155
seconds, 315 seconds, etc.

Maximum Number of Seconds to Wait Before Sending a Duplicate Alert. You can set a
cap on the number of seconds to wait between intervals via the maximum number of seconds
to wait before sending a duplicate alert field. For example, if you set the initial value to 5
seconds, and the maximum value to 60 seconds, alerts would be sent at 5 seconds, 15 seconds,
35 seconds, 60 seconds, 120 seconds, etc

Wait Before Sending a
Duplicate Alert

Specifies whether to send Cisco the following support information:

• a copy of all alert messages generated by the system
• weekly reports noting the uptime of the system, the output of the status command, and
the AsyncOS version used.

Also specifies whether or not to send internal alert recipients a copy of every message sent
to Cisco. This applies only to recipients that are set to receive System alerts at Information
severity level.

Cisco AutoSupport

Step 4 Submit and commit your changes.

Alert Listing
The following sections list alerts by classification. The table in each section includes the alert name (internally
used descriptor), actual text of the alert, description, severity (critical, information, or warning) and the
parameters (if any) included in the text of the message.

Feature Key Alerts
The following table contains a list of the various feature key alerts that can be generated by AsyncOS, including
a description of the alert and the alert severity:

ParametersAlert SeverityMessage

$feature: Name of the feature.Information.A “$feature” key was downloaded from the key server
and placed into the pending area. EULA acceptance
required.

$feature: Name of the feature.Warning.Your “$feature” evaluation key has expired. Please
contact your authorized sales representative.
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ParametersAlert SeverityMessage

$feature: Name of the feature.

$days: The number of days that
will pass before the feature key will
expire.

Warning.Your “$feature” evaluation key will expire in under
$days day(s). Please contact your authorized sales
representative.

Hardware Alerts
The following table contains a list of the various hardware alerts that can be generated by AsyncOS, including
a description of the alert and the alert severity:

ParametersAlert SeverityMessage

$error: Text of the RAID error.WarningA RAID-event has occurred:

$error

Logging Alerts
The following table contains a list of the various logging alerts that can be generated by AsyncOS, including
a description of the alert and the alert severity:

ParametersAlert SeverityMessage

$error: The traceback string of the
error.

Information.$error.

$name: Log subscription name.Critical.Log Error: Subscription $name: Log partition is full.

$name: Log subscription name.

$ip: IP address of the remote host.

$reason: Text describing the
connect error

Critical.Log Error: Push error for subscription $name: Failed
to connect to $ip: $reason.

$name: Log subscription name.

$ip: IP address of the remote host.

$reason: Text describing what
went wrong.

Critical.Log Error: Push error for subscription $name: An FTP
command failed to $ip: $reason.

$name: Log subscription name.

$ip: IP address of the remote host.

$port: Port number on the remote
host.

$reason: Text describing what
went wrong.

Critical.Log Error: Push error for subscription $name: SCP
failed to transfer to $ip:$port: $reason',
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ParametersAlert SeverityMessage

$name: Log subscription name.

$hostname: Hostname of the
syslog server.

$ip: IP address of the syslog server.

$error: Text of the error message.

Critical.Log Error: 'Subscription $name: Failed to connect to
$hostname ($ip): $error.

$name: Log subscription name.

$hostname: Hostname of the
syslog server.

$ip: IP address of the syslog server.

$error: Text of the error message.

Critical.Log Error: Subscription $name: Network error while
sending log data to syslog server $hostname ($ip):
$error

$name: Log subscription name.

$timeout: Timeout in seconds.

$hostname: Hostname of the
syslog server.

$ip: IP address of the syslog server.

Critical.Subscription $name: Timed out after $timeout seconds
sending data to syslog server $hostname ($ip).

$name: Log subscription name.

$hostname: Hostname of the
syslog server.

$ip: IP address of the syslog server.

Critical.Subscription $name: Syslog server $hostname ($ip)
is not accepting data fast enough.

$name: Log subscription name.

$max_num_files: Maximum
number of files allowed per log
subscription.

$files_removed: List of files that
were removed.

Information.Subscription $name: Oldest log file(s) were removed
because log files reached the maximum number of
$max_num_files. Files removed include:

$files_removed.

Reporting Alerts
The following table contains a list of the various reporting alerts that can be generated by AsyncOS, including
a description of the alert and the alert severity:

ParametersAlert SeverityMessage

Not applicable.Critical.The reporting system is unable to maintain the rate of
data being generated. Any new data generated will be
lost.

Not applicable.Information.The reporting system is now able to handle new data.
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ParametersAlert SeverityMessage

$report_title: Title of the report.Critical.A failure occurred while building periodic report
‘$report_title’.

This subscription should be examined and deleted if
its configuration details are no longer valid.

$report_title: Title of the report.Critical.A failure occurred while emailing periodic report
‘$report_title’.

This subscription has been removed from the
scheduler.

$threshold: Threshold value.Warning.Processing of collected reporting data has been
disabled due to lack of logging disk space. Disk usage
is above $threshold percent. Recording of reporting
events will soon become limited and reporting data
may be lost if disk space is not freed up (by removing
old logs, etc).

Once disk usage drops below $threshold percent, full
processing of reporting data will be restarted
automatically.

$report_title: Title of the report.

$file_name: Name of the file.

Critical.PERIODICREPORTS:While building periodic report
$report_title' the expected domain specification file
could not be found at ‘$file_name’. No reports were
sent.

$counter_group: Name of the
counter_group.

Critical.Counter group “$counter_group” does not exist.

$report_title: Title of the report.

$file_name: Name of the file.

Critical.PERIODICREPORTS:While building periodic report
$report_title’ the domain specification file
‘$file_name’ was empty. No reports were sent.

$report_title: Title of the report.

$file_name: Name of the file.

$error_text: List of errors
encountered.

Critical.PERIODIC REPORTS: Errors were encountered
while processing the domain specification file
‘$file_name’ for the periodic report ‘$report_title’.
Any line which has any reported problem had no
report sent.

$error_text

$threshold: Threshold value.Warning.Processing of collected reporting data has been
disabled due to lack of logging disk space. Disk usage
is above $threshold percent. Recording of reporting
events will soon become limited and reporting data
may be lost if disk space is not freed up (by removing
old logs, etc).

Once disk usage drops below $threshold percent, full
processing of reporting data will be restarted
automatically.
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ParametersAlert SeverityMessage

$err_msg: Error message text.Critical.The reporting system has encountered a critical error
while opening the database. In order to prevent
disruption of other services, reporting has been
disabled on this machine. Please contact customer
support to have reporting enabled.

The error message is:

$err_msg

System Alerts
The following table contains a list of the various system alerts that can be generated by AsyncOS, including
a description of the alert and the alert severity:

ParametersAlert SeverityMessage

$name: Name of the script.

$message: Error message text.

Critical.Startup script $name exited with error: $message

$exit_status: Exit code of the
command.

$output: Output from the
command.

Critical.System halt failed: $exit_status: $output',

$exit_status: Exit code of the
command.

$output: Output from the
command.

Critical.System reboot failed: $exit_status: $output

$name: Name of the process.

$dependency: Name of the
dependency that was listed.

Critical.Process $name listed $dependency as a dependency,
but it does not exist.

$name: Name of the process.

$dependency: Name of the
dependency that was listed.

Critical.Process $name listed $dependency as a dependency,
but $dependency is not a wait_init process.

$name: Name of the process.Critical.Process $name listed itself as a dependency.

$name: Name of the process.

$dependency: Name of the
dependency that was listed.

Critical.Process $name listed $dependency as a dependency
multiple times.

$cycle: The list of process names
involved in the cycle.

Critical.Dependency cycle detected: $cycle.
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ParametersAlert SeverityMessage

$error: The error message
associated with the exception.

Warning.An error occurred while attempting to share statistical
data through the Network Participation feature. Please
forward this tracking information to your support
provider:

Error: $error.

$name: Name of the process that
generated a core file.

Critical.There is an error with “$name”.

$error: Text of the error, typically
a traceback.

Critical.An application fault occurred: “$error”

$appliance: Identifier of the
specific WSA.

$username: Identifier of the
specific user account.

$ip: - IP address from which the
login attempt occurred.

Information.Appliance: $appliance, User: $username, Source IP:
$ip, Event: Account locked due to X failed login
attempts.

User $username is locked after X consecutive login
failures. Last login attempt was from $ip.

$port: Port number used for the
service tunnel.

Information.Tech support: Service tunnel has been enabled, port
$port

Not applicable.Information.Tech support: Service tunnel has been disabled.

$ip - IP address fromwhich a login
attempt occurred.

Description:

IP addresses that try to connect to
the appliance over SSH but do not
provide valid credentials are added
to the SSH blocked list if more than
10 failed attempts occur within two
minutes.

When a user logs in successfully
from the same IP address, that IP
address is added to the allowed list.

Addresses on the allowed list are
allowed access even if they are also
on the blocked list.

Entries are automatically removed
from the blocked list after about a
day.

Warning.• The host at $ip has been added to the blocked
list because of an SSH DOS attack.

• The host at $ip has been permanently added to
the ssh allowed list.

• The host at $ip has been removed from the
blocked list.
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Updater Alerts
The following table contains a list of the various updater alerts that can be generated by AsyncOS, including
a description of the alert and the alert severity:

ParametersAlert SeverityMessage

$app: Web Security appliance
security service name.

$attempts: Number of attempts
tried.

Warning.The $app application tried and failed $attempts times
to successfully complete an update. This may be due
to a network configuration issue or temporary outage.

$threshold: Threshold value time.Warning.The updater has been unable to communicate with the
update server for at least $threshold.

$traceback: Traceback
information.

Critical.Unknown error occurred: $traceback.

$host: The hostname of the
UPDATER Server.

$port: The port of the UPDATER
Server.

CriticalCertificate Revoke: OCSP validation failed for the
UPDATER Server Certificate ($host:$port). Ensure
the certificate is valid.

Anti-Malware Alerts
For information about alerts related to Advanced Malware Protection, see Ensuring That You Receive Alerts
About Advanced Malware Protection Issues, on page 273.

Policy Expiration Alerts
The following table contains a list of the various Policy Expiration alerts that can be generated by AsyncOS,
including a description of the alert and the alert severity:

ParametersAlert SeverityMessage

$PolicyType: Access policy /
decryption policy based on the web
policy type.

$GroupName:Policy group name.

Information'$PolicyType': '$GroupName' has been disbaled due
to expiry configuration.

$PolicyType: Access policy /
decryption policy based on the web
policy type.

$GroupName: Policy group name.

Information'$PolicyType' : '$GroupName' will expire in days : 3.

FIPS Compliance
Federal Information Processing Standards (FIPS) specify requirements for cryptographic modules that are
used by all government agencies to protect sensitive but unclassified information. FIPS help ensure compliance
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with federal security and data privacy requirements. FIPS, developed by the National Institute for Standards
and Technology (NIST), are for use when no voluntary standards exist to meet federal requirements.

TheWSA achieves FIPS 140-2 compliance in FIPSmode using Cisco CommonCryptographicModule (C3M).
By default, FIPS mode is disabled.

Related Topics

• FIPS Mode Problems, on page 470

FIPS Certificate Requirements
FIPS mode requires that all enabled encryption services on the Web Security appliance use a FIPS-compliant
certificate. This applies to the following encryption services:

• HTTPS Proxy

• Authentication

• Identity Provider for SaaS

• Appliance Management HTTPS Service

• Secure ICAP External DLP Configuration

• Identity Services Engine

• SSL Configuration

• SSH Configuration

The Appliance Management HTTPS Service must be configured with a FIPS Complaint certificate before
FIPS mode can be enabled. The other encryption services need not be enabled.

Note

A FIPS-compliant certificate must meet these requirements:

NotesSignature AlgorithmAlgorithmCertificate

Cisco recommends a bit key size of 1024 for best
decryption performance and sufficient security. A
larger bit size will increase security, but impact
decryption performance.

sha1WithRSAEncryption

sha256WithRSAEncryption

RSAX509

FIPS Certificate Validation
When you enable FIPS mode, the appliance performs the following certificate checks:

• All certificates uploaded to the WSA, whether by means of the UI or the certconfig CLI command, are
validated to comply strictly with CC standards. Any certificate without a proper trust path in the WSA’s
trust store cannot be uploaded.
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• Certificate Signature with a trusted path validation; Certificate/Public Key tampering with
basicConstrains and CAFlag set validated for all signer certificates.

• OCSP validation is available to validate a certificate against a revocation list. This is configurable using
the certconfig CLI command.

See also Strict Certificate Validation, on page 449.

Enabling or Disabling FIPS Mode

Before you begin

• Make a back-up copy of the appliance configuration; see Saving the Appliance Configuration File, on
page 412

• Ensure the certificates to be used in FIPS mode use FIPS 140-2 approved public key algorithms (see
FIPS Certificate Requirements, on page 445).

• Changing the FIPS mode initiates a reboot of the appliance.

• When you disable FIPSmode, the SSL and SSH settings—whichwere automaticallymade FIPS-compliant
when FIPS mode was enabled—are not reset to their default values. You must explicitly change these
settings if you wish to allow a client using weaker SSH/SSL settings to connect. See SSL Configuration
, on page 447 for additional information.

Note

Step 1 Choose System Administration > FIPS Mode.
Step 2 Click Edit Settings.
Step 3 Check Enable FIPS Compliance to enable FIPS compliance.

When you check Enable FIPS Compliance, the Enable encryption of Critical Sensitive Parameters (CSP) check box
is enabled.

Step 4 Check Enable encryption of Critical Sensitive Parameters (CSP) to enable encryption of configuration data such as
passwords, authentication information, certificates, shared keys, and so on.

Step 5 Click Submit.
Step 6 Click Continue to allow the appliance to reboot.

System Date and Time Management
• Setting the Time Zone, on page 447
• Synchronizing the System Clock with an NTP Server , on page 447
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Setting the Time Zone

Step 1 Choose System Administration > Time Zone.
Step 2 Click Edit Settings.
Step 3 Select your region, country, and time zone or select the GMT offset.
Step 4 Submit and commit the changes.

Synchronizing the System Clock with an NTP Server
Cisco recommends that you set your Web Security appliance to track the current date and time by querying
a Network Time Protocol (NTP) server, not by manually setting the time on the appliance. This is especially
true if your appliance integrates with other devices. All integrated devices should use the same NTP server.

Step 1 Choose System Administration > Time Settings.
Step 2 Click Edit Settings.
Step 3 Select Use Network Time Protocol as the Time Keeping Method.
Step 4 Enter the fully qualified hostname or IP address of the NTP server, clicking Add Row as needed to add servers.
Step 5 (Optional) Choose the routing table associated with an appliance network interface type, either Management or Data, to

use for NTP queries. This is the IP address from which NTP queries should originate.

This option is only editable if the appliance is using split routing for data and management traffic.Note

Step 6 Submit and commit your changes.

SSL Configuration
For enhanced security, you can enable and disable SSL v3 and various versions of TLS for several services.
Disabling SSL v3 for all services is recommended for best security. By default, all versions of TLS are enabled,
and SSL is disabled.

You also can use the sslconfigCLI command to enable or disable these features. SeeWeb Security Appliance
CLI Commands, on page 503.

Note

Step 1 Choose System Administration > SSL Configuration.
Step 2 Click Edit Settings.
Step 3 Check the corresponding boxes to enable SSL v3 and TLS v1.x for these services:

• Appliance Management Web User Interface – Changing this setting will disconnect all active user connections.

• Proxy Services – Includes HTTPS Proxy and Credential Encryption for Secure Client. This section also includes:
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• Cipher(s) to Use – You can enter additional cipher suites to be used with Proxy Services communications.
Use colons (:) to separate the suites. To prevent use of a particular cipher, add an exclamation point (!) to the
front of that string. For example, !EXP-DHE-RSA-DES-CBC-SHA .

Be sure to enter only suites appropriate to the TLS/SSL versions you have checked. Refer to
https://www.openssl.org/docs/manmaster/man1/ciphers.html for additional information, and cipher lists.

The default cipher for AsyncOS versions 9.0 and earlier is DEFAULT:+kEDH.

The default cipher for AsyncOS versions 9.1 - 11.8 is:
EECDH:DSS:RSA:!NULL:!eNULL:!EXPORT:!3DES:!RC4:!RC2:!DES:!SEED:!CAMELLIA
:!SRP:!IDEA:!ECDHE-ECDSA-AES256-SHA:!ECDHE-RSA-AES256-SHA:!DHE-DSS-AES256-SHA:
!AES256-SHA:DHE-RSA-AES128-SHA

In this case, the default cipher may change based on your ECDHE cipher selections.

The default cipher for AsyncOS versions 12.0 and later is:
EECDH:DSS:RSA:!NULL:!eNULL:!aNULL:!EXPORT:!3DES:!SEED:!CAMELLIA
:!SRP:!IDEA:!DHE-DSS-AES256-SHA:!AES256-SHA:DHE-RSA-AES128-SHA:
TLS_AES_256_GCM_SHA384

Update the default cipher suite while upgrading to a newer AsyncOS version. The ciphers suites are
not automatically updated. When you upgrade from an earlier version to AsyncOS 12.0 and later,
Cisco recommends updating the cipher suite to:

Note

EECDH:DSS:RSA:!NULL:!eNULL:!aNULL:!EXPORT:!3DES:!SEED:!CAMELLIA
:!SRP:!IDEA:!DHE-DSS-AES256-SHA:!AES256-SHA:DHE-RSA-AES128-SHA:
TLS_AES_256_GCM_SHA384

• Disable TLS Compression (Recommended) – You can check this box to disable TLS compression; this is
recommended for best security.

• Secure LDAP Services – Includes Authentication, External Authentication and Secure Mobility.

• Secure ICAP Services (External DLP) – Select the protocol(s) used to secure ICAP communications between the
appliance and external DLP (data loss prevention) servers. See Configuring External DLP Servers, on page 299 for
more information.

• Update Service – Select the protocol(s) used for communications between the appliance and available update servers.
See AsyncOS for Web Upgrades and Updates, on page 453 for more information about update services.

Cisco’s Update servers do not support SSL v3, therefore TLS 1.0 or abovemust be enabled for the Cisco Update
service. However, SSL v3 can still be used with a local update server, if it is so configured—youmust determine
which versions of SSL/TLS are supported on that server.

Note

Step 4 Click Submit.

Certificate Management
The appliance uses digital certificates to establish, confirm and secure a variety of connections. The Certificate
Management page lets you view and update current certificate lists, manage trusted root certificates, and view
blocked certificates.
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Related Topics

• About Certificates and Keys, on page 449
• Certificate Updates, on page 450
• Managing Trusted Root Certificates, on page 450
• Viewing Blocked Certificates, on page 450

Strict Certificate Validation
With the release of the FIPS-mode updates in AsyncOS 10.5, all presented certificates are validated strictly
to comply with Common Criteria (CC) standards before uploading, and OCSP validation is available to
validate certificates against a revocation list.

You must ensure that proper, valid certificates are uploaded to the WSA, and that valid, secure certificates
are configured on all related servers to facilitate smooth SSL handshakes with those servers.

Strict certificate validation is applied for the following certificate uploads:

• HTTPS Proxy (Security Services > HTTPS Proxy)

• File Analysis Server (Security Services > Anti-Malware and Reputation > Advanced Settings for File
Analysis > File Analysis Server: Private Cloud & Certificate Authority: Use Uploaded Certificate
Authority)

• Trusted Root Certificates (Network > Certificate Management)

• Global Authentication Settings (Network > Authentication > Global Authentication Settings)

• Identity Provider for SaaS (Network > Identity Provider for SaaS)

• Identity Services Engine (Network > Identity Services Engine)

• External DLP Servers (Network > External DLP Servers)

• LDAP & Secure LDAP (Network > Authentication > Realm)

See also FIPS Compliance, on page 444.

About Certificates and Keys
When a browser prompts its user to authenticate, the browser sends the authentication credentials to the Web
Proxy using a secure HTTPS connection. By default, theWeb Security appliance uses the “CiscoWeb Security
Appliance DemoCertificate” that comes with it to create an HTTPS connection with the client. Most browsers
will warn users that the certificate is not valid. To prevent users from seeing the invalid certificate message,
you can upload a certificate and key pair that your applications recognize automatically.

Related Topics

• Uploading or Generating a Certificate and Key, on page 451
• Certificate Signing Requests, on page 452
• Intermediate Certificates, on page 452
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Managing Trusted Root Certificates
The Web Security appliance ships with and maintains a list of trusted root certificates. Web sites with trusted
certificates do not require decryption.

You can manage the trusted certificate list, adding certificates to it and functionally removing certificates
from it. While the Web Security appliance does not delete certificates from the primary list, it allows you to
override trust in a certificate, which functionally removes the certificate from the trusted list.

To add, override or download a trusted root certificate:

Step 1 Choose Network > Certificate Management.
Step 2 Click Manage Trusted Root Certificates on the Certificate Management page.
Step 3 To add a custom trusted root certificate with a signing authority not on the Cisco-recognized list:

Click Import and then browse to, select, and Submit the certificate file.

Step 4 To override the trust for one or more Cisco-recognized certificates:
a) Check the Override Trust checkbox for each entry you wish to override.
b) Click Submit.

Step 5 To download a copy of a particular certificate:
a) Click the name of the certificate in the Cisco Trusted Root Certificate List to expand that entry.
b) Click Download Certificate.

Certificate Updates
The Updates section lists version and last-updated information for the Cisco trusted-root-certificate and blocked
list bundles on the appliance. These bundles are updated periodically.

Click Update Now on the Certificate Management page to update all bundles for which updates are available.

Viewing Blocked Certificates
To view a list of certificates which Cisco has determined to be invalid, and has blocked:

Click View Blocked Certificates.
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Uploading or Generating a Certificate and Key
Certain AsyncOS features require a certificate and key to establish, confirm or secure a connection Identity
Services Engine (ISE) and . You can either upload an existing certificate and key, or you can generate one
when you configure the feature.

Uploading a Certificate and Key
A certificate you upload to the appliance must meet the following requirements:

• It must use the X.509 standard.
• It must include a matching private key in PEM format. DER format is not supported.

Step 1 Select Use Uploaded Certificate and Key.
Step 2 In the Certificate field, click Browse; locate the file to upload.

The Web Proxy uses the first certificate or key in the file. The certificate file must be in PEM format. DER
format is not supported.

Note

Step 3 In the Key field, click Browse; locate the file to upload.

The key length must be 512, 1024, or 2048 bits. The private key file must be in PEM format. DER format is
not supported.

Note

Step 4 If the key is encrypted, select Key is Encrypted.
Step 5 Click Upload Files.

Generating a Certificate and Key

Step 1 Select Use Generated Certificate and Key.
Step 2 Click Generate New Certificate and Key.

a) In the Generate Certificate and Key dialog box, enter the necessary generation information.

You can enter any ASCII character except the forward slash ( / ) in the Common Name field.Note

b) Click Generate in the Generate Certificate and Key dialog box.

When generation is complete, the certificate information is displayed in the Certificate section, along with two links:
Download Certificate and Download Certificate Signing Request. In addition, there is a Signed Certificate option
that is used to upload the signed certificate when you receive it from the Certificate Authority (CA).

Step 3 Click Download Certificate to download the new certificate for upload to the appliance.
Step 4 Click Download Certificate Signing Request to download the new certificate file for transmission to a Certificate

Authority (CA) for signing. See Certificate Signing Requests, on page 452 for more information about this process.
a) When the CA returns the signed certificate, click Browse in the Signed Certificate portion of the Certificate field to

locate the signed-certificate file, and then click Upload File to upload it to the appliance.
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b) Ensure the CA’s root certificate is present in the appliance’s list of trusted root certificates. If it is not, add it. See
Managing Trusted Root Certificates, on page 450 for more information.

Certificate Signing Requests
The Web Security appliance cannot generate Certificate Signing Requests (CSR) for certificates uploaded to
the appliance. Therefore, to have a certificate created for the appliance, you must issue the signing request
from another system. Save the PEM-formatted key from this system because you will need to install it on the
appliance later.

You can use any UNIX machine with a recent version of OpenSSL installed. Be sure to put the appliance
hostname in the CSR. Use the guidelines at the following location for information on generating a CSR using
OpenSSL:

http://www.modssl.org/docs/2.8/ssl_faq.html#ToC28

Once the CSR has been generated, submit it to a certificate authority (CA). The CA will return the certificate
in PEM format.

If you are acquiring a certificate for the first time, search the Internet for “certificate authority services SSL
server certificates,” and choose the service that best meets the needs of your organization. Follow the service’s
instructions for obtaining an SSL certificate.

You can also generate and sign your own certificate. Tools for doing this are included with OpenSSL, free
software from http://www.openssl.org .

Note

Intermediate Certificates
In addition to root certificate authority (CA) certificate verification, AsyncOS supports the use of intermediate
certificate verification. Intermediate certificates are certificates issued by a trusted root CA which are then
used to create additional certificates. This creates a chained line of trust. For example, a certificate may be
issued by example.com who, in turn, is granted the rights to issue certificates by a trusted root CA. The
certificate issued by example.com must be validated against example.com’s private key as well as the trusted
root CA’s private key.

Servers send a “certificate chain” in an SSL handshake in order for clients (for example, browsers and in this
case the WSA, which is a HTTPS proxy) to authenticate the server. Normally, the server certificate is signed
by an intermediate certificate which in turn is signed by a trusted root certificate, and during the handshake,
the server certificate and the entire certificate chain are presented to the client. As the root certificate is typically
present in the Trusted Certificate store of the WSA, verification of the certificate chain is successful.

However, sometimes when the end-point entity certificate is changed on the server, necessary updates for the
new chain are not performed. As a result, going forward the server presents only the server certificate during
the SSL handshake and theWSA proxy is unable to verify the certificate chain since the intermediate certificate
is missing.

Previously, the solution was manual intervention by the WSA administrator, who would upload the necessary
intermediate certificate to the Trusted Certificate store. Now you can use the CLI command
advancedproxyconfig > HTTPS > Do you want to enable automatic discovery and download of

missing Intermediate Certificates? to enable “intermediate certificate discovery,” a process the WSA
uses in an attempt to eliminate the manual step in these situations.
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Intermediate certificate discovery uses a method called “AIA chasing”: when presented with an untrusted
certificate, the WSA examines it for an extension named “Authority Information Access.” This extension
includes an optional CA Issuers URI field, which can be queried for the Issuer Certificate used to sign the
server certificate in question. If it is available, the WSA fetches the issuer’s certificate recursively until the
root CA certificate is obtained, and then tries to verify the chain again.

AsyncOS for Web Upgrades and Updates
Cisco periodically releases upgrades (new software versions) and updates (changes to current software versions)
for AsyncOS for Web and its components.

Best Practices For Upgrading AsyncOS for Web
• Before you start the upgrade, save the XML configuration file off the Web Security appliance from the

System Administration > Configuration File page or by using the saveconfig command.

• Save other files stored on the appliance, such as PAC files or customized end-user notification pages.

• When upgrading, do not pause for long amounts of time at the various prompts. If the TCP session times
out during the download, the upgrade may fail.

• After the upgrade completes, save the configuration information to an XML file.

Related Topics

• Saving, Loading, and Resetting the Appliance Configuration, on page 412

Upgrading and Updating AsyncOS and Security Service Components

Downloading and Installing an Upgrade

Before you begin

Save the appliance configuration file (see Saving, Loading, and Resetting the Appliance Configuration, on
page 412).

When downloading and upgrading AsyncOS in a single operation from a local server instead of from a Cisco
server, the upgrade installs immediately while downloading. A banner is displayed for 10 seconds at the
beginning of the upgrade process. While this banner is displayed, you can type Control-C to exit the upgrade
process before downloading starts.

Note

While performing an upgrade, if the secure authentication certificate is not FIPs-complaint, it will be replaced
with the default certificate of the latest path to which your appliance is upgraded to. This happens only when
the customer has used the default certificate before the upgrade.

Note

You can download and install in a single operation, or download in the background and install later.
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Step 1 Choose System Administration > System Upgrade.
Step 2 Click Upgrade Options.

Select upgrade options and an upgrade image:

DescriptionSetting

• Download and install – Download and install the upgrade in a single operation.

If you have already downloaded an installer, you will be prompted to overwrite the
existing download.

• Download only – Download an upgrade installer, but do not install.

If you have already downloaded an installer, you will be prompted to overwrite the
existing download. The installer downloads in the background without interrupting
service.

An Install button is displayed when the download is complete; click to install a
previously downloaded upgrade.

Choose an upgrade option

Select an upgrade image to be downloaded, or downloaded and installed, from the List
of available upgrade images files at upgrade server.

• To save a back-up copy of the current configuration to the configuration
directory on the appliance, check Save the current configuration to the
configuration directory before upgrading.

• If the Save current configuration option is checked, you can checkMask passwords
in the configuration file to have all current-configuration passwords masked in the
back-up copy. However, you cannot load a configuration file with masked passwords
using theLoad Configuration command, nor with the CLIloadconfig command.

If FIPS mode is enabled, you can selectEncrypt passphrases in the Configuration
Files. These files can be reloaded.

• If the Save current configuration option is checked, you can enter one or more
email addresses into the Email file to field; a copy of the back-up configuration file
is mailed to each address. Separate multiple addresses with commas.

Upgrade Preparation

Step 3 Click Proceed.

If you are installing:

a) Be prepared to respond to prompts during the process.
b) At the completion prompt, click Reboot Now.
c) After about 10 minutes, access the appliance again and log in.

If you feel you need to power-cycle the appliance to troubleshoot an upgrade issue, do not do so until at least 20
minutes have passed since you rebooted.
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Viewing Status of, Canceling, or Deleting a Background Download

Step 1 Choose System Administration > System Upgrade.
Step 2 Click Upgrade Options.
Step 3 Choose an option:

Do ThisTo

Look in the middle of the page.

If there is no download in progress and no completed download waiting to be installed,
you will not see download status information.

View download status

Click the Cancel Download button in the middle of the page.

This option appears only while a download is in progress.

Cancel a download

Click the Delete File button in the middle of the page.

This option appears only if an installer has been downloaded.

Delete a downloaded
installer

Step 4 (Optional) View the Upgrade Logs.

What to do next

Related Topics

• Local And Remote Update Servers, on page 456

Automatic and Manual Update and Upgrade Queries
AsyncOS periodically queries the update servers for new updates to all security service components, but not
for newAsyncOS upgrades. To upgrade AsyncOS, youmust manually prompt AsyncOS to query for available
upgrades. You can also manually prompt AsyncOS to query for available security service updates. For more
information, see Reverting to a Previous Version of AsyncOS for Web, on page 460.

When AsyncOS queries an update server for an update or upgrade, it performs the following steps:

1. Contacts the update server.

Cisco allows the following sources for update servers:

• Cisco update servers. For more information, see Updating and Upgrading from the Cisco Update
Servers, on page 457.

• Local server. For more information, see Upgrading from a Local Server, on page 457.

2. Receives an XML file that lists the available updates or AsyncOS upgrade versions. This XML file is
known as the “manifest.”

3. Downloads the update or upgrade image files.
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Manually Updating Security Service Components
By default, each security service component periodically receives updates to its database tables from the Cisco
update servers. However, you can manually update the database tables.

Some updates are available on demand from the GUI pages related to the feature.Note

View a record of update activity in the updater log file. Subscribe to the updater log file on the System
Administration > Log Subscriptions page.

Tip

Updates that are in-progress cannot be interrupted. All in-progress updates must complete before new changes
can be applied.

Note

Step 1 Choose System Administration > Upgrade and Update Settings.
Step 2 Click Edit Update Settings.
Step 3 Specify the location of the update files.
Step 4 Initiate the update using the Update Now function key on the component page located on the Security Services tab. For

example, Security Services > Web Reputation Filters page.

The CLI and the Web application interface may be sluggish or unavailable during the update process.

Local And Remote Update Servers
By default, AsyncOS contacts the Cisco update servers for both update and upgrade images and the manifest
XML file. However, you can choose fromwhere to download the upgrade and update images and the manifest
file. Using a local update server for the images or manifest file for any of the following reasons:

• You have multiple appliances to upgrade simultaneously. You can download the upgrade image to
a web server inside your network and serve it to all appliances in your network.

• Your firewall settings require static IP addresses for the Cisco update servers. The Cisco update
servers use dynamic IP addresses. If you have strict firewall policies, you may need to configure a static
location for updates and AsyncOS upgrades. For more information, see Configuring a Static Address for
the Cisco Update Servers, on page 457.

Local update servers do not automatically receive security service updates, only AsyncOS upgrades. After
using a local update server for upgrading AsyncOS, change the update and upgrade settings back to use the
Cisco update servers so the security services update automatically again.

Note
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Updating and Upgrading from the Cisco Update Servers
AWeb Security appliance can connect directly to Cisco update servers and download upgrade images and
security service updates. Each appliance downloads the updates and upgrade images separately.

Configuring a Static Address for the Cisco Update Servers

The Cisco update servers use dynamic IP addresses. If you have strict firewall policies, you may need to
configure a static location for updates and AsyncOS upgrades.

Step 1 Contact Cisco Customer Support to obtain the static URL address.
Step 2 Navigate to the System Administration > Upgrade and Update Settings page, and click Edit Update Settings.
Step 3 On the Edit Update Settings page, in the “Update Servers (images)” section, choose Local Update Servers and enter the

static URL address received in step 1.
Step 4 Verify that Cisco Update Servers is selected for the “Update Servers (list)” section.
Step 5 Submit and commit your changes.

Upgrading from a Local Server
The Web Security appliance can download AsyncOS upgrades from a server within your network instead of
obtaining upgrades directly from the Cisco update servers. When you use this feature, you download the
upgrade image from Cisco once only, and then serve it to all Web Security appliances in your network.

The following figure shows how Web Security appliances download upgrade images from local servers.

Figure 9: Upgrading from a Local Server
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Hardware and Software Requirements for Local Upgrade Servers

For downloading AsyncOS upgrade files, you must have a system in your internal network that has a web
browser and Internet access to the Cisco update servers.

If you need to configure a firewall setting to allow HTTP access to this address, you must configure it using
the DNS name and not a specific IP address.

Note

For hostingAsyncOS upgrade files, a server on the internal network must have a web server, such asMicrosoft
IIS (Internet Information Services) or the Apache open source server, which has the following features:

• Supports the display of directory or filenames in excess of 24 characters.

• Has directory browsing enabled.

• Is configured for anonymous (no authentication) or Basic (“simple”) authentication.

• Contains at least 350MB of free disk space for each AsyncOS upgrade image.

Configuring Upgrades from a Local Server

Cisco recommends changing the update and upgrade settings to use the Cisco update servers (using dynamic
or static addresses) after the upgrade is complete to ensure the security service components continue to update
automatically.

Note

Step 1 Configure a local server to retrieve and serve the upgrade files.
Step 2 Download the upgrade zip file.

Using a browser on the local server, go to http://updates.ironport.com/fetch_manifest.html to download a zip file of an
upgrade image. To download the image, enter your serial number (for a physical appliance) or VLN (for a virtual appliance)
and the version number of the appliance. You will then be presented with a list of available upgrades. Click on the upgrade
version that you want to download.

Step 3 Unzip the zip file in the root directory on the local server while keeping the directory structure intact.
Step 4 Configure the appliance to use the local server using the System Administration > Upgrade and Update Settings page

or the updateconfig command.
Step 5 On the System Administration > System Upgrade page, click Available Upgrades or run the upgrade command.

Differences Between Local and Remote Upgrading Methods
The following differences apply when upgrading AsyncOS from a local server rather than from a Cisco update
server:

• The upgrading installs immediately while downloading .

• A banner displays for 10 seconds at the beginning of the upgrade process. While this banner is displayed,
you have the option to type Control+C to exit the upgrade process before downloading starts.
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Configuring Upgrade and Service Update Settings
You can configure how the Web Security appliance downloads security services updates and AsyncOS for
Web upgrades. For example, you can choose which network interface to use when downloading the files,
configure the update interval or disable automatic updates.

Step 1 Choose System Administration > Upgrade and Update Settings.
Step 2 Click Edit Update Settings.
Step 3 Configure the settings, referencing the following information:

DescriptionSetting

Choose whether to enable automatic updates of the security components. If you choose
automatic updates, enter the time interval. The default is enabled and the update interval
is 5 minutes.

Automatic Updates

Choose whether to display a notification at the top of the Web Interface when a new
upgrade to AsyncOS is available. The appliance only displays this notification for
administrators.

For more information, see AsyncOS for Web Upgrades and Updates, on page 453.

Upgrade Notifications

Whether to download the list of available upgrades and updates (the manifest XML file)
from the Cisco update servers or a local web server.

When you choose a local update server, enter the full path to the manifest XML file for
the list including the file name and port number for the server. If you leave the port field
blank, AsyncOS uses port 80. If the server requires authentication, you can also enter a
valid user name and passphrase.

• The URL for obtaining the manifest for hardware appliances is:

https://update-manifests.ironport.com

• The URL for obtaining the manifest for virtual appliances is:

https://update-manifests.sco.cisco.com

Update Servers (list)

Whether to download upgrade and update images from the Cisco update servers or a local
web server.

When you choose a local update server, enter the base URL and port number for the
server. If you leave the port field blank, AsyncOS uses port 80. If the server requires
authentication, you can also enter a valid user name and passphrase.

Update Servers (images)

Choose which network interface’s routing table to use when contacting the update servers.Routing Table

If an upstream proxy server exists and requires authentication, enter the server information
and user name and passphrase here.

Proxy Server (optional)

Step 4 Submit and commit your changes.
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What to do next

Related Topics

• Local And Remote Update Servers, on page 456
• Automatic and Manual Update and Upgrade Queries, on page 455
• Upgrading and Updating AsyncOS and Security Service Components, on page 453

Reverting to a Previous Version of AsyncOS for Web
AsyncOS forWeb supports the ability to revert the AsyncOS forWeb operating system to a previous qualified
build for emergency uses.

You cannot revert to a version of AsyncOS for Web earlier than version 7.5.Note

Reverting AsyncOS on Virtual Appliances Impacts the License
If you revert to AsyncOS 8.0, there is no 180-day grace period during which the appliance processes web
transactions without security features. License expiration dates are unaffected.

Configuration File Use in the Revert Process
Effective in version 7.5, when you upgrade to a later version, the upgrade process automatically saves the
current system configuration to a file on the Web Security appliance. (However, Cisco recommends manually
saving the configuration file to a local machine as a backup.) This allows AsyncOS for Web to load the
configuration file associated with the earlier release after reverting to the earlier version. However, when it
performs a reversion, it uses the current network settings for the management interface.

Reverting AsyncOS for an Appliance Managed by the SMA
You can revert AsyncOS for Web from the Web Security appliance. However, if the Web Security appliance
is managed by a Security Management appliance, consider the following rules and guidelines:

• When Centralized Reporting is enabled on the Web Security appliance, AsyncOS for Web finishes
transferring the reporting data to the Security Management appliance before it starts the reversion. If the
files take longer than 40 seconds to transfer to the Security Management appliance, AsyncOS for Web
prompts you to continue waiting to transfer the files, or continue the reversion without transferring all
files.

• Youmust associate theWeb Security appliance with the appropriate Primary Configuration after reverting.
Otherwise, pushing a configuration from the Security Management appliance to the Web Security
appliance might fail.
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Reverting AsyncOS for Web to a Previous Version

Reverting the operating system on a Web Security appliance is a very destructive action and destroys all
configuration logs and databases. Reversion also disrupts web traffic handling until the appliance is
reconfigured. Depending on the initialWeb Security appliance configuration, this action may destroy network
configuration. If this happens, you will need physical local access to the appliance after performing the
reversion.

Caution

If updates to the set of URL categories are available, they will be applied after AsyncOS reversion.Note

Before you begin

• Contact Cisco Quality Assurance to confirm that you can perform the intended reversion. (BS: this is a
summary of the Available Versions section in the original chapter. Have asked if this is correct.)

• Back up the following information from the Web Security appliance to a separate machine:

• System configuration file (with passphrases unmasked).
• Log files you want to preserve.
• Reports you want to preserve.
• Customized end-user notification pages stored on the appliance.
• PAC files stored on the appliance.

Step 1 Log into the CLI of the appliance you want to revert.

When you run the revert command in the next step, several warning prompts are issued. After these warning
prompts are accepted, the revert action takes place immediately. Therefore, do not begin the reversion process
until after you have completed the pre-reversion steps.

Note

Step 2 Enter the revert command.
Step 3 Confirm twice that you want to continue with the reversion.
Step 4 Choose one of the available versions to revert to.

The appliance reboots twice.

The reversion process is time-consuming. It may take fifteen to twenty minutes before reversion is complete
and console access to the appliance is available again.

Note

The appliance should now run using the selected AsyncOS for Web version. You can access the web interface from a
web browser.

Monitoring System Health and Status Using SNMP
The AsyncOS operating system supports system status monitoring via SNMP (Simple Network Management
Protocol). (For more information about SNMP, see RFCs 1065, 1066, and 1067.)
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Please note:

• SNMP is off by default.

• SNMP SET operations (configuration) are not implemented.

• AsyncOS supports SNMPv1, v2, and v3. For more information on SNMPv3, see RFCs 2571-2575.

• Message authentication and encryption are mandatory when enabling SNMPv3. Passphrases for
authentication and encryption should be different. The encryption algorithm can be AES (recommended)
or DES. The authentication algorithm can be SHA-1 (recommended) orMD5. The snmpconfig command
“remembers” your passphrases the next time you run the command.

• The SNMPv3 username is: v3get.

> snmpwalk -v 3 -l AuthNoPriv -u v3get -a MD5 serv.example.com

• If you use only SNMPv1 or SNMPv2, you must set a community string. The community string does not
default to public.

• For SNMPv1 and SNMPv2, you must specify a network from which SNMP GET requests are accepted.

• To use traps, an SNMP manager (not included in AsyncOS) must be running and its IP address entered
as the trap target. (You can use a host name, but if you do, traps will only work if DNS is working.)

MIB Files
MIB files are available from
http://www.cisco.com/c/en/us/support/security/web-security-appliance/tsd-products-support-series-home.html

Use the latest version of each MIB file.

There are multiple MIB files:

• asyncoswebsecurityappliance-mib.txt — an SNMPv2 compatible description of the Enterprise MIB for
Web Security appliances.

• ASYNCOS-MAIL-MIB.txt — an SNMPv2 compatible description of the Enterprise MIB for Email
Security appliances.

• IRONPORT-SMI.txt — This “Structure of Management Information” file defines the role of the
asyncoswebsecurityappliance-mib.

This release implements a read-only subset of MIB-II as defined in RFCs 1213 and 1907.

See https://www.cisco.com/c/en/us/support/docs/security/web-security-appliance/118415-technote-wsa-00.html
to know about monitoring CPU usage on the appliance using SNMP.

Enabling and Configuring SNMP Monitoring
To configure SNMP to gather system status information for the appliance, use the snmpconfig command in
the command-line interface (CLI). After you choose and configure values for an interface, the appliance
responds to SNMPv3 GET requests.

When you use SNMP monitoring, keep the following points in mind:
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• These version 3 requests must include a matching passphrase.
• By default, version 1 and 2 requests are rejected.
• If enabled, version 1 and 2 requests must have a matching community string.

Hardware Objects
Hardware sensors conforming to the Intelligent Platform Management Interface Specification (IPMI) report
information such as temperature, fan speed, and power supply status.

To determine the hardware-related objects available for monitoring (for example, the number of fans or the
operating temperature range), see the hardware guide for your appliance model.

Related Topics

• Documentation Set, on page 523

SNMP Traps
SNMP provides the ability to send traps, or notifications, to advise an administration application when one
or more conditions have been met. Traps are network packets that contain data relating to a component of the
system sending the trap. Traps are generated when a condition has been met on the SNMP agent (in this case,
the Cisco Web Security Appliance appliance). After the condition has been met, the SNMP agent then forms
an SNMP packet and sends it to the host running the SNMP management console software.

You can configure SNMP traps (enable or disable specific traps) when you enable SNMP for an interface.

To specify multiple trap targets: when prompted for the trap target, you may enter up to 10 comma separated
IP addresses.

Related Topics

• About the connectivityFailure SNMP Trap , on page 463

About the connectivityFailure SNMP Trap
The connectivityFailure trap is intended to monitor your appliance’s connection to the internet. It does this
by attempting to connect and send an HTTP GET request to a single external server every 5 to 7 seconds. By
default, the monitored URL is downloads.ironport.com on port 80.

To change the monitored URL or port, run the snmpconfig command and enable the connecivityFailure trap,
even if it is already enabled. You will see a prompt to change the URL.

To simulate connectivityFailure traps, you can use the dnsconfig CLI command to enter a non-working DNS
server. Lookups for downloads.ironport.com will fail, and traps will be sent every 5-7 seconds. Be sure to
change the DNS server back to a working server after completing your test.

Tip

CLI Example: snmpconfig

wsa.example.com> snmpconfig
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Current SNMP settings:
SNMP Disabled.

Choose the operation you want to perform:
- SETUP - Configure SNMP.
[]> SETUP

Do you want to enable SNMP?
[Y]>

Please choose an IP interface for SNMP requests.
1. Management (198.51.100.1: wsa.example.com)
[1]>

Which port shall the SNMP daemon listen on interface "Management"?
[161]>

Please select SNMPv3 authentication type:
1. MD5
2. SHA
[1]> 2

Please select SNMPv3 privacy protocol:
1. DES
2. AES
[1]> 2

Enter the SNMPv3 authentication passphrase.
[]>

Please enter the SNMPv3 authentication passphrase again to confirm.
[]>

Enter the SNMPv3 privacy passphrase.
[]>

Please enter the SNMPv3 privacy passphrase again to confirm.
[]>

Service SNMP V1/V2c requests?
[N]> Y

Enter the SNMP V1/V2c community string.
[ironport]> public

Shall SNMP V2c requests be serviced from IPv4 addresses?
[Y]>

From which IPv4 networks shall SNMP V1/V2c requests be allowed? Separate
multiple networks with commas.
[127.0.0.1/32]>

Enter the Trap target as a host name, IP address or list of IP
addresses separated by commas (IP address preferred). Enter "None" to disable traps.
[127.0.0.1]> 203.0.113.1

Enter the Trap Community string.
[ironport]> tcomm

Enterprise Trap Status
1. CPUUtilizationExceeded Disabled
2. FIPSModeDisableFailure Enabled
3. FIPSModeEnableFailure Enabled
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4. FailoverHealthy Enabled
5. FailoverUnhealthy Enabled
6. RAIDStatusChange Enabled
7. connectivityFailure Disabled
8. fanFailure Enabled
9. highTemperature Enabled
10. keyExpiration Enabled
11. linkUpDown Enabled
12. memoryUtilizationExceeded Disabled
13. powerSupplyStatusChange Enabled
14. resourceConservationMode Enabled
15. updateFailure Enabled
Do you want to change any of these settings?
[N]> Y

Do you want to disable any of these traps?
[Y]> n

Do you want to enable any of these traps?
[Y]> y

Enter number or numbers of traps to enable. Separate multiple numbers with
commas.
[]> 1,7,12

What threshold would you like to set for CPU utilization?
[95]>

What URL would you like to check for connectivity failure?
[http://downloads.ironport.com]>

What threshold would you like to set for memory utilization?
[95]>

Enter the System Location string.
[Unknown: Not Yet Configured]> Network Operations Center - west; rack #30, position 3

Enter the System Contact string.
[snmp@localhost]> wsa-admin@example.com

Current SNMP settings:
Listening on interface "Management" 198.51.100.1 port 161.
SNMP v3: Enabled.
SNMP v1/v2: Enabled, accepting requests from subnet 127.0.0.1/32 .
SNMP v1/v2 Community String: public
Trap target: 203.0.113.1
Location: Network Operations Center - west; rack #30, position 3
System Contact: wsa-admin@example.com

Choose the operation you want to perform:
- SETUP - Configure SNMP.
[]>

wsa.example.com> commit

Please enter some comments describing your changes:
[]> Enable and configure SNMP

Changes committed: Fri Nov 06 18:13:16 2015 GMT
wsa.example.com>

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
465

Perform System Administration Tasks
CLI Example: snmpconfig



Web Traffic Tap
Before You Begin:Enabling Web Traffic Tap feature will result in reduced transaction handling capacity
(requests per second) for the appliance as appliance will need additional CPU cycles and memory to copy the
messages to the tap interface.

For reducing the performance impact due to Web Traffic Tap feature, reduce the amount of traffic that gets
tapped by setting appropriate Web Traffic Tap policies.

This feature is not supported on Amazon Web Services (AWS)

Note

Web Traffic Tap feature allows you to tap the HTTP and HTTPS web traffic that passes through the appliance
and copy it to a Web Security appliance interface in-line with the real time data traffic. You can select the
Web Security appliance interface to which the tapped traffic data is sent. If the tapped traffic includes HTTPS
data, the appliance decrypts them based on the decryption policies before sending them to the tap interface.
See Decryption Policies , on page 224.

The selected tap interface must be directly connected to an external security device for analysis, forensics,
and archiving. Alternatively, it may be connected to a L2 switch on a dedicated VLAN.

The traffic mirrored on the tap interface is broadcast over Ethernet layer and not IP routable. Therefore a
dedicated VLAN is required if connected to a L2 switch.

Note

This feature also enables you to set Web Traffic Tap policies. Based on these customer defined policy filters,
the appliance mirrors the web traffic that is available for the external security device. Web Traffic Tap feature
provides visibility to the HTTPS traffic.

The term tapping refers to the reconstruction of complete TCP (Transmission Control Protocol) streams as if
occurring between a directly connected client and server.

Virtual Web Security appliances support Web Traffic Tap feature.

The act of inspecting SSL traffic might be subject to corporate policy guidelines and/or national legislation.
Cisco is not responsible for any legal obligations and it is your sole responsibility to ensure that your use of
Web Traffic Tap feature onWeb Security appliance is in accordance with any such legal or policy requirements.

Note

You must perform the following procedures to tap the web traffic using the appliance:

1. Enable Web Traffic Tap feature

2. Configure Web Traffic Tap policies

Related Topics

• Enabling Web Traffic Tap, on page 467

• Configuring Web Traffic Tap Policies, on page 467
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Enabling Web Traffic Tap

Before you begin

The Web Traffic Tap feature is disabled by default. You must enable the feature before you define the Web
Traffic Tap policies using Web Security Manager > Web Traffic Tap Policies.

Decryption policies must be defined in order to tap HTTPS transactions. See Decryption Policies , on page
224.

Note

Step 1 Choose Network > Web Traffic Tap.
Step 2 Click Edit Settings.
Step 3 In the Edit Web Traffic Tap page, check the Enable check box to enable Web Traffic Tap feature.

To disable the Web Traffic Tap feature, uncheck the Enable check box. If you disable the Web Traffic Tap
feature, you will not be able to view or edit the Web Traffic Tap policies. You must enable the feature again
to view and edit the policies.

Note

Step 4 From the Tap Interface drop-down list, choose the WSA interface to which the tapped traffic data is sent. The interface
options are P1, P2, T1, and T2. See Connecting the Appliance, on page 14 to know about interfaces.

The selected tap interface must be directly connected to an external security device for analysis, forensics, and
archiving. Alternatively, it may be connected to a L2 switch on a dedicated VLAN. The tap interface chosen
should be connected and its status should be active; if not, mirroring of tapped traffic will fail.

Note

Step 5 Click Submit and commit your changes.

Configuring Web Traffic Tap Policies

Step 1 Choose Web Security Manager > Web Traffic Tap Policies.
Step 2 Click Add Policy.

Follow the instructions in Creating a Policy , on page 203to add a new Web Traffic Tap policy.

A Global Traffic Tap policy with no tapping set is available by default on the Web Traffic Tap Policies page
(Web Security Manager > Web Traffic Tap Policies).

Note

Step 3 Expand the Advanced section of the Policy Member Definition area to add the following additional group membership
criteria for Web Traffic Tap.

• Protocols - Choose either HTTP or HTTPS protocol or both of them to create Web Traffic Tap Policy.

You must define matching decryption policy (Web Security Manager > Decryption Policies) in order
to tap HTTPS traffic.

Web Traffic Tap policies do not support Native FTP and SOCKS protocols.

Note
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• Subnets

• URLCategories – SetTap orNo Tap for the URL Filtering categories as required. To set traffic tap for uncategorized
URLs, choose Tap from the Uncategorized URLs drop-down list and click Submit.

• User Agents

See Creating a Policy , on page 203 to know more about defining additional group membership criteria.

The traffic that you want to tap must satisfy all the filter conditions that you have defined for the Web Traffic
Tap policy.

Note

You can also add URL categories from the URL Filtering table using Web Security Manager > Web Traffic Tap
Policies.

If you have already added the URL categories in the Advanced section, you will see only those URL categories
listed in the URL Filtering table (Web Security Manager > Web Traffic Tap Policies).

Note

See Policy Order, on page 202 to know about the Web Traffic Tap policy order.
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A P P E N D I X A
Troubleshooting

This appendix contains the following sections:

• General Troubleshooting Best Practices, on page 469
• FIPS Mode Problems, on page 470
• Authentication Problems, on page 470
• Blocked Object Problems, on page 472
• Browser Problems, on page 473
• DNS Problems, on page 473
• Failover Problems, on page 473
• Feature Keys Expired, on page 474
• FTP Problems, on page 474
• Upload/Download Speed Issues, on page 475
• Hardware Issues, on page 476
• HTTPS/Decryption/Certificate Problems, on page 477
• Identity Services Engine Problems, on page 479
• Problems with Custom and External URL Categories, on page 482
• Logging Problems, on page 483
• Policy Problems, on page 484
• Problems with File Reputation and File Analysis , on page 489
• Reboot Issues, on page 489
• Site Access Problems, on page 491
• Upstream Proxy Problems, on page 491
• Virtual Appliances , on page 492
• WCCP Problems, on page 493
• Packet Capture, on page 493
• Working With Support , on page 495

General Troubleshooting Best Practices
Configure your Access Logs to include the following custom fields:

%u, %g, %m, %k, %L (These values are case-sensitive.)

For descriptions of these fields, see Access Log Format Specifiers and W3C Log File Fields, on page 396.
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For configuration instructions, see Customizing Access Logs, on page 391 and Adding and Editing Log
Subscriptions, on page 366.

FIPS Mode Problems
Check the following topics if you encounter encryption and certificate problems after you upgraded your
WSA to AsyncOS 10.5, and enabled FIPS mode and CSP encryption.

• CSP Encryption, on page 470
• Certificate Validation, on page 470

CSP Encryption
For a feature that worked before you enabled FIPS-mode CSP encryption, but doesn’t work after encryption
is enabled, determine if the CSP encryption is the problem. Disable CSP encryption and FIPS mode and then
test the feature. If it works, enable FIPS mode and test it again. If it works, enable CSP encryption and test it
again. See Enabling or Disabling FIPS Mode , on page 446.

Certificate Validation
Certificates which were accepted by your WSA prior to upgrading to AsyncOS 10.5 might be rejected when
they are uploaded again, regardless of uploadmethod. (That is, via UI pages such as HTTPS Proxy, Certificate
Management, Identity Provider for SaaS, ISE configuration, Authentication configuration, or via the certconfig
CLI command.)

Ensure that the certificate’s signer CAs have been added as “Custom Trusted Certificate Authorities” on the
Certificate Management page (Network > Certificate Management). A certificate cannot be uploaded to the
WSA if the complete certificate path is untrusted.

Also, when reloading an older configuration, its likely that the included certificates will not be trusted and
the reload will fail. Ensure these certificates are replaced while loading the saved configuration.

All certificate validation failures are logged in the audit logs (/data/pub/audit_logs/audit_log.current).Note

Authentication Problems
• Troubleshooting Tools for Authentication Issues , on page 471
• Failed Authentication Impacts Normal Operations, on page 471
• LDAP Problems, on page 471
• Basic Authentication Problems, on page 472
• Single Sign-On Problems, on page 472
• Also see:

• General Troubleshooting Best Practices, on page 469
• HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require
Authentication, on page 485
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• Cannot Access URLs that Do Not Support Authentication, on page 491
• Client Requests Fail Upstream Proxy, on page 492

Troubleshooting Tools for Authentication Issues
KerbTray or klist (both part of the Windows Server Resources Kit) for viewing and purging a Kerberos ticket
cache. Active Directory Explorer for viewing and editing an Active directory. Wireshark is a packet analyzer
you can use for network troubleshooting.

Failed Authentication Impacts Normal Operations
When certain user agents or applications fail to authenticate and are denied access, they repeatedly send
requests to theWeb Security appliance, which in turn repeatedly sends requests to the Active Directory servers
with machine credentials, sometimes to the point of impacting normal operations.

For best results, bypass authentication with these user agents. See Bypassing Authentication with Problematic
User Agents , on page 114.

LDAP Problems
• LDAP User Fails Authentication due to NTLMSSP, on page 471

• LDAP Authentication Fails due to LDAP Referral, on page 471

LDAP User Fails Authentication due to NTLMSSP
LDAP servers do not support NTLMSSP. Some client applications, such as Internet Explorer, always choose
NTLMSSP when given a choice between NTLMSSP and Basic. When all of the following conditions are
true, the user will fail authentication:

• The user only exists in the LDAP realm.

• The Identification Profile uses a sequence that contains both LDAP and NTLM realms.

• The Identification Profile uses the “Basic or NTLMSSP” authentication scheme.

• A user sends a request from an application that chooses NTLMSSP over Basic.

Reconfigure the Identification Profile or the authentication realm or the application such that at least one of
the above conditions will be false.

LDAP Authentication Fails due to LDAP Referral
LDAP authentication fails when all of the following conditions are true:

• The LDAP authentication realm uses an Active Directory server.

• The Active Directory server uses an LDAP referral to another authentication server.

• The referred authentication server is unavailable to the Web Security appliance.

Workarounds:
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• Specify the Global Catalog server (default port is 3268) in the Active Directory forest when you configure
the LDAP authentication realm in the appliance.

• Use the advancedproxyconfig > authentication CLI command to disable LDAP referrals. LDAP
referrals are disabled by default.

Basic Authentication Problems
• Basic Authentication Fails, on page 472

Related Problems

• Upstream Proxy Does Not Receive Basic Credentials, on page 492

Basic Authentication Fails
AsyncOS for Web only supports 7-bit ASCII characters for passphrases when using the Basic authentication
scheme. Basic authentication fails when the passphrase contains characters that are not 7-bit ASCII.

Single Sign-On Problems
• Users Erroneously Prompted for Credentials, on page 472

Users Erroneously Prompted for Credentials
NTLM authentication does not work in some cases when theWeb Security appliance is connected to aWCCP
v2 capable device. When a user makes a request with a highly locked down version of Internet Explorer that
does not do transparent NTLM authentication correctly and the appliance is connected to aWCCP v2 capable
device, the browser defaults to Basic authentication. This results in users getting prompted for their
authentication credentials when they should not get prompted.

Workaround

In Internet Explorer, add the Web Security appliance redirect hostname to the list of trusted sites in the Local
Intranet zone (Tools > Internet Options > Security tab).

Blocked Object Problems
• Some Microsoft Office Files Not Blocked, on page 472
• Blocking DOS Executable Object Types Blocks Updates for Windows OneCare, on page 473

Some Microsoft Office Files Not Blocked
When you block Microsoft Office files in the Block Object Type section, it is possible that some Microsoft
Office files will not be blocked.

If you need to block all Microsoft Office files, add application/x-ole in the Block CustomMIME Types field.
However, blocking this custom MIME type also blocks all Microsoft Compound Object format types, such
as Visio files and some third-party applications.
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Blocking DOS Executable Object Types Blocks Updates for Windows OneCare
When you configure the Web Security appliance to block DOS executable object types, the appliance also
blocks updates for Windows OneCare.

Browser Problems
• WPAD Not Working With Firefox, on page 473

WPAD Not Working With Firefox
Firefox browsers may not support DHCP lookup with WPAD. For current information, see
https://bugzilla.mozilla.org/show_bug.cgi?id=356831 .

To use Firefox (or any other browser that does not support DHCP) with WPAD when the PAC file is hosted
on the Web Security appliance, configure the appliance to serve the PAC file through port 80.

Step 1 Choose Security Services > Web Proxy and delete port 80 from the HTTP Ports to Proxy field.
Step 2 Use port 80 as the PAC Server Port when you upload the file to the appliance.
Step 3 If any browsers are manually configured to point to the web proxy on port 80, reconfigure those browsers to point to

another port in the HTTP Ports to Proxy field.
Step 4 Change any references to port 80 in PAC files.

DNS Problems
• Alert: Failed to Bootstrap the DNS Cache, on page 473

Alert: Failed to Bootstrap the DNS Cache
If an alert with the message “Failed to bootstrap the DNS cache” is generated when an appliance is rebooted,
it means that the system was unable to contact its primary DNS servers. This can happen at boot time if the
DNS subsystem comes online before network connectivity is established. If this message appears at other
times, it could indicate network issues or that the DNS configuration is not pointing to a valid server.

Failover Problems
• Failover Misconfiguration, on page 473
• Failover Issues on Virtual Appliances , on page 474

Failover Misconfiguration
Misconfiguration of failover groups might result in multiple primary appliances or other failover problems.
Diagnose failover problems using the testfailovergroup subcommand of the CLI failoverconfig command.
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For example:

wsa.wga> failoverconfig
Currently configured failover profiles:
1. Failover Group ID: 61

Hostname: failoverV4P1.wga, Virtual IP: 10.4.28.93/28
Priority: 100, Interval: 3 seconds
Status: PRIMARY

Choose the operation you want to perform:
- NEW - Create new failover group.
- EDIT - Modify a failover group.
- DELETE - Remove a failover group.
- PREEMPTIVE - Configure whether failover is preemptive.
- TESTFAILOVERGROUP - Test configured failover profile(s)
[]> testfailovergroup
Failover group ID to test (-1 for all groups):
[]> 61

Failover Issues on Virtual Appliances
For deployments on virtual appliances, ensure that you have configured the interface/ virtual switch on the
hypervisor to use promiscuous mode.

Feature Keys Expired
If the feature key for the feature you are trying to access (via the web interface) has expired, please contact
your Cisco representative or support organization.

FTP Problems
• URL Categories Do Not Block Some FTP Sites, on page 474
• Large FTP Transfers Disconnect, on page 475
• Zero Byte File Appears On FTP Servers After File Upload, on page 475
• Chrome Browser Not Detected As User Agent in FTP-over-HTTP Requests, on page 475
• Also see:

• Unable to Route FTP Requests Via an Upstream Proxy, on page 492
• HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require
Authentication, on page 485

URL Categories Do Not Block Some FTP Sites
When a native FTP request is transparently redirected to the FTP Proxy, it contains no hostname information
for the FTP server, only its IP address. Because of this, some predefined URL categories and Web Reputation
Filters that have only hostname information will not match native FTP requests, even if the requests are
destined for those servers. If you wish to block access to these sites, you must create custom URL categories
for them using their IP addresses.
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Large FTP Transfers Disconnect
If the connection between the FTP Proxy and the FTP server is slow, uploading a large file may take a long
time, particularly when Cisco Data Security Filters are enabled. This can cause the FTP client to time out
before the FTP Proxy uploads the entire file and you may get a failed transaction notice. The transaction does
not fail, however, but continues in the background and will be completed by the FTP Proxy.

You can workaround this issue by increasing the appropriate idle timeout value on the FTP client.

Zero Byte File Appears On FTP Servers After File Upload
FTP clients create a zero byte file on FTP servers when the FTP Proxy blocks an upload due to outbound
anti-malware scanning.

Chrome Browser Not Detected As User Agent in FTP-over-HTTP Requests
Chrome browsers do not include a user-agent string in FTP-over-HTTP requests; therefore, Chrome cannot
be detected as the user agent in those requests.

Upload/Download Speed Issues
The WSA is designed to handle thousands of client and server connections in parallel, and the sizes of the
send and receive buffers are configured to deliver optimal performance, without sacrificing stability. Generally,
actual usage is browse traffic, consisting of numerous short-lived connections for which we have
receive-packet-steering (RPS) and receive-flow-steering (RFS) data, and for which theWSAhas been optimized.

However, at times you may experience a noticeable reduction in upload or download speeds; for example,
when transferring large files via proxy. To illustrate: assuming a 10-Mbps line, downloading a 100-MB file
that passes through aWSA can be approximately seven to eight times slower than downloading the file directly
from its server.

In non-typical environments that include a larger proportion of large-file transfers, you can use the
networktuning command to increase send and receive buffer size to alleviate this issue, but doing so can also
cause network memory exhaustion and affect system stability. See Web Security Appliance CLI Commands,
on page 503 for details of the networktuning command.

Exercise care when changing the TCP receive and send buffer control points and other TCP buffer parameters.
Use the networktuning command only if you understand the ramifications.

Caution

Here are examples of using the networktuning command on two different appliances:

On an S380

networktuning
sendspace = 131072
recvspace = 131072
send-auto = 1 [Remember to disable miscellaneous > advancedproxy > send buf auto tuning]
recv-auto = 1 [Remember to disable miscellaneous > advancedproxy > recv buf auto tuning]
mbuf clusters = 98304 * (X/Y) where is X is RAM in GBs on the system and Y is 4GB.
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sendbuf-max = 1048576
recvbuf-max = 1048576

Questions

What are these parameters?

The WSA has several buffers and optimization algorithms which can be altered for specific needs. Buffer
sizes are originally optimized to suit the “most common” deployment scenarios. However, larger buffer sizes
can be used when faster per-connection performance is needed, but note that overall memory usage will
increase. Therefore, buffer-size increases should be in line with the memory available on the system. The
send- and receive-space variables control the size of the buffers available for storing data for communication
over a socket. The send- and receive-auto options are used to enable and disable dynamic scaling of send and
receive TCP window sizes. (These parameters are applied in the FreeBSD kernel.)

How were these example values determined?

We tested different sets of values on a customer’s network where this “problem” was observed, and “zeroed
in” on these values. We then further tested these changes for stability and performance increase in our labs.
You are free to use values other than these at your own risk.

Why are these values not the defaults?

As mentioned, by default the WSA is optimized for the most-common deployments, and operating in a very
large number of locations without per-connection performance complaints. Making the changes discussed
here will not increase RPS numbers, and in fact may cause them to drop.

Hardware Issues
• Cycling Appliance Power , on page 476
• Appliance Health and Status Indicators , on page 476
• Alert: Battery Relearn Timed Out (RAID Event) on 380 or 680 Hardware, on page 476

Cycling Appliance Power
Important! If you need to cycle power to your x80 or x90 appliance, wait at least 20 minutes for the appliance
to come up again (all LEDs are green) before pushing the power button.

Appliance Health and Status Indicators
Lights on the front and/or rear panels of your hardware appliance indicate health and status of your appliance.
For descriptions of these indicators, see the hardware guides, such as the Cisco x90 Series Content Security
Appliances Installation and Maintenance Guide, available from
http://www.cisco.com/c/en/us/support/security/web-security-appliance/products-installation-guides-list.html.

Specifications for your appliance, such as temperature ranges, are also available in these documents.

Alert: Battery Relearn Timed Out (RAID Event) on 380 or 680 Hardware
This alert may or may not indicate a problem. The battery relearn timeout, in itself, does not mean there is
any problem with the RAID controller. The controller can recover in the subsequent relearn. Please monitor
your email for any other RAID alerts for the next 48 hours, to ensure that this is not the side-effect of any
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other problem. If you do not see any other RAID-type alerts from the system, then you can safely ignore this
alert.

HTTPS/Decryption/Certificate Problems
• Accessing HTTPS Sites Using Routing Policies with URL Category Criteria, on page 477
• HTTPS Request Failures, on page 477
• Bypassing Decryption for Particular Websites, on page 478
• Conditions and Restrictions for Exceptions to Blocking for Embedded and Referred Content, on page
478

• Alert: Problem with Security Certificate, on page 478
• Also see:

• Logging HTTPS Transactions, on page 483
• Access Policy not Configurable for HTTPS, on page 484
• HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require
Authentication, on page 485

Accessing HTTPS Sites Using Routing Policies with URL Category Criteria
For transparently redirected HTTPS requests, the Web Proxy must contact the destination server to determine
the server name and therefore the URL category in which it belongs. Due to this, when theWeb Proxy evaluates
Routing Policy Group membership, it cannot yet know the URL category of an HTTPS request because it has
not yet contacted the destination server. If the Web Proxy does not know the URL category, it cannot match
the transparent HTTPS request to any user-defined Routing Policy because of insufficient information.

As a result, transparently redirected HTTPS transactions only match Routing Policies if no Routing Policy
Group and no identification profile has a membership criteria by URL category. If any user-defined Routing
Policies or identification profiles define their membership by URL category, then the transparent HTTPS
transactions match the Default Routing Policy Group.

HTTPS Request Failures
• HTTPS with IP-based Surrogates and Transparent Requests, on page 477
• Different Client “Hello” Behavior for Custom and Default Categories, on page 477

HTTPS with IP-based Surrogates and Transparent Requests
If the HTTPS request comes from a client that does not have authentication information available from an
earlier HTTP request, AsyncOS either fails the HTTPS request or decrypts the HTTPS request in order to
authenticate the user, depending on how you configure the HTTPS Proxy. Use the HTTPS Transparent Request
setting on the Security Services > HTTPS Proxy page to define this behavior. Refer to the Enabling HTTPS
Proxy section in Decryption Policies chapter.

Different Client “Hello” Behavior for Custom and Default Categories
When scanning packet captures, you may notice that the “Client Hello” handshake is sent at different times
for custom category and default (Web) category HTTPS Decryption pass-through policies.
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For an HTTPS page passed through via the default category, the Client Hello is sent before receipt of a Client
Hello from the requestor, and the connection fails. For an HTTPS page passed through via a custom URL
category, the Client Hello is sent after the Client Hello is received from the requestor, and the connection is
successful.

As a remedy, you can create a custom URL category with a pass-through action for SSL 3.0-only-compatible
Web pages.

Bypassing Decryption for Particular Websites
Some HTTPS servers do not work as expected when traffic to them is decrypted by a proxy server, such as
the Web Proxy. For example, some websites and their associated web applications and applets, such as high
security banking sites, maintain a hard-coded list of trusted certificates instead of relying on the operating
system certificate store.

You can bypass decryption for HTTPS traffic to these servers to ensure all users can access these types of
sites.

Step 1 Create a custom URL category that contains the affected HTTPS servers by configuring the Advanced properties.
Step 2 Create a Decryption Policy that uses the custom URL category created in Step 1 as part of its membership, and set the

action for the custom URL category to Pass Through.

Conditions and Restrictions for Exceptions to Blocking for Embedded and
Referred Content

Referrer-based exceptions are supported only in Access policies. To use this feature with HTTPS traffic,
before defining exceptions in Access policies, you must configure HTTPS decryption of the URL Categories
that you will select for exception. However, this feature will not work under certain conditions:

• If the connection is tunneled and HTTPS decryption is not enabled, this feature will not work for requests
going to HTTPS sites.

• According to RFC 2616, a browser client could have a toggle switch for browsing openly/anonymously,
which would respectively enable/disable the sending of Referer and from information. The feature is
exclusively dependent on the Referer header, and turning off sending them would cause our feature not
to work.

• According to RFC 2616, clients should not include a Referer header field in a (non-secure) HTTP request
if the referring page was transferred with a secure protocol. So, any request from an HTTPS-based site
to an HTTP-based site would not have the Referer header, causing this feature to not work as expected.

• When a Decryption policy is set up such that when a custom category matches the Decryption policy
and the action is set to Drop, any incoming request for that category will be dropped, and no bypassing
will be done.

Alert: Problem with Security Certificate
Typically, the root certificate information you generate or upload in the appliance is not listed as a trusted
root certificate authority in client applications. By default in most web browsers, when users send HTTPS
requests, they will see a warning message from the client application informing them that there is a problem
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with the website’s security certificate. Usually, the error message says that the website’s security certificate
was not issued by a trusted certificate authority or the website was certified by an unknown authority. Some
other client applications do not show this warning message to users nor allow users to accept the unrecognized
certificate.

Mozilla Firefox browsers: The certificate you upload must contain “basicConstraints=CA:TRUE” to work
with Mozilla Firefox browsers. This constraint allows Firefox to recognize the root certificate as a trusted
root authority.

Note

Identity Services Engine Problems
• Tools for Troubleshooting ISE Issues, on page 479

• ISE Server Connection Issues, on page 479

• ISE-related Critical Log Messages, on page 481

Tools for Troubleshooting ISE Issues
The following can be useful when troubleshooting ISE-related issues:

• The ISE test utility, used to test the connection to the ISE server, provides valuable connection-related
information. This is the Start Test option on the Identity Services Engine page; see Connect to the
ISE/ISE-PIC Services, on page 145.

• ISE and Proxy Logs; see Monitor System Activity Through Logs, on page 359

• ISE-related CLI commands iseconfig and isedata , particularly isedata to confirm security group tag
(SGT) download. See Web Security Appliance CLI Commands, on page 503 for additional information.

• The Web Tracking and Policy Trace functions can be used to debug policy match issues; for example,
a user that should be allowed is blocked, and vice versa. See Policy Troubleshooting Tool: Policy Trace,
on page 486 for additional information.

• Packet Capture, on page 493 if Working With Support , on page 495.

• For checking certificate status, you can use the openssl Online Certificate Status Protocol ( ocsp ) utility,
available from https://www.openssl.org/ .

ISE Server Connection Issues

Certificate Issues
TheWSA and the ISE server(s) use certificates to mutually authenticate for successful connection. Thus, each
certificate presented by one entity should be recognizable by other. For example, if theWSA’s Client certificate
is self-signed, the same certificate must be present in the trusted certificates list on the appropriate ISE server(s).
Correspondingly, if the WSA Client certificate is CA-signed, then the CA root certificate must be present on
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the appropriate ISE server(s). Similar requirements apply to the ISE server-related Admin and pxGrid
certificates.

Certificate requirements and installation are described in Integrate the Cisco Identity Services Engine (ISE)
/ ISE Passive Identity Controller (ISE-PIC), on page 139. If you encounter certificate-related issues, check the
following:

• If using CA-signed certificates:

• Verify that the root CA signing certificate(s) for the Admin and pxGrid certificates are present on
the WSA.

• Verify that the root CA signing certificate for the WSA Client certificate is present in the
trusted-certificates list on the ISE server.

• If using self-signed certificates:

• Verify that theWSAClient certificate—generated on theWSA and downloaded—has been uploaded
to the ISE server and is present in the ISE servers trusted-certificates list.

• Verify that the ISE Admin and pxGrid certificates—generated on the ISE server and
downloaded—have been uploaded to the WSA are present in the its certificate list.

• Expired certificates:

• Confirm that certificates which were valid when uploaded have not expired.

Log Output Indicating Certificate Issue

The following ISE-service log snippet shows a client-connection timeout due to a missing or invalid certificate.

These Trace-level log entries on theWSA show that after 30 seconds the attempts to connect to the ISE server
are terminated.

Network Issues
If connection to the ISE server fails during the Start Test on the Identity Services Engine page (Connect to
the ISE/ISE-PIC Services, on page 145), check connectivity to the configured ISE server on ports 443 and
5222.

Port 5222 is the official client-to-server Extensible Messaging and Presence Protocol (XMPP) port, and is
used for connection to the ISE server; it is also used by applications such as Jabber and Google Talk. Note
that some firewalls are configured to block port 5222.
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Tools that can be used to check connectivity include tcpdump

Other ISE Server Connectivity Issues
The following issues can cause failure when the WSA attempts to connect with the ISE server:

• Licenses on the ISE server have expired.

• The pxGrid node status is “not connected” on the ISE server’s Administration > pxGrid Services page.
Be sure Enable Auto-Registration is selected on this page.

• OutdatedWSA clients (specifically “test_client” or “pxgrid_client”) are present on the ISE server. These
need to be deleted; see Administration > pxGrid Services > Clients on the ISE server.

• The WSA is attempting to connect to the ISE server before all its services are up and running.

Some changes on the ISE server, such as certificate updates, require the ISE server or services running
on it to restart. Any attempt to connect to the ISE server during this time will fail; however, eventually
the connection will succeed.

ISE-related Critical Log Messages
This section contains explanations for ISE-related critical Log messages on the WSA:

• Tue Mar 24 03:56:47 2015 Critical: ISEEngineManager: Waiting for client connection timed

out

The WSA’s ISE process failed to connect to the ISE server for 30 seconds.

• Tue Mar 24 03:56:47 2015 Critical: ISEEngineManager: WSA Client cert/key missing. Please

check ISE config

The WSA Client certificate and key were not uploaded or generated on the WSA’s Identity Service
Engine configuration page.

• Tue Mar 24 03:56:47 2015 Critical: ISEEngineManager: ISE service exceeded maximum

allowable disconnect duration with ISE server

The WSA’s ISE process could not connect to the ISE server for 120 seconds and exited.

• Tue Mar 24 03:56:47 2015 Critical: ISEEngineManager: Subscription to updates failed ...

The WSA’s ISE process could not subscribe to the ISE server for updates.

• Tue Mar 24 03:56:47 2015 Critical: ISEEngineManager: Could not create ISE client: ...

Internal error when creating the WSA’s ISE client for ISE server connection.

• Tue Mar 24 03:56:47 2015 Critical: ISEEngineManager: Bulk Download thread failed: ...

Internal error indicating bulk download of SGTs failed on connection or re-connection.

• Tue Mar 24 03:56:47 2015 Critical: ISEService: Unable to start service. Error: ...

The WSA’s ISE service failed to start.

• Tue Mar 24 03:56:47 2015 Critical: ISEService: Unable to send ready signal ...

The WSA’s ISE service was unable to send a ready signal to heimdall .
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• Tue Mar 24 03:56:47 2015 Critical: ISEService: Unable to send restart signal ...

The WSA’s ISE service was unable to send a restart signal to heimdall .

Problems with Custom and External URL Categories
• Issues Downloading An External Live Feed File, on page 482

• MIME Type Issue on IIS Server for .CSV Files, on page 483

• Malformed Feed File Following Copy and Paste, on page 483

Issues Downloading An External Live Feed File
When Creating and Editing Custom and External URL Categories and providing an External Live Feed file
(either Cisco Feed Format or Office 365 Feed Format), you must click the Get File button to initiate
connection to the specified server, and download and parsing of the file. Progress and results of this process
are displayed; if errors occur they are described. Rectify the problems and try downloading the file again.

There are four types of possible error:

• Connect exceptions

Failed to resolve server hostname – the URL provided as the feed-file location is invalid; provide
a correct URL to resolve this issue.

• Protocol errors

Authentication failed due to invalid credentials – Server authentication failed; provide the
correct user name and passphrase for server connection.

The requested file is not found on the server – The URL provided for the feed file points to an
invalid resource. Ensure the correct file is available on the specified server.

• Content validation errors

Failed to validate the content of the field – The content of the feed file is invalid.

• Parsing errors

• The Cisco Feed Format .csv file must contain one or more entries, where each entry is a site address
or a valid regex string, followed by a comma and then the addresstype (which can be either site
or regex). If this convention is not followed for any entry in the feed file, a parsing error is thrown.

Also, do not include http:// or https:// as part of any site entry in the file, or an error will occur.
In other words, www.example.com is parsed correctly, while http://www.example.com produces an
error.

• The XML feed file obtained from a Microsoft server is parsed by a standard XML parser. Any
inconsistencies in the XML tagging are also flagged as parsing errors.

The line number of a parsing error is included in the log. For example:

Line 8: 'www.anyurl.com' - Line is missing address or address-type field. Line 8 in the
feed file doesn’t include a valid address or regex pattern, or an addresstype.
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Line 12: 'www.test.com' - Unknown address type.Line 12 has a invalid addresstype; the addresstype
can be either site or regex.

MIME Type Issue on IIS Server for .CSV Files
When providing a .csv file for theExternal Live Feed Category >Cisco Feed Format option while Creating
and Editing Custom and External URL Categories, you may encounter a “406 not acceptable” error when
fetching the file if the Cisco Feed Format server is running Internet Information Services (IIS) version 7 or 8
software. Similarly, the feedsd log will report something like: 31 May 2016 16:47:22 (GMT +0200) Warning:

Protocol Error: 'HTTP error while fetching file from the server'.

This is because the default MIME type for .csv files on IIS is application/csv rather than text/csv. You
can remedy the problem by logging into the IIS server and editing the MIME type entry for .csv files to be
text/csv.

Malformed Feed File Following Copy and Paste
If you copy and paste the contents of a .csv (text) feed file from a UNIX or OSX system to aWindows system,
an extra carriage return (\r) is added automatically and this can make the feed file malformed.

If you manually create the .csv file, or if you transfer the file from a UNIX or OS X system to a Windows
server using SCP, FTP, or POST, there should be no problem.

Logging Problems
• Custom URL Categories Not Appearing in Access Log Entries, on page 483
• Logging HTTPS Transactions, on page 483
• Alert: Unable to Maintain the Rate of Data Being Generated, on page 484
• Problem Using Third-Party Log-Analyzer Tool with W3C Access Logs, on page 484

Custom URL Categories Not Appearing in Access Log Entries
When a web access policy group has a custom URL category set to Monitor and some other component, such
as the Web Reputation Filters or the DVS engine, makes the final decision to allow or block a request for a
URL in the customURL category, then the access log entry for the request shows the predefined URL category
instead of the custom URL category.

Logging HTTPS Transactions
HTTPS transactions in the access logs appear similar to HTTP transactions, but with slightly different
characteristics. What gets logged depends on whether the transaction was explicitly sent or transparently
redirected to the HTTPS Proxy:

• TUNNEL. This gets written to the access log when the HTTPS request was transparently redirected to
the HTTPS Proxy.

• CONNECT. This gets written to the access log when the HTTPS request was explicitly sent to the
HTTPS Proxy.
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When HTTPS traffic is decrypted, the access logs contain two entries for a transaction:

• TUNNEL or CONNECT depending on the type of request processed.
• The HTTP Method and the decrypted URL. For example, “GET https://ftp.example.com”.

The full URL is only visible when the HTTPS Proxy decrypts the traffic.

Alert: Unable to Maintain the Rate of Data Being Generated
AsyncOS for Web sends a critical email message to the configured alert recipients when the internal logging
process drops web transaction events due to a full buffer.

By default, when the Web Proxy experiences a very high load, the internal logging process buffers events to
record them later when the Web Proxy load decreases. When the logging buffer fills completely, the Web
Proxy continues to process traffic, but the logging process does not record some events in the access logs or
in the Web Tracking report. This might occur during a spike in web traffic.

However, a full logging buffer might also occur when the appliance is over capacity for a sustained period of
time. AsyncOS for Web continues to send the critical email messages every few minutes until the logging
process is no longer dropping data.

The critical message contains the following text:

Reporting Client: The reporting system is unable to maintain the rate of data being generated.

Any new data generated will be lost.

If AsyncOS for Web sends this critical message continuously or frequently, the appliance might be over
capacity. Contact Cisco Customer Support to verify whether or not you need additionalWeb Security appliance
capacity.

Problem Using Third-Party Log-Analyzer Tool with W3C Access Logs
If you want to use a third party log analyzer tool to read and parse the W3C access logs, you might need to
include the “timestamp” field. The timestamp W3C field displays time since the UNIX epoch, and most log
analyzers only understand time in this format.

Policy Problems
• Access Policy not Configurable for HTTPS, on page 484
• Blocked Object Problems, on page 472
• Identification Profile Disappeared from Policy, on page 485
• Policy Match Failures, on page 485
• Policy Troubleshooting Tool: Policy Trace, on page 486
• Also see: Accessing HTTPS Sites Using Routing Policies with URL Category Criteria, on page 477

Access Policy not Configurable for HTTPS
With the HTTPS Proxy is enabled, Decryption Policies handle all HTTPS policy decisions. You can no longer
define Access and Routing Policy group membership by HTTPS, nor can you configure Access Policies to
block HTTPS transactions.
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If some Access and Routing Policy group memberships are defined by HTTPS and if some Access Policies
block HTTPS, then when you enable the HTTPS Proxy, those Access and Routing Policy groups become
disabled. You can choose to enable the policies at any time, but all HTTPS related configurations are removed.

Blocked Object Problems
• Some Microsoft Office Files Not Blocked, on page 472
• Blocking DOS Executable Object Types Blocks Updates for Windows OneCare, on page 473

Some Microsoft Office Files Not Blocked
When you block Microsoft Office files in the Block Object Type section, it is possible that some Microsoft
Office files will not be blocked.

If you need to block all Microsoft Office files, add application/x-ole in the Block CustomMIME Types field.
However, blocking this custom MIME type also blocks all Microsoft Compound Object format types, such
as Visio files and some third-party applications.

Blocking DOS Executable Object Types Blocks Updates for Windows OneCare
When you configure the Web Security appliance to block DOS executable object types, the appliance also
blocks updates for Windows OneCare.

Identification Profile Disappeared from Policy
Disabling an Identification Profile removes it from associated policies. Verify that the Identification Profile
is enabled and then add it to the policy again.

Policy Match Failures
• Policy is Never Applied, on page 485
• HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require Authentication,
on page 485

• User Matches Global Policy for HTTPS and FTP over HTTP Requests, on page 486
• User Assigned Incorrect Access Policy , on page 486

Policy is Never Applied
If multiple Identification Profiles have identical criteria, AsyncOS assigns the transactions to the first
Identification Profile that matches. Therefore, transactions never match the additional, identical Identification
Profiles, and any policies that apply to those subsequent, identical Identification Profiles are never matched
or applied.

HTTPS and FTP over HTTP Requests Match only Access Policies that Do Not Require Authentication
Configure the appliance to use IP addresses as the surrogate when credential encryption is enabled.

When credential encryption is enabled and configured to use cookies as the surrogate type, authentication
does not work with HTTPS or FTP over HTTP requests. This is because the Web Proxy redirects clients to
the Web Proxy itself for authentication using an HTTPS connection if credential encryption is enabled. After
successful authentication, the Web Proxy redirects clients back to the original website. In order to continue
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to identify the user, the Web Proxy must use a surrogate (either the IP address or a cookie). However, using
a cookie to track users results in the following behavior if requests use HTTPS or FTP over HTTP:

• HTTPS. The Web Proxy must resolve the user identity before assigning a Decryption Policy (and
therefore, decrypt the transaction), but it cannot obtain the cookie to identify the user unless it decrypts
the transaction.

• FTP over HTTP. The dilemma with accessing FTP servers using FTP over HTTP is similar to accessing
HTTPS sites. The Web Proxy must resolve the user identity before assigning an Access Policy, but it
cannot set the cookie from the FTP transaction.

Therefore, HTTPS and FTP over HTTP requests will match only Access Policies that do not require
authentication. Typically, they match the global Access Policy because it never requires authentication.

User Matches Global Policy for HTTPS and FTP over HTTP Requests
When the appliance uses cookie-based authentication, the Web Proxy does not get cookie information from
clients for HTTPS and FTP over HTTP requests. Therefore, it cannot get the user name from the cookie.

HTTPS and FTP over HTTP requests still match the Identification Profile according to the other membership
criteria, but theWeb Proxy does not prompt clients for authentication even if the Identification Profile requires
authentication. Instead, theWeb Proxy sets the user name to NULL and considers the user as unauthenticated.

Then, when the unauthenticated request is evaluated against a policy, it matches only a policy that specifies
“All Identities” and apply to “All Users.” Typically, this is the global policy, such as the global Access Policy.

User Assigned Incorrect Access Policy
• Clients on your network use Network Connectivity Status Indicator (NCSI)
• Web Security appliance uses NTLMSSP authentication.
• Identification Profile uses IP based surrogates

A user might be identified using the machine credentials instead of the user’s own credentials, and as a result,
might be assigned to an incorrect Access Policy.

Workaround:

Reduce the surrogate timeout value for machine credentials.

Step 1 Use the advancedproxyconfig > authentication CLI command.
Step 2 Enter the surrogate timeout for machine credentials.

Policy Trace Mismatch after Modifying Policy Parameters
When you modify policy parameters such as Access Policy, Identification Profiles and Users, Select One or
More Identification Profiles, or Selected Groups and Users, the changes will take a few minutes to take effect.

Policy Troubleshooting Tool: Policy Trace
• About the Policy Trace Tool, on page 487

• Tracing Client Requests, on page 487
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• Advanced: Request Details, on page 488

• Advanced: Response Detail Overrides, on page 489

About the Policy Trace Tool
The Policy Trace Tool can emulate a client request and then detail how the Web Proxy processes that request.
It can be used to trace client requests and debug policy processing when troubleshooting Web Proxy issues.
You can perform a basic trace, or you can enter advanced trace settings and override options.

When you use the Policy Trace tool, the Web Proxy does not record the requests in the access log or reporting
database.

Note

The Policy Trace tool evaluates requests against polices used by the Web Proxy only. These are Access,
Encrypted HTTPS Management, Routing, Data Security, and Outbound Malware Scanning polices.

SOCKS and External DLP polices are not evaluated by the Policy Trace tool.Note

Tracing Client Requests

You can use the CLI command maxhttpheadersize to change the maximum HTTP header size for proxy
requests. Increasing this value can alleviate Policy Trace failures that can occur when the specified user belongs
to a large number of authentication groups, or when the response header is larger than the current maximum
header size. See Web Security Appliance CLI Commands, on page 503 for more information about this
command.

Note

Step 1 Choose System Administration > Policy Trace.
Step 2 Enter the URL you wish to trace to in the Destination URL field.
Step 3 (Optional) Enter additional emulation parameters:

Enter...To emulate...

An IP address in the Client IP Address field.

If an IP address is not specified, AsyncOS uses localhost. Also, SGTs (security
group tags) cannot be fetched and policies based on SGTs will not be matched.

Note

The client source IP used to
make the request.

A user name in the User Name field, and then choose Identity Services Engine or an
authentication realm from the Authentication/Identification drop-down list.

Only enabled option(s) are available. That is, authentication options and the
ISE option are available only if they are both enabled.

Note

For authentication of the user you enter here, the user must have already successfully
authenticated through the Web Security appliance.

The
authentication/identification
credentials used to make the
request.
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Step 4 Click Find Policy Match.

The Policy Trace output is displayed in the Results pane.

For a Pass Through HTTPS transaction, the Policy Trace tool bypasses further scanning and no Access policy
is associated with the transaction. Similarly, for a Decrypt HTTPS transaction, the tool cannot actually decrypt
the transaction to determine the applied Access policy. In both cases, as well as for Drop transactions, the trace
results display: “Access policy: Not Applicable.”

Note

What to do next

Related Topics

• Advanced: Request Details, on page 488

• Advanced: Response Detail Overrides, on page 489

Advanced: Request Details
You can use the settings in the Request Details pane of the Policy Trace page, Advanced section, to tune the
outbound malware scan request for this policy trace.

Step 1 Expand the Advanced section on the Policy Trace page.
Step 2 Complete the fields in the Request Details pane as required:

DescriptionSetting

Select a specific proxy port to use for the trace request to test policy membership based on proxy
port.

Proxy Port

Specify the User Agent to simulate in the request.User Agent

Specify the Date and Time of day to simulate in the request.Time of Request

Choose a local file to simulate uploading in the request.

When you specify a file to upload here, theWeb Proxy simulates an HTTP POST request instead
of a GET request.

Upload File

Enter the size of the request object in bytes. You can enter K, M, or G to represent Kilobytes,
Megabytes, or Gigabytes.

Object Size

Enter the MIME type.MIME Type

To override aWebroot, McAfee, or Sophos scanning verdict, choose the specific type of verdict
to be overridden.

Anti-malware
Scanning Verdicts

Step 3 Click Find Policy Match.

The Policy Trace output is displayed in the Results pane.
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Advanced: Response Detail Overrides
You can use the settings in the Response Detail Overrides pane of the Policy Trace page, Advanced section,
to “tweak” aspects of the Web Access Policies response for this trace.

Step 1 Expand the Advanced section on the Policy Trace page.
Step 2 Complete the fields in the Response Detail Overrides pane as required:

DescriptionSetting

Use this setting to override the URL transaction category of the trace response. Choose a category
which is to replace the URL category in the response results.

URL Category

Similarly, use this setting to override the application category of the trace response. Choose a
category which is to replace the application category in the response results.

Application

Enter a size for the response object in bytes. You can enter K, M, or G to represent Kilobytes,
Megabytes, or Gigabytes.

Object Size

Enter a MIME type.MIME Type

Enter a web reputation score from -10.0 to 10.0.Web Reputation Score

Use these options to override specific anti-malware scanning verdicts provided in the trace
response. Choose verdicts which are to replace the Webroot, McAfee, and Sophos scanning
verdicts in the response results.

Anti-malware
Scanning Verdicts

Step 3 Click Find Policy Match.

The Policy Trace output is displayed in the Results pane.

Problems with File Reputation and File Analysis
See Troubleshooting File Reputation and Analysis , on page 277

Reboot Issues
• Virtual Appliance Running on KVM Hangs on Reboot , on page 489
• Hardware Appliances: Remotely Resetting Appliance Power , on page 490

Virtual Appliance Running on KVM Hangs on Reboot

This is a KVM issue and may change at any time.Note
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For more information, see https://www.mail-archive.com/kvm@vger.kernel.org/msg103854.html and
https://bugs.launchpad.net/qemu/+bug/1329956.

Step 1 Check the following:
cat /sys/module/kvm_intel/parameters/enable_apicv

Step 2 If the above value is set to Y:
a) Stop your virtual appliances and reinstall the KVM kernel module:

rmmod kvm_intel modprobe kvm_intel enable_apicv=N

b) Restart your virtual appliance.

Hardware Appliances: Remotely Resetting Appliance Power

Before you begin

• Obtain and set up a utility that can manage devices using IPMI version 2.0.
• Understand how to use the supported IPMI commands. See the documentation for your IPMI tool.

If a hardware appliance requires a hard reset, you can reboot the appliance chassis remotely using a third-party
Intelligent Platform Management Interface (IPMI) tool.

Restrictions

• Remote power cycling is available only on certain hardware. For specifics, see Enabling Remote Power
Cycling , on page 427.

• If you want be able to use this feature, you must enable it in advance, before you need to use it. For
details, see Enabling Remote Power Cycling , on page 427.

• Only the following IPMI commands are supported: status, on, off, cycle, reset, diag, soft. Issuing
unsupported commands will produce an “insufficient privileges” error.

Step 1 Use IPMI to issue a supported power-cycling command to the IP address assigned to the Remote Power Cycle port, which
you configured earlier, along with the required credentials.

For example, from a UNIX-type machine with IPMI support, you might issue the command:

ipmitool -I lan -H 192.0.2.1 -U remoteresetuser -P passphrase chassis power reset

For S195, S395, and S695 models, use :
ipmitool -I lanplus -H 192.0.2.1 -U remoteresetuser -P password chassis power reset

where 192.0.2.1 is the IP address assigned to the Remote Power Cycle port and remoteresetuser and passphrase are the
credentials that you entered while enabling this feature.

Step 2 Wait at least eleven minutes for the appliance to reboot.
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Site Access Problems
• Cannot Access URLs that Do Not Support Authentication, on page 491
• Cannot Access Sites With POST Requests , on page 491
• Also see: Bypassing Decryption for Particular Websites, on page 478

Cannot Access URLs that Do Not Support Authentication
This is a partial list of applications cannot be used when theWeb Security appliance is deployed in transparent
mode because they do not support authentication.

• Mozilla Thunderbird
• Adobe Acrobat Updates
• HttpBridge
• Subversion, by CollabNet
• Microsoft Windows Update
• Microsoft Visual Studio

Workaround: Create a class of user for the URL that does not require authentication.

Related Topics

• Bypassing Authentication, on page 115

Cannot Access Sites With POST Requests
When the user’s first client request is a POST request and the user still needs to authenticate, the POST body
content is lost. This might be a problem when the POST request is for a application with the Access Control
single sign-on feature in use.

Workarounds:

• Have users first authenticate with the Web Proxy by requesting a different URL through the browser
before connecting to a URL that uses POST as a first request.

• Bypass authentication for URLs that use POST as a first request.

When working with Access Control, you can bypass authentication for the Assertion Consumer Service (ACS)
URL configured in the Application Authentication Policy.

Note

Related Topics

• Bypassing Authentication, on page 115.

Upstream Proxy Problems
• Upstream Proxy Does Not Receive Basic Credentials, on page 492
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• Client Requests Fail Upstream Proxy, on page 492

Upstream Proxy Does Not Receive Basic Credentials
If both the appliance and the upstream proxy use authentication with NTLMSSP, depending on the
configurations, the appliance and upstream proxy might engage in an infinite loop of requesting authentication
credentials. For example, if the upstream proxy requires Basic authentication, but the appliance requires
NTLMSSP authentication, then the appliance can never successfully pass Basic credentials to the upstream
proxy. This is due to limitations in authentication protocols.

Client Requests Fail Upstream Proxy
Configuration:

• Web Security appliance and upstream proxy server use Basic authentication.
• Credential Encryption is enabled on the downstream Web Security appliance.

Client requests fail on the upstream proxy because the Web Proxy receives an “Authorization” HTTP header
from clients, but the upstream proxy server requires a “Proxy-Authorization” HTTP header.

Unable to Route FTP Requests Via an Upstream Proxy
If your network contains an upstream proxy that does not support FTP connections, then you must create a
Routing Policy that applies to all Identities and to just FTP requests. Configure that Routing Policy to directly
connect to FTP servers or to connect to a proxy group whose proxies all support FTP connections.

Virtual Appliances
• Do Not Use Force Reset, Power Off, or Reset Options During AsyncOS Startup , on page 492
• Network Connectivity on KVM Deployments Works Initially, Then Fails , on page 492
• Slow Performance, Watchdog Issues, and High CPU Usage on KVM Deployments , on page 493
• General Troubleshooting for Virtual Appliances Running on Linux Hosts , on page 493

Do Not Use Force Reset, Power Off, or Reset Options During AsyncOS Startup
The following actions on your virtual host are the equivalent of pulling the plug on a hardware appliance and
are not supported, especially during AsyncOS startup:

• In KVM, the Force Reset option.
• In VMWare, the Power Off and Reset options. (These options are safe to use after the appliance has
come up completely.)

Network Connectivity on KVM Deployments Works Initially, Then Fails
Problem

Network connectivity is lost after previously working.

Solution
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This is a KVM issue. See the section on "KVM: Network connectivity works initially, then fails" in the
OpenStack documentation at
http://docs.openstack.org/admin-guide-cloud/content/section_network-troubleshoot.html

Slow Performance, Watchdog Issues, and High CPU Usage on KVM
Deployments

Problem

Appliance performance is slow, watchdog issues occur, and the appliance shows unusually high CPU usage
when running on an Ubuntu virtual machine.

Solution

Install the latest Host OS updates from Ubuntu.

General Troubleshooting for Virtual Appliances Running on Linux Hosts
Problem

Issues with virtual appliances running on KVM deployments may be related to host OS configuration issues.

Solution

See the troubleshooting section and other information in the Virtualization Deployment and Administration
Guide available from:

https://access.redhat.com/documentation/en-US/Red_Hat_Enterprise_Linux/7/pdf/
Virtualization_Deployment_and_Administration_Guide/Red_Hat_Enterprise_Linux-7-
Virtualization_Deployment_and_Administration_Guide-en-US.pdf.

WCCP Problems
• Maximum Port Entries, on page 493

Maximum Port Entries
In deployments using WCCP, the maximum number of port entries is 30 for HTTP, HTTPS , and FTP ports
combined.

Packet Capture
• Starting a Packet Capture, on page 494
• Managing Packet Capture Files, on page 494

The appliance provides the ability to capture and display TCP/IP and other packets being transmitted or
received over the network to which the appliance is attached.
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The packet capture feature is similar to the Unix tcpdump command.Note

Starting a Packet Capture

Step 1 Choose Support and Help > Packet Capture.
Step 2 (Optional) Click Edit Settings to change the packet capture settings.

DescriptionOption

Specifies the maximum size that the capture file can reach. One the limit is reached, the data
will be discarded and a new file started, unless the Capture Duration setting is 'Run Capture
Until File Size Limit Reached.'

Capture File Size
Limit

Options for if and when the capture automatically stops. Choose from:

• Run Capture Until File Size Limit Reached. The capture runs until the file limit set
above is reached.

• Run Capture Until Time Elapsed Reaches. The capture runs for a specified duration. If
you enter the amount of time without specifying the units, AsyncOS uses seconds by
default.

• Run Capture Indefinitely. The packet capture runs until you manually stop it.

The capture can be ended manually at any time.Note

Capture Duration

The interfaces from which traffic will be captured.Interfaces

The filtering options to apply when capturing packets. Filtering allows you to capture required
packets only. Choose from:

• No Filters. All packets will be captured.
• Predefined Filters. The predefined filters provide filtering by port and/or IP addresses. If
left blank, all traffic will be captured.

• Custom Filter. Use this option if you already know the exact syntax of the packet capture
options that you need. Use standard tcpdump syntax.

Filters

(Optional) Submit and commit your packet capture changes.

When you change the packet capture settings without committing the changes and then start a packet capture,
AsyncOS uses the new settings. This allows you to use the new settings in the current session without enforcing
the settings for future packet capture runs. The settings remain in effect until you clear them.

Note

Step 3 Click Start Capture. To manually stop a running capture, click Stop Capture.

Managing Packet Capture Files
The appliance saves the captured packet activity to a file and stores the file locally. You can send packet
capture files using FTP to Cisco Customer Support for debugging and troubleshooting purposes.
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• Downloading or Deleting Packet Capture Files, on page 495

Downloading or Deleting Packet Capture Files

You can also connect to the appliance using FTP and retrieving packet capture files from the captures directory.Note

Step 1 Choose Support and Help > Packet Capture.
Step 2 Select the packet capture file you wish to use from the Manage Packet Capture Files pane. If this pane is not visible then

no packet capture files have been stored on the appliance.
Step 3 Click Download File or Delete Selected Files as required.

Working With Support
• Gathering Information for Efficient Service , on page 495
• Opening a Technical Support Request, on page 495
• Getting Support for Virtual Appliances , on page 496
• Enabling Remote Access to the Appliance , on page 496

Gathering Information for Efficient Service
Before contacting Support:

• Enable custom logging fields as described in General Troubleshooting Best Practices, on page 469.
• Consider doing a packet capture. See Packet Capture, on page 493.

Opening a Technical Support Request

Before you begin

• Verify that your Cisco.com user ID is associated with your service agreement contract for this appliance.
To view a list of service contracts that are currently associated with your Cisco.com profile, visit the
Cisco.com Profile Manager at https://sso.cisco.com/autho/forms/CDClogin.html. If you do not have a
Cisco.com user ID, register to get one.

You can use the appliance to send a non-urgent request for assistance to Cisco Customer Support. When the
appliance sends the request, it also sends the configuration of the appliance. The appliance must be able to
send mail to the Internet to send a support request.

If you have an urgent issue, please call a Cisco Worldwide Support Center.Note

Step 1 Choose Support And Help > Contact Technical Support.
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Step 2 (Optional) Choose additional recipients for the request. By default, the support request and configuration file is sent to
Cisco Customer Support.

Step 3 Enter your contact information.
Step 4 Enter the issue details.

• If you have a customer support ticket already for this issue, enter it.

Step 5 Click Send. A trouble ticket is created with Cisco.

Getting Support for Virtual Appliances
If you file a support case for a Cisco content security virtual appliance, you must provide your Virtual License
Number (VLN), your contract number, and your Product Identifier code (PID).

You can identify your PID based on the software licenses running on your virtual appliance, by referencing
your purchase order, or from the following table:

DescriptionPIDFunctionality

Includes:

• Web Usage Controls
• Web Reputation

WSA-WSE-LIC=Web Security Essentials

Includes:

• Web Usage Controls
• Web Reputation
• Sophos and Webroot Anti-Malware signatures

WSA-WSP-LIC=Web Security Premium

Includes Sophos andWebroot Anti-Malware signaturesWSA-WSM-LIC=Web Security Anti-Malware

—WSA-AMM-LIC=McAfee Anti-Malware

—WSA-AMP-LIC=AdvancedMalware Protection

Enabling Remote Access to the Appliance
The Remote Access option allows Cisco Customer Support to remotely access your appliance for support
purposes.

Step 1 Choose Support And Help > Remote Access.
Step 2 Click Enable.
Step 3 Complete the Customer Support Remote Access options:
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DescriptionOption

If you enter a string, the string should not match any existing or future pass phrase.

The string will appear near the top of the page after you click Submit.

You will give this string to your support representative.

Seed String

Specifies whether or not to use a secure tunnel for remote access connections.

When enabled, the appliance creates an SSH tunnel over the specified port to the server
upgrades.ironport.com, over port 443 (by default). Once a connection is made, Cisco Customer
Support is able to use the SSH tunnel to obtain access to the appliance.

Once the techsupport tunnel is enabled, it will remain connected to upgrades.ironport.com for
7 days. After 7 days, no new connections can be made using the techsupport tunnel, though any
existing connections will continue to exist and work.

The Remote Access account will remain active until specifically deactivated.

Secure Tunnel
(recommended)

Step 4 Submit and commit your changes.
Step 5 Look for the seed string in the Success message near the top of the page and make a note of it.

For security reasons, this string is not stored on the appliance and there is no way to locate this string later.

Keep this seed string in a safe place.

Step 6 Give the seed string to your Support representative.
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A P P E N D I X B
Command Line Interface

This appendix contains the following sections:

• Overview of the Command Line Interface , on page 499
• Accessing the Command Line Interface, on page 499
• General Purpose CLI Commands, on page 502
• Web Security Appliance CLI Commands, on page 503

Overview of the Command Line Interface
TheAsyncOSCommand Line Interface (CLI) allows you to configure andmonitor theWeb Security appliance.
The Command Line Interface is accessible using SSH on IP interfaces that have been configured with these
services enabled, or using terminal emulation software on the serial port. By default, SSH is configured on
the Management port.

The commands are invoked by entering the command name with or without any arguments. If you enter a
command without arguments, the command prompts you for the required information.

Accessing the Command Line Interface
You can connect using one of the following methods:

• Ethernet. Start an SSH session with the IP address of the Web Security appliance. The factory default
IP address is 192.168.42.42. SSH is configured to use port 22.

• Serial connection. Start a terminal session with the communication port on your personal computer that
the serial cable is connected to.

First Access
You can add other users with differing levels of permissions after you have accessed the CLI the first time
using the admin account—log in to the appliance by entering the default admin user name and passphrase:

• User name: admin
• Passphrase: ironport

The System Setup Wizard prompts you to change the passphrase for the admin account the first time you log
in with the default passphrase.
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You can also reset the admin account passphrase at any time using the passwd command.

Subsequent Access
You can connect and log into the appliance at any time, using a valid user name and passphrase. Note that a
listing of recent appliance access attempts, both successes and failures, for the current user name is displayed
automatically upon log-in.

See the following userconfig command description, or Administering User Accounts, on page 428 for
information about configuring additional users.

Working with the Command Prompt
The top-level command prompt consists of the fully qualified hostname, followed by the greater than ( > )
symbol, followed by a space. For example:

example.com>

When running commands, the CLI requires input from you. When the CLI is expecting input, the prompt
displays the default values enclosed in square brackets ( [] ) followed by the greater than ( > ) symbol. When
there is no default value, the brackets are empty.

For example:

example.com> routeconfig

Choose a routing table:
- MANAGEMENT - Routes for Management Traffic
- DATA - Routes for Data Traffic
[]>

When there is a default setting, the setting is displayed within the command-prompt brackets. For example:

example.com> setgateway

Warning: setting an incorrect default gateway may cause the current connection
to be interrupted when the changes are committed.
Enter new default gateway:
[172.xx.xx.xx]>

When a default setting is shown, typing Return is equivalent to accepting the default.

Command Syntax
When operating in the interactive mode, the CLI command syntax consists of single commands with no white
space and no arguments or parameters. For example:

example.com> logconfig
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Select Lists
When you are presented with multiple choices for input, some commands use numbered lists. Enter the number
of the selection at the prompt.

For example:

Log level:
1. Critical
2. Warning
3. Information
4. Debug
5. Trace
[3]> 3

Yes/No Queries
When given a yes or no option, the question is posed with a default in brackets. You may answer Y, N, Yes,
or No. Case is not significant.

For example:

Do you want to enable the proxy? [Y]> Y

Subcommands
Some commands give you the opportunity to use subcommand directives such as NEW, EDIT, and DELETE.
The EDIT and DELETE functions provide a list of previously configured values.

For example:

example.com> interfaceconfig
Currently configured interfaces:
1. Management (172.xxx.xx.xx/xx: example.com)
Choose the operation you want to perform:
- NEW - Create a new interface.
- EDIT - Modify an interface.
- DELETE - Remove an interface.
[]>

Within subcommands, pressing Enter or Return at an empty prompt returns you to the main command.

Escaping Subcommands
You can use the Ctrl+C keyboard shortcut at any time within a subcommand to immediately exit return to the
top level of the CLI.

Command History
The CLI keeps a history of all commands entered during a session. Use the Up and Down arrow keys on your
keyboard, or the Ctrl+P and Ctrl+N key combinations to scroll through a running list of the recently-used
commands.
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Completing Commands
The AsyncOS CLI supports command completion. You can enter the first few letters of some commands
followed by the Tab key and the CLI completes the string. If the letters you entered are not unique among
commands, the CLI “narrows” the set. For example:

example.com> set (press the Tab key)
setgateway, setgoodtable, sethostname, settime, settz
example.com> seth (pressing the Tab again completes the entry with sethostname)
example.com> sethostname

Committing Configuration Changes Using the CLI
• Many configuration changes do not take effect until you commit them.
• The commit command allows you to change configuration settings while other operations proceed
normally.

• To successfully commit changes, you must be at the top-level command prompt. Type Return at an
empty prompt to move up one level in the command line hierarchy.

• Changes to configuration that have not been committed are recorded, but do not go into effect until you
run the commit command. However, not all commands require the commit command to be run. Exiting
the CLI session, system shutdown, reboot, failure, or issuing the clear command clears changes that
have not yet been committed.

• Changes are not actually committed until you receive confirmation and a timestamp.

General Purpose CLI Commands
This section describes some basic commands you might use in a typical CLI session, such as committing and
clearing changes.

CLI Example: Committing Configuration Changes
Entering comments after the commit command is optional.

example.com> commit

Please enter some comments describing your changes:
[]> Changed “psinet” IP Interface to a different IP address
Changes committed: Wed Jan 01 12:00:01 2007

CLI Example: Clearing Configuration Changes
The clear command clears any changes made to the appliance configuration since the last commit or clear
command was issued.

example.com> clear

Are you sure you want to clear all changes since the last commit? [Y]> y
Changes cleared: Wed Jan 01 12:00:01 2007
example.com>
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CLI Example: Exiting the Command Line Interface Session
The exit command logs you out of the CLI application. Configuration changes that have not been committed
are cleared.

example.com> exit

Configuration changes entered but not committed. Exiting will lose changes.
Type 'commit' at the command prompt to commit changes.

Are you sure you wish to exit? [N]> y

CLI Example: Seeking Help on the Command Line Interface
The help command lists all available CLI commands and gives a brief description of each command. The
help command can be invoked by typing either help or a single question mark ( ? ) at the command prompt.

example.com> help

Further, you can access help for a specific command by entering help commandname.

Related Topics

• Web Security Appliance CLI Commands, on page 503

Web Security Appliance CLI Commands
The Web Security Appliance CLI supports a set of proxy and UNIX commands to access, upgrade, and
administer the system.

Not all CLI commands are applicable/available in all operating modes (Standard and Cloud Web Security
Connector).

Note

adminaccessconfig

You can configure the Web Security appliance to have stricter access requirements for administrators logging
into the appliance, and you can specify an inactivity time-out value. See Additional Security Settings for
Accessing the Appliance, on page 433 and User Network Access, on page 434 for more information.

advancedproxyconfig

Configure advanced Web Proxy options; subcommands are:

AUTHENTICATION – Authentication configuration options:

• When would you like to forward authorization request headers to a parent proxy

• Enter the Proxy Authorization Realm to be displayed in the end user authentication

dialog

• Would you like to log the username that appears in the request URI
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• Should the Group Membership attribute be used for directory lookups in the Web UI (when

it is not used, empty groups and groups with different membership attributes will be

displayed)

• Would you like to use advanced Active Directory connectivity checks

• Would you like to allow case insensitive username matching in policies

• Would you like to allow wild card matching with the character * for LDAP group names

• Enter the charset used by the clients for basic authentication [ISO-8859-1/UTF-8]

• Would you like to enable referrals for LDAP

• Would you like to enable secure authentication

• Enter the hostname to redirect clients for authentication

• Enter the surrogate timeout for user credentials

• Enter the surrogate timeout for machine credentials

• Enter the surrogate timeout in the case traffic permitted due to authentication service

unavailability

• Enter re-auth on request denied option [disabled / embedlinkinblockpage]

• Would you like to send Negotiate header along with NTLM header for NTLMSSP authentication

• Configure username and IP address masking in logs and reports

CACHING – Proxy Caching mode; choose one:

• Safe Mode

• Optimized Mode

• Aggressive Mode

• Customized Mode

See also Choosing The Web Proxy Cache Mode, on page 69.

DNS – DNS configuration options:

• Enter the URL format for the HTTP 307 redirection on DNS lookup failure

• Would you like the proxy to issue a HTTP 307 redirection on DNS lookup failure

• Would you like proxy not to automatically failover to DNS results when upstream proxy

(peer) is unresponsive

• Do you want to disable IP address in Host Header

• Find web server by:

0 = Always use DNS answers in order

1 = Use client-supplied address then DNS

2 = Limited DNS usage
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3 = Very limited DNS usage

The default value is 0. For options 1 and 2, DNS will be used if Web Reputation is enabled. For options
2 and 3, DNS will be used for explicit proxy requests, if there is no upstream proxy or in the event the
configured upstream proxy fails. For all options, DNS will be used when Destination IP Addresses are
used in policy membership.

EUN – End-user notification parameters:

• Choose:

1. Refresh EUN pages

2. Use Custom EUN pages

3. Use Standard EUN pages

• Would you like to turn on presentation of the User Acknowledgement page?

See also Web Proxy Usage Agreement, on page 73 and End-User Notifications Overview, on page 303.

NATIVEFTP – Native FTP configuration:

• Would you like to enable FTP proxy

• Enter the ports that FTP proxy listens on

• Enter the range of port numbers for the proxy to listen on for passive FTP connections

• Enter the range of port numbers for the proxy to listen on for active FTP connections

• Enter the authentication format:

1. Check Point

2. No Proxy Authentication

3. Raptor

• Would you like to enable caching

• Would you like to enable server IP spoofing

• Would you like to pass FTP server welcome message to the clients

• Enter the max path size for the ftp server directory

See alsoOverview of FTP Proxy Services, on page 78.

FTPOVERHTTP – FTP Over HTTP options:

• Enter the login name to be used for anonymous FTP access

• Enter the password to be used for anonymous FTP access

See also Overview of FTP Proxy Services, on page 78.

HTTPS – HTTPS-related options:

• HTTPS URI Logging Style - fulluri or stripquery

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
505

Command Line Interface
Command Line Interface



• Would you like to decrypt unauthenticated transparent HTTPS requests for authentication

purpose

• Would you like to decrypt HTTPS requests for End User Notification purpose

• Action to be taken when HTTPS servers ask for client certificate during handshake:

1. Pass through the transaction

2. Reply with certificate unavailable

• Do you want to enable server name indication (SNI) extension?

• Do you want to enable automatic discovery and download of missing Intermediate

Certificates?

• Do you want to enable session resumption?

See also Overview of Create Decryption Policies to Control HTTPS Traffic, on page 223.

SCANNING – Scanning options:

• Would you like the proxy to do malware scanning all content regardless of content type

• Enter the time to wait for a response from an anti-malware scanning engine (Sophos,

McAfee, or Webroot), in seconds

• Do you want to disable Webroot body scanning

See also Overview of Anti-Malware Scanning , on page 246 and Overview of Scanning Outbound Traffic, on
page 237.

PROXYCONN – Manage the list of user agents that cannot accept the proxy connection header. The list entries
are interpreted as regular expressions in Flex (Fast Lexical Analyzer) dialect. A user agent will be matched
if any substring of it matches any regular expression in the list.

• Choose the operation you want to perform:

NEW - Add an entry to the list of user agents

DELETE - Remove an entry from the list

CUSTOMHEADERS – Manage custom request headers for specific domains.

• Choose the operation you want to perform:

DELETE - Delete entries

NEW - Add new entries

EDIT - Edit entries

See also Adding Custom Headers To Web Requests, on page 71.

MISCELLANEOUS – Miscellaneous proxy-related parameters:

• Would you like proxy to respond to health checks from L4 switches (always enabled if

WSA is in L4 transparent mode)

• Would you like proxy to perform dynamic adjustment of TCP receive window size

• Would you like proxy to perform dynamic adjustment of TCP send window size
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• Do you want to filter non-HTTP responses?

(Non-HTTP responses are filtered by default.Enter N if you want to allow non-HTTP

responses via proxy)

• Enable caching of HTTPS responses

• Enter minimum idle timeout for checking unresponsive upstream proxy (in seconds)

• Enter maximum idle timeout for checking unresponsive upstream proxy (in seconds)

• Mode of the proxy:

1. Explicit forward mode only

2. Transparent mode with L4 Switch or no device for redirection

3. Transparent mode with WCCP v2 Router for redirection

• Spoofing of the client IP by the proxy:

1. Disable

2. Enable for all requests

3. Enable for transparent requests only

• Do you want to pass HTTP X-Forwarded-For headers?

• Do you want to enable server connection sharing?

• Would you like to permit tunneling of non-HTTP requests on HTTP ports?

• Would you like to block tunneling of non-SSL transactions on SSL Ports?

• Would you like proxy to log values from X-Forwarded-For headers in place of incoming

connection IP addresses?

• Do you want proxy to throttle content served from cache?

• Would you like the proxy to use client IP addresses from X-Forwarded-For headers

• Do you want to forward TCP RST sent by server to client?

• Do you want to enable WCCP proxy health check?

• Do you want to enable URL lower case conversion for velocity regex?

See also Using the P2 Data Interface for Web Proxy Data , on page 30 and Configuring Web Proxy Settings,
on page 65.

SOCKS – SOCKS Proxy options:

• Would you like to enable SOCKS proxy

• Proxy Negotiation Timeout

• UDP Tunnel Timeout

• SOCKS Control Ports

• UDP Request Ports
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See also Using the P2 Data Interface for Web Proxy Data , on page 30 and SOCKS Proxy Services, on page
79.

CONTENT-ENCODING – Allow and block content-encoding types.

Currently allowed content-encoding type(s): compress, deflate, gzip

Currently blocked content-encoding type(s): N/A

To change the setting for a specific content-encoding type, select an option:

1. compress

2. deflate

3. gzip

[1]>

The encoding type "compress" is currently allowed

Do you want to block it? [N]>

adminaccessconfig

You can configure the Web Security appliance to have stricter access requirements for administrators logging
into the appliance.

alertconfig

Specify alert recipients, and set parameters for sending system alerts.

authcache

Allows you to delete one or all entries (users) from the authentication cache. You can also list all users currently
included in the authentication cache.

bwcontrol

Enable bandwidth control debug messages in the Default Proxy log file.

certconfig

SETUP – Configure security certificates and keys.

OCSPVALIDATION – Enable/disable OCSP validation of certificate during upload.

clear

Clears pending configuration changes since last commit.

commit

Commits pending changes to the system configuration.

createcomputerobject

Creates a computer object at the location you specify.
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curl

Send a cURL request directly to a Web server, or to a Web server via proxy, with the request and response
HTTP headers returned to let you determine why a Web page is failing to load.

This command is for Administrator or Operator use only, under TAC supervision.Note

Subcommands are:

• DIRECT – URL access going direct

• APPLIANCE – URL access through the Appliance

datasecurityconfig

Defines a minimum request body size, belowwhich upload requests are not scanned by the Cisco Data Security
Filters.

date

Displays the current date. Example:

Thu Jan 10 23:13:40 2013 GMT

diagnostic

Proxy- and reporting-related subcommands:

NET – Network Diagnostic Utility

This command has been deprecated; use packetcapture to capture network traffic on the appliance.

PROXY – Proxy Debugging Utility

Choose the operation you want to perform:

• SNAP – Take a snapshot of the proxy

• OFFLINE – Take the proxy off-line (via WCCP)

• RESUME – Resume proxy traffic (via WCCP)

• CACHE – Clear proxy cache

REPORTING – Reporting Utilities

The reporting system is currently enabled.

Choose the operation you want to perform:

• DELETEDB – Re-initialize the reporting database

• DISABLE – Disable the reporting system

• DBSTATS – List DB and Export Files (Displays the list of unprocessed files and folders under export_files
and always_onbox folders.)
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• DELETEEXPORTDB – Delete Export Files (Deletes all unprocessed files and folders under export_files and
always_onbox folders.)

• DELETEJOURNAL – Delete Journal Files(Deletes all aclog_journal_files.)

dnsconfig

Configure DNS server parameters.

dnsflush

Flush DNS entries on the appliance.

etherconfig

Configure Ethernet port connections.

Choose the operation you want to perform:

• MEDIA – View and edit ethernet media settings.

• PAIRING – View and configure NIC Pairing.

• VLAN – View and configure VLANs.

• MTU – View and configure MTU.

externaldlpconfig

Defines a minimum request body size, below which upload requests are not scanned by the external DLP
server.

externaldlpconfig

Defines a minimum request body size, below which upload requests are not scanned by the external DLP
server.

featurekey

Submits valid keys to activate licensed features.

featurekeyconfig

Automatically check for and update feature keys.

fipsconfig

SETUP – Enable/disable FIPS 140-2 compliance, and encryption of Critical Sensitive Parameters (CSP). Note
that an immediate reboot will be necessary.

FIPSCHECK – Check FIPS mode compliance. Indicates whether various certificates and services are FIPS
compliant.

See FIPS Compliance, on page 444 for additional information.
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grep

Searches named input files for lines containing a match to the given pattern.

gathererdconfig

Configure the polling functionality between the appliance and the authentication server.

help

Returns a list of commands.

httppatchconfig

Enables or disables outgoing HTTP PATCH requests. The default value is disable.

iccm_message

Clears the message in the web interface and CLI that indicates when this Web Security appliance is managed
by a Security Management appliance (M-Series).

ifconfig or interfaceconfig

Configure andmanage network interfaces includingM1, P1, and P2. Displays currently configured interfaces,
and provides an operations menu to create, edit, or delete interfaces.

iseconfig

Displays current ISE configuration parameters; specify an ISE configuration operation to perform:

• setup – Configure ISE settings: enable/disable, ISE server name or IPv4 address, proxy cache timeout,
statistics back-up interval.

isedata

Specify an ISE data-related operation:

statistics – Show ISE server status and ISE statistics.

cache – Show the ISE cache, or check an IP address:

sgts – Show the ISE Secure Group Tag (SGT) table.

groups – Show the ISE Groups table.

If VDI is implemented, the sub commands show and checkip under the main command cache displays more
details. The show subcommand displays details about port range and checkip subcommand displays details
about the VDI user such as IP address, name, port range etc.
[]> cache

Choose the operation you want to perform:
- SHOW - Show the ISE ID cache.
- CHECKIP - Query the local ISE cache for an IP address

User Guide for AsyncOS 11.7 for Cisco Web Security Appliances - GD (General Deployment)
511

Command Line Interface
Command Line Interface



last

Lists user-specific user information that includes ttys and hosts, in reverse time order or lists the users that
are logged in at a specified date and time.

loadconfig

Load a system configuration file.

logconfig

Configure access to log files.

mailconfig

Mail the current configuration file to the address specified.

maxhttpheadersize

Set the maximum HTTP header size or URL size for proxy requests; enter the value in bytes, or append a K
to the number to indicate kilobytes.

Policy Trace can fail for a user that belongs to a large number of authentication groups. It can also fail if the
HTTP response header size or URL size is greater than the current “max header size.” Increasing this value
can alleviate such failures. Minimum value is 32 KB; default value is 32 KB; maximum value is 1024 KB.

modifyauthhelpers

Use this command to configure the number of Kerberos authentication helpers within a range of 5 to 21 for
BASIC, NTLMSSP, and NEGO.

musconfig

Use this command to enable Secure Mobility and configure how to identify remote users, either by IP address
or by integrating with one or more Cisco adaptive security appliances.

Changes made using this command cause the Web Proxy to restart.Note

musstatus

Use this command to display information related to Secure Mobility when the Web Security appliance is
integrated with an adaptive security appliance.

This command displays the following information:

• The status of the Web Security appliance connection with each adaptive security appliance.

• The duration of theWeb Security appliance connection with each adaptive security appliance in minutes.

• The number of remote clients from each adaptive security appliance.

• The number of remote clients being serviced, which is defined as the number of remote clients that have
passed traffic through the Web Security appliance.
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• The total number of remote clients.

networktuning

The WSA utilizes several buffers and optimization algorithms to handle hundreds of TCP connections
simultaneously, providing high performance for typical Web traffic—that is, short-lived HTTP connections.

In certain situations, such as frequent downloading of large files (100+ MB), larger buffers can provide better
per-connection performance. However, overall memory usage will increase, and thus any buffer increases
should be in line with the memory available on the system.

The send- and receive-space variables represent the buffers used for storing data for communications over
any given TCP socket. The send- and receive-auto variables are used to enable and disable the FreeBSD
auto-tuning algorithm for dynamically controlling window size. These two parameters are applied directly in
the FreeBSD kernel.

When SEND_AUTO and RECV_AUTO are enabled, the system tunes the window size dynamically based on system
load and available resources. On a lightly loaded WSA, the system attempts to keep window sizes large to
reduce per transaction latency. The maximum value of the dynamically tuned window size is dependent on
the configured number of mbuf clusters, which in turn is dependent on the total RAM available on the system.
As the total number of client connections increases, or when the available network buffer resources become
scarce, the system tunes down the window sizes to protect itself from losing all network buffer resources to
proxied traffic.

See Upload/Download Speed Issues, on page 475 for additional information about using this command.

The networktuning subcommands are:

SENDSPACE – TCP send-space buffer size; range is from 8192 to 131072 bytes; the default is 16000 bytes.

RECVSPACE – TCP receive-space buffer size; range is from 8192 to 131072 bytes; the default is 32768 bytes.

SEND-AUTO – Enable/disable TCP send auto-tuning; 1 = On, 0 = Off; default is Off. If you enable TCP send
auto-tuning, be sure to use advancedproxyconfig > miscellaneous > Would you like proxy to perform

dynamic adjustment of TCP send window size? to disable send buffer auto-tuning.

RECV-AUTO – Enable/disable TCP receive auto-tuning; 1 = On, 0 = Off; default is Off. If you enable TCP
receive auto-tuning, be sure to use advancedproxyconfig > miscellaneous > Would you like proxy to

perform dynamic adjustment of TCP receive window size? to disable receive buffer auto-tuning.

MBUF CLUSTER COUNT – Change the number of available mbuf clusters; acceptable range is from 98304 to
1572864. The value should vary according to installed system memory, using this calculation: 98304 * (X/Y)
where is X is gigabytes of RAMon the system and Y is 4 GB. For example, with 4 GBRAM, the recommended
value is 98304 * (4/4) = 98304. Linear scaling is recommended as RAM increases.

SENDBUF-MAX – Specify the maximum send buffer size; range is from 131072 bytes to 2097152 bytes; the
default is 1 MB (1048576 bytes).

RECVBUF-MAX – Specify the maximum receive buffer size; range is from 131072 bytes to 2097152 bytes; the
default is 1 MB (1048576 bytes).

CLEAN-FIB-1 – Remove all M1/M2 entries from the data-routing table—essentially, enable
control-plane/data-plane separation. That is, disable any data-plane process from sending data over the M1
interface when “Separate Routing” is enabled. Data-plane processes are those for which “Use data routing
table” is enabled, or which carry strictly non-management traffic. Control-plane processes can still send data
of over either the M1 or P1 interfaces.

Following any changes to these parameters, be sure to commit your changes and the restart the appliance.
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Use this command only if you understand the ramifications. We recommend using only with TAC guidance.Caution

nslookup

Queries Internet domain name servers for information about specified hosts and domains or to print a list of
hosts in a domain.

ntpconfig

Configure NTP servers. Displays currently configured interfaces, and provides an operations menu to add,
remove, or set the interface from whose IP address NTP queries should originate.

packetcapture

Intercepts and displays TCP/IP and other packets being transmitted or received over the network to which the
appliance is attached.

passwd

Set the passphrase.

pathmtudiscovery

Enables or disables Path MTU Discovery.

You might want to disable Path MTU Discovery if you need to packet fragmentation.

ping

Sends an ICMP ECHO REQUEST to the specified host or gateway.

proxyconfig <enable | disable>

Enables or disables the Web Proxy.

proxystat

Display web proxy statistics.

quit, q, exit

Terminates an active process or session.

reboot

Flushes the file system cache to disk, halts all running processes, and restarts the system.

reportingconfig

Configure a reporting system.
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resetconfig

Restores the configuration to factory defaults.

revert

Revert the AsyncOS for Web operating system to a previous qualified build. This is a very destructive action,
destroying all configuration logs and databases. Refer to Reverting to a Previous Version of AsyncOS for
Web, on page 460 for information about using this command.

rollovernow

Roll over a log file.

routeconfig

Configure destination IP addresses and gateways for traffic. Displays currently configured routes, and provides
an operations menu to create, edit, or delete, or clear entries.

saveconfig

Saves a copy of the current configuration settings to a file. This file can be used to restore defaults, if necessary.

If FIPS mode is enable, provide a passphrase-handling option: Mask passphrases or Encrypt passphrases.

setgateway

Configure the default gateway for the machine.

sethostname

Set the hostname parameter.

setntlmsecuritymode

Changes the security setting for the NTLM authentication realm to either “ads” or “domain”.

• domain—AsyncOS joins the Active Directory domain with a domain security trust account. AsyncOS
requires Active Directory to use only nested Active Directory groups in this mode.

• ads—AsyncOS joins the domain as a native Active Directory member.

Default is ads .

settime

Set system time.

settz

Displays the current time zone and the time zone version. Provides an operations menu to set a local time
zone.

showconfig

Display all configuration values.
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User passphrases are encrypted.Note

shutdown

Terminates connections and shuts down the system.

smtprelay

Configure SMTP relay hosts for internally generated email. An SMTP relay host is required to receive system
generated email and alerts.

smtpconfig

Configure the local host to listen for SNMP queries and allow SNMP requests.

sshconfig

Configure hostname and host key options for trusted servers.

sslconfig

The default cipher for AsyncOS versions 9.0 and earlier is DEFAULT:+kEDH.

The default cipher for AsyncOS versions 9.1 - 11.8 is:
EECDH:DSS:RSA:!NULL:!eNULL:!EXPORT:!3DES:!RC4:!RC2:!DES:!SEED:!CAMELLIA
:!SRP:!IDEA:!ECDHE-ECDSA-AES256-SHA:!ECDHE-RSA-AES256-SHA:!DHE-DSS-AES256-SHA:
!AES256-SHA:DHE-RSA-AES128-SHA

In this case, the default cipher may change based on your ECDHE cipher selections.

The default cipher for AsyncOS versions 12.0 and later is:
EECDH:DSS:RSA:!NULL:!eNULL:!aNULL:!EXPORT:!3DES:!SEED:!CAMELLIA
:!SRP:!IDEA:!DHE-DSS-AES256-SHA:!AES256-SHA:DHE-RSA-AES128-SHA:
TLS_AES_256_GCM_SHA384

Update the default cipher suite while upgrading to a newer AsyncOS version. The ciphers suites are not
automatically updated.When you upgrade from an earlier version to AsyncOS 12.0 and later, Cisco recommends
updating the cipher suite to:

Note

EECDH:DSS:RSA:!NULL:!eNULL:!aNULL:!EXPORT:!3DES:!SEED:!CAMELLIA
:!SRP:!IDEA:!DHE-DSS-AES256-SHA:!AES256-SHA:DHE-RSA-AES128-SHA:
TLS_AES_256_GCM_SHA384

FALLBACK – Enable/disable the SSL/TLS fall-back option. If enabled, communications with remote servers
will fall back to the lowest configured protocol following a handshake failure.

After a protocol version is negotiated between client and server, handshake failure is possible because of
implementation issues. If this option is enabled, the proxy attempts to connect using the lowest version of the
currently configured TLS/SSL protocols.
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On new AsyncOS 9.x installations, fall-back is disabled by default. For upgrades from earlier versions on
which the fall-back option exists, the current setting is retained; otherwise, when upgrading from a version
on which the option did not exist, fall-back is enabled by default.

Note

ECDHE – Enable/disable use of ECDHE ciphers for LDAP.

Additional ECDH ciphers are supported in successive releases; however, certain named curves provided with
some of the additional ciphers cause the appliance to close a connection during secure LDAP authentication
and HTTPS traffic decryption. See SSL Configuration , on page 447for more information about specifying
additional ciphers.

If you experience these issues, use this option to disable or enable ECDHE cipher use for either or both
features.

ssltool

Executes different OPENSSL commands from appliance's CLI to troubleshoot SSL connections. The ssltool
command has the following subcommands:

• sclient -This is CLI version of openssl s_client command. It will connect to a remote host using
SSL/TLS directly without using the appliance.

• COMMAND - Executes an openssl s_client command. The following openssl s_client commands are
supported:
-connect, -servername, -verify, -cipher, -verify_return_error, -reconnect, -pause,
-showcerts, -prexit, -state, -debug, -msg, -tls1, -tls1_1, -tls1_2, -no_ssl2,
-no_ssl3, -no_tls1, -no_tls1_1, -no_tls1_2, -tlsextdebug, -no_ticket, -status,
-save, -noout

See the inline help for more information about the supported openssl s_client commands .

After you execute the command, you can save the output to a file using the -save
option. You cannot access the saved log files. These log files are used by Cisco
support team for debugging.

Note

• HELP - Provides help information.

• CLEARLOGS -Deletes all logs generated by ssltool.

status

Displays system status.

supportrequest

Send the support request email to Cisco Customer Support. This includes system information and a copy of
the primary configuration.
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(Optional) If you provide the service request number, a larger set of system and configuration information is
added to the service request automatically. This information is zipped and uploaded to the service request
using FTP.

tail

Displays the end of a log file. Command accepts log file name as parameter.

Example 1
example.com> tail
Currently configured logs:
1. "accesslogs" Type: "Access Logs" Retrieval: FTP Poll
2. "amp_logs" Type: "AMP Engine Logs" Retrieval: FTP Poll
…
…
Enter the number of the log you wish to tail.
[]> 9
Press Ctrl-C to stop scrolling, then `q` to quit.
~
~
Thu Dec 14 10:03:07 2017 Info: Begin Logfile
~
~
…
…
“CTRL-C” + “q”

Example 2
example.com> tail system_logs
Press Ctrl-C to stop scrolling, then `q` to quit.
~
~
Thu Dec 14 09:59:10 2017 Info: Begin Logfile
…
…
“CTRL-C” + “q”

tcpservices

Displays information about open TCP/IP services.

techsupport

Provides a temporary connection to allow Cisco Customer Support to access the system and assist in
troubleshooting.

telnet

Communicates with another host using the TELNET protocol, usually used to check connectivity.

testauthconfig

Tests the authentication settings for a given authentication realm against the authentication servers defined
in the realm.
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testauthconfig [-d level] [realm name]

Running the command without any option causes the appliance to list the configured authentication realms
from which you can make a selection.

The debug flag ( -d ) controls the level of debug information. The levels can range between 0-10. If
unspecified, the appliance uses a level of 0. With level 0, the command will return success or failure. If the
test settings fail, the command will list the cause of the failure.

Cisco recommends you use level 0. Only use a different debug level when you need more detailed information
to troubleshoot.

Note

tuiconfig tuistatus

These two commands are documented in Using the CLI to Configure Advanced Transparent User Identification
Settings, on page 91.

traceroute

Traces IP packets through gateways and along the path to a destination host.

trailblazerconfig

You can use the trailblazerconfig command to route your incoming and outgoing connections through
HTTP and HTTPS ports on the new web interface.

By default, trailblazerconfig CLI command is enabled on your appliance. You can see the inline help by
typing the command: help trailblazerconfig.

Note

The syntax is as follows:

trailblazerconfig enable <https_port> <http_port>

trailblazerconfig disable

trailblazerconfig status

Where:

'enable' runs the trailblazer on the default ports (HTTPS: 4431 or HTTP: 801).

'disable' terminates the trailblazer

'status' checks the status of the trailblazer.

If you have enabled trailblazerconfig command on the appliance, the request URL will contain the
HTTP/HTTPS port number appended to the hostname.

Note

You can try any one of the following steps to make the navigation in your browser seamless:
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• Accept the certificate used by the web interface and use the following URL syntax:
https://hostname:<https_api_port> (for example, https://some.example.com:6443) in a new
browser window and accept the certificate. Here <https_api_port> is the AsyncOS API HTTPS port
configured in Network > IP Interfaces. Also, ensure that the API ports (HTTP/HTTPS) are opened on
the firewall.

• By default, trailblazerconfig CLI command is enabled on your appliance. Make sure that the
HTTP/HTTPS ports are opened on the firewall. Also ensure that your DNS server can resolve the hostname
that you specified for accessing the appliance.

If the trailblazerconfig CLI command is disabled, you can run the trailblazerconfig > enable
command using the CLI to avoid the following issues:

• Requiring to add multiple certificates for API ports in certain browsers.

• Redirecting to the legacy web interface when you refresh the Spam quarantine, Safelist or Blocklist
page.

• Metrics bar on the Advanced Malware Protection report page does not contain any data.

updateconfig

Configure update and upgrade settings.

updatenow

Update all components.

upgrade

Install the Async OS software upgrade.

downloadinstall – Download and immediately install an upgrade package.

download – Download and save upgrade package for installation later.

After you enter either of these commands, a list of upgrade packages applicable for this WSA is displayed.
Select the desired package by entering its entry number and then pressing Enter; download begins in the
background. During download, additional subcommands are available: downloadstatus and canceldownload.

When download is complete, if you initially entered downloadinstall, installation begins immediately. If
you entered download, two additional commands are available when download is complete: install and
delete. Enter install to begin installing a previously downloaded package. Use delete to remove the
previously downloaded package from the WSA.

userconfig

Configure system administrators.

version

Displays general system information, installed versions of system software, and rule definitions.

wccpstat

all - Displays details of all WCCP (Web Cache Communication Protocol) service groups.
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servicegroup - Displays details of a specific WCCP service group.

webcache

Examine or modify the contents of the proxy cache, or configure domains and URLs that the appliance never
caches. Allows an administrator to remove a particular URL from the proxy cache or specify which domains
or URLs to never store in the proxy cache.

who

Displays users logged into the system, for both CLI and Web interface sessions.

Individual users can have a maximum of 10 concurrent sessions.Note

whoami

Displays user information.
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A P P E N D I X C
Additional Information

This appendix contains the following sections:

• Cisco Notification Service , on page 523
• Documentation Set, on page 523
• Training, on page 524
• Knowledge Base Articles (TechNotes) , on page 524
• Cisco Support Community, on page 524
• Customer Support , on page 524
• Registering for a Cisco Account to Access Resources , on page 525
• Cisco Welcomes Your Comments, on page 525
• Third Party Contributors, on page 525

Cisco Notification Service
Sign up to receive notifications relevant to your Cisco Content Security Appliances, such as Security Advisories,
Field Notices, End of Sale and End of Support statements, and information about software updates and known
issues.

You can specify options such as notification frequency and types of information to receive. You should sign
up separately for notifications for each product that you use.

To sign up, visit http://www.cisco.com/cisco/support/notifications.html

A Cisco.com account is required. If you do not have one, see Registering for a Cisco Account to Access
Resources , on page 525.

Documentation Set
Related documentation for Cisco Web Security Appliances is available from the following locations:

LinkProduct

http://www.cisco.com/c/en/us/support/security/
web-security-appliance/tsd-products-support-series-home.html

Web Security appliances

(Includes hardware documentation.)
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LinkProduct

http://www.cisco.com/c/en/us/support/security/
content-security-management-appliance/
tsd-products-support-series-home.html

Content Security Management appliances

(Includes hardware documentation.)

http://www.cisco.com/c/en/us/support/security/
cloud-web-security/tsd-products-support-series-home.html

Cisco Cloud Web Security

(Includes hardware documentation.)

Training
Training for Cisco email and web security products:

http://www.cisco.com/c/en/us/training-events/training-certifications/supplemental-training/
email-and-web-security.html

Knowledge Base Articles (TechNotes)

Step 1 Go to the main product page ( http://www.cisco.com/c/en/us/support/security/web-security-appliance/
tsd-products-support-series-home.html).

Step 2 Look for links with TechNotes in the name.

Cisco Support Community
Access the Cisco Support Community for web security and associated management at the following URL:

https://supportforums.cisco.com/community/5786/web-security

The Cisco Support Community is a place to discuss general web security issues as well as technical information
about specific Cisco products. For example, posts may include troubleshooting videos.

Customer Support
Cisco TAC: http://www.cisco.com/en/US/support/tsd_cisco_worldwide_contacts.html

Support site for legacy IronPort: http://www.cisco.com/web/services/acquisitions/ironport.html

For instructions for virtual appliances, see the Cisco Content Security Virtual Appliance Installation Guide.

For non-critical issues, you can also open a support case from the appliance.

Related Topics

• Working With Support , on page 495
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Registering for a Cisco Account to Access Resources
Access to many resources on Cisco.com requires a Cisco account.

If you do not have a Cisco.com User ID, you can register for one here: https://tools.cisco.com/RPF/register/
register.do

Cisco Welcomes Your Comments
The Cisco Technical Publications team is interested in improving the product documentation. Your comments
and suggestions are always welcome. You can send comments to the following email address:
contentsecuritydocs@cisco.com

Please include the title of this book and the publication date from the title page in the subject line of your
message.

Third Party Contributors
Some software included within AsyncOS is distributed under the terms, notices, and conditions of software
license agreements of FreeBSD, Inc., Stichting Mathematisch Centrum, Corporation for National Research
Initiatives, Inc., and other third party contributors, and all such terms and conditions are incorporated in license
agreements. The full text of these agreements can be found here:

https://support.ironport.com/3rdparty/AsyncOS_User_Guide-1-1.html

Portions of the software within AsyncOS is based upon the RRDtool with the express written consent of Tobi
Oetiker.

Portions of this document are reproduced with permission of Dell Computer Corporation. Portions of this
document are reproduced with permission of McAfee, Inc. Portions of this document are reproduced with
permission of Sophos Plc.
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A P P E N D I X D
End User License Agreement

This appendix contains the following sections:

• Cisco Systems End User License Agreement , on page 527
• Supplemental End User License Agreement for Cisco Systems Content Security Software , on page 533

Cisco Systems End User License Agreement
IMPORTANT: PLEASE READ THIS END USER LICENSE AGREEMENT CAREFULLY. IT IS
VERY IMPORTANT THAT YOU CHECK THAT YOU ARE PURCHASING CISCO SOFTWARE
OR EQUIPMENT FROM AN APPROVED SOURCE AND THAT YOU, OR THE ENTITY YOU
REPRESENT (COLLECTIVELY, THE "CUSTOMER") HAVE BEEN REGISTERED AS THE END
USER FOR THE PURPOSES OF THIS CISCO END USER LICENSE AGREEMENT. IF YOU ARE
NOT REGISTERED AS THE END USER YOU HAVE NO LICENSE TO USE THE SOFTWARE
AND THE LIMITED WARRANTY IN THIS END USER LICENSE AGREEMENT DOES NOT
APPLY. ASSUMING YOU HAVE PURCHASED FROM AN APPROVED SOURCE, DOWNLOADING,
INSTALLING OR USING CISCO OR CISCO-SUPPLIED SOFTWARE CONSTITUTES
ACCEPTANCE OF THIS AGREEMENT.

CISCO SYSTEMS, INC. OR ITS SUBSIDIARY LICENSING THE SOFTWARE INSTEAD OF CISCO
SYSTEMS, INC. ("CISCO") IS WILLING TO LICENSE THIS SOFTWARE TO YOU ONLY UPON THE
CONDITION THAT YOU PURCHASED THE SOFTWARE FROM AN APPROVED SOURCE AND
THATYOUACCEPTALLOFTHETERMSCONTAINED INTHIS ENDUSERLICENSEAGREEMENT
PLUS ANY ADDITIONAL LIMITATIONS ON THE LICENSE SET FORTH IN A SUPPLEMENTAL
LICENSE AGREEMENT ACCOMPANYING THE PRODUCT OR AVAILABLE AT THE TIME OF
YOUR ORDER (COLLECTIVELY THE "AGREEMENT"). TO THE EXTENT OF ANY CONFLICT
BETWEEN THE TERMS OF THIS END USER LICENSE AGREEMENT AND ANY SUPPLEMENTAL
LICENSE AGREEMENT, THE SUPPLEMENTAL LICENSE AGREEMENT SHALL APPLY. BY
DOWNLOADING, INSTALLING, OR USING THE SOFTWARE, YOU ARE REPRESENTING THAT
YOU PURCHASED THE SOFTWARE FROM AN APPROVED SOURCE AND BINDING YOURSELF
TO THE AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE TERMS OF THE AGREEMENT,
THEN CISCO IS UNWILLING TO LICENSE THE SOFTWARE TO YOU AND (A) YOU MAY NOT
DOWNLOAD, INSTALL OR USE THE SOFTWARE, AND (B) YOU MAY RETURN THE SOFTWARE
(INCLUDING ANY UNOPENED CD PACKAGE AND ANYWRITTEN MATERIALS) FOR A FULL
REFUND, OR, IF THE SOFTWARE AND WRITTEN MATERIALS ARE SUPPLIED AS PART OF
ANOTHER PRODUCT, YOUMAY RETURN THE ENTIRE PRODUCT FOR A FULL REFUND. YOUR
RIGHT TO RETURN AND REFUND EXPIRES 30 DAYS AFTER PURCHASE FROM AN APPROVED
SOURCE, AND APPLIES ONLY IF YOU ARE THE ORIGINAL AND REGISTERED END USER
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PURCHASER. FOR THE PURPOSES OF THIS END USER LICENSE AGREEMENT, AN "APPROVED
SOURCE"MEANS (A) CISCO; OR (B) ADISTRIBUTOROR SYSTEMS INTEGRATORAUTHORIZED
BY CISCO TO DISTRIBUTE / SELL CISCO EQUIPMENT, SOFTWARE AND SERVICES WITHIN
YOUR TERRITORY TO END USERS; OR (C) A RESELLER AUTHORIZED BY ANY SUCH
DISTRIBUTOR OR SYSTEMS INTEGRATOR IN ACCORDANCE WITH THE TERMS OF THE
DISTRIBUTOR'S AGREEMENT WITH CISCO TO DISTRIBUTE / SELL THE CISCO EQUIPMENT,
SOFTWARE AND SERVICES WITHIN YOUR TERRITORY TO END USERS.

THE FOLLOWING TERMS OF THE AGREEMENT GOVERN CUSTOMER'S USE OF THE SOFTWARE
(DEFINED BELOW), EXCEPT TO THE EXTENT: (A) THERE IS A SEPARATE SIGNED CONTRACT
BETWEEN CUSTOMER AND CISCO GOVERNING CUSTOMER'S USE OF THE SOFTWARE, OR (B) THE
SOFTWARE INCLUDES A SEPARATE "CLICK-ACCEPT" LICENSE AGREEMENT OR THIRD PARTY
LICENSE AGREEMENT AS PART OF THE INSTALLATION OR DOWNLOAD PROCESS GOVERNING
CUSTOMER'S USE OF THE SOFTWARE. TO THE EXTENT OF A CONFLICT BETWEEN THE PROVISIONS
OF THE FOREGOING DOCUMENTS, THE ORDER OF PRECEDENCE SHALL BE (1)THE SIGNED
CONTRACT, (2) THE CLICK-ACCEPT AGREEMENT OR THIRD PARTY LICENSE AGREEMENT, AND
(3) THE AGREEMENT. FOR PURPOSES OF THE AGREEMENT, "SOFTWARE" SHALL MEAN COMPUTER
PROGRAMS, INCLUDING FIRMWARE AND COMPUTER PROGRAMS EMBEDDED IN CISCO
EQUIPMENT, AS PROVIDED TO CUSTOMER BY AN APPROVED SOURCE, AND ANY UPGRADES,
UPDATES, BUG FIXES OR MODIFIED VERSIONS THERETO (COLLECTIVELY, "UPGRADES"), ANY
OF THE SAME WHICH HAS BEEN RELICENSED UNDER THE CISCO SOFTWARE TRANSFER AND
RE-LICENSING POLICY (AS MAY BE AMENDED BY CISCO FROM TIME TO TIME) OR BACKUP COPIES
OF ANY OF THE FOREGOING.

License. Conditioned upon compliance with the terms and conditions of the Agreement, Cisco grants to
Customer a nonexclusive and nontransferable license to use for Customer's internal business purposes the
Software and the Documentation for which Customer has paid the required license fees to an Approved Source.
"Documentation"means written information (whether contained in user or technical manuals, trainingmaterials,
specifications or otherwise) pertaining to the Software and made available by an Approved Source with the
Software in any manner (including on CD-Rom, or on-line). In order to use the Software, Customer may be
required to input a registration number or product authorization key and register Customer's copy of the
Software online at Cisco's website to obtain the necessary license key or license file.

Customer's license to use the Software shall be limited to, and Customer shall not use the Software in excess
of, a single hardware chassis or card or such other limitations as are set forth in the applicable Supplemental
License Agreement or in the applicable purchase order which has been accepted by an Approved Source and
for which Customer has paid to an Approved Source the required license fee (the "Purchase Order").

Unless otherwise expressly provided in the Documentation or any applicable Supplemental License Agreement,
Customer shall use the Software solely as embedded in, for execution on, or (where the applicable
Documentation permits installation on non-Cisco equipment) for communication with Cisco equipment owned
or leased by Customer and used for Customer's internal business purposes. No other licenses are granted by
implication, estoppel or otherwise.

For evaluation or beta copies for which Cisco does not charge a license fee, the above requirement to pay
license fees does not apply.

General Limitations. This is a license, not a transfer of title, to the Software and Documentation, and Cisco
retains ownership of all copies of the Software and Documentation. Customer acknowledges that the Software
and Documentation contain trade secrets of Cisco or its suppliers or licensors, including but not limited to the
specific internal design and structure of individual programs and associated interface information. Except as
otherwise expressly provided under the Agreement, Customer shall only use the Software in connection with
the use of Cisco equipment purchased by the Customer from an Approved Source and Customer shall have
no right, and Customer specifically agrees not to:
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(i) transfer, assign or sublicense its license rights to any other person or entity (other than in compliance with
any Cisco relicensing/transfer policy then in force), or use the Software on Cisco equipment not purchased
by the Customer from an Approved Source or on secondhand Cisco equipment, and Customer acknowledges
that any attempted transfer, assignment, sublicense or use shall be void;

(ii) make error corrections to or otherwise modify or adapt the Software or create derivative works based upon
the Software, or permit third parties to do the same;

(iii) reverse engineer or decompile, decrypt, disassemble or otherwise reduce the Software to human-readable
form, except to the extent otherwise expressly permitted under applicable law notwithstanding this restriction
or except to the extent that Cisco is legally required to permit such specific activity pursuant to any applicable
open source license;

(iv) publish any results of benchmark tests run on the Software;

(v) use or permit the Software to be used to perform services for third parties, whether on a service bureau or
time sharing basis or otherwise, without the express written authorization of Cisco; or

(vi) disclose, provide, or otherwise make available trade secrets contained within the Software and
Documentation in any form to any third party without the prior written consent of Cisco. Customer shall
implement reasonable security measures to protect such trade secrets.

To the extent required by applicable law, and at Customer's written request, Cisco shall provide Customer
with the interface information needed to achieve interoperability between the Software and another
independently created program, on payment of Cisco's applicable fee, if any. Customer shall observe strict
obligations of confidentiality with respect to such information and shall use such information in compliance
with any applicable terms and conditions upon which Cisco makes such information available.

Software, Upgrades and Additional Copies.NOTWITHSTANDINGANYOTHER PROVISIONOF THE
AGREEMENT: (1) CUSTOMERHASNOLICENSEORRIGHTTOMAKEORUSEANYADDITIONAL
COPIES OR UPGRADES UNLESS CUSTOMER, AT THE TIME OF MAKING OR ACQUIRING SUCH
COPY OR UPGRADE, ALREADY HOLDS A VALID LICENSE TO THE ORIGINAL SOFTWARE AND
HAS PAID THE APPLICABLE FEE TO AN APPROVED SOURCE FOR THE UPGRADE OR
ADDITIONAL COPIES; (2) USE OF UPGRADES IS LIMITED TO CISCO EQUIPMENT SUPPLIED BY
AN APPROVED SOURCE FOR WHICH CUSTOMER IS THE ORIGINAL END USER PURCHASER
OR LESSEE OR OTHERWISE HOLDS A VALID LICENSE TO USE THE SOFTWARE WHICH IS
BEING UPGRADED; AND (3) THE MAKING AND USE OF ADDITIONAL COPIES IS LIMITED TO
NECESSARY BACKUP PURPOSES ONLY.

Proprietary Notices. Customer agrees to maintain and reproduce all copyright, proprietary, and other notices
on all copies, in any form, of the Software in the same form and manner that such copyright and other
proprietary notices are included on the Software. Except as expressly authorized in the Agreement, Customer
shall not make any copies or duplicates of any Software without the prior written permission of Cisco.

Term and Termination. The Agreement and the license granted herein shall remain effective until terminated.
Customer may terminate the Agreement and the license at any time by destroying all copies of Software and
any Documentation. Customer's rights under the Agreement will terminate immediately without notice from
Cisco if Customer fails to comply with any provision of the Agreement. Upon termination, Customer shall
destroy all copies of Software and Documentation in its possession or control. All confidentiality obligations
of Customer, all restrictions and limitations imposed on the Customer under the section titled "General
Limitations" and all limitations of liability and disclaimers and restrictions of warranty shall survive termination
of this Agreement. In addition, the provisions of the sections titled "U.S. Government End User Purchasers"
and "General Terms Applicable to the Limited Warranty Statement and End User License Agreement" shall
survive termination of the Agreement.
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Customer Records.Customer grants to Cisco and its independent accountants the right to examine Customer's
books, records and accounts during Customer's normal business hours to verify compliancewith this Agreement.
In the event such audit discloses non-compliance with this Agreement, Customer shall promptly pay to Cisco
the appropriate license fees, plus the reasonable cost of conducting the audit.

Export, Re-Export, Transfer and Use Controls.The Software, Documentation and technology or direct products
thereof (hereafter referred to as Software and Technology), supplied by Cisco under the Agreement are subject
to export controls under the laws and regulations of the United States (U.S.) and any other applicable countries'
laws and regulations. Customer shall comply with such laws and regulations governing export, re-export,
transfer and use of Cisco Software and Technology and will obtain all required U.S. and local authorizations,
permits, or licenses. Cisco and Customer each agree to provide the other information, support documents,
and assistance as may reasonably be required by the other in connection with securing authorizations or
licenses. Information regarding compliance with export, re-export, transfer and use may be located at the
following URL:

https://www.cisco.com/web/about/doing_business/legal/global_export_trade/general_export/contract_
compliance.html

U.S. Government End User Purchasers. The Software and Documentation qualify as "commercial items," as
that term is defined at Federal Acquisition Regulation ("FAR") (48 C.F.R.) 2.101, consisting of "commercial
computer software" and "commercial computer software documentation" as such terms are used in FAR
12.212. Consistent with FAR 12.212 andDoDFARSupp. 227.7202-1 through 227.7202-4, and notwithstanding
any other FAR or other contractual clause to the contrary in any agreement into which the Agreement may
be incorporated, Customer may provide to Government end user or, if the Agreement is direct, Government
end user will acquire, the Software and Documentation with only those rights set forth in the Agreement. Use
of either the Software or Documentation or both constitutes agreement by the Government that the Software
and Documentation are "commercial computer software" and "commercial computer software documentation,"
and constitutes acceptance of the rights and restrictions herein.

Identified Components; Additional Terms. The Software may contain or be delivered with one or more
components, which may include third-party components, identified by Cisco in the Documentation, readme.txt
file, third-party click-accept or elsewhere (e.g. on https://www.cisco.com/ ) (the "Identified Component(s)")
as being subject to different license agreement terms, disclaimers of warranties, limited warranties or other
terms and conditions (collectively, "Additional Terms") than those set forth herein. You agree to the applicable
Additional Terms for any such Identified Component(s)."

Limited Warranty

Subject to the limitations and conditions set forth herein, Cisco warrants that commencing from the date of
shipment to Customer (but in case of resale by an Approved Source other than Cisco, commencing not more
than ninety (90) days after original shipment by Cisco), and continuing for a period of the longer of (a) ninety
(90) days or (b) the warranty period (if any) expressly set forth as applicable specifically to software in the
warranty card accompanying the product of which the Software is a part (the "Product") (if any): (a) the media
on which the Software is furnished will be free of defects in materials and workmanship under normal use;
and (b) the Software substantially conforms to the Documentation. The date of shipment of a Product by Cisco
is set forth on the packaging material in which the Product is shipped. Except for the foregoing, the Software
is provided "AS IS". This limited warranty extends only to the Software purchased from an Approved Source
by a Customer who is the first registered end user. Customer's sole and exclusive remedy and the entire liability
of Cisco and its suppliers under this limited warranty will be (i) replacement of defective media and/or (ii) at
Cisco's option, repair, replacement, or refund of the purchase price of the Software, in both cases subject to
the condition that any error or defect constituting a breach of this limited warranty is reported to the Approved
Source supplying the Software to Customer, within the warranty period. Cisco or the Approved Source
supplying the Software to Customer may, at its option, require return of the Software and/or Documentation
as a condition to the remedy. In no event does Cisco warrant that the Software is error free or that Customer
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will be able to operate the Software without problems or interruptions. In addition, due to the continual
development of new techniques for intruding upon and attacking networks, Cisco does not warrant that the
Software or any equipment, system or network on which the Software is used will be free of vulnerability to
intrusion or attack.

Restrictions. This warranty does not apply if the Software, Product or any other equipment upon which the
Software is authorized to be used (a) has been altered, except by Cisco or its authorized representative, (b)
has not been installed, operated, repaired, or maintained in accordance with instructions supplied by Cisco,
(c) has been subjected to abnormal physical or electrical stress, abnormal environmental conditions, misuse,
negligence, or accident; or (d) is licensed for beta, evaluation, testing or demonstration purposes. The Software
warranty also does not apply to (e) any temporary Software modules; (f) any Software not posted on Cisco's
Software Center; (g) any Software that Cisco expressly provides on an "AS IS" basis on Cisco's Software
Center; (h) any Software for which an Approved Source does not receive a license fee; and (i) Software
supplied by any third party which is not an Approved Source.

DISCLAIMER OF WARRANTY

EXCEPT AS SPECIFIED IN THIS WARRANTY SECTION, ALL EXPRESS OR IMPLIED
CONDITIONS, REPRESENTATIONS, AND WARRANTIES INCLUDING, WITHOUT LIMITATION,
ANY IMPLIED WARRANTY OR CONDITION OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, NON-INFRINGEMENT, SATISFACTORY QUALITY,
NON-INTERFERENCE, ACCURACY OF INFORMATIONAL CONTENT, OR ARISING FROM A
COURSE OF DEALING, LAW, USAGE, OR TRADE PRACTICE, ARE HEREBY EXCLUDED TO
THE EXTENT ALLOWED BY APPLICABLE LAW AND ARE EXPRESSLY DISCLAIMED BY
CISCO, ITS SUPPLIERS AND LICENSORS. TO THE EXTENT THAT ANY OF THE SAME
CANNOT BE EXCLUDED, SUCH IMPLIED CONDITION, REPRESENTATION AND/OR
WARRANTY IS LIMITED IN DURATION TO THE EXPRESS WARRANTY PERIOD REFERRED
TO IN THE "LIMITED WARRANTY" SECTION ABOVE. BECAUSE SOME STATES OR
JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY
LASTS, THE ABOVE LIMITATION MAY NOT APPLY IN SUCH STATES. THIS WARRANTY
GIVES CUSTOMER SPECIFIC LEGAL RIGHTS, AND CUSTOMER MAY ALSO HAVE OTHER
RIGHTS WHICH VARY FROM JURISDICTION TO JURISDICTION. This disclaimer and exclusion
shall apply even if the express warranty set forth above fails of its essential purpose.

Disclaimer of Liabilities - Limitation of Liability. IF YOUACQUIRED THE SOFTWARE IN THE UNITED
STATES, LATIN AMERICA, CANADA, JAPAN OR THE CARIBBEAN, NOTWITHSTANDING
ANYTHING ELSE IN THE AGREEMENT TO THE CONTRARY, ALL LIABILITY OF CISCO, ITS
AFFILIATES, OFFICERS, DIRECTORS, EMPLOYEES, AGENTS, SUPPLIERS AND LICENSORS
COLLECTIVELY, TO CUSTOMER, WHETHER IN CONTRACT, TORT (INCLUDING NEGLIGENCE),
BREACHOFWARRANTYOROTHERWISE, SHALLNOTEXCEEDTHEPRICEPAIDBYCUSTOMER
TO ANY APPROVED SOURCE FOR THE SOFTWARE THAT GAVE RISE TO THE CLAIM OR IF THE
SOFTWARE IS PART OF ANOTHER PRODUCT, THE PRICE PAID FOR SUCH OTHER PRODUCT.
THIS LIMITATION OF LIABILITY FOR SOFTWARE IS CUMULATIVE AND NOT PER INCIDENT
(I.E. THE EXISTENCE OF TWO OR MORE CLAIMS WILL NOT ENLARGE THIS LIMIT).

IFYOUACQUIREDTHESOFTWARE INEUROPE, THEMIDDLEEAST,AFRICA,ASIAOROCEANIA,
NOTWITHSTANDINGANYTHINGELSE INTHEAGREEMENTTOTHECONTRARY,ALLLIABILITY
OF CISCO, ITS AFFILIATES, OFFICERS, DIRECTORS, EMPLOYEES, AGENTS, SUPPLIERS AND
LICENSORS COLLECTIVELY, TO CUSTOMER, WHETHER IN CONTRACT, TORT (INCLUDING
NEGLIGENCE), BREACH OF WARRANTY OR OTHERWISE, SHALL NOT EXCEED THE PRICE
PAID BY CUSTOMER TO CISCO FOR THE SOFTWARE THAT GAVE RISE TO THE CLAIM OR IF
THESOFTWARE IS PARTOFANOTHERPRODUCT, THEPRICEPAIDFORSUCHOTHERPRODUCT.
THIS LIMITATION OF LIABILITY FOR SOFTWARE IS CUMULATIVE AND NOT PER INCIDENT
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(I.E. THE EXISTENCE OF TWO ORMORE CLAIMS WILL NOT ENLARGE THIS LIMIT). NOTHING
IN THE AGREEMENT SHALL LIMIT (I) THE LIABILITY OF CISCO, ITS AFFILIATES, OFFICERS,
DIRECTORS,EMPLOYEES,AGENTS, SUPPLIERSANDLICENSORSTOCUSTOMERFORPERSONAL
INJURYORDEATHCAUSEDBYTHEIRNEGLIGENCE, (II) CISCO'S LIABILITYFORFRAUDULENT
MISREPRESENTATION, OR (III) ANY LIABILITY OF CISCO WHICH CANNOT BE EXCLUDED
UNDER APPLICABLE LAW.

Disclaimer of Liabilities - Waiver of Consequential Damages and Other Losses. IF YOU ACQUIRED THE
SOFTWARE IN THE UNITED STATES, LATIN AMERICA, THE CARIBBEAN OR CANADA,
REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL
PURPOSE OR OTHERWISE, IN NO EVENTWILL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY
LOST REVENUE, PROFIT, OR LOST OR DAMAGED DATA, BUSINESS INTERRUPTION, LOSS OF
CAPITAL,ORFORSPECIAL, INDIRECT,CONSEQUENTIAL, INCIDENTAL,ORPUNITIVEDAMAGES
HOWEVERCAUSEDANDREGARDLESSOFTHETHEORYOFLIABILITYORWHETHERARISING
OUT OF THE USE OF OR INABILITY TO USE SOFTWARE OR OTHERWISE AND EVEN IF CISCO
OR ITS SUPPLIERS OR LICENSORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. BECAUSE SOME STATES OR JURISDICTIONS DO NOT ALLOW LIMITATION OR
EXCLUSION OF CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONMAY
NOT APPLY TO YOU.

IF YOU ACQUIRED THE SOFTWARE IN JAPAN, EXCEPT FOR LIABILITY ARISING OUT OF OR
IN CONNECTION WITH DEATH OR PERSONAL INJURY, FRAUDULENT MISREPRESENTATION,
AND REGARDLESS OFWHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL
PURPOSEOROTHERWISE, INNOEVENTWILLCISCO, ITSAFFILIATES, OFFICERS, DIRECTORS,
EMPLOYEES, AGENTS, SUPPLIERS AND LICENSORS BE LIABLE FOR ANY LOST REVENUE,
PROFIT, OR LOST OR DAMAGED DATA, BUSINESS INTERRUPTION, LOSS OF CAPITAL, OR FOR
SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL, OR PUNITIVE DAMAGES HOWEVER
CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY OR WHETHER ARISING OUT OF
THE USE OF OR INABILITY TO USE SOFTWARE OR OTHERWISE AND EVEN IF CISCO OR ANY
APPROVED SOURCE OR THEIR SUPPLIERS OR LICENSORS HAVE BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

IFYOUACQUIREDTHESOFTWARE INEUROPE, THEMIDDLEEAST,AFRICA,ASIAOROCEANIA,
IN NO EVENT WILL CISCO, ITS AFFILIATES, OFFICERS, DIRECTORS, EMPLOYEES, AGENTS,
SUPPLIERS AND LICENSORS, BE LIABLE FOR ANY LOST REVENUE, LOST PROFIT, OR LOST
ORDAMAGEDDATA,BUSINESS INTERRUPTION,LOSSOFCAPITAL,ORFORSPECIAL, INDIRECT,
CONSEQUENTIAL, INCIDENTAL,ORPUNITIVEDAMAGES,HOWSOEVERARISING, INCLUDING,
WITHOUTLIMITATION, INCONTRACT,TORT (INCLUDINGNEGLIGENCE)ORWHETHERARISING
OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE, EVEN IF, IN EACH CASE, CISCO,
ITS AFFILIATES, OFFICERS, DIRECTORS, EMPLOYEES, AGENTS, SUPPLIERS AND LICENSORS,
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES OR
JURISDICTIONS DO NOT ALLOW LIMITATION OR EXCLUSION OF CONSEQUENTIAL OR
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT FULLY APPLY TO YOU. THE
FOREGOING EXCLUSION SHALL NOT APPLY TO ANY LIABILITY ARISING OUT OF OR IN
CONNECTIONWITH: (I) DEATHORPERSONAL INJURY, (II) FRAUDULENTMISREPRESENTATION,
OR (III) CISCO'S LIABILITY IN CONNECTIONWITHANY TERMS THAT CANNOT BE EXCLUDED
UNDER APPLICABLE LAW.

Customer acknowledges and agrees that Cisco has set its prices and entered into the Agreement in reliance
upon the disclaimers of warranty and the limitations of liability set forth herein, that the same reflect an
allocation of risk between the parties (including the risk that a contract remedy may fail of its essential purpose
and cause consequential loss), and that the same form an essential basis of the bargain between the parties.
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Controlling Law, Jurisdiction. If you acquired, by reference to the address on the purchase order accepted by
the Approved Source, the Software in the United States, Latin America, or the Caribbean, the Agreement and
warranties ("Warranties") are controlled by and construed under the laws of the State of California, United
States of America, notwithstanding any conflicts of law provisions; and the state and federal courts of California
shall have exclusive jurisdiction over any claim arising under the Agreement or Warranties. If you acquired
the Software in Canada, unless expressly prohibited by local law, the Agreement andWarranties are controlled
by and construed under the laws of the Province of Ontario, Canada, notwithstanding any conflicts of law
provisions; and the courts of the Province of Ontario shall have exclusive jurisdiction over any claim arising
under the Agreement or Warranties. If you acquired the Software in Europe, the Middle East, Africa, Asia or
Oceania (excluding Australia), unless expressly prohibited by local law, the Agreement and Warranties are
controlled by and construed under the laws of England, notwithstanding any conflicts of law provisions; and
the English courts shall have exclusive jurisdiction over any claim arising under the Agreement orWarranties.
In addition, if the Agreement is controlled by the laws of England, no person who is not a party to the Agreement
shall be entitled to enforce or take the benefit of any of its terms under the Contracts (Rights of Third Parties)
Act 1999. If you acquired the Software in Japan, unless expressly prohibited by local law, the Agreement and
Warranties are controlled by and construed under the laws of Japan, notwithstanding any conflicts of law
provisions; and the Tokyo District Court of Japan shall have exclusive jurisdiction over any claim arising
under the Agreement or Warranties. If you acquired the Software in Australia, unless expressly prohibited by
local law, the Agreement and Warranties are controlled by and construed under the laws of the State of New
South Wales, Australia, notwithstanding any conflicts of law provisions; and the State and federal courts of
New SouthWales shall have exclusive jurisdiction over any claim arising under the Agreement orWarranties.
If you acquired the Software in any other country, unless expressly prohibited by local law, the Agreement
and Warranties are controlled by and construed under the laws of the State of California, United States of
America, notwithstanding any conflicts of law provisions; and the state and federal courts of California shall
have exclusive jurisdiction over any claim arising under the Agreement or Warranties.

For all countries referred to above, the parties specifically disclaim the application of the UN Convention on
Contracts for the International Sale of Goods. Notwithstanding the foregoing, either party may seek interim
injunctive relief in any court of appropriate jurisdiction with respect to any alleged breach of such party's
intellectual property or proprietary rights. If any portion hereof is found to be void or unenforceable, the
remaining provisions of the Agreement andWarranties shall remain in full force and effect. Except as expressly
provided herein, the Agreement constitutes the entire agreement between the parties with respect to the license
of the Software and Documentation and supersedes any conflicting or additional terms contained in any
Purchase Order or elsewhere, all of which terms are excluded. The Agreement has been written in the English
language, and the parties agree that the English version will govern.

Product warranty terms and other information applicable to Cisco products are available at the following
URL:

http://www.cisco.com/go/warranty

Supplemental End User License Agreement for Cisco Systems
Content Security Software

IMPORTANT: READ CAREFULLY

This Supplemental End User License Agreement ("SEULA") contains additional terms and conditions for the
Software product licensed under the End User License Agreement ("EULA") between You ("You" as used
herein means You and the business entity you represent or "Company") and Cisco (collectively, the
"Agreement"). Capitalized terms used in this SEULA but not defined will have the meanings assigned to them
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in the EULA. To the extent that there is a conflict between the terms and conditions of the EULA and this
SEULA, the terms and conditions of this SEULA will take precedence.

In addition to the limitations set forth in the EULA on your access and use of the Software, you agree to
comply at all times with the terms and conditions provided in this SEULA.

DOWNLOADING, INSTALLING, OR USING THE SOFTWARE CONSTITUTES ACCEPTANCE OF
THE AGREEMENT, AND YOU ARE BINDING YOURSELF AND THE BUSINESS ENTITY THAT
YOU REPRESENT TO THE AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE TERMS OF
THE AGREEMENT, THEN CISCO IS UNWILLING TO LICENSE THE SOFTWARE TO YOU AND (A)
YOU MAY NOT DOWNLOAD, INSTALL OR USE THE SOFTWARE, AND (B) YOU MAY RETURN
THESOFTWARE (INCLUDINGANYUNOPENEDCDPACKAGEANDANYWRITTENMATERIALS)
FOR A FULL REFUND, OR, IF THE SOFTWARE AND WRITTEN MATERIALS ARE SUPPLIED AS
PARTOFANOTHERPRODUCT,YOUMAYRETURNTHEENTIREPRODUCTFORAFULLREFUND.
YOUR RIGHT TO RETURN AND REFUND EXPIRES 30 DAYS AFTER PURCHASE FROM CISCO
OR AN AUTHORIZED CISCO RESELLER, AND APPLIES ONLY IF YOU ARE THE ORIGINAL END
USER PURCHASER.

For purposes of this SEULA, the Product name and the Product description You have ordered is any of the
following Cisco Systems Email Security Appliance ("ESA"), Cisco SystemsWeb Security Appliance ("WSA")
and Cisco Systems Security Management Application ("SMA") (collectively, "Content Security") and their
Virtual Appliance equivalent ("Software"):

Cisco AsyncOS for Email

Cisco AsyncOS for Web

Cisco AsyncOS for Management

Cisco Email Anti-Spam, Sophos Anti-Virus

Cisco Email Outbreak Filters

Cloudmark Anti-Spam

Cisco Image Analyzer

McAfee Anti-Virus

Cisco Intelligent Multi-Scan

Cisco Data Loss Prevention

Cisco Email Encryption

Cisco Email Delivery Mode

Cisco Web Usage Controls

Cisco Web Reputation

Sophos Anti-Malware

Webroot Anti-Malware

McAfee Anti-Malware

Cisco Email Reporting

Cisco Email Message Tracking

Cisco Email Centralized Quarantine
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Cisco Web Reporting

Cisco Web Policy and Configuration Management

Cisco Advanced Web Security Management with Splunk

Email Encryption for Encryption Appliances

Email Encryption for System Generated Bulk Email

Email Encryption and Public Key Encryption for Encryption Appliances

Large Attachment Handling for Encryption Appliances

Secure Mailbox License for Encryption Appliances

Definitions

For purposes of this SEULA, the following definitions apply:

"Company Service" means the Company's email, Internet, security management services provided to End
Users for the purposes of conducting Company's internal business.

"End User" means: (1) for theWSA and SMA, the employee, contractor or other agent authorized by Company
to access the Internet and the SMA via the Company Service; and (2) for the ESA, the email boxes of the
employees, contractors, or other agent authorized by Company to access or use the email services via the
Company Service.

"Ordering Document" means the purchase agreement, evaluation agreement, beta, pre-release agreement or
similar agreement between the Company and Cisco or the Company and a Cisco reseller, or the valid terms
of any purchase order accepted by Cisco in connection therewith, containing the purchase terms for the
Software license granted by this Agreement.

"Personally Identifiable Information" means any information that can be used to identify an individual,
including, but not limited to, an individual's name, user name, email address and any other personally identifiable
information.

"Server" means a single physical computer or devices on a network that manages or provides network resources
for multiple users.

"Services" means Cisco Software Subscription Services.

"Service Description" means the description of the Software Subscription Support Services at
https://www.cisco.com/c/en/us/about/legal/service-descriptions.html

"Telemetry Data" means samples of Company's email and web traffic, including data on email message and
web request attributes and information on how different types of email messages and web requests were
handled by Company's Cisco hardware products. Email message metadata and web requests included in
Telemetry Data are anonymized and obfuscated to remove any Personally Identifiable Information.

"Term"means the length of the Software subscription You purchased, as indicated in your Ordering Document.

"Virtual Appliance" means the virtual version of Cisco's email security appliances, web security appliances,
and security management appliances.

"Virtual Machine" means a software container that can run its own operating system and execute applications
like a Server.

Additional License Terms and Conditions

LICENSE GRANTS AND CONSENT TO TERMS OF DATA COLLECTION
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License of Software.

By using the Software and the Documentation, Company agrees to be bound by the terms of this Agreement,
and so long as Company is in compliancewith this Agreement, Cisco hereby grants to Company a nonexclusive,
non-sublicensable, non-transferable, worldwide license during the Term to use the Software only on Cisco's
hardware products, or in the case of the Virtual Appliances, on a Virtual Machine, solely in connection with
the provision of the Company Service to End Users. The number of End Users licensed for the use of the
Software is limited to the number of End Users specified in the Ordering Documents. In the event that the
number of End Users in connection with the provision of the Company Service exceeds the number of End
Users specified in the Ordering Documents, Company shall contact an Approved Source to purchase additional
licenses for the Software. The duration and scope of this license(s) is further defined in the Ordering Document.
The Ordering Document supersedes the EULA with respect to the term of the Software license. Except for
the license rights granted herein, no right, title or interest in any Software is granted to the Company by Cisco,
Cisco's resellers or their respective licensors. Your entitlement to Upgrades to the Software is subject to the
Service Description. This Agreement and the Services are co-terminus.

Consent and License to Use Data.

Subject to the Cisco Privacy Statement at https://www.cisco.com/c/en/us/about/legal/privacy.html, Company
hereby consents and grants to Cisco a license to collect and use Telemetry Data from the Company. Cisco
does not collect or use Personally Identifiable Information in the Telemetry Data. Cisco may share aggregated
and anonymous Telemetry Data with third parties to assist us in improving your user experience and the
Software and other Cisco security products and services. Company may terminate Cisco's right to collect
Telemetry Data at any time by disabling SenderBase Network Participation in the Software. Instructions to
enable or disable SenderBase Network Participation are available in the Software configuration guide.

Description of Other Rights and Obligations

Please refer to the Cisco Systems, Inc. EndUser License Agreement, Privacy Statement and Service Description
of Software Subscription Support Services.
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